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C h a p t e r

1.INTRODUCTION

OVERVIEW
This section covers the following topics:

! About Content Publisher (page 1-1)

! What’s New (page 1-2)

! Using the Help System (page 1-3)

! Upgrading to Content Publisher 10gR3 (page 1-6)

ABOUT CONTENT PUBLISHER
With Content Publisher, you can streamline the publishing process by converting standard 
business content into professional, well-designed, interactive Web sites.
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Figure 1-1 Content Publisher screens

The Content Publisher suite comprises Site Builder, Site Scheduler, and Site Server. When 
you use these together, you can create a Web site true to your professional image without 
altering sensitive source documents (word processing, data sheets, presentation files, etc.)

You can use the online Help to make the most of Content Publisher. (See About the Help 
System on page 1-3.) Additionally, you will find two learning exercises, the Seven Easy 
Lessons and the comprehensive Tutorial, both available from the Help menu. Lastly, you 
may refer to the Installation and Configuration Guide, Release Notes, Creating a WML 
Project, and Enabling Section 508 Compliance for more information.

WHAT’S NEW
Content Publisher 10gR3 is a version that contains performance improvements, updated 
filters for greater conversion fidelity, and fixes for known problems. It also comes with 
“TCConsole”.

! New filters—This release of Content Publisher includes updated conversion filters 
that can handle Microsoft Office 2007 applications. See Appendix B (Office 2007 
Limitations) for a number of conversion considerations.

! TCConsole—This release of Content Publisher includes the console application 
TCCONSOLE.EXE, which provides Site Server with limited command functionality 

Note: See User Documentation (page 1-3) for a complete summary of the documentation 
available for Content Publisher.
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to control the execution of an existing project. For more information, see the 
Command Line Functionality.pdf in the Documentation folder.

USING THE HELP SYSTEM
This section covers the following topics:

! About the Help System (page 1-3)

! User Documentation (page 1-3)

! Using Site Builder Help (page 1-4)

! Help From the Menu Bar (page 1-5)

About the Help System
The Content Publisher Help system consists of individual Help topics in HTML format. 
You can view the Help system in a Web browser such as Internet Explorer or Firefox, 
and you can use conventional Web browser controls to navigate and view the Help topics 
(Back, Forward, Favorites, Print, and so on).

You can access Help topics related to each feature in Site Builder by clicking the Help 
button (you can also access the Help system from the Help menu in Site Builder and Site 
Scheduler).

User Documentation
Following is a complete summary of the user documentation available for Content 
Publisher. The PDF manuals can be opened from the drop-down list on the top pane of the 
Help window.

! Release Notes (PDF)—Open from the Content Publisher program group. Available in 
the Documentation folder of your Content Publisher directory and in the root directory 
of your product disc.

! Installation & Configuration Guide (PDF, print)—PDF version available in the 
Documentation folder of both your Content Publisher directory and product disc.

! Getting Started (PDF)—PDF version available in the Documentation folder of both 
your Content Publisher directory and product disc.
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! Seven Easy Lessons (PDF)—Open from the Startup Screen and Help menu in Site 
Builder. Available in the Documentation folder of both your Content Publisher 
directory and product disc.

! Tutorial (PDF)—Open from the Startup Screen and Help menu in Site Builder. 
Available in the Documentation folder of both your Content Publisher directory and 
product disc.

! Enabling Section 508 Compliance (PDF)—Available in the Documentation folder 
of both your Content Publisher directory and product disc. 

! Creating a WML Project (PDF)—Available in the Documentation folder of both 
your Content Publisher directory and product disc.

! Online Help (Help)—Open from Help menu in Site Builder.

! What’s New (Help)—Open from Help menu in Site Builder. See the “What’s New” 
book on the Contents tab of Help.

Using Site Builder Help
Site Builder has an extensive Help system to help you use all of the tools available for 
creating Web pages. You can access Help at any time, from the main window or from any 
tab dialog or dialog box that has a Help button.

! Help menu—On the menu bar of the main window. Choose Help Topics to open the 
Help system. Note the other commands on this menu.

! Help buttons—On any tab dialog or dialog box. Click the Help button to display a 
topic specific to that tab dialog or dialog box.

! F1— Press at any time in Site Builder. On any tab dialog or dialog box, F1 works like 
a Help button to display a topic specific to that tab dialog or dialog box.

! Status bar Help—Available from the status bar on the main screen. When you pass 
the cursor over a menu command, a brief description of the function of that command 
appears at the bottom of the main window.

! Wizards—Four wizards are available in Site Builder to assist you in using the 
program. The Add a Document Wizard is available on the large toolbar. The Template 
Wizard is available in the Edit Template dialog box. The Folder Import Wizard is 
available when you choose Import from the File menu. And the Project Export wizard 
is available from the Server menu. See Wizards in Site Builder (page 2-4) for more 
information.
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Help From the Menu Bar
The Help menu contains the following commands for obtaining assistance in Site Builder:

! Help Topics—Opens this Help system. Pressing F1 from anywhere in Site Builder 
will perform the same function.

! What’s New—Opens the Help topic ‘What’s New in Site Builder’, which highlights 
the latest Site Builder features.

! Seven Easy Lessons—Opens the seven introductory lessons in PDF format. These are 
recommended for new users.

! Tutorial—Opens the Tutorial in PDF format. These lessons are a comprehensive 
version of the Seven Easy Lessons.

! Show Startup Screen—Opens the Startup Screen with commands for starting a new 
or existing publication, and also for running the Seven Easy Lessons and the Tutorial.

! Site Models—Provides a direct link to the Site Models, a variety of Web site 
examples built with technology. (Each site model is located on the Support Web site.)

! About Site Builder—Provides the version number and copyright information for the 
Content Publisher product you are using.

Internet Explorer on Windows XP SP2
The Help systems in Content Publisher use client-side JavaScript to display the Contents 
pane. If you are running Windows XP Service Pack 2 and open Help from Designer, you 
may not see its contents because Internet Explorer, by default, prevents users from 
viewing active content on a local file system. To view the Help system, click on the 
Information Bar and choose Allow Blocked Content..

Follow these steps to prevent this message from appearing each time:

1. Open Internet Explorer and choose Tools > Internet Options.

2. Click the Advanced tab.

3. Scroll down to Security.

4. Check the box Allow active content to run in files on My Computer.

5. Click OK to close the Internet Options dialog box. 

For more information, see Internet Explorer Help.
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UPGRADING TO CONTENT PUBLISHER 10gR3
This section covers the following topics:

! Migrating From a Previous Version (page 1-6)

! Importing the Previous Version Default.tcp (page 1-6)

! Importing Project Files From a Previous Version (page 1-7)

! Converting Older Projects in Site Server (page 1-8)

! Importing Templates From a Previous Version (page 1-9)

Migrating From a Previous Version
If you are upgrading from a previous version of Content Publisher, you may need to do 
one of the following:

! Importing Project Files From a Previous Version (page 1-7)

! Importing Templates From a Previous Version (page 1-9)

! Importing the Previous Version Default.tcp (page 1-6) (assuming you customized 
your default project file in a previous version of Content Publisher and want to use 
it in version 10gR3)

! Automatically Running Pre-7.2 Projects in Site Server (page 8-26) (when using Site 
Server)

You can run version 7.2, 7.5, and 7.6 project files immediately. Pre-7.2 project files will 
need to be converted to the 10gR3 format (and once saved in that format, they can no 
longer be run in the previous version of Content Publisher).

Importing the Previous Version Default.tcp
If you customize the default project file for a previous version of Content Publisher and 
want to use it in version 10gR3, you can do so easily. This assumes that you preserved 
a copy of the Default.tcp before you installed version 10gR3 of Content Publisher.

1. Close Site Builder, if you currently have the application open.

2. Copy the old default project file into the ..\Resources\en folder of your Content 
Publisher directory (first changing its extension back to .tcp, if necessary), thus 
overwriting the default project file that was installed with Content Publisher 10gR3.
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Any new projects you now create in Site Builder will be based on the customized 
Default.tcp you were using in version 7.2, 7.5, or 7.6. That is, you have preserved all the 
customization you did to the older project file.

Use these instructions to import Default.tcp from a pre-7.2 version:

1. Close Site Builder, if you currently have the application open.

2. Copy the old default project file into the ..\Resources\en folder of your Content 
Publisher directory (first changing its extension back to .tcp, if necessary), thus 
overwriting the default project file that was installed with Content Publisher 10gR3.

3. Open Site Builder.

4. When the dialog box as shown in Figure 1-2 opens, click Save.

You have now converted your customized pre-7.2 Default.tcp into the 10gR3 format. 
You have preserved all the customization of the older project file. In addition, you can 
take advantage of new features available for 10gR3 projects.

If you have never customized Default.tcp but may be interested in doing so, see Editing 
the Default Project File (page 4-5).

If the installed version of Default.tcp becomes corrupted or ever needs to be replaced for 
whatever reason, you can find a copy of the file in the Support folder on your Content 
Publisher product disc.

Importing Project Files From a Previous 
Version
When you open a project file from version 7.2, 7.5, or 7.6 of Site Builder in version 
10gR3, it will run immediately, just as if it were a 10gR3 project file. Likewise, you can 
schedule version 7.2, 7.5, and 7.6 project files to run on your installed instance of Site 
Server 10gR3.

However, if you open a pre-7.2 project file in Site Builder for the first time, the following 
dialog box appears:
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Figure 1-2 Dialog box

Click Save to convert your pre-7.2 project file into a 10gR3 project file that can be run 
immediately in Site Builder 10gR3. (The history file for the older-version project file will 
remain associated with the new version in the 10gR3 format.)

Click Save As to make a copy of the existing (older version) file, either with a new name 
or in another directory. Once you do this, however, the history file will no longer be 
associated with the project file. Moreover, once you convert a pre-7.2 project file to the 
10gR3 format, you cannot run that project again in the older version of Site Builder.

If you plan to import a large number of pre-7.2 project files into Site Builder 10gR3, and 
want to keep copies of your older project files, you may want to start out by making those 
copies (which you can do in Windows Explorer). Then, each time you import a project, 
you can simply click Save when the above dialog box appears.

Site Server will not automatically convert pre-7.2 project files to the 10gR3 format. 
However, there is a switch in Site Server that allows you to convert the older project 
files into the new format so that you can schedule the project to run in Site Server. 
See Converting Older Projects in Site Server (page 1-8).

Converting Older Projects in Site Server
Like Site Builder, Site Server will automatically translate 7.2, 7.5, and 7.6 projects; 
however, it will not automatically translate pre-7.2 projects. If you plan to schedule 
pre-7.2 projects for translation on Site Server, you have two options:

! Open the pre-7.2 project files in Site Builder and save them to the 10gR3 format, 
as explained above, and then schedule them for translation by Site Server.

! Change a setting in the Site Server Properties dialog box so that the server will 
automatically convert all scheduled pre-7.2 projects to the 10gR3 format before 
translating them. Since Site Server simply converts an existing file to the 10gR3 
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format (and does not preserve a copy of the pre-7.2 version), this switch is off by 
default.

If you installed Site Server as an OLE Automation Server on Windows XP, and Site 
Server is running, right-click the Site Server icon on the taskbar and choose Properties. 
The Properties dialog box will open. Then select Update old project files to the current 
format.

Figure 1-3 Properties dialog box

If you are running Site Server as a Service, the same option is available by opening the 
Control Panel and clicking the Site Server icon.

Importing Templates From a Previous Version
You can use a template from a previous version of Site Builder in version 10gR3 in three 
different ways:

! Import the template as part of a project file from a previous version that you convert to 
the 10gR3 format, or

! Import the template as a standalone file directly into any Site Builder 10gR3 project 
file (including the default project file, Default.tcp), or

! Link to the standalone template file, assuming it is accessible on your network
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Templates imported as part of an older project will be available only for the projects of 
which they are a part, unless you formally export them and then import them into any new 
version project you create (or link your projects to the external, standalone file). If you 
want such a template to be available for all new Site Builder projects, you should import 
the template into the default project file.

You can view all the templates that ship with Content Publisher 10gR3 in the Manage 
Templates dialog box. The templates listed are “internal.” You can also have “external” 
or “linked” templates. You create a linked template by linking to a standalone template 
file on your file system or in a content server (using the Link button in the Manage 
Templates dialog box). You can use a linked template to format your Web pages just as 
you would an internal template. However, you must import the standalone template into 
a 10gR3 project in order to edit it.
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2.USING CONTENT PUBLISHER
This section covers the following topics:

! Startup Screen (page 2-1)

! How Site Builder Works (page 2-2)

! Wizards in Site Builder (page 2-4)

! Exiting Site Builder (page 2-4)

! Setup and Configuration (page 2-5)

STARTUP SCREEN
Site Builder opens with the Startup Screen on top of the main window. (You can open it at 
any time by choosing Startup Screen from the Help menu.)

The Startup Screen offers ways to start a project plus some learning opportunities.

! Wizard—Walks you through the process of starting a new publication. Helpful if you 
are new to Site Builder and not yet familiar with its basic features and commands.

! Blank Publication—The same as starting a new publication from the File menu or 
the toolbar. Opens the Publication Properties dialog box for the default publication 
“Unnamed.” You can rename the publication and change the output directories, if you 
want. The new name appears at the top of the Publication Hierarchy pane and just 
above the Contents pane. But the title bar still shows “Unsaved,” because Site Builder 
lets you name a publication and its project file differently, and you still haven’t named 
the project file. (To name and save a project file, choose Save As from the File menu.)
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! Open an existing publication—The same as opening an existing publication from 
the File menu or the toolbar. When the Open dialog box appears, you can locate the 
project file you want to use. When you select the file and click OK, the dialog box 
closes, the name of the project file appears in the title bar, the name of the publication 
appears at the top of the Publication Hierarchy pane and immediately above the 
Contents pane, and publication details appear in the Contents pane.

! Open the last publication used—A quick way to open the project you worked on 
during your previous session in Site Builder.

! Seven Easy Lessons—Opens Adobe Reader to display a series of lessons to help you 
learn the basics of Site Builder. The PDF manual is also available from the Help 
menu.

! Tutorial—A series of lessons for the more advanced user that explore the many 
features of Site Builder in detail. The PDF manual is also available from the Help 
menu.

HOW SITE BUILDER WORKS
In its simplest terms, Site Builder converts source documents into Web pages using 
elements and templates.

Small Publication
In a small Web publication, you might perform the following tasks to create a Web page 
from a source document:

1. Start a new project (see The Project File on page 4-3) in Site Builder.

2. Create a new publication (see Adding a Publication on page 5-3).

3. Select a source document from a repository (could be the file system, an FTP, HTTP, 
or a content server). (See Adding a Document on page 5-31).

4. Associate a template (see Choosing a Template on page 6-3) with that document when 
you add it to your publication (this process involves applying styles, patterns, or ranks 
to the document).

Note:  If you don’t want the screen to show the next time you open Site Builder, select 
Don’t show this screen again. To open the screen at any time, click Show Startup 
Screen on the Help menu.
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5. Modify the template (see Template Editing Options on page 6-9) to create a desirable 
look and feel for your publication (you do this using the Element Setup, Formatting, 
Navigation, and Globals tab dialogs).

6. Design a page layout (see Layout Options: Frameset, HTML Table, and Custom Table 
on page 5-56) for the Web site using HTML tables or framesets (you do this using the 
Layout dialog box).

7. Translate the document into a Web page (which is stored on your local file system). 
(See Translating Source Documents on page 5-41).

8. Publish the Web page to a Web server (could be the file system, an FTP, HTTP, or a 
content server). (See Publishing a Project on page 8-17).

Large Publication
Thanks to the power of Site Builder, you can easily handle more complex projects. A more 
sophisticated Web publication might include the following:

! Add a variety of source documents (Microsoft Word, Excel, Powerpoint, Adobe 
FrameMaker, Lotus 1-2-3, and more) to your project (See File Formats and 
Translation on page 5-44.)

! Build a publication hierarchy by adding publications to the root publication and then 
adding source documents and reference pages to each publication. (See Publication 
Hierarchy on page 5-8.)

! Build reference pages for each publication and subpublication (such as a table of 
contents, key word index, or query page) to aid navigation and information retrieval. 
(See Adding a Reference Page on page 5-53.)

! Add a directory item to a publication, to let content authors drop documents into that 
directory and to have those documents automatically translated to become a part of the 
Web publication. (See Adding a Directory Item on page 5-89.)

! Add a linked publication to your project. A linked publication is a separate project file 
that becomes part of your master project. (See Adding a Linked Publication to a 
Project on page 5-2.)

! Stage and publish your project using Content Publisher's dual publishing capabilities. 
(See The Dual Publishing Model on page 8-2.)
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WIZARDS IN SITE BUILDER
There are four wizards in Site Builder:

! You can use the Add a Document wizard to add a document to a new or existing 
publication, pick a graphics set and select formatting options, and preview the results. 
You may find it especially useful if you are new to Site Builder. The Add a Document 
wizard is available from the large toolbar by clicking the wizard button ( ), as well 
as the Startup Screen.

! The Template wizard is available from the Edit Template dialog box, also by clicking 
the wizard button ( ). You can use it to pick a graphics set, format the top heading 
levels in the source document, and split the source document into multiple Web pages. 
This wizard also may be especially useful to those new to Site Builder.

! The Folder Import wizard is available by choosing Import from the File menu. It is 
designed to let you add a portion of your file system hierarchy to the publication 
hierarchy of your Content Publisher project. See Importing Folders From the File 
System Hierarchy (page 5-97) for details.

! The Project Export wizard is designed to let you move your project to another location 
on the network. See Project Export Wizard (page 4-13) for details.

EXITING SITE BUILDER
You can exit Site Builder at any time. Site Builder prompts you to save changes, if any, to 
the project currently open.

To exit Site Builder, do one of the following:

! From the File menu, choose Exit.

! Use the keyboard shortcut Alt, F, X.

! Use the keyboard shortcut Alt+F4.

! On the main screen, click the Close button on the title bar.

Note: If you have a project open when you choose to exit the program, Site Builder 
prompts you to save any unsaved formatting or other instructions before it closes the 
program.
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SETUP AND CONFIGURATION
This section covers the following topics:

! Configuring Content Publisher (page 2-5)

! Anti-Virus Software (page 2-5)

! Disk Space (page 2-6)

Configuring Content Publisher
Content Publisher comprises the workstation Site Builder and the server Site Server. To 
successfully integrate Content Publisher with Content Server, you must first configure 
both Site Builder and Site Server.

! On each machine on which either Site Builder or Site Server is installed, install 
Internet Explorer version 4.0 or higher. See Installing Internet Explorer (page 7-3).

! On each machine on which either Site Builder or Site Server is installed, register 
(a) the name of each content server you want to have access to, and (b) the name 
of the HTTP server hosting each content server. See Registering a Content Server 
(page 5-24).

! On each machine on which Site Server is installed, create Registry entries for a 
username and password for each content server that Site Server will access. See 
Registering a Username and Password for Site Server (page 8-77).

! On each machine on which Site Server is installed, make sure that you have installed 
the server either as an OLE Automation Server or Service, depending on your 
preference. If the server is to run as a Service, complete the necessary additional 
configuration. See Setting Up Site Server as a Service (page 8-29).

! On each machine on which Site Builder is installed, import any project files and 
templates you have been using with a previous version of the product and want to 
convert for use with version 10gR3. See Migrating From a Previous Version 
(page 1-6).

Anti-Virus Software
Conflicts can occur with anti-virus software if you frequently run translations that can 
result in large log files. If translations occur frequently, the translation log file may be 
more or less continuously updated. Since the file is frequently changing, it can attract a lot 
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of attention from anti-virus software. As the anti-virus software attempts to review the 
entire file, more changes could get made to the file. This results in a deadlock situation, 
where the anti-virus software cannot catch up.

We recommend that you use a unique extension for the translation log file and set your 
anti-virus software to ignore files of that extension type.

Disk Space
If you experience performance difficulties, especially in displaying previews, check to see 
that you have adequate disk space. Adequate disk space depends upon the number of 
documents you are trying to translate and their complexity. A range of 25 to 50 megabytes 
of free disk space is highly recommended for translation purposes, though you may 
require much more for a large project. This disk space must be on the drive that contains 
your \\Temp directory. Of course, you will also require disk space at the staging and 
publishing areas for your translated output.

Note:  Choose Application Options from the View menu to change the logging options as 
well as the log file name and location. If you are scheduling a project for translation by 
Site Server, the server log file must be set up in the New Task dialog box for each project 
you schedule. You can view the log file for the latest translation by choosing Log File 
from the View menu.
2-6 Content Publisher User Guide



C h a p t e r

3.CONTENT PUBLISHER INTERFACE
This section covers the following topics:

! Site Builder Main Window (page 3-2)

! Publication Hierarchy Pane (page 3-3)

! Contents Pane (page 3-3)

! Title Bar (page 3-4)

! Status Bar (page 3-4)

! Menu Bar (page 3-5)

! Popup Menus (page 3-5)

! Toolbars (page 3-6)

! Toolbar Commands (page 3-12)

! Application Options (page 3-14)

! Viewers (page 3-17)

! Showing and Hiding Toolbars (page 3-18)

! Showing Dialog Boxes (page 3-19)
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SITE BUILDER MAIN WINDOW
Site Builder opens with a Startup Screen on top of the main window. You can make your 
initial choices from the Startup Screen or close the screen and begin project setup in the 
main window.

! Startup Screen—Lets you start a new project or open an existing one. Also offers 
two learning opportunities. See Startup Screen (page 2-1).

! Publication Hierarchy pane—Where you set up the hierarchy for your publication. 
You can add publications to the root publication, and add publications to those 
publications. Each publication becomes a subpublication when added to another 
publication. See Publication Hierarchy Pane (page 3-3).

! Contents pane—Where you display key setup information about a publication. See 
Contents Pane (page 3-3).

! Title bar—The horizontal bar at the very top of the main window. See Title Bar 
(page 3-4).

! Menu bar—The horizontal list of menu names below the title bar. See Menu Bar 
(page 3-5).

! Standard toolbar—The horizontal series of buttons below the menu bar. See 
Standard Toolbar (page 3-11).

! Large toolbar—The series of labels and buttons down the right-hand side of the main 
window. See Large Toolbar (page 3-9).

! Status bar—The information bar across the bottom of the main window. See Status 
Bar (page 3-4).

You complete project setup in the main window before you begin editing templates and 
formatting your Web pages. You can add publications to the root publication, and then add 
source documents and reference pages to each publication. Only publications appear in the 
Publication Hierarchy pane. All publication details, including the output page and 
template for each document, appear in the Contents pane.
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PUBLICATION HIERARCHY PANE
The Publication Hierarchy pane is one of two panes in the Site Builder main window. The 
Publication Hierarchy pane shows the publication hierarchy (see Publication Hierarchy on 
page 5-8) for the current project (the root publication plus any subpublications). The 
Contents pane (see Contents Pane on page 3-3) displays publication details for whichever 
publication in the hierarchy is currently selected.

Publications are containers for organizing the source documents you want to turn into 
Web pages. Each project has a root publication. You can add publications to the root 
publication, and add publications to those publications, to create a multi-tiered 
publication.

You can use the plus and minus boxes to expand and contract the publication hierarchy. 
You can also right-click any publication and choose Expand All or Collapse All from the 
Tree submenu of the popup menu that appears. And with the left mouse button held down, 
you can drag a publication in the Publication Hierarchy pane to reposition it at a different 
level or in a different order in the publication hierarchy.

When you save the project file (see The Project File on page 4-3) at the end of a session, 
all the information you see in the Publication Hierarchy pane is saved, along with all the 
information in the Contents pane and the formatting instructions captured in the templates.

CONTENTS PANE
The Contents pane is one of two panes in the Site Builder main window. The Publication 
Hierarchy pane (see Publication Hierarchy Pane on page 3-3) shows the publication 
hierarchy (see Publication Hierarchy on page 5-8) for the current project. The Contents 
pane displays publication details for whichever publication in the hierarchy is currently 
selected.

Each time you select a source document to add to a publication, details about the source 
document appear in the Contents pane: the name of the output file you will create when 
you translate the source document, the full path and name of the source document itself, 
the name of the template associated with the document, and the translation status of the 
source document.

The Contents pane also displays the names of any reference pages you add to the 
publication. The only key information not visible here is the location of the output 
directories, which can be checked in the Publication Properties or Document Properties 
dialog box.
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Once project setup is complete here, you are ready to edit the template for each document. 
When you save the project file (see The Project File on page 4-3) at the end of a session, 
all the information you see in the Contents pane is saved along with all the formatting 
instructions captured in the templates (and the publication hierarchy and location of output 
directories).

TITLE BAR
The title bar is the horizontal bar at the top of the Site Builder main window. The title bar 
always displays the name of the project file currently open.

Figure 3-1 Title bar

To the left are the program icon, the name of the current project file, and the name of the 
program. To the right are buttons to minimize the main window, maximize or restore the 
window, and close the program.

You can right-click the program icon to open a popup menu with commands that duplicate 
these buttons.

STATUS BAR
The status bar is the horizontal bar at the bottom of the Site Builder main window.

Figure 3-2 Status bar

When you pass your cursor over a specific command in a menu or on the toolbar, the field 
to the left of the status bar displays a brief explanation.
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MENU BAR
The menu bar is the horizontal list of menu names below the title bar at the top of the Site 
Builder main window.

Figure 3-3 Menu bar

Click a menu name to open the menu. Choose any command by clicking the command 
name or using its keyboard shortcut.

Some menu commands may be grayed out. For example, most of the Template commands 
are not available until you select a source document in the Contents pane.

POPUP MENUS
Throughout Site Builder there are many opportunities to right-click in order to open a 
popup menu with a selection of commands appropriate to where you are in the interface. 

Figure 3-4 Popup menu example

Popup menus can be opened from different parts of the interface. The commands available 
will vary, depending on where you are in the interface and what you right-click.

There are many “right-click opportunities” in Site Builder to help you speed up the 
execution of commands.
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TOOLBARS
This section covers the following topics:

! Toolbars (page 3-6)

! Add Toolbar (page 3-6)

! Customizing the Standard Toolbar (page 3-7)

! Edit Toolbar (page 3-8)

! File Toolbar (page 3-9)

! Moving a Toolbar (page 3-9)

! Large Toolbar (page 3-9)

! Standard Toolbar (page 3-11)

! Template Toolbar (page 3-11)

Toolbars
There are two toolbars in Site Builder: standard and large.

! The standard toolbar is the horizontal series of buttons at the top of the main window, 
below the menu bar (see Standard Toolbar on page 3-11).

! The large toolbar is the series of labels and buttons down the right side of the window. 
See Large Toolbar on page 3-9.

The command buttons on the standard toolbar duplicate many of the commands in the 
menus. To identify a command, hold the mouse briefly over the button and its name will 
display in a screentip. Some command buttons may be grayed to denote they are 
temporarily unavailable.

Add Toolbar
The Add toolbar commands on the standard toolbar duplicate three of the four commands 
on the Add menu: Add Document, Add Reference Page, and Add Publication.

Figure 3-5 Add toolbar
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These commands do the following:

! Add Document—Opens the Add Document dialog box so you can add a source 
document to the publication currently selected in the Publication Hierarchy pane. The 
Select a Repository dialog box may open first so that you can identify the repository 
containing the document you want to add. See Selecting a Repository (page 5-8) and 
Adding a Document (page 5-31).

! Add Reference Page—Opens the Add Reference Page dialog box so that you can add 
a reference page to the publication currently selected in the Publication Hierarchy 
pane. See Adding a Reference Page (page 5-53).

! Add Publication—Opens the Publication Properties dialog box so that you can add a 
subpublication to the publication currently selected in the Publication Hierarchy pane. 
See Adding a Publication (page 5-3).

Customizing the Standard Toolbar
The standard toolbar is the horizontal series of buttons at the top of the main window, 
below the menu bar. You can remove buttons and separators from the toolbar or rearrange 
the order of the buttons.

1. Click Toolbars on the View menu and then Customize on the submenu to open the 
Customize Toolbar dialog box.

2. To remove a toolbar button or separator, select the button or separator under Toolbar 
Buttons and click Remove.

3. If you have previously removed a button or separator that you now want to add back 
to the toolbar, select the button or separator under Available Buttons and click Add.

4. To change the position of a button or separator on the toolbar, select the button or 
separator under Toolbar Buttons and click the Move Up or Move Down button until 
the button or separator is in the correct position on the toolbar.

5. To reset the standard toolbar, click the Reset button. The toolbar will now be returned 
to its original form, with all buttons and separators in place.

6. Click OK.

Note:  The Directory Item command is available only from the Add menu. This command 
lets you add a folder to your publication. All source documents that have one of the 
specified file formats and are in that folder at translation time will be translated.
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You can also remove an individual toolbar button when working in the main window. 
With the Shift key held down, drag the button off the toolbar and then let go of the mouse. 
(You cannot remove a separator this way.)

Separators keep related toolbar buttons together. If you create a toolbox, related buttons 
will always appear on the same line if they are separated by a separator from the adjacent 
group of related buttons.

Edit Toolbar
The Edit toolbar commands on the standard toolbar duplicate the commands on the Edit 
menu: Cut, Copy, Paste, and Delete.

Figure 3-6 Edit toolbar

These standard Windows commands work the same way in Site Builder:

! Cut—Removes the selected item from the project: a source document or reference 
page from the Contents pane, or a publication from the Publication Hierarchy pane.

! Copy—Makes a copy of the selected item: a source document or reference page from 
the Contents pane, or a publication from the Publication Hierarchy pane.

! Paste—Pastes into the project the last item that was copied by use of the Copy 
command during your current session in Site Builder.

! Delete—Removes the selected item from the project: a source document or reference 
page from the Contents pane, or a publication from the Publication Hierarchy pane. 
The deleted item cannot be returned to the project by using the Paste command.

The Cut, Copy, and Delete commands are available only if you have selected a publication 
in the Publication Hierarchy pane or a document or reference page in the Contents pane. 
The Paste command is active only if you have used the Copy command during your 
current session in Site Builder.
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File Toolbar
The File toolbar commands on the standard toolbar duplicate some of the commands on 
the File menu: New, Open, Save.

Figure 3-7 File toobar

These commands do the following:

! New—Starts a new project (by opening a copy of Default.tcp, the default project file).

! Open—Opens an existing project.

! Save—Saves an existing project. In the case of a new project that has not yet been 
saved, opens the Save As dialog box.

Moving a Toolbar
The standard toolbar in the Site Builder main window is movable and dockable. It can be 
positioned anywhere on the desktop. You can also re-arrange the order of the buttons and 
delete some, if you want (see Customizing the Standard Toolbar on page 3-7).

You can move the large toolbar the same way, but you can position it only within the main 
window. To move the standard toolbar

1. Click a blank portion of the toolbar and, with left mouse button held down, drag the 
toolbar to its new position. Note how the outline of the toolbar thickens once it is 
removed from the main toolbar.

2. Drop the outline of the toolbar in the desired position by letting go of the mouse 
button.

The toolbar now has its own title bar, name, and Close button. You can reshape the toolbar 
into a vertical or horizontal row of buttons, or turn it into a square or rectangular toolbox.

Large Toolbar
The large toolbar duplicates some of the buttons on the main toolbar.

! Wizard—Opens the Add a Document wizard, which shows you how to add a source 
document to a new or existing publication. Command also available from the Startup 
Screen.
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! Add Document—Opens the Add Document dialog box, which allows you to select a 
source document to add to a publication. Command also available from the Add menu 
and the standard toolbar.

! Add Reference Page—Opens the Add Reference Page dialog box, which allows you 
to add a reference page to a publication. Command also available from the Add menu 
and the standard toolbar.

! Add Publication—Opens the Add Publication dialog box, which allows you to add a 
publication to the publication. Command also available from the Add menu and the 
standard toolbar.

! Choose Template—Opens the Choose Template dialog box, where you associate a 
template with a source document. Opens automatically when you add a document to a 
publication. But you can enter the dialog box at any time to change the association 
between a template and a document.

! Edit Template—Opens the Edit Template dialog box, where you can move between 
the four template editing options without returning to the main window. You can also 
preview any document associated with the selected template.

! Update Versions—Updates source documents in the repository by checking for the 
latest versions. Can be used when your source documents are from Content Server or 
from an FTP or HTTP site. (Site Builder automatically recognizes when files in the 
file system need to be updated.)

! Translate—Runs an incremental translation to translate only those source documents 
that have changed since the last translation of the publication.

! View—Opens the default Web browser or other viewer associated with Site Builder. 
If you have several Web browsers associated with the program, you can click the 
down arrow to the right of the default viewer name and select another from the popup 
menu that appears.

! Stage—Copies translated output from the file system to a staging server in Content 
Server.

! Publish—Copies translated output from the file system to a publishing server in 
Content Server.

You can move the large toolbar anywhere in the main window.
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Standard Toolbar
The standard toolbar is the horizontal series of buttons at the top of the main window, 
below the menu bar.

Figure 3-8 Standard toolbar

The standard toolbar duplicates commands on the various menus. The command buttons 
are grouped to reflect their assignment on the menus.

You can drag and drop the standard toolbar to position it anywhere in the main window or 
dock it along either side, or the bottom, of the window. You can also resize the toolbar to 
create a toolbox. Finally, you can remove individual buttons, if you want. See 
Customizing the Standard Toolbar (page 3-7).

Template Toolbar
The Template toolbar commands on the standard toolbar duplicate the commands on the 
Template menu: Element Setup, Formatting, Navigation, and Globals; also, Choose 
Template, Edit Template, and Manage Templates.

Figure 3-9 Template toolbar

These commands do the following:

! Element Setup—Opens the Element Setup property sheet, where you edit and 
promote the elements in your project. See Element Setup (page 6-16).

! Formatting—Opens the Formatting property sheet, where you format your Web 
pages. See Formatting (page 6-96).

! Navigation—Opens the Navigation property sheet, where you set navigation between 
and within Web pages. See Navigation Topics (page 6-134).

! Globals—Opens the Globals property sheet, where you set global options for your 
Web publication. See Globals (page 6-173).
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The other three commands open dialog boxes:

! Choose Template—Where you choose the template you want to associate with a 
source document. You can change this association at any time. See Choosing a 
Template (page 6-3).

! Edit Template—Where you can edit your template by previewing the source 
document and opening the four property sheets. See Using the Edit Template Dialog 
Box (page 6-7).

! Manage Templates—Where you create new templates, import and export templates, 
and link to an external template. See Managing Templates (page 6-12).

The four property sheets can also be opened from the Edit Template dialog box.

TOOLBAR COMMANDS
This section covers the following topics:

! Run Toolbar Commands (page 3-12)

! Publication Toolbar Commands (page 3-13)

! Server Toolbar Commands (page 3-13)

Run Toolbar Commands
The Run toolbar commands on the standard toolbar duplicate some of the commands on 
the Run menu: Update All Versions, Incremental Translation, Stage, and Publish.

Figure 3-10 Run toolbar

These commands do the following:

! Update All Versions—Updates source documents so that your translation includes 
the latest versions of these documents in a repository. For use when the source 
documents are from an FTP or HTTP site, or a content server. Site Builder 
automatically recognizes when source documents in the file system are dated and will 
automatically translate these files with the next incremental translation. (However, 
you must formally update source documents in a Directory Item on the file system.)
3-12 Content Publisher User Guide



Content Publisher Interface
! Incremental Translation—Runs an incremental translation of the project, translating 
only those documents that have changed since the last translation. If you are using a 
repository other then the file system, you should use the Update Versions command 
first.

! Stage—Copies translated output from the file system to a content server designated 
for staging.

! Publish—Copies translated output from the file system to a content server designated 
for publishing.

Publication Toolbar Commands
The Publication toolbar commands on the standard toolbar duplicate the commands on the 
Publication menu: Layout, Associated Files, and Publication Properties.

Figure 3-11 Publication toolbar

These commands do the following:

! Layout—Opens the Layout dialog box, where you create a frameset or HTML table 
for your publication. See Creating a Frameset (page 5-59) and Creating an HTML 
Table (page 5-73).

! Associated Files—Opens the Associated Files dialog box, where you can list files that 
are associated with the project but are not formally a part of it. See Associating a File 
With a Publication (page 5-99).

! Publication Properties—Opens the Publication Properties dialog box, where you can 
change the name or title of the publication, add a Map file property, and change the 
output directories. See Publication Properties (page 5-6).

Server Toolbar Commands
The Server toolbar commands on the standard toolbar duplicate commands on the Server 
menu.

Figure 3-12 Server toolbar
Content Publisher User Guide 3-13



Content Publisher Interface
These commands do the following:

! Project Export wizard—Lets you copy a project file and its related source 
documents and graphics files to a shared network location, to be accessible to Site 
Server for translation. The command is grayed out unless you have a saved 
publication open in Site Builder.

! Site Scheduler—Opens a utility that lets you schedule the automatic translation of 
projects by Site Server.

APPLICATION OPTIONS
This section covers the following topics:

! Application Options (page 3-14)

! Setting Application Options (page 3-16)

! Options Available in Site Builder (page 3-16)

Application Options
Application options are user-specific for a given machine. They apply only to translations 
on that machine. If multiple users share a machine and set different options, the options in 
effect will be those that have been set by the user who is currently logged in.

The Application Options dialog box has three tab dialogs with the following settings.

Logging
! Level—Select the level of logging you want to use. See Setting Up the Translation 

Log on Site Builder (page A-5).

! Log file—Type the path and file name for the log file you want to use. (You can 
change the name of the log file as well as the path.) Alternatively, use the Browse 
button to search for the directory you want to use.

! HTML or Text—Choose a format for the log file. With HTML formatting enabled, 
you can quickly find what you are looking for using a color-coded logging system. 
The HTML log file includes a set of preferences for customizing the layout of the log 
file.

! Reset log file for each translation—Select this option to create a log file just for the 
current translation. Clear this check box to create a continuous record of all logging.
3-14 Content Publisher User Guide



Content Publisher Interface
General
! Word Processor Default Character Style Name—An important option if you are 

using an international version of Microsoft Word. See Working With International 
Versions of Microsoft Word (page 6-50).

! Default Output Extension—You can change the extension to match a scripting 
language in your project if you prefer (such as ASP, JSP, and IdocScript). Once you 
change this setting, it will be used on all new documents added to your publication 
(but not to any existing documents). See Specifying the Extension for Output Files 
(page 5-106). The wml extension is the default for WML projects (see Creating a 
WML Project on page 4-10).

! Default Output File Names—The default setting is to use the file name of the source 
document for the output file name. Click Use this property for file naming if you 
prefer to use a metadata property (e.g., dDocAuthor or dDocTitle) for files from the 
content server. You can also choose to strip the file extension from the original file 
name at the same time.

Dialogs
! Startup Screen—Lets you toggle between showing and hiding the Startup Screen 

each time Site Builder opens. See Showing the Startup Screen (page 3-19).

! CSS Caution—Alerts you when formatting characters and paragraphs with CSS 
turned on. See Showing the Caution for Using CSS (page 3-20).

! Select a Repository—Lets you toggle between showing and hiding the Select a 
Repository dialog box. See Showing the Select a Repository Dialog Box (page 3-21).

! Print Warning—Alerts you when adding a Print button without the required options 
enabled in the Map File / Print Publication tab dialog of the Project Options dialog 
box. See Enabling the Print Functionality (page 6-139).

! Update Versions—Determines whether the Update Versions dialog box displays 
before each translation. See Update Versions Command (page 8-9).

! Project Type—Determines whether the New Project Type dialog box displays when 
you start a new project. This dialog box lets you toggle between creating an HTML 
project or a WML project. (See Creating a WML Project (page 4-10).)

! Selective Incremental Translation—Lets you toggle between showing and hiding 
the Selective Incremental Translation dialog box. See Showing the Selective 
Incremental Translation Dialog Box (page 3-20).
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! Show Template Export Format—Lets you toggle between showing and hiding the 
Template Export Format dialog box. See Exporting a Template (page 6-5).

Setting Application Options
The Application Options dialog box contains a number of options that are set by default in 
Site Builder and that apply to whatever projects you create. The options are user-specific 
for a given machine settings and will apply to all projects you translate on the machine 
until you decide to change them.

1. Click Application Options on the View menu to open that dialog box.

2. Click the tab to open the appropriate tab dialog.

3. Under the appropriate heading, change the setting for the option you want to change.

4. Click OK.

Options Available in Site Builder
You can set two types of options in Site Builder: application and project.

! Application options are user-specific for a given machine. They apply to all projects 
you translate on that machine, but no longer apply once you export the project file to a 
network location or schedule the project for translation by Site Server. See 
Application Options (page 3-14) for more details.

! Project options are specific to the project and are therefore saved with the project file. 
They apply to your project whether you run it locally, export the project file to a 
network location, or schedule the project for translation by Site Server. See Project 
Options (page 4-7) for more details.

Note:  You can also set project options in Site Builder, which are saved with the project 
and apply even if you export the project file to a network location or schedule the project 
for translation by Site Server. See Project Options (page 4-7).

Note:  If multiple users share a machine and set different options, the options in effect will 
be those that have been set by the user who is currently logged in.
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VIEWERS
This section covers the following topics:

! Changing the Default Viewer (page 3-17)

! Viewer Toolbar Command (page 3-17)

Changing the Default Viewer
When you install Site Builder, Site Builder will select a browser on your machine as the 
default viewer for viewing the Web pages you create. You open this browser by choosing 
Launch Viewer on the Viewers menu or clicking the View button on the standard toolbar 
or large toolbar.

You can change the default viewer at any time.

! From the Viewers menu, choose the viewer you now want to use, or

! On the large toolbar, click the down arrow next to the button displaying the icon and 
name of the default viewer and choose the new viewer from the popup menu that 
appears.

The new default browser will now open each time you view Web pages in Site Builder. If 
the viewer you want to use is not currently associated with Site Builder, you can set up the 
viewer by choosing Setup from the Viewers menu. See Setting Up a Viewer (page 7-2).

Viewer Toolbar Command
The Launch Default Viewer command on the standard toolbar duplicates the Launch 
Viewer command on the Viewers menu. The toolbar icon matches the browser you are 
using, and as such could look like either of the following graphics.

Figure 3-13 Viewer toolbar

 

This command does the following:

Launch Default Viewer—Launches the default viewer for viewing the Web publication 
you have created in Site Builder. You must first translate a project for the viewer to open.

If your publication has a frameset, a Web browser will open the frameset, no matter what 
is selected in the Contents pane. Otherwise, the browser will open the first document or 
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reference page selected in the Content pane. (If nothing is selected and the publication has 
no frameset, the browser will display the first page of the publication.)

The toolbar icon is determined by the default viewer. You can change the default by 
choosing another viewer from the Viewers menu. Alternatively, you can click the down 
arrow to the right of the default viewer shown on the large toolbar and choose another 
viewer from the popup menu that appears.

SHOWING AND HIDING TOOLBARS
This section covers the following topics:

! Displaying and Hiding the Large Toolbar (page 3-18)

! Displaying and Hiding the Standard Toolbar (page 3-18)

! Displaying and Hiding the Status Bar (page 3-19)

Displaying and Hiding the Large Toolbar
The large toolbar on the right of the main window can be hidden from view.

To hide the large toolbar:

1. From the View menu, choose Toolbars.

2. From the Toolbars submenu, choose Large Toolbar.

The large toolbar is now hidden. To show the toolbar again, repeat this action.

Displaying and Hiding the Standard Toolbar
The standard toolbar in the main window can be hidden from view.

1. From the View menu, choose Toolbars.

2. From the Toolbars submenu, choose Standard Toolbar.

The standard toolbar is now hidden. To show the toolbar again, repeat this action.

You can also customize the standard toolbar by removing buttons from the toolbar or 
changing the order of the buttons. See Customizing the Standard Toolbar (page 3-7).
3-18 Content Publisher User Guide



Content Publisher Interface
Displaying and Hiding the Status Bar
The status bar is the horizontal bar at the bottom of the main window. When you pass your 
cursor over a command in the menu bar or toolbar, the status bar displays a short 
explanation of the command. You can hide the status bar, if you want.

1. From the View menu, choose Toolbars.

2. From the Toolbars submenu, choose Status Bar.

The status bar is now hidden. To show the status bar again, repeat this action.

SHOWING DIALOG BOXES
This section covers the following topics:

! Showing the Startup Screen (page 3-19)

! Showing the Caution for Using CSS (page 3-20)

! Showing the Selective Incremental Translation Dialog Box (page 3-20)

! Showing the Warning When Adding a Print Button (page 3-21)

! Showing the Select a Repository Dialog Box (page 3-21)

Showing the Startup Screen
The Startup Screen opens each time you start Site Builder. It provides different ways to 
start a project and also some learning opportunities. If you don’t want the screen to show 
the next time you open Site Builder, select the Don’t show this screen again check box. If 
you have selected this check box and want to view the Startup Screen, do the following.

1. From the View menu, choose Application Options to open that dialog box.

2. Click Dialogs to open that tab dialog.

3. Select the Show Startup Screen when starting Site Builder check box.

4. Click OK.

The next time you start Site Builder, the Startup Screen will appear.

If you want to view the Startup Screen at any time, click Show Startup Screen on the 
Help menu.
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Showing the Caution for Using CSS
Site Builder can be configured to generate formatting with standard HTML tags or with 
CSS (cascading style sheet) markup. Enabling CSS for a template changes options in the 
Character and Paragraph tab dialogs in Formatting.

Since support for the advanced paragraph features may vary significantly between 
browsers, a caution appears onscreen when you click the Advanced button in the 
Paragraph tab dialog of Formatting to open the Advanced Settings dialog box.

If you click the Don’t show this warning again check box, you may later want this 
caution to appear as a reminder.

1. TFrom the View menu, choose Application Options to open that dialog box.

2. Click the Dialogs tab to open that tab dialog.

3. Select the Show Caution when using advanced paragraph formatting with CSS 
turned on check box.

4. Click OK.

This setting is user-specific on a given machine. It applies to all projects run on the 
machine by the user logged in at the time of the change.

Showing the Selective Incremental Translation 
Dialog Box
The Selective Incremental Translation dialog box displays the items that are currently 
selected for translation, and the items that are currently omitted from translation. You can 
easily add or remove any item from translation by placing a check mark to the left of the 
item if you want to translate it, or clearing the box if you do not.

! To hide the Selective Incremental Translation dialog, click Don't show this screen 
again from within the dialog box. You may choose to hide the dialog box if you 
frequently use the selective translation option and do not want to see all of the items 
that can be translated.

! To show the Selective Incremental Translation dialog box again after it has been 
hidden, click Show Selective Incremental Translation dialog on the Dialogs tab in 
Application Options.

If you choose to hide the Selective Incremental Translation dialog box, you can still 
selectively translate items using the methods described in Translating Source Documents 
(page 5-41).
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Showing the Warning When Adding a Print 
Button
The print functionality is set up by default so that when you add a Print button to a 
publication it should work immediately.

The first time you try to add a Print button to a publication and the print functionality is 
not enabled, the Print Publication Setup Warning dialog box will appear. If you click the 
Don’t show this warning again check box, you may later want this warning to appear as 
a reminder.

1. From the View menu, choose Application Options to open that dialog box.

2. Click the Dialogs tab to open that tab dialog.

3. Select the Show warning when adding a print publication button check box.

4. Click OK.

This setting is user-specific on a given machine. It applies to all projects run on the 
machine by the user logged in at the time of the change.

Showing the Select a Repository Dialog Box
In Site Builder you can work in your file system or in Content Server. You can also add 
documents to a publication from an FTP or HTTP site.

You make your selection in the Select a Repository dialog box, which opens by default the 
first time you you add a source document (see Adding a Document on page 5-31) or 
Directory Item (see Adding a Directory Item on page 5-89) to a project. Once you select a 
repository from the drop-down list, you can hide this dialog box from view as you work in 
Site Builder.

If you later want to add source documents or Directory Items from another source, you 
need to show the Select a Repository dialog box again.

1. Click Application Options on the View menu to open that dialog box.

2. Click Dialogs to open that tab dialog.

3. Select the check box Show Select a Repository dialog box when adding a source 
document or directory item to a publication.

4. Click OK.
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The Select a Repository dialog box will open the next time you choose the Add Document 
or Add Directory Item command. You can show or hide the dialog box at any time by 
selecting or clearing this option.

This setting is user-specific on a given machine. It applies to all projects run on the 
machine by the user logged in at the time of the change.

You can create a project by adding documents and directory items from different sources. 
To do this, you would want the Select a Repository dialog box to open each time.
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C h a p t e r

4.CREATING AND MANAGING
PROJECTS

This section covers the following topics:

! Projects (page 4-1)

! Exporting a Project (page 4-13)

! Path Conflicts (page 4-18)

PROJECTS
This section covers the following topics:

! About Projects (page 4-2)

! The Project File (page 4-3)

! The History File (page 4-3)

! Project Setup (page 4-4)

! Editing the Default Project File (page 4-5)

! About the Default Project File (page 4-6)

! Customizing the Default Project File (page 4-6)

! Project Options (page 4-7)

! Setting Project Options (page 4-9)

! Versioning the Project File (page 4-9)
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! Copying a Project File (page 4-10)

! Creating a WML Project (page 4-10)

! Starting a Project (page 4-11)

! Saving a Project File (page 4-12)

About Projects
A Content Publisher project consists of a project file, source documents, related graphics, 
templates, and any other files associated with the project.

Each project has a unique project file. A copy of the default project file Default.tcp is 
already open when you start a new project. You can save the file with a new name to 
capture all key information about the project you are creating. The Publication Hierarchy 
pane displays a root publication. The Contents pane is empty.

You use the root publication as a container for the source documents you want to translate, 
their associated templates, the reference pages you want to build, and the output pages that 
Site Builder creates when you translate. You can also add publications to the root 
publication to create a publication hierarchy.

Each publication when added in this way becomes a subpublication, which, in turn, can 
contain source documents, reference pages, templates and output pages. The Contents 
pane displays the contents of whichever publication is selected in the Publication 
Hierarchy pane.

If you open an existing project, the project file name appears in the title bar, the name of 
the root publication appears at the top of the Publication Hierarchy pane and just above the 
Contents pane, and the Contents pane displays the publication’s contents: output pages, 
source documents, and templates.

If you have moved any source documents or removed any output directories since the last 
time you worked in the project, Site Builder will recognize this during project path 
verification as it loads the project file. A series of dialog boxes will appear so that you can 
direct Site Builder to the necessary files or output directories.

Note: Default.tcp is used to create HTML projects in Site Builder. A second default 
project file, DefaultWML.tcp, is available for creating WML projects. See Creating a 
WML Project (page 4-10).
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The Project File
Each project has its own project file, which is used to capture key information about the 
project. The project file helps you create, maintain, and archive a Web publication.

When you start a new project, Site Builder creates an empty project (its name, 
“Unnamed,” appears at the top of the Publication Hierarchy pane and immediately above 
the Contents pane) and opens a default project file (“Unsaved” displays in the title bar).

When you save a project file, you capture the following information about the publication:

! The Publication Hierarchy (page 5-8).

! The names of the output page that Site Builder will create when it translates the source 
documents and builds any reference page.

! The full path and file name of each source document.

! The template associated with each source document and the formatting instructions 
that each template contains

! The output directory for the output pages and any graphics files

When you open an existing project file, the Publication Hierarchy pane displays the 
publication hierarchy and the Contents pane displays key information for each 
publication: output pages, location of source documents, and templates. (The output 
directories can be viewed in the Publication Properties dialog box.)

If you have moved the project file, source documents, or any custom graphics since you 
last saved the project file, the Publication Paths Verification dialog box will appear so that 
you can reconcile the paths you are now using with the ones you were using before. See 
Path Verification (page 4-19).

If you are opening a project file from a repository, be sure to select the project file, not 
its companion history file. See Opening a Project File From Content Server (page 5-23).

The History File
When you create a project file, Site Builder automatically creates a companion history file, 
which it uses to track the date and time-stamp of each source document. As a result, when 
you run an incremental translation, Site Builder can identify those documents that have 
been updated since the last translation and translate only those.

So if you create the new project file “My Project,” Site Builder will create two files: My 
Project.tcp (the project file) and My Project.tch (the history file). Should you delete the 
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history file, Site Builder will create a new one and run a full translation the next time you 
translate, even if you choose Translate for an incremental translation.

When you check a project file into Content Server for the first time, you actually check in 
both the project file and its companion history file, but you won't be aware of checking in 
the latter and you won’t see it in Content Server. When you check out the project file, the 
history file is automatically checked out, too. As with source documents, you are always 
working with temporary versions of both the project file and the history file.

To reduce file size, both project and history files are automatically zipped by Content 
Publisher. (Though zipped, they retain their .tcp and .tch extensions.)

Project Setup
The process of setting up a project for translation takes place primarily in the main 
window. It consists of:

! Opening a new project

! Adding subpublications to the root publication, if necessary

! Adding source documents to each publication in the publication hierarchy

! Associating templates with those source documents

! Adding reference pages to each publication

! Designating output directories

! Creating a frameset for each publication, if necessary

! Saving key data in a project file

Once project setup is complete, you can begin editing the templates associated with the 
source documents. You select each template, in turn, in the Contents pane and work 
through each of four property sheets to set the various options that determine how the Web 
pages you create will look and behave.

The four property sheets—Element Setup, Formatting, Navigation, and Globals—can 
be opened from the Template menu, the standard toolbar, and the Edit Template dialog 
box.

You can use them in any order, but for a new publication, you should start with Element 
Setup. Any fine-tuning of elements or changes to ranks, styles, or patterns should be done 
before you start formatting the templates. Element Setup is especially important if you’re 
working with a manually formatted document.
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Editing the Default Project File
Default.tcp, the default project file, is installed in your Content Publisher directory. A 
copy of the file opens each time you start a new project in Site Builder.

You may want to edit this file, for example, to import some templates from a previous 
version of Site Builder so that these are available each time you start a new project in 
version 10gR3. Before doing so, you should create a backup file, Default.bak, and also 
export the templates to create standalone files, if you haven’t already done so.

1. Start Site Builder. A copy of Default.tcp opens by default (the title bar simply reads 
<Unsaved>, while the root publication in the Publication Hierarchy pane is 
“Unnamed”).

2. Click Manage Template ( ) on the toolbar.

3. In the Manage Template dialog box, click the Import button to open the Template 
Import dialog box.

4. Locate the folder containing the template file you want to import. Select the file and 
click Open.

5. Your template is now listed in the Manage Templates dialog box (as an internal 
template).

6. Click OK to return to the main window.

7. Click Save As to open the Save As dialog box. Locate and select Default.tcp in the 
Content Publisher directory.

8. Click Save.

However you edit the default project file, the changes will be immediately available each 
time you start a new project. (You can even change some of the default template settings. 
To do this, add some source documents to activate the template commands, make the 
template changes you want, and then delete the source documents before you save the 
project file as Default.tcp, writing over the existing file.)

If you want, you can continue to use the Default.tcp file shipped with earlier versions 
of Site Builder, by copying the old file into your Site Builder directory. (To avoid 
overwriting the default project file shipped with Site Builder 10gR3, you may want to 
first create a backup copy of the older version of the default project file.) 

Version 7.2, 7.5, and 7.6 project files will automatically run in version 10gR3. If your 
previous default project file is pre-7.2, when you open Site Builder with that project file, 
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click Save when the Site Builder dialog box appears. This will convert the old project file 
to the new format. 

If the installed version of Default.tcp becomes corrupted or ever needs to be replaced for 
whatever reason, you can find a copy of the file in the Support folder on your Content 
Publisher product disc.

For more information about templates, see Managing Templates (page 6-12).

About the Default Project File
Each time you start a new project, Site Builder opens a copy of Default.tcp, the default 
project file. As a result, several existing templates (Administration, etc.) are already part 
of the project. These are intended to help new users create great-looking Web pages on 
their first try.

Each template contains basic formatting for certain styles (Title, Heading 1, etc.), as well 
as three character patterns (HTTP, WWW, Email), which can be used to create live Web 
or email links. See Template Summary (page 6-3) for more about default settings.

Default.tcp is in the Content Publisher directory. So if you want to change the settings of 
the default project file, start a new project and change the project and template settings, as 
necessary. See Customizing the Default Project File (page 4-6) for more information.

Before you change Default.tcp, you should save the original as Default.bak so that it is 
always available as a backup.

Default.tcp is used to create HTML projects in Site Builder. A second default project 
file—DefaultWML.tcp—is available for creating WML projects. See Creating a WML 
Project (page 4-10) for more information.

Customizing the Default Project File
Each time you start a new project, Site Builder opens a copy of Default.tcp, the default 
project file, which contains a number of templates. (See About the Default Project File on 
page 4-6.)

You can easily change these templates and make a modified Default.tcp available to 
others in your organization who are using Site Builder. By copying this file into their 
Content Publisher directory, other users will have the same default settings available each 
time they start a new project. This is especially useful if you use standard style sheets or 
want to create a specific look and feel for your Web site.
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The following are ways to customize the default project file:

Deleting a template—You can delete a template in Default.tcp at any time. For more 
information, see Deleting a Template (page 6-5).

Importing a template—You may want to import a template from one project into 
another. Also, if you have modified a template in a particular project and realize you want 
the modified version to be available by default each time you start a new project, you can 
export the template from that project and import it into Default.tcp, overwriting the 
template of the same name in Default.tcp in the process. See Importing a Template 
(page 6-13).

Modifying a template—You can use the many editing options throughout Site Builder. 
But first you must add a document to the new publication to associate with each template 
you want to modify. You can delete this document later, when you’ve made your changes 
to the templates and are ready to save Default.tcp.

Ideally, this document should contain the styles from a style sheet you plan to use for your 
Web publishing activities. Alternatively, it could contain text formatting common to your 
manually formatted source documents, or be a document containing just two styles, Title 
and Heading1, with sample text associated with each style.

Before modifying any of the templates in Default.tcp, see Template Summary (page 6-3).

Changing a template name—Once you modify a template, you may want to change its 
name. A name such as “Policy and Procedures” or “Press Releases” may be more 
meaningful than “Administration,” and could suggest which source documents should be 
associated with the template. See Template Names (page 6-7).

Creating a new template—You can create new templates at any time, and re-associate 
templates with source documents whenever you want. See Creating a New Template 
(page 6-4).

Project Options
Project options are specific to the project and are therefore saved with the project file. 
They apply to your project whether you run it locally, export the project file to a network 
location, or schedule the project for translation by Site Server. The Project Options dialog 
box has three tab dialogs, containing the following settings:

Note: Before you change Default.tcp, you should save the original as Default.bak so that it 
is always available as a backup.
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General
! HTML Generation—Gives you the option of choosing Windows-specific characters 

instead of the ISO Latin-1 character set supported by HTML. See HTML Generation 
(page 5-109).

! Output Character Set—The default Unicode option ensures that the widest possible 
array of characters is available for your output. Not supported by older browsers 
(version 2.0 and earlier). See Output Character Sets (page 5-108).

! Containing frame name—The link used to navigate between frames. Should be 
changed if your publication is to be placed within an existing frameset. See Targeting 
a Frameset (page 5-65).

! Publish with errors—The option to publish a project even where Site Builder has 
failed to translate one or more source documents. See Publishing With Errors 
(page 8-11).

! No Script Support—Add any text to be displayed in your browser when an output 
page contains scripts and the browser may not support them. The addition of text for 
No Script Support isn’t generally required, because Web publications built with Site 
Builder will still function when scripting is turned off. The only time you might want 
to use this feature is when you have created a Web publication that includes the Print 
button and you are not certain that all users will be able to use this functionality 
successfully.

File Naming
! File Names—Check Force all file names to lower case if the files you create will be 

passed to a case-sensitive server, such as a Unix machine. Note that Use ISO 9660 
compliant file names not only forces all output file names to upper case but also 
truncates any long names to eight characters. See Complying With ISO 9660 
(page 5-107).

! Output name prefix—The option to add a prefix to output files in a publication. See 
Adding a Prefix to Output File Names (page 8-79).

Map File / Print Publication
! Map file—Use to create an XML file that describes the output of your project on the 

Web site. See Map File (page 6-142).

! Print Publication—Reference to the script required in order to use the Print button. 
See Printing the Publication (page 6-141).
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Repositories
! Output page name—See Output Page Names (page 5-105).

! Enable conditional disclosure—See Conditional Disclosure (page 8-53).

You can also set application options in Site Builder, which apply to whatever projects are 
translated on that machine. See Application Options (page 3-14).

Setting Project Options
The Project Options dialog box contains a number of options that are saved with your 
project file and apply to that project wherever it is run. You can change these settings, if 
you want.

1. Click Project Options on the View menu to open that dialog box.

2. Click the tab to open the appropriate tab dialog.

3. Under the appropriate heading, change the setting for the option you want to change.

4. Click OK.

Versioning the Project File
With an existing project open in Site Builder, you can create a new version of the project 
file at any time. You can also add comments to the document information for the project 
file.

When you schedule a project for translation on Site Server, you can choose to overwrite 
the existing version of the project file in the content server or create a new version.

1. With your project open in Site Builder, click Save ( ) on toolbar or choose Save 
from the File menu. The Project Check In (New Revision) dialog box opens.

2. In the Comments box, type any information you want to associate with the new 
version you are creating. (You can change any of the editable values.)

3. Click the Assign Info button to save your comments with the new version of the 
project file. The Project Check In (New Revision) dialog box closes.

If you want to create a new project file based on an existing project file, use the Save As 
command instead. In the Project Check In dialog box, you can give the project file a new 
name and change any of the properties of the original project file.

Follow these steps to create a new version of a project file in Site Server:
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When you schedule projects for translation by Site Server, you can choose to overwrite the 
version of the project file in Content Server or create a new version each time the project 
runs.

1. Open Site Scheduler (click Site Scheduler on the Server menu in Site Builder).

2. Click New ( ) on the toolbar to open the New Task dialog box.

3. Select Content Server from the Repository drop-down list, and then click Browse 
opposite the Project text box.

4. In the Select a Project dialog box, conduct a search for project files and then click the 
appropriate Select button for the one you want to schedule.

5. The Select a Project dialog box closes and the Content Publisher dialog box opens.

6. Click Yes to create a new revision of the project file in Content Server or No to 
overwrite the latest version in the content server. If you click Yes, a new version of the 
project file will be created each time Site Server runs the project and there has been a 
“meaningful” update (e.g., new documents have been added to a Directory Item).

7. Complete the other information in the New Task dialog box, as appropriate.

Copying a Project File
You can copy a project file just like any other file. You may want to do this to shortcut the 
process of creating a new project.

For example, you might want to create a new project using some or all of the templates of 
another project but none of the documents of that project. Once you copy the project file, 
you can delete all the documents in the project and retain the templates.

To copy a project file, open the project file and immediately save it under a new name.

Alternatively, if the file is in the file system, you can copy a project file in Windows 
Explorer just as you would any other file.

Creating a WML Project
You can create a WML project in Site Builder, publishing your WML output to a WAP 
server for it to be available via Internet-ready phones.

For more information on WML projects, see “Creating a WML project,” a PDF file in the 
Documentation folder of your Content Publisher directory (the file is also available on 
your Content Publisher product disc).
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Starting a Project
Each time you start Site Builder a default project file is already open. If you open an 
existing project, the project file name appears in the title bar and project details appear in 
the Publication Hierarchy and Contents panes.

Follow these steps to start a new project:

1. Do one of the following:

! On the Startup Screen, select Blank Publication and click OK.

! Click New ( ) on the toolbar.

! Choose New from the File menu.

2. In the Publication Properties dialog box, type over “Unnamed” to name the new 
publication. Change the default output directories, if you want.

You have named the publication. You still have to name the project file, which you do by 
choosing Save As from the File menu.

Follow these steps to start an existing project:

1. Do one of the following:

! On the Startup Screen, select Open an existing publication and click OK.

! Click Open ( ) on the toolbar.

! Choose Open from the File menu.

2. In the Select a Repository dialog box, select the repository containing the project file 
you want to open.

3. If you select the file system, the Open dialog box will open. Locate the appropriate 
drive and folder, open the folder, and select the project file.

4. If you select Content Server, and more than one content server is registered on the 
machine on which Site Builder is running, the Choose a Content Server dialog box 
will open. From the drop-down list, select the content server in which the project file 
resides, and click OK.

5. On the Search page, search for the project file you want to open. Click Select to open 
the file.

Alternatively, you can open an existing project by choosing one of the project files listed 
at the bottom of the File menu ( Site Builder lists the last four projects you worked on).
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Saving a Project File
When you save a project file you save key information about the project, including the 
publication hierarchy, the names of all output pages, the path and file name of each source 
document, the template associated with each source document, and the location of output 
directories.

The next time you open the project file, the Publication Hierarchy pane will display the 
publication hierarchy, and the Contents pane will initially display key details of the root 
publication.

Follow these steps to save a new project file:

1. From the File menu, choose Save As to open that dialog box.

2. In the File Name text box, type over “Unnamed.tcp” to give the project file a new 
name. Change the drive and path for the new project file, if necessary.

3. Click Save.

Follow these steps to save an existing project file:

1. Choose Save ( ) on the toolbar, or Choose Save from the File menu.

2. If the file is in Content Server, the Assign Project Check In (New Revision) dialog box 
will open. Enter comments in the Comments box, if appropriate, and click the Assign 
Info button.

You can save a project file to the file system or Content Server, but not to an FTP or HTTP 
site. (See Creating a Project File in Content Server on page 5-20.)

You select the appropriate repository in the Select a Repository dialog box, which should 
open when you click Save As to save a new project file. If you need to display this dialog 
box, click Application Options on the View menu and then switch to the Dialogs tab 
dialog to select the appropriate option.

If you are saving the file to Content Server and you have more than one content server 
registered on your machine, the Choose a Content Server dialog box will open for you to 
choose the content server you want to save the file to.

Note: You can switch from one project to another at any time. Selecting a different project 
closes the current one, so it is a good idea to choose Save before you click Open. (Site 
Builder prompts you to save changes if you forget.)
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EXPORTING A PROJECT
This section covers the following topics:

! Project Export Wizard (page 4-13)

! Starting the Project Export Wizard (page 4-14)

! Checking Output Directories (page 4-15)

! Checking Source Directories (page 4-16)

! Editing the Destination Directories (page 4-16)

! Ready to Export (page 4-17)

Project Export Wizard
Once you create publications in Site Builder, you may want to move them to a shared 
directory on the network so that they can be placed on a Web site. Or you may simply 
want to transfer them to a co-worker. You can do this easily with the Project Export 
wizard.

The Project Export wizard can copy the project file, all source documents, and custom 
graphics to any shared directory in your organization's network. It also “fixes up” the 
project file in the process.

The wizard can copy just the project file or all of the following files to the shared network 
location:

! project file

! source documents

! custom graphics (including those from the gallery)

! associated files

With the wizard, you specify the directories containing the files to be copied. The wizard 
copies only project-related files from those directories. Any graphics linked to source 
documents should be listed in the Associated Files dialog box; otherwise, they will have to 
be copied separately to the new location and possibly re-linked.

The wizard does not move a linked template. If a project file contains a link to an external 
template in a network location, the assumption is that the project file will still have access 
to the location after it is moved.
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When you export project files using the wizard, Site Builder generates a report 
summarizing all the directories and files for the publication. The report project.pfl, where 
“project” is the name of the project file) is placed in the original source directory of the 
project file.

Starting the Project Export Wizard
Once you create publications in Site Builder, you may want to move them to a shared 
directory on the network so that they can be placed on a Web site. Or you may simply 
want to transfer them to a co-worker. You can do this easily with the Project Export 
wizard.

The Project Export wizard can copy the project file, all source documents, custom 
graphics, and associated files to any shared directory in your organization's network. It 
also “fixes up” the project file in the process.

Starting Project Export wizard
You are ready to use the wizard once you have a completed, saved project currently open 
in Site Builder.

1. In Site Builder, click Project Export Wizard ( ) on the toolbar.

2. On the Welcome screen, enter the path and name of the shared directory in the Shared 
Destination Directory text box, or click Browse to locate the directory you want to 
use.

3. Click Next.

If as you work through the wizard you are in doubt about a particular option, click the 
Help button for a topic that provides information specific to that screen.

You can select this check box to copy the project to the same shared directory as before. 
You will still have to move through each screen, in turn, to finish the wizard. But all the 
information will be completed in the appropriate text boxes already. You can change the 
pre-set information if you like.

Note: When you move a project for the first time, Project Export wizard captures all the 
essential details about the move. The next time you start the wizard with that project open 
in Site Builder, the Welcome screen displays the check box Use Record of Previous 
Export to Expedite This Export.
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Checking Output Directories
The Project Output Directories screen shows the current path and proposed path for output 
directories. The Project Source Directories column displays the current output directories, 
as specified in the project file. The Project Destination Directories displays the proposed 
output directories, as set when you chose a shared directory on the network.

A project can, of course, have multiple output directories. Entries in white show the full 
paths you set for the output files in your project. You can edit and modify these paths by 
selecting an output directory and clicking the Edit Destination Directory button to open 
that dialog box. Any entries in gray are for output directories that have relative paths. 
These are read-only.

1. Select the subdirectory you want to change and click Edit Destination Directory to 
open that dialog box.

The current path for the selected subdirectory displays in the Original Project 
Directory text box. The path to the shared directory is in the Current Destination 
Directory text box. The third text box, New Destination Directory, is where you 
specify a new path for the selected subdirectory.

2. When you first enter the Edit Destination Directory dialog box, the paths in the 
Current Destination Directory and New Destination Directory text boxes are the same. 
Edit the path in the New Destination Directory text box to reflect the location you 
want to use. Use the Browse button, if necessary, to locate the new directory.

When you change a path for any directory listed in the Project Output Directories 
dialog box, you also change the paths for all directories listed below that directory in 
the Project Destination Directories list where a lower directory has the first directory 
as a stem.

3. When you have edited the path, click OK to return to the Project Output Directories 
dialog box.

4. Click Next to move to the next screen.

Note: The check box at the top of the screen determines whether any fixups will be done 
to the project file for destination directories. If the box is not checked, the project file will 
be copied to the destination directory, but no output destination paths will be modified.
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Checking Source Directories
In the Project Source Directories screen, the wizard lists the paths of the directories 
containing all files referenced in the project file. The first column shows the current 
directories, as listed in the project file. The last column displays those same paths, with the 
proposed destination (shared directory) replacing the original drive (or the UNC 
equivalent of the original).

By default, all project-related files will be copied to the shared directory, as the green 
check marks in the Copy File column signify. You can choose not to copy files in a 
particular directory. You can also edit the destination directory.

UNC stands for Universal Naming Convention. For example, \\News\Share might be the 
UNC equivalent of the drive S:\.

Follow these steps to change the copy status of a subdirectory:

1. Select the appropriate subdirectory.

2. Click Change Copy Status.

The green check mark in the Copy File column changes to a red cross. Any project-related 
files in that directory will not be copied. You can use the Shift and Ctrl keys with the 
mouse to select multiple directories.

Follow these steps to edit a destination directory:

1. Select the directory you want to edit, and click Edit Destination Directory to open 
that dialog box.

2. Press F1 in the Edit Destination Directory dialog box if you need assistance.

Editing the Destination Directories
In the Project Source Directories screen the wizard lists the paths of the directories 
containing all files referenced in the project file. The first column shows the current 
directories, as listed in the project file. The last column displays those same paths, with the 
proposed destination (shared directory) replacing the original drive (or the UNC 
equivalent of the original).

Note: The check box at the top of the screen determines whether any fixups will be done 
to the project file for source directories. If the box is not checked, the project file will be 
copied to the destination directory, but no source paths will be modified.
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The Edit Destination Directory dialog box is also used to edit project output directories, in 
which case references to “Project Source Directories” should be read as “Project Output 
Directories.”

1. Select the directory you want to edit, and click Edit Destination Directory to open 
that dialog box.

The current path for the selected directory displays in the Original Project Directory 
text box. The path to the shared directory is in the Current Destination Directory text 
box. The third text box, New Destination Directory, is where you specify a new path 
for the selected directory. When you first enter the Edit Destination Directory dialog 
box, the paths in the Current Destination Directory and New Destination Directory 
text boxes are the same.

2. Edit the path in the New Destination Directory text box to reflect the new location you 
want to use for this directory. Use the Browse button, if necessary, to locate the 
directory.

When you change a path for any directory listed in the Project Source Directories 
dialog box, you also change the paths for all directories listed below this directory in 
the Destination Project Directory column where a lower directory has the first 
directory as a stem.

3. Click OK to return to the Project Source Directories dialog box.

4. Select another directory to edit and click the Edit Designation Directory button, or 
click Next to move to the next screen of the wizard.

Ready to Export
1. Clear the Generate Project File List check box if you do not want the wizard to 

generate a report summarizing all directories and files for the project. If you generate a 
report, its name will be project.pfl (where “project” is the name of the project file), 
and it will be placed in the same directory as the project file.

2. In the Current Settings box, review both the original and the proposed directories for 
the project.

3. Click Finish.

The Confirm File Replace dialog box will appear as the wizard begins to copy all project-
related files to the destination directory in the event that a source file will overwrite an 
existing file in the shared directory. Also, the wizard creates directories, as necessary, to 
complete the project export operation.
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PATH CONFLICTS
This section covers the following topics:

! Causes of Path Conflicts (page 4-18)

! Resolving Conflicting Paths (page 4-18)

! Path Verification (page 4-19)

! Path Verification Complete (page 4-20)

! Replacing a File or Directory (page 4-20)

Causes of Path Conflicts
When you open an existing project, Site Builder runs a “path verification” to verify all 
paths in the project file for source documents, output directories, and any referenced files 
(graphics, HTML, etc.) used to create your Web pages. A dialog box appears briefly 
onscreen as it does this.

Path conflicts can occur for several reasons:

! The project file has been moved since you last used it.

! The source documents have been moved since the project file was last saved, and so 
the paths are no longer valid.

! The source documents have been renamed.

! The output directories specified in the project file no longer exist.

! Graphics specified in the project file for the Web pages cannot be located. (Site 
Builder doesn’t check graphics linked to the source documents, only graphics from the 
Gallery or elsewhere used for navigation buttons, visual aids, and backgrounds.)

! Graphics specified in the template cannot be located.

Resolving Conflicting Paths
When you open an existing project, Site Builder runs a “path verification” to verify all 
paths in the project file for source documents, associated files, output directories, and any 
graphics used to create your Web pages. It also does this when you import a template, to 
be sure all the graphics specified in the template can be found.
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The Project Path Conflict dialog box appears if it encounters duplicate paths for a given 
file or directory. This may happen, for example, if you have copied the project file and its 
source documents to another directory, so that these files now reside in two places.

Use one of these methods to resolve conflicting paths:

! Click Use Original Path to use the original path for the file specified in the Original 
Path text box.

! Click Use Original Path Always to use the original path for the file specified in the 
Original Path text box plus all other files that have ambiguous resolutions.

! Click Use Proposed Path to use the proposed path for the file specified in the 
Proposed Path text box.

! Click Use Proposed Path Always to use the proposed path for the file specified in the 
Proposed Path text box plus all other files that have ambiguous resolutions.

After you have verified the paths for the files and directories, Site Builder displays the 
Project File Paths Verification dialog box, which summarizes your changes. You should 
check this carefully to confirm that all files have been successfully re-located and are now 
specified in the project file or template file according to their new path.

You can then click OK to begin work on your project. If you click Cancel, none of the 
changes will be implemented. You can still work in your project, but it will be missing the 
files that couldn’t be verified.

If you click Cancel All Fixups in the Project Path Conflict dialog box, Site Builder 
cancels any fixups you have already approved and return the project file to its original 
state. You will then exit the dialog box.

Path Verification
When you open an existing project, Site Builder runs a “path verification” to verify all 
paths in the project file for source documents, associated files, output directories, and any 
graphics used to create your Web pages. It also does this when you import a template, to 
be sure that all the graphics specified in the template can be found.

A Progress dialog box appears briefly onscreen during the process. If the verification is 
successful, the project opens and the Contents pane displays the source documents, output 
pages, and templates for the root publication. (If you are importing a template, the 
template will now display in the Manage Templates dialog box.)

If a problem is encountered, one of two dialog boxes will appear, depending on the nature 
of the problem.
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! The Project Path Replacement dialog box appears if Site Builder cannot find a file or 
directory specified in the project file or template.

! The Project Path Conflict dialog box appears if it encounters duplicate paths for a 
given file or directory.

Path Verification Complete
When you see the Project Paths Verification dialog box onscreen, Site Builder has 
completed “path verification.” This means it has completed one of two processes:

! the path verification process it runs each time you open a project file or import a 
template

! the path fixup process according to your instructions in the Project Path Conflict 
dialog box or the Project Path Replacement dialog box

You should carefully check the summary of paths for files and directories in the list box to 
be sure that you are not missing any files that are part of the project file or are referenced 
in the template.

If you have completed path fixup to replace missing files or resolve path conflicts, you can 
still cancel these changes by clicking Cancel. In that case, Site Builder will return the 
project file or template file to its original state. Otherwise, click OK to open your project 
or import the template file.

Replacing a File or Directory
When you open an existing project, Site Builder runs a “path verification” to verify all 
paths in the project file for source documents, associated files, output directories, and any 
graphics used to create your Web pages. It also does this when you import a template, to 
be sure that all the graphics specified in the template can be found.

The Project Path Replacement dialog box appears if Site Builder cannot find a file or 
directory specified in the project file or template file.

1. In the second text box in the dialog box, enter the correct path for the file or directory. 
You can type the new path and name or use the Browse button to locate the file or 
directory.

Tech Tip: You may want to copy all or a portion of the summary to the Clipboard so that 
it can be inspected in another program, such as Notepad, and saved, if necessary. Highlight 
the entries to copy and press Ctrl+C, or right-click the selected text and choose Copy from 
the popup menu. Then open Notepad and press Ctrl+V.
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You can use an output directory that does not currently exist. (A directory will be 
created at translation, but only if it is possible to actually create the specified 
directory.)

2. Click Yes to accept the new path if this is the only file or directory that needs to be 
replaced. Click Yes to All if you know there are additional files in the old directory 
that also should be referenced by the new path.

After you have verified the paths for the files and directories, the Project File Paths 
Verification dialog box appears, which summarizes your changes. You can click OK 
to begin work on your project. If you click Cancel, none of the changes will be 
implemented. You can still work on your project, but it will be missing the files that 
couldn’t be verified.

If you click No in the Project Path Replacement dialog box, you will reject any proposed 
new path in the text box and the original path will be retained. If you click Cancel, you 
will cancel all paths already fixed up plus any automatic fixups already performed.
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5.BUILDING A PUBLICATION
This section covers the following topics:

! Publications (page 5-1)

! Choosing a Repository (page 5-8)

! Source Documents (page 5-30)

! Reference Pages (page 5-52)

! Templates (page 5-55)

! Layout Options (page 5-55)

! Directory Items (page 5-88)

! Associating a File With a Publication (page 5-99)

! Output Files and Directories (page 5-100)

! Integrating Third-Party Applications (page 5-109)

PUBLICATIONS
This section covers the following topics:

! About Publications (page 5-2)

! Adding a Linked Publication to a Project (page 5-2)

! Adding a Publication (page 5-3)

! Exporting a Publication (page 5-4)
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! Importing a Publication (page 5-5)

! Updating a Web Publication (page 5-6)

! Publication Properties (page 5-6)

! Publication Hierarchy (page 5-8)

About Publications
There are two types of publications in Site Builder:

! the publication you use as a container to organize source documents for translation

! the Web publication you create when you translate the publication and turn those 
source documents into Web pages to view in your Web browser.

There are two types of Web page: body and reference. Body page is another name for a 
translated source document. Reference page is an optional page that Site Builder builds 
during translation to create a table of contents, index, query, list of figures, or list of tables 
(you can create all five).

Adding a Linked Publication to a Project
Just as you can add a Directory Item as a subpublication to a project, so, too, you can add 
another project. When you add one project as a subpublication to a second project, the first 
project becomes a linked publication (or subproject) and the second project becomes the 
master project. Each time you run a translation of the master project, the contents of the 
linked publication are translated, too.

However, to change a linked publication, you must open the linked publication by itself in 
Site Builder. And the next time you open the master project, you must be sure to use 
Update Versions before translating so that the changes made to the linked publication are 
reflected in the translation of the master project. See Updating a Linked Publication 
(page 8-10).

Linked publications can be especially useful in large projects where a heavy workload and 
complex publication hierarchy demand multiple project authors (and multiple content 
authors). The lead project author can be responsible for the master project, with other 
project authors handling portions (linked publications) of the master project.

Follow these steps to add a linked publication:

1. With your project open in Site Builder, select the subpublication in the publication 
hierarchy that will contain the linked publication.
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2. Click Publication on the Add menu to open the Add Publication dialog box.

3. Click the Linked Publication button, and in the Open dialog box locate the project 
file for the project you want to add as a linked publication.

4. Select the project file and click OK to return to the Add Publication dialog box.

The publication name of the project is used for the name and title of the new 
subpublication you have just created for the linked publication. It is also used for the 
subfolder of output directories. You can change this, if you want.

5. Click OK.

You have now added a linked publication, which appears as a subpublication of the 
publication originally selected. Both the linked publication (in the Publication 
Hierarchy pane) and its contents (as displayed in the Contents pane) are grayed out to 
signify that you cannot edit a linked publication while it is part of a master project. 
You can convert a linked publication into a regular publication at any time.

Follow these steps to convert a linked publication into a regular publication:

1. Right-click the linked publication in the Publication Hierarchy pane.

2. Choose Make embedded from the popup menu.

3. Click Yes in the dialog box that appears.

The publication is now a permanent part of the master project and its contents can be 
edited like those of any other subpublication. (The project file for the linked publication 
still exists in its original location and can be used for other purposes, if you want.)

Adding a Publication
You can add a publication to any other publication in the publication hierarchy. Any 
publication you add becomes a subpublication of the other publication and can be used to 
organize a source document for translation.

1. In the Publication pane, select the root publication or one of the other publications you 
want to add this publication to.

2. Do one of the following:

! Right-click to open a popup menu and choose Add Publication.

! Click the Add Publication button ( ) on the toolbar or large toolbar.

! Choose Publication from the Add menu.
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When you add a publication to the publication hierarchy, you name the publication. You 
can also give it a title that will display at the beginning of the Web page you create. And 
you can designate output directories for the output pages and for the graphics you convert 
during translation.

These options are all properties of the publication. They can be changed at any time by 
right-clicking the publication name in the Publication Hierarchy pane and choosing 
Properties from the popup men to open the Publication Properties dialog box.

You can also add a linked publication (see Adding a Linked Publication to a Project on 
page 5-2) to a project, that is, link a second project to an existing one by creating a special 
subpublication.

Exporting a Publication
To export and import publications in Site Builder, you use the appropriate commands 
from the File menu. When you export you simply create a project file for the publication. 
You then use that project file to import the publication into another project.

1. Open the project containing the publication you want to export.

2. In the Publication Hierarchy pane, select the publication you want to export. Whatever 
publication you select, you export that publication plus all it contains.

3. Click Export Publication on the File menu to open the Save As dialog box.

4. By default, Site Builder creates a project file name, using the name of the publication 
you’re exporting. It’s probably best to keep the same name when you export and 
import publications in this fashion.

5. Use the Save In drop-down box to locate the directory you want to save the new 
project to.

6. Click Save to return to the main window.

The new project file you have just created contains information about source documents, 
reference pages, formatting in templates, and even other subpublications (if any) and their 
contents.

Another way to

publications between two different projects is to have two instances of Site Builder open at 
the same time and to use the Cut and Paste commands.
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Importing a Publication
To export and import publications in Site Builder, you use the appropriate commands 
from the File menu. When you export you simply create a project file for the publication. 
You then use that project file to import that publication into another project.

Once you’ve imported the publication, the project file still exists on whatever directory 
you saved it to, but it’s no longer relevant to the new project, since the imported 
publication is now part of another project file.

1. In the Publication Hierarchy pane, select the publication you want to add the imported 
publication to.

2. Choose Import Publication from the File menu. In the Open dialog box, use the 
Look In drop-down box to locate the project file for the publication to be imported.

3. Select the project file and click Open.

At this stage, the Project Paths Verification dialog box will appear, because the paths 
of files in the project file you’re importing have not yet been verified by Site Builder 
for the project file of the existing publication. If you need assistance, click the Help 
buttons in the dialog boxes that appear for path verification.

4. The Change Template Name dialog box may also appear, if the project file you’re 
importing contains a template with the same name as one in the existing publication. If 
the templates have different settings, change the name of the template being imported, 
and click Yes. (If they’re the same, you can overwrite the existing template.)

Site Builder lets you to give the template you’re importing a new name so that you won’t 
overwrite the same template in the existing publication. If you want to associate the source 
documents in the imported publication with the template in the existing publication, you 
can simply import the publication with its renamed template, and then re-associate its 
source documents with the template in the existing publication later.

Another way to move publications between two different projects is to have two instances 
of Site Builder open at the same time and to use the Cut and Paste commands.

Tech Tip: If you are creating a new project from a publication you exported from another 
publication, start Site Builder and choose Open from the File menu to locate the project 
file you created when you exported the publication.
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Updating a Web Publication
When you update a Web publication, you change content, formatting, or both.

! You change content by editing the source documents.

! You change formatting by making the appropriate changes to the templates used in the 
publication and saving those changes to the project file.

If you add new styles or create new patterns in your source document, you'll need to either 
re-import the styles from the source document before retranslating it, or create new styles 
and elements in the template, using the same names as the new styles in the source 
document. (See Importing New Styles From a Source Document on page 6-47.)

It is best to make content changes in your source document in most instances. Because 
once you create a Web page with the original source document and its associated template, 
updating that page is simple.

Publication Properties
The properties of a publication consist of its name, its title, the output directory used to 
store the output pages generated during translation of its source documents and also each 
graphic converted during translation, and any text you choose to include in the Map file.

You can use different output directories for each body page and the graphics files created 
when Site Builder converts the graphics in the source documents. (A publication’s output 
directories are applied by default to all of its source documents and thus become properties 
of those documents, too.) In the case of a root publication, you can also create an output 
directory specifically for Gallery Graphics.

Follow these steps to change a publication’s properties:

1. In the Publication Hierarchy pane, right-click the publication and choose Properties 
from the popup menu to open the Publication Properties dialog box (or choose 
Properties from the Publication menu).

2. To change the publication name, type the new name over the existing one.

3. Type a new title, if necessary, to replace the default one (by default, Site Builder uses 
the publication name for the title).

4. In the Map file property text box, enter any information you want to appear in the 
publication element in the XML Map file that Site Builder will generate when it 
translates the project.
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5. In the Prefix to be added to all output file names text box, enter the prefix to apply 
to each output file in this publication. See Adding a Prefix to Output File Names 
(page 8-79) for more information.

6. Click Generate JavaScript navigation file to generate TOC.js, a JavaScript file that 
will be created in the Pages output directory. 

TOC.js can be used to build your own navigation scheme. It summarizes the output 
Web pages for the project by output name and title (the latter as created in document 
properties for each source document or reference page). TOC.js for the root 
publication includes entry points for all subpublications, consisting of the first 
reference page or document in each subpublication. To generate greater detail, you 
can create a TOC.js file for each subpublication in the project by selecting this option 
in the Publication Properties dialog box for each subpublication. 

7. To change the output directories, type over the path given or click Browse to locate 
the directory you want to use.

8. To specify an output directory for Gallery Graphics, click Use gallery graphics 
directory and enter the path and name of the directory you want to use, or click 
Browse to locate the directory. (This option is available only for the root publication.) 
Click OK.

9. Select Publication TOC will appear in parent publication if you would like the 
TOC of this publication to be treated as a normal page in the parent publication. This 
option can be useful for navigation. It is not available for the root publication.

10. Click OK to return to the main window.

The Translate and Translate All commands always place your output files on the file 
system, in the output directories specified in the Publication Properties dialog box. The 
Publish command makes copies of all output pages and graphics files from your last 
translation and places these in the locations specified in the Publish Options dialog box. 
The locations can be on your file system or in a repository.

See the Titles tab dialog in Globals for more information on how the title entered in 
Publication Properties can be used.

Tech Tip: If you temporarily don’t want to use the specified directory, clear the check 
box. The directory path and name will be retained. You can simply select the check box 
any time you want to use the directory again.
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Publication Hierarchy
A publication hierarchy consists of the root publication and any subpublication(s), which 
display in the Publication Hierarchy pane.

The publication hierarchy is similar to a directory structure, in that you have a root 
publication instead of a root directory, and publications instead of folders. And just as a 
folder can contain other folders and files, so a publication can contain other publications 
and documents.

The order of publications in the publication hierarchy is important, as is the order of 
documents in each publication. Site Builder translates and links documents in the order in 
which they are listed in publications, and so uses this order to:

! Display body pages once you link them

! Summarize the contents of the body pages in the table of contents

! Determine which style attributes take precedence if you import two styles with the 
same name but different attributes from different source files

CHOOSING A REPOSITORY
This section covers the following topics:

! Selecting a Repository (page 5-8)

! Showing the Select a Repository Dialog Box (page 5-9)

! Adding Content From an FTP Server (page 5-10)

! Adding Content From an HTTP Server (page 5-13)

! Adding Content From Content Server (page 5-16)

Selecting a Repository
You can add documents from different sources: the file system, an FTP site, an HTTP site, 
or Content Server.

The Select a Repository dialog box opens by default the first time you add a source 
document (see Adding a Document on page 5-31) or a Directory Item (see Adding a 
Directory Item on page 5-89) to a project. Once you select a repository from the drop-
down list, you can hide this dialog box from view as you work in Site Builder. If you later 
want to add source documents or Directory Items from another source, you need to show 
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the Select a Repository dialog box again (see Showing the Select a Repository Dialog Box 
on page 5-9).

You can create a project by adding documents and directory items from different 
repositories. To do this, you would want the Select a Repository dialog box to open each 
time.

Showing the Select a Repository Dialog Box
In Site Builder you can work in your file system or in Content Server. You can also add 
documents to a publication from an FTP or HTTP site.

You make your selection in the Select a Repository dialog box, which opens by default 
the first time you add a source document (see Adding a Document on page 5-31) or a 
Directory Item (see Adding a Directory Item on page 5-89) to a project. Once you select a 
repository from the drop-down list, you can hide this dialog box from view as you work in 
Site Builder.

If you later want to add source documents or Directory Items from another source, you 
need to show the Select a Repository dialog box again.

1. Click Application Options on the View menu to open that dialog box.

2. Click Dialogs to open that tab dialog.

3. Select the check box Show Select a Repository dialog box when adding a source 
document or directory item to a publication.

4. Click OK.

The Select a Repository dialog box will open the next time you choose the Add Document 
or Add Directory Item command. You can show or hide the dialog box at any time by 
selecting or clearing this option.

This setting is user-specific on a given machine. It applies to all projects run on the 
machine by the user logged in at the time of the change.

You can create a project by adding documents and directory items from different sources. 
To do this, you would want the Select a Repository dialog box to open each time.
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Adding Content From an FTP Server
This section covers the following topics:

! Adding a Directory Item From an FTP Site (page 5-10)

! Adding a Document From an FTP Site (page 5-11)

! Updating Source Documents From an FTP or HTTP Site (page 5-12)

! Adding Multiple Language Documents From an FTP Server (page 5-13)

Adding a Directory Item From an FTP Site
You can select a Directory Item from different repositories, including an FTP site. See 
Adding a Directory Item From the File System (page 5-89) for information on selecting a 
repository and choosing a template. Once the FTP Source Directory dialog box opens, do 
the following:

1. Under Destination, enter the FTP server name. Neither the protocol (ftp://) nor a 
closing forward slash is required.

Example ftp.oracle.com.

2. Under Login Credentials, click Use Anonymous FTP if you are accessing an FTP site 
as an anonymous user. If you require an FTP user account, click Use specific 
credentials and enter both your user account and password.

3. Click Use specific server TCP/IP port if the server at the FTP site you are 
connecting to does not use the standard FTP port. Then enter the port number in the 
box.

4. Click Browse to open the Browse for Directory dialog box. Locate the directory you 
want to add to the project and click OK to return to the FTP Source Directory dialog 
box. The Path To Source Documents text box displays the path and name of the 
selected directory.

5. In the Wildcard specification text box, accept the default *.* if you want to include 
all files in the directory to your project. (Site Builder will translate only supportable 
file formats). Alternatively, specify the file formats you want to use, using semicolons 
to separate the entries.

Example *.doc;*.123;*.wpd

6. Click OK to leave the FTP Source Directory dialog box and return to the New 
Directory Item Properties dialog box. Once you have completed the other required 
information in this dialog box, click OK to return to the main window.
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You can add a Directory Item from any FTP site that you can connect to. But when using 
“Anonymous” you may find that you are restricted to certain levels of files (which may 
also be the case with an FTP user account).

If you are connecting to the FTP site through a proxy server, click Proxy in the FTP 
Source Directory dialog box to open the Proxy Settings dialog box (see Proxy Settings for 
an HTTP Site on page 8-65).

You can also add a Dynamic Directory Item from an FTP site. See Adding a Dynamic 
Directory Item From the File System or an FTP Site (page 5-93) for more information.

Adding a Document From an FTP Site
You can select source documents from different repositories, including an FTP site. See 
Adding a Document From the File System (page 5-31) for information on selecting a 
repository and choosing a template. Once the FTP Source Document dialog box opens, 
do the following:

1. Under Destination, enter the FTP server name. Neither the protocol (ftp://) nor a 
closing forward slash is required.

Example: ftp.oracle.com

2. Under Login Credentials, click Use Anonymous FTP if you are connecting to an FTP 
site as an anonymous user. If you require an FTP user account, click Use specific 
credentials and enter both your user account and password.

3. Click Use specific server TCP/IP port if the server at the FTP site you are 
connecting to does not use the standard FTP port. Then enter the port number in the 
box.

4. Click Browse to open the Browse for File dialog box. Locate the document you want 
to add to the project and click OK to return to the FTP Source Document dialog box. 
The Source Document Path text box displays the path and name of the document you 
have just added.

You can add only one document at a time from an FTP site.

5. Click OK to leave the FTP Source Document dialog box. The Choose Template 
dialog box will open so that you can associate a template with the source document.

You can add documents from any FTP site that you can connect to. But when using 
“Anonymous” you may find that you are restricted to certain levels of files (which may 
also be the case with an FTP user account).
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If you are connecting to the FTP site through a proxy server, click Proxy to open the 
Proxy Settings dialog box (see Proxy Settings for an FTP Site on page 8-61).

The source documents you translate must have file extensions; otherwise, you will not be 
able to publish successfully.

Updating Source Documents From an FTP or HTTP Site
When you start a new project and add source documents from an FTP or HTTP site, Site 
Builder makes copies of those documents, places them in a temporary directory on the file 
system, and translates the copies. Site Builder will continue to use those copies for 
translation during your current session in Site Builder unless you formally update the 
source documents.

So if there is a delay between the first time you translate and the last time you translate 
before publishing, you should update the copies of the source documents in the temporary 
directory.

To update source documents from an FTP or HTTP site, click Update Versions ( ) 
on the toolbar.

Copies of the latest versions of the source documents on the FTP or HTTP site have been 
placed in a temporary directory on your file system. You can now translate one last time 
and then publish. (See Update Versions Command on page 8-9.)

Because Site Builder copies source documents only when they are “requested,” the Status 
column in the main window may be misleading. You may see a green check mark even 
though a more recent version of a document is available from an FTP or HTTP site. So 
always click Update Versions (see Update Versions Command on page 8-9) before your 
final translation. If a green check mark opposite a document turns to a red cross, you’ll 
know that Site Builder has just copied an updated version of that document into the 
temporary directory, ready for translation.

Note:  Site Builder copies a source document the first time it is “requested.” This could be 
when you associate a template with the source document in the Choose Template dialog 
box (with the preview functionality turned on), when you preview the document in the 
Edit Template dialog box, or when you first translate the document. Also, Site Builder will 
delete the temporary file each time you close the project and create a new one the next 
time you start the project and the document is first requested.
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Adding Multiple Language Documents From an FTP 
Server
Content Publisher accepts documents of all languages from an FTP server as long as the 
FTP server can properly read and process the file names and the paths of the source 
documents. If you add a source document to a publication from an FTP server that does 
not recognize the language used in the document’s file name or path, you will receive a 
“Preview Fail” error, and the process will close. 

To resolve the problem, change the filename (and if necessary the path to the file) to a 
language that the FTP server will recognize. Alternatively, move the source documents to 
an FTP server that matches the language used in the source documents.

Adding Content From an HTTP Server
This section covers the following topics:

! Adding a Directory Item From an HTTP Site (page 5-13)

! Adding a Document From an HTTP Site (page 5-14)

! Updating Source Documents From an FTP or HTTP Site (page 5-15)

Adding a Directory Item From an HTTP Site
You can select a Directory Item from different repositories, including an HTTP site. See 
Adding a Directory Item From the File System (page 5-89) for information on selecting a 
repository and choosing a template.

You can only add a directory from an HTTP site if the server for that site provides virtual 
directory listings.

After the HTTP Source Directory dialog box opens, do the following to add a Directory 
Item from an HTTP site:

1. Under Destination, enter the HTTP server name. Neither the protocol (http://) nor a 
closing forward slash is required.

Example www.oracle.com.

2. Under Login Credentials, click Use anonymous connection if you are connecting to 
an HTTP site as an anonymous user. If you require an HTTP user account, click Use 
specific credentials and enter both your user account and password.
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3. Click Use specific server TCP/IP port if the server at the HTTP site you are 
connecting to does not use the standard HTTP port. Then enter the port number in the 
box.

4. In the Path to Source Documents text box, enter the path and name of the directory 
you want to add to your project.

To specify the directory you want to add to your project, you can open the HTTP site 
in your browser and select the directory from the directory listing. Then copy the URL 
from the Address or Location bar and paste it into the Path to Source Documents text 
box.

5. In the Wildcard specification text box, accept the default *.* if you want to include 
all files in the directory to your project. Site Builder will translate only supportable file 
formats). Alternatively, specify the file formats you want to use, using semicolons to 
separate the entries.

Example *.doc;*.123;*.wpd

6. Click OK to leave the HTTP Source Directory dialog box and return to the New 
Directory Item Properties dialog box. Once you have completed the other required 
information in this dialog box, click OK to return to the main window.

You can add a Directory Item from any HTTP site that you can connect to. But when 
using “Anonymous” you may find that you are restricted to certain levels of files (which 
may also be the case with an HTTP user account).

If you are connecting to the HTTP site through a proxy server, click Proxy in the HTTP 
Source Directory dialog box to open the Proxy Settings dialog box (see Proxy Settings for 
an HTTP Site on page 8-65).

The source documents you translate must have file extensions; otherwise, you will not be 
able to publish successfully.

Adding a Document From an HTTP Site
You can select source documents from different repositories, including an HTTP site. 
See Adding a Document From the File System (page 5-31) for information on selecting a 
repository and choosing a template. Once the HTTP Source Document dialog box opens, 
do the following:

1. Under Destination, enter the HTTP server name. Neither the protocol (http://) nor a 
closing forward slash is required.

Example www.oracle.com.
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2. Under Login Credentials, click Use anonymous connection if you are connecting to 
an HTTP site as an anonymous user. If you require an HTTP user account, click Use 
specific credentials and enter both your user account and password.

3. Click Use specific server TCP/IP port if the server at the HTTP site you are 
connecting to does not use the standard HTTP port. Then enter the port number in the 
box.

4. In the Source Document Path text box, enter the path and name of the document you 
want to add to your project.

You can add only one document at a time from an HTTP site.

5. Click OK to leave the HTTP Source Document dialog box. The Choose Template 
dialog box will open so that you can associate a template with the source document.

You can add documents from any HTTP site that you can connect to. But when using 
“Anonymous” you may find that you are restricted to certain levels of files (which may 
also be the case with an HTTP user account).

If you are connecting to the HTTP site through a proxy server, click Proxy to open the 
Proxy Settings dialog box (see Proxy Settings for an HTTP Site on page 8-65).

To specify the document you want to add to your project, you can open the HTTP site in 
your browser and navigate to the document. Then copy the URL from the Address or 
Location bar and paste it into the Source Document Path text box.

The source documents you translate must have file extensions; otherwise, you will not be 
able to publish successfully.

Updating Source Documents From an FTP or HTTP Site
When you start a new project and add source documents from an FTP or HTTP site, Site 
Builder makes copies of those documents, places them in a temporary directory on the file 
system, and translates the copies. Site Builder will continue to use those copies for 
translation during your current session in Site Builder unless you formally update the 
source documents.

So if there is a delay between the first time you translate and the last time you translate 
before publishing, you should update the copies of the source documents in the temporary 
directory.

To update source documents from an FTP or HTTP site click Update Versions ( ) 
on the toolbar.
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Copies of the latest versions of the source documents on the FTP or HTTP site have been 
placed in a temporary directory on your file system. You can now translate one last time 
and then publish. (See Update Versions Command on page 8-9.)

Actually, Site Builder copies a source document the first time it is “requested.” This could 
be when you associate a template with the source document in the Choose Template 
dialog box (with the preview functionality turned on), when you preview the document in 
the Edit Template dialog box, or when you first translate the document. Also, Site Builder 
will delete the temporary file each time you close the project and create a new one the next 
time you start the project and the document is first requested.

Because Site Builder copies source documents only when they are “requested,” the Status 
column in the main window may be misleading. You may see a green check mark even 
though a more recent version of a document is available from an FTP or HTTP site. So 
always click Update Versions (see Update Versions Command on page 8-9) before your 
final translation. If a green check mark opposite a document turns to a red cross, you’ll 
know that Site Builder has just copied an updated version of that document into the 
temporary directory, ready for translation.

Adding Content From Content Server
This section covers the following topics:

! Adding a Document From Content Server (page 5-17)

! Adding a Directory Item from Content Server (page 5-18)

! Creating a Project File in Content Server (page 5-20)

! Connecting to Content Server (page 5-21)

! Illegal Characters in a Title (page 5-22)

! Obtaining Source Documents From Content Server (page 5-22)

! Opening a Project File From Content Server (page 5-23)

! Registering a Content Server (page 5-24)

! Registering a Content Server by Manually Creating a Registry Entry (page 5-24)

! Registering a Content Server by Running the Mini-Installer (page 5-25)

! Specifying a Directory for Temporary Files (page 5-26)

! Updating to the Latest Released Version of a Source Document (page 5-27)

! Specifying a Particular Version of a Source Document (page 5-27)
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! Version Options When Translating a Source Document (page 5-28)

! Specifying a Directory Item to Facilitate Previews (page 5-28)

! Creating a Restricted Directory Item in Content Server (page 5-29)

! Criteria of a Directory Item in Content Server (page 5-30)

Adding a Document From Content Server
To add documents from Content Server to a project in Site Builder, you must first ensure 
that Site Builder is connected to Content Server so that you can select the appropriate 
repository option.

1. Click Add Document ( ) on the toolbar.

2. If the Select a Repository dialog box opens, select Content Server from the drop-
down list. If this is to be the sole source of those documents, click Don’t show this 
dialog box again. Then click OK. 

3. In the Select a Document dialog box, conduct a search for the documents you want to 
add to your project. Once the search results display, select the documents.

4. If you want to choose a version other than the native file format, select Alternate or 
Web from the Content Rendition drop-down list at the top of the dialog box. Alternate 
is the alternative format you may have used when you checked the documents into 
Content Server. Web is the browser-ready version of the document. In most cases, this 
will be the PDF format.

5. Click the Add Selected to Project button (or click the Add All to Project button to 
add all the documents listed from the search.)

The Select a Document dialog box closes and the Choose Template dialog box opens.

6. In the Choose Template dialog box, associate a template with the source documents 
and click OK to return to the main window. The documents selected from Content 
Server are now listed in the Contents pane, with their associated template displayed in 
the Template column.

If Site Builder is not yet set up to access documents in Content Server, see Configuring 
Content Publisher (page 2-5).

If you have access to multiple content servers, the Choose a Content Server dialog box 
will open once you select Content Server as the repository and click OK (step 2). You can 
then select a content server from the drop-down list and click OK. The Choose a Content 
Server dialog box will still open even if you choose to hide the Select a Repository dialog 
box.
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Only those content servers registered on your machine are available from the Choose a 
Content Server dialog box (see Registering a Content Server on page 5-24).

See Obtaining Source Documents From Content Server (page 5-22) for more information 
on adding source documents to Site Builder.

You must associate a single template with multiple source documents when you first add 
them to a project. But you can later associate a different template with those documents or 
even a different template with each one.

The default setting in the Choose Template dialog box is None. To import styles or 
patterns from a source document, you must formally select Styles or Patterns (see Ranks, 
Styles, and Patterns on page 6-28).

Adding a Directory Item from Content Server
In Content Server, a Directory Item is defined by a query. Any source documents that 
meet the search criteria for the query are considered part of the Directory Item. You 
should use the Update Versions command to ensure that any source documents later added 
to Content Server that meet the search criteria are included in future translations.

1. In the Publication Hierarchy pane, select the publication you want to add the Directory 
Item to, and click Directory Item on the Add menu to open the New Directory Item 
Properties dialog box. (If necessary, select Content Server from the drop-down list 
and click OK.)

2. Click Browse opposite the Directory field to open the Directory Item Properties 
dialog box. Then click the Content Server button to open the Choose a Content 
Server dialog box, and select a content server from the drop-down list. (If only one 
content server is configured on your machine, it will be selected already.) Click OK to 
return to the New Directory Item Properties dialog box.

3. Under Directory Item Information, provide a name for the Directory Item. (This name 
will be added to the content server name and will display in the Contents pane. By 
naming Directory Items, you will be able to differentiate between multiple Directory 
Items that are added to the same publication of your project and drawn from the same 
content server.)

4. Select Restricted from the Type drop-down list (since it’s the default setting, it should 
be selected already).

5. In the Maximum document count box, enter the maximum number of source 
documents you want to include in the Directory Item in Content Publisher.
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If you leave this blank, the number of documents returned will equal the number of 
documents returned as a result of the query in Content Server, up to the query result 
limit imposed by Content Server. The default limit in Content Server is 200.

For example, if you set up a query in Content Server using the default of 200 and set 
the Maximum document count in Site Builder to 40, you will only receive 40 files or 
fewer, depending upon the query results. If, instead, you set the document count in 
Site Builder to 250, you will only receive 200 files or fewer depending upon the query 
results, because that is the limit set in the content server.

The Sort selections you make influence your results. See Sorting Directory Items 
(page 5-94) for more information.

6. From the Content Rendition drop-down list, select Alternate or Web if you prefer to 
add source documents to your project in other than their native format. Alternate is the 
alternative format, if any, that you provided the source document in when you added it 
to the content server. Web is the browser-ready version of your native file. Since this 
will be PDF in most cases, the Web option can be particularly useful for adding PDF 
files to your project.

7. Click the Query button to open the Specify a Search dialog box in Content Server. Set 
your search parameters and click the Search button. Review the list of current hits 
resulting from the query to be sure that your Directory Item will capture all the 
documents you want to capture – and no additional ones. To refine the query, click the 
Back button and set new search parameters. If the list of documents is satisfactory, 
click the Add Query to Project button to return to the Directory Item Properties 
dialog box.

To create a folder hierarchy based on the metadata assigned to your content items, 
click Hierarchy (see Query Results Hierarchy on page 5-96).

8. Click OK to return to the New Directory Item Properties dialog box, where the 
Directory field will read \\<content server>\<query name>.

9. In the Title text box, enter a title for the Directory Item. (You don’t have to enter one. 
If you do, it can be used to populate titles of your output pages.)

10. Under Map File Property, you can enter text to specify a custom item that will be 
added to the output Map file (MapFile.xml). This could enable you, for example, to 
place security information in the Map file.

11. In the Prefix to be added to all output file names text box, enter the prefix to apply 
to each output file in this Directory Item. If publishing to Content Server, ensure that 
the file name, including all prefixes, is no more than 30 characters. See Adding a 
Prefix to Output File Names (page 8-79) for more information.
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12. Under Output Directories, specify directories for output pages and graphics. Click 
Browse, if necessary, to locate the directories you want to use.

You don’t have to enter anything. By default, Site Builder uses the full path specified 
for the root publication and mirrors the publication hierarchy in the structure of the 
output directories it creates. So you may want to simply enter just the names for the 
output directories you want to use.

13. Under Template, click Choose Template to open the Choose template dialog box. 
Select the template you want to associate with the source documents in the Directory 
Item, and click OK. Click OK again, to return to the main window.

When you created a restricted Directory Item, you must select Restricted before you create 
the query.

To edit the query for a Directory Item at any time, click the Info button on the Directory 
Item Properties dialog box to open the Details dialog box, and then click Modify. See 
Criteria of a Directory Item in Content Server (page 5-30) for more information.

On the Options tab dialog, you can set conversion options for passing through documents 
(see Passing Through Source Documents Without Conversion on page 5-38) and changing 
the output file extension (see Setting Check-In File Extensions on page 8-82) during 
check-in to the content server.

Creating a Project File in Content Server
Creating a project file in Content Server is similar to creating one when working in the file 
system, except that you save the project file to the content server and thus take advantage 
of the security, versioning, and other features of the content management system.

1. With a new project open in Site Builder, click Save ( ) on the File menu.

2. In the Select a Repository dialog box, select Content Server from the Repository 
drop-down list. Click OK. 

If you have not yet logged onto Content Server during your current session in Site 
Builder, the Enter Network Password dialog box will open so that you can log on. 
Complete the required information to gain access to the repository, and then click OK.

3. The Assign Project Info dialog box displays. Under Content ID, accept the ID that 
displays, or enter a unique Content ID without spaces. Note that any Content ID you 
enter is permanently assigned to the project file after you save the information.

4. Under Type, select the type from the choice list that best describes the project file. 
(You may want to create a special Type for project files to facilitate future searches 
for them.)
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5. In the Title text box, enter a descriptive title for the project.

Do not provide the standard .tcp extension. Content Server will add it automatically. 
The extension won’t be visible in Content Server, but you will see it, for example, in 
the title bar of Site Builder.

6. Complete the other fields, as necessary. For example, you may want to create a special 
security group for project files. See your Content Server documentation for more 
information.

7. Click Assign Info to save the information and return to the main window in Site 
Builder, where the project file name now displays in the title bar (with the .tcp 
extension).

Once you save a project file to Content Server, each time you click Save on the File menu 
or the standard toolbar, you will create a new version of the project file in the content 
server. See Versioning the Project File (page 4-9).

If you have access to multiple content servers, the Choose a Content Server dialog box 
will open once you select Content Server as the repository and click OK (step 2). You can 
then select a content server from the drop-down list and click OK. The Choose a Content 
Server dialog box will still open even if you choose to hide the Select a Repository dialog 
box.

Only those content servers registered on your machine are available from the Choose a 
Content Server dialog box. See Registering a Content Server (page 5-24) for more 
information.

Connecting to Content Server
For Content Publisher to run successfully with Content Server, you need to complete the 
following:

On each machine on which either Site Builder or Site Server is installed

! Register the name of each content server and also the name of the HTTP server that is 
hosting each content server. See Registering a Content Server (page 5-24).

On each machine on which Site Server is running

! Register a username and password in order to access each content server. 
See Registering a Username and Password for Site Server (page 8-27).
Content Publisher User Guide 5-21



Building a Publication
Illegal Characters in a Title
When you add a document to a publication, Site Builder uses the document title of the 
source document in Content Server as the file name in Site Builder. When you translate 
the publication, Site Builder creates an output file using the same name (adding the 
extension .htm). The name of the output file that is created during translation is used as the 
title when you publish and place the output files in the repository.

In Content Server you can create a document title that includes characters that are illegal 
on the file system. (For example, you can use commas and quotation marks.) Content 
Publisher handles illegal characters in the document title by replacing them with an 
underscore ( _ ) when it creates a file name. The file system therefore accepts the output 
file name that is created during translation and Content Publisher successfully translates 
the file. As a result, when the output file is published back to the repository, its title is now 
slightly different to the source document title.

This modification of the source document title to create an output file name occurs only 
when the title contains illegal characters. The source document title itself is not modified.

Obtaining Source Documents From Content Server
To use Site Builder with Content Server, you must first select the appropriate repository 
option in the Select a Repository dialog box (see Selecting a Repository on page 5-8). 
Thereafter, if you choose to hide this dialog box, each time you use the Add Document 
command, the Select a Document dialog box will open and you can immediately begin to 
select documents from the content server.

If you have access to multiple content servers, the Choose a Content Server dialog box 
will open once you select Content Server as the repository. You can then select a content 
server from the drop-down list and click OK. The Choose a Content Server dialog box will 
still open even if you choose to hide the Select a Repository dialog box.

Only those content servers registered on your machine are available from the Choose a 
Content Server dialog box. See Registering a Content Server (page 5-24) for more 
information.

When you add source documents to a project, the default setting in the Choose Template 
dialog box is None. With this setting, Site Builder won’t import styles or patterns from the 
source documents. Rather, it will create a set of default ranks that will be applied to the 
content of the source documents at translation. (See Ranks, Styles, and Patterns on 
page 6-28 for more information.) If you change this setting, the new setting will prevail 
until you change it again.
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Site Builder doesn’t actually check out source documents from the content server. Rather, 
it identifies the current version of each document during project setup and obtains a 
working copy of that version for translation. The Update Versions command should 
therefore be used before your final translation, assuming you want to use the latest 
versions of source documents in the repository. See Updating Source Documents in 
Content Server (page 8-70).

If the Update Versions command identifies a newer version of a source document, the 
Status column in the Contents pane will display an 8to denote this. In that event, you can 
use the Translate command to run an incremental translation to update your publication.

If you choose to use a specific version of a document in your publication, that document 
will not be subject to the Update Versions command, and only the specified version will 
be used for translations. See Version Options When Translating a Source Document 
(page 5-28).

Site Builder places working copies of source documents in the directory designated on 
your machine for temporary files. You can change this directory, if you want. See 
Specifying a Directory for Temporary Files (page 5-26).

Opening a Project File From Content Server
Once you check a new project file into Content Server, you can begin using it right away. 
And you can open the file at any time from the content server for future sessions in Site 
Builder.

1. Click Open ( ) on the toolbar.

2. If the Select a Repository dialog box opens, select Content Server from the 
Repository drop-down list, and click OK. The Select a Project dialog box opens. 

3. Create a search in order to locate the project file you want to open.

4. Once the review of hits appears, click the Select button for the project file you want to 
open.

Each time you create a project file, Site Builder creates a companion history file. See The 
History File (page 4-3) for more information.

If you have access to multiple content servers, the Choose a Content Server dialog box 
will open once you select Content Server as a repository and click OK (step 2). You can 
then select a content server from the drop-down list and click OK. The Choose a Content 
Server dialog box will still open even if you choose to hide the Select a Repository dialog 
box.
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Only those content servers registered on your machine are available from the Choose a 
Content Server dialog box. See Registering a Content Server (page 5-24) for more 
information.

Registering a Content Server
For Content Publisher to work successfully with Content Server, both Site Builder and 
Site Server must have access to each content server in use. This is true whether the content 
server is a source of documents for your projects or serves as a location for the staged and 
published output that your projects generate.

During installation you can register a single content server by providing the name of the 
content server and also the name of the HTTP server that is hosting the content server. 
You may need to register additional content servers (say, for the staged and published 
output your projects generate). You can do this in one of two ways:

! Running the mini-installer provided on your Content Publisher product disc 
(see Registering a Content Server by Running the Mini-Installer on page 5-25), or

! Manually creating a Registry entry (see Registering a Content Server by Manually 
Creating a Registry Entry on page 5-24).

Running the mini-Installer simply automates the process of creating the required Registry 
entry.

Registering a Content Server by Manually Creating a 
Registry Entry
During the installation of Site Builder or Site Server, you can register a single content 
server by providing the name of the content server and also the name of the HTTP server 
that is hosting the content server. This is essential if the client or server is to have access to 
Content Server.

You may need to register additional content servers (say, for the staged and published 
output your projects generate). You can do so at any time by manually creating the 
required Registry entry.

1. From the Start menu, click Run.

2. In the Open text box, type regedit and click OK.

3. Locate the following Registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Stellent\Content Publisher\Repository\ 
6.0\Stellent\CS List
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4. Right-click CS List, and choose New and then Key from the popup menu.

5. In the edit box that appears, replace New Key #1 with the name of the content server, 
say, Dev. Press Enter.

6. Right-click the new Key (say, Dev) and select New and then String Value from the 
popup menu.

7. Enter the String Name CgiURL and press Enter.

8. Right-click CgiURL and choose Modify from the popup menu. In the Value Data text 
box, enter the following if you are using Microsoft Explorer Information Server to 
host Content Server:

http://<HTTP server name>/intradoc-cgi/idc_cgi_isapi.dll

For example, if your HTTP server is named ContentServer, you would enter:

http://contentserver/intradoc-cgi/idc_cgi_isapi.dll

If, instead, you are using Netscape Enterprise Server to host Content Server, enter the 
following in the Value Data box:

http://<HTTP server name>/intradoc-cgi/nph-idc_cgi.exe

Example:

http://contentserver/intradoc-cgi/nph-idc_cgi.exe

9. Press Enter.

You have created the necessary Registry entry. You can begin using the client or server 
immediately to access the content server you have just registered.

You can edit this entry at any time, should you later change the name of your content 
server or HTTP server.

Follow the above steps to register the same content server on additional machines, as 
necessary, and also to register additional content servers on the same machine.

You can automate the process of registering a content server by using the mini-Installer 
available on the Content Server product disc. See Registering a Content Server by 
Running the Mini-Installer (page 5-25).

Registering a Content Server by Running the 
Mini-Installer
During the installation of Site Builder or Site Server, you can register a single content 
server by providing the name of the content server and also the name of the HTTP server 
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that is hosting the content server. This is essential if the client or server is to have access to 
Content Server.

You may need to register additional content servers (say, for the staged and published 
output your projects generate). You can do so at any time by running the mini-Installer 
that is available on your Content Publisher product disc.

Follow these steps to run the mini-Installer:

1. Insert your Content Publisher product disc in the product disc drive of the machine on 
which either Site Builder or Site Server is installed.

2. Open the Support folder and double-click CSSetup.exe.

3. Complete the information requested on each of the installer screens that appear, in 
turn.

4. Click Finish to complete the running of the mini-Installer.

You have created the necessary Registry entry. You can begin using the client or server 
immediately to access the content server you have just registered.

Follow the above steps to register the same content server on any additional machines, as 
necessary, and also to register additional content servers on the same machine.

The mini-Installer simply automates the process of creating the required Registry entry. 
To manually create the entry or to edit an existing entry, see Registering a Content Server 
by Manually Creating a Registry Entry (page 5-24).

Specifying a Directory for Temporary Files
When you add a source document from Content Server to a project, Site Builder identifies 
the latest released version at that time and makes a working copy of the source document 
at translation time. It places the working copy in your TEMP directory. Site Builder uses 
that working copy for all future translations (unless you use the Update Versions 
command to update the source documents).

If you prefer, you can place the working copies elsewhere on your file system. To do this, 
you need to create the following Registry Key:

HKEY_LOCAL_MACHINE\Software\Stellent\Content Publisher\Repository\6.0\Stellent

Create a string value with the String Name “Cache” and the Data Value being <the 
directory you want to use> (the full path of the directory).
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Updating to the Latest Released Version of a Source 
Document
The default behavior in Content Server is for the latest released version of a source 
document to be used each time you translate. Thus, each time you enter the Document 
Details dialog box, the Allow refresh to latest released version check box is selected at 
the top of the dialog box.

You may have previously specified that a particular version be used and now want the 
latest released version to be used, instead.

1. In Site Builder, right-click the appropriate source document in the Contents pane and 
choose Properties from the popup menu.

2. In the Document Properties dialog box, click the Info button ( ) to open the 
Document Details dialog box.

3. At the top of the dialog box, select the Allow refresh to latest released version check 
box.

4. Click the Select button to close the Document Details dialog box.

Each time you use the Update Versions Command (page 8-9), Site Builder will now use 
the latest released version of this source document when you translate or publish in future.

Specifying a Particular Version of a Source Document
When you add documents that reside in Content Server, you do not check out those 
documents as you do in your normal use of Content Server. Rather, Site Builder identifies 
the current version of each document at the time it is added to the publication and obtains 
a working copy of that version for translation.

By default, Site Builder automatically uses the latest released version of all source 
documents. When you click Update Versions (see Update Versions Command on 
page 8-9) Site Builder checks the repository to identify the latest released version of each 
document and uses that version for translation.

You can, instead, use a particular version of a source document. 

1. On the Contents pane, right-click the appropriate source document and choose 
Properties from the popup menu.

2. In the Document Properties dialog box, click the Info button ( ) to open the 
Document Details dialog box.

3. At the top of the dialog box, clear the Allow refresh to latest released version check 
box.
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4. Scroll down the list of versions available for the document and click the Revision 
button for the version you want to use.

5. Click the Select button to return to the main window.

Even if you use Update Versions to update the other source documents in your 
publication, Site Builder will ignore any later versions of this document and translate only 
the specified version.

Version Options When Translating a Source Document
When you add documents that reside in Content Server, you do not check out those 
documents as you do in your normal use of Content Server. Rather, Site Builder identifies 
the current version of each document at the time it is added to the publication and obtains 
a working copy of that version for translation.

As you create a publication, you may translate your source documents several times 
before you finally stage and publish a project. And you may stage and publish many times 
as you maintain and update the project over time.

You can control the version of each source document you translate, and therefore the 
content you stage and publish:

1. The latest released version—With the Update Versions Command (page 8-9), you 
update your publication to use the latest released version of each source document, 
unless you have specified that a particular version of a source document be used. See 
Updating to the Latest Released Version of a Source Document (page 5-27).

2. The specified version—When you specify a particular version of a source document, 
this version is always used when you translate, even if you use the Update Versions 
command. See Specifying a Particular Version of a Source Document (page 5-27).

Specifying a Directory Item to Facilitate Previews
Each Directory Item you create is, by default, of the “restricted” type. With this setting, 
and once a project is registered, a content author can preview at check-in any source 
document that is assigned document information that associates the document with a 
restricted Directory Item in the project.

1. Click Directory Item on the Add menu. If necessary, select Content Server as the 
repository and choose a specific content server.

2. In the New Directory Item Properties dialog box, click Browse to open the Directory 
Item Properties dialog box.
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3. Click the Content Server button to open the Choose a Content server and choose a 
content server from the drop-down list.

4. Under Directory Item Information, provide a name for the Directory Item.

This name will be added to the content server name and will display in the Contents 
pane. By naming Directory Items, you will be able to differentiate between multiple 
Directory Items that are added to the same publication of your project and drawn from 
the same content server.

5. Select Restricted from the Type drop-down list (since it’s the default setting, it should 
be selected already).

6. In the Maximum Document Count box, enter the number of source documents you 
want to include in the query.

The default setting is blank, which means that the query will include all source 
documents that meet the query criteria (up to the limit set within Content Server). But 
you can, if you like, limit the number of documents by entering a number in the box or 
using the arrows to the right of the box to set the number.

If you set a limit, the source documents used will be those listed first according to the 
Sort selection you made for the search in Content Server and whether you wanted the 
results listed in ascending or descending order.

7. Create a query in Content Server (see Adding a Directory Item From Content Server 
on page 5-91). Once you click the Add Query to Project button, you’ll return to the 
Directory Item Properties dialog box.

8. Click OK.

When you create a restricted Directory Item, you must select Restricted (step 5) before 
you create the query (step 7).

You cannot conduct a full text search to create a restricted query. (You can use only 
document information for the search, not document content.)

To change a standard query to a restricted query, you must re-specify the query.

Creating a Restricted Directory Item in Content Server
When adding a Directory Item from Content Server, (see Adding a Directory Item From 
Content Server on page 5-91), you have the option of making it restricted or standard.

The following options are available from the Type drop-down list under Directory Item 
Information in the Directory Items Properties dialog box:
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! Restricted—to be used to facilitate previews when source documents that are part of 
the Directory Item are checked into Content Server (you can use only document 
information to create the query, not document content)

! Standard—to be used if you want to use a full-text search in Content Server to create 
the query

Restricted is the default setting. Be sure to accept the default setting if you want to be able 
to preview source documents checked into Content Server.

Criteria of a Directory Item in Content Server
A Directory Item in Content Server is created from a query. Once the Directory Item is 
created, you may forget the criteria you used to create the query. Or you may want to edit 
the query once it has been set up.

1. Right-click the Directory Item in the Contents pane and choose Properties from the 
popup menu.

2. In the Directory Item Properties dialog box, click the Info button ( ) to open the 
Details dialog box. The Details dialog box provides a summary of the Directory Item, 
including the criteria used to create the query for the Directory Item.

3. To edit the query, click Modify, to return to the Directory Item Properties dialog box. 
You can edit any of the information in this dialog box. You can also click Query to 
edit the query itself.

SOURCE DOCUMENTS
This section covers the following topics:

! Adding a Document (page 5-31)

! Adding a Document From the File System (page 5-31)

! Document Properties (page 5-32)

! Moving Source Documents in the Contents Pane (page 5-34)

! Associating Alternative Text with a Graphic From Source (page 5-34)

! Creating Alternative Text From a Caption (page 5-35)

! PDF Input Files (page 5-36)

! XML Input Files (page 5-36)
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! Updating Source Documents (page 5-36)

! About Pass-Through Conversion (page 5-37)

! Opening a Source Document (page 5-38)

! Passing Through Source Documents Without Conversion (page 5-38)

! Passing Through HTML or Scripting Code During Translation (page 5-39)

! Removing a Document or Reference Page From a Publication (page 5-40)

! Translating Source Documents (page 5-41)

! Translation Status of Source Documents (page 5-42)

! HTML Input Files (page 5-43)

! File Formats and Translation (page 5-44)

! Text Formats Supported (page 5-45)

! OLE Object Support (page 5-51)

Adding a Document
You can add source documents to a project from the following repositories:

! File system—See Adding a Document From the File System (page 5-31).

! FTP site—See Adding a Document From an FTP Site (page 5-11).

! HTTP site—See Adding a Document From an HTTP Site (page 5-14).

! Content Server—See Adding a Document From Content Server (page 5-17).

The source documents you translate must have file extensions; otherwise, you will not be 
able to publish successfully.

Adding a Document From the File System
Adding a document to a publication is a two-step process: you select a document for 
translation and then associate a template with the document. Site Builder lets you select 
documents from different sources, including the file system.

1. Do one of the following:

! Right-click anywhere in the Contents pane and choose Add Document from the 
popup menu that appears.
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! Click Add Document ( ) on the toolbar or large toolbar.

! Choose Document from the Add menu.

2. When the Select a Repository dialog box opens, select File System from the drop-
down list and click OK. (If you need to display this dialog box, see Showing the 
Select a Repository Dialog Box on page 5-9.)

The Add Document dialog box appears.

3. Use the Look In drop-down box to display the directory structure and locate the folder 
containing the document you want to add.

4. Open the folder, select the document, and then click Open. The Choose Template 
dialog box opens.

To associate a template with the document

1. In the Choose Template dialog box, select the template from the Templates list that 
you want to associate with the document.

2. Under Import Styles or Patterns, accept the default None or select Styles or Patterns 
instead. (See Ranks, Styles, and Patterns on page 6-28.)

3. Click OK.

You can select multiple source documents in a directory. They will all be associated with 
the same template when you import them.

You can import multiple source documents of different file formats by selecting All 
Supported Formats from the Files of Type drop-down box.

You can also add documents to a publication by dragging them directly from Windows 
Explorer and dropping them into the Contents pane.

The source documents you translate must have file extensions; otherwise, you will not be 
able to publish successfully. 

Document Properties
The general properties of a source document consist of its output page name, the template 
associated with the document, the output directories for the body page itself and for the 
graphics files created when Site Builder converts graphics in the source document.

Document options include settings for specifying an output character set and ensuring that 
the document is passed through without conversion, if desired.
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Changing a Document’s General Properties
Follow these steps to change a document's general properties:

1. In the Contents pane, right-click the document and choose Properties from the popup 
menu to open the Document Properties dialog box.

2. To change the output page name, type the new name over the existing one, which is 
already selected.

3. In the Map File Property text box, enter any information you want to appear in the 
Document element in the XML Map file that Site Builder will generate when it 
translates the project.

4. To change the output directories, type over the paths given or click Browse to locate 
the directory you want to use. If no paths are listed in the two text boxes, Site Builder 
will use the paths set in the Publication Properties dialog box.

5. To change the template associated with the document, click Choose Template to 
open that dialog box, and select another template from the Templates list box.

6. If the document is from Content Server, you can click the Info button ( ) to open 
the Content Information page for the document (and, for example, specify a different 
version of the source document that you want to use.)

7. Click OK, and OK again to return to the main window.

Changing a Document’s Options
Follow these steps to change a document's options:

1. In the Contents pane, right-click the document and choose Properties from the popup 
menu to open the Document Properties dialog box.

2. Select the Options tab dialog.

3. If this document requires a different output character set than the one displayed under 
Output Character Set, select a set from the drop-down list. See Output Character Sets 
(page 5-108) for information on character sets and setting the project default set.

4. If you want the document to be passed through to the output folder in its original 
format, retaining the original file name and extension, select Pass this file through 
without conversion and specify an output file location. See About Pass-Through 
Conversion (page 5-37) for more information.
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Moving Source Documents in the Contents 
Pane
The order of source documents in a publication is important because it determines how the 
individual Web pages in your publication are linked.

Once you complete publication setup, you can “drag and drop” any source document to 
change its order in the publication. In the Contents pane, select the document, hold down 
the mouse button as you reposition the document, and then release the mouse button once 
you have the document where you want it positioned.

Associating Alternative Text with a Graphic 
From Source
You have three options in Site Builder for associating alternative text with a graphic from 
a source document. Whatever text is used will display in your browser in the event that the 
graphic does not display. (The text will also be visible when the mouse is passed over the 
graphic on your Web page.)

1. In the Formatting property sheet, select the element associated with the graphic.

2. Click Graphics to open that tab dialog.

3. Do one of the following:

! Under Alternative Text, click Use Alternative text from source document if 
available, or

! Under Captions, click Use caption, and then click the Caption button, and in the 
Captions dialog box, click Before the graphic or After the graphic, and then 
click OK, or

! Under Alternative Text, enter text in the Alternative Text field that you want to 
display in place of the graphic.

4. Click OK.

You must select the element associated with a graphic in order to associate alternative text 
with it. However, you can select multiple elements, if you like, to be sure that you edit all 
the appropriate elements of the template that are associated with graphics. 

You can also select multiple methods of associating alternative text, that is, all three 
bulleted options in Step 3. In that event,  Site Builder will follow the order of the bulleted 
list items to determine what alternative text to display.
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In other words, if you associate alternative text with a graphic that is embedded in a source 
document, that text will always be used, and the other two types of alternative text, if 
selected, will be ignored for that graphic. If you don’t specify alternative text from the 
source document, then caption text will be used, if it has been specified, and any 
alternative text entered in the Alternative Text field will be ignored. Finally, alternative 
text entered in the Alternative Text field will be used only if no other alternative text is 
specified.

One benefit of using alternative text specified in the source document is that you can have 
a unique piece of text associated with each graphic. This isn’t generally possible when you 
enter text in the Alternative Text field, unless, of course, you have created a unique style 
(and therefore element) for each graphic.

”Caption text” refers to any text immediately before or after the graphic. For more 
information, see Creating Alternative Text From a Caption (page 5-35).

Creating Alternative Text From a Caption
Site Builder provides three options for associating alternative text with a graphic in a 
source document (see Associating Alternative Text with a Graphic From Source on 
page 5-34). One is to use “caption text.”

“Caption text” is any text that appears immediately before or after a graphic in your source 
document. Either portion of text can be used as alternative text in your output Web pages. 
It will appear onscreen when the user passes the mouse over the graphic. It will also take 
the place of the graphic in the event that the graphic does not display on the Web page.

1. On the main window, select the appropriate template and click Formatting ( ).

2. Select the element associated with the graphic and click Graphics to open that tab 
dialog.

3. Under Captions, click Use caption and then click the Caption button to open the 
Captions dialog box.

4. Under Caption Source, click Before the graphic or After the graphic.

5. Click OK, and OK again to return to the main window.

The text immediately before or after each graphic associated with the selected template 
will now be used as alternative text in your Web output pages.

If you want to use the text of actual captions in this way, the captions must immediately 
follow the graphic (and not a figure number, for example).
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If you want to use caption text for alternative text, do not select the Use alternative text 
from source document if available check box on the Graphics tab dialog. Otherwise, that 
text will be used instead.

PDF Input Files
In addition to creating HTML and XML output files, Site Builder can also handle these 
formats as input files. It can also incorporate PDF files into a Web publication by creating 
a page linked to the original file, which can be opened in its native format if the user has 
Adobe Reader installed.

The original files are passed through to the staging or publishing area. Site Builder creates 
a page as a placeholder for the PDF file at the appropriate point in the publication. This 
page is linked to other output pages, according to its order in the translation process. In 
addition, the page contains a link to the PDF file, using the name of the file as an 
identifier. When the user clicks that link, the PDF file opens in its native format in Adobe 
Reader, assuming that application is installed on the user’s machine.

You can also pass through PDF files without conversion and promote the file to a 
publication’s TOC, creating a direct link from the TOC to the PDF file. See About Pass-
Through Conversion (page 5-37) for more information.

XML Input Files
In addition to creating HTML and XML output files, Site Builder can also handle these 
formats as input files. It can also incorporate PDF files into a Web publication by creating 
a page linked to the original file, which can be opened in its native format if the user has 
Adobe Reader installed.

XML files are passed through, completely unchanged, to your staging or publishing area. 
Their existence is noted in the TOC and other navigational links. They are also noted in 
the XML Map file. How your browser or other viewer renders the file may vary.

Updating Source Documents
Site Builder automatically recognizes when single source documents on the file system 
have changed and includes those files in any incremental translation you run.
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However, you must use the Update Versions Command (page 8-9) in all other instances in 
order to update source documents before translation:

! Updating a Dynamic Directory Item (page 5-94)

! Updating Source Documents in Content Server (page 8-70)

! Updating Source Documents From an FTP or HTTP Site (page 5-12)

About Pass-Through Conversion
The files you use to create a Web publication may include those in special formats (such 
as AVI or PDF) that you want Site Builder to preserve. Site Builder can pass through such 
files and place them in the appropriate output directory so that they are recognized as part 
of the project. They can then be referenced from within the project and even promoted to a 
publication Table of Contents (TOC) (page G-24).

You can set the pass-through conversion option for Directory Item and documents.

Passing Through a Document
When you set the pass-through conversion option for a document, that source document is 
passed through to the output folder in its original format, using the original file name and 
extension. You can then reference the file in your project. You can also promote the 
document to the publication TOC, creating a direct link from the TOC to the file.

This can be useful if you want to link to a PDF file directly from the TOC so the user can 
open the PDF file from the TOC. (In this case, the user will have to have Acrobat Reader 
installed on his or her machine. Other files you pass through may require other 
applications to be available on the user’s machine.)

Passing Through a Directory Item
When you set a pass-through option for a Directory Item, the documents matching the 
criteria you specify are passed through to the output folder during translation in their 
original format, using their original file names and extensions.

You can set conversion options for one file type, multiple file types, or all documents in 
that directory. You could use this feature to place all of the files you want to include in 
your publication without translation into one central location.
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Opening a Source Document
You can open any source document in your publication at any time by launching the file in 
its native application from Site Builder.

In the Contents pane, select the source document you want to open and

! Right-click and choose Open Source Document from the popup menu that appears, 
or

! Choose Source Document from the View menu.

You can only view the source document if the appropriate application is available from 
your machine. Also, the source document must be on your file system or in Content Server 
(this option is not available for source documents on an FTP or HTTP site). In the case of 
Content Server, clicking Open Source Document will take you to the Content Information 
page for the document.

You can also open a source document from your Web page. See Adding a Link to Source 
Link to a Page Button Bar (page 6-145).

Passing Through Source Documents Without 
Conversion
You can set pass-through conversion options for documents and Directory Items to 
preserve their original format. See About Pass-Through Conversion (page 5-37) for more 
information.

1. In the Contents pane, right-click the document or Directory Item and choose 
Properties from the popup menu to open the Properties dialog box.

2. Select the Options tab dialog.

3. Under Conversion Options, do one of the following:

! if a document, select Pass this file through without conversion.

! if a Directory Item, select Pass through files matching the following 
specification. In the File specification criteria text box, enter the specifications 
for the types of files included in the Directory Item that you want to pass through 
without modification during translation, such as *.avi;*.pdf. Separate entries with 
a semicolon.

4. Select the output location for passed-through files.

5. Click OK.
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To reference a passed-through document in the TOC, promote Title (System), which is the 
only element available for TOC promotion when using this option.

If you do not promote the title of a passed-through document to the TOC, the file is 
essentially the same as an associated file in Site Builder. See Associating a File With a 
Publication (page 5-99) for more information on associated files.

If you choose to treat the files in a Directory Item in a manner similar to associated files, 
add the Directory Item to a publication containing no TOC and no framesets, and select a 
“blank” template containing no promotion to reference pages.

You can also include a PDF file in a Web publication as a Web page that contains a link to 
the original file. See PDF Input Files (page 5-36) for details.

Passing Through HTML or Scripting Code 
During Translation
You can pass through HTML or scripting code during translation. One simple example 
might be the HTML code embedded in your source documents in the form of a link to 
another Web page from the one you are creating. 

Another example might be Word bookmarks. By default, when Site Builder regenerates 
target names in output files, it does not retain bookmark names in Word source files. This 
ensures uniqueness, because Site Builder can add its own navigation to a Web publication 
(navigation buttons, TOC links, etc.). But you may want to preserve links to specific 
bookmarks in the Word source documents. (See Retaining Original Bookmark Names on 
page 6-163.)

Hard coding the bookmarks will preserve them during conversion. This procedure can 
also be used to pass through Idoc Script and other scripting code. 

Follow these steps to map hidden code for a Word bookmark to HTML in published 
output:

1. With your source document open in Word, place your cursor immediately before the 
word you want to bookmark and type the HTML code for a bookmark: 

<a name=“myBookmark”></a>

2. Select the HTML code, click Format > Styles, and create a character style. Give that 
style the hidden font. You might want to name that style “Bookmark.” (If you passed 
through Idoc Script, you might name the character style “idocscript.”)
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If you want to display the hidden text in your Word document, click Tools > Options, 
and from the General tab check the option to show Hidden text. The hidden text will 
display with a dotted line below it.

3. In Site Builder, add the file to your project. (If it is already a part of your project, right-
click the file name or Directory Item in the Contents pane and choose Import > 
Styles. Alternatively, manually add and associate this new style with a new element 
by using the Add buttons in the Element Setup, Element and Style tabs.)

4. Open Formatting. On the Character tab, select the character element that is 
associated with the hidden text (say, “Bookmark”), and click the Effects button.

5. In the lower section, scroll down and select Hidden as the input effect. Then right-
click the output effect opposite, and select HTML from the popup menu.

6. Translate and view your results. 

Instead of using hidden text, you can use text attributes such as bold, italic, underline, and 
subscript. But these attributes might already be in use in your source documents, so hidden 
text is likely to be the best choice. 

Removing a Document or Reference Page From 
a Publication
You can remove a document or reference page from a publication at any time.

1. In the Contents pane, select the source document or reference page.

2. Click Delete ( ) on the toolbar or choose Delete from the Edit menu.

When you delete a source document or reference page in this way, you simply remove the 
source document or reference page from the publication. The original source document is 
unchanged. The template associated with the document or reference page is still available 
in the publication.

If you delete a source document or reference page after you have translated a publication, 
you might also want to the delete the appropriate files from your output directory.

You can also use the Cut command from the Edit menu or toolbar. If you do, and change 
your mind, you can then use the Paste command to return the source document or 
reference page to the publication.
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Translating Source Documents
Translation in Content Publisher is the process of creating Web pages from source 
documents. (For a list of source documents, see File Formats and Translation on 
page 5-44.) The individual template settings control the translation details and ultimately 
the appearance of the Web page—the source documents remain unchanged.

Site Builder offers three translation options: Selective Incremental Translation, Translate, 
and Translate All.

! Use Selective Incremental Translation for a translation of only the item or items you 
specify (except reference pages). You may want to use this option if, for example, you 
change a template that impacts many documents, but you only want to translate one of 
those documents.

! Use Translate for an incremental translation, where Site Builder recognizes the source 
documents in the file system that have changed since the last translation and translates 
only those.

! Use Translate All for a full translation.

To determine the translation status of source documents (see Translation Status of Source 
Documents on page 5-42), check the Status column in the Contents pane.

For a Selective Incremental Translation
Perform a selective incremental translation in one of these ways:

! Select and right click any publication from the Publication Hierarchy Pane and click 
Translate Publication from the drop-down menu that displays.

! Select and right click any item except a reference page from the Contents Pane and 
click Translate Selected from the drop-down menu that displays.

! Select any item(s) except a reference page from the Contents Pane and click 
Translate Selected from the Run menu. To select multiple items, hold down the CTL 
key while you click the items you want to translate.

For an Incremental Translation
Perform an incremental translation in one of three ways:

! On the standard toolbar or large toolbar, click Incremental Translation ( ).

! From the Run menu, choose Translate.
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For a Full Translation
! From the Run menu, choose Translate All.

You use temporary disk space each time you translate. This can vary significantly, 
depending on the number and size of the files and graphics you convert. A range of 20–50 
free megabytes of free disk space is highly recommended. Check your log file, which will 
warn you if you have run out of disk space. (See Setting Up the Translation Log on Site 
Builder on page A-5.)

You can always force a translation by right-clicking the appropriate green check mark in 
the Status column and choosing the red cross from the popup menu that appears. A red 
cross now appears in the Status column and Site Builder will include the source document 
in the next incremental translation. You can also select the document and translate it using 
Selective Incremental Translation. The Translate All command may be appropriate for 
your final translation before publishing. In that event, you might also want to clean out the 
output directories just in case there are remnants, for example, of source files that are no 
longer part of the project.

The Status column won’t flag out-of-date source documents from an FTP or HTTP site, or 
from Content Server. In those cases, you can use the Update Versions command before 
translating to ensure that you use the latest versions available.

Likewise, since a Directory Item can contain multiple documents added to the directory or 
updated at any time, the Status column won’t flag the status of the directory’s contents. 
However, Site Builder will include new and updated files in any incremental translation.

For more information on selective translation options, see Showing the Selective 
Incremental Translation Dialog Box (page 3-20).

The source documents you translate must have file extensions; otherwise, you will not be 
able to publish successfully.

Translation Status of Source Documents
The Status column in the Contents pane summarizes the translation status of each source 
document in the project.

ü Source document is currently up-to-date and has not been revised since the last 
translation.

r Source document is out-of-date and should be included in the next incremental 
translation.
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When you first translate a publication, a green check mark appears opposite each source 
document. A green check mark will revert to a red cross for one of three reasons: the 
content of the source document has changed, the template has changed, or an output file is 
missing.

If source documents on an FTP or HTTP site have been updated, the Status column won’t 
necessarily reflect this, but you can use the Update Versions command to update such 
documents before translating.

You can force a translation very easily. Simply right-click the appropriate green check 
mark in the Status column and choose the red cross from the popup menu that appears. 
A red cross now appears in the Status column and Site Builder will include the source 
document in the next incremental translation. You can also use Selective Incremental 
Translation (see Showing the Selective Incremental Translation Dialog Box on page 3-20.

The Status column for reference pages reflects the status of the template. All reference 
pages are updated, as necessary, whenever you do an incremental translation. Reference 
pages are not updated using Selective Incremental Translation.

The source documents you translate must have file extensions; otherwise, you will not be 
able to publish successfully.

HTML Input Files
In addition to creating HTML output files, Site Builder can also handle files in this format 
as input. When HTML files are added to a project as source documents, the HTML files 
remain intact, but you can make them consistent with other Web pages in the project by 
enhancing them with a common background, a title, and navigation buttons.

When you translate files that have linked graphics, such as HTML files, the graphics are 
copied to the output directory. If you have two HTML source documents that have links to 

! As Site Builder translates a publication, this mark may appear temporarily as 
each source document is translated. If the mark is still there at the end of a 
translation, an error has occurred. In that event, Site Builder has been unable to 
translate the source document and you should consult the log file for logging 
errors (see Logging Errors on page A-3).

– Signifies a Directory Item, which can contain new files added at any time. You 
need to use the Update Versions command before each translation to ensure 
that Site Builder updates all files.
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different graphics with the same name, the resulting graphics file names will be 
incremented to keep them from overwriting each other.

When Site Builder translates an HTML file, information in the <HEAD> of the file, 
including Meta tags, is passed through unchanged. The element Title is assigned to any 
titles in the Head.

File Formats and Translation
Site Builder translates source documents from major word processing, spreadsheet, and 
presentation software programs, as well as those in other common file formats. In 
addition, Site Builder accepts many different graphics formats. Site Builder can convert 
more than 225 different document and graphics formats.

See... For...

Text Formats Supported 
(page 5-45)

A complete list of the major formats that Site 
Builder accepts for source documents

Graphics Formats Supported 
(page 6-170)

A complete list of the major formats that Site 
Builder accepts for graphics embedded in or 
linked to source documents

OLE Object Support (page 5-51) A special note about embedded OLE objects in 
Microsoft Word or Excel source documents

HTML Input Files (page 5-43)
XML Input Files (page 5-36)
PDF Input Files (page 5-36)

A note about HTML, XML and PDF files as input 
files

Graphics as Input Files 
(page 6-124)

A note about graphics as input files

Disk Space (page 2-6) Recommended disk space for translating Content 
Publisher projects

Anti-Virus Software (page 2-5) A special note about using Site Builder while 
running anti-virus software

Styles in Microsoft Excel 
(page 6-48)

A note about styles in Microsoft Excel 
spreadsheets
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Text Formats Supported

Styles in Microsoft PowerPoint 
(page 6-49)

A note about styles in Microsoft PowerPoint 
presentations

Application / Format Version

Word processing – DOS 

ANSI Text (7 & 8 bit) all versions

ASCII Text (7 & 8 bit) all versions

DEC WPS Plus (DX) through 4.0

DEC WPS Plus (WPL) through 4.1

DisplayWrite 2 & 3 (TXT) all versions

DisplayWrite 4 & 5 through 2.0

Enable 3.0, 4.0, 4.5

First Choice through 3.0

Framework 3.0

HTML through 3.0

IBM FFT all versions

IBM Revisable Form Text all versions

IBM Writing Assistant 1.01

Lotus Manuscript through 2.0

MASS11 through 8.0

Microsoft Word through 6.0

See... For...
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Microsoft Works through 2.0

MultiMate through 4.0

Navy DIF all versions

Nota Bene 3.0

Novell WordPerfect through 6.1

Office Writer 4.0 through 6.0

PC-File Letter through 5.0

PC-File+ Letter through 3.0

PFS:Write A, B, C

Professional Write through 2.1

Q&A 2.0

Samna Word through IV+

SmartWare II 1.02

Sprint 1.0

Total Word 1.2

Unicode Text all versions

Volkswriter 3 and 4 through 1.0

Wang PC (IWP) through 2.6

WordMARC through Composer+

WordStar through 7.0

WordStar 2000 through 3.0

XyWrite through III Plus

Application / Format Version
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Word processing – Windows 

Adobe FrameMaker (MIF) 6.0

Corel/Novell WordPerfect through 12.0

Hangul 2002 (full conversion)

JustSystems Ichitaro 5.0, 6.0, 8.0 through 13.0, 2004

JustWrite through 3.0

Legacy through 1.1

Lotus Ami/Ami Professional through 3.1

Lotus WordPro (Intel platforms) 96 through Millennium Edition 9.6

Microsoft Rich Text Format (RTF) all versions

Microsoft Word through 2003

Microsoft WordPad all versions

Microsoft Works through 4.0

Microsoft Write through 3.0

Novell Perfect Works 2.0

Professional Write Plus 1.0

Q&A Write 3.0

StarOffice /
Open Office Writer

5.2, 6.x, 7.x /
1.1 (text only)

Unicode Text all versions

WordStar 1.0

Word Processing – Macintosh 

MacWrite II 1.1

Application / Format Version
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Microsoft Word 3.0, 4.0, 98, 2001, 2004

Microsoft Works through 2.0

Novell WordPerfect 1.02 through 3.0

Word Processing – Unix 

Star Office Writer Version 5.2

Spreadsheet  

Enable 3.0, 4.0, 4.5

First Choice through 3.0

Framework 3.0

Lotus 1-2-3 Charts (DOS/Windows) through 5.0

Lotus 1-2-3 (DOS/Windows) through 5.0

Lotus 1-2-3 (OS/2) through 2.0

Lotus 1-2-3 for SmartSuite 97 through Millennium 9.6

Lotus Symphony 1.0, 1.1, and 2.0

Microsoft Excel Charts 2.x through 7.0

Microsoft Excel (Mac) 3.0 through 4.0, 98, 2001, 2004

Microsoft Excel (Windows) 2.2 through 2003

Microsoft Multiplan 4.0

Microsoft Works (Mac) through 2.0

Microsoft Works (Windows) through 4.0

Microsoft Works (DOS) through 2.0

Mosaic Twin 2.5

Application / Format Version
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Novell Perfect Works 2.0

PFS:Professional Plan 1.0

Quattro Pro (DOS) through 5.0

Quattro Pro (Windows) through 12.0

SmartWare II 1.02

StarOffice /
Open Office Writer

5.2, 6.x, 7.x /
1.1 (text only)

SuperCalc 5 4.0

VP Planner 3D 1.0

Presentation 

Corel/Novell Presentations through 12.0

Harvard Graphics (DOS) 2.x, 3.x

Harvard Graphics (Windows) all versions

Freelance (Windows) through Millennium 9.6

Freelance (OS/2) through 2.0

Microsoft PowerPoint (Windows) 3.0 through 2003 

Microsoft PowerPoint (Mac) 4.0 through 2001, 2004

StarOffice /
Open Office Writer

5.2, 6.x, 7.x /
1.1 (text only)

Databases 

Access through 2.0

dBASE through 5.0

DataEase 4.x

Application / Format Version
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dBXL 1.3

Enable 3.0, 4.0, 4.5

First Choice through 3.0

FoxBase 2.1

Framework 3.0

Microsoft Works (Mac) through 2.0

Microsoft Works (Windows) through 4.0

Microsoft Works (DOS) through 2.0

Paradox (DOS) through 4.0

Paradox (Windows) through 1.0

Personal R:BASE 1.0

Q&A through 2.0

R:BASE 5000 through 3.1

R:BASE System V 1.0

Reflex 2.0

SmartWare II 1.02

Other 

Executable (EXE, DLL) no specific version

ID3 (MP3, AAC, WMA, Ogg Vorbis, 
etc.)

text only

Macromedia Flash (SWF) text only

Microsoft Outlook Express (EML)

Microsoft Outlook Folder (PST) 97, 98, 2002, 2003

Application / Format Version
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In addition to the above text formats, Site Builder supports many graphics formats. 
(See Graphics Formats Supported on page 6-170.)

You can also pass through source documents to preserve the original file type or file 
extension, such as HTML, XML, PDF, and so on. (See About Pass-Through Conversion 
on page 5-37.)

OLE Object Support
If a source document created in Microsoft Word or Excel (version 97 or 2000) contains an 
embedded OLE object, Site Builder will, if possible, export a copy of that object. It will 
create not only an output graphics file as a graphical representation of the object, but also 
a file for the linked object itself. It will then attempt to link the graphical representation of 
the OLE object in the output Web page to that file. If that object-type is supported by the 
browser setup, clicking the graphic will display the object in its native format (assuming 
you have the appropriate application installed on your machine).

Site Builder cannot export multimedia objects (only the graphical representation of the file 
will display in the output page).

To enable this functionality, you must check “Preserve links to embedded OLE objects 
where possible” on the Options tab dialog of Globals for the template you associate with 

Microsoft Outlook Message  (MSG) all versions

Microsoft Project 98 98 through 2003 (Datasheet view)

Microsoft Visio 2003

Mime Internet mail format

vCalendar Scheduling 1.0

vCard Electronic Business Card Versit 2.1

WML specification 5.2

XML text only

Yahoo Instant Message (YIM) text only

Application / Format Version
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your source documents. Also, in the source document itself, be sure to turn off the options 
“Float Over Text” and “Link to File” for the object.

See Preserving Links to Embedded OLE Objects on page 6-203.

REFERENCE PAGES
This section covers the following topics:

! About Reference Pages (page 5-52)

! Adding a Reference Page (page 5-53)

! Creating Reference Pages (page 5-53)

! Removing a Document or Reference Page From a Publication (page 5-54)

About Reference Pages
A reference page is an optional page that Site Builder builds when you turn source 
documents into body pages. There are five types of reference page. Their content (except 
for the Query page) is derived from one or more body pages and is automatically linked to 
them.

Publication Table of Contents (TOC)—Used to summarize the content of a publication. 
Not to be confused with the page TOC. Site Builder can also create a page TOC for each 
body page. This is part of the body page and summarizes the content of only that page.

List of Figures (LOF)—Can be used to create a special reference page that lists the 
figures in source documents.

List of Tables (LOT)—Can be used to create a special reference page that lists the tables 
in source documents.

Index—If the source documents contain index markers, Site Builder can use these entries 
to automatically generate an index, and link the index entries to the content of the body 
pages.

Query—Used to search the contents of you Web publication (in fact, the complete 
contents of the Content Server in which the Web publication resides). See Query 
Reference Page (page 6-191) for more information.

You create a TOC, LOF, or LOT in exactly the same way. And you can promote any 
content from any source documents to any one, two, or all three of these reference pages.
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Adding a Reference Page
A Web publication consists of two types of Web pages: body pages, which Site Builder 
creates when it translate a source documents, and optional reference pages, which Site 
Builder builds during translation.

Each publication can have four types of reference page (see About Reference Pages on 
page 5-52), which you add to the publication one at a time.

1. Do one of the following:

! Right-click anywhere in the Contents pane and choose Add Reference Page from 
the popup menu.

! Click Add Reference Page ( ) on the toolbar or large toolbar.

! Choose Reference Page from the Add menu.

The Add Reference Page dialog box opens.

2. Select the type of reference page you want to add, choose the appropriate template 
from the drop-down list, and click OK.

You can create an Index only if your source document contains index markers.

The Query is a special type of reference page that is used to search for content on a Web 
site. Once you add a Query page to a project, you must then specify the page in Globals. 
See Query Reference Page (page 6-191) for more information.

Creating Reference Pages
Creating a reference page is a three-step process, consisting of:

! Adding a reference page to a publication—In the Add Reference Page dialog box, 
you decide which reference page you want to add to your publication. (You can add 
all of them, if you want.) At this stage, the reference page has no content. It simply 
appears as an output page in the Contents pane.

! Promoting elements from source documents—You promote elements by editing 
the template containing those elements. You do this in the Promote tab dialog of 
Element Properties in Element Setup. When you “promote” elements, you simply 
make them available for inclusion in any reference page you choose to build. At this 
stage, the reference page still has no content.

! Selecting which of the promoted elements should be placed in the reference 
page—Since any promoted element is available for inclusion in any reference page, 
you must edit the template for the specific reference page you want to include the 
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promoted elements. (The same elements can be promoted to more than one reference 
page.) That is, you must formally add the element to the body of the reference page (in 
the Elements tab dialog of Element Setup). When this is done, you have determined 
what content will appear in the reference page once you translate the publication and 
build the reference page.

By default, the elements Heading 1 and Title (System) are promoted from source 
documents to the publication TOC (the latter is promoted as “Title”).

The above applies to the publication TOC, List of Figures, and List of Tables. The Index is 
a special type of reference page that you can create only if your source documents contain 
index markers. Also, promotion is not required for an Index, since standard default 
elements are used for content.

The Query reference page is also a special reference page, which is used to search the 
content of your Web publication. Once you add a Query to your Web publication, you 
must set options for the page in the Query tab dialog of Globals. See Query Reference 
Page (page 6-191) for more information.

Removing a Document or Reference Page From 
a Publication
You can remove a document or reference page from a publication at any time.

To remove a document or reference page:

1. In the Contents pane, select the source document or reference page.

2. Click Delete ( ) on the toolbar or choose Delete from the Edit menu.

When you delete a source document or reference page in this way, you simply remove the 
source document or reference page from the publication. The original source document is 
unchanged. The template associated with the document or reference page is still available 
in the publication.

If you delete a source document or reference page after you have translated a publication, 
you might also want to the delete the appropriate files from your output directory.

You can also use the Cut command from the Edit menu or toolbar. If you do, and change 
your mind, you can then use the Paste command to return the source document or 
reference page to the publication.
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TEMPLATES
A template is a set of formatting instructions you can associate with one or more source 
documents in a publication. It is saved as part of the project file.

When you add a document to a publication, you associate a template with that document. 
When Site Builder imports styles (or patterns) from the document, it automatically 
generates an element for each style (or pattern), and places the elements in the template. 
(If you use the default setting None in the Choose Template dialog box, Site Builder will 
associate ranks with elements instead.)

To turn a source document into a Web page, you select the template associated with the 
document and edit the template, using the four Template Editing Options (page 6-9).

You can associate only one template with any given source document, but you can 
associate the same template with many different documents.

A template typically isn’t a standalone file, but you can export a template to create one. 
You can then import the template file into another project (to become an internal 
template).

Alternatively, any workstation with access to a standalone template file on the file system 
can link to that template and use the template to format source documents. However, you 
cannot change the settings of a template while it is linked. You must import the linked 
template into a project in order to modify it.

If the template associated with a document is internal, you can change it at any time. In the 
Contents pane, select the template and open the Choose Template dialog box. (You can 
also open the Choose Template dialog box from the Document Properties dialog box.)

See Chapter 6 (Templates) for more information about templates.

LAYOUT OPTIONS
This section covers the following topics:

! Layout Options: Frameset, HTML Table, and Custom Table (page 5-56)

! HTML Framesets (page 5-57)

! HTML Tables (page 5-68)

! Custom HTML Tables (page 5-84)
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Layout Options: Frameset, HTML Table, and 
Custom Table
The Layout feature can be used to create a frameset, HTML table, or custom table layout 
for your Web publication.

With a frameset layout, you use the individual frames for site navigation, source content, 
and referencing other files in a Web browser. Table-based layout can accomplish the 
same, while also lending structure and appearance to the Web page. Custom table layout 
gives you the opportunity to create your own Web page layout, possibly from a third-party 
HTML editor, and then use that layout for your Web publication.

Figure 5-1 Layout options

When you first enter the Layout dialog box, the default setting under Active Layout is 
None. Once you select Frame Layout or Table Layout, you have a similar set of options 
available to create the frameset or table you want. You can select from the components in 
the lower left, place them in a frame or HTML table, and use the buttons on the right to 
modify the frameset or table properties.

If you select Custom Table Layout, you can copy and paste the supplied tokens (static, 
dynamic, and template) into your own custom HTML. You can include the HTML in the 
text box or browse to a separate HTML file on your file system or in Content Server.

You apply the layout to a single publication at a time (either the root or a subpublication) 
by selecting the publication in the Publication Hierarchy window. You can use the same 
layout for some or all of the publications in a project, and can easily apply one layout 
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you've created to any other publication. (See Copying a Frameset on page 5-59 and 
Copying an HTML Table on page 5-72.)

Framesets, HTML tables, and custom tables layout are explained in greater detail in the 
following Help topics:

! About Framesets (page 5-58)

! About HTML Tables (page 5-69)

! About Custom Table Layout (page 5-68)

You must assign a component to each frame of a frameset before you can switch to Table 
layout or exit the Layout dialog box. And you must assign the Body Pages icon to one of 
the cells of an HTML table before you can switch to the Frameset layout or exit the Layout 
dialog box. If you create a frameset or table and then change your mind, you can simply 
delete the existing layout and then exit the Layout dialog.

HTML Framesets
This section covers the following topics:

! About Framesets (page 5-58)

! Associating a Frameset With a Publication (page 5-58)

! Copying a Frameset (page 5-59)

! Creating a Frameset (page 5-59)

! Editing a Frameset (page 5-61)

! Editing Frame Properties (page 5-61)

! Editing Frameset Properties (page 5-62)

! Frame Properties (page 5-62)

! Frameset Properties (page 5-63)

! Handling an Event Within a Frameset (page 5-64)

! Populating the Frames of a Frameset (page 5-65)

! Targeting a Frameset (page 5-65)

! Adding a Frameset to the Frameset Gallery (page 5-66)

! Applying a Frameset From the Gallery (page 5-67)
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! Selecting a Frameset From the Gallery (page 5-67)

! Selecting a Frameset From the Gallery (page 5-67)

About Framesets
A frameset is a structure of frames used to organize the content of a Web publication and 
control where content displays in a Web browser. You can create a frameset of a single 
frame or leave a publication unframed. But in either case your ability to display content 
and permit navigation through your Web publication will be severely limited.

Most publications will benefit from a frameset of at least two frames (one for a table of 
contents, the other for body pages). By using several frames, you can create a potentially 
more powerful publication that displays different kinds of information onscreen at the 
same time and offers the user multiple navigation options.

Each publication can have its own frameset. Alternatively, the same frameset can be used 
for some or all the publications in a project. Site Builder lets you populate the frames of a 
frameset with different kinds of content and to associate an event with the frameset itself.

Any frameset created for one project can be available for all other projects by adding it to 
the Frameset Gallery.

Associating a Frameset With a Publication
The Frameset Gallery contains all the framesets that are available to you in Site Builder. 
Included are those shipped with Site Builder as well as any you choose to create and add to 
the Gallery.

You can associate any frameset from the Gallery with one or more publications in your 
project.

1. Click Layout ( ) on the toolbar to open the Layout dialog box.

2. In the Publication Hierarchy box, select the publication you want to associate a 
particular frameset with. If a frameset is already associated with the publication, it will 
display in the Frameset window.

3. Click Gallery to open the Frameset Gallery dialog box.

4. Select the frameset you want to associate with the publication and click OK.

5. Select one of the three options, depending on whether you want to apply the frameset 
to the selected publication, to that publication and its subpublications, or to all 
publications in the project.

6. Select the Active Layout option to make the frameset active for this publication.
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7. Click OK to return to the main window.

Copying a Frameset
You can simplify the creation of framesets by copying the frameset for one publication 
and applying it to one or more other publications in the same project.

1. In the Layout dialog box, right-click the publication in the Publication Hierarchy box 
for the frameset you want to copy. The frameset appears in the Frameset window 
opposite.

2. Choose Copy from the popup menu.

3. To apply the frameset to a single publication, right-click the target publication and 
choose Paste from the popup menu.

4. To apply the frameset to a specific publication and all its subpublications, right-click 
the target publication, choose Paste Special from the popup menu, and then choose 
This publication and all subpublications from the submenu.

5. To apply the frameset to all publications in the project, right-click any publication, 
choose Paste Special from the popup menu, and then choose All publications in the 
project from the submenu.

6. Click OK to return to the main window.

A frameset must be valid in order to copy and apply it to other publications. That is, you 
must assign content to each frame. (You can accomplish this, for example, by assigning a 
TOC to a frame in the Layout dialog box, even though you haven’t formally added a TOC 
to your project.)

When you copy a frameset, you copy the frameset structure, the frame names and assigned 
content, and all frameset and frame properties.

Creating a Frameset
Each publication in a publication hierarchy can have its own frameset. You can either 
create a new frameset for the publication or select an existing frameset from the Gallery. 
(See Selecting a Frameset From the Gallery on page 5-67.)

Tech Tip: The simplest way to review all the framesets in a project is to enter the Layout 
dialog box. As you click on each publication in the Publication Hierarchy box, the 
frameset associated with the publication will display in the frameset window.
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1. Click Layout ( ) on the toolbar or right-click anywhere in the Publication 
Hierarchy pane and choose Layout from the popup menu to open the Layout dialog 
box.

2. In the Publication Hierarchy box, select the publication you want to create a frameset 
for and then select Frame Layout beneath the Active Layout field.

3. Click the New Vertical or New Horizontal button to start the process of creating the 
frameset. Add additional frames to complete the frameset (see Tips below).

4. If necessary, drag-and-drop the Body Pages icon to another frame. (Body pages can 
populate only a single frame of a frameset but this can be any frame.)

5. To add reference pages to the frameset, drag-and-drop icons from the Components 
box to the appropriate frames.

6. To populate a frame with something other than body or reference pages, double-click 
the frame to open the Frame Properties dialog box.

7. Click the Contents tab. Select This specific page and enter the path and name of the 
file you want to include or reference, or click Browse to locate the file.

8. Click OK to return the Layout dialog box. To save the frameset for use with other 
projects or publications, click Add to the Gallery.

9. Click OK to return to the main window.

Tips
! To add a frame, right-click an existing frame and choose New Vertical or New 

Horizontal from the popup menu. You can also place your cursor on any existing 
frame border or the outside edge of the frameset, press the Control key, and use drag-
and-drop to create a new frame.

! To delete any frame, select the frame and click Delete.

! If you add a reference page icon to a frame, you must also add the reference page to 
the publication. Otherwise, you will create an empty frame when you translate the 
publication.

! Any file referenced in the Contents tab dialog of the Frame Properties dialog box will 
be automatically picked up by Site Builder for translation. However, if that file 
references a graphics file, say, then the graphics file will have to be listed in the 
Associated Files dialog box in order to become a part of the project.
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Editing a Frameset
You can edit any frameset in your project or one that is in the Frameset Gallery.

Follow this process to edit a frameset in your project:

1. Click Layout ( ) on the toolbar to open the Layout dialog box.

2. In the Publication Hierarchy box, select the publication for the frameset you want to 
edit. The frameset displays in the frameset window.

3. Edit the frame, as appropriate.

4. To edit another frameset, select another publication in the Publication Hierarchy box 
to display the frameset for that publication in the frameset window.

5. To save any frameset to the Frameset Gallery, click Add to Gallery and either label 
the revised frameset with the same name (to overwrite the original version, if there is 
one in the Gallery) or give the frameset a new label.

Follow these steps to edit a frameset in the Frameset Gallery:

1. Click Layout ( ) on the toolbar to open the Layout dialog box.

2. Click Gallery to open the Frameset Gallery.

3. Select the frameset you want to edit, and click OK to return to the Layout dialog box, 
where the frameset displays in the frameset window.

4. Edit the frameset.

5. Click Add Frameset to Gallery. To replace the original version of the frameset with 
the edited version, enter the same label in the textbox and click OK. To add the 
revised frameset to the Gallery while keeping the original version of the frameset, 
enter a new label and click OK.

6. Click OK in the Layout dialog box to return to the main window.

To edit a frameset, you change the properties of the frameset in the Frameset Properties 
dialog box and the properties of individual frames in the Frame Properties dialog box.

Editing Frame Properties
The properties of a frame are summarized in the Frame Properties dialog box. You can 
change these properties at any time.

To edit the properties of a frame:

1. In the Layout dialog box, double-click the frame you want to edit.
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2. In the Frame Properties dialog box, edit each of the fields, as appropriate.

3. Click OK.

See Frame Properties (page 5-62) for details on each of the fields in this dialog box.

Editing Frameset Properties
The properties of a frameset are summarized in the Frameset Properties dialog box. You 
can change these properties at any time.

1. In the Layout dialog box, click the Frameset Properties button to open that dialog 
box.

2. In the Frameset file name text box, change the name of the file, if you want to.

3. In the Frameset Title text box, enter the title you want to give the frameset. The title 
will appear in the title bar of your browser. (It will override any title you set in the 
Titles tab dialog of Globals. If you leave this box empty, the path and name of the 
frameset file will appear in the browser title bar, instead.)

4. Under Events, click Include HTML or scripting code in the frameset if you want to 
include code in the frameset. Then make the appropriate selection depending on 
whether you are specifying the code itself or specifying a file that contains the code. 
(If the latter, see Handling an Event Within a Frameset (page 5-64).)

If you reference a file that is in Content Server, this will activate the Info ( ) 
button and thereafter you will be able to open the Content Information page for 
that file.

5. Click OK to return to the Layout dialog box.

Frame Properties
The properties of a frame are summarized in the Frame Properties dialog box.

The General tab dialog contains:

! Name—The default name of the frame, which is used when linking between frames. 
For example, this would be the target name if you want another Web publication to 
display in the frame. Site Builder assigns a unique name to each frame of a frameset.

! Title—The title of the frame, which will appear in the source for the frameset. 
(Disabled visitors to your Web site can view this information in an HTML screen 
reader and thus quickly navigate through your Web site to read the contents of those 
frames they are interested in. Ideally, your frame titles should be as descriptive as 
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possible.) Once you create a title that is different from the frame name, the title will be 
visible at the top of the frame in the Layout dialog box.

! Sizes—Lets you adjust column width and row height, which may be “relative” by 
default where the size of one frame is determined by the size of another frame. For 
example, if you set a specific width for a TOC in the left-hand frame of a two-frame 
frameset, this will determine the column width of the second frame. Both 
measurements can be set in pixels or as a percentage of screen size (the default).

! Options—Settings for the border between frames, to allow users to re-size frames, 
and to display scrollbars. The first two options should be set the same for adjacent 
frames. A scrollbar will only appear in a frame of a Web publication if you select the 
Scrollable check box and the scrollbar is necessary in order to display additional 
information in the frame.

! Margins—Determine the distance (in pixels) between content and the borders of 
a frame. For text, you will probably want a margin. For graphics, you may want to 
eliminate the margin all together. To do this, select both check boxes and set the 
values to zero (as opposed to clearing the check boxes). This is best because different 
browsers may interpret this setting differently.

The Contents tab dialog contains options for content. If you have assigned one or more 
icons for body pages and reference pages to a frame, these will display in the Components 
box. Alternatively, you can specify a graphics file or other file here.

To open the Frame Properties dialog box, double-click the frame in the frameset in the 
Layout dialog box. To edit the properties of a frame, see Editing Frame Properties 
(page 5-61).

Any file referenced in the Contents tab dialog is automatically an “associated file” and 
will be translated by Site Builder with all the other files in your project. However, if the 
referenced file contains a reference to another file – say, a graphics file – that file should 
be added to your list of Associated Files. See Associating a File With a Publication 
(page 5-99).

If you reference a file that is in Content Server, this will activate the Info ( ) button 
and thereafter you will be able to open the Content Information page for that file.

Frameset Properties
The properties of a frameset are summarized in the Frameset Properties dialog box. You 
can change these properties at any time, by clicking the Frameset Properties button in the 
Layout dialog box.
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! Name – The name of the frameset. Site Builder uses the same default name, 
Frame.htm, for every frameset. If you change the extension of output files to html, the 
name for any new frames created will be Frame.html.

! Frameset title – The title that will appear in the title bar of your browser. See Editing 
Frameset Properties (page 5-62).

! Events – Allows you to associate an event with a frameset, so that a particular event is 
triggered each time the frameset opens. See Handling an Event Within a Frameset 
(page 5-64).

Handling an Event Within a Frameset
You can assign an event handler to a frameset that is triggered each time an event occurs 
in your browser. Such an event handler might be onLoad or onUnload. You could also 
include HTML code or JavaScript within the frameset.

1. Click Layout ( ) on the toolbar to open the Layout dialog box.

2. In the Publication Hierarchy box, select the publication containing the frameset you 
want to edit and click the Frameset Properties button to open that dialog box.

3. Under Events, click Include HTML or scripting code in the frameset, and then 
click either Use the following or Use the contents of this file.

4. If you click Use the following, enter the code you want to use in the box provided.

5. If you click Use the contents of this file, enter the path and file name in the text box, 
or click Browse to locate the file, or click Gallery to pick a file from the HTML Code 
folder in the Gallery.

6. Click OK.

If you select Use the contents of this file and the referenced file references another file, 
such as a graphic, this file should be listed in Associated Files so that Site Builder will 
copy this file to the output directory when you translate the publication. See Associating a 
File With a Publication (page 5-99).

If you reference a file (step 5) that is in Content Server, this will activate the Info ( ) 
button and thereafter you will be able to open the Content Information page for that file.

To temporarily remove an event handler from a frameset but keep it available for future 
use, clear the Include HTML or scripting code in the frameset check box. When you’re 
ready to assign the event handler once more within the frameset, select the check box.

See Handling an Event Within a Body Page (page 6-179), Handling an Event for an 
Element (page 6-23), and Tokens for Adding HTML Code (page 6-186).
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Populating the Frames of a Frameset
You can populate the frames of a frameset with different kinds of content.

! Body pages—By default, the Body Pages icon is automatically added to one of the 
frames as you create a frameset. Body pages can be assigned to only a single frame in 
the frameset, but you can drag-and-drop the Body Pages icon to place this content in 
any frame.

! Reference pages—You can assign one, several, or all the reference pages to frames, 
using drag-and-drop to move the icons from the Components box to the appropriate 
frames. You can even assign more than one type of reference page to the same frame. 
If you do, you will have to be sure to link the reference pages.

! Other—In addition to body and reference pages, you can populate frames in other 
ways. For example, you could assign a banner graphic to a frame or specify a URL for 
a Web site to display in that frame. You do this by selecting a frame in the Layout 
dialog box and opening the Contents tab of the Frame Properties dialog box.

In addition to populating the frames of a frameset, you can also associate an event with the 
frameset itself. See Handling an Event Within a Frameset (page 5-64).

Depending on what type of content you assign to a frame in the Frame Properties dialog 
box, you may also need to reference files or graphics in the Associated Files dialog box. 
See Associating a File With a Publication (page 5-99).

Targeting a Frameset
If the publication you create is to be placed within a user-defined frameset, you will have 
to specifically target the user-defined frameset in your publication.

If you accept the default link when creating a Web publication in Site Builder, and your 
publication is referenced from within a user-defined frameset, problems inevitably arise as 
soon as you navigate within the publication. That's because any references to the default 
TARGET=_top override the existing frameset. Instead of appearing within just a single 
frame of the existing frameset, the publication takes control of the whole browser window.

To avoid this, you can specify a parent frame in an existing frameset within which the 
publication must appear. You do this by replacing the standard attribute parameter “_top” 
with one of your own, which can be used to reference the publication in any links within 
the existing frameset.

1. On the View menu, click Project Options to open that dialog box.
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2. On the General tab dialog, under Containing Frame Name, enter the name of the target 
frame of the user-defined frameset. For example, you might target the frame named 
“custom” in the existing frameset (an underscore before “custom” is not required).

Any new frame name you enter will be available from the drop-down list when you 
enter the Project Options dialog box in future.

3. Click OK to return to the main window, and click Save ( ) to save the change to 
your project file.

Adding a Frameset to the Frameset Gallery
The Frameset Gallery contains all the framesets that are available to you in Site Builder. 
Included are those shipped with Site Builder as well as any you choose to create and add to 
the Gallery.

A given publication can have only one frameset associated with it, but you can associate 
the same frameset with some or all of the publications in a given project. When you select 
a frameset from the Gallery, Site Builder gives you the option of applying the frameset to 
the publication only, to the publication plus all subpublications of the publication, or to all 
publications and subpublications in the project.

You can edit framesets at any time, including those shipped with Site Builder. You can 
also delete any frameset in the Gallery.

You can create new framesets and add them to the Gallery at any time.

1. In the Layout dialog box, create the frameset you want to preserve for future use.

2. Click the Add Frameset to Gallery button to open that dialog box.

3. In the text box, type the name you want to use for the frameset. Add a description of 
the frameset if you feel this will be useful when selecting a frameset from the Gallery 
in the future.

4. Click OK. The new frameset has now been added to the Framesets Gallery. You can 
confirm this by clicking the Frameset Gallery button to open the Gallery.

The frameset you have created can be associated with any publication.

The frameset name and the frameset file name are not the same. The frameset name is 
simply the name you give a frameset when you save it in order to differentiate it from 
other framesets in the Gallery. The frameset file name is a property of a frameset (see the 
Frameset Properties dialog box), which can be important when creating navigation links.
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Applying a Frameset From the Gallery
The Frameset Gallery contains all the framesets available to you for your projects in Site 
Builder. Included are those shipped with Site Builder as well as any you choose to create 
and add to the Gallery.

When you open any frameset from the Gallery for a specific publication, you can apply 
the frameset to some or all of the other publications in the project, if you want.

1. In the Frameset Gallery, select the frameset you want to use and click OK. The Apply 
Gallery Frameset dialog box opens.

2. Select one of the three options, depending on whether you want to apply the frameset 
to just the selected publication, to that publication and its subpublications, or to all 
publications in the project.

3. Select the Active Layout option to make the frameset active for this publication.

4. Click OK.

You can also apply any existing frameset within a project to some or all the other 
framesets in a project. See Copying a Frameset (page 5-59).

Selecting a Frameset From the Gallery
The Frameset Gallery contains all the framesets that are available to you in Site Builder. 
Included are those shipped with Site Builder as well as any you choose to create and add to 
the Gallery. You can select any frameset from the Framesets Gallery to associate with one 
or more publications in your project.

1. Click Layout ( ) on the toolbar or right-click anywhere in the Publication 
Hierarchy pane and choose Layout from the popup menu to open the Layout dialog 
box.

2. In the Publication Hierarchy box, select the publication you want to associate a 
frameset with and then select Frame Layout beneath the Active Layout field (if the 
publication is not currently associated with a frameset).

3. Click Gallery to Open the Framesets Gallery.

4. From the list of available framesets, select the one you want to associate with the 
selected publication and click OK.

5. In the Apply Gallery Frameset dialog box, select one of the three options for 
applying the frameset to the publications in your project.

6. Click OK.
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If you apply the frameset to a publication and all its subpublications and later create a new 
subpublication for that publication, you will have to apply the frameset to the new 
subpublication.

HTML Tables
This section covers the following topics:

! About Custom Table Layout (page 5-68)

! About HTML Tables (page 5-69)

! Associating an HTML Table With a Publication (page 5-69)

! Cell Properties of an HTML Table (page 5-70)

! Copying an HTML Table (page 5-72)

! Creating an HTML Table (page 5-73)

! Editing an HTML Table (page 5-74)

! Editing the Cell Properties of an HTML Table (page 5-75)

! Editing the Table Properties of an HTML Table (page 5-76)

! HTML Table Cells and Dynamic Includes (page 5-77)

! Populating the Cells of an HTML Table (page 5-80)

! Table Properties of an HTML Table (page 5-81)

! HTML Table Gallery (page 5-83)

About Custom Table Layout
One of the layout options in Site Builder is to create your own Web site layout by using 
custom table layout. This option is especially useful if you are creating your Web site look 
and feel in a third-party HTML editor such as Macromedia Dreamweaver, Microsoft 
FrontPage, or Adobe GoLive.

You can create a custom table layout by inserting reference pages and body pages that use 
the tokens supplied on the Custom Table Layout page of the Layout dialog box. (See 
Tokens for Adding HTML Code on page 6-186.)

On the Custom Table Layout page, the tokens are grouped in three columns: For Static 
Inclusion, For Dynamic Inclusion, and Template Tokens. A static include token can be 
pasted directly into your HTML code. (Just select and copy the token, and then paste it 
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into your HTML code.) A static include places the contents of the reference page directly 
in the output page. Each time the source file is changed, a static include will rebuild your 
Web page. So you may encounter a performance degradation not found with a dynamic 
include.

You can create a dynamic include in the same way. A dynamic include requires scripting 
syntax around the dynamic include token. This scripting syntax will depend on the 
scripting language you have chosen for your include (Idoc, ASP, SSI, or JSP). A Web 
page with dynamic includes is assembled by the Webserver when the page is requested. 
For syntax examples, see HTML Table Cells and Dynamic Includes (page 5-77).

The third column on the Custom Table Layout page is for template tokens, which act as 
placeholders for HTML markup from templates.

Your custom HTML will be included in the output pages of your publication when you 
translate, stage, and publish. Any file that is referenced in your custom HTML (graphics, 
templates, CSS, etc.) will not be automatically included. As such, you will need to add 
these files as associated files to your project. (See Associating a File With a Publication on 
page 5-99.)

About HTML Tables
HTML tables are similar to tables in a source document. However, in addition to using 
HTML tables to present information in a tabular fashion, you can also use them to control 
the layout of a Web page.

An HTML table comprises individual cells (just as a frameset comprises frames). With a 
simple table of two cells, you could use the left cell for your site navigation and the right 
cell for body content. With a more sophisticated table that has multiple cells, you could 
place text, graphics, and various objects in the different cells. You can also assign table 
attributes and scripting events (onClick, onMouseOver, etc.) to the table itself.

Most publications would benefit greatly from the use of an HTML table layout. Current 
Web site design practices include the creative placement of items on a Web page, and 
HTML tables let you do just that. Each publication in your project can have its own table, 
or the same table can be applied to some or all of the publications in the project, thus 
allowing you to assign a mixture of static and dynamic content in a variety of ways.

Associating an HTML Table With a Publication
The Table Gallery contains all the tables available to you for your projects in Site Builder. 
Included are the sample tables that are shipped with Site Builder as well as any tables you 
choose to create and add to the Gallery. 
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You can associate any table from the Gallery with one or more publications in your 
project.

1. Click Layout ( ) on the toolbar to open the Layout dialog box.

2. In the Publication Hierarchy window, select the publication you want to associate a 
particular table with. The existing table layout will display in the viewing area. If no 
table is associated with the publication, select Table Layout beneath the Active 
Layout field.

3. Click Gallery to open the Table Gallery dialog box.

4. Select the table you want to associate with the publication and click OK.

5. Select one of the three options, depending on whether you want to apply the table to 
the selected publication, to that publication and its subpublications, or to all 
publications in the project.

6. Select the Active Layout option to make the table layout active for this publication.

7. Click OK to return to the main window.

The simplest way to review all the tables in a project is to enter the Layout dialog box. As 
you click on each publication in the Publication Hierarchy box, the table associated with 
the publication will display in the table window.

The HTML table selected for a publication will be applied to each document in the 
publication. If you want to assign a unique table to a specific document, first create a 
publication for that document and then assign the table to that publication.

If you are associating an HTML table that contains dynamic scripting (IDOC, ASP/SSI, 
or JSP), then you must modify your publication to recognize that scripting language. See 
HTML Table Cells and Dynamic Includes (page 5-77).

Cell Properties of an HTML Table
An HTML table has both table and cell properties. The cell properties are summarized in 
the Cell Properties dialog box. You can view the properties by selecting a cell and clicking 
the Cell Properties button on the Layout dialog box. (See Table Properties of an HTML 
Table on page 5-81.)

Attributes Tab
! Width and Height—Can be adjusted independently of table width and height. You 

can specify this value in pixels to maintain a specified aspect ratio or as a percentage 
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of the table, which will resize with a Web browser. This value can be changed in the 
Layout viewing area as well, using your mouse drag-and-drop function.

! Alignment—Controls the horizontal placement of text and graphics inside of a cell, 
much like the paragraph attributes of a Web page.

! Vertical alignment—Controls the vertical placement of text and graphics inside a 
cell.

! Background color—Creates a new background for the individual cell in a table, 
which will override the background color applied to the table itself.

! No wrap—Controls the behavior of the text in the cell. With this option selected, the 
text will extend beyond the margin of the Web page without returning to the next line.

! Header cell—Places an emphasis on the text inside the cell by making the default text 
centered and bold.

Contents Tab
! Don’t specify or The following component—Determines what content will appear in 

the cell. You can choose a component from your publication (Body Pages, TOC, 
Query, etc.) or use your own HTML (<Custom HTML>).

! Include statically or Include dynamically—Allows you to include content statically 
or dynamically. To place content dynamically in the cell, you must select a scripting 
language: IDOC (proprietary to Content Server), ASP (Active Server Pages) / SSI 
(Server Side Include), JSP (JavaServer Pages) or your own scripting language. See 
HTML Table Cells and Dynamic Includes (page 5-77).

! Use the following or Use the contents of this file—Allows you to place the cell 
content in the field provided or to attach a file from your file system or from Content 
Server.

Events Tab
! Include HTML or scripting code in the cell tag—Allows you to include custom 

HTML or script inside the HTML cell tags. An example might be an event handler 
such as onClick or onMouseOver.

! Use the following or Use the contents of this file—Allows you to enter the contents 
of your script in the field provided or to use the Browse and Gallery buttons to locate 
a remote file.
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! If you reference a file that is in Content Server, the Info ( ) button becomes active 
and thereafter you will be able to open the Content Information page for this file.

Copying an HTML Table
You can simplify the creation of HTML tables by copying an existing table for one 
publication and applying it to one or more other publications in the same project.

1. Click Layout ( ) on the toolbar or right-click a publication in the Publication 
Hierarchy pane and choose Layout from the popup menu to open the Layout dialog 
box.

2. In the Layout dialog box, right-click the publication in the Publication Hierarchy box 
for the table you want to copy and choose Copy from the popup menu.

! To apply the table to a single publication, right-click the target publication and 
choose Paste from the popup menu.

! To apply the table to a specific publication and all its subpublications, right-click 
the target publication, choose Paste Special from the popup menu, and then 
choose This publication and all subpublications from the submenu.

! To apply the table to all publications in the project, right-click any publication, 
choose Paste Special from the popup menu, and then choose All publications in 
the project from the submenu.

3. Click OK to return to the main window.

When you copy a table, you copy the table structure, assigned cell content, and all table 
and cell properties.

HTML tables are applied to each document in a publication. If you want to copy a table to 
a specific document, first create a publication for that document, and then copy the table 
layout to the publication.

If you are copying an HTML table that contains dynamic scripting (IDOC, ASP/SSI, or 
JSP), then you must modify your publication to recognize that scripting language. See 
HTML Table Cells and Dynamic Includes (page 5-77).

The simplest way to review all the tables in a project is to enter the Layout dialog box. As 
you click on each publication in the Publication Hierarchy window, the table associated 
with the publication will display in the table window.
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Creating an HTML Table
When you use a table-based layout for your Web publication, each publication in the 
publication hierarchy can have its own HTML table. You can create a new table for each 
publication or select an existing table from the Gallery. (See Applying an HTML Table 
From the Gallery on page 5-83.)

1. Click Layout ( ) on the toolbar or right-click a publication in the Publication 
Hierarchy pane and choose Layout from the popup menu to open the Layout dialog 
box.

2. In the Publication Hierarchy window, select the publication you want to create a table 
for (you can select a publication other than the one selected before you opened the 
dialog box). Under Active Layout, select Table Layout.

3. Click the Insert Table button to open the Insert Table dialog box.

4. Select the number of Rows and Columns for your table. (The rows and columns 
organize the individual cells of your table.) Click OK to return to Table Layout.

5. To modify the table or individual table cells, place your mouse over the appropriate 
border until it turns into a double arrow  and then drag the border to modify the 
table or cell to your preferred size. Alternatively, you can click Table Properties and 
Cell Properties to set the exact size in pixels or percent. (See Editing an HTML Table 
on page 5-74.)

6. To add content to a table cell, drag a component from the components window and 
drop it into the cell. (The Body Page icon  must be placed in one of the cells to 
create a table.) To add content other than a component, or to modify the way content is 
included in the cell, perform the following steps:

! Select a cell and click Cell Properties (or double-click the cell) to open the Cell 
Properties dialog box.

! Click the Content tab.

! Select The following component and choose the type of content to include in the 
cell.

! Select Include dynamically if you want the content to be displayed dynamically 
in the cell. (The Include static option will insert your content between the HTML 
cell tags.) See HTML Table Cells and Dynamic Includes (page 5-77).

! Click OK to return to the Table Layout dialog box.

7. To save your table for use with other projects or publications, click Add to Gallery.

8. Click OK to return to the main window.
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If you add a reference page icon to a cell, you must also add the reference page to the 
publication. Otherwise, you will create an empty cell when you translate the publication.

The Query icon is not available when you create an HTML table layout. You can still add 
a Query reference page to your project in the usual way, in the Contents pane. It will then 
be automatically placed in the table cell reserved for body pages.

Any file referenced in the Contents tab dialog of the Cell Properties dialog box will be 
included in your publication. However, if that file references a graphics file, then the 
graphics file must be listed as an associated file in order to be included in the project (see 
Associating a File With a Publication on page 5-99).

Unlike framesets, tables do not have a title or file name. The HTML table layout is 
embedded in your output Web pages.

A cell can contain only a single component (TOC, Body Page, etc.). To place different 
components near one another, you can create multiple cells or split your current cells.

Editing an HTML Table
Once you create an HTML table for the layout of your publication, you may want to edit 
that table later. (For help in creating tables, see Creating an HTML Table on page 5-73.)

1. Click Layout ( ) on the toolbar or right-click a publication in the Publication 
Hierarchy pane and choose Layout from the popup menu to open the Layout dialog 
box.

2. In the Publication Hierarchy window, select the publication you want to modify. The 
existing table layout displays in the viewing area.

3. Click Table Properties to modify the framework of your table layout, that is, the 
table itself. (See Editing the Cell Properties of an HTML Table on page 5-75.) You 
can quickly adjust the table height and width by placing your mouse over the border 
until it turns into a double-arrow ( ) and then adjust the table size.

Under Table Properties, you can modify the following attributes:

! Table height and width

! Table borders and background color

! HTML or scripting to include before and after the table

4. Click Cell Properties to modify the content of your table layout, that is, the individual 
cells of the table. (See Editing the Cell Properties of an HTML Table on page 5-75.) 
You can quickly adjust the cell height and width by placing your mouse over the 
border until it turns into a double-arrow ( ) and then adjust the table size.
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Under Cell Properties, you can modify the following attributes:

! Cell height and width

! Cell alignment (horizontal/vertical) and background color

! Content of the cell (component or source document)

5. To split a cell, highlight the cell (or cells) and click Split Cells.

6. To merge two cells together, drag your cursor over the cells you want to merge and 
click Merge Cells. (You can also navigate through the cells by using your arrow keys 
on the keyboard and select multiple cells to merge by using the Shift key in 
combination with the arrow keys.) 

If you merge two cells that both have content, the content of only one cell will be 
preserved. If one cell is above the other, the content of the top cell will take priority. If 
the cells are side by side, the content of the left cell will take priority. You should try 
to complete the structure of your table layout before adding content to the cells.

7. To delete your entire table layout, click Delete Table. (To remove individual cells, 
use the Merge Cells option.)

Table layout often resembles frameset layout. However, you can include a reference page 
in a cell statically or dynamically. If you choose to include the reference page 
dynamically, you must choose a scripting format: IDOC (Content Server format), ASP 
(Active Server Pages) / SSI (Server Side Include), JSP (JavaServer Pages), or your own. 
See HTML Table Cells and Dynamic Includes (page 5-77) for more information.

When creating a table with multiple cells, you may find yourself limited in certain 
instances. For example, you cannot create a table as shown in A. You would have to use 
the table layout shown in B, instead.

Editing the Cell Properties of an HTML Table
An HTML table has both table and cell properties. The cell properties are summarized in 
the Cell Properties dialog box. You can change them at any time. (See Editing the Table 
Properties of an HTML Table on page 5-76.)

A B
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1. In the Publication Hierarchy box, select the publication you want to modify. The table 
layout displays in the viewing area.

2. Double-click the cell you want to edit or select the cell and then click Cell Properties 
to open that dialog box.

3. Open the Attributes, Content, and Events tab dialogs, in turn, to specify the values 
for your cell. See Cell Properties of an HTML Table (page 5-70) for details on the cell 
property values.

4. Click OK to return to the Layout dialog box.

A cell can contain only a single component (TOC, Body Page, etc.). To place different 
components near to one another, create multiple cells or split an existing cell.

If you add a reference page icon to a cell, you must also add the reference page to the 
publication, in the main window. Otherwise, you will create an empty cell when you 
translate the publication.

If you want to include content dynamically in a table cell, you must select a scripting 
language and then modify your publication to recognize the selected scripting language. 
See HTML Table Cells and Dynamic Includes (page 5-77).

Any file referenced in the Use the contents of this file check box is automatically 
included in your project and is recognized by Site Builder when you translate. However, if 
that file references a graphics file, then you will have to make the graphics file an 
associated file in order for it to become a part of the project, too (see Associating a File 
With a Publication on page 5-99).

You can temporarily remove an event handler from a table but retain it for future use by 
clearing the Include HTML or scripting code in the table tag check box. When you’re 
ready to assign the event handler once more, select the check box.

Editing the Table Properties of an HTML Table
The properties of a table are summarized in the Table Properties dialog box. You can 
change these properties at any time. (See Editing the Cell Properties of an HTML Table on 
page 5-75.)

1. In the Publication Hierarchy window, select the publication you want to modify. The 
existing table layout displays in the viewing area.

2. Click Table Properties to open that dialog box.
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3. Open the Attributes, Events, and HTML tab dialogs to specify the values for your 
table. See Table Properties of an HTML Table (page 5-81) for details on the table 
property values.

4. Click OK to return to the Layout dialog box.

Unlike framesets, tables do not have their own title or file name. All of the information 
pertaining to HTML table layout is embedded in your body and reference page output 
files.

Any file referenced in the Use the contents of this file check box will be automatically 
picked up by Site Builder for translation. However, if that file references another file, such 
as a graphic, the second file should be included in your project as an associated file so that 
Site Builder will copy it to the output directory when you translate the publication (see 
Associating a File With a Publication on page 5-99).

You can temporarily remove an event handler from a table but retain it for future use by 
clearing the Include HTML or scripting code in the table tag check box. When you’re 
ready to assign the event handler once more, select the check box.

HTML Table Cells and Dynamic Includes
The content of the cell of an HTML table may be included statically or dynamically. 
“Dynamic includes” rely on a scripting language to insert content into the cell. You can 
choose from IDOC script, Active Server Pages (ASP) / SSI (Server Side Include), 
JavaServer Pages (JSP), or your own scripting language.

Each scripting language has a unique syntax for retrieving and displaying content in a 
Web page. Regardless of the scripting format you choose, your project will need to be 
modified to recognize the newly implemented script.

IDOC Script
! IDOC uses its own scripting syntax with a Transit token to dynamically include an 

existing reference page in a table cell. (See Tokens for Adding HTML Code on 
page 6-186.) The appropriate scripting syntax is placed in the Use the Following text 
box for you:

TOC
<$docLoadResourceIncludes( “dDocName=” & docRootFilename(“%%TRANSIT-
PATH(TOC)%%”) )$>
<$include TRANSIT_TOC_RESOURCE$>
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LOF
<$docLoadResourceIncludes( “dDocName=” & docRootFilename(“%%TRANSIT-
PATH(LOF)%%”) )$>
<$include TRANSIT_LOF_RESOURCE$>

LOT
<$docLoadResourceIncludes( “dDocName=” & docRootFilename(“%%TRANSIT-
PATH(LOT)%%”) )$>
<$include TRANSIT_LOT_RESOURCE$>

INDEX
<$docLoadResourceIncludes( “dDocName=” & docRootFilename(“%%TRANSIT-
PATH(INDEX)%%”) )$>
<$include TRANSIT_INDEX_RESOURCE$>

QUERY
<$docLoadResourceIncludes( “dDocName=” & docRootFilename(“%%TRANSIT-
PATH(QUERY)%%”) )$>
<$include TRANSIT_QUERY_RESOURCE$>

! If you choose Use the contents of this file, your attached file must follow IDOC 
scripting standards.

! The reference pages must use the .idoc extension and the remaining Web pages must 
use the .hcsp file extension and reside in Content Server to include the reference page 
in the table cell. (See Setting Check-In File Extensions on page 8-82 and see 
Overriding Staging and Publishing Options on page 8-21.)

! The template for the included reference page must contain the following HTML 
before and after, where xxx is the name of the reference page you are including: TOC, 
LOT, LOF, INDEX, or QUERY. (See Including HTML or Scripting Code in a Web 
Page on page 6-180.)

<@dynamichtml TRANSIT_xxx_RESOURCE@>
<@end@>

! Conflicts can occur when an included reference page retains the promoted element 
anchor tags. You can avoid conflicts in named anchors by omitting hyperlink targets 
for promoted elements. (See Omitting Hyperlink Targets for Promoted Elements on 
page 6-197.)

ASP (Active Server Pages) / SSI (Server Side Include)
! ASP and SSI use their own scripting syntax with a Transit token to dynamically 

include an existing reference page in a table cell. (See Tokens for Adding HTML 
Code on page 6-186.) The appropriate scripting syntax is placed in the Use the 
Following text box for you:
5-78 Content Publisher User Guide



Building a Publication
TOC

<!--#include file=“%%TRANSIT-PATH(TOC)%%”-->

LOF

<!--#include file=“%%TRANSIT-PATH(LOF)%%”-->

LOT

<!--#include file=“%%TRANSIT-PATH(LOT)%%”-->

Index

<!--#include file=“%%TRANSIT-PATH(INDEX)%%”-->

Query

<!--#include file=“%%TRANSIT-PATH(QUERY)%%”-->

! If you choose Use the contents of this file, your attached file must follow ASP or SSI 
scripting standards.

! Your publication Web pages must use the .asp (Active Server Pages) or .shtml 
(Server Side Includes) file extension. (See Specifying the Extension for Output Files 
on page 5-106.)

! Conflicts can occur when an included reference page retains the promoted element 
anchor tags. You can avoid conflicts in named anchors by omitting hyperlink targets 
for promoted elements. (See Omitting Hyperlink Targets for Promoted Elements on 
page 6-197.)

JSP (JavaServer Pages)
! JSP uses its own scripting syntax with a Transit token to dynamically include an 

existing reference page in a table cell. (See Tokens for Adding HTML Code on 
page 6-186.) The appropriate scripting syntax is placed in the Use the Following text 
box for you.

Scripting syntax

TOC

<%@ include file=“%%TRANSIT-PATH(TOC)%%” %>

LOF

<%@ include file=“%%TRANSIT-PATH(LOF)%%” %>

LOT

<%@ include file=“%%TRANSIT-PATH(LOT)%%” %>
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Index

<%@ include file=“%%TRANSIT-PATH(INDEX)%%” %>

Query

<%@ include file=“%%TRANSIT-PATH(QUERY)%%” %>

! If you choose Use the contents of this file, your attached file must follow JSP 
scripting standards.

! Your publication Web pages must use the .jsp file extension. (See Specifying the 
Extension for Output Files on page 5-106.)

! Conflicts can occur when an included reference page retains the promoted element 
anchor tags. You can avoid conflicts in named anchors by omitting hyperlink targets 
for promoted elements. (See Omitting Hyperlink Targets for Promoted Elements on 
page 6-197.)

If you add a reference page icon to a cell, you must also add the reference page to the 
publication, in the main window. Otherwise, you will create an empty cell when you 
translate the publication.

Any file referenced in the Use the contents of this file check box is automatically a part of 
the project and is recognized by Site Builder during translation. However, if that file 
references a graphics file, then you will have to make the graphics file an associated file in 
order to include it in the project (see Associating a File With a Publication on page 5-99).

Active Server Pages (ASP) and Server Side Includes (shtml) use the same syntax to 
include a dynamic reference page. As such, they share the same default scripting button.

Content Publisher provides two sample templates that can be used to generate dynamically 
includable reference pages. These specially formatted templates remove the HTML head 
and title tags. They also avoid conflicts in named anchors by omitting hyperlink targets for 
promoted elements. DynamicTOC_iDoc.ttp and DynamicTOC.ttp are available in the 
Support directory of your product disc. DynamicTOC_iDoc.ttp is used for IDOC scripting 
purposes. DynamicTOC.ttp is available for all other scripting languages.

Populating the Cells of an HTML Table
You can populate the cells of a table with different kinds of content.

! Body pages—Body pages (the content of your source documents) can be added to one 
of the cells in a table. You can drag the Body page icon ( ) and drop it into the cell. 
(Alternatively, you can open the Cell Properties dialog box and on the Content tab 
dialog select The following component and then select Body Pages from the drop-
down list.)
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! Reference pages—Reference pages (for the navigation for your site) can be added to 
one of the cells in the table just as you add body pages.

! Other—In addition to body and reference pages, you can populate cells in other ways. 
For example, you can assign custom HTML that references a banner graphic or 
another Web component for your site.

Each cell can contain only a single component (Body Pages, TOC, etc.). You can place 
two or more different components near each another by creating multiple cells or splitting 
an existing cell.

The Query icon is not available when you create an HTML table layout. You can still add 
a Query reference page to your project in the usual way, in the Contents pane. It will then 
be automatically placed in the table cell reserved for body pages.

If you choose to dynamically include content in a table cell, you must choose a scripting 
language and then modify your publication to recognize that scripting language. See 
HTML Table Cells and Dynamic Includes (page 5-77).

In addition to populating the cells of a table, you can also associate an event with the table 
itself. See Handling an Event Within a Frameset (page 5-64).

Depending on what type of content you assign to a cell in the Cell Properties dialog box, 
you may also need to reference files or graphics in the Associated Files dialog box. See 
Associating a File With a Publication (page 5-99).

If you are populating the cells of a table with a reference page (TOC, Index, Query, etc.) 
and do not want promoted element hyperlinks to interfere with your table navigation, you 
can disable this feature. See Omitting Hyperlink Targets for Promoted Elements 
(page 6-197).

Table Properties of an HTML Table 
An HTML table has both table and cell properties. The table properties are summarized in 
the Table Properties dialog box. You can view the table properties by clicking the Table 
Properties button on the Layout dialog box. (See Cell Properties of an HTML Table on 
page 5-70.)

Attributes Tab Dialog
! Width and Height—Determines the overall size of your table, including the cells 

embedded in your table. You can specify this value in pixels to maintain a specified 
aspect ratio or as a percentage of the screen, which will resize with a Web browser. 
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This value can be changed in the Layout viewing area as well, using your mouse drag-
and-drop function ( ).

! Wrapping—Affects the items that surround your table. When table wrapping is 
enabled, the text on a Web page will wrap around a table much like it can wrap around 
an image.

! Background color—Creates a new background for your table and all the cells 
embedded in your table.

! Border thickness—Controls the size of the outer edge of your table. This value can 
be increased to make a table stand out (such as a chart or a table listing) or it can be 
resized to 0 when used as a layout device.

! Cell spacing—Determines the distance between the cells in your table and is 
frequently used to create necessary white space between objects on a Web page.

! Cell padding—Determines the distance between the objects in a cell and the edge of 
the cell. Cell padding is used in the same manner that margins are used on a Web 
page.

Events Tab Dialog
! Include HTML or scripting code in the table tag—Allows you to include custom 

HTML or script inside the HTML table tags. An example might be an event handler 
such as onClick or onMouseOver.

! Use the following or Use the contents of this file—Allows you to enter the contents 
of a script in the field provided or to use the Browse and Gallery buttons to locate a 
remote file.

HTML Tab Dialog
! Include HTML or scripting code before the table—Allows you to place HTML or 

scripting before the table layout. This setting affects the entire table layout and 
therefore has a much broader use than the scripting options under Events.

! Include HTML or scripting code after the table—Allows you to place HTML or 
scripting after the table layout. You would likely use this to close out the variables or 
functions declared in the previous include.

! If you reference a file that is in Content Server, the Info button ( ) becomes active 
and thereafter you will be able to open the Content Information page for that file.
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HTML Table Gallery
This section covers the following topics:

! Applying an HTML Table From the Gallery (page 5-83)

! HTML Table Gallery (page 5-83)

! Adding an HTML Table to the Table Gallery (page 5-84)

Applying an HTML Table From the Gallery
The Table Gallery contains all the tables available to you for your projects in Site Builder. 
Included are the sample tables that are shipped with Site Builder as well as any tables you 
choose to create and add to the Gallery. 

When you open any table from the Gallery for a specific publication, you can apply the 
table to some or all of the publications in the project.

1. In the Publication Hierarchy box, select the publication you want to associate an 
HTML table with and then select Table Layout under Active Layout (if the 
publication is not currently associated with a table).

2. Click Gallery to open the Table Gallery dialog box.

3. Select the table you want to use and click OK. The Apply Gallery Table dialog box 
opens.

4. Select one of the three options, depending on whether you want to apply the table to 
just the selected publication, to that publication and its subpublications, or to all 
publications in the project. Click OK to return to the Layout dialog box.

5. Click OK again to return to the main window.

You can also apply any existing table within a project to some or all of the other 
publications in a project. See Copying an HTML Table (page 5-72).

If you are applying an HTML table that contains dynamic scripting (IDOC, ASP/SSI, or 
JSP), then you must modify your publication to recognize that scripting language. See 
HTML Table Cells and Dynamic Includes (page 5-77).

HTML Table Gallery
The Table Gallery contains all the tables that are available to you in Site Builder. Included 
are those shipped with Site Builder as well as any you choose to create and add to the 
Gallery.
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A given publication can have only one table associated with it, but you can associate the 
same table with some or all of the publications in a given project. When you select a table 
from the Gallery, Site Builder gives you the option of applying the table to the publication 
only, to the publication plus all subpublications of the publication, or to all publications 
and subpublications in the project.

You can edit tables at any time, including those shipped with Site Builder. You can also 
delete any table in the Gallery.

Adding an HTML Table to the Table Gallery
The Table Gallery contains all the tables available to you for your projects in Site Builder. 
Included are the sample tables that are shipped with Site Builder as well as any tables you 
choose to create and add to the Gallery. 

1. In the Layout dialog box, create the table you want to preserve for future use.

2. Click the Add to Gallery button to open that dialog box.

3. In the label text box, type the name you want to use for the table. Add a description of 
the table if you feel this will be useful when selecting a table from the Gallery in the 
future.

4. Click OK. The new table has been added to the Table Gallery. You can confirm this 
by clicking the Gallery button to see the most current Gallery.

The table you have created can be associated with any publication.

The label you assign to your HTML table (Step 3) is simply used to differentiate it from 
other tables in the Gallery. The label is not used in your project or Web publication.

Custom HTML Tables
This section covers the following topics:

! Creating a Custom Table Layout (page 5-84)

! Pulling Third-Party Web Pages Into a Publication (page 5-86)

Creating a Custom Table Layout
As an alternative to a frameset layout (see Creating a Frameset on page 5-59) or an HTML 
table layout (see Creating an HTML Table on page 5-73), you can create your own custom 
table layout for a publication. A custom table layout may be ideal for those wishing to 
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create a Web site look and feel by using an HTML editor that they are already familiar 
with.

1. Determine where your translated source documents (reference and body pages) will 
be placed in the custom HTML and place the tokens accordingly.

2. Click Layout ( ) on the toolbar or right-click a publication in the Publication 
Hierarchy pane and choose Layout from the popup menu to open the Layout dialog 
box.

3. In the Publication Hierarchy window, select the publication you want to create a 
custom table layout for. (You can select a publication other than the one selected 
before you opened the dialog box.) Under Active Layout, select Custom Table 
Layout.

4. Copy the appropriate token from the For Static Inclusion or For Dynamic Inclusion 
column and paste it into your custom HTML, where the source document (reference 
page or body page) should go. (See Tokens for Adding HTML Code on page 6-186.)

Dynamic includes require scripting syntax (Idoc, ASP, SSI, JSP) around the token. 
For syntax examples, see HTML Table Cells and Dynamic Includes (page 5-77).

5. Copy three tokens (all except <!-- TRANSIT - CUSTOMLAYOUT(BODY) -->) from 
the Template Tokens category into your custom HTML as follows:

! The 'TOP' token should be placed at the top of the Web page before the <HTML> 
tag.

! The 'HEAD' token should be placed between the <HEAD> tags.

! The 'Body Attributes' token should be placed in the <BODY> tag.

6. Finally, copy and paste all of your custom HTML from your HTML editor into the 
Use the following text box or browse to your custom HTML file with the Use the 
contents of this file option. (Your custom HTML file can be stored on a file system or 
in Content Server.)

7. Click OK to return to the main window.

If you add a reference page token to your custom HTML, you must also add the reference 
page to your publication. Otherwise, you will create an empty placeholder when you 
translate the publication.

Your custom HTML will be included in your publication when you translate, stage, and 
publish. However, if the custom HTML references another file, then that file must be 
added as an associated file in order to be included in the project. (See Associating a File 
With a Publication on page 5-99.)
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You can include reference pages in your custom HTML by using static or dynamic 
inclusion (see Step 4). As a static include, the reference page token will be replaced with 
the contents of the reference page. As a dynamic include, the reference page token will be 
replaced with a path to the reference page file, stored on your file system or in Content 
Server. Dynamic includes are preferred, because they allow for incremental translation, 
whereas changes to source content for static includes require your project to be published 
in full, which may result in a performance degradation.

The custom layout is applied to each source document in the selected publication. If you 
want to create a custom layout for a specific document, first create a publication just for 
that document, and then create a custom layout for that publication.

If you create a custom layout that involves scripting (IDOC, ASP/SSI, or JSP) and 
dynamic includes, then you must modify the file extensions of the output files of your 
project to recognize that scripting language. (See HTML Table Cells and Dynamic 
Includes on page 5-77.)

Content Publisher provides two sample templates that can be used to generate dynamically 
included reference pages: DynamicTOC_iDoc.ttp (for Idoc script) and DynamicTOC.ttp 
(for all other scripting languages), which are located in the Support directory of the 
product disc. These specially formatted templates remove potentially problematic HTML 
tags in your dynamic includes.

If you don’t place the <!--TRANSIT - CUSTOMLAYOUT(BODY)--> token, your output 
page will not have any body content.

Pulling Third-Party Web Pages Into a Publication
The web page you create in your third-party application, containing tokens, can be used as 
a custom layout for a publication. Content Publisher uses layouts to control the placement 
of items on a web page. (Content Publisher also uses templates to control the appearance 
and behavior of source content.)

Once your web page is complete in your third-party application (with template, reference, 
and body page tokens in place), the next step is to pull this file into a project. Depending 
on your company's organization, this step might be performed by another individual (one 
who administers Content Publisher).

1. With your project open in Content Publisher, click Layout ( ) on the toolbar or 
right-click a publication in the Publication Hierarchy pane and choose Layout from 
the popup menu.
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2. In the Layout dialog box, select the publication you want to create a custom table 
layout for (you can select a publication other than the one selected before you opened 
the dialog box). Under Active Layout, select Custom Table Layout.

Figure 5-2 Custom Table Layout page

3. Copy and paste your third-party source code into the Use the following text box or 
select Use the contents of this file and then browse to your third-party web page 
(stored on your file system or in Content Server).

4. Click OK to return to the main window.

If you add a reference page token to your custom HTML, you must also add the reference 
page to your publication. Otherwise, you will create an empty placeholder when you 
translate the publication.

Your custom HTML will be included in your publication when you translate, stage, and 
publish. If your custom HTML references another file (graphic, style sheet, etc.), then that 
file must be added as an associated file in order to be included in the project. (See 
Including Third-Party Content in Projects on page 5-115.)

If your custom table layout uses a scripting language (IDOC, ASP, SSI, or JSP), then the 
file extensions in the project output directories must match the scripting language. (See 
Modifying File Extensions in a Project on page 5-116.)
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The custom table layout is applied to each document in the selected publication. To create 
a custom table layout for a specific document, first create a publication for that document, 
and then create a custom table layout for that publication.

Conflicts can occur when an included reference page retains promoted element anchor 
tags. You can avoid this by selecting Omit hyperlink targets for promoted elements in the 
Globals area of your templates.

Content Publisher provides two sample templates that can be used to generate dynamically 
included reference pages: DynamicTOC_iDoc.ttp (for Idoc Script) and DynamicTOC.ttp 
(for all other scripting languages), both located in the Support directory of the Content 
Publisher product disc. These specially formatted templates remove potentially 
problematic HTML tags in your dynamic includes.

In addition to the Custom Table Layout option, Content Publisher provides a Frameset and 
Table layout, each of which contains a design area, sample galleries, and more.

DIRECTORY ITEMS
This section covers the following topics:

! Adding a Directory Item (page 5-89)

! Adding a Directory Item From the File System (page 5-89)

! Adding a Directory Item From Content Server (page 5-91)

! Adding a Dynamic Directory Item From the File System or an FTP Site (page 5-93)

! Updating a Dynamic Directory Item (page 5-94)

! Sorting Directory Items (page 5-94)

! Directory Item Options (page 5-95)

! Query Results Hierarchy (page 5-96)

! Importing Folders From the File System Hierarchy (page 5-97)

! The Dynamic Directory Item Versus the Folder Import Wizard (page 5-98)
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Adding a Directory Item
You can add a Directory Item from the following repositories:

! File system—See Adding a Directory Item From the File System (page 5-89)

! FTP site—See Adding a Directory Item From an FTP Site (page 5-10)

! HTTP site—See Adding a Directory Item From an HTTP Site (page 5-13)

! Content Server—See Adding a Directory Item From Content Server (page 5-91)

When using Site Builder standalone, the Directory Item command on the Add menu is 
grayed out and the Directory Item option in the Folder Import wizard is not available.

Adding a Directory Item From the File System
You can add a Directory Item to a project from different repositories, including the file 
system. (See Adding a Directory Item on page 5-89.) As a result, each time you run a 
translation, all files of the specified types in the directory at the time of translation are 
translated.

1. In the Publication Hierarchy pane, right-click the publication you want to add the 
Directory Item to and choose Add Directory Item from the popup menu.

2. In the Select a Repository dialog box, select File System from the drop-down list to 
open the New Directory Item Properties dialog box.

3. In the Directory text box, enter the path and name of the directory you want to add to 
the publication. Click Browse, if necessary, to locate the desired directory.

4. In the Title text box, enter a name for the directory.

This name can be used to create a title for your Web pages (see the Titles tab dialog in 
Globals). It will also appear on the title bar of the Properties dialog box once you exit 
the dialog box and then return to it again.

5. In the Include files matching the following file specification text box, enter file 
specifications for the types of files you want to translate. Separate multiple entries 
with semicolons. You can also use the wildcard to specify a partial file name.

Example 1 *.doc;*.123;*.wpd

Example 2 Sales*.doc (Site Builder will translate such files as SalesQ1.doc and 
SalesQ2.doc)
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6. In the Map file property text box, enter any information you want to appear in the 
directory element in the XML Map file that Site Builder will generate when it 
translates the project.

7. In the Prefix to be added to all output file names text box, enter the prefix to apply 
to each output file in this Directory Item. See Adding a Prefix to Output File Names 
(page 8-79) for more information.

8. Under Output Directories, enter the paths and names of the directories you want to use 
for the translated files from this directory. You can use different directories for output 
pages and graphics files, and you can enter a directory that doesn’t exist. (Site Builder 
will create the directory when it translates the files, assuming the directory can be 
created.)

9. Under Template, click Choose Template, to open the Choose Template dialog box. 
The Documents box in this dialog box lists all the documents currently in the selected 
directory that have the file specifications. A temporary translation of the first 
document on the list will display in the Preview window if the Auto button is checked. 
Pick the template you want to associate with the documents.

The default setting in Choose Template is None, which means that Site Builder will 
create a default set of ranks for the source documents. To import styles or patterns 
instead, select the appropriate option. 

10. Click OK to return you to the New Directory Item Properties dialog box, and OK 
again to return to the main window.

The Contents pane now displays a single entry for the directory item you have just added 
to the publication. Only *.htm displays in the Output column. When Site Builder translates 
all files in this directory, it will name them after the original file names, except for the 
change in extension.

Once you have completed the basic setup of a directory in the General tab dialog, you can 
click the Sort tab dialog to refine the order in which items in the directory are to be 
translated. See Sorting Directory Items (page 5-94) for more information.

On the Options tab dialog, you can set conversion options for passing through documents 
(see Passing Through Source Documents Without Conversion on page 5-38) and changing 
the output file extension (see Setting Check-In File Extensions on page 8-82).

A Directory Item can be empty when you add it to your project. Site Builder will check the 
specified folder each time you translate the project. If the folder contains source 
documents with the specified extensions, those documents will be translated.
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If you select Styles in the Choose Template dialog box, Site Builder will import styles 
only from those documents in the directory at the time the Directory Item is added. If you 
later add documents to the directory that contain new styles not in the template, you will 
have to import the new styles. To do so, right-click the Directory Item in the Contents 
pane and choose Import and then Styles from the popup menu.

Adding a Directory Item From Content Server
In Content Server, a Directory Item is defined by a query. Any source documents that 
meet the search criteria for the query are considered part of the Directory Item. You 
should use the Update Versions command to ensure that any source documents later added 
to Content Server that meet the search criteria are included in future translations.

1. In the Publication Hierarchy pane, select the publication you want to add the Directory 
Item to, and click Directory Item on the Add menu to open the New Directory Item 
Properties dialog box. (If necessary, select Content Server from the drop-down list 
and click OK.)

2. Click Browse opposite the Directory field to open the Directory Item Properties 
dialog box. Then click the Content Server button to open the Choose a Content 
Server dialog box, and select a content server from the drop-down list. (If only one 
content server is configured on your machine, it will be selected already.) Click OK to 
return to the New Directory Item Properties dialog box.

3. Under Directory Item Information, provide a name for the Directory Item. (This name 
will be added to the content server name and will display in the Contents pane. By 
naming Directory Items, you will be able to differentiate between multiple Directory 
Items that are added to the same publication of your project and drawn from the same 
content server.)

4. Select Restricted from the Type drop-down list (since it’s the default setting, it should 
be selected already).

5. In the Maximum document count box, enter the maximum number of source 
documents you want to include in the Directory Item in Content Publisher.

If you leave this blank, the number of documents returned will equal the number of 
documents returned as a result of the query in Content Server, up to the query result 
limit imposed by Content Server. The default limit in Content Server is 200.

Example: If you set up a query in Content Server using the default of 200 and set the 
Maximum document count in Site Builder to 40, you will only receive 40 files or 
fewer, depending upon the query results. If, instead, you set the document count in 
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Site Builder to 250, you will only receive 200 files or fewer depending upon the query 
results, because that is the limit set in the content server.

The Sort selections you make influence your results. See Sorting Directory Items 
(page 5-94) for more information.

6. From the Content Rendition drop-down list, select Alternate or Web if you prefer to 
add source documents to your project in other than their native format. Alternate is the 
alternative format, if any, that you provided the source document in when you added it 
to the content server. Web is the browser-ready version of your native file. Since this 
will be PDF in most cases, the Web option can be particularly useful for adding PDF 
files to your project. 

7. Click the Query button to open the Specify a Search dialog box in Content Server. Set 
your search parameters and click the Search button. Review the list of current hits 
resulting from the query to be sure that your Directory Item will capture all the 
documents you want to capture – and no additional ones. To refine the query, click the 
Back button and set new search parameters. If the list of documents is satisfactory, 
click the Add Query to Project button to return to the Directory Item Properties 
dialog box.

To create a folder hierarchy based on the metadata assigned to your content items, 
click Hierarchy (see Query Results Hierarchy on page 5-96).

8. Click OK to return to the New Directory Item Properties dialog box, where the 
Directory field will read \\<content server>\<query name> .

9. In the Title text box, enter a title for the Directory Item. (You don’t have to enter one. 
If you do, it can be used to populate titles of your output pages.)

10. Under Map File Property, you can enter text to specify a custom item that will be 
added to the output Map file (MapFile.xml). This could enable you, for example, to 
place security information in the Map file.

11. In the Prefix to be added to all output file names text box, enter the prefix to apply 
to each output file in this Directory Item. If publishing to Content Server, ensure that 
the file name, including all prefixes, is no more than 30 characters. See Adding a 
Prefix to Output File Names (page 8-79) for more information.

12. Under Output Directories, specify directories for output pages and graphics. Click 
Browse, if necessary, to locate the directories you want to use.

You don’t have to enter anything. By default, Site Builder uses the full path specified 
for the root publication and mirrors the publication hierarchy in the structure of the 
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output directories it creates. So you may want to simply enter just the names for the 
output directories you want to use.

13. Under Template, click Choose Template to open the Choose template dialog box. 
Select the template you want to associate with the source documents in the Directory 
Item, and click OK. Click OK again, to return to the main window.

When you created a restricted Directory Item, you must select Restricted (step 4) before 
you create the query (step 6).

To edit the query for a Directory Item at any time, click the Info button on the Directory 
Item Properties dialog box to open the Details dialog box, and then click Modify. See 
Criteria of a Directory Item in Content Server (page 5-30) for more information.

On the Options tab dialog, you can set conversion options for passing through documents 
(see Passing Through Source Documents Without Conversion on page 5-38) and changing 
the output file extension (see Setting Check-In File Extensions on page 8-82) during 
check-in to the content server.

Adding a Dynamic Directory Item From the File 
System or an FTP Site
When you add a Directory Item from the file system or an FTP Site, you can turn it into a 
dynamic Directory Item by selecting the Include Subfolders option, which is turned off by 
default.

With the default setting, you add a Directory Item and therefore only the individual source 
documents of the specified folder. When you select Include Subfolders, Site Builder not 
only imports the specified folder, but also the complete hierarchy of folders below that 
folder. It automatically processes source documents in all of the folders.

1. In the New Directory Item Properties dialog box, once you have specified the 
Directory Item and selected a template, click Options to open that tab dialog.

2. Under Dynamic, select Include subfolders.

3. Click OK to return to the main window.

The dynamic Directory Item and the Folder Import wizard both can be used to add source 
documents to a publication. For a comparison of the two methods, see The Dynamic 
Directory Item Versus the Folder Import Wizard (page 5-98).
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Updating a Dynamic Directory Item
When your project contains dynamic Directory Items, you must use the Update Versions 
Command (page 8-9) to update the project before translation. That’s because Site Builder 
not only checks for the newest version of each source document, but also for any structural 
change in the dynamic Directory Item.

If you have added a new folder to a dynamic Directory Item since the last time you 
translated, Site Builder will recognize this and include the new folder in the next 
translation.

1. Click Update Versions on standard toolbar ( ) or on the Run menu.

2. If the Update Versions dialog box opens, click OK. 

See Update Versions Command (page 8-9) for more information on this dialog box and 
how to automate the updating process in Site Builder.

When you schedule projects to run on Site Server, all source documents and Directory 
Items are automatically updated, because Site Server can execute four commands—
Update Versions, Translate, Stage, and Publish—automatically.

Sorting Directory Items
When you add a Directory Item to a publication, you can determine the sort order of the 
documents in that directory when they are translated. The order is important because it 
will determine how the output files are linked and the order in which the Web pages you 
create can be browsed onscreen.

See Adding a Directory Item From the File System (page 5-89) for information on setting 
up a Directory Item.

1. If you previously specified a Directory Item, right-click the directory Item in the 
Contents pane and choose Properties from the popup menu.

2. In the Directory Item Properties dialog box, click Sort to switch to that tab dialog.

3. If you are setting sort options for a Directory Item added from Content Server, you 
may want to select Do not sort this Directory Item. When selected, the sort order 
that is specified for the query in the content server will be used in Site Builder.

4. Under Sort Order, select Ascending or Descending according to how the documents 
will be sorted.

5. Under Sort By, select the file attribute you want to sort by.
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6. Click OK to return to the main screen.

Ascending means that documents will be linked from A to Z (if you sort by document 
name), smallest to largest (by document size), and oldest to newest (by date and time). 
Descending means the opposite.

When you add a Directory Item from Content Server, the documents that are returned by 
the query will be those listed first according to the Sort selection you made in Content 
Server, and then by the Sort selection set here.

If you are adding a Directory Item from Content Server and you want to set sort options in 
the content server and Site Builder differently, such as sorting the query in ascending 
order and the Directory Item in descending order, you can do so if you prefer.

Directory Item Options
When you create a Directory Item, you can set options that determine how Site Builder 
translates documents in the selected Directory Item.

! Conversion Options—To pass through documents in their native format, using their 
original file name and extension.

To select the pass-through conversion option, select Pass through files matching the 
following specification. In the File specification criteria text box, enter the 
specifications for the types of files included in the Directory Item that you want to pass 
through without modification during translation, such as *.avi;*.pdf. Separate entries with 
semicolons. Select the output location for passed-through files. See Passing Through 
Source Documents Without Conversion (page 5-38) for more information.

! Output page extension—to set the extension for all translated output generated from 
source documents in this directory. The default extension is .htm.

To change the extension, enter the new extension in the Output page extension text box. 
To change the default at the project level (for example, to .html), see the Application 
Options dialog box, from the View menu. When you change this extension, the new 
extension applies only to new saved documents added to the project after the change is 
made.

! File naming—to change output file names for those source documents drawn from 
the content server (as defined by the Query you create for the Directory Item). You 
can specify a unique identifier (custom metadata) to be used for the output file names. 
You can also choose to strip the file extension from the original file name at the same 
time.
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! Dynamic—to create a Dynamic Directory Item, which means that Site Builder 
imports not only the specified folder but also the complete hierarchy of folders below 
that folder. It automatically processes source documents in all of the folders.

To specify a directory item as dynamic, select Include Subdirectories. This option is 
available only when adding a directory item from the file system or from an FTP site. See 
Adding a Dynamic Directory Item From the File System or an FTP Site (page 5-93) for 
more information.

Query Results Hierarchy
A Directory Item in Content Server is defined by a query. Any source documents that 
meet the search criteria for the query are considered part of the Directory Item. When you 
translate and publish your project, the entire contents of the Directory Item are placed in 
one folder, thus creating a flat hierarchy.

You can, however, create a dynamic Directory Item whereby the metadata assigned to 
source documents in Content Server is used to create a folder hierarchy in your published 
output. You can then base your reference pages and site navigation off of this hierarchy.

1. Follow the steps to add a Directory Item from Content Server (see Adding a Directory 
Item from Content Server on page 5-18).

2. On the Directory Item Properties dialog, click the Hierarchy button.

3. Select the metadata values that you would like to use in your folder hierarchy by 
checking the Field Caption next to your metadata field names.

4. To set the order of the fields, highlight the appropriate Field Caption and click 
Move Up or Move Down. The order of the fields will determine which metadata 
value produces a top level folder, a second level folder, a third level folder, and so on.

5. Click OK to close the Query Results Hierarchy dialog, and click OK again to close 
the Directory Item Properties dialog.

6. In the General tab dialog of the New Directory Item Properties dialog box, click the 
Choose Template button to choose a template for the Directory Item, if you haven’t 
done so already.

7. Then click the Options tab, and under Dynamic, select Include subfolders. (This 
option must be enabled to create the folder hierarchy.)

8. Click OK to return to the main window. (If you haven’t already chosen a template for 
your Directory Item, you will be prompted to do so and should return to the General 
tab dialog and click Choose Template.)
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A query results hierarchy uses the metadata assigned to source documents in Content 
Server to create a folder hierarchy. The metadata values (Field Names) that are selected in 
the Query Results Hierarchy dialog will become the folders and subfolders. The order of 
the metadata values in the Query Results Hierarchy dialog will determine the folder level. 
And lastly, the order of the query results will determine the order of output folders and 
files, with output folders coming before output files.

If a source document does not have a metadata value for a given field in the query results 
hierarchy, that source document will be placed in the parent folder. (This rule applies even 
if a source document is missing one metadata value but meets another metadata value in 
the query.) Also, if a source document does not have any of the metadata values specified, 
it will be placed in the root of the Directory Item hierarchy.

To control the order of items in your directory reference pages, use the Sort feature on the 
Properties dialog (see Sorting Directory Items on page 5-94).

The Query Results Hierarchy feature is designed for users who are creating Directory 
Items in Content Server and publishing to a hierarchical repository, such as a file system 
or FTP.

The query results hierarchy reads a fixed list of metadata—it does not create a hierarchy 
that deepens over time. If you add new metadata values in Content Server, then you need 
to update your Directory Item query to include those values. If you create new metadata 
that is used only to organize your hierarchy and does not affect the Directory Item query, 
then you need to update your Directory Item by selecting the new metadata in the Query 
Results Hierarchy dialog.

Importing Folders From the File System 
Hierarchy
In addition to adding individual documents, reference pages, publications, and Directory 
Items to your publication, you can use the Folder Import wizard to create a publication 
hierarchy from an existing hierarchy in your file system. As a result, you can create 
multiple new publications for your project from the folders in the file system hierarchy. 
You can either treat the folders as Directory Items or add the documents in the folders to 
your project.

Use this process to start the Folder Import wizard:

1. From the File menu, choose Import to open the Folder Import wizard

2. Follow the instructions on the wizard screens.
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When you select a root folder, you are selecting that folder and everything in it. Site 
Builder will create a Directory Item for the root folder itself (even if it is empty), as well as 
for all the other folders it contains. But you won’t see the name of the root folder in the 
publication hierarchy of your project.

The Folder Import wizard and the dynamic Directory Item both can be used to add source 
documents to a publication. For a comparison of the two methods, see The Dynamic 
Directory Item Versus the Folder Import Wizard (page 5-98).

Whether you import the folders as Directory Items or import the documents in the folders, 
you can use wildcards to specify which file formats to be imported. For example, if you 
want to import all .doc and all .txt files, you would enter *.doc;*.txt (with the semicolon 
as a separator) in the wizard screen.

The Dynamic Directory Item Versus the Folder 
Import Wizard
When adding source documents from the file system, it's worth comparing the dynamic 
Directory Item to the Folder Import wizard. Both the dynamic Directory Item and the 
Folder Import wizard can import a portion of a hierarchy from the file system. The 
important differences are listed below:

The Dynamic Directory Item
1. Only the parent Directory Item is visible in the Contents pane. Site Builder creates a 

hidden subpublication for the subfolders of the parent Directory Item. The 
subpublication inherits the properties of the publication in which the dynamic 
Directory Item resides.

2. If you create a TOC for the parent Directory Item, you are, in effect, creating a TOC 
for each subfolder—and the contents of the subfolders are promoted so that the TOC 
for the parent Directory Item summarizes the complete hierarchy of the dynamic 
Directory Item.

3. Promotion and linking specified in the template for the TOC of the parent Directory 
Item apply to all subfolders. Likewise, any reference pages you assign to the parent 
Directory Item (as well as any files associated with the parent) are automatically 
inherited by the subfolders, too.

4. Site Builder includes in translation any new subfolders added to the hierarchy in the 
future. This can be handled automatically. (See Updating a Dynamic Directory Item 
(page 5-94).)
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The Folder Import Wizard
1. When you select a root folder, you are selecting that folder and everything within it. 

Site Builder will create a Directory Item for the root folder itself (even if it is empty), 
as well as for all the other folders it contains. But you won’t see the name of the root 
folder in the publication hierarchy of your project.

2. You must associate the same template with all folders and source documents. If you 
import the folders as Directory Items, you can choose a different template for each 
Directory Item later, if you want, in the Choose Template dialog box. Likewise, if you 
import the documents in the folders, you can (after the initial importation) associate 
any template with any document.

ASSOCIATING A FILE WITH A PUBLICATION
During translation, Site Builder generates output files for your body pages and for any 
graphics embedded or referenced in your source documents. It makes copies of all 
graphics from the Gallery used for navigation and places these in the output directories, 
too. But it does not recognize “associated files” that may be an integral part of your 
project.

Say you reference a file for the content of a specific frame and the referenced file, in turn, 
references a graphics file. The graphics file would not be recognized by Site Builder. So 
the behavior or content of your Web publication would be affected in some way.

You can associate such files with a project to ensure that Site Builder recognizes them 
during translation and places copies of the files in the appropriate output directories. You 
do this at the publication level.

1. In the Publication Hierarchy pane, select the publication for which you want to create 
an associated files list.

2. Click Associated Files ( ) on the toolbar to open that dialog box.

3. To add an associated file to the list, click the Add button.

4. In the Open dialog box, locate the file you want to add to the list, select the file, and 
click OK. The file appears in the Associated Files list. To place it another output 
directory, double-click the red cross in the Graphics or Gallery Graphics column 
opposite the file name or select the appropriate radio button under Output Directory.

5. Click the Add button to add another file to the list, if you want. You can add multiple 
files at the same time if they are in the same folder.
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6. To change the output file name of an associated file, select the file in the Associated 
File list. Its default output file name displays in the Output File Name text box. Enter 
the name of the output file name you want to use.

7. Click OK.

The output directories for the Associated Files list are set in the Publication Properties 
dialog box. For Pages and Graphics they can be set for each publication. The output 
directory for Gallery Graphics can be set only for the root publication (see Gallery 
Graphics Output Directory on page 5-102).

If you do not specify an output directory for Gallery Graphics, any associated files 
specified to appear in that directory will appear in the Graphics output directory instead.

For output pages and other graphics, the default directories for subpublications mirror the 
publication hierarchy, based on the path specified for the root publication.

You can also set documents and Directory Items to act essentially the same as associated 
files by setting a pass-through conversion option for those items. See About Pass-Through 
Conversion (page 5-37) for more information.

OUTPUT FILES AND DIRECTORIES
This section covers the following topics:

! Case Sensitivity of Output File Names (page 5-101)

! Designating Output Directories (page 5-101)

! Gallery Graphics Output Directory (page 5-102)

! Output HTML Pages (page 5-102)

! File Conflicts Notice (page 5-103)

! Output Page Names (page 5-105)

! Output Directories on page 5-105

! Specifying the Extension for Output Files (page 5-106)

! Complying With ISO 9660 (page 5-107)

! Output Character Sets (page 5-108)

! Selecting an Output Character Set for a Document (page 5-108)

! HTML Generation (page 5-109)
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Case Sensitivity of Output File Names
Site Builder is case sensitive regarding output file names, directories, and HTML links. In 
a Windows environment this typically isn’t an issue, but you may plan to move your 
output to a Unix-based Web server. If so, pay careful attention to case sensitivity when 
you set up your publication, because such servers are case sensitive.

Designating Output Directories
Site Builder automatically designates a default directory for the output pages you create 
and the graphics converted during translation. The default is a property of the root 
publication and is applied to all source documents and reference pages in the root 
publication as well as to the contents of any subpublications.

You can set a different output directory for each publication in your project, and even 
different directories for source documents. The output directories can be anywhere on the 
network that is accessible from your workstation. Site Builder will create the directories if 
none exist.

1. In the Publication Hierarchy pane, right-click the root publication and choose 
Properties from the popup menu to open the Publication Properties dialog box.

2. Under Output Directories, enter a new path for the Pages output directory. Do the 
same for the Graphics directory if you want to use a separate output directory for 
graphics. Use the Browse button, if necessary, to locate the directories you want to 
use.

3. Click Use gallery graphics directory if you want to designate a special directory for 
Gallery graphics. Then specify the path and name of the directory.

This directory will be used for all graphics from the Gallery used in the project. In this 
way, you will avoid generating duplicate graphics in your output.

4. Click OK.

5. For any other publication in the Publication Hierarchy pane, open the Publication 
Properties dialog box and repeat step 2. (You can designate a gallery graphics 
directory only for the root publication.)

6. To designate an output directory for a source document, right-click the source 
document in the Contents pane and choose Properties from the popup menu. Then 
repeat step 2 in the Document Properties dialog box.
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If you designate an output directory only for the root publication, Site Builder will mirror 
the publication hierarchy in the output directories it creates for subpublications. So if the 
output directory for your root publication is \\Application Data\Output and your root 
publication contains the subpublications Marketing and Finance, Site Builder will create 
the subdirectories \\Application Data\Output\Marketing and \\Application 
Data\Output\Finance, unless you specify otherwise

See Output Directories (page 5-105) for more information.

Gallery Graphics Output Directory
You can create an output directory for all graphics from the Gallery used in your Web 
publication. This way, you can eliminate the need for duplicate graphics if you are using a 
hierarchy of output directories for output files. For example, with such a directory you 
would need only one set of the graphics for the navigation buttons that are used throughout 
your Web publication.

Because the Graphics Gallery is for the project as a whole, you create it in the root 
publication, in the Properties dialog box.

1. Right-click the root publication and choose Properties from the popup menu. (You 
can also choose Proper ties from the Publication menu.)

2. Click the Use gallery graphics directory check box.

3. Enter the path and name of the directory to be used for gallery graphics. Or click 
Browse to locate the directory you want to use.

4. Click OK to return to the main window.

You can assign any associated file to the Gallery Graphics output directory, no matter its 
type. If you will only need one copy of an associated file for your project, you should 
place it in the Gallery Graphics output directory.

Output HTML Pages
If you delete a source document from a project, the history file will also be updated but the 
output HTML file from the last translation will not be removed. It is recommended that 
you delete all files from your output directories before carrying out your final translation.
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File Conflicts Notice
The File Conflicts Notice dialog box appears when you are about to translate a publication 
and one or more of the output files you are about to create will overwrite existing files in 
your output directory or may conflict with other output files about to be created.

This may happen if the same source documents are included in different publications, if 
multiple source documents have the same output filename, or if you are using one of the 
default titles for a reference page (Table of Contents.htm is a common output file).

When a File Conflicts Notice appears, either:

! Click OK if you don’t mind overwriting the files specified in the File Conflicts Notice 
dialog box, or

! Click Cancel if you don’t want to overwrite the specified files.

If you click Cancel, do the following:

! Change the output page name of the file or files in your current publication that are in 
danger of replacing other files with the same names. Once you have done this, you are 
ready to translate the current publication.

It is recommended that you translate when the project is free of any conflicts. You can 
avoid the File Conflicts Notice by using unique output directories and file names for all 
publications.

If you publish to Content Server, you may want to add a prefix to file names (see Adding a 
Prefix to Output File Names on page 8-79) and publish using the original file name (see 
Publishing to the Content Server Without a Unique Suffix on page 8-81) to ensure that 
your file names are unique in the content server. This also helps you create predictable file 
names. If you know that you will publish “pub1_salesfigures.hcsp” into the content server, 
you can plan for it, and link to that file more easily than you would if the timestamp and 
unique suffix is added to the file while it is published.

About the File Conflicts Notice
The File Conflicts Notice dialog initially displays all of the items in your project in the 
left-hand pane, and all of the conflicts that Site Builder noted prior to translation in the 
right-hand pane. You can change the default display options if you wish:

Note: This notice won’t appear if you are repeatedly translating a document and 
overwriting files created for the same document. Site Builder recognizes when a file was 
previously created for another document and issues the warning only then.
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Show Conflicting Items Only: Select this box when you want to view only conflicting 
items, not all of the items contained in the project. Clear the box to view every item 
contained in the project, regardless of whether or not it represents a conflict.

Filter Possible Duplicates: Select this box to omit possible duplicate conflict notices 
from the File Conflicts Notice dialog. Clear the box to view every conflict found, 
regardless of whether or not it may be a duplicate entry.

You can navigate through the File Conflicts Notice in one of two different ways to see 
which conflicts are associated with which items:

! Select an item in the left-hand pane to view conflicts that are associated with that item 
in the right-hand pane. If no conflicts are associated with the item, nothing displays in 
the right-hand pane. If you select a project, you will see every conflict associated with 
that project; if you select a subpublication, you will see every conflict associated with 
that subpublication, and if you select an individual item, you will see every conflict 
associated with that item. (Note that if you select Filter Possible Duplicates, you may 
not see every conflict, because possible duplicate messages do not display.)

! Select a conflict message in the right-hand pane to identify which items are associated 
with that conflict, as shown below, where the “Other Issues” items are associated with 
the highlighted conflict notice.

A blue ! displays next to the items that are associated with the conflict message that is 
highlighted on the right. The entire conflict message displays in the bottom window of the 
File Conflicts Notice so that you can easily read the full text of the message.

Figure 5-3 Conflict message
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Output Page Names
When Site Builder translates a source document, it uses the name of the source document 
for the output page, changing the extension to htm. So if you add Tutor.doc to your 
publication, Site Builder will display Tutor.htm in the Contents pane to denote the 
proposed name of the output file upon translation.

1. Click Project Options on the View menu to open that dialog box.

2. Click Repositories to open that tab dialog.

3. Under Output Page Naming, select either Replace name with source ID or Add 
source ID to name.

4. Click OK.

This setting is project-specific and is therefore saved to the project file. The setting will 
apply whether you run the project locally, move it to a network location, or schedule it for 
translation by Site Server.

Since the output page name is a property of the document, you can change the name to 
anything you want, in the Document Properties dialog box. You can also change the 
extension. See Specifying the Extension for Output Files (page 5-106).

If you split a source document into several smaller files, Site Builder modifies the output 
file name to create multiple file names. If the output file name initially is Tutor.htm, Site 
Builder will probably create multiple files with the names Tutor-01.htm, Tutor-02.htm, 
etc. You cannot control the naming of files when you split a document. The actual names 
will depend on the number of characters in the output file name and how many files you 
create. It will also depend on the existence of other similarly named files.

Output Directories
Site Builder automatically designates a default directory for the output pages you create 
and the graphics converted during translation. The default is a property of the root 
publication and is applied to all source documents and reference pages in the root 
publication as well as to the contents of any subpublications.

! The default output directory is:

C:\Documents and Settings\<username>\My Documents\Stellent\Output

! You designate output directories in the Publication and Document Properties dialog 
boxes. You can set a different output directory for each publication in your project, 
and even different directories for source documents. You can use any output 
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directories on the network that are accessible from your workstation. See Designating 
Output Directories (page 5-101).

! If you designate an output directory only for the root publication, Site Builder will 
mirror the publication hierarchy in the output directories it creates for subpublications. 
So if the output directory for your root publication is \\Application Data\Output and 
your root publication contains the subpublications Marketing and Finance, Site 
Builder will create the directories \\Application Data\Output\Marketing and 
\\Application Data\Output\Finance for the output for those subpublications, unless 
you specify otherwise.

! You can use a single output directory for all output files or use two or three separate 
output directories instead. The Pages output directory is designed for body pages 
(which Site Builder creates from source documents), and the Graphics output 
directory is designed for graphics files (which Site Builder creates when it converts or 
passes through graphics in the source documents).

! Gallery Graphics is a special output directory that can be set only for the root 
publication. It is designed to avoid duplication in graphics for navigation buttons in a 
project where multiple output subdirectories are created. The Gallery Graphics output 
directory can, in fact, be used for files of any kind, whether or not they are graphics, to 
avoid creating duplicate copies.

All output body and reference pages have an HTM extension. Any converted graphics 
files will have one of three extensions, depending on which format you choose: GIF (.gif), 
JPEG (.jpg), or PNG (.png).

You can change the default .htm extension for output pages to .html, if you want. See 
Output Page Names (page 5-105).

Specifying the Extension for Output Files
By default, Site Builder applies the htm extension to all output files it creates from source 
documents. You can use html, if you prefer. (You may also want to use xml if you are 
generating XML-compliant output.)

1. Choose Application Options from the View menu.

2. Click General to open that tab.

3. Under Default Output Extension, select htm and type over html.

4. Click OK.
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This setting is user-specific on a given machine. It applies to all projects run on the 
machine by the user logged in at the time of the change.

The extension you have specified will be used only for new source documents added to the 
project after the change is made.

You can also set documents and Directory Items to be passed through during conversion 
in their original format, using their original file name and extension. See About Pass-
Through Conversion (page 5-37) for more information.

Complying With ISO 9660
If you distribute publications on CD-ROM, your file naming conventions should comply 
with ISO 9660, which requires that all file names:

! contain a maximum of 8 characters, followed by a dot, and then by a maximum of 3 
characters for the extension (the file name or the extension may be empty, but not 
both).

! use only letters, numbers, and underscores (no hyphens, tildes, equals signs, or pluses)

! use only upper case for the letters

To comply with ISO 9660:

1. Click Project Options on the View menu to open that dialog box.

2. In the General tab dialog, under File Names, click Use ISO 9660 compliant file 
names.

3. Click OK to return to the main window.

For all future translations, Site Builder will produce ISO 9660-compliant file names.

This setting is project-specific and is therefore saved to the project file. The setting 
selected will apply whether you run the project locally, move it to a network location, or 
schedule it for translation by Content Server.

If you know that your output HTML and graphics files must follow the 8.3 convention, 
you should carefully consider the naming of all source documents and externally linked 
graphics files to begin with. Starting out with short file names will help you avoid 
problems that may arise when longer names are truncated.

Site Builder sometimes modifies the original file name. For example, if you split a source 
document on a particular element, Site Builder will modify the file name to accommodate 
the necessary numbering needed to create multiple output files.
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Site Builder will not force ISO-compliant directory names, so you must be sure to name 
directories properly.

Output Character Sets
Output Character Set is a setting in the Project Options dialog box where you can choose 
the character set to be used by Site Builder in creating your output pages. The default 
setting is Western (ISO-8859-1).

To select an output character set

1. Click Project Options on the View menu to open that dialog box.

2. In the General tab dialog, under Output Character Set, select an output character set 
from the drop-down list.

3. Click OK.

This setting is project-specific and is therefore saved to the project file. The setting will 
apply whether you run the project locally, move it to a network location, or schedule it for 
translation by Site Server.

Unicode, which is supported by HTML 4.0, offers the broadest range of characters for all 
browsers, except older ones (version 2.0 and earlier).

This setting should be used in conjunction with HTML Generation, also in the Project 
Options dialog box. (See HTML Generation on page 5-109.)

Selecting an Output Character Set for a 
Document
Output Character Set is a setting in the Project Options dialog box where you can choose 
the character set to be used for output pages. The default setting is Western (ISO-8859-1).

You can select an output character set for a single document, if you want.

1. Right-click the document in the Contents pane and choose Properties from the popup 
menu.

2. Click Options to switch to that tab dialog.

3. Under Output Character Set, select an output character set from the drop-down list.

4. Click OK.
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This setting is specific to the selected document and will override the character set 
selected for the project.

Unicode, which is supported by HTML 4.0, offers the broadest range of characters for all 
browsers, except older ones (version 2.0 and earlier).

HTML Generation
HTML Generation is a setting in the Project Options dialog box where you can choose 
between the Standard HTML (Latin 1) and Windows-specific characters. The Allow 
Windows-specific characters options lets you use a richer character set, but should be 
used only if your users will be able to display these characters in their browsers. This 
won’t be possible, for example, with Unix browsers.

1. Click Project Options on the View menu to open that dialog box.

2. Under HTML generation, select the appropriate option for your Web publication.

3. Click OK.

This setting is project-specific and is therefore saved to the project file. The setting will 
apply whether you run the project locally, move it to a network location, or schedule it for 
translation by Site Server.

This setting should be used in conjunction with Output Character Set option, also in the 
Project Options dialog box. (See Output Character Sets on page 5-108.)

INTEGRATING THIRD-PARTY APPLICATIONS
This section covers the following topics:

! Integrating Third-Party Applications With Content Publisher (page 5-110)

! About Tokens (page 5-110)

! Using Layout Tokens (page 5-110)

! Layout Token Syntax (page 5-111)

! Dynamic Include Token Syntax (page 5-112)

! Template Tokens (page 5-114)

! Including Third-Party Content in Projects (page 5-115)

! Modifying File Extensions in a Project (page 5-116)
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Integrating Third-Party Applications With 
Content Publisher
You can use a third-party web site development tool in tandem with Content Publisher to 
create highly dynamic web pages for enterprise-level web sites. Third-party applications 
can be used with the Custom Table Layout feature in Content Publisher.

About Tokens
Third-party applications can take advantage of the tokens in Content Publisher. A token is 
a snippet of code that serves as a placeholder for web content. Content Publisher offers a 
library of tokens that you can choose from when creating web pages.

A token represents content in another part of your web publication. As such, you can use 
one in place of a hyperlink target or directory path statement. 

When you publish a project to a web server or content server, your web pages will 
continue to work even when source content (represented by the token) changes.

Using Layout Tokens
A third-party web development application can be used with Content Publisher.

Tokens can be used to include content in your web page either dynamically or statically: a 
dynamic include is for reference page content (TOC, Index, LOF, LOT), and a static 
include is for body page content. In a dynamic include, the token is replaced with a path to 
the file (that the token represents) when the page is served by a web server. In a static 
include, the token is replaced with the contents of the file (that the token represents) when 
a project is translated.

A dynamic include requires a scripting language to support the include action, and each 
scripting language uses a different syntax with the token. You have four scripting 
languages to choose from: Idoc Script (Idoc), Active Server Pages (ASP), Server Side 
Includes (SSI), and JavaServer Pages (JSP). 

The body page is different from reference pages in that it can only be included statically. 
As a static include, no scripting syntax is required. The body token by itself can be placed 
in your source code:
<!-- TRANSIT - CUSTOMLAYOUT(BODY) -->
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A query reference page is added and defined in Content Publisher; as a result, it displays 
as a static body page.

Please note the following:

1. If you add a reference page in the HTML source code of a third-party application, you 
must also add the reference page to your publication.

2. The scripting language you choose must follow the appropriate syntax required for 
that scripting language.

3. The file extensions in the project output directories need to match your chosen 
scripting language.

4. Dynamic includes are assembled by the web server when the web page is viewed in a 
browser. As such, you cannot preview your dynamic includes on a local file system.

Layout Token Syntax
Third-party applications can take advantage of the following tokens in Content Publisher. 

Template Tokens
In addition to the reference page and body page content that you add to your third-party 
source code, you should insert template tokens for added functionality in Content 
Publisher. These tokens are replaced with template settings (top, head, and body 
attributes) that you make in Content Publisher.

TOP (Before <HTML> tag)
<!-- TRANSIT - CUSTOMLAYOUT(TOP) -->

HEAD (Between <HEAD> tags)
<!-- TRANSIT - CUSTOMLAYOUT(HEAD) -->

BODY (Included in <BODY> tag)
%%TRANSIT-BODYATTRIBUTES%%

Dynamically Included Reference Pages
The following tokens will dynamically include the path to a reference page file in place of 
the token. The dynamic tokens require a scripting language (Idoc, ASP, SSI, or JSP) to 
perform the include action. (See Dynamic Include Token Syntax on page 5-112.)

TOC (Table of Contents)
%%TRANSIT-PATH(TOC)%%
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LOT (List of Tables)
%%TRANSIT-PATH(LOT)%%

INDEX
%%TRANSIT-PATH(INDEX)%%

LOF (List of Figures)
%%TRANSIT-PATH(LOF)%%

Statically Included Reference Pages
The following tokens will statically include the contents of a reference page in place of the 
token. The static tokens do not require a scripting language to perform the include action.

TOC (Table of Contents)
<!-- TRANSIT - LAYOUT(TOC) -->

LOT (List of Tables)
<!-- TRANSIT - LAYOUT(LOT) -->

INDEX
<!-- TRANSIT - LAYOUT(INDEX) -->

LOF (List of Figures)
<!-- TRANSIT - LAYOUT(LOF) -->

Statically Included Body Page
The body page token is a static include that contains no scripting syntax. The body token 
represents source documents in a project. If you add multiple body page tokens, only the 
first one will work.

BODY
<!-- TRANSIT - CUSTOMLAYOUT(BODY) -->

All tokens and their parameters are case sensitive.

Dynamic Include Token Syntax
Third-party applications can take advantage of the tokens in Content Publisher. Following 
is a summary of how the the tokens can be used with different scripting syntax.
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Idoc Script
Idoc Script is a proprietary scripting language for use with Content Server. Idoc Script 
uses the following syntax for each token:

TOC (Table of Contents)
<!--TOC--><!--$docLoadResourceIncludes( 

“RevisionSelectionMethod=Latest&amp;dDocName=” & docRootFilename(“%%TRANSIT-

PATH(TOC)%%”) ), inc(“TRANSIT_TOC_RESOURCE”)-->

LOF (List of Figures)
<!--LOF--><!--$docLoadResourceIncludes( 

“RevisionSelectionMethod=Latest&amp;dDocName=” & docRootFilename(“%%TRANSIT-

PATH(LOF)%%”) ), inc(“TRANSIT_LOF_RESOURCE”)-->

INDEX
<!--INDEX--><!--$docLoadResourceIncludes( 

“RevisionSelectionMethod=Latest&amp;dDocName=” & docRootFilename(“%%TRANSIT-

PATH(INDEX)%%") ), inc(“TRANSIT_INDEX_RESOURCE")-->

LOT (List of Tables)
<!--LOT--><!--$docLoadResourceIncludes( 

“RevisionSelectionMethod=Latest&amp;dDocName=” & docRootFilename(“%%TRANSIT-

PATH(LOT)%%") ), inc(“TRANSIT_LOT_RESOURCE")-->

ASP/SSI
Active Server Pages (ASP) and Server Side Includes (SSI) use the same scripting syntax 
for each token:

TOC (Table of Contents)
<!--#include file=“%%TRANSIT-PATH(TOC)%%"-->

LOF (List of Figures)

<!--#include file=“%%TRANSIT-PATH(LOF)%%"-->

INDEX

<!--#include file=“%%TRANSIT-PATH(INDEX)%%"-->

LOT (List of Tables)

<!--#include file=“%%TRANSIT-PATH(LOT)%%"-->
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JSP
JavaServer Pages (JSP) use the following syntax for each token:

TOC (Table of Contents)
<%@ include file=“%%TRANSIT-PATH(TOC)%%” %>

LOF (List of Figures)
<%@ include file=“%%TRANSIT-PATH(LOF)%%” %>

INDEX
<%@ include file=“%%TRANSIT-PATH(INDEX)%%” %>

LOT (List of Tables)
<%@ include file=“%%TRANSIT-PATH(LOT)%%” %>

Please note the following:

1. All tokens and their parameters are case sensitive.

2. The body page token is a static include. As a result, no scripting syntax is necessary, 
and the body token by itself can be placed in your source code: 

<!-- TRANSIT - CUSTOMLAYOUT(BODY) -->

Template Tokens
In addition to the reference page and body page content that you add to your third-party 
source code, you should insert template tokens for added functionality in Content 
Publisher. These tokens are summarized in layout token syntax. 

These template tokens are placed in your HTML code as follows:

<!-- TRANSIT - CUSTOMLAYOUT(TOP) -->
<html>
<head>
<!-- TRANSIT - CUSTOMLAYOUT(HEAD) -->
</head>
<body %%TRANSIT-BODYATTRIBUTES%%>
</body>
</html>

By inserting template tokens into your web page, you can modify your web site using 
templates rather than changing each web page in your publication.

For example, you may decide to add custom HTML or script to the body tag of a template. 
As long as you add the Body Attributes template token to your custom table layout in your 
third-party application, then the modified template body tag will be placed in each web 
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page on your web site. As a result, the templates and the custom table layout are tightly 
linked and scalable for future changes.

The body page token, <!-- TRANSIT - CUSTOMLAYOUT(BODY) -->, contains 
template information as well, and must be included in your HTML code (where source 
content should appear).

Including Third-Party Content in Projects
The custom HTML and script you create in a third-party application can be made available 
to the project you are designing a custom table layout for. 

However, any file that is referenced by your custom HTML, such as graphics, templates, 
style sheets, etc., will not be automatically included. You will need to add these items as 
associated files in Content Publisher. (Associated files are added at the publication level in 
a project.)

1. With your project open in Content Publisher, select the publication for which you 
want to add an associated file.

2. Click Associated Files ( ) on the toolbar to open the Associated File dialog box.

3. Click the Add button to add an associated file.

4. In the Open dialog box, locate the file you want to add to the list, select the file, and 
click OK. The file appears in the Associated Files list. To change the output directory 
location for this file, double-click the red cross in the Graphics or Gallery Graphics 
column or select the appropriate radio button under Output Directory.

5. Repeat this process for each file. (You can add multiple files at once if they are stored 
in the same directory.)

6. To change the output file name of an associated file, select the file in the Associated 
File list and modify its name beneath the Output File Name text box.

7. Click OK.

As an alternative to associated files, you can create a Directory Item for your included 
third-party content and then assign a pass-through value to the Directory Item so that 
content is preserved in its original format.

The output directories for the Associated Files list are set in the publication properties 
dialog box. For Pages and Graphics, they can be set for each publication. The output 
directory for Gallery Graphics can be set only at the root publication.
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If you do not specify an output directory for Gallery Graphics (as specified in the 
publication properties dialog), any associated file specified to appear in that directory will 
appear in the Graphics output directory instead.

Modifying File Extensions in a Project
By default, Content Publisher applies the .htm extension to all output files it creates from 
source documents. Dynamic includes, however, require a scripting language to support the 
include action, and scripting languages require the appropriate file extension in order to 
parse the web page on a web server (or Content Server).

1. With your project open in Content Publisher, choose Application Options from the 
View menu.

2. Click the General tab.

3. Under Default Output Extension, specify the file extension appropriate for your 
scripting language.

4. Click OK.

File extensions must be specified in Content Publisher. Any file extension you have 
specified in your third-party application for the custom table layout will not be used by the 
project.

The supplied scripting languages have the following file extension requirements: Idoc 
Script requires .idoc for the included reference page and .hcsp for all other pages; ASP 
requires .asp; SSI requires .shtml (this value is dependent on web server settings); and JSP 
requires .jsp.

Idoc Script pages must also be stored in Content Server, and the template for the included 
reference page must contain the same Idoc Script reference as the include statement. (This 
text is entered in the Before and After text boxes in the Globals HTML tab dialog.) 

Example: The Idoc Script TOC supplied in your third-party application (see Dynamic 
Include Token Syntax on page 5-112) would require the following HTML before and after 
tags in your TOC template: <@dynamichtml TRANSIT_TOC_RESOURCE@> [before] 
<@end@> [after]

The extension you specify in Content Publisher will be used only for new source 
documents added to the project after the change.
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6.TEMPLATES
This section covers the following topics:

! About Templates (page 6-2)

! Template Summary (page 6-3)

! Choosing a Template (page 6-3)

! Copying a Template (page 6-4)

! Creating a New Template (page 6-4)

! Deleting a Template (page 6-5)

! Exporting a Template (page 6-5)

! Using the Edit Template Dialog Box (page 6-7)

! Template Names (page 6-7)

! Template Name Conflict (page 6-8)

! Saving a Template (page 6-9)

! Template Editing Options (page 6-9)

! Default Template Settings (page 6-10)

! Templates and Associated Graphics Sets (page 6-11)

! Managing Templates (page 6-12)

! Importing a Template (page 6-13)

! Template Name Conflict (page 6-8)

! Linking to an External Template (page 6-14)
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! Template Guidelines (page 6-15)

! Element Setup (page 6-16)

! Formatting (page 6-96)

! Navigation Topics (page 6-134)

! Global Settings (page 6-173)

ABOUT TEMPLATES
A template is a set of formatting instructions you can associate with one or more source 
documents in a publication. It is saved as part of the project file.

When you add a document to a publication, you associate a template with that document. 
When Site Builder imports styles (or patterns) from the document, it automatically 
generates an element for each style (or pattern), and places the elements in the template. 
(If you use the default setting None in the Choose Template dialog box, Site Builder will 
associate ranks with elements instead.)

To turn a source document into a Web page, you select the template associated with the 
document and edit the template, using the four Template Editing Options (page 6-9).

You can associate only one template with any given source document, but you can 
associate the same template with many different documents.

A template typically isn’t a standalone file, but you can export a template to create one. 
You can then import the template file into another project (to become an internal 
template).

Alternatively, any workstation with access to a standalone template file on the file system 
can link to that template and use the template to format source documents. However, you 
cannot change the settings of a template while it is linked. You must import the linked 
template into a project in order to modify it.

If the template associated with a document is internal, you can change it at any time. In the 
Contents pane, select the template and open the Choose Template dialog box. (You can 
also open the Choose Template dialog box from the Document Properties dialog box.)
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TEMPLATE SUMMARY
Each time you start a new project, Site Builder opens a copy of Default.tcp, the default 
project file. As a result, several existing templates (Administration, etc.) are already part 
of the project. You can check the templates, available by opening the Manage Templates 
dialog box.

Site Builder ships with 19 body templates:

! The Blank template contains no ranks, styles, patterns, or metadata, or any other 
default settings. This template is often useful the first time you translate a source 
document to see how the document will look when “passed through” Site Builder 
without any formatting being done.

! 14 body templates have various default settings for promotion, splitting, and so forth. 
(See Default Template Settings on page 6-10.) These body templates also have a 
complementary TOC, Index, and Query template. In each case, the same graphics set 
is associated with all four templates—body, TOC, Index, and Query—to ensure a 
consistent look throughout your publication.

! 4 special-purpose templates are designed for use with source documents created in 
certain spreadsheet and presentation applications; each has a complementary TOC 
template but no Index template. (See Default Template Settings on page 6-10.)

! Templates with “CSS” in the name have Cascading Style Sheets turned on.

CHOOSING A TEMPLATE
When you select a source document to add to a publication, the Choose Template dialog 
box opens automatically for you to associate a template with that document. You can 
change the template at any time.

1. In the Contents pane, select the source document you want to edit and click Choose 
Template ( ) on the toolbar.

In the Choose Template dialog box, the source document is highlighted in the 
Documents list box, and the template currently associated with the document is 
highlighted in the Templates list box.

2. In the Templates list box, select the template you now want to associate with the 
source document (or click the New button to create a new template).
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If the Auto check box is turned on, you will see a temporary translation of the 
document in the Preview window for the template you have just selected. (If the Auto 
check box is clear, you can either select the check box or click the Update Now 
button.)

3. Click OK to return to the main window, where the new template is now listed for that 
source document in the Contents pane.

You can also enter the Choose Template dialog box from the Document Properties dialog 
box.

The default setting for importing styles or patterns is None. If, when you first associate a 
template with a source document, you select Styles or Patterns, Site Builder will import 
styles or patterns at that time. You can also select one of these options when you change 
the template associated with a particular source document. However, if you have already 
selected None and later want to import styles or patterns, you must do so from the 
Contents pane. Select all the source documents associated with the template, right-click, 
and choose Import and then Styles (or Patterns) from the popup menu.

COPYING A TEMPLATE
The simplest way to copy a template is to open a publication containing the template you 
want to copy, and then create a new template based on that template. See Creating a New 
Template (page 6-4).

CREATING A NEW TEMPLATE
When you select a document in the Add Document dialog box, the Choose Template 
dialog box opens automatically to show the first template in the Template list already 
associated with the document. You can associate another template with the document, 
instead, or create a new template. In fact, you can create a new template at any time and 
associate the new template with any document in a publication.

1. In the Contents pane, click Manage Templates ( ) to open that dialog box.

2. Click New to open the New Template dialog box.

3. In the text box, enter the name of the new template. If you want the new template to 
contain some of the formatting instructions of an existing template, select the existing 
template from the Based On list. Until you modify its settings, the new template will 
be identical to the one it is based on.
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4. Check the appropriate radio button for the type of template you want to create: Body, 
Reference, or Index.

5. Select This template should use CSS style formatting by default if you want to 
allow CSS formatting in the new template. With the check box selected, additional 
formatting options will be available in the Character and Paragraph tab dialogs of 
Formatting.

6. Click OK to return to the Manage Templates dialog box.

The new template is now listed with other templates in the project and can be associated 
with any document. The templates are listed alphabetically.

If you create a reference template, the same template will be used each time you add a 
TOC (table of contents), LOT (list of tables), or LOF (list of figures) to your project. In 
other words, these three default reference templates differ only in name.

DELETING A TEMPLATE
You delete a template in the Manage Templates dialog box.

1. In the Contents pane, click Manage Templates ( ) on the toolbar.

2. In the Manage Templates dialog box, select the template you want to delete.

3. Click Delete (or press the Delete key on your keyboard).

4. Repeat steps 2 and 3 to delete any other templates in the project.

5. Click OK to return to the main window.

You cannot delete a template that is associated with a source document. The Delete button 
is grayed out each time you select such a template.

EXPORTING A TEMPLATE
Templates are typically not standalone files. You create and name templates and save 
them as part of a project file. The project file contains all key data for the project, 
including information about the publication hierarchy, source documents and output files, 
as well as formatting instructions captured in the templates.

But if one project contains a template you want to use in another project, you can export a 
template file from the first project for use in the second.

1. Open the project containing the template you want to export.
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2. Click Manage Templates ( ) on the toolbar to open that dialog box.

3. In the Template list, select the template you want to export.

4. Click Export to open the Export Template Format dialog box. (If this dialog box 
doesn’t open and you want to pick a format other than the default binary, you can 
choose to show this dialog box by setting a switch in the Dialogs tab dialog of the 
Application Options dialog box. 

Binary is the default format for any template export to create a standalone template 
file. You can also export a template in the Full or Compact XML formats. You can 
open an XML template in an XML editor or Notepad. Generally, you should not edit 
this file, but you might find it useful if you want to make a global change for a path to 
a network server, say, that has been renamed. The Full XML format explicitly states 
all settings, including the default ones; the Compact XML explicitly states only 
changes to default settings

5. In the Export Template Format dialog box, select a format for the template you are 
exporting and click OK.

6. In the Export Template dialog box, use the Save In drop-down box and other 
commands to locate the folder in which you want to place the exported template.

7. In the File Name text box, change the file name, if you want.

When you export a template, the default template file name is the same as the template 
name. But you can name the template file differently. If you do, the template will still 
retain its original name, and this will be recognized by Site Builder when the template 
file is later imported into another project. So when you import a template, the name 
that displays in the Manage Templates dialog box may be different from the file name. 
See Template Names (page 6-7).

8. Select the folder and click Save.

You have saved the template as a file in the specified directory. The extension .ttp has 
been assigned by default.

Instead of importing a standalone template file, any user at a Site Builder workstation who 
has access to that template file on the network can link to it and associate the template with 
any source document in any project on the workstation. (However, a template cannot be 
modified while linked. It must be imported into a project in order to be modified.)
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USING THE EDIT TEMPLATE DIALOG BOX
You can simplify the editing of a template by using the Edit Template dialog box to move 
easily between Element Setup, Formatting, Navigation, and Globals without returning 
to the main window. In the Edit Template dialog box you can:

! Quickly identify the elements you want to edit because as you pass your cursor over 
the content of the Preview window a screentip displays the name of each element.

! See your changes in the Preview window each time you return to the dialog box after 
working in one of the property sheets.

To open the Edit Template dialog box In the Contents pane, select the template you want 
to edit. Click Edit Template on the standard toolbar or large toolbar.

You can use the commands in the Edit Template dialog box to open the four property 
sheets to complete all editing for the template.

Follow these steps to preview another document:

1. In the Edit Template dialog box, click Change Preview to open that dialog box. 

2. From the list of documents the template is associated with, select the one you want to 
preview as you edit the template.

3. Click OK.

4. In the Edit Template dialog box, click Update Now. The document appears in the 
Preview window.

To preview your Web pages, you must have Internet Explorer 4.0 or higher or Netscape 
Navigator 6.01 or higher installed on your machine. See Previewing Web pages 
(page 7-3).

TEMPLATE NAMES
Each template has its own name, as listed in the Manage Templates dialog box. A template 
name must be unique for each project. When you export a template to create a standalone 
template file, you can give the template a file name different from the name shown in the 
Manage Templates dialog box. However, the original, underlying template name is 
retained.

When you import a template, Site Builder always recognizes the underlying template 
name (as listed originally in the Manage Templates dialog box). If you rename a template 
as you export it, and then try to import it into another project, you will receive an error 
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message if the second project has a template with the same name as the original, 
underlying name of the template you exported.

Tips
! If you want to change the name of a template, it is best to do this in the Manage 

Templates dialog box, before you export it. (Double-click the template name, with a 
pause between clicks, and then change the name.) In fact, you can change the original 
name of a template only in the Manage Templates dialog box.

! If you export a template and want to keep the template name and the file name the 
same -- and that name is different from the original template name -- change the 
template name before you export the template (see Tip 1).

! When you import a template into a project, Site Builder recognizes the template by its 
original template name – not its file name. If a template by the original template name 
already exists in the project, the Template Name Conflict dialog box will open as soon 
as you try to import the template. You can overwrite the template already in the 
project or give the template your are importing a new name.

! Template names must be unique in Site Builder. If, when you create a new template, 
you enter a name in the Name text box of the New Template dialog box that is already 
being used by an existing template, you will get an error message.

TEMPLATE NAME CONFLICT
When you import a template, the name of the template as originally created in the Manage 
Templates dialog box is the name that will be used during import. That is, Site Builder 
always recognizes the original, underlying template name.

Say you export the template Academy as Academy2 (renaming it in the Export Template 
dialog box). If the Academy is part of a project when you later try to import Academy2, 
you will receive a “Template Name Conflict” message. To avoid this, you should always 
rename templates in the Manage Templates dialog box.

If you receive a warning message, you may choose to overwrite the existing template with 
the one you're importing or enter a new name in the dialog box. If you don’t mind 
overwriting the file specified, click OK; otherwise, enter a new name in the Template 
Name text box, and then click OK. 
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SAVING A TEMPLATE
A template and its formatting instructions are saved as part of the project file. The 
instructions include those applied to the template itself and those applied to the elements 
in the template.

To save a template, click Save on the toolbar or choose Save from the File menu.

You have now saved the project file for the publication and therefore all the templates in 
that project file.

TEMPLATE EDITING OPTIONS
After you have selected source documents for translation, you work with the templates 
associated with those documents. You create a set of instructions for each template, in 
turn, to determine how its source document will look when turned into Web pages.

Some instructions are applied to the template itself. Most are applied to the individual 
elements that reside in each template. There are four options for editing templates:

Element Setup—Where you manage elements. You can change the relationships between 
elements and the ranks, styles, or patterns in your template; use elements to determine the 
placement of content in body and reference pages; create new elements, ranks, styles, or 
patterns; and create metadata to include information about your source documents in the 
Web pages you create and in the Head of your output HTML.

Formatting—Contains numerous options for formatting the text in your source 
document. When you create Web pages, you’ll spend much of your time in the Character 
and Paragraph tab dialogs, in particular, formatting each element in the template. 
Additional formatting options are available in these two tab dialogs when Cascading Style 
Sheets (CSS) are turned on.

Navigation—Where you set links for the pages of your Web publication, either for Web 
pages (Page Button Bar and Page Text Bar tab dialogs) or individual elements (Element 
Button Bar and Element Text Bar tab dialogs). Optional navigation buttons allow you to 
print all or a portion of your Web publication, to return to the top of your root publication 
from anywhere in the publication, and to you open the source document used to create a 
Web page in its native format.

Globals—These settings are generally for the Web page as a whole, and include inserting 
an address to appear at the end of your Web page. Some settings in the Options tab dialog 
are template-based, for example, whether to allow CSS in your template.
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DEFAULT TEMPLATE SETTINGS
Following is a list of the default settings for the 14 general-purpose body templates. This 
isn’t necessarily a complete list of the settings. If you decide to use any of these templates, 
you should check the template before using it.

General-Purpose Templates

Feature Default Setting

Graphics Set See Templates and Associated Graphics Sets 
(page 6-11)

Elements promoted to TOC Title and Heading 1

Treatment of elements on TOC Title flush left, Heading 1 indented

Split On Heading 1

Fonts Take from Source, Arial, or Verdana

Navigation buttons in Body Previous Page, Next Page, TOC, and Index (TOC 
and Index display only if your publication has a 
TOC and Index)

Navigation buttons in TOC None

Navigation buttons in Index None; Index may contain an Element Text Bar

Navigation buttons in Query None

Ranks Lowest 1, Title, Lowest 2, Heading 1

Character patterns HTTP, Weblink, Email

Metadata Keywords

Imported graphics Converted to Gifs; no alignment

Cascading Style Sheets (CSS) Turned on for those templates with 'CSS' in their 
name
6-10 Content Publisher User Guide



Templates
The following table lists the four specialized templates for use when the source documents 
were created with one of the following spreadsheet or presentation applications shown 
below.

TEMPLATES AND ASSOCIATED GRAPHICS SETS
The table below lists all 19 body templates in the default project file. The graphics set 
listed for each body template is also associated with the TOC, Query, and Index templates, 
where available. (There are 28 graphics sets in Site Builder, so not all are used.)

Link colors Specified, but vary with template

Template Comment

Lotus 1-2-3
Lotus 1-2-3 TOC

No ranks or metadata

Lotus Freelance
Lotus Freelance TOC

Default styles: Automatic Heading, Heading 1, 
Normal, Slide, and Speaker Notes

MS Excel
MS Excel TOC

No ranks or metadata

MS PowerPoint
MS PowerPoint TOC

Includes a number of default styles not assigned to 
elements: Body #1, Body #2, etc.; Center Body 1, 
Center Body 2, etc.

Feature Default Setting

Template Graphics Set

Academy Aqua Weave

Acclaim CSS Investment

Account Clearing House

Adagio CSS Gray Tab
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MANAGING TEMPLATES
The Manage Templates dialog box lists all the templates and source documents in a 
project.

In the main window, click Manage Templates ( ) on the standard toolbar or the large 
toolbar. You do not need to select a template in the Contents pane to open the dialog box.

The Manage Templates dialog box lists, alphabetically, all the templates available in the 
project currently open in Site Builder. If no project is open, you will see all the templates 
available for the default template, Default.tcp.

Administration Planner

Analysis Grouted Tiles

Archive CSS Scalloped

Blank None

Business Blue Bevel

Ceremonial Blue Mexico

Courtesy CSS Cranberry Script

Executive Gray Tab

Introduction CSS Blue Peach

Lotus 1-2-3 Royal Cloth

Lotus Freelance Olive

MS Excel Skill Set

MS PowerPoint Maroon Sand

Purple Frost Lilac Spiral

Retrofied! CSS Salmon Retro

Template Graphics Set
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The Location column tells you whether a template is internal or linked. You can recognize 
a linked template by the path and file name for the template file somewhere on the file 
system or in Content Server.

From this dialog box, you can click:

! New to create a new template

! Delete to remove the selected template from the Template list

! Import or Export to import a standalone template file or to create a standalone file of 
the selected template (placing the file either on the file system or in a content server)

! Link to create a link to an external template. You can use a linked template to format 
your Web pages as you would an internal template. However, you must import the 
template into a project in order to edit it.

! Details to view the Content Information page for the selected template (which must be 
a linked template in Content Server)

! Update Versions to update the selected template (which must be a linked template 
from the file system or Content Server)

Site Builder ships with 19 template sets. See Template Summary (page 6-3) for the list of 
templates and their default settings.

IMPORTING A TEMPLATE
Templates are typically not standalone files. You save them as part of a project file. The 
project file contains all key data for the project, including information about the 
publication hierarchy, source documents and output files, as well as formatting 
instructions captured in the templates.

But if one project contains a template you want to use in another project, you can export a 
template file from the first project for use in the second.

1. Open the project you want to import the template into.

2. Click Manage Templates ( ) on the toolbar to open that dialog box.

3. Click Import to open the Import Template dialog box. Use the Look In drop-down 
box and other commands to locate the folder containing the template you want to 
import, and then open the folder.

If the template has the recommended .ttp extension, the template will display in the 
window when you open the appropriate folder. If you are using another extension for 
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the template file, type this extension, preceded by *. in the File Name text box (*.ext), 
and then press the Return key.

4. Select the template and click Open.

5. The Template Paths Verification dialog box will open. Site Builder is simply verifying 
the location of Gallery and other images. Click OK.

6. The Template Name Conflict dialog box may open. This will happen if the original 
name (not the file name) of the template you are importing happens to be the same as 
an internal template in your project. See Template Names (page 6-7). Select 
Overwrite existing template if you want the imported template to overwrite the 
existing template in your project. Alternatively, enter a new name in the text box for 
the template you are importing.

7. The Import Template dialog box closes and you return to the Manage Templates 
dialog box. The template displays in the Templates list. (Templates are listed 
alphabetically in the list box.)

The template can now be associated with any source document in the project.

Instead of importing a standalone template file, any user at a Site Builder workstation with 
access to that file on the network can link to it and associate the template with any source 
document in any project on the workstation. (However, a template cannot be modified 
while linked. It must be imported into a project in order to be modified.)

LINKING TO AN EXTERNAL TEMPLATE
Templates typically are part of a project file. But you can export a template to create a 
standalone template file. You then have the option of importing that file into another 
project (see Importing a Template on page 6-13) or creating a link to the external template.

Linking to an external template can be a useful way for several content creators in an 
organization to use the same template and thus maintain consistent standards for the 
creation of Web publications. Control is maintained because you cannot change the 
settings of a template while it is linked. The template must be imported into a project in 
order to edit it. As long as the linked template is available to users on a network, any 
number of users can link to it.

1. Click Manage Templates ( ) on the toolbar to open that dialog box.

2. Click the Link button to open the Link Template dialog box. Locate the external 
template on your file system. Select the template and click Open.
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The Template Paths Verification dialog box will open. Site Builder is simply verifying 
the location of Gallery and other images. Click OK.

3. The Template Name Conflict dialog box may open. This will happen if the original 
template name (not the file name) of the template you are linking to happens to be the 
same as an internal template in your project. Site Builder treats an imported template 
and a linked template in the same way. See Template Names (page 6-7).

4. Select Overwrite existing template if you want the linked template to overwrite the 
existing template in your project. Alternatively, enter a new name in the text box for 
the template you are linking to.

5. Click OK. The linked template now appears in the Manage Templates dialog box, 
with its path and file name shown in the Location column.

TEMPLATE GUIDELINES
Consider these guidelines when managing templates:

! The templates in the default project file are simply a starter list. If you use any of 
them, it would be best to first review the template settings to confirm what is listed 
and to identify any settings that may not be listed.

! If you use one of the templates in the default project file, it would be best to create a 
new template based on the template provided—giving it a unique name in the process. 
That way, there will be no danger of overwriting the new template.

! When you rename a template, it's best to do so in the Manage Templates dialog box, 
which displays the underlying name of each template. This name will be retained in 
the template even if you rename the template as you export it or rename the template 
file in Windows Explorer. When you import a template into a project, Site Builder 
recognizes the underlying template name and compares it to the list of templates 
already in the project. If there's a match, you can either overwrite the existing template 
or rename the one you are importing.

! Project files can be quite large (even when zipped). If you want to keep project files 
small, you might want to delete the templates you are not using. Alternatively, you can 
edit the project file by exporting most of the templates and 'parking' them in a safe 
place. You can then simply import them as you need them. You might want to do this 
with the template files you create as well as the ones supplied by Site Builder. Of 
course, with Site Builder's linking functionality, you can always link to an external 
template. (You will need to import the template into a project in order to edit it.)
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! Any templates you have been using with a previous version of Site Builder can still be 
used when you import a project file into Site Builder. You can also import old 
templates into the new default project file. (You will first need to export those 
templates from the old projects and import them into the default project file.)

ELEMENT SETUP
This section covers the following topics:

! About Elements (page 6-16)

! Element Setup (page 6-17)

! Elements (page 6-17)

! Ranks (page 6-31)

! Styles (page 6-43)

! Patterns (page 6-51)

! Metadata (page 6-67)

! Elements and HTML tags (page 6-88)

! Styles in Source Documents (page 6-90)

About Elements
Site Builder uses elements as “handles” to format the content of source documents and 
associate the styles or patterns in those documents with the HTML tags that control the 
appearance of Web pages. Site Builder does this automatically, so you don’t need to worry 
about the HTML tags themselves. Site Builder likewise associates ranks with HTML tags 
if you choose not to import styles or patterns.

When you add a source document to a publication, you choose a template for the 
document. And when Site Builder imports styles or patterns from the document, or creates 
a default set of ranks, it generates a corresponding element for each rank, style, or pattern, 
and places those elements in the template.

You create the look of a particular Web page by editing the template that is associated 
with the source document. Some of the instructions apply to the template itself, but most 
apply to the individual elements in the template.
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Elements lists throughout Site Builder can help you select the elements to edit. For 
example, an Elements list is always available in Formatting, no matter which tab dialog 
you're working in, and the currently selected element is always highlighted on the list.

Element Setup
Element Setup is one of four property sheets used to edit templates. Once you set up a 
project, you use the property sheets to complete settings for each template in the project. 
The settings determine the look and behavior of a Web page created from any source 
document associated with the template.

In Element Setup you can review the elements generated for the styles or patterns 
imported from the source document, or for the ranks created by Site Builder (if you import 
neither styles nor patterns). With a new project, in particular, you may want to fine-tune 
the elements and possibly merge some ranks, styles, or patterns, or create new ones.

Among the options are the ability to control the placement of content in the Web pages 
you create and to “promote” elements so that the content of body pages can be included in 
reference pages.

After you select a template for editing, you can open Element Setup and the other 
property sheets by clicking the buttons on the Template toolbar. Or you can open the Edit 
Template dialog box and move between the four property sheets from there. You can use 
the property sheets in any order.

Elements
This section covers the following topics:

! Changing Element Assignments (page 6-18)

! Changing Element Properties (page 6-19)

! The Elements List (page 6-19)

! Changing the Name of an Element (page 6-21)

! Creating a New Element (page 6-21)

! Element Properties (page 6-22)

! Elements Tab Dialog (page 6-22)

! Handling an Event for an Element (page 6-23)

! Linking Reference Pages (page 6-24)
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! Placing an Element in a Meta Tag (page 6-25)

! Placing an Element in Your Web Pages (page 6-26)

! Removing an Element From a Template (page 6-27)

! Promoting an Element (page 6-27)

! Ranks, Styles, and Patterns (page 6-28)

! Changing the Association Between a Rank, Style, or Pattern and an Element 
(page 6-29)

! Special Elements (page 6-30)

Changing Element Assignments
When you select a source document for translation, you formally associate a template with 
that document. As a result, Site Builder either creates a set of default ranks to apply to the 
content or it imports styles or patterns from the document. At the same time, Site Builder 
generates an element for each rank, style, or pattern. The elements are saved in the 
template.

You use the elements to edit the template to determine how the Web page will look once 
you translate the source document. One editing choice is to decide what content to place in 
the body page and in the page table of contents (TOC), which is part of the body page. By 
default, Site Builder assigns all elements to the body page and none to the page TOC.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Elements to open that tab dialog.

The green check marks and the red crosses in the In Body and In Page TOC columns 
indicate whether content associated with an element has been assigned to the body 
page or page TOC, respectively.

3. Under Name, select the element you want to re-assign.

4. Right-click the green check mark or red cross in whichever column (In Body or In 
Page TOC) that you want to change.

5. From the popup menu that appears, choose the cross or check mark you want to use 
instead. The popup menu closes and the association is now changed.

With the element selected, you can also click Properties to open that dialog box and 
change the association there. The Properties dialog box provides an additional option to 
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include content associated with an element in Meta tags in the Head of HTML files. See 
Placing an Element in a Meta Tag (page 6-25).

Changing Element Properties
elements contain a number of properties you can change in Element Properties in Element 
Setup.

To change the property of an element:

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Elements to open that tab dialog.

3. From the Elements list, right-click the name of the element you want to change and 
choose Properties from the popup menu (or select the element and click the 
Properties button).

4. In the Element Properties property sheet, click the appropriate tab to open that tab 
dialog and make the changes you want.

5. Click OK.

Click Related Topics for topics that explain the tab dialogs in Element Properties.

The Elements List
When you view the Elements list in Formatting or elsewhere in Site Builder, typically you 
will see the following:
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Figure 6-1 Typical elements list

It is important to understand the different kinds of elements and how they are listed 
throughout Site Builder. The elements in the above list are presented alphabetically as 
follows:

Three system paragraph elements not shown are Index Heading, Index Entry, and Index 
SubEntry, which are found only in the template for an Index reference page.

For more on the system paragraph elements, see Special Elements (page 6-30).

Paragraph elements. These are derived from styles or patterns in 
the source document, or have been associated with ranks.

Character elements. These are derived from character styles or 
pattern matching on special formatting in the source document.

System paragraph elements. These are common to all templates 
and cannot be removed.

System character element. Default Character is the only such 
element.

Paragraph elements not currently assigned to any rank, style, or 
pattern are grayed out and placed below the bar.
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Changing the Name of an Element
Elements contain a number of properties you can change in Element Properties in Element 
Setup.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Elements to open that tab dialog.

3. Right-click the element you want to change and choose Properties from the popup 
menu.

4. Click General to open that tab dialog.

5. In the Name text box, type the new name for the element.

6. Click OK.

Creating a New Element
When you select a source document for translation, you formally associate a template with 
that document. As a result, Site Builder either creates a set of default ranks to apply to the 
content or it imports styles or patterns from the document. At the same time, Site Builder 
generates an element for each rank, style, or pattern. The elements are saved in the 
template.

You can create new elements, if you want. This is especially useful when you import 
patterns from a manually formatted source document, because only four elements are 
assigned initially to the content of such a document. Since Default Paragraph is assigned 
to most of the patterns, you might want to create unique elements for all patterns after the 
top three. This will increase your formatting options.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click New to open the New Template dialog box.

3. Under Name, enter the name of the new element you want to create.

4. Change the default HTML tag <P>, if necessary.

5. Under Element Type, select Paragraph or Character.

6. Click OK to return to the Elements tab dialog.

The new element appears grayed out at the bottom of the Elements list. Once you assign 
the element to a rank, style, or pattern, it becomes active and appears in regular type in the 
top portion of the list.
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In most cases you will create a paragraph element. But you may need to create a character 
element for a character style or pattern, for example, if you want to search for a specific 
word or phrase in the document.

Element Properties
Elements contain a number of properties you can change in Element Properties in Element 
Setup.

! In the General tab dialog you change the name of an element. You also specify its 
inclusion in the body or page TOC, or within a Meta tag in the Head of the HTML file.

! In the Promote tab dialog you can promote content from body pages to any reference 
pages you build. You can also promote elements from reference pages at one level in a 
publication to a higher level. This can be especially useful if you want to create a 
single master TOC at the root level for a multi-tiered publication.

! The Links tab dialog is used to link a reference page to a body document or page TOC. 
(This tab dialog is available only when you edit a reference page template.)

! The Split tab dialog is used to split a source document into a series of smaller body 
pages to facilitate viewing and downloading. You can split a source document on any 
element.

! In the HTML Tags tab dialog you can place custom HTML tags before and after 
elements.

! In the Meta Tag tab dialog you can give a name to the element when it is included in a 
Meta tag in the Head of the HTML file. You can also specify custom tags. (This tab 
dialog is available only when you edit a body page template.)

! In the Events tab dialog you can specify an event for the element, that is, HTML or 
scripting code to be included in the tag for the element.

You can change element properties at any time (see Changing Element Properties on 
page 6-19).

Elements Tab Dialog
When you select a source document for translation, you formally associate a template with 
that document. As a result, Site Builder either creates a set of default ranks to apply to the 
content or it imports styles or patterns from the document. At the same time, Site Builder 
generates an element for each rank, style, or pattern. The elements are saved in the 
template.
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Element Setup contains four tab dialogs that let you view ranks or imported styles or 
patterns, along with the elements assigned to them. (A fifth tab dialog summarizes any 
metadata in the template.)

In the Elements tab dialog, you can perform the following actions:

! Control the placement of content in the body and reference pages of your publication

! Change the assignment of content to the page table of contents, which appears at the 
beginning of the body page

! Select an element to split a source document into a series of smaller Web pages for 
ease of browsing and downloading (separately, you can choose to split a source 
document on hard page breaks)

! “Promote” elements to the reference pages you build when you translate the source 
document.

Handling an Event for an Element
You can assign an event handler to an element that is triggered by an event in your 
browser. Such an event handler might be onClick or onMouseOver. You could also 
include HTML code or JavaScript.

Follow these steps to assign an event handler or include HTML or scripting code:

1. Click Element Setup ( ) on the toolbar to open the Element Setup property sheet.

2. Select the element you want to assign an event handler to, and click Properties.

3. Click Include HTML or scripting code in the element’s tag, and then click either 
Use the following or Use the contents of this file.

4. If you click Use the following, enter the code you want to use in the box provided.

5. If you click Use the contents of this file, enter the path and file name in the text box, 
or click Browse to locate the file, or click Gallery to pick a file from the HTML Code 
folder in the Gallery.

6. If you pick a file from Content Server, you will activate the Info button ( ) and 
thereafter will be able to open the Content Information page for that file at any time.

7. Click OK.

If you select Use the contents of this file and the referenced file references another file, 
such as a graphic, this file should be listed in the Associated Files dialog box so that Site 
Builder will copy the latter file to the output directory when you translate the publication. 
See Associating a File With a Publication (page 5-99).
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To temporarily remove an event handler from an element but keep it available for future 
use, clear the Include HTML or scripting code in the element’s tag check box. When 
you are ready to assign the event handler once more, select the check box.

See Handling an Event Within a Frameset (page 5-64), Handling an Event Within a Body 
Page (page 6-179), and Tokens for Adding HTML Code (page 6-186).

Linking Reference Pages
Elements contain a number of properties you can change in Element Properties in Element 
Setup.

When you include a promoted element in a reference page, Site Builder automatically 
creates a link from the reference page to the body page for the content associated with that 
element. You have the option to link in other ways to the body page or to not link at all.

1. In the Contents pane, select the reference page template you want to edit and click 
Element Setup ( ) on the toolbar.

2. Click Elements to open that tab dialog.

3. Select the element you want to change and click Properties.

4. Click Links to open that tab dialog.

5. From the Links Type drop-down list, select the appropriate option.

6. Click OK.

Each link option serves a specific purpose:

! No link might be useful with an abstract, to preserve the links to chapter headings in 
the source document while eliminating the links to the introductory material (abstract) 
that follows each heading.

! Site Builder uses Link to content in body document, for example, to link TOC 
entries to headings in body pages. The Link to page TOC entry in body document 
option would be appropriate for linking a TOC to entries in the page TOC of a body 
page.

! Link to next level reference document of same type is appropriate when promoting 
elements through the same type of reference page at different levels.

! Link to top of body document can be useful when you have navigation bars at the 
top of body pages. This link will take the user to the top of a body document, so the 
user won’t have to scroll to the top of a page to see the navigation buttons.
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! The Links tab dialog is available in the Element Properties tab dialog only when you 
edit a reference page template.

Placing an Element in a Meta Tag
Any element can be placed in a Meta tag in the Head of your HTML files, to facilitate 
searches on your Web server. It can also be placed in your Web pages, (see Placing an 
Element in Your Web Pages on page 6-26) to be visible to users.

Site Builder automatically creates elements for the styles, patterns, and ranks in each 
template, but it doesn’t do so for metadata. (The standard metadata Keywords was created 
specially for the templates that ship with Site Builder.) You must make a metadata 
element-based (see Making a Metadata Element-Based on page 6-78) in order to include it 
in your Web publications. 

Certain elements are automatically included in the Meta tag of your HTML files. So the 
following procedure may not be necessary. 

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. In the Elements tab dialog, select the element you want to include in the Head of your 
output HTML.

3. Click Properties to open the Element Properties dialog box.

4. In the General tab dialog, select Include in Head with Meta tag.

5. Click Meta Tag to open that tab dialog.

6. Select Use standard Meta tag and enter the name you want to appear within the Meta 
tag to describe this element. You may want to use the element name itself.

7. To use custom tags instead, click Use custom tags, select the appropriate check 
boxes, and enter the opening and closing tags in the text boxes. See Using Custom 
Tags for New Metadata (page 6-82).

8. Click OK, and OK again.

For a metadata to appear in a Meta tag, it must exist in the source document (in the case of 
standard or custom metadata) or in the content server (in the case of content server 
metadata). As with the elements for styles, patterns, and ranks, the metadata you create 
will apply to all source documents associated with the template you edit. 

The order in which metadata are listed in the Metadata tab dialog of Element Setup 
determines the order in which the metadata will appear in the Meta tags of your HTML 
Content Publisher User Guide 6-25



Templates
output. You can use drag-and-drop to move an element up or down the list of metadata. 
See Ordering Metadata (page 6-86).

In addition to being placed in Meta tags, metadata can also be published to a content 
server (see Publishing Metadata to a Content Server on page 6-79) to be used for 
searching and categorizing documents in the content server.

Placing an Element in Your Web Pages
Any element can be placed in your Web pages, to be visible to users. It can also be placed 
in a Meta tag (see Placing an Element in a Meta Tag on page 6-25) in the Head of your 
HTML files, to facilitate searches on your Web server.)

Site Builder automatically creates elements for the styles, patterns, and ranks in each 
template, but it doesn’t do so for metadata. (The standard metadata Keywords was created 
specially for the templates that ship with Site Builder.) You must make a metadata 
element-based (see Making a Metadata Element-Based on page 6-78) in order to include it 
in your Web publications. 

Certain elements are automatically included in your Web pages. So the following 
procedure may not be necessary. 

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. In the Elements tab dialog, select the element associated with the metadata you want 
to include in your publication.

3. Click Properties to open the Element Properties dialog box. In the General tab dialog, 
by default, the element is already checked to appear in the Head of your HTML output 
files. You can also include the metadata in the body of your Web pages and/or the 
page TOC.

4. Select or clear the Include in Body and Include in Page TOC check boxes, so that 
the appropriate metadata will display automatically in your Web pages once you 
translate your publication.

5. Click OK, and OK again.

For a metadata to appear in your Web pages, it must exist in the source document (in the 
case of standard or custom metadata) or in the content server (in the case of content server 
metadata). As with the elements for styles, patterns, and ranks, the metadata you create 
will apply to all source documents associated with the template you edit. 

The order in which metadata are listed in the Metadata tab dialog of Element Setup 
determines the order in which the metadata will appear in your Web pages. You can use 
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drag-and-drop to move an element up or down the list of metadata. See Ordering Metadata 
(page 6-86).

In addition to being placed in your Web output, metadata can also be published to a 
content server (see Publishing Metadata to a Content Server on page 6-79), to be used for 
searching and categorizing documents in the content server.

Removing an Element From a Template
When you select a source document for translation, you formally associate a template with 
that document. As a result, Site Builder either creates a set of default ranks to apply to the 
content at translation or it imports styles or patterns from the document. At the same time, 
Site Builder generates an element for each rank, style, or pattern. The elements are saved 
in the template.

You can remove an element, if you want. You may want to do this if you import duplicate 
styles under different names. You can associate all the styles with a single element and 
remove the elements you don’t need. This shortens the list of elements and makes it easier 
to manage.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Elements to open that tab dialog.

3. Select the element you want to remove and click Delete.

4. The rank, style, or pattern associated with the element is now associated with the 
Default Paragraph element. You can associate the rank, style, or pattern with another 
element, instead.

5. When you've finished removing elements, click OK.

Promoting an Element
Elements contain a number of properties you can change in Element Properties in Element 
Setup.

The Promote property lets you promote content from body pages to any reference page in 
your publication. You still need to add the reference page to your publication and formally 
include the promoted element in the body of the reference page (see Creating Reference 
Pages on page 5-53).

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.
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2. Click Elements to open that tab dialog.

3. Select the element you want to promote and click the Properties button.

4. Click Promote to open that tab dialog.

5. Click Promote this element, making it available to all reference pages.

6. In the Promote As text box, enter the name you want to use for formatting the element 
in the reference page template. You don’t have to give the element a different name. 
Do so only if you are promoting different elements from different templates and want 
to format them all the same way.

7. Click OK. When you return to the Elements tab dialog, the name you enter in the 
Promote As text box is listed in the Promote As column opposite the element.

In the Elements tab dialog, you can double-click on the appropriate line in the Promote As 
column to promote an element under its own name. The element name will appear 
immediately in the Promote As column. You can also right-click and choose Promote 
from the popup menu.

Ranks, Styles, and Patterns
When you select a source document for translation, you formally associate a template with 
that document. As a result, Site Builder either applies a default set of ranks to the content 
or it imports styles or patterns from the document. At the same time, Site Builder 
generates an element for each rank, style, or pattern. The elements are saved in the 
template.

With documents that contain named styles, Site Builder can automatically create an 
element for each style, and you can use these elements to format your documents and turn 
them into Web pages. With manually formatted styles, Site Builder can instead identify 
patterns and create elements for those patterns. Where source documents are “mixed,” 
ranks are best.

You decide how Site Builder should handle source documents in the Choose Template 
dialog box, under Import Styles or Patterns. The default setting is None. Unless you 
change this, Site Builder will ignore styles and patterns in your source document and 
recognize content hierarchy in terms of ranks.

! If all your source documents contain named styles consistently applied, select Styles 
in the Choose Template dialog box and import styles from those documents.

! If all your source documents are formatted manually in a consistent fashion, select 
Patterns and import patterns instead (but also consider ranks, because they might do a 
better job).
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! If your source documents are “mixed” (some contain named styles, others are 
manually formatted) or where the styles (whether named or manually formatted) have 
been inconsistently applied, use the default None for ranks.

The advantage of using ranks for documents is that you avoid any clash of styles or 
patterns that might arise when adding a large number of source documents. You also avoid 
importing more styles or patterns than you need for formatting. Ranks can be especially 
useful if you add a Directory Item to your project.

If you choose None (Site Builder applies a pre-existing set of ranks in order to identify 
top-level content hierarchy), that doesn’t mean you might still not use patterns. Where 
content is consistent throughout all the source documents, patterns can be used to create 
additional elements for your template. For example, you could create patterns for bulleted 
and numbered lists.

If your source documents are text files, you are limited in how you can format the content. 
Creating patterns, if you can, is probably your best chance.

Changing the Association Between a Rank, Style, or 
Pattern and an Element
You can change the association between a rank, style, or pattern and its element. You may 
want to do this if, say, you import two similar styles that you want to format the same way 
in a body page.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Ranks, Styles, or Patterns to open the appropriate tab dialog.

3. Depending on which tab dialog you are in, select the rank, style, or pattern you want to 
associate with a different element, and click Association.

4. In the Change Associations dialog box, select the new element from the drop-down 
elements list.

5. Click OK.

The new element associated with the rank, style, or pattern can be seen in the element 
column opposite the rank, style, or pattern name.
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Special Elements
Site Builder automatically creates elements when you add a document to a project:

! If you accept the default None in the Choose Template dialog box, Site Builder will 
create four default ranks for the document.

! If you choose Styles, Site Builder will create an element for each imported style in the 
source document, and gives each element the same name as the style it is associated 
with.

! In you choose Patterns, Site Builder will create patterns named Pattern1, Pattern2, 
etc., and uses standard element names such as Title and Heading 1 for the top patterns.

Whichever approach you take, the information will be captured in the template used to 
translate the document. That template will also contain a number of predefined elements 
that are part of any body or reference page template and cannot be removed. These special 
elements represent special source content.

In addition, the template will contain some pre-set elements that can be useful in many 
projects and which can be deleted, if you want. These – a metadata and three character 
patterns – are listed first in the following table.

Icon Element Description

Keywords Used for keyword metadata in source documents, 
which by default is included in the Meta tags of 
output pages.

Email Used for links in source documents that contain an 
email address. Formatting includes necessary 
HTML code to make such links active in output 
pages.

HTTP Used for links in source documents that use the 
HTTP protocol. Formatting includes necessary 
HTML code to make such links active in output 
pages.

Weblink Used specifically for links in source documents to 
the World Wide Web. Formatting includes 
necessary HTML code to make such links active in 
output pages.
6-30 Content Publisher User Guide



Templates
Ranks
This section covers the following topics:

! Removing a Rank From a Template (page 6-32)

! Ranks Tab Dialog (page 6-33)

! Rank Rules (page 6-33)

! Rank Properties (page 6-34)

Address (System) Used to format the address information entered on 
the Address tab of the Globals property sheet.

Default Paragraph Associated with any paragraph not matched by a 
style or pattern.

Email (System) Used to format the email information entered on the 
Address tab of the Globals property sheet.

Title (System) Used to format the title information entered on the 
Titles tab of the Globals property sheet.

Index Entry Assigned to first-level index entries embedded in 
source files. Controls the appearance of these 
entries in the index document. Can be assigned only 
to an index.

Index Heading Assigned to the index headings generated 
automatically when Site Builder builds an index. 
Controls the appearance of these headings in the 
index document. Can be assigned only to an index.

IndexSubEntry Assigned to second-level index entries embedded 
in source files. Controls the appearance of these 
entries in the index document. Can be assigned only 
to an index.

Default Character Associated with any character style or pattern that 
is not associated with a character element.

Icon Element Description
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! Rank Order (page 6-35)

! About Ranks (page 6-36)

! Changing the Alignment Property of a Rank (page 6-37)

! Changing the Association Between a Rank and an Element (page 6-38)

! Changing the Ront Property of a Rank (page 6-38)

! Changing the Color Property of a Rank (page 6-39)

! Changing the Properties of a Rank (page 6-40)

! Changing the Rank Rules (page 6-40)

! Creating a New Rank (page 6-41)

! Hierarchy and Frequency of Ranks (page 6-43)

Removing a Rank From a Template
When you add source documents to a project and accept the default setting None under 
Import Styles or Patterns in the Choose Template dialog box, Site Builder applies a default 
set of ranks in the template to content at translation time: Lowest 1, Title, Lowest 2, 
Heading 1. These ranks are designed to identify content hierarchy in source documents so 
that top-level content, in particular, can be handled consistently.

After initial setup, you may create a number of additional ranks for a particular template 
only to discover later that one or more of the ranks is no longer needed. You can easily 
remove any rank from a template.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Ranks to open that tab dialog.

3. Under Rank, select the rank you want to delete, and click Delete.

4. Click Elements to switch to the Elements tab dialog. The element is now grayed out, 
below the line.

5. Select the element and click Delete.

The content associated with that rank is now associated with the Default Paragraph 
element.
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Ranks Tab Dialog
When you add source documents to a project and accept the default setting None under 
Import Styles or Patterns in the Choose Template dialog box, Site Builder applies a default 
set of ranks in the template to content at translation time: Lowest 1, Title, Lowest 2, 
Heading 1.

You can complete project setup in Element Setup, where the Ranks tab dialogs lets you 
view the ranks initially created by Site Builder for the template, as well as the elements 
Site Builder has associated with these ranks.

In the Ranks tab dialog, you can

! Control the relationship between ranks and the elements assigned to them

! Add new ranks

! Delete unwanted ranks

! Change the properties of ranks

! Change the rank rules

The order of ranks in the Ranks tab dialog is important. Generally, you should not change 
it. See Rank Order (page 6-35).

The hierarchy and frequency of each rank is summarized in the Properties box on the tab 
dialog.

Rank Rules
Rank rules dictate how content in your source documents will be treated at translation 
when Site Builder assigns ranks to identify content hierarchy. They consist of “effects,” 
which represent all possible characteristics of text. For ranking purposes, each effect has 
the properties “significance” and “order.” By changing these, you change the rank rules 
that govern how Site Builder assigns ranks.

The default settings can be seen in the Rank Rules dialog box (click Advanced on the 
Advanced tab dialog of Element Setup).

Important: When you remove a rank, Site Builder re-evaluates content in terms of the 
remaining ranks the next time you translate. If you deleted Title, say, Site Builder would 
assign Heading 1 to content it formerly assigned Title to. So you should be careful how 
you delete ranks. Also, the element associated with the rank remains. You can associate 
the element with another rank or remove the element, too, from the template.
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Figure 6-2 Rank rules dialog box

By default, hidden and strikethrough text have “negative” significance so that Site Builder 
can quickly identify any content associated with these effects in the source documents and 
place that content at the bottom of its list.

The effects that matter are the “positive” ones, in order. By default, then, when Site 
Builder applies ranks to source documents at translation, it places text with the largest font 
size at the highest hierarchical level.

Three effects can be especially important in Site Builder: Color, Font, and Alignment. In 
addition to significance and order, you can change the properties of these effects in 
different ways. See Changing the Color Property of a Rank (page 6-39), Changing the 
Ront Property of a Rank (page 6-38), and Changing the Alignment Property of a Rank 
(page 6-37).

Rank rules work in conjunction with Rank Properties, in particular, Hierarchy and 
Frequency.

Rank Properties
Ranks contain properties that can be changed in the Ranks Properties dialog box in 
Element Setup. You can change the name of a rank and also the element assigned to it. 
You can also change the hierarchical level of the rank plus the frequency with which the 
rank appears in the source document. These properties are especially important when 
creating new ranks to help identify unique content in source documents. You may have to 
experiment with hierarchy and frequency to successfully identify unique content.
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Rank Order
When you add source documents to a project and accept the default setting None under 
Import Styles or Patterns in the Choose Template dialog box, Site Builder applies a default 
set of ranks in the template to content at translation time: Lowest 1, Title, Lowest 2, 
Heading 1.

These ranks are designed to identify content hierarchy in source documents so that top-
level content, in particular, can be handled consistently Site Builder use the following 
rules:

Site Builder always looks first for content defined as the “lowest” because, in most 
instances, this will be your body text. Also, if one of your source documents is a text file, 
all the text will be in the same font size, and you wouldn’t want the text designated Title. 
What Site Builder identifies as body text will be determined by the rules used to create 
ranks. See Rank Rules (page 6-33) for more information.

This order is important because ranks are set by Site Builder at translation (styles and 
patterns, on the other hand, are imported from source documents). So if you changed the 
order, with Lowest 1 second and Title first, say, you would find Title assigned to all the 
content in the case of a text file. Likewise, the order is important when you create new 
ranks and add them to the list in the Ranks tab dialog. See Creating a New Rank 
(page 6-41).

To review the way Site Builder has assigned the Title and Heading 1 ranks to a specific 
source document, open the Edit Template dialog box for the template and pass your cursor 
slowly over the Preview window. A screentip will display the element for each portion of 
content.

Strictly speaking, Site Builder identifies only a single instance of the highest level content. 
Even if manual line breaks have been used to spread the title of a source document over 

Rank Element Availability Number of occurrences

Lowest 1 Default 
Paragraph

Lowest Greater than 0

Title Title Highest Equals 1

Lowest 2 Default 
Paragraph

Lowest Greater than 0

Heading 1 Heading 1 Highest Greater than 0
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two or more lines, Site Builder will treat this “block” of text as a single instance and 
successfully assign the Title rank to it.

About Ranks
Ranks are an alternative to styles and patterns. They can be particularly useful where the 
styles of your source documents are inconsistently applied or the documents contain a 
mixture of named and manually formatted styles.

When you add a document to a project, None is the default setting under Import Styles or 
Patterns in the Choose Template dialog box. With this setting, Site Builder ignores any 
named styles or patterns. Instead, it applies a default set of ranks in the template to content 
at translation time: Lowest 1, Title, Lowest 2, Heading 1.

The following table shows a simple example of what would happen for two documents 
with the manually formatted styles shown:

By using patterns, you would end up with nine patterns, where only five are required. So 
you would have to map some of the patterns to common elements to ensure a consistency 
of presentation in your Web pages.

In this example, you would have to specifically identify the second-level heading and the 
caption and map these to their own elements. However, you could immediately format the 
elements associated with the Title and Heading 1 ranks. And once you create patterns for 

Tech Tip: Ranks are especially recommended when you are dealing with large numbers 
of legacy documents or your project contains one or more Directory Items.

Content Doc A Doc B Rank Element

Title Times 20 pt 
Bold

Arial 16pt 
Bold

Title Title

First level 
Heading

Times 14 pt 
Italic

Arial 12 pt 
Bold

Heading 1 Heading 1

Other 
Heading

Times 12 pt 
Underscore

Lowest 2 Default Paragraph

Caption Times 9 pt 
Bold

Lowest 2 Default Paragraph

Text Times 10 pt Times 9 pt Lowest 1 Default Paragraph
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“Other Heading” and “Caption,” you could also format the Default element so that the 
Times 10 pt and Times 9 pt text could be handled consistently.

With ranks, Site Builder doesn’t recognize the complete variety of content your source 
documents might contain. But with ranks, Site Builder can

! recognize content that helps define the top-level hierarchy of your source documents 
and thus successfully format the most important content in your source documents

! eliminate potential problems with clashing styles or patterns or with too many styles 
or patterns

Note how Site Builder determines which portion of content should be designated. Title, 
Heading 1, Lowest 1, or Lowest 2 is determined by Rank Rules. You can customize these. 
See Rank Rules (page 6-33).

Changing the Alignment Property of a Rank
Rank rules dictate how content in your source documents will be treated at translation 
when Site Builder assigns ranks to identify hierarchy. They consist of “effects,” which 
represent all possible characteristics of text.

If you use ranks a great deal – as opposed to importing styles or patterns from source 
documents – you may want to change the rank rules, depending on the nature of the 
content of your source documents. If, say, you use specific alignments in your source 
documents to differentiate content and define hierarchy, you may want to change the 
default settings for the Alignment effect.

1. On the Ranks tab dialog on Element Setup, click Advanced to open the Rank Rules 
dialog box.

2. Select the Alignment effect and click Properties.

3. Under Significance, be sure that Has Positive Effect is selected.

4. The Alignments box contains three possible alignments: Right, Center, and Left. To 
delete any alignment, select the alignment and click Delete. To change the order of the 
alignments, select any alignment and click Move Up or Move Down.

5. To add Justify to the selection of alignments, click Add to open the Add Alignment 
dialog box. Select Justify and click OK.

6. Click OK again, to return to the Ranks tab dialog.

If alignment is used consistently in your source documents and can be helpful in creating 
ranks for special content, you may also want to change the order of the Alignment effect in 
the Ranks Rules dialog box.
Content Publisher User Guide 6-37



Templates
Changing the Association Between a Rank and an 
Element
You can change the association between a rank and its element. You may want to do this if 
you have created ranks for two distinct types of content that you now want to format the 
same way in a body page.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Ranks to open that tab dialog.

3. From the Ranks list, select the rank you want to associate with a different element, and 
click Association.

4. In the Change Associations dialog box, select the new element from the drop-down 
elements list.

5. Click OK.

The new element associated with the rank can be seen in the element column opposite the 
rank name.

Changing the Ront Property of a Rank
Rank rules dictate how content in your source documents will be treated at translation 
when Site Builder assigns ranks to identify hierarchy. They consist of “effects,” which 
represent all possible characteristics of text.

If you use ranks a great deal – as opposed to importing styles or patterns from source 
documents – you may want to change the rank rules, depending on the nature of the 
content of your source documents. If, say, you use specific fonts in your source documents 
to differentiate content and define hierarchy, you may want to change the default settings 
of the Font effect.

1. On the Ranks tab dialog on Element Setup, click Advanced to open the Rank Rules 
dialog box.

2. Select the Font effect and click Properties.

3. Under Significance, be sure that Has Positive Effect is selected.

4. Click the Add button to open the Add Font dialog box. From the drop-down list, 
select the font that you want to become a property of the Font effect, and then click 
OK. The font name displays in the Font box. If the name of the font used in your 
source documents is not on the list, type it into the text box.
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5. Click Add again if you want to add a second font property to the Font effect.

6. If you add two or more fonts to the Font effect, you can arrange the order of the fonts 
by selecting any font and clicking Move Up or Move Down.

7. Click OK to return to the Ranks Rules dialog box.

Changing the Color Property of a Rank
Rank rules dictate how content in your source documents will be treated at translation 
when Site Builder assigns ranks to identify hierarchy. They consist of “effects,” which 
represent all possible characteristics of text.

If you use ranks a great deal – as opposed to importing styles or patterns from source 
documents – you may want to change the rank rules, depending on the nature of the 
content of your source documents. If, say, you use color in your source documents to 
differentiate content and define hierarchy, you may want to change the default settings of 
the Color effect.

1. On the Ranks tab dialog on Element Setup, click Advanced to open the Rank Rules 
dialog box.

2. Select the Color effect and click Properties.

3. Under Significance, be sure that Has Positive Effect is selected.

4. Click the Add button to open the Color dialog box. Select the color you want to 
become a property of the Color effect, and then click OK. A color bar representing 
that color appears in the Color box. Click Add again if you want to add a second color 
property.

5. If you add two or more colors to the Color effect, you can arrange the order of the 
colors by selecting any color and clicking Move Up or Move Down.

6. Click OK to return to the Ranks Rules dialog box.

Tech Tip: If fonts are used consistently in your source documents and can be helpful in 
creating ranks for special content, you may also want to change the order of the Font effect 
in the Ranks Rules dialog box.

Tech Tip: If color is used consistently in your source documents and can be helpful in 
creating ranks for special content, you may also want to change the order of the Color 
effect in the Ranks Rules dialog box.
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Changing the Properties of a Rank
The properties of a rank consist of its name, the element it is associated with, and its 
hierarchical level and frequency.

When you create ranks to help identify unique content in source documents, hierarchical 
level and frequency are important properties. Typically, with the Title and Heading 1 
ranks successfully assigned, you will want to create additional ranks for additional 
headings levels and special content.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Ranks to open that tab dialog.

3. From the Ranks list, right-click the rank whose properties you want to change and 
choose Properties from the popup menu (or select the rank and click the Properties 
button).

4. If you want to change the rank name, type a new name in the Name text box.

5. If you want to change the element associated with the rank, choose another element 
from the Elements drop-down list.

6. Under Hierarchy, select the appropriate radio button. Under Frequency, select the 
appropriate choice from the drop-down list and enter a value in the text box. See 
Hierarchy and Frequency of Ranks (page 6-43) for more information.

7. Click OK.

Changing the Rank Rules
Rank rules dictate how content in your source documents will be treated at translation time 
when Site Builder assigns ranks to identify hierarchy. Rank rules consist of “effects,” 
which represent all possible characteristics of text. For ranking purposes, each effect has 
the properties “significance” and “order.” By changing these, you change the rank rules 
that govern how Site Builder assigns ranks.

If you use ranks a great deal – as opposed to importing styles or patterns from source 
documents – you may want to change the rank rules, depending on the nature of the 
content of your source documents. You can change the rules by changing the significance 
and/or order of each effect.

1. On the Ranks tab dialog in Element Setup, click Advanced to open the Rank Rules 
dialog box.

2. To change the significance of an effect, select the effect and click Properties.
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3. In the Rank Properties dialog box, change the significance by selecting the appropriate 
radio button.

! Has negative effect means that Site Builder will place ranks with this effect at the 
bottom of its list when it is determining content hierarchy.

! Has no effect means that the effect is not taken into account by Site Builder at 
translation when Site Builder determines content hierarchy.

! Has positive effect means that Site Builder will use this effect to ascertain the 
ranks for top-level content in source documents.

4. Click OK to return to the Rank Rules dialog box.

5. To change the order of the effect, select the effect and click Move Up or Move Down, 
as necessary, to position the effect in the desired order in the list of effects.

6. Select another effect and repeat steps 3 to 5.

7. Click OK to return to the Ranks tab dialog.

The effects Color, Font, and Alignment have additional properties that may be useful in 
ranking content if your source documents consistently use color, font, or alignment in 
special ways to define hierarchy. See Changing the Color Property of a Rank (page 6-39), 
Changing the Ront Property of a Rank (page 6-38), and Changing the Alignment Property 
of a Rank (page 6-37).

Creating a New Rank
When you add source documents to a project and accept the default setting None under 
Import Styles or Patterns in the Choose Template dialog box, Site Builder applies a default 
set of ranks in the template to content at translation time: Lowest 1, Title, Lowest 2, 
Heading 1. These ranks are designed to identify content hierarchy in source documents so 
that top-level content, in particular, can be handled consistently.

Follow these steps to complete project setup: 

1. Check that Site Builder has successfully assigned the Title and Heading 1 ranks to the 
content. The best way is to open the Edit Template dialog box and pass your cursor 
over the Preview window. A screentip will display the element associated with each 
portion of content.

2. Review content associated with Default Paragraph and decide how many new ranks 
you should create in order to identify the different kinds of content in your source 
documents and maximize your formatting options.

Follow these steps to create a new rank:
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1. On the Ranks tab dialog of Element Setup, click the New button to open the New 
Rank dialog box.

2. In the Name text box, type the name you want to use for the new rank. You may care 
to use a descriptive name such as Intro (if your source document contained, say, 
introductory text in a specific style).

3. Under Associated Element, select an element from the drop-down list or click the 
New button to open the New Element dialog box.

4. In the text box, enter the name you want to use for the new element. Typically, you 
will want to create a new element for each new rank, and to use the same name for the 
elements as the rank.

5. Click OK to return to the New Rank dialog box, and OK again to return to the Ranks 
tab dialog.

6. Select the new rank from the Ranks list and click Properties to open that dialog box. 
Having given the new rank a name and associated it with a new element, you must 
now specify its properties.

7. Under Hierarchy, select one of the options. Highest Available means Site Builder will 
create the new rank by identifying content, based on the current rank rules, 
immediately below the Title and Heading 1 ranks.

8. Under Frequency, select the appropriate option from the drop-down list, and in the 
second text box enter a value. For example, if you were seeking to create a rank for a 
second-level heading, you would probably select the frequency Number of 
occurrences if greater than and enter the value 0.

9. Click OK to return to the Ranks tab dialog.

The rank you create will take effect the next time you translate your project. If you are 
working in the Edit Template dialog box, Site Builder will do a temporary translation of 
your source documents as soon as you return there and the new rank should be apparent as 
soon as you pass your cursor over the Preview window.

If you already know how many elements you will need, you can always create these first. 
If you do so, they will be available from the drop-down Associated Element list in the 
New Rank dialog. But they will be “below the line,” grayed out, until you select each one 
and formally associate it with a rank.

Once you create a new rank and associate it with a new element, your next step is to 
review the rank’s properties. (Select the rank in the Ranks tab dialog and click Properties.) 
Your choice of Hierarchy and Frequency options (see Hierarchy and Frequency of Ranks 
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on page 6-43) along with Rank rules (see Rank Rules on page 6-33), will determine what 
content the new rank is associated with.

Hierarchy and Frequency of Ranks
Hierarchy and frequency are two important properties of a rank. When Site Builder creates 
ranks, it uses these properties, in conjunction with rank rules, to identify unique content in 
source documents.

Once you create a new rank and associate it with a new element, your next step is to 
review the rank’s properties. (Select the rank in the Ranks tab dialog and click Properties.) 
Your choice of Hierarchy and Frequency options, along with Rank Rules, will determine 
what content the new rank is associated with.

In Rank Properties dialog box, you have these hierarchy options:

! Number of occurrences equals—Use when you know the exact number of 
occurrences of the content you’re trying to associate the rank with, and enter that 
number in the companion text box. This option, with the value 1, is used by Site 
Builder to create the Title rank when you first add source documents to a project.

! Number of occurrences is fewer than—Use when you want to limit the instances of 
specific content to the value entered in the companion text box.

! Number of occurrences is greater than—Typically used with a value of 0 in the text 
box. Three of the four default ranks created by Site Builder have this property.

Remember: these options work in conjunction with the Ranks Rules.

The value for Number of occurrences equals should always be set to 1 in order to 
identify the title. Even if manual line breaks have been used to spread the title of a source 
document over two or more lines, Site Builder will treat this “block” of text as a single 
instance and successfully assign the Title rank to it. (This value can be set to 1 for other 
ranks, too.)

Styles
This section covers the following topics:

! Styles Tab Dialog (page 6-44)

! Style Properties (page 6-44)

! Removing a Style From a Template (page 6-44)

! Creating a New Style (page 6-45)
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! About Styles (page 6-46)

! Changing the Association Between a Style and an Element (page 6-46)

! Changing the Properties of a Style (page 6-47)

! Importing New Styles From a Source Document (page 6-47)

! Creating a New Style in Microsoft Excel (page 6-48)

! Styles in Microsoft Excel (page 6-48)

! Styles in Microsoft PowerPoint (page 6-49)

! Working With International Versions of Microsoft Word (page 6-50)

Styles Tab Dialog
When you add a styled document to a project and select Styles in the Choose Template 
dialog box, Site Builder imports styles from the document and assigns a element to each 
style. It then places those elements in the template you associate with the document.

Element Setup contains tab dialogs that let you view the imported styles along with the 
elements assigned to them. In the Styles tab dialog, you can

! Control the relationship between imported styles and the elements assigned to them

! Add new styles

! Delete unwanted styles

! Change the properties of styles

Style Properties
Styles contain properties that can be changed in Styles Properties in Element Setup. On 
the General tab dialog, you can change the name of a style and also the element assigned 
to it.

See Changing the Properties of a Style (page 6-47) and Styles (page 6-43).

Removing a Style From a Template
When you add a styled document to a project and select Styles in the Choose Template 
dialog box, Site Builder imports styles from the document and assigns an element to each 
style. It then places those elements in the template you associate with the document. You 
can easily remove a style from a template.
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For example, you may be translating revised source documents that no longer contain a 
certain style. When you remove a style, the element associated with the style remains. You 
can associate the element with another style or remove the element, too, from the 
template.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Styles to open that tab dialog.

3. Under Input Style, select the style you want to delete, and click Delete.

4. Click OK.

The content associated with that style is now associated with the Default Paragraph 
element.

Creating a New Style
When you add a styled document to a project and select Styles in the Choose Template 
dialog box, Site Builder imports styles from the document and assigns an element to each 
style. It then places those elements in the template you associate with the document. 

You can create new styles, if you want. For example, if you later add a new source 
document that contains a style that isn’t in your template, you can create a new style with 
the same name as the one in the source document. You can create a new element for the 
style at the same time. Just be sure to accurately name the new style you create.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Styles to open that tab dialog, and then click New.

3. In the New Style dialog box, type the name of the new style in the text box.

4. From the Associated Element drop-down list, select the element to you want to 
associate with the new style. If necessary, click New to create a new element.

5. Under Style Type, select Paragraph for a paragraph style or Character for a 
character style.

6. Click OK.

Typically, you will want to create a paragraph style, since character styles are used for the 
specialized treatment of text or data within a paragraph.

If you add a new style to a source document after you have added that document to your 
project, there is an alternative to creating a new style as explained above. You can right-
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click that document in the Contents pane of the main window, click Import, and then 
select Styles. Any used styles in the source document that are not currently a part of the 
template will be imported.

About Styles
“Styles” in Site Builder refers to named styles typically found in word processing 
documents. A named style is a set of formatting characteristics that are saved and given a 
name so that they can be applied to any paragraph in a document.

When Site Builder translates a styled document, it imports the named styles, automatically 
generates an element for each style, and saves those elements to the template you choose 
to associate with the document. It also assigns an HTML tag to each element. You create 
the look of your Web page by formatting the template and its elements.

If a source document contains the named style Heading 1, Site Builder imports that style 
and creates an element named Heading 1 and saves it in the template. You format the 
content of the source document associated with the style Heading 1 by selecting the 
template, selecting the element Heading 1, and then setting options for that element.

You don’t have to change the original style attributes, but you can. You can also use 
elements to suppress content, place content in reference pages, create text bars, and more.

The default setting in the Choose Template dialog box is None. You have to formally 
select Styles in order to import styles from a source document. If you don’t select Styles at 
that time, you can always import styles later by right-clicking the source document in the 
Contents pane and choosing Import and then Styles from the popup menu.

When Site Builder imports styles, it imports only those styles that are used in the source 
document.

Changing the Association Between a Style and an 
Element
You can change the association between a style and its element. You may want to do this 
if, say, you import two similar styles that you want to format the same way in a body page.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Styles to open the appropriate tab dialog.

3. Depending on which tab dialog you are in, select the style you want to associate with a 
different element, and click Association.
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4. In the Change Style Associations dialog box, select the new element from the drop-
down elements list.

5. Click OK.

The new element associated with the style can be seen in the element column opposite the 
style name.

Changing the Properties of a Style
The properties of a style consist of its name and the element it is associated with. You can 
change them in Style Properties in Element Setup.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Styles to open that tab dialog.

3. From the Input Style list, right-click the style whose name you want to change and 
choose Properties from the popup menu (or select the style and click the Properties 
button).

4. In the Name text box, type the name for the new style.

5. If you want to change the element associated with the style, choose another element 
from the Elements drop-down list.

6. Click OK.

Importing New Styles From a Source Document
When you add a styled document to a project and select Styles in the Choose Template 
dialog box, Site Builder imports the document’s styles, generates an element for each 
style, and saves those elements to the template you associate with the document. If you 
later add new styles to a source document, you should re-import the styles from that 
document.

1. In the Contents pane, right-click the source document that contains the new styles.

2. From the popup menu that appears, choose Import and then Styles.

3. The Progress dialog box displays briefly as the styles in the source document are 
imported once again. You can check the new styles in Elements, and use Formatting 
and the other property sheets to edit the new elements created for the styles.
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Creating a New Style in Microsoft Excel
If you want to create a new style in Microsoft Excel, open your spreadsheet in the program 
and do the following:

1. Select a cell that has the combination of formats you want to include in the new style.

2. From the Format menu, choose Style to open that dialog box.

3. In the Style Name text box, type a name for the new style.

4. Click OK.

The new style you have created can now be applied to any selected cells in your 
spreadsheet. It will be saved with the spreadsheet and used to create a new element when 
the spreadsheet is imported. If the spreadsheet is already part of a project in Site Builder, 
you can simply open that publication, right-click the spreadsheet in the Contents pane, and 
choose Import and then Styles.

Styles in Microsoft Excel
When you create Web pages from spreadsheets, note that styles in Microsoft Excel are 
based on the formatting of the cell. The default styles are:

! Heading 1

! Comma

! Comma [0]

! Currency

! Currency [0]

! Normal

! Percent

The Heading 1 style represents each worksheet. By default, Site Builder will split a 
spreadsheet during translation to create a separate HTML file for each worksheet.

Site Builder ships with templates specifically designed for source documents created in 
Microsoft Excel. The MS Excel template is listed in the Manage Templates dialog box for 
the default project file. The MS Excel TOC template is available from the drop-down list 
whenever you add a reference page to a project (assuming you have associated the MS 
Excel template with your source document).
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Styles in Microsoft PowerPoint
When you add a Microsoft PowerPoint presentation to a project, Site Builder imports the 
styles in the slides that form the presentation. In general, Site Builder translates content 
relating to the following:

! Title

! Body text

! Top-level text objects (the content of text boxes that are not inserted in graphics)

The following table summarizes styles available after a PowerPoint presentation has been 
added to a project, and shows how the styles are mapped in Site Builder.

Style Element Comment

Style Element Comment

Automatic Heading Heading 1 Style created by Site Builder where a slide 
has no title or heading. It is applied to the 
title that Site Builder also creates, based on 
the slide’s position in the presentation (e.g., 
“Slide 7”).

Center Title Heading 1 A PowerPoint style used for the title of a 
Title slide.

Heading 1 Heading 1 Style created by Site Builder and applied to 
the title of a regular slide.

Slide Slide Style created by Site Builder for all slide 
images (thus allowing them to be turned on 
or off in the output Web pages).

Body 1 to 5 Body 1 to 5 All Body styles are mapped to the Body 
element

Center Body 1 to 5 Body 1 to 5 All Body styles are mapped to the Body 
element

Half Body 1 to 5 Body 1 to 5 All Body styles are mapped to the Body 
element
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Site Builder ships with templates specifically designed for source documents created in 
Microsoft PowerPoint. The MS PowerPoint template is listed in the Manage Templates 
dialog box for the default project file. The MS PowerPoint TOC template is available from 
the drop-down list whenever you add a reference page to a project.

Working With International Versions of Microsoft Word
Microsoft Word contains a default character style that provides the font for the underlying 
paragraph style of all styles in every template you use. In the English version of Word, 
Site Builder recognizes this style by name and does not import it.

By ignoring this style, Site Builder lets you address paragraph styles throughout your 
publication without worrying about the default character style overriding them. (In Site 
Builder, character elements take precedence over paragraph elements.) So if you want to 
change the color of a particular heading, for example, you simply select the appropriate 
element and apply the color you want.

If you are using an international version of Microsoft Word, Site Builder needs to know 
the name of the default character style so that it can ignore this style. Otherwise, Site 
Builder will import the style and you will have limited control over paragraph formatting.

Follow these steps to recognize the default character style:

1. Click Application Options on the View menu.

2. In the text box under Word Processor Default Character Style Name, click the Add 
button to open the Add Default Character Style dialog box. Then type in the name of 

Quarter Body 1 to 5 Body 1 to 5 All Body styles are mapped to the Body 
element

Note 1 to 5 Note 1 to 5 Notes displayed in PowerPoint’s “Speaker 
Notes” view.

Text 1 to 5 Text 1 to 5 Text added by the user (only top-level text 
objects are translated)

Notes Footer Ignored by Site Builder

Notes Header Ignored by Site Builder

Slide Footer Ignored by Site Builder

Style Element Comment
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the default character style appropriate for the particular international version of Word 
you are using and click OK.

Default Paragraph Font is the name of this style in the English version of Word. If you 
are not sure of the name of this style in your international version, check the Styles 
drop-down list in Word (or choose Style from the Format menu to review all styles in 
use).

3. Click OK to return to the main window.

When this is set, Site Builder ignores the default character style as it imports styles from 
new documents that have been created in Microsoft Word.

This setting is user-specific on a given machine. It applies to all projects run on the 
machine by the user logged in at the time of the change.

When you add a new default character style, it will be available from the drop-down list in 
the future, unless you delete it.

If you already have publications that contain the default character style, you can delete the 
style by opening Element Setup, selecting the appropriate element in the Elements tab 
dialog, and deleting it. You will also have to open the Styles tab dialog to delete the 
corresponding style (which will now be associated with the Default element). And you 
will have to delete both the element and style from each template in your project file.

Patterns
This section covers the following topics:

! About Patterns (page 6-52)

! Changing Pattern Properties (page 6-53)

! Changing the Association Between a Pattern and an Element (page 6-53)

! Changing the Name of a Pattern (page 6-54)

! Changing the Order of Patterns (page 6-54)

! Character Patterns (page 6-55)

! Creating a New Pattern (page 6-56)

! Creating a Paragraph Pattern for Figure Numbers (page 6-57)

! Creating a Paragraph Pattern for Graphics in a Source Document (page 6-57)

! Creating a Paragraph Pattern for Numbered Lists (page 6-58)
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! Creating a Paragraph Pattern for Bulleted Lists (page 6-59)

! Creating a Paragraph Pattern for Tables (page 6-60)

! Examples of Pattern Matching (page 6-60)

! Font Properties of a Pattern (page 6-61)

! Paragraph Properties of a Pattern (page 6-62)

! Pattern Properties (page 6-63)

! Patterns Tab Dialog (page 6-63)

! Previewing Patterns (page 6-63)

! Removing a Pattern From a Template (page 6-64)

! Text Expression Properties of a Pattern (page 6-65)

About Patterns
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder analyzes the documents for formatting patterns. 
By identifying such characteristics as typeface, font size, font effects (bold, italic, etc.), 
and color, Site Builder can separate content in the document into similarly formatted 
groups, known as patterns.

Site Builder ranks the patterns, first by font size, then by text effects (bold, italic, 
underline). It associates the element Title with the highest ranking pattern, and the 
Heading 1 and Heading 2 elements with the next highest rankings. The Default Paragraph 
element is assigned to all other patterns. It names the patterns Pattern1, Pattern2, etc., in 
the order in which they appear in the document.

After Site Builder has created this series of patterns for your publication, you'll probably 
want to rename all the patterns and create some new elements (see Setting Up a Manually 
Formatted Document on page 6-93). You will then be ready to format the elements 
associated with these patterns just as you would elements associated with styles.

Site Builder assigns the Title element only if it finds only one instance of the highest 
ranking pattern in the source document. Otherwise, it will use only the Heading 1, 
Heading 2 and Default Paragraph elements.
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Changing Pattern Properties
Patterns contain a number of properties that can be changed in Pattern Properties in 
Element Setup.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Patterns to open that tab dialog.

3. From the Pattern list, right-click the name of the pattern you want to change and 
choose Properties from the popup menu (or select the pattern and click the Properties 
button).

4. In the Pattern Properties property sheet, click the appropriate tab to open that tab 
dialog and make the changes you want.

5. Click OK.

Options in the Font, Paragraph, and Text Expression tab dialogs are used for pattern 
matching when you create new patterns. Should the nature of content in the source 
document change after you’ve created a pattern, you can use these options to update the 
pattern.

Click the Related topics button for topics that explain the tab dialogs in Pattern Properties.

Changing the Association Between a Pattern and an 
Element
You can change the association between a pattern and its element easily. You may want to 
do this if you import two similar patterns that you want to format the same way.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. In the Patterns tab dialog, select the pattern you want to associate with a different 
element, and click Association.

3. In the Change Pattern Associations dialog box, select the element you now want to 
associate with the pattern from the drop-down list.

4. Click OK.
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Changing the Name of a Pattern
Patterns contain a number of properties that can be changed in Pattern Properties in 
Element Setup.

Once you complete project setup, you might want to change the names of the patterns that 
Site Builder assigns, and the elements assigned to them, to make it easier to edit the 
template.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Patterns to open that tab dialog.

3. Right-click the pattern you want to change, and choose Properties from the popup 
menu.

4. Click General to open that tab dialog.

5. In the Name text box, type in the new name for the pattern.

6. To change the element associated with the pattern, select a new element from the 
Elements drop-down list.

7. Click OK.

The General tab dialog also tells you the type of pattern selected (paragraph or character) 
and the template that contains the pattern. The Description window summarizes the 
characteristics associated with the pattern, which can be changed in the Font, Paragraph, 
and Text Expression tab dialogs and viewed in the Preview tab dialog.

Changing the Order of Patterns
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns it identifies in the document 
and assigns an element to each pattern. It then places those elements in the template you 
associate with the document.

A list of imported patterns can be viewed in the Patterns tab dialog in Element Setup. 
Patterns are listed according to their importance (font size, boldness, etc.), but named 
(Pattern1, Pattern2, etc.) according to the order of their appearance in the source 
document. Changing the order is simple.

1. In the Patterns tab dialog in Element Setup, select the pattern you want to move.

2. Use the Move Up or Move Down button, as appropriate, to reposition the selected 
pattern in the list of Patterns.
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Generally, you won’t want to change the order of patterns unless you create a new pattern 
to identify special content in the source document. In that event, the order can be critical to 
successful pattern matching. In most instances, this won’t be an issue, however, because 
new patterns are added by default to the top of the Pattern list.

Example: Your source document is set entirely in the Normal style. Your body text, 
including a bulleted list, has been named Pattern4 and assigned to Default Paragraph. You 
create a new pattern (and element) named List Bullet and use pattern matching to define 
this pattern. Your new pattern will be automatically placed at the top of the Pattern list, 
thus,

In this example, it’s important that List Bullet appears before Pattern4. It doesn’t matter 
where the two patterns appear on the pattern list, as long as List Bullet appears somewhere 
before Pattern4. In this way, Site Builder will be able to identify the bulleted list first and 
format it appropriately before formatting all the other patterns that are associated with 
Default Paragraph.

If you also created a pattern named List Number to identify numbered lists, the order of 
List Number and List Bullet wouldn’t matter, as long as both appear before Default 
Paragraph. That's because the two patterns are mutually exclusive.

Character Patterns
Character patterns can be used to identify specific characters within a paragraph. This 
allows you to recognize a word, phrase, or any data within a paragraph, and to control the 
formatting of just the matched data.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Elements to open that tab dialog, and then click New to open the New Element 
dialog box.

3. In the Name text box, type in the new name, and under Element Type, select 
Character. Then click OK.

4. Click Patterns to open that tab dialog, and then New to open the New Pattern dialog 
box.

List Bullet List Bullet

Pattern4 Default Paragraph
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5. In the Name text box, type in a name for your character pattern, and select the element 
you created in step 3. Then click OK.

6. Select the Pattern you have created, and then click Properties.

7. In Pattern Properties, set up the properties you would like to use to find content to 
associate with this pattern.

In matching character patterns, some selections such as Paragraph Alignment and 
Paragraph Contains a Table (in the Paragraph tab dialog) are not relevant and therefore 
aren’t available. Also, Character Patterns can use only sub expressions, so a Character 
Pattern such as “FISHING AND BOATING” would not be valid.

Creating a New Pattern
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns that it identifies in the 
document and assigns an element to each pattern. It then places those elements in the 
template you associate with the document. You can create new patterns, if you want.

Site Builder assigns no more than four elements to the content of a manually formatted 
document. The special element named Default Paragraph is assigned to much of the 
content. As a result, you might want to use pattern matching to identify specialized content 
and assign a new pattern name to that content.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Patterns to open that tab dialog, and then click New.

3. In the New Pattern dialog box, type the new pattern name in the text box.

4. From the Associated Element drop-down list, select the element you want to associate 
with the new pattern.

5. Under Pattern Type, select Paragraph.

6. Click OK.

You will probably want to create a new element each time you create a new pattern. And 
you will probably find it best to use the same name for both the pattern and the element.

Typically, you will want to create a paragraph pattern, since character patterns are used for 
the specialized treatment of text or data within a paragraph.
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Creating a Paragraph Pattern for Figure Numbers
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns that it identifies in the 
document and assigns an element to each pattern. It places those elements in the template 
you associate with the document. Site Builder assigns the elements Title, Heading 1, and 
Heading 2 to the top three patterns, and the element Default to all other content.

You can use pattern matching to identify and format specific content currently associated 
with the Default element. Let’s say you have a series of figures in your source document 
and these are numbered Figure 1, Figure 2, etc.

1. In the Patterns tab dialog, click New to open the New Pattern dialog box.

2. Type Figure in the Name text box (or whatever name you want to use), and click the 
New button to open the New Element dialog box.

3. Type Figure in the Name text box, and click OK to return to the New Pattern dialog 
box.

4. Click OK to return to the Patterns tab dialog.

5. With the new pattern Figure selected, click Properties to open Pattern Properties, and 
then click Text Expression to open that tab dialog.

6. Under Text Paragraph Position, click Beginning.

7. In the Text Expression text box, type the following string between the quotation marks

Figure \d+

The pattern created will also match successfully if the figures in the source document 
are numbered Figure 1-1, Figure 1-2, etc.

8. Click OK to return to the Patterns tab dialog. The Pattern Details box now lists the 
characteristic you have used to define the figures in your source document. You can 
now use this element to format this text in Formatting. Moreover, you could use this 
new element to create a List of Figures.

Creating a Paragraph Pattern for Graphics in a Source 
Document
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns that it identifies in the 
document and assigns an element to each pattern. It places those elements in the template 
you associate with the document. Site Builder assigns the elements Title, Heading 1, and 
Heading 2 to the top three patterns, and the element Default to all other content.
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You can use pattern matching to identify and format specific content currently associated 
with the Default element. Let’s say you want to create a pattern specifically for those 
paragraphs in the source document that contain graphics. You could then format the new 
element for this pattern to format the graphics (in the Graphics tab dialog in Formatting).

1. In the Patterns tab dialog, click New to open the New Pattern dialog box.

2. Type Graphic in the Name text box (or whatever name you want to use), and click the 
New button to open the New Element dialog box.

3. Type Graphic in the Name text box, and click OK to return to the New Pattern dialog 
box.

4. Click OK to return to the Patterns tab dialog.

5. With the new pattern Graphic selected, click Properties to open Pattern Properties, 
and then click Paragraph to open that tab dialog.

6. From the Paragraph Contains a Graphic drop-down box, select Yes.

7. Click OK to return to the Patterns tab dialog. The Pattern Details box now lists the 
paragraph characteristic you have used to define the new pattern.

If the graphics are associated with the Default Paragraph element, Site Builder will still 
convert them when you translate the publication. If the graphics are not GIFs, they will be 
converted to GIFs by default. By assigning a special element to the graphics, however, 
you increase your formatting options.

Creating a Paragraph Pattern for Numbered Lists
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns that it identifies in the 
document and assigns an element to each pattern. It places those elements in the template 
you associate with the document. Site Builder assigns the elements Title, Heading 1, and 
Heading 2 to the top three patterns, and the element Default to all other content.

You can use pattern matching to identify and format special content currently associated 
with the Default element. Let’s say you have a numbered list in the source document and 
have used the same font and font size for the list as for the rest of the source document.

1. In the Patterns tab dialog, click New to open the New Pattern dialog box.

2. Type ListNumber in the Name text box (or whatever name you want to use), and 
click the New button to open the New Element dialog box.

3. Type ListNumber in the Name text box, and click OK to return to the New Pattern 
dialog box.
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4. Click OK to return to the Patterns tab dialog.

5. With the new pattern ListNumber selected, click Properties to open Pattern 
Properties, and then click Text Expression to open that tab dialog.

6. In the Text Expression text box, type the following string:

“\d+\.[\t| ]”

What you have instructed Site Builder to do in its pattern search is look for one or 
more of any digit (\d+), followed by a period (\.), followed by a tab or a space (\t| ). 
The last instruction would cover situations in which some lists have tabs after the 
numbers while others do not.

7. Click OK to return to the Patterns tab dialog. The Pattern Details box now lists the 
characteristic you have used to define the numbered list in your source document. You 
can now format the numbered list in the Lists tab dialog in Formatting.

Creating a Paragraph Pattern for Bulleted Lists
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns that it identifies in the 
document and assigns an element to each pattern. It places those elements in the template 
you associate with the document. Site Builder assigns the elements Title, Heading 1, and 
Heading 2 to the top three patterns, and the element Default to all other content.

You can use pattern matching to identify and format specific content currently associated 
with the Default element. Let’s say you have a bulleted list in the source document and 
have used the same font and font size for the list as the rest of the source document.

1. In the Patterns tab dialog, click New to open the New Pattern dialog box.

2. Type ListBullet in the Name text box (or whatever name you want to use), and click 
the New button to open the New Element dialog box.

3. Type ListBullet in the Name text box, and click OK to return to the New Pattern 
dialog box.

4. Click OK to return to the Patterns tab dialog.

5. With the new pattern ListBullet selected, click Properties to open Pattern Properties, 
and then click Text Expression to open that tab dialog.

6. Under Text Paragraph Position, make sure that Beginning is selected.

7. Place your cursor between the quotation marks in the Text Expression text box and do 
the following: Click the Bullet button and type [\t| ].
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You could click the Bullet button if in pattern matching it didn’t matter what followed 
the bullet.

8. Click OK to return to the Patterns tab dialog. The Pattern Details box now lists the 
characteristic you have used to define the bulleted list in your source document. You 
can now format the bulleted list in the Lists tab dialog in Formatting.

Creating a Paragraph Pattern for Tables
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns that it identifies in the 
document and assigns an element to each pattern. It places those elements in the template 
you associate with the document. Site Builder assigns the elements Title, Heading 1, and 
Heading 2 to the top three patterns, and the element Default to all other content.

You can use pattern matching to identify and format specific content currently associated 
with the Default element.

1. In the Patterns tab dialog, click New to open the New Pattern dialog box.

2. Type Table in the Name text box (or whatever name you want to use), and click the 
New button to open the New Element dialog box.

3. Type Table in the Name text box, and click OK to return to the New Pattern dialog 
box.

4. Click OK to return to the Patterns tab dialog.

5. With the new pattern Table selected, click Properties to open Pattern Properties, and 
then click Paragraph to open that tab dialog.

6. From the Paragraph Contains a Table drop-down box, select Yes.

7. Click OK to return to the Patterns tab dialog. The Pattern Details box now lists the 
paragraph characteristic you have used to define the new pattern.

What you have done is select the paragraph immediately preceding the table. In order to 
format the appearance of a table (in the Tables tab dialog in Formatting), you must select 
the element that immediately precedes the table.

Examples of Pattern Matching
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns that it identifies in the 
document, names each pattern, and assigns an element to each pattern. It places those 
elements in the template you associate with the document.
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Site Builder assigns the elements Title, Heading 1, and Heading 2 to the top three patterns 
in the document, and the element Default Paragraph to all other patterns. Since Default 
may be assigned to most of the content of the source document, the first thing you will 
probably want to do is create new elements for those patterns assigned to Default 
Paragraph.

You may also need to create new elements for the other content not specifically identified 
in the source document. That way, you will have more formatting options when you edit 
the template. You do this by using pattern matching to identify the content. The patterns 
you create can be paragraph or character.

Following are some examples of pattern matching.

! Creating a Paragraph Pattern for Graphics in a Source Document (page 6-57)

! Creating a Paragraph Pattern for Tables (page 6-60)

! Creating a Paragraph Pattern for Numbered Lists (page 6-58)

! Creating a Paragraph Pattern for Bulleted Lists (page 6-59)

! Creating a Paragraph Pattern for Figure Numbers (page 6-57)

Several of the templates that ship with Site Builder contain three default character 
patterns: HTTP, WWW, and Email (the element names are HTTP, Weblink, and Email, 
respectively). Each contains HTML code to ensure that any character strings in the source 
documents that begin with the protocol http, the www designation that signifies a link to 
the Web, or the Mailto: link for electronic mail, will be automatically activated in the 
output pages that Site Builder creates.

Font Properties of a Pattern
Patterns contain a number of properties that can be changed in the series of tab dialogs in 
Pattern Properties in Element Setup. In the Patterns tab dialog you select the pattern you 
want to change or define, and click Properties to open Pattern Properties.

The Font tab dialog lets you use characteristics of the text in the source document to match 
patterns.

! The drop-down boxes for Bold, Italic, etc., have three settings. Yes means a pattern 
match will occur only if content contains this characteristic. No means it will occur 
only if content does not contain this characteristic. And N/A means that matching will 
be successful whether or not this characteristic is present.
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! You can also choose a type face, font size, and font color for matching purposes. 
Clearing any of these boxes means that pattern matching will be successful regardless 
of the value for that characteristic.

If you choose any of these font characteristics in matching a paragraph pattern, it must 
apply to the entire paragraph. If you choose any in matching a character pattern, the entire 
character string must contain the characteristic.

Paragraph Properties of a Pattern
Patterns contain a number of properties that can be changed in the series of tab dialogs in 
Pattern Properties in Element Setup. In the Patterns tab dialog you select the pattern you 
want to change or define, and click Properties to open Pattern Properties.

The Paragraph tab dialog lets you identify paragraphs that contain graphics or tables, and 
also by their alignment. Each paragraph contains drop-down boxes (for a graphic, a table, 
and alignment), which have three settings.

! Graphic: Yes means that pattern matching will be successful only if a paragraph in the 
source document contains a graphic. No means that pattern matching will be 
successful only if the content does not contain a graphic. N/A means that pattern 
matching will be successful whether or not this characteristic is present. This option is 
useful when you want to create a new pattern for all paragraphs containing graphics so 
you can format the graphics consistently (in the Graphics tab dialog in Formatting).

! Tables: Yes means that pattern matching will be successful only if a paragraph in the 
source document contains a table. No means that pattern matching will be successful 
only if the content does not contain a table. N/A means that pattern matching will be 
successful whether or not this characteristic is present. Here, you are actually 
identifying the paragraph that precedes the table, because it is the element associated 
with that style that must be selected in the Tables tab dialog in Formatting if you 
want to format the appearance of a table.

! Alignment: Here, pattern matching will be successful only if the paragraph has the 
alignment selected: Left, Center, or Right. N/A means that pattern matching will be 
successful whether or not this characteristic is present. This option might be useful, 
for example, if you want to create a pattern for a particular heading that is centered on 
the page. You would combine the Center option with specific font settings in the Font 
tab dialog.
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Pattern Properties
Patterns contain a number of properties that can be changed in Pattern Properties in 
Element Setup. See Changing Pattern Properties (page 6-53).

! In the General tab dialog you can change the name of a pattern and also the element 
assigned to the pattern.

! The Font tab dialog is used in pattern matching to help identify portions of text by the 
font used, the font size and color, and character attributes such as bold and italic.

! The Paragraph tab dialog is used in pattern matching to identify paragraphs containing 
graphics or tables, as well as by their alignment.

! In the Text Expression tab dialog you can modify the text expression property settings 
for the current pattern and check syntax for pattern matching.

! The Preview tab dialog allows you to preview the content of your source document 
that matches the pattern, as you change properties and test patterns.

Patterns Tab Dialog
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns it identifies in the document 
and assigns an element to each pattern. It then places those elements in the template you 
associate with the document.

Element Setup contains tab dialogs that let you view the imported patterns along with the 
elements assigned to them. In the Patterns tab dialog, you can

! Control the relationship between imported patterns and the elements assigned to them

! Add new patterns

! Delete unwanted patterns

! Change the properties of patterns

Previewing Patterns
Patterns contain a number of properties that can be changed in Pattern Properties in 
Element Setup.

In the Preview tab dialog you can see which paragraphs the selected pattern matches to.

1. In the Patterns tab dialog, right-click the pattern you want to preview and choose 
Properties from the popup menu.
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2. Click Preview to open that tab dialog.

3. Click Change Preview to open that dialog box.

4. Choose one of the documents associated with the current template, and click OK.

When you return to the Preview tab dialog, the first instance of the pattern in the selected 
document will appear in the Preview window. You can use the Previous and Next buttons 
to scroll back and forth to preview every instance of the pattern in the document. A tally of 
the number of “hits” is displayed in the upper right of the dialog box.

If nothing appears in the Preview window the document currently being previewed 
contains no examples of the pattern being matched.

Removing a Pattern From a Template
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns that it identifies in the 
document and assigns an element to each pattern. It then places those elements in the 
template you associate with the document. Site Builder assigns the elements Title, 
Heading 1, and Heading 2 to the top three patterns in the document, and Default to all the 
others.

You may decide to remove a pattern, either during project setup (if you decide to format 
two or more patterns the same way) or later (if a revised source document no longer 
contains paragraph or text formatting of a particular nature).

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Patterns to open that tab dialog.

3. From the Pattern column, select the pattern you want to delete and click Delete.

The selected pattern is removed from the template.

4. Click OK.

When you remove a pattern, Site Builder automatically re-associates the content with 
another element. In most cases, this will be Default Paragraph. But the content may be 
associated with the next pattern lower on the pattern list, instead.

For example, if you delete an element associated with Pattern4, 11 pt Arial Bold Italic, and 
the template also contains Pattern5, 11 pt Arial Bold, the content associated with Pattern4 
would then be associated with Pattern5.
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Text Expression Properties of a Pattern
Patterns contain a number of properties that can be changed in the series of tab dialogs in 
Pattern Properties in Element Setup. In the Patterns tab dialog you select the pattern you 
want to change or define, and click Properties to open Pattern Properties.

In the Text Expression tab dialog you can modify text expression settings, which allow 
you to match paragraphs (or text strings for character elements) based on their content 
instead of their formatting. You can match content at the beginning or end of a paragraph, 
or anywhere in a paragraph, by using the appropriate radio button under Text Paragraph 
Position.

The Text Expression edit box allows you to edit the string you want to match. You can use 
the Check button to parse and validate the string to ensure that it has proper syntax for 
pattern matching.

Expression Operators

Sub Expression Operators

“ “ Quotation marks – every expression must be surrounded by 
quotation marks to denote the start and end of an expression

< > Can be used to nest expressions

AND Used to command that both sub expressions be found

OR Used to command that either sub expression be found

NOT Used to command that a sub expression not be found

[ ] Allows you to express a character range; for example, from 
the digits zero to nine, use [0-9]

( ) Allows you to nest sub expressions

| Used to set an OR expression within a sub expression

? Look for zero or one of the previous – used to express when 
only one more of the previous expression may exist
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Common Character Definitions
These are used to match certain characters:

Text Combinations
The following four text combinations can also be used:

Another character that can be used is the caret, which represents any character but the one 
that follows it. For example [^ ] would represent any character except a space.

+ Look for one or more of the previous – used to express when 
more than one of the previous expression definitely exists

* Look for zero or more of the previous – used to express when 
more of the previous expression may exist

. Use to find any character

[0-9] Use to find any digit

[A-Z] Use to find any uppercase character in the English alphabet.

[a-z] Use to find any lowercase character in the English alphabet

[A-Za-z] Use to find any uppercase or lowercase character in the 
English alphabet

Bullet Use to find any bullet character. Bullets are frequently ANSI 
characters 0149 or 0183. The characters inserted represent 
these ANSI values.

Tab Use to find any tab character. The representation of a tab 
character is the result of an ANSI value insertion.

\d Use to find any digit

\u Use to find any uppercase character

\l Use to find any lowercase character

\t Use to find a tab
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The backslash is used as an escape character. If you need to match characters that are used 
in the search syntax, such as the quotation marks or parentheses, place a backslash before 
each.

Metadata
This section covers the following topics:

! A Metadata Strategy (page 6-67)

! About Metadata (page 6-69)

! Applying the Hierarchy of Metadata (page 6-70)

! Content Server Metadata (page 6-73)

! Creating New Metadata (page 6-74)

! List of Standard Metadata (page 6-76)

! Metadata Options (page 6-77)

! Making a Metadata Element-Based (page 6-78)

! Publishing Metadata to a Content Server (page 6-79)

! The Hierarchy of Metadata (page 6-81)

! Using Custom Tags for New Metadata (page 6-82)

! Changing the Association Between a Metadata and an Element (page 6-82)

! Standard and Custom Metadata (page 6-83)

! Changing the Properties of Metadata (page 6-84)

! Metadata Tab Dialog (page 6-85)

! Ordering Metadata (page 6-86)

! Removing Metadata From a Template (page 6-87)

A Metadata Strategy
In handling metadata, you are essentially trying to do two things: 

! Place the metadata in your Web output, to be visible in your Web pages and/or to 
facilitate searches for information on your Web server

! Place the metadata in your content server, to facilitate searches there
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Placing metadata in your Web output is straightforward. Once you make the metadata 
element-based (see Making a Metadata Element-Based on page 6-78), you can treat the 
metadata like any other content in . That is, you can place the metadata in your Web pages 
(see Placing an Element in Your Web Pages on page 6-26) and also promote the metadata 
to reference pages (as you would any other element). You can also place the metadata in 
Meta tags (see Placing an Element in a Meta Tag on page 6-25) to facilitate searches of 
your Web site.

The key to placing metadata in your content server is to coordinate how you inherit 
metadata from source (when you set staging and publishing options) with how you publish 
element-based metadata in Element Setup.

! When you stage or publish your project, metadata for each output page is placed in 
one or more of the metadata fields that exist in the content server. (See Content Server 
Metadata on page 6-73 for more information.)

! No matter the type of metadata (content server, standard, or custom) or the source of 
the metadata (a content server or the file system), the metadata must be assigned to 
one of these fields.

! Content server metadata is recognized by default when you inherit. That is, if your 
project contains no element-based metadata, the metadata used to stage or publish 
your project will be the metadata used to check the original source documents into 
Content Server (assuming it has been selected in Inheritance Settings on page 8-51).

! You can assign any metadata to any field (e.g., you could place Author in the 
Comments field), and different metadata to the same field. But this is unlikely to be 
useful. Conversely, if you want to publish Keywords metadata , say, you will likely 
want to create a custom metadata field named Keywords in your content server.

! For each output page that is staged or published, Content Server will accept only one 
instance of metadata for a given metadata field. As a result, if you have published 
element-based metadata, that metadata may compete with content server metadata. 
Site Builder uses a hierarchy of metadata (see The Hierarchy of Metadata on 
page 6-81) to determine which metadata will be associated with the staged or 
published output.

When Site Builder inherits from source, it applies the hierarchy to all non-empty 
metadata fields in the source documents. Say you publish the standard metadata 
Author to override the content server metadata Author. If a particular source 
document has no standard metadata for Author, Site Builder will inherit the content 
server metadata for that document, instead.
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! If you are staging or publishing to a content server other than the one used for source 
documents, you will likely want the metadata fields to be set up the same way on both 
content servers.

You can only stage or publish metadata that exists. If you have used a set procedure for 
checking source documents in Content Server, it should be easy to control the metadata 
that is associated with your source documents. To determine what standard or custom 
metadata is also associated with those documents, you may have to examine the properties 
of individual files.

Metadata is not element-based by default (except for the standard metadata Keywords, 
which is included in most templates that ship with Site Builder). You must make metadata 
element-based (see Making a Metadata Element-Based on page 6-78) in order to place the 
metadata in your Web pages and in the Meta tags of those pages.

Once metadata becomes element-based, it can also be published to the content server in 
the Element Properties tab dialog of Element Setup (see Publishing Metadata to a 
Content Server on page 6-79). When you publish element-based metadata, you are making 
it available for inheritance. What is actually inherited will depend on a number of things, 
including the hierarchy of metadata that Site Builder uses.

When Site Builder inherits from source, it applies the hierarchy to all non-empty metadata 
fields in the source documents. Say you publish the standard metadata Author to override 
the content server metadata Author. If a particular source document has no standard 
metadata for Author, Site Builder will inherit the content server metadata for that 
document, instead.

About Metadata
Metadata is simply “data about data.” In addition to content, the typical source document 
has a title, author, and other information that is associated with the document and can be 
used in different ways. In Site Builder, document information, content information, 
document properties, property values, and security settings are all metadata.

Site Builder recognizes three types of metadata:

! Content server metadata— information you apply to a source document when you 
check the document into a content server. (See Content Server Metadata on page 6-73 
for more information.)

! Standard metadata—properties automatically generated by the application that was 
used to create the source document. 
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! Custom metadata—special properties you create in the application for the source 
document.

Not every source document has standard or custom metadata. (See Standard and Custom 
Metadata on page 6-83 for more information.)

Content server metadata is used to check source documents, as well as staged and 
published output, into Content Server. All three types of metadata can be used to:

! Improve the usability of your Web site by being placed in Web pages and also the 
Meta tags of those Web pages, to facilitate information searches on your site.

! Improve the usability of your content server by being published to the content server, 
to facilitate the indexing and categorization of content. 

You must make metadata element-based (see Making a Metadata Element-Based on 
page 6-78) in order to place the metadata in your Web pages and in Meta tags. Once 
element-based, standard and custom metadata can be published to a content server (see 
Publishing Metadata to a Content Server on page 6-79). (When you  inherit document 
information (see Inheriting Document Information From Source on page 8-50), content 
server metadata is automatically recognized, so it doesn’t have to be element-based.

When different types of metadata are inherited from source, content server metadata may 
clash with standard and custom metadata. Site Builder uses a hierarchy of metadata (see 
The Hierarchy of Metadata on page 6-81) to determine which metadata is to be given 
preference during staging and publishing.

Whatever metadata you plan to use must exist in, or be associated with, the source 
documents if Site Builder is to successfully place that metadata in your Web output or in 
the content server.

The properties (standard metadata) of a source document may not accurately describe the 
document. For example, if you create a new document by making a copy of an existing 
one, the new document may inherit the properties of the existing one.

Applying the Hierarchy of Metadata
Following are five simple examples to show how Site Builder associates metadata with 
Web output in the content server when it stages or publishes a project. (See A Metadata 
Strategy on page 6-67 for more information on how Site Builder inherits metadata from 
source.)
6-70 Content Publisher User Guide



Templates
Example 1
! In the Word source document, John Doe is the property for Author. Jane Doe checks 

the document into Content Server. The document is then added to a project. When the 
project is staged, a third author -- Jack Frost -- is selected in the document information 
that is specified for all output pages in the project. 

! What metadata do we have? Three authors defined by two different types of metadata: 
John Doe = standard metadata, Jane Doe = content server metadata (for the source 
document), and Jack Frost = content server metadata (for check-in purposes for the 
Web output). All the metadata are non–element-based.

! What metadata will be used? In this simple instance, Jack Frost is the author who will 
be associated with all Web output. The two other types of metadata are irrelevant 
because you’re not inheriting from source. So if you were searching by author for the 
output Web page in your content server, you would use Jack Frost. 

Example 2
! The same as Example 1, except that this time, when the project is staged, document 

information is specified only for those output pages (frames, reference pages, etc.) that 
do not originate in a content server or the file system. For the body pages, metadata 
(including Author) is inherited from source. 

! What metadata do we have? Still three authors defined by two different types of 
metadata. 

! What metadata will be used? This time, two metadata will be used by Site Builder 
when it checks the staged output into the content server. Jack Frost again will be 
used, but this time only for frames, reference pages, etc. For body pages, Site Builder 
will recognize Jane Doe because you selected Author in Inheritance Settings and the 
content server Author is inherited by default in the absence of any element-based 
standard metadata Author being published.

Example 3
! Let’s say that in Example 2 you also associate the John Doe standard metadata with an 

element and publish that element to the content server as “Author.”

! What metadata do we have? Still three authors, defined by two different types of 
metadata. But one metadata -- John Doe -- is now element-based and has been 
published to the content server.
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! What metadata will be used? When Site Builder inherits metadata during staging, it 
will recognize John Doe rather than Jane Doe, because you have made the standard 
metadata Author element-based and published it to the content server. Jack Frost will 
still be used for the other output pages (frames, reference pages, etc.).

Example 4
! Let’s say that in Example 3, you now make the Jane Doe content server metadata 

element-based. In addition, we’ll call the original file that was checked into the 
content server Word1, and add a second file, Word2, to our project. John Doe is also 
the standard metadata Author for this second file, which resides on the file system. 
Oh, one other thing. When we order the metadata in the Metadata tab dialog of 
Element Setup, we place content server metadata Author (i.e., Jane Doe) before 
standard metadata Author (i.e., John Doe).

! What metadata do we have? Still three authors, now defined by three different types of 
metadata. John Doe = a standard element-based metadata, Jane Doe = a content server 
element-based metadata, and Jack Frost = content server metadata. 

! What metadata will be used? For both Word1 and Word2, Jack Frost will once 
again be used to check frames, reference pages, etc. into the content server. For 
Word1 (the source document in the content server), Jane Doe will be used for the 
output body pages. That’s because while both the content server metadata Author 
(Jane Doe) and standard metadata Author (John Doe) are now both element-based, the 
content server metadata is listed before the standard metadata in Element Setup. For 
Word2 (the source document in the file system), John Doe will be used because there 
is no content server metadata competing with the standard metadata in this instance.

What’s key in Example 4 is that the content server metadata is listed before the standard 
metadata in Element Setup. (See Ordering Metadata on page 6-86 for more information.) 
Had the standard metadata been listed first, it would have overridden the content server 
metadata, and John Doe would have been inherited from both Word1 and Word2. 

The following, unrelated example reinforces the issues covered in Example 4. 

Example 5
! Let’s say that your project contains source documents from both the file system and a 

content server. Ideally, you want to inherit the content server metadata Author from 
those documents. In the case of documents on the file system, however, you can’t do 
that and you’re prepared to inherit the standard metadata Author, instead. There are 
several options.
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! If you set Inheritance Settings and select Author -- and do nothing else -- you will 
inherit only the content server metadata Author -- and therefore will inherit Author 
only from the source documents in the content server. (Output pages generated from 
the source documents in the file system will be checked into the content server with 
the document information that was specified. See Specifying Document Information 
(page 8-49).)

! If you then make the standard metadata Author element-based and publish it to the 
Author metadata field in the content server, you will inherit only the standard 
metadata Author -- from both sets of source documents (in the content server and on 
the file system). That’s because element-based metadata always overrides content 
server metadata (see The Hierarchy of Metadata on page 6-81).

! However, if you also make the content server metadata Author element-based, publish 
it to the content server, and list it before the standard metadata Author in the list of 
elements in Element Setup -- then you will have the best of both worlds. That is, 
Content Publisher will inherit the content server metadata Author from documents in 
the content server and will inherit the standard metadata Author from documents on 
the file system.

Content Server Metadata
Site Builder recognizes different types of metadata: content server, standard and custom 
(see Standard and Custom Metadata on page 6-83). Content server metadata is the 
document information that you assign when you check a file into Content Server. At a 
minimum, you must assign Type, Author, and Security Group to each file.

Like standard and custom metadata, content server metadata can be associated with 
elements and placed in your Web output (in your body and reference pages, as well as in 
Meta tags to facilitate searches on your Web site). It can also be inherited from the source 
documents when you stage or publish your project.

Following are the metadata used by Content Server, which can be applied to all new 
documents checked into the content server and also inherited from source.
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Figure 6-3 Metadata used by Content Server

If you plan to use metadata in your publications, you should experiment to see what is 
possible, especially if you have source documents of different types associated with the 
same template.

The field caption “Account” was previously named “Document Account.” You can still 
use “Document Account” (any projects that already use this field caption will still run 
fine). Likewise, you can still use “Document Author,” “Document Title,” and “Document 
Type.”

Creating New Metadata
When you start a new project and add source documents to your publication, Site Builder 
can import styles or patterns from those documents or create a default set of ranks instead. 
But it does not automatically import metadata.

To include metadata from source documents in your Web pages, you must first “create” 
the metadata you want to use and associate it with an element. You must then decide how 
you want to include the metadata in your publication. (See Placing an Element in Your 
Web Pages on page 6-26.) If including metadata from the repository, you must also set 
publish option properties for the element. 
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1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Metadata to open that tab dialog, and then click the New button to open the 
New Metadata dialog box.

3. Select Standard, Custom or Repository:

! If you select Standard, choose from the drop-down list the specific type of 
metadata you want to create for your publication. See Metadata Options 
(page 6-77).

! If you select Custom, enter the name of the custom metadata you created for your 
source document.

! If you select Repository, enter the property name (such as “Document Author”) 
or the user interface name (such as dDocAuthor) of the metadata that is contained 
in the content server. Property names must contain quotes. Do not enter quotes if 
you enter the user interface name.

4. Click the New button to open the New Element dialog box. It is always best to create 
a new element for each metadata you create.

5. In the Name text box, type the name you want to use for the metadata. Typically, 
using the name of the metadata itself will simplify identification of the metadata.

6. Click OK to return to the New Metadata dialog box, and OK again. The new metadata 
is now listed in the Metadata tab dialog.

7. Click Elements to switch to that tab dialog. The new element for the metadata has 
been added to the list of elements.

8. If you are adding repository-based metadata, select the new element and click 
Properties. Click Publish to open that tab dialog. Select Publish this element, and 
enter the property name or user interface name that matches the content server in the 
Publish as text box. The name entered here should match the name entered in the 
New Metadata dialog box (see step 3). Place all user property names in quotes (such 
as “Document Author”). Enter the user interface name without quotes.

What metadata is actually included in your publication will depend on what is available 
from your content server or from your source documents. See Metadata Options 
(page 6-77).

By default, the metadata you have created will be included in the Meta tag in the <HEAD> 
of the output HTML for your publication. You can also include metadata in the body 
pages and/or page TOC to display with content.
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It is usually best to create a new element for each metadata you create. Be careful if you 
use Title from the standard drop-down list. Your document may already have a Title 
element (based on an imported style). In that case, you may want to name the new element 
for that metadata Title (Meta).

To find the formal name of a repository-based metadata, go to the Staging or Publishing 
Options dialog box and select the Browse button opposite pages. Click Inheritance 
Settings to open the Inherited Document Information dialog box, which displays the 
property and user interface metadata names that are available in the content server.

List of Standard Metadata
The following list summarizes all standard metadata recognized by Site Builder. Not all 
metadata are available for every source document. Some of the following will appear only 
in Word files, others in PowerPoint files, and so on. Some source documents contain no 
standard metadata at all. 

See Standard and Custom Metadata (page 6-83) for a list of applications that can create 
standard and custom metadata.

These metadata can be selected from the Standard drop-down list when you make a 
metadata element-based (see Making a Metadata Element-Based on page 6-78).

Title Number of characters From

Author Number of words Reply to

Subject Edit time Number of revisions

Keywords Number of bytes Version

Creation date Number of lines Last author

Modification date Number of paragraphs Account

Description Number of slides Category

Comments Number of notes Presentation target

Time Number of hidden slides Scale or crop

Manager Number of sounds or video 
clips

Links up to date
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When you make a standard metadata element-based, the metadata isn’t necessarily 
available from your source documents. You should experiment to see what is possible, 
especially if you have source documents of different types associated with the same 
template.

Metadata Options
Site Builder lets you include metadata from source documents or the content server in 
your Web publications. In the New Metadata dialog box you can select the specific form 
of metadata you want to use from the Standard drop-down list, specify custom metadata, 
or enter repository-based metadata instead.

When you are including metadata from source documents using the standard or custom 
option, keep in mind the new metadata you create isn’t necessarily available from your 
source documents. If you plan to use metadata in your publications, you should 
experiment to see what is possible, especially if you have source documents of different 
types associated with the same template.

The standard and custom metadata available will vary with different types of source 
documents and, in some instances, with the version of the application used to create the 
source documents.

Standard metadata may vary. For Microsoft Word, Microsoft Excel, and Microsoft 
PowerPoint, information in the Summary and Statistics tab dialogs of the Document 
Properties dialog box may be available: For the other applications, only metadata from the 
Summary tab dialog may be available.

Custom metadata is available only from those applications indicated in the table.

Metadata as defined in Document Properties may differ from actual metadata for a 
document. This could happen if you create a new document by copying an existing one, 
for example. In that event, the new document may inherit the properties of the existing 
one.

Company name To Characters (with spaces)

Number of pages CC

Standard Custom

Word 97/2000/2002
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Repository-based metadata applies to all source documents, if the information exists in the 
content server.

Any repository-based metadata you specify must exist in the content server. The metadata 
does not need to exist in source documents. If the content server contains the metadata, 
you can apply the repository-based metadata to all of your output files. Any repository-
based metadata you set takes precedence over standard and custom metadata settings. (See 
Inheriting Document Information From Source on page 8-50 for more information.)

Making a Metadata Element-Based
Metadata in source documents isn’t automatically included in your Web publication. (The 
standard metadata Keywords was created specially for the templates that ship with Site 
Builder). To place a metadata in your Web pages and in the Meta tags of the HTML files, 
you must formally associate the metadata with an element.

The metadata itself must exist in the source document (in the case of standard or custom 
metadata) or in the content server (in the case of content server metadata). The metadata 
you create will apply to all source documents associated with the template you edit.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Metadata to open that tab dialog, and then click the New button to open the 
New Metadata dialog box.

Excel 97/2000/2002

PowerPoint 97/2000/2002

Ami Pro

Word Pro

Word versions 2, 6

Excel

RTF

Corel WordPerfect

Standard Custom
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3. Select Standard, Custom or Repository.

! If you select Standard, select the specific type of metadata from the drop-down list 
as used in the source document. See Standard and Custom Metadata (page 6-83) 
and also List of Standard Metadata (page 6-76).

! If you select Custom, enter the name of the custom metadata you created for your 
source document.

! If you select Repository (for content server metadata), enter the field caption or 
field name as assigned to the source documents in the content server. Use quotes 
for the field caption (“Author”) but not for the field name (dDocAuthor). See 
Content Server Metadata (page 6-73) and Inheritance Settings (page 8-51).

4. Under Associated element, click the New button to open the New Element dialog box. 
It is always best to create a new element for each metadata you create. 

5. In the Name text box, type the name you want to use for the metadata. Typically, 
using the name of the metadata itself will simplify identification of the metadata. 

6. Click OK to return to the New Metadata dialog box, and OK again. The new metadata 
is now listed in the Metadata tab dialog. 

7. Click Elements to switch to that tab dialog. The new element for the metadata has 
been added to the list of elements. 

8. Click OK to return to the main window.

By default, any new metadata is placed in the Meta tag (see Placing an Element in a Meta 
Tag on page 6-25) of the Head of the output HTML file. You can also place metadata in 
your Web pages (see Placing an Element in Your Web Pages on page 6-26) and promote 
them to the reference pages of your Web output.

Which metadata are actually included in your publication will depend on what is available 
in your source documents or the content server. See Content Server Metadata (page 6-73) 
and Standard and Custom Metadata (page 6-83).

It is usually best to create a new element for each metadata you create. But be careful if 
you use Title from the Standard drop-down list. Your document may already have a Title 
element (based on an imported style). In that case, you may want to name the new element 
for metadata “Title (Meta),” say.

Publishing Metadata to a Content Server
When you set staging and publishing options, you must specify certain document 
information in order to check Web output into the content server. This metadata—Type, 
Author, and Security Group (and any other metadata you’ve specified as required)—is the 
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minimum needed for check-in, and is always used for those output pages (frames, 
reference pages, etc.) that do not originate in a content server or the file system. For output 
body pages, you can inherit metadata from source, instead.

When you inherit from source, Site Builder gives preference to content server metadata by 
default. To inherit such metadata, simply select the metadata in Inheritance Settings 
(page 8-51) when you set staging and publishing options. If you also want to inherit 
standard and custom metadata, you must associate the metadata with elements and 
formally publish those elements to the content server.

If you inherit both content server metadata and standard and custom metadata, some 
metadata may clash. Site Builder uses a hierarchy of metadata (see The Hierarchy of 
Metadata on page 6-81) to determine which metadata will be given preference when you 
stage or publish your output. (See A Metadata Strategy on page 6-67.)

1. If you have not already done so, create a new metadata, associate it with an element, 
and select where you would like the element to display. See Making a metadata 
element-based for instructions.

2. In Elements tab dialog, select the new element, click Properties, and then click 
Publish. 

3. In the Publish tab dialog, select Publish this element.

4. In the Publish as text box, enter the name of the metadata field in the content server 
that you want to publish to. Enter either the field caption or field name as it is used in 
the content server. Use quotes for field captions (such as “Author”), but not for field 
names (such as dDocAuthor). See Content Server Metadata (page 6-73) for a list of 
the default field captions and names. 

For standard and custom metadata, you will likely want to use the metadata name for 
publishing purposes. To do so, however, you will have to create a metadata field in the 
content server with that name. 

5. Click OK, and OK again to return to the main window.

When you inherit from source, you should, at the very least, select Type, Author, and 
Security Group in Inheritance Settings, unless you want to use the specified document 
information, instead (see Specifying Document Information on page 8-49).

There’s generally no need to publish element-based content server metadata, since by 
default Site Builder gives preference to this type of metadata when you inherit from 
source. (All you have to do is select the appropriate metadata in Inheritance Settings on 
page 8-51 when you set staging and publishing options). However, see Examples 4 and 5 
in Applying the Hierarchy of Metadata (page 6-70).
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If the metadata name changes in the content server, you may need to change the name in 
the Publish As text box to reflect this. You may also need to change the metadata name 
entered in Metadata Properties to ensure that the template contains the correct metadata 
name (see Changing the Properties of Metadata on page 6-84).

When Site Builder inherits from source, it applies the hierarchy to all non-empty metadata 
fields in the source documents. Say you publish the standard metadata Author to override 
the content server metadata Author. If a particular source document has no standard 
metadata for Author, Site Builder will inherit the content server metadata for that 
document, instead.

The Hierarchy of Metadata
Key metadata (Type, Author, and Security Group) are used to check Web output into 
Content Server. In other, more powerful uses, a broader range of metadata can help to 
improve the usability of your Web output and facilitate the search for information on both 
your Web server and content server.

There are different types and sources of metadata. Moreover, element-based metadata 
can be published to a content server (see Publishing Metadata to a Content Server on 
page 6-79). However, when Web output is staged or published, Content Server can accept 
only a single instance of metadata for a particular metadata field for each output page that 
is checked into the content server.

As a result, when you inherit from source during staging and publishing, you may have 
“competing” metadata. Site Builder uses a hierarchy to determine which metadata will 
take precedence and be applied to the staged or published output. (In other words, when 
you publish element-based metadata to a content server, you’re simply making it available 
for inheritance.)

When Site Builder stages or publishes a project, it recognizes metadata in the following 
order:

! 1: Metadata associated with elements

! 2: Metadata direct from the source in Content Server

! 3: Metadata (document information) that you specified when you set staging and 
publishing options

By default, when Site Builder inherits metadata from source, it inherits content server 
metadata. Once you start publishing element-based metadata, however, content server 
metadata may clash with standard or custom metadata. 
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The optimum strategy for any project will depend on the nature and location of your 
source documents, the types of metadata associated with them, and what you’re ideally 
trying to accomplish. See A Metadata Strategy (page 6-67) for more information.

When Site Builder inherits from source, it applies the hierarchy to all non-empty metadata 
fields in the source documents. Say you publish the standard metadata Author to override 
the content server metadata Author. If a particular source document has no standard 
metadata for Author, Site Builder will inherit the content server metadata for that 
document, instead.

Using Custom Tags for New Metadata
When you create new metadata to be included in the Head of the HTML output of your 
publication, by default Site Builder places the metadata in Meta tags. You can use custom 
tags, instead, if you want.

1. In the Elements tab dialog, select the new element that your metadata is associated 
with, and then click Properties to open the Element Properties dialog box.

2. Click Meta Tag to open that tab dialog.

3. Select Use custom tags, and then click Use custom tag before metadata. Enter the 
opening custom tag you want to use in the text box. For example, you might enter 
<TITLE> here.

4. Click Use custom tag after metadata and enter the closing tag. You might enter 
</TITLE> here.

5. Click OK, and OK again.

You cannot have two title tags in your HTML output. So if, in the above example, you 
used the Title tag as your custom tag, you would want to turn off titles in the Titles tab 
dialog of Globals.

Changing the Association Between a Metadata and an 
Element
You can change the association between a metadata and its element at any time.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Metadata to open that tab dialog.

3. Select the metadata you want to associate with a different element, and click 
Association.
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4. In the Change Associations dialog box, select the new element from the drop-down 
list.

5. Click OK. The new element associated with the metadata can be seen in the Elements 
column, opposite the metadata name.

6. Click OK to return to the main window.

You can also enter the Metadata Properties dialog box and change the element there. If 
you want to change just the name of the element, open the Elements tab dialog, select the 
element, and click Properties. Then change the name in the Element Properties dialog box.

Standard and Custom Metadata
Site Builder recognizes different types of metadata: content server (see Content Server 
Metadata on page 6-73), standard and custom. Standard and custom metadata originate in 
the source document, with the application used to create it.

Like content server metadata, standard and custom metadata can be associated with 
elements and placed in your Web output in your body and reference pages, as well as in 
Meta tags to facilitate searches on your Web site. (It can also be inherited from the source 
documents when you stage or publish your project.) 

See List of Standard Metadata (page 6-76) for a summary of the standard metadata 
recognized by Site Builder. You can create element-based standard metadata using the 
metadata names listed there. The table below shows the type of metadata available from 
certain applications.

Standard Custom

Word 97/2000/2002

Excel 97/2000/2002

PowerPoint 97/2000/2002

Ami Pro

Word Pro

Word versions 2, 6

Excel
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! The metadata names you use in Site Builder should be the same as those used in your 
source documents.

! The metadata available will vary with different types of source documents and, in 
some instances, with the version of the application used to create the source 
documents.

! Standard metadata may vary between applications. For Microsoft Word, Microsoft 
Excel, and Microsoft PowerPoint, information in the Summary and Statistics tab 
dialogs of the Document Properties dialog box may be available. For the other 
applications, only metadata from the Summary tab dialog may be available.

! Metadata as defined in Document Properties may differ from actual metadata for a 
document. This could happen if you create a new document by copying an existing 
one, for example. In that event, the new document may inherit the properties of the 
existing one. 

! Custom metadata is available only from those applications indicated in the table.

! In order to inherit standard and custom metadata from source documents, you must 
make the metadata element-based (see Making a Metadata Element-Based on 
page 6-78) and formally publish the metadata to the content server (see Publishing 
Metadata to a Content Server on page 6-79) This makes the metadata available for 
inheritance.

! When Site Builder inherits from source, content server metadata may clash with 
standard or custom metadata. Site Builder uses a hierarchy of metadata (see The 
Hierarchy of Metadata on page 6-81) to determine what metadata will be associated 
with the staged or published output. 

! If the source documents are on the file system, only standard and custom metadata can 
be inherited. (See Inheriting Document Information From Source on page 8-50.)

Changing the Properties of Metadata
The properties of a metadata in Site Builder are the name of the metadata and the element 
associated with the metadata. 

RTF

Corel WordPerfect

Standard Custom
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After you create the name of a standard metadata, you cannot change it. But you can 
change the name of a custom or content server metadata. (Of course, you must be careful 
how you create a metadata name in the first place. See Making a Metadata Element-Based 
on page 6-78.) In all cases, you can always change the element associated with the 
metadata.

1. In the Contents pane, select the template that contains the metadata you want to 
modify.

2. Click Element Setup ( ) on the toolbar, and then click Metadata to open that tab 
dialog.

3. Select the metadata you want to modify and click Properties to open the Metadata 
Properties dialog box.

4. Change the name of the metadata, if you want, assuming it is a custom or repository-
based metadata.

5. If you want to associate another element with the metadata, select the element from 
the drop-down list.

If you want to create a new element for the metadata, you will have to do so before 
you enter the Metadata Properties dialog box. In that event, when you select the new 
element from the Element drop down list in the Metadata Properties dialog box, you 
will find it grayed out, below the line.

6. Click OK, and OK again.

The element you associate with metadata has its own properties. To view these, open the 
Elements tab dialog, select the element, and then click Properties.

If you change the name of a content server metadata, the new name (like the original) must 
be one of the recognized metadata fields (see Content Server Metadata on page 6-73). You 
will also need to update the Publish as name in the Publish tab dialog of Element 
properties (the two names should be the same).

Metadata Tab Dialog
The Metadata tab dialog is one of five tab dialogs in the Element Setup property sheet, 
where you organize your templates initially in terms of ranks, styles, and patterns, and 
then elements.

With elements for ranks, styles, and patterns, you can format the content of your Web 
pages, promote content to reference pages, create navigation links, and so forth.
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While Site Builder can import styles or patterns from source documents, or create a 
default set of ranks instead, it doesn’t automatically recognize metadata in source 
documents. That’s why (except for the Keywords metadata) the Metadata tab dialog is 
empty when you start a new project.

Once you make a metadata element-based (see Making a Metadata Element-Based on 
page 6-78), it is automatically included in the Meta tag of the head of your output HTML 
files. It can also be placed in your Web output in the body page and page TOC (see 
Placing an Element in Your Web Pages on page 6-26), as well as promoted to reference 
pages (just like any other element) and published to a content server (see Publishing 
Metadata to a Content Server on page 6-79).

Ordering Metadata
The order in which metadata appear in the Metadata tab dialog of Element Setup 
determines the order in which the metadata appear in your Web pages and in the Meta tags 
of your HTML files. It may also determine which metadata Site Builder publishes to 
Content Server.

You can use drag-and-drop to move any metadata up or down the list.

Figure 6-4 Element setup dialog
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The Metadata tab dialog (above) shows all the element-based metadata for a given 
template of a project. If all of the metadata shown have been placed in Meta tags and 
included in the body pages and/or page TOCs, the metadata for the source documents 
associated with the template will appear in the corresponding output pages in the order 
shown.

All of the metadata shown will also be published to the content server, assuming that you 
have formally published the metadata (see Publishing Metadata to a Content Server on 
page 6-79) in the Publish tab dialog of the Metadata dialog box of Element Setup. The 
metadata will then be available for inheritance from the source documents.

Note there are two metadata named Author on the list. However, Content Server will 
accept only one instance of a given metadata field when you stage or publish a project. 

Site Builder initially uses a hierarchy of metadata (see The Hierarchy of Metadata on 
page 6-81) to determine which metadata are to be associated with staged and published 
output. In this case, Site Builder will recognize the two element-based metadata for 
Author -- and will use the content server metadata because it is listed before the standard 
metadata Author.

Removing Metadata From a Template
When you add a source document to a publication, its metadata isn’t automatically 
associated with elements in the template. You have to make each metadata element-based 
(see Making a Metadata Element-Based on page 6-78) in order to place the metadata in 
the Meta tag of your output HTML files and in the Web pages themselves. Any metadata 
you create can easily be removed from a template. 

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Metadata to open that tab dialog.

3. Select the metadata you want to remove and click Delete. You have now removed the 
metadata from your template. However, the element you created specifically for the 
metadata is still in your template.

4. Click Elements to switch to that tab dialog. The element associated with the metadata 
you deleted is now grayed out, below the line, to denote it is no longer being used in 
the template. If you no longer want the element as part of the template, select the 
element and click Delete.

5. Click OK to return to the main window.
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Elements and HTML tags
This section covers the following topics:

! Adding Custom Tags Before and After an Element (page 6-88)

! Changing the HTML Tag Assigned to an Element (page 6-89)

! About HTML Tags (page 6-89)

Adding Custom Tags Before and After an Element
Elements contain a number of properties you can change in Element Properties in Element 
Setup.

One property is the HTML tag assigned to an element. Site Builder assigns heading tags to 
elements that have heading styles associated with them, and the paragraph tag to all other 
elements. You can change these assignments, if you want. One option is to use custom 
tags.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Elements to open that tab dialog.

3. Select the element you want to change and click Properties.

4. Click HTML Tags to open that tab dialog.

5. Under Use Custom Tags, click Use custom tag before content, and in the text box 
enter the HTML tag you want to place before the element.

6. Click Use custom tag after content, and in the text box enter the HTML tag you want 
to place after the element.

Example If you use the <marquee> tag (Internet Explorer only), the content 
associated with the tag will move slowly across the screen when displayed. The 
<blink> tag (in Netscape Navigator) will cause the content to blink on and off while 
your Web page is displayed.

7. Click OK.

If you want to remove the carriage return before each paragraph for the content associated 
with a particular element, click the Remove aesthetic formatting before custom tags 
check box. This option might be especially useful where you are including JavaScript in 
your code.
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Changing the HTML Tag Assigned to an Element
Elements contain a number of properties you can change in Element Properties in Element 
Setup.

One property is the HTML tag assigned to an element. Site Builder assigns heading tags to 
elements that have heading styles associated with them, and the paragraph tag to all other 
elements. You can change these assignments, if you want.

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Elements to open that tab dialog.

3. Right-click the element for the assignment you want to change, and choose 
Properties from the popup menu.

4. Click HTML Tag to open that tab dialog.

5. Under Standard Tags, the HTML tag assigned by default to the selected element 
displays in the Tag text box. Select another tag from the drop-down list or type the 
new tag in the text box.

6. Click OK.

7. Repeat steps 3 to 6 to assign new HTML tags to other elements you want to change.

You can assign custom tags instead of using standard HTML tags. See Adding Custom 
Tags Before and After an Element (page 6-88).

About HTML Tags
Site Builder automatically assigns HTML tags to elements, which represent the ranks, 
styles, and patterns in your source documents and are used to define the look of your 
content in HTML format. You can change the default assignments, if you want. Here are 
some of the standard HTML tags defined by the industry that Site Builder uses.

HTML Tag “Extension” Explanation

address block <ADDRESS> To set off the address of the Web 
site sponsor.

block quote <BLOCKQUOTE> To set off long quotations or 
citations.

line break <BR> Forces a line break in text flow.
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Styles in Source Documents
This section covers the following topics:

! Importing Source Documents That Share Styles (page 6-91)

! Import Conflicts (page 6-91)

! Resolving Import Conflicts Between Styles and Patterns (page 6-92)

definition <DD> Definition for a term in a 
glossary list.

division <DIV> To set off different kinds of 
containers (say, chapter, section, 
abstract, or appendix).

term <DT> Descriptive part of a definition 
entry.

heading 1
through
heading 6

<H1>
through
<H6>

First-level heading through 
sixth-level heading.

list header <LH> Marks a heading of a list.

list item <LI> Marks a member item within a 
list of any kind.

no tag Used when content is not 
assigned to any tag.

note <NOTE> For admonishments (say, a 
Caution or Warning).

paragraph <P> Breaks up text into spaced 
regions.

preformatted <PRE> Renders text using a fixed font 
and treats white space characters 
literally.

HTML Tag “Extension” Explanation
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! Setting Up a Manually Formatted Document (page 6-93)

! Splitting a Source Document Into Several Web Pages (page 6-95)

! Using Hard Page Breaks to Create Multiple Output Pages (page 6-96)

Importing Source Documents That Share Styles
If you add several documents to a publication and the documents share a common set of 
named styles, a problem may arise if some of the styles have the same names but different 
attributes.

When Site Builder imports the styles of those documents, the style attributes of the first 
document translated will prevail throughout the publication (that is, to all documents that 
share the same template). In other words, the styles in the document that is listed highest in 
the Contents pane -- and is therefore highest in the translation order -- will prevail.

You might want to change the translation order to place a particular document first for 
translation purposes. But if you plan to format the shared styles extensively in Site 
Builder, the differences in attributes may not matter.

This is relevant only if you are passing through formatting characteristics “from source,” 
which is the default setting for most elements throughout Site Builder.

Import Conflicts
Conflicts can occur between patterns and styles because patterns take precedence over 
styles. In the event of a conflict, the formatting associated with a particular style may be 
ignored when you translate a publication. And unless you carefully review the formatting 
of your publication after translation, you may not be aware that this has happened.

Because of potential conflicts, you will receive an error message whenever you add a 
styled document to a publication containing manually formatted documents or add a 
manually formatted document to a publication containing only styled documents. In fact, a 
conflict may arise even if you’ve create a single pattern in an otherwise styled document 
and later add another styled document to the publication.

If you receive an “Import Conflict” error message when importing a document, you can 
still go ahead and import the document. What matters is that you then resolve the conflict 
so that when you later translate the publication, you don’t find that certain styles in your 
styled documents are being overridden by patterns.

There are two possible ways to resolve conflicts. In a simple situation, you may be able to 
remap a pattern or a style to another element if you know where the potential conflicts will 
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occur. Alternatively, you may have to create two identical templates and use one only for 
styled documents and the other only for manually formatted documents.

Resolving Import Conflicts Between Styles and Patterns
When a project consists solely of styled or manually formatted source documents, you 
have a great deal of flexibility in how you associate templates with the documents and 
how you edit the elements in those templates. When you combine a styled document with 
a manually formatted one in the same template, however, conflicts can occur.

In fact, conflicts can occur when you,

! Try to import a manually formatted document and associate it with a template that 
contains only styles (from styled documents)

! Try to import a styled document and associate it with a template that contains only 
patterns (from manually formatted documents)

! Create a paragraph pattern in a template that contains styles and later add a styled 
document to the template.

In short, a conflict can arise when you combine patterns with styles in the same template. 
That’s because patterns always take precedence over styles. Say you have a template 
containing only patterns, and one of those patterns is named Heading 1. In that event, the 
formatting associated with that pattern will be applied to any content that matches that 
pattern’s attributes, even if the content is styled “List,” for instance.

There are two solutions, depending on whether the source of potential conflicts can be 
easily identified or is widespread.

Problem 1
You’ve created a paragraph pattern in a template containing only styles. The pattern is 
used to identify bulleted lists, which don’t have a unique style. A conflict could arise if 
you later import a styled document that has bulleted lists with a unique style assigned to 
them and you want to format the two types of bulleted lists differently.

Solution 1
Let’s say you named the pattern (and the element) for bulleted lists in the original 
document Pattern Bullet, and that the style (and element) associated with bulleted lists in 
the new document is Style Bullet. Thus,
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Map either the Pattern Bullet pattern to the Style Bullet element, or the Style Bullet style 
to the Pattern Bullet element. See Changing the Association Between a Pattern and an 
Element (page 6-53) or Changing the Association Between a Style and an Element 
(page 6-46).

This will work only if the pattern is looking for formatting (in this case, a unique bullet) 
that doesn’t appear elsewhere in the source documents.

Problem 2
Your project contains many source documents. All the documents are styled but you know 
that, from time to time, you’ll want to import a manually formatted document. 
(Alternatively, your documents are all manually formatted and you may be importing a 
styled document in future.)

Solution 2
Since you can’t anticipate all the styles or patterns that will come into play in your 
publication, the simplest solution is to create two identical templates and always use one 
template for all documents containing styles and the other for all documents containing 
patterns. This means,

! Creating a new template for the styled document you import into a publication 
containing patterns (or vice versa)

! Editing only one of the two templates, but periodically replacing the dated template 
with a new template based on the one that is being continually updated.

To create a new template based on another, see Copying a Template (page 6-4).

Setting Up a Manually Formatted Document
When you add a manually formatted document to a project and select Patterns in the 
Choose Template dialog box, Site Builder imports patterns it identifies in the document 
and assigns an element to each pattern. It then places those elements in the template you 
associate with the document.

Style / Pattern Element

Pattern Bullet Pattern Bullet

Style Bullet Style Bullet
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No matter how many patterns there are in the document, Site Builder associates, at most, 
only four elements with the patterns: Title, Heading 1, Heading 2, and Default Paragraph. 
(It assigns Title only if the top pattern appears only once in the document.)

Initial Setup
In the Patterns tab dialog of Element Setup, the patterns are listed in their order of 
importance but named in their order of appearance in the document. So when you first 
enter the Patterns tab dialog to review the patterns imported, you might find something 
like this,

Setup Task
As part of project setup, you might want to do the following:

! Rename all patterns.

! Create new elements for those patterns associated with Default Paragraph. (Generally, 
it is best to use the same names for elements as for the styles or patterns.)

In this way, you will create the equivalent of a styled document and should find it easier to 
relate the elements you are formatting to the content of the source documents.

Revised Setup
In the above example, you might end up with the following:

Pattern Element

Pattern1 Title

Pattern2 Heading 1

Pattern4 Heading 2

Pattern3 Default Paragraph

Pattern5 Default Paragraph

Pattern6 Default Paragraph
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To learn more about naming patterns and creating new elements, see,

! Changing the Name of a Pattern (page 6-54)

! Creating a New Element (page 6-21)

Splitting a Source Document Into Several Web Pages
Elements contain a number of properties you can change in Element Properties in Element 
Setup.

The Split property lets you split a long source document into a series of smaller Web pages 
to simplify navigation and facilitate downloading. Each Web page becomes a separate 
HTML file in the process.

To split a source document into several Web pages

1. In the Contents pane, select the template you want to edit and click Element Setup 
( ) on the toolbar.

2. Click Elements to open that tab dialog.

3. From the Elements list, select the element you want to use to split the source 
document.

Right-click the red cross in the Split column opposite the element and choose the green 
tick mark from the popup menu that appears. (You can also click Properties and in the 
Split tab dialog click the Split the source document into multiple output pages check 
box.)

Pattern Element

Title Title

Heading 1 Heading 1

Heading 2 Heading 2

Heading 3 Heading 3

Body Text Body Text

List Bullet List Bullet
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When Site Builder splits a source document, it starts the second Web page with the second 
instance of the element. It creates a new Web page for each instance of the element after 
that. To split a document beginning with the first instance of the element, clear the 
appropriate check box in the Options tab dialog of Globals.

In addition to or instead of splitting on an element, you can use hard page breaks to create 
multiple output pages (see Using Hard Page Breaks to Create Multiple Output Pages on 
page 6-96).

Using Hard Page Breaks to Create Multiple Output Pages
As an alternative to splitting a source document on an element (see Splitting a Source 
Document Into Several Web Pages on page 6-95), you can use the hard page breaks of 
your source document to create multiple output pages.

1. In the main window, select the template associated with the source documents you 
want to edit and click Element Setup ( ) on the toolbar to open the Element Setup 
property sheet.

2. On the Elements tab dialog, click Split the source document into multiple output 
pages at each hard page break.

3. Click OK.

When you translate your source document, Site Builder will create a new Web page for 
each hard page break in each source document associated with the template.

FORMATTING
This section covers the following topics:

! Formatting (page 6-97)

! Captions (page 6-98)

! Paragraphs (page 6-100)

! Style Sheets (page 6-107)

! Tables (page 6-113)

! Lists (page 6-119)

! Graphics (page 6-123)

! Background (page 6-126)
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! Associating HTML or Scripting Code With an Element (page 6-127)

! Text Effects (page 6-128)

! Visual Aids (page 6-130)

Formatting
Formatting is one of four property sheets used to edit templates. Once you set up a 
project, you use the property sheets to complete settings for each template. The settings 
determine the look and behavior of a Web page created from any source document 
associated with the template.

In Formatting, most of the work is done in the Character and Paragraph tab dialogs, 
where you decide how text will display in a Web browser.

Among the many options in Formatting are the ability to

! Handle the special challenges posed by tables and lists

! Add graphical aids to set off content and reinforce document hierarchy

! Select conversion options for graphics in source documents

! Associate HTML code with elements

Once you select a template for editing, you can open Formatting by

! Clicking Formatting ( ) on the toolbar, or

! Opening the Edit Template dialog box and clicking the Formatting button.

In the Edit Template dialog box, you can move between the four property sheets and use 
them in any order. And you can check your changes in the Preview window as you make 
them. Also, as you pass your cursor over the content of the Preview window, a screentip 
will display the name of each element.

The Character and Paragraph tab dialogs have different options available, depending on 
whether CSS (cascading style sheets) is turned on or off in Globals. See Cascading Style 
Sheets (CSS) (page 6-107).
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Captions
This section covers the following topics:

! Promoting Captions to a Reference Page (page 6-98)

! Promoting the Captions of Graphics (page 6-98)

! Promoting the Captions of Tables (page 6-99)

Promoting Captions to a Reference Page
If your source documents contain tables or graphics with captions, you can promote the 
captions to a reference page and link directly to the tables or graphics from the reference 
page.

Since such links are to the top of the table or graphic in the Web pages you create, this 
feature is especially useful where source documents contain captions following the tables 
or graphics.

See:

! Promoting the Captions of Graphics (page 6-98)

! Promoting the Captions of Tables (page 6-99)

You can also create alternative text from a caption (see Creating Alternative Text From a 
Caption on page 5-35).

Promoting the Captions of Graphics
If your source documents contain graphics with captions, you can promote the captions to 
a reference page and link directly to the graphics from the reference page.

Because such links are to the top of the graphics in the Web pages you create, this feature 
is especially useful where source documents contain captions following the graphics.

Use this procedure to promote captions to a reference page:

1. In Formatting, from the Elements list, select the element associated with the graphics 
in your source documents, and click Graphics to open that tab dialog.

2. Under Captions, click Use caption and then click the Caption button to open the 
Captions dialog box.

3. Under Caption source, select Before the graphic or After the graphic, depending on 
where the content should be taken from in the source document.
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Site Builder uses the content immediately before or after the graphic. It doesn’t matter 
whether the content is a true caption or whether it is associated with a unique element. 
Site Builder will promote whatever that content is.

4. Under Promote, click Promote this caption with the following name, and enter a 
name in the text box below. You should give the caption a unique name.

With the name, you create an element for promotion. It isn’t included in the template 
for the body page you are promoting from, but it will be listed in the template for any 
reference page you add to your project (except for the Index). You must formally 
include the caption in the body of that reference page.

5. Click OK to return to the Graphics tab dialog.

After you include the promoted caption in reference page, Site Builder will automatically 
link the caption to the top of the graphic in the body page. In addition, it will use the 
contents of the caption as the alternative text for the image. (Alternative text is the text that 
appears in a popup window when the cursor is held over the image.)

Promoting the Captions of Tables
If your source documents contain tables with captions, you can promote the captions to a 
reference page and link directly to the tables from the reference page.

To promote captions to a reference page:

1. In Formatting, from the Elements list, select the element for the style immediately 
before the table in the source document. Then click Tables to open that tab dialog.

2. Under Captions, click Use caption and then click the Caption button to open the 
Captions dialog box.

3. Under Caption source, select Before the table or After the table, depending on 
where the content should be taken from in the source document.

Site Builder uses the content immediately before or after the table. It doesn’t matter 
whether the content is a true caption or whether it is associated with a unique element. 
Site Builder will promote whatever that content is.

4. Under Promote, click Promote this caption with the following name, and enter a 
name in the text box below. You should give the caption a unique name.

With the name, you create an element for promotion. It isn’t included in the template 
for the body page you are promoting from, but it will be listed in the template for any 

Tech Tip: Because such links are to the top of the tables in the Web pages you create, this 
feature is especially useful where source documents contain captions following the tables.
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reference page you add to your project (except for the Index). You must formally 
include the caption in the body of that reference page.

5. Click OK to return to the Tables tab dialog.

After you include the promoted caption in a reference page, Site Builder will 
automatically link the caption to the top of the table in the body page. In addition, it will 
add the caption to the output page, centered immediately below the table.

Because Site Builder adds the caption to the table in the output page, you will end up with 
two captions. If you have a unique element associated with the original caption in the 
source document, you can choose not to include the caption generated from the source 
document in the translated output. That way, you will only see one caption — the one Site 
Builder creates for the output page.

If you have graphics and tables in the same source documents, and you want to eliminate 
the table captions from the body content (per note 2), you will need to be able to associate 
different elements with the table and graphics captions.

Paragraphs
This section covers the following topics:

! Adding Padding to Paragraphs (page 6-100)

! Setting Advanced Options for Paragraphs (page 6-101)

! Setting Paragraph Borders (page 6-102)

! Indents, Margins, Borders, and Padding (page 6-103)

! Setting First-Line Indentation (page 6-104)

! Setting Paragraph Margins (page 6-105)

! Setting Line Height (page 6-106)

! Setting Paragraph Width (page 6-106)

Adding Padding to Paragraphs
Among the options available for formatting paragraphs with CSS turned on is the addition 
of padding to paragraphs. Padding typically is added when you set borders, and is the 
amount of space between the border and actual content.

See Indents, Margins, Borders, and Padding (page 6-103) for more information on how 
these options relate to each other.
6-100 Content Publisher User Guide



Templates
1. In the Contents pane, select the template you want to edit and click Formatting ( ) 
on the toolbar to open that property sheet. Then click Paragraph to open that tab 
dialog.

2. From the Elements list, select the element or elements that you want to set padding 
for. The padding you add will apply to all paragraphs associated with these elements.

3. Under Advanced, click the Advanced button. A Caution dialog box may open to 
remind you that support for the different features in the Advanced section may vary 
between browsers. Click OK.

4. Click Borders to switch to that tab dialog. Then click the Padding button under 
Padding to open the Padding dialog box. It doesn’t matter which tab you have selected 
on the Borders tab dialog when you do this.

5. In the Padding dialog box, select the tab for the border you want to set padding for: 
Left, Top, Right, Bottom. You can set padding for any one, any two or three, or all 
four borders. You can also apply the settings of any one border to all borders by 
simply clicking the Set All button.

6. Under Left, click Set left padding. Enter a value in the first text box and select the 
unit of measure from the drop-down list: points, inches, centimeters, or pixels. Repeat 
these steps to set padding for Top, Right, or Bottom.

7. If you want any setting in the Padding dialog to apply to all other settings, click Set 
All in the appropriate panel.

Setting Advanced Options for Paragraphs
The Paragraph tab dialog in Formatting is used to set options for paragraphs such as 
alignment, first line indentation, and spacing. (You format text in the Character tab 
dialog.) The options available vary significantly, depending on whether CSS is turned on 
or off. See Cascading Style Sheets (CSS) (page 6-107).

With CSS turned on, there are a number of additional settings available. Under Advanced, 
you can set the following:

! Line height—See Setting Line Height (page 6-106).

! Background color—See Setting a Background Color (page 6-126).

! Background image—See Setting a Background Image (page 6-126).

! First line indent—See Setting First-Line Indentation (page 6-104).

! Borders—Setting Paragraph Borders (page 6-102).
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! Paragraph width—Setting Paragraph Width (page 6-106).

Setting Paragraph Borders
Among the options available for formatting paragraphs with CSS turned on is the setting 
of borders for paragraphs. Borders are different from indentation, margins, and padding. 
With those three, you inject space between the edge of your screen or frame and the 
content. With borders, you can inject a rule of varying form, thickness, and color.

See Indents, Margins, Borders, and Padding (page 6-103) for more information on how 
these options relate to each other.

1. In the Contents pane, select the template you want to edit and click Formatting ( ) 
on the toolbar to open that property sheet. Then click Paragraph to open that tab 
dialog.

2. From the Elements list, select the element or elements that you want to set borders for. 
The indentation you set will be used for all paragraphs associated with these elements.

3. Under Advanced, click the Advanced button. A Caution dialog box may open to 
remind you that support for the different features in the Advanced section may vary 
between browsers. Click OK.

4. Click Borders to switch to that tab dialog. Select the tab for the border you want to 
set: Left, Top, Right, Bottom. You can set a border for one, any two or three, or all 
four. You can also apply the settings of one tab to all the others by clicking the Apply 
these settings to all sides button.

5. For the selected tab, under Size, select Take from source, Don’t specify, or Set to.

Take From Source means that Site Builder uses what is in the source document. Don’t 
Specify means the Web browser used to view the Web page may substitute its own 
default settings. With the Set To option, you can specify the size of the border you 
want to use.

6. If under Size you select Set to, enter a value in the first text box and select a unit of 
measure from the second: points, inches, centimeters, or pixels.

7. Under Style, select Take from source, Don’t specify, or Use this style. If you select 
Use this style, select the style of border you want to use from the drop-down list.

8. Under Color, select Take from source, Don’t specify, or Use this color. If you select 
Use this color, click the color button to open the Color dialog box and choose a color 
for the border there.
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9. To add Padding, click the Padding button. See Adding Padding to Paragraphs 
(page 6-100).

Indents, Margins, Borders, and Padding
When you format source documents with CSS (cascading style sheets) turned on, you 
enjoy a great deal of flexibility in setting indents, margins, borders, and padding for your 
template. See Cascading Style Sheets (CSS) (page 6-107).

The illustration below shows how these formatting options relate to each other.

Figure 6-5 Formatting options

! Indent—Can be set left and right only. Creates space that represents the distance 
between the edge of the frame and content. (Set in the Paragraph tab dialog of 
Formatting.)

! margin—Can be set top, bottom, left and right. Creates space that represents the 
distance between the indent (or frame, for top and bottom) and the border. (Click the 
Margins button in the Paragraph tab dialog of Formatting.)

! border—Can be set top, bottom, left and right. A visual effect that represents the 
distance between the margin and padding. (Click the Advanced button in the 
Paragraph tab dialog of Formatting.)

! padding—Can be set top, bottom, left and right. Represents the distance between the 
border and content. If you assign a background color or image to an element, the color 
or image will apply both to the content associated with the element and any padding 
you have set. (Click the Padding button on the Borders tab dialog of the Advanced 
dialog box.)

All these settings are zero by default. If all are zero except, say, padding, then padding 
would represent the distance between the frame and content. And so on.
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If you set a horizontal margin for a frame in the Frame Properties dialog box, any indent 
will be measured from that horizontal margin.

You can set a first-line indent for any element that is negative. If, at the same time, zero is 
the setting for indents, margins, borders, and padding, then you will lose the beginning of 
the line in your the Web page (unless you set a sufficient margin in the Frame Properties 
dialog box.)

Setting First-Line Indentation
Among the options available for formatting paragraphs with CSS turned on is setting the 
indentation for the first line of text in each paragraph of text. It is often helpful to set off 
paragraphs from each other by using a different indentation for the first line. This can be 
positive or negative. If you set negative indentation, you in effect create a hanging 
paragraph after the first line.

1. In the Contents pane, select the template you want to edit and click Formatting ( ) 
on the toolbar to open that property sheet. Then click Paragraph to open that tab 
dialog.

2. From the Elements list, select the element or elements that you want to set a first line 
of indentation for. The indentation set will be used for all paragraphs associated with 
these elements.

3. Under Advanced, click the Advanced button. A Caution dialog box may open to 
remind you that support for the different features in the Advanced section may vary 
between browsers. Click OK.

4. Under First Line Indent, on the General tab dialog, select Take from source, No 
indent, or Set to.

Take From Source means that Site Builder uses what is in the source document. Don’t 
Specify means the Web browser used to view the Web page may substitute its own 
default settings. With the Set To option, you can control the line indentation precisely.

5. If you select Set to, in the first text box select the units for the indent. In the second, 
select the unit of measure: points, inches, or centimeters. You can set a negative value 
if you want to create a hanging indent.

6. Click OK.

If you set a negative value for the indent (step 5), be sure to create sufficient space with 
either indent, margins, borders, or padding. Otherwise, part of the first line of your 
paragraph may not be visible. See Indents, Margins, Borders, and Padding (page 6-103).
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Setting Paragraph Margins
Among the options available for formatting paragraphs with CSS turned on is the setting 
of margins. The margin is simply the distance between the edge of the screen and where 
text begins. If the text is within a frame, then it is the distance from the edge of the frame 
to text.

See Indents, Margins, Borders, and Padding (page 6-103) for more information on how 
these options relate to each other.

1. In the Contents pane, select the template you want to edit and click Formatting ( ) 
on the toolbar to open that property sheet. Then click Paragraph to open that tab 
dialog.

2. From the Elements list, select the element or elements associated with the content you 
want to set line height for.

3. Under Margins, click the Margins button to open that dialog box.

4. Set the margin for Left, Top, Right and Bottom, as appropriate. In each case, select 
Take from source, Don’t specify, or Set to.

Take From Source means that Site Builder uses what is in the source document. Don’t 
Specify means the Web browser used to view the Web page may substitute its own 
default settings.

5. If you select Set to, enter a value in the first text box (or use the Up/Down controls to 
set the value) and from the second, drop-down list, choose a unit of measure: points, 
inches, centimeters, or pixels.

If you want to apply the same margin for Left, Top, Right, and Bottom, complete the 
settings for just one of the four panels and click Set All.

6. Click OK to return to the Paragraph tab dialog.

Verify your results carefully when setting margins. Top and bottom margins aren’t 
handled with uniformly by all browsers.

If you have created a frameset and already set a margin for a frame in the frameset, any 
margin you create for the paragraphs that display in that frame will be in addition to the 
frame margin.

If you apply a top and/or bottom margin, you will increase the space between all 
paragraphs associated with the element you have formatted.
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Setting Line Height
Among the options available for formatting paragraphs with CSS turned on is the setting 
of line height. Line height is the height that a line of text occupies, from its base line to the 
base line of the line above or below.

1. In the Contents pane, select the template you want to edit and click Formatting ( ) 
on the toolbar to open that property sheet. Then click Paragraph to open that tab 
dialog.

2. From the Elements list, select the element or elements associated with the content you 
want to set line height for.

3. Under Advanced, click the Advanced button. A Caution dialog box opens to remind 
you that support for the different features in the Advanced section may vary between 
browsers. Click OK.

4. Under Line Height, on the General tab dialog, select Take from source, Don’t 
specify, or Set to.

Take From Source means that Site Builder uses what is in the source document. Don’t 
Specify means the Web browser used to view the Web page may substitute its own 
default settings. With the Set To option, you can control the line height precisely.

5. If you select Set to, enter a value for the number of units and select a unit of measure: 
points, inches, centimeters, or pixels. The line height you set will be used for all lines 
in paragraphs associated with the element you are editing.

6. Click OK to return to the Paragraph tab dialog.

Line height should be set in conjunction with font size. You shouldn’t set a line height of 
12 points if your font size is 20 points unless you intentionally want lines of text to 
overlap.

Setting Paragraph Width
Among the options available for formatting paragraphs with CSS turned on is setting 
paragraph width.

1. In the Contents pane, select the template you want to edit and click Formatting ( ) 
on the toolbar to open that property sheet. Then click Paragraph to open that tab 
dialog.

2. From the Elements list, select the element or elements that you want to set paragraph 
width for. The width will be used for all paragraphs associated with these elements.
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3. Under Advanced, click the Advanced button. A Caution dialog box may open to 
remind you that support for the different features in the Advanced section may vary 
between browsers. Click OK.

4. In the Advanced Settings dialog box, click Width to open that tab dialog.

5. Under Content Width, select Don’t specify or Set to.

Don’t Specify means the Web browser used to view the Web page may substitute its 
own default settings. With the Set To option, you can control the width of paragraphs 
precisely.

6. If you select Set to, in the first text box select a value for the width. In the second, 
select the unit of measure: points, inches, centimeters, pixels, or percent. Click OK to 
return to Formatting.

7. Click OK.

How text displays in a Web publication will also be affected by the use of other features. 
See Indents, Margins, Borders, and Padding (page 6-103). How browsers display 
paragraph width onscreen and print pages with this CSS setting may vary significantly.

Style Sheets
This section covers the following topics:

! Cascading Style Sheets (CSS) (page 6-107)

! Formatting Characters With CSS (page 6-108)

! Formatting Characters Without CSS (page 6-110)

! Formatting Paragraphs With CSS (page 6-111)

! Formatting Paragraphs Without CSS (page 6-112)

Cascading Style Sheets (CSS)
Site Builder implements CSS (cascading style sheets) by means of embedded, inline 
styles, which you create mostly in the Character and Paragraph tab dialogs of Formatting.

! Since CSS is template-based, you turn CSS on or off for each template in your project.

! Some templates already have CSS turned on – those with “CSS” in their name (see the 
Manage Templates dialog box).

! As you create the template, you can turn on CSS in the New Template dialog box.
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! Settings affected by CSS are in the Character and Paragraph tab dialogs of Formatting. 
These include settings in the Table Overrides dialog boxes and the Page TOC tab 
dialog.

! Options in Navigation for creating text bars are also affected by CSS.

! For some CSS settings, especially those in the Advanced section of the Paragraph tab 
dialog, browser behavior is inconsistent. You may need to experiment to see how CSS 
can enhance the look of your Web pages.

Use this procedure to enable or disable Cascading Style Sheets:

1. In the Contents pane, select the template that you want to enable Cascading Style 
Sheets for and click Globals ( ) on the toolbar.

2. Click Options to open that tab dialog.

3. Select the Allow CSS character and paragraph formatting check box.

4. Click OK to return to the main window and then modify the element or elements you 
want to format.

You can use a style sheet in Site Builder, either by referencing a file or by entering the 
complete style sheet as HTML code in your HTML file. You can do this in the HTML tab 
dialog of Globals. However, the results may not be what you expect.

Site Builder generates CSS1- and CSS2-compatible style sheets inline. (CSS1 and CSS2 
are both W3C standards. The more recently recommended CSS2 builds on CSS1.)

With CSS, you can enhance the onscreen presentation of your text. But your browser may 
not handle CSS well when you print what is on the screen.

Formatting Characters With CSS
Site Builder can be configured to generate formatting with standard HTML tags or with 
CSS (cascading style sheet) markup. Enabling CSS for a template changes options in the 
Character and Paragraph tab dialogs in Formatting. See Cascading Style Sheets (CSS) 
(page 6-107).

The Character tab dialog in Formatting is used to format text for your Web page at the 
character level. Options under Font Size are different when you have the CSS 
functionality turned off. See Formatting Characters Without CSS (page 6-110).

1. In Globals, click Options to open that tab dialog and select the Allow CSS character 
and paragraph formatting check box.

2. In Formatting, click Character to open that tab dialog.
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3. From the Elements list, select the element or elements you want to format.

4. Under Font Name, Font Color, and Font Size, select radio buttons for the desired 
options.

Take From Source means that Site Builder uses what is in the source document. Don’t 
Specify means the Web browser used to view the Web page may substitute its own 
default settings.

5. If you select Use this font, click the down arrow on the appropriate drop-down box to 
select a specific font.

6. If you select Use this size, you have several options from the drop-down box. In 
addition to Larger and Smaller and a range of seven sizes from xx-Small to xx-Large 
(analogous to the sizes numbered 1 through 7 available when CSS is turned off), there 
is now a Custom option.

By selecting Custom, you can fine-tune the size of text in your Web pages, using one 
of four units of measure: points, inches, centimeters, or percent. Enter a value for font 
size and select a unit of measure.

1 inch = 72 points. “Percent” means percentage of the parent element’s font size. (For 
example, the default font size for the <P> tag is Medium.)

7. If you select Use this color, click the color button to open the Color dialog box to 
select a color.

8. Under Text Effects, click Effects if you want to change some of the effects used in 
your source document. (See Text Effects on page 6-128.)

9. Under Table Overrides, click Override when in a table if you want to format the 
content of tables in the document differently. (See Formatting Characters in Tables on 
page 6-113.)

10. Click OK to save the changes to the template and return to the Edit Template dialog 
box or the main window.

You may want to use Table Overrides when the same styles have been used for the content 
of tables as well as for other content in the source document.

The actual font, font size, and font color that display in a Web page are dependent on the 
Web browser used as well as options on the user's machine.

You use options in the Character and Paragraph tab dialogs of Formatting to format the 
content of tables. You use options in the Tables tab dialog to format the appearance of 
tables.
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Formatting Characters Without CSS
Site Builder can be configured to generate formatting with standard HTML tags or with 
CSS (cascading style sheet) markup. Enabling CSS for a template changes options in the 
Character and Paragraph tab dialogs in Formatting. See Cascading Style Sheets (CSS) 
(page 6-107).

The Character tab dialog in Formatting is used to format text for your Web page at the 
character level. Options under Font Size are different when you have the CSS 
functionality turned on. See Formatting Characters With CSS (page 6-108).

1. In the Contents pane, select the template you want to edit and click Options in 
Globals to open that tab dialog, and clear the Allow CSS character and paragraph 
formatting check box.

2. In Formatting, click Character to open that tab dialog.

3. From the Elements list, select the element or elements you want to format.

4. Under Font Name, Font Color, and Font Size, select radio buttons for the desired 
options.

Take From Source means that Site Builder uses what is in the source document. Don’t 
Specify means the Web browser used to view the Web page may substitute its own 
default settings.

5. If you select Use this font or Use this size, click the down arrow on the appropriate 
drop-down box to select a specific font or size.

6. If you select Use this color, click the Color button to open the Color dialog box to 
select a color.

7. Under Text Effects, click Effects if you want to change some of the effects used in 
your source document. (See Text Effects on page 6-128.)

8. Under Table Overrides, click Override when in a table if you want to format the 
content of tables in the document differently. (See Formatting Characters in Tables on 
page 6-113.)

9. Click OK to save the changes to the template and return to the Edit Template dialog 
box or the main window.

You may want to use Table Overrides when the same styles have been used for the content 
of tables as well as for other content in the source document.

The actual font, font size, and font color that display in a Web page are dependent on the 
Web browser used as well as options on the user's machine.
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Options in the Character and Paragraph tab dialogs of Formatting are used to format the 
content of tables. Options in the Tables tab dialog are used to format the appearance of 
tables.

Formatting Paragraphs With CSS
Site Builder can be configured to generate formatting with standard HTML tags or CSS 
(cascading style sheet) markup. Enabling CSS for a template changes the options available 
in the Character and Paragraph tab dialogs of Formatting. See Cascading Style Sheets 
(CSS) (page 6-107).

The Paragraph tab dialog in Formatting is used to set options for paragraphs such as 
alignment, indentation, and spacing. (You format text in the Character tab dialog.) These 
options differ significantly with CSS turned off. See Formatting Paragraphs Without CSS 
(page 6-112).

1. In Globals, click Options to open that tab dialog and select the Allow CSS character 
and paragraph formatting check box.

2. In Formatting, click Paragraph to open that tab dialog.

3. From the Elements list, select the element or elements you want to format.

4. Under Alignment, select one of the three options. If you select Use this alignment, 
use the down arrow to select Left, Center, Right, or Justify from the drop-down box.

5. Under Indentation, select one of the three options for Left Side. Do likewise for Right 
Side. If you select Set To in either case, enter the desired value in the edit box or use 
the Up/Down control to set the value. Click the down arrow on the second box to 
select a unit of measure: points, inches, or centimeters (1 inch = 72 points).

6. Under Spacing, set the additional line space you want before or after each paragraph. 
Your browser may automatically add space between paragraphs.

7. Under Special, click Render paragraph as a graphic to save the element information 
in a graphic format during translation. This could be useful, for example, where you 
are using an unusual font that users are unlikely to have available on their machines.

8. Under Advanced, to set advanced options such as borders and padding, click the 
Advanced button to open that dialog box. See Setting Advanced Options for 
Paragraphs (page 6-101).

9. Under Table Overrides, click Override when in a table if you want to format the 
content of tables in the document differently. See Formatting Paragraphs in Tables 
(page 6-115).
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10. Click OK to save the changes to the template and return to the Edit Template dialog 
box or to the main window. Or click another tab to format other aspects of the 
document.

If you work in the Edit Template dialog box, you can use the Preview box to see how your 
Web page changes with each modification. Also, as you pass your cursor over the content 
of the Preview window, a tool tip will display the name of each element.

Formatting Paragraphs Without CSS
Site Builder can be configured to generate formatting with standard HTML tags or CSS 
(cascading style sheet) markup. Enabling CSS for a template changes the options available 
in the Character and Paragraph tab dialogs of Formatting. See Cascading Style Sheets 
(CSS) (page 6-107).

The Paragraph tab dialog in Formatting is used to set options for paragraphs such as 
alignment, indentation, and spacing. These options differ significantly with CSS turned 
on. See Formatting Paragraphs With CSS (page 6-111).

1. In Globals, click Options to open that tab dialog and clear the Allow CSS character 
and paragraph formatting check box.

2. In Formatting, click Paragraph to open that tab dialog.

3. From the Elements list, select the element or elements you want to format.

4. Under Alignment, select one of the three options. If you select Use this alignment, 
use the down arrow to select Left, Center, or Right from the drop-down box.

5. Under Indentation, select one of the four options. If you select Indent left side only 
by or Indent both sides by, enter the desired value in the edit box or use the 
Up/Down control to select the number of tab stops you want to use.

6. Under Spacing, set the additional line space you want before or after each paragraph. 
Your browser may automatically add space between paragraphs.

7. Under Special, click Render paragraph as a graphic to save the element information 
in a graphic format during translation. This could be useful, for example, where you 
are using an unusual font that users are unlikely to have available on their machines.

8. Under Table Overrides, click Override when in a table if you want to format the 
content of tables in the document differently. (See Formatting Paragraphs in Tables on 
page 6-115 for more information.)
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9. Click OK to save the changes to the template and return to the Edit Template dialog 
box or to the main window. Or click another tab to format other aspects of the 
document.

If you work in the Edit Template dialog box, you can use the Preview box to see how your 
Web page changes with each modification. Also, as you pass your cursor over the content 
of the Preview window, a screentip will display the name of each element.

Indentation is the only option you have for affecting the layout of paragraphs with CSS 
turned off. With CSS turned on, however, you can also set margins, borders, padding, and 
paragraph width.

If you have created a frameset for your publication and have set margins for any of the 
frames in the frameset, this will affect the indentation setting in the Paragraph tab dialog. 
In other words, indentation is measured from the margin set for the frame, not from the 
edge of the frame.

Tables
This section covers the following topics:

! Formatting Characters in Tables (page 6-113)

! Formatting the Appearance of Tables (page 6-114)

! Setting Colors in Tables (page 6-115)

! Formatting Paragraphs in Tables (page 6-115)

! Setting Up Styles to Format the Appearance of Tables (page 6-116)

! Setting Table Borders and Size (page 6-117)

! Setting Table Alignment (page 6-117)

! Formatting Headings in Tables (page 6-118)

Formatting Characters in Tables
When you format characters for an element in a template, the formatting instructions 
apply throughout your Web pages, including to text in tables.

Ideally, you will want to use unique styles for table content. But if you use the same styles 
as for the rest of your source document, you can still use Table Overrides to format text in 
tables differently.
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1. In Formatting, click Character to open that tab dialog. Select the element or 
elements you want to format for tables.

2. Under Table Overrides, click Override when in a table, and then click Character.

3. In the Character dialog box for table overrides, select the font name, font color, and 
font size you want to use. See Formatting Characters Without CSS (page 6-110).

4. If you want to change text effects, click Effects and set the appropriate options in that 
dialog box (see Changing Text Effects on page 6-129).

5. Click OK to save the changes to the template and return to the Character tab dialog.

You use options in the Character and Paragraph tab dialogs of Formatting to format the 
content of tables. You use options in the Tables tab dialog to format their appearance.

Formatting the Appearance of Tables
You can format both the content of tables and their appearance. You format table content 
in the Character and Paragraph tab dialogs in Formatting, using the Table Overrides 
feature, if necessary. (See Formatting Characters in Tables on page 6-113 and Formatting 
Paragraphs in Tables on page 6-115.) You format the appearance of tables in the Tables 
tab dialog.

To format the appearance of a table, you must select the element that is associated with the 
style that immediately precedes the table in the source document. See Setting Up Styles to 
Format the Appearance of Tables (page 6-116) for more information on how to make the 
most of Site Builder’s table formatting features.

1. In the Contents pane, select the template you want to edit, click Formatting, and then 
click Tables to open that tab dialog.

2. From the Elements list, select the element that immediately precedes the table in the 
source document.

3. Under Appearance, do one of the following:

! if you want to format the appearance of the table, click Borders and sizing, 
Alignment, or Colors (all three buttons open the same property sheet, but with a 
different tab dialog open initially).

! if you want to ensure that no tables are contained in your output, select Omit all 
table markup tags from output HTML. When selected, the preview window for 
that element becomes blank, because no output for that element will appear within 
a table. 
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4. Under Special, select Convert two column tables with no visible border to heading 
and paragraph and use this tag for the heading part, then select a heading, if you 
want to convert tables containing two columns and no border into headings and 
paragraphs.

5. Under Empty Cells, accept the default of Non breaking space to place a non-breaking 
space in the output HTML for the table. In HTML, non-breaking spaces are required 
in blank cells of tables to retain proper formatting. If you would rather add text than 
leave an empty cell, select the blank text box and enter the text you want to appear, 
such as “intentionally left blank.”

6. Under Headers, select Use row headings or Use column headings if you want the 
first row of the table or the first column to be treated as headings on your Web pages. 
(For more information, see Formatting Headings in Tables on page 6-118.)

7. Complete formatting for the table, as appropriate. 

Setting Colors in Tables
Among the options for formatting the appearance of tables are setting colors for four 
separate table elements: table border, cell, border, table background, and cell background.

1. In the Contents pane, select the template you want to edit and click Formatting on the 
toolbar.

2. From the Elements list, select the element that immediately precedes the table in the 
source document.

3. Click Tables to open that tab dialog, and then click Colors.

4. Under Table Border, click one of the radio buttons.

5. If you select Use this color, click the Color button to open the Color dialog box and 
select a color you want to use. Click OK to return to the Colors tab dialog in Tables.

6. Repeat steps 4 and 5 to set colors for table background and also cell borders and 
background.

7. Click OK.

The Preview box displays your changes.

Formatting Paragraphs in Tables
The Paragraph tab dialog in Formatting is used to set options for paragraphs such as 
alignment, indentation, and spacing. For each element selected, the formatting instructions 
apply throughout the Web page, including to paragraphs in tables.
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Ideally, you will want to use unique styles for table content. But if you use the same styles 
for the content of tables as for the rest of your source document, you can still use Table 
Overrides to format paragraphs in tables differently.

1. In Formatting, click Paragraph to open that tab dialog. From the Elements list, 
select the element or elements you want to format for tables.

2. Under Table Overrides, click Override when in a table, and then click Paragraph.

3. In the Paragraph dialog box for Table Overrides, select the alignment, indentation, and 
spacing you want to use. See Formatting Paragraphs Without CSS (page 6-112).

4. Click OK to save the changes and return to the Paragraph tab dialog.

You use options in the Character and Paragraph tab dialogs of Formatting to format the 
content of tables. You use options in the Tables tab dialog to format the appearance of 
tables.

Setting Up Styles to Format the Appearance of Tables
To use the Tables tab dialog in Formatting to format the appearance of a table, you must 
select the element that immediately precedes the table. This has the advantage of letting 
you use unique styles for the content of all your tables while retaining the option of 
formatting the appearance of the tables differently.

If you plan to format all the tables the same way, you need to identify the styles that 
precede the tables in your source documents. Then, when you are ready to use the Tables 
tab dialog in Formatting, simply select all the elements based on those styles. Site Builder 
lets you format multiple elements simultaneously, and this approach will save you time.

On the other hand, if you plan to format some tables differently, minimal editing of your 
source documents may be required. But you will have much greater control over how your 
tables display in your Web pages, as a result.

1. In your source documents, create a special series of styles named, say, Table1, Table2, 
etc. They all can have the same attributes and be based on Normal (their attributes 
don’t matter if you use them only for this purpose).

2. Assign these styles to the tables in your documents. For example, you might want 
Table1 to be used for certain tables that you want to appear flush left with a blue 
border and yellow cell background. Likewise, you might want Table2 to be used for 
tables that are to be centered, with extra “padding” to set the cells apart.

3. That is, before each table in your source document, place the appropriate style. 
Remember, all you’re entering is an empty paragraph. So you can minimize the space 
the paragraph occupies by setting the font size to 2 or 3 points.
6-116 Content Publisher User Guide



Templates
4. Next, re-import the styles from your source documents so that you now have elements 
for those styles in your publication. When you format the appearance of tables in the 
Tables tab dialog of Formatting, pick the appropriate element: Table1, Table2, etc.

Setting Table Borders and Size
Among the options for formatting the appearance of tables are setting table borders and 
size. Formatting borders is a three-part process of setting the border width and then 
adjusting both cell spacing and cell padding. Setting table size refers to setting the width 
of the table itself.

1. In the Contents pane, select the template you want to edit and click Formatting on the 
toolbar.

2. From the Elements list, select the element that immediately precedes the table in the 
source document.

3. Click Tables to open that tab dialog, and then click Borders and sizing.

4. Under Table Width, click the appropriate radio button to set the width of the table in 
your Web page. If you check Pixels or Percent, you must also enter a value in the 
appropriate box opposite. You can use the up/down controls to reset the values.

5. Under Cell width, click Take from source or Don’t specify.

6. Under Border thickness, select one of the radio buttons. If you select Use this 
thickness, use the Up/Down control to set a value in the box.

7. Check Set Cell Spacing and enter value in the box opposite.

8. Check Set Cell Padding and enter a value in the box opposite.

The Preview box displays your changes.

Setting Table Alignment
Among the options for formatting the appearance of tables are setting table alignment. 
This involves setting the horizontal position of the table on the Web page and adjusting the 
vertical position of cell contents.

1. In the Contents pane, select the template you want to edit and click Formatting on the 
toolbar.

2. From the Elements list, select the element that immediately precedes the table in the 
source document.

3. Click Tables to open that tab dialog, and then click Alignment.
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4. Under Table Horizontal, click one of the radio buttons.

5. If you check Use this alignment, select Left, Right, or Center from the drop-down 
list.

6. Under Cell Contents, select one of the four radio buttons according to how you want 
to align the contents of the table vertically within the table cells.

7. Click OK.

The Preview box displays your changes.

Formatting Headings in Tables
When formatting the appearance of tables (see Formatting the Appearance of Tables on 
page 6-114), one option is to treat the first row or column of the tables as headings in your 
Web output. You may want to do this if the tables of your source documents do not have a 
distinct style (and therefore element) associated with them.

By using this formatting option, the content associated with the heading will be associated 
with the <TH> tag in the output and not the <TD> tag. Your browser will treat this content 
differently to make it more distinctive.

The use of the <TH> tag will also make the table's content more accessible to those with 
disabilities who are using an HTML screen reader to gain access to your Web site and 
navigate its contents.

1. With the appropriate template selected on the main window, click Formatting ( ) 
to open that property sheet.

2. Select the element immediately before the table you want to format and click Tables 
to open that tab dialog.

3. Under Headings, select Use row headings and/or Use column headings. You can 
use both, assuming that all the tables associated with the selected template are 
structured the same way and it makes sense to treat both the first column and first row 
of each table as a heading.

4. Click OK to save your changes and return to the main window.

When you translate your source documents (or view a temporary translation in the Edit 
Template dialog box), your table row heading and/or table column heading will now be 
formatted differently, according to how your browser interprets the <TH> tag. For 
example, in Internet Explorer 5.5 the headings will be bold, centered within each cell.
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Lists
This section covers the following topics:

! Applying the <LI> Tag as a Custom Tag (page 6-119)

! Choosing Bullets for Lists (page 6-120)

! Formatting Bulleted Lists (page 6-120)

! Formatting Lists (page 6-121)

! Formatting Numbered Lists (page 6-122)

! Stripping Non-List Items (page 6-123)

Applying the <LI> Tag as a Custom Tag
When you work with bulleted lists, you have the option of applying the <LI> tag as a 
custom tag to get the list to display flush left in your Web pages.

When you first translate a list, Site Builder applies the <P> tag to the element associated 
with list content so that the list displays in your Web pages just as it does in your source 
documents. To achieve greater control over formatting, you can select Bulleted list in the 
Lists tab dialog in Formatting, check Strip input to first blank space or tab, and choose 
a bullet for the list item (see Formatting Bulleted Lists on page 6-120).

With these changes, Site Builder replaces the <P> tag with the <LI> tag. The bulleted list 
appears correctly in your Web page, with the old bullet stripped out and the new one in its 
place. However, the list is indented. That is because when Site Builder applies an <LI> tag 
to each list item, it also applies the <UL> tag to the list itself, and the <UL> tag forces 
indentation.

If you want your list to display flush left in your Web pages, you can apply the <LI> tag as 
a custom tag and thus avoid use of the <UL> tag.

1. In Formatting, select the element associated with list items and open the Lists tab 
dialog.

2. Under Type, select Not a list. Check Strip input to first blank space or tab.

3. With the element still selected, right-click and choose Properties from the popup 
menu.

4. In the Properties dialog box, click HTML Tag to open that tab dialog.

5. Click Use custom tag. Enter <LI> for the tag to be used before content, and </LI> for 
the tag to be used after content.
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6. Click OK, and OK again.

When you translate your source document, Site Builder will create a Web page with the 
bulleted list flush left. If you view the source, you will see that the <LI> tag has been 
applied to each list item but that no <UL> tag has been used.

By treating the list as Not a List (step 2) you won’t be able to use a custom bullet.

Choosing Bullets for Lists
When you format bulleted lists, you can select the type of bullet for the list.

1. In the Lists tab dialog, click Bullets.

2. Do one of the following,

! Under Bullet Type, check Use standard bullet and select a bullet type from the 
drop-down list, or

! Check Use custom bullet, and in the File Name text box, enter the name of the 
file for the bullet you want to use. Alternatively, click Browse to locate the file, or 
click Gallery to select a bullet from the Gallery.

If you pick a graphic from Content Server, you will activate the Info ( ) button 
and thereafter will be able to open the Content Information page for that file at any 
time.

3. In the Alternative Text box, enter information that you would like to display onscreen 
in the event that the bullet doesn’t display. The alternative text will display when (a) a 
user's browser is text only, (b) a user chooses to disable the browser's graphics 
functionality, or (c) a visually impaired user is viewing Web pages with an HTML 
screen reader. ). If you do not add alternative text, no default text will be used

4. Click OK.

If you check Use Custom Bullet and are using a default graphics set for your template, the 
path and name of the graphic will appear immediately in the File Name text box. When 
you return to the Lists tab dialog, the bullet from that Set will display in the Bullet panel as 
well as in the Preview box.

Formatting Bulleted Lists
Lists are a special kind of content consisting of a series of related items that are either 
numbered or bulleted. Lists must be treated a special way in Site Builder to ensure they 
display properly in Web pages.
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Best results are obtained when you use unique elements for list content. You also need to 
assign the <LI> list tag to these elements. The following instructions assume you have 
done both. If not, see the note in Formatting Lists (page 6-121).

1. In the Contents pane, select the template you want to edit and click Formatting on the 
toolbar.

2. Click Lists to open that tab dialog, and select the element you want to format.

3. Under Type, select Bulleted list.

4. Under Bullet, select Don’t specify or Use this bullet. If the latter, click Bullets to 
open that dialog box. (See Choosing Bullets for Lists on page 6-120 for more 
information.)

5. Check Strip input to first blank space or tab if you want to strip out the original 
bullets from the source data.

6. Web browsers don’t always properly display the bullets used in the source document. 
Choose this option to strip out the original bullets and add new ones.

7. Click OK.

By selecting Bulleted List (step 3), Site Builder will apply not only the <LI> tag to each 
list item, but also the <UL> to the list itself. As a result, the list will appear indented in 
your Web page. If you prefer, you can avoid use of the <UL> tag and display your list 
flush left by applying the <LI> tag as a custom tag. See Applying the <LI> Tag as a 
Custom Tag (page 6-119).

Formatting Lists
Lists are a special kind of content consisting of a related series of items that are either 
numbered or bulleted. You may have to apply special formatting instructions to a template 
to ensure that lists display properly in a Web browser.

Among the problems:

! Lists often use tabs to set off the numbers or bullets from the content, but Web 
browsers do not recognize tabs. So if you “pass through” a list in Site Builder, the 
space between the numbers or bullets and the content will be eliminated.

! Solid bullets in a source document may be barely visible when translated.

! The number of the first item of a numbered list may no longer be 1.

! Web browsers often “double up” the numbers or bullets of a list, so you often need to 
have Site Builder strip out the numbers or bullets in the source document.
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! The automatic numbering and bulleting features of word processors can create 
problems, too.

Site Builder does not apply the <LI> list tag to lists in source documents. As a result, any 
list in your source document can be “passed through” during translation. Tabs may be lost 
and bullets may appear smaller, but otherwise the list content will display satisfactorily in 
your Web pages.

For best results in formatting lists, you should assign the list tag <LI> to list content. To do 
this, you must associate a unique style with lists in the source document, which is highly 
recommended. If you haven not done so, you can either create a new style in the source 
document (and re-import styles), or create a character pattern to search for list content. 
You can use patterns even if your document is styled (as long as the pattern is mapped to a 
unique element).

For more information, see: 

! Formatting Numbered Lists (page 6-122)

! Formatting Bulleted Lists (page 6-120)

! Changing the HTML Tag Assigned to an Element (page 6-89)

! Lists (page 6-119)

Formatting Numbered Lists
Lists are a special kind of content consisting of a series of related items that are either 
numbered or bulleted. You may have to apply special formatting instructions to a template 
to ensure that lists display properly in a Web browser.

Best results are obtained when you use unique elements for list content. You also need to 
assign the <LI> list tag to these elements. The following instructions assume you have 
done both. If not, see Formatting Lists (page 6-121).

1. In the Contents pane, select the template you want to edit and click Formatting on the 
toolbar.

2. Click Lists to open that tab dialog, and select the element associated with the list 
content.

3. Under Type, select Numbered list.

4. Under Numbering Type, select Don’t specify or Use this type. If the latter, select the 
type of numbering you want to use from the Numbering Type drop-down list.
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Check Strip input to first blank space or tab to strip out numbers from the source 
data.

Web browsers typically add numbers to numbered lists. Choose this option to avoid 
having the numbers “double up” on your Web pages.

5. Click OK.

Stripping Non-List Items
Site Builder allows you to strip to the first white space after the first character or word of 
each paragraph associated with a particular element.

This option typically is used to strip out the bullets a browser automatically adds to a 
bulleted list so that you can then add your own custom bullets. But you may also want to 
strip out, for example, other content such as a special paragraph numbering system in the 
original source document.

1. In the Contents pane, select the template you want to edit.

2. Click Formatting ( ) on the toolbar.

3. In the Elements list, select the element associated with the content you want to strip in 
this fashion.

4. Click Lists to open that tab dialog.

5. Under Type, select Not a list.

6. Click the Strip input to first blank space or tab check box.

7. Click OK.

When you translate the project, the content associated with this element will have been 
stripped of whatever precedes the first blank space or tab of each paragraph.

Graphics
This section covers the following topics:

! Graphics as Input Files (page 6-124)

! Converting Graphics in Source Documents (page 6-124)
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Graphics as Input Files
You can use graphics as input files in Site Builder. When Site Builder converts a graphics 
file, it generates a separate HTML file with navigation buttons and a link to the graphic 
file (just as it does for a source document).

Site Builder also handles multi-page graphics. The multiple images will be displayed in 
single HTML file with a title based on the source file name. The title will be represented 
as a Heading 1 element, which you can use to split the multiple images into multiple 
HTML files.

Converting Graphics in Source Documents
If your source documents contain graphics, you can control how they are converted during 
translation and display in Web pages.

Any GIFs, JPEG, PNG, BMP, and WBMP graphics that are externally linked can be 
passed through unchanged. But any embedded graphics will be converted according to the 
settings in the Graphics tab dialog. (The default is GIF for an HTML project, and WBMP 
for a WML project.)

1. In the Contents pane, select the template you want to edit, click Formatting on the 
toolbar, and click Graphics to open that tab dialog.

2. From the Elements box, select the element or elements associated with graphics in the 
source document.

3. Under Format, click GIF, JPEG, PNG, BMP or WBMP, depending on which format 
you want to convert your graphics into. (Not all browsers support the PNG format. 
The WBMP option is designed for WML projects.)

4. If you want to make one of the colors in the graphic transparent, click Make this color 
transparent and click the Color button to open the Color dialog box. Select the color 
and then click OK to return to the Graphics tab dialog.

5. Under Alignment, select the appropriate radio button to determine the alignment of 
graphics in Web pages.

Center means the graphic will be centered on a line by itself. Top means the top of the 
graphic will align with the base line of the text. Bottom means the bottom of the 
graphic will align with the base line of the text. And Middle means the middle of the 
graphic will align with the base line of the text.

6. Under Appearance, check Base image sizes on original graphic size if available if 
you want to use the original sizes of the graphics for your Web page. (For example, 
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you may have resized a graphic when you placed it in a Word file. With this option, 
you can revert to the original size of the graphic for displaying in your body pages.)

7. If you want to promote the captions of graphics in your source documents to a 
reference page, click Use caption and then click the Captions button to open that 
dialog box. See Promoting Captions to a Reference Page (page 6-98) for more 
information. You can also create alternative text from a caption (see Creating 
Alternative Text From a Caption on page 5-35).

Use this procedure to embed graphics:

1. Under Appearance, check Embed graphic in output page.

2. In the Alternate Text text box, type what you want to display in the Web page should 
the reader's Web browser fail to display a particular graphic. Alternatively, click Use 
alternative text from source document if available. See Associating Alternative 
Text with a Graphic From Source (page 5-34) for more information.

Your decision to embed graphics in your files or use placeholders will depend on the 
number of graphics, their size, and so on. Also, when you embed graphics, Site 
Builder still creates an output graphics file.

Use this procedure if you link graphics:

1. Check Create a link to the graphic.

2. If you want text to display as a hotspot in your Web page so that when it is clicked the 
graphic opens, select Link using alternative text, and in the text box enter the text 
that you want to display.

3. Alternatively, select Link using a thumbnail, instead, if you want the graphic to 
display as a thumbnail in the Web page. Either select a specific thumbnail size from 
the drop-down list, or select Custom and enter the width and height of the thumbnail 
in pixels in the two boxes. If you click Keep aspect ratio, you need enter only the 
height or the width.

4. Click OK.

When Site Builder translates source files that contain graphics, the converted graphics are 
placed in the output directory specified in the Publication or Document Properties dialog 
box.
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Background
This section covers the following topics:

! Setting a Background Image (page 6-126)

! Setting a Background Color (page 6-126)

Setting a Background Image
Among the options available for formatting paragraphs with CSS turned on is setting a 
background image.

To set a background image

1. In the Contents pane, select the template you want to edit and click Formatting ( ) 
on the toolbar to open that property sheet. Then click Paragraph to open that tab 
dialog.

2. From the Elements list, select the element or elements that you want to set a 
background image for. The image you select will be used as a background for all 
content associated with these elements.

3. Under Advanced, click the Advanced button. A Caution dialog box may open to 
remind you that support for the different features in the Advanced section may vary 
between browsers. Click OK.

4. Under Background Image, on the General tab dialog, select Set background image, 
and then click the Browse button to locate the graphics file that you want to use. 
Alternatively, if you know the path and file name of the image, you can enter it 
directly in the text box.

If you select a graphic from Content Server, you can use the Info button ( ) 
thereafter at any time to open the Content Information page for that file.

5. Click OK, to leave the Advanced dialog box and return to the Paragraph dialog box.

You can set a background color instead of an image. See Setting a Background Color 
(page 6-126).

Setting a Background Color
Among the options available for formatting paragraphs with CSS turned on is the setting 
of a background color.
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1. In the Contents pane, select the template you want to edit and click Formatting ( ) 
on the toolbar to open that property sheet. Then click Paragraph to open that tab 
dialog.

2. From the Elements list, select the element or elements that you want to set a 
background color for. The color you select will be used as a background for all content 
associated with these elements.

3. Under Advanced, click the Advanced button. A Caution dialog box may open to 
remind you that support for the different features in the Advanced section may vary 
between browsers. Click OK.

4. Under Background Color, on the General tab dialog, select Take from source, Don’t 
specify, or Use this color.

Take From Source means that Site Builder uses what is in the source document. Don’t 
Specify means the Web browser used to view the Web page may substitute its own 
default settings. Use This Color lets you specify the color you want to use.

5. If you select Use this color, double-click the Color button to open the Color dialog 
box. Select the color you want to use and click OK. See Using the Color Dialog Box 
(page 6-129) for more information.

6. Click OK, again, to leave the Advanced dialog box and return to the Paragraph dialog 
box.

You can set a background image instead of a color. See Setting a Background Image 
(page 6-126). The color that actually displays in the user’s browser may differ from the 
color you select.

Associating HTML or Scripting Code With an 
Element
You may want to incorporate HTML or scripting code in your Web page. You can 
associate HTML or scripting code with a specific element of a Web page or associate it 
globally with the page itself. (To do so globally, see Including HTML or Scripting Code in 
a Web Page on page 6-180.)

1. In the Contents pane, select the template you want to edit and click Formatting on the 
toolbar.

2. Click HTML to open that tab dialog.

3. From the Elements list, select the element you want to associate the HTML or 
scripting code with.
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4. Click Include HTML or scripting code before content.

5. You can enter HTML code in the text box provided or select a file containing the 
code. Do one of the following:

! Select Use the following and in the text box type the HTML or scripting code you 
want to associate with the element, or

! Select Use the contents of this file and in the text box type the fill path and name 
of the file that contains the code. Alternatively, click Browse or Gallery to locate 
the file containing the HTML or scripting code.

If you pick a graphic from Content Server, you will activate the Info ( ) button 
and thereafter will be able to open the Content Information page for that file at any 
time.

6. To include HTML or scripting code after the element selected, click Include HTML 
or scripting code after content, and repeat step 5.

Text Effects
This section covers the following topics:

! Text Effects (page 6-128)

! Changing Text Effects (page 6-129)

! Using the Color Dialog Box (page 6-129)

Text Effects
Text effects are formatting attributes associated with individual characters within a 
paragraph. Paragraphs often contain words or phrases set in bold or italic, say, that are not 
part of the paragraph style. When you translate a source document, you can retain these 
input effects in your Web pages. You can also turn them off or map them to different 
output effects.

For each effect listed, the following options are available from the drop-down boxes,

! From Source—Select this option if you want to retain a particular effect during 
translation or want Site Builder to re-map the effect.

! Always On—Select if you always want the effect to apply to all content controlled by 
the element.

! Always Off—Select if you want to turn off the effect entirely so that it won’t display 
in the Web page. The effect will apply to the whole element.
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See Changing Text Effects (page 6-129) and Text Effects (page 6-128).

If you select Always On or Always Off, the effect is removed from the current mappings 
box because it is no longer available for a change in mapping.

Changing Text Effects
Text effects are formatting attributes associated with individual characters within a 
paragraph. Paragraphs often contain words or phrases set in bold or italic, say, that are not 
part of the paragraph style. When you translate a source document, you can map 
individual input effects to other output effects.

1. In Formatting, click Character to open that tab dialog.

2. Select the element containing the text effect you want to edit, and click Effects to 
open that dialog box.

3. In the Output Effect column, select the effect you want to change, and do one of the 
following,

! Right-click to display a popup menu and select the new effect you want to map to, 
or

! Click Change to open the Change Text Effects dialog box, and from the drop-
down box select the effect you want to use. Then click OK.

4. Click OK to return to Formatting.

The effects Inserted Text and Deleted Text relate to revisions in your source document. 
They are mapped to Underline and Strikethrough, respectively. For revision text to display 
in your output pages, you must open the Options tab dialog of Globals and select the 
Include revision information from source documents check box. Any colors associated 
with revision text in your source documents will not be preserved in your output pages.

Using the Color Dialog Box
You use the Color dialog box to set colors for text and other elements of your Web page. 
When you open the dialog box, a sample of any default color used displays under Custom 
Colors.

1. Select a color under Basic Colors, or click Define custom color and use your cursor to 
select a color from the color matrix. You can use the color bar to fine-tune the color 
selected. You can also enter RGB values to specify the hue.

The Color | Solid sample box displays each color you choose.
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2. Click Add to custom colors if you want to make the color available in future. Then 
click OK to accept the color and close the dialog box.

When you return to the previous dialog box, the selected color appears in place of the 
color sample originally displayed.

The colors that appear in your Web pages are browser dependent. Thus, the settings shown 
in the Color dialog box may not be exactly those that appear in your Web page.

Visual Aids
This section covers the following topics:

! Setting the Order of Navigation and Visual Aids (page 6-130)

! Inserting Icons (page 6-131)

! Inserting Rules (page 6-132)

! Inserting Separators (page 6-133)

! Formatting the Page TOC (page 6-134)

Setting the Order of Navigation and Visual Aids
As you format a template, you may associate a number of navigation or visual aids with a 
specific element, for example, text bars, button bars, rules, separators, icons, and HTML 
or scripting code. You can control the order in which these aids appear on your Web page.

1. In the Contents pane, select the template you want to edit and click Formatting on the 
toolbar.

2. Click Layout to open that tab dialog.

3. Select the element you want to set this order for.

Sample text and icons appear in the three preview windows. You can see all the 
possible navigation and visual aids, as well as HTML or scripting code, that you might 
associate with an element.

4. Use your mouse to drag and drop individual navigation or visual aids, or “Custom 
HTML,” to set the order in which these should appear before or after content, or on 
the same line as content. You can also change alignment in this way. Or select an item 
and use the Reorder buttons.

5. Click OK.
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Unlike other tab dialogs in Formatting, you can only format a single element at a time 
when you are using the Layout tab dialog.

See the Layout tab dialog in Globals for setting the layout order of navigation and visual 
aids for the Web page as a whole.

Inserting Icons
Icons are graphics you can add to Web pages to set off content. Icons, separators, and rules 
all can be used the same way. So in creating Web pages, you should consider the effect 
you're trying to achieve before deciding which to use. You insert icons in Formatting, 
once you’ve selected the template you want to edit.

1. In Formatting, click Icons to open that tab dialog.

2. From the Elements list, select the element you want to modify.

3. To insert an icon before the selected element, check Insert icon before content.

4. Do one of the following:

! In the File Name text box, enter the file name of the icon graphic, or

! Click Browse to locate the graphic, or

! Click Gallery to open the Gallery and select an icon from the graphics available 
in Site Builder. Select one and click OK.

If you pick a graphic from Content Server, you will activate the Info ( ) button 
and thereafter will be able to open the Content Information page for that file at any 
time.

5. Under Alignment, select Flush left or With content, depending on how the icon 
should appear in the Web page.

6. To insert an icon after the element, check Insert icon after element and repeat steps 4 
and 5.

7. In the Alternative Text box, enter information that you would like to display as a 
screen tip on the Web page in the event that the separator doesn’t display. The 
alternative text will display when (a) a user's browser is text only, (b) a user chooses to 
disable the browser's graphics functionality, or (c) a visually impaired user is viewing 
Web pages with an HTML screen reader. If you do not add alternative text, no default 
text will be used.

8. If the element you are formatting is also used in tables and you do not want icons to 
display in those tables, check Omit icons when element is within a table.
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9. Click another tab to format another aspect of the document. Or click OK to return to 
the Edit Template dialog box or to the main window.

Inserting Rules
You can add rules to Web pages to set off content. Rules, separators, and icons all can be 
used the same way. So in creating Web pages, you should consider the effect you're trying 
to achieve before deciding which to use. You insert rules in Formatting, once you have 
selected the template you want to edit.

1. In Formatting, click Rules to open that tab dialog.

2. From the Elements list, select the element you want to modify.

3. To insert a rule before the selected element, check Insert rule before content.

If you have picked a graphics set as the default, the path and name of the rule from that 
Set will appear automatically in the File Name text box, and the rule will appear in the 
Preview box below. (See Selecting a Graphics Set for a Web Page on page 6-198.) In 
which case, go to step 8. If you haven't, and the default settings are fine, go to step 7.

4. In the Set Width edit box, enter the percentage (of the Web browser window) for the 
width of the rule, or use the up/down control to set the percentage. If you selected 
Pixels under Width Is, the value you enter will be in pixels.

5. In the Set Height edit box, enter the height of the rule in pixels, or use the up/down 
controls to set the pixel height.

6. Check 3D Shading if you want to apply a 3D effect to the rule rather than color it. To 
color the rule, under Color, click Set color and click the Color button to open the 
Color dialog box. Select a color and click OK (see Using the Color Dialog Box on 
page 6-129).

7. Under Alignment, select Left, Center, or Right, depending on how the rule should 
appear in the Web page.

8. To insert a rule after the element, check Insert rule after content and repeat steps 4 to 
7.

9. If the element you are formatting is also used in tables and you do not want rules to 
display in those tables, check Omit rules when element is within a table. Then click 
OK.

You can also set rules for an entire Web page. See Adding Rules to a Web Page 
(page 6-174).
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Inserting Separators
Separators are graphics you add to Web pages to set off content. Separators, rules, and 
icons all can be used the same way. So in creating Web pages, you should consider the 
effect you are trying to achieve before deciding which to use. You insert separators in 
Formatting, once you have selected the template you want to edit.

1. In Formatting, click Separators to open that tab dialog.

2. From the Elements list, select the element you want to modify.

3. To insert a separator before the selected element, check Insert separator before 
element.

4. Do one of the following,

! In the File Name text box, enter the file name of the separator graphic, or

! Click Browse to locate the graphic, or

! Click Gallery to open the Gallery and select a separator from the Separators 
group of graphics.

If you have picked a graphics set as the default, the path and name of the separator 
from that Set will appear automatically in the File Name text box, and the separator 
will appear in the Preview box below. (See Selecting a Graphics Set for a Web Page 
(page 6-198).)

If you pick a graphic from Content Server, you will activate the Info ( ) button 
and thereafter will be able to open the Content Information page for that file at any 
time.

5. Under Alignment, select Left, Center, or Right, depending on how the separator 
should appear in the Web page.

6. To insert a separator after the element, check Insert separator after element and 
repeat steps 4 and 5.

7. In the Alternative Text box, enter information that you would like to display onscreen 
in the event that the separator doesn’t display.

8. If the element you're formatting is also used in tables and you don’t want separators to 
display in those tables, check Omit separators when element is within a table.

9. Click another tab to format other aspects of the document. Or click OK to save the 
changes to the template and return to the Edit Template dialog box or the main 
window.
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You can also set separators for an entire Web page. See Adding Separators to a Web Page 
(page 6-175).

The alternative text will display when (a) a user's browser is text only, (b) a user chooses 
to disable the browser's graphics functionality, or (c) a visually impaired user is viewing 
Web pages with an HTML screen reader.

Formatting the Page TOC
Each Web page can have its own table of contents, which is part of the body page. The 
elements used in the page TOC will be formatted the same way as for the body page, 
unless you specify differently.

1. In the Contents pane, select the template you want to edit and click Formatting on the 
toolbar to open that property sheet.

2. Click Page TOC to open that tab dialog.

3. From the Elements list, select the element or elements you want to format.

4. There are five formatting option buttons on this tab dialog. Click any button to open a 
property sheet with tabs available for all five options. The settings available in each of 
these tab dialogs are the same as can be found in other tab dialogs in Formatting: 
Character, Paragraph, Icons, Lists, and HTML.

5. For example, if you want to format the text itself, click Character to open that tab 
dialog to format character settings (see Formatting Characters Without CSS on 
page 6-110 for more information).

6. Once you are done formatting characters, use the other four tab dialogs, as 
appropriate, to complete the formatting of your page TOC. See Related topics for 
other topics on formatting the page TOC.

See the Page TOC tab dialog in Globals for option of applying global settings for HTML 
or scripting code, separators, and rules.

NAVIGATION TOPICS
This section covers the following topics:

! Navigation (page 6-135)

! Printing From the Web (page 6-136)

! Hyperlinks (page 6-143)
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! Link to Source Button (page 6-145)

! Navigation Bars (page 6-150)

! Graphics (page 6-163)

Navigation
Navigation is one of four property sheets used to edit templates. Once you set up a 
project, you use the property sheets to complete settings for each template in the project. 
These settings determine the look and behavior of Web pages created from source 
documents associated with the templates.

In Navigation, you create links to help users move within and between the pages of your 
publication. Among the options are the ability to:

! Create a page button bar (page G-20) or a page text bar (page G-21)

! Create an element button bar (page G-7) or an element text bar (page G-7)

Whichever type of navigation bar you create, a range of buttons is available for the links. 
The Gallery offers 28 graphics sets, each consisting of a uniquely designed set of buttons 
suitable for all navigation purposes. In addition to the usual links for previous page, next 
page, etc., Site Builder provides several special-purpose links:

! Specific Page—Links to any URL anywhere (see Navigating to Another Web Site on 
page 6-144).

! Top of Project—Takes the user from anywhere in your Web publication to the 
highest-level Web page in the project (see Navigating to the Top Page of a Web 
Publication on page 6-145).

! Link to Source—Lets the user open the source document used to create the Web page 
on which the button resides (see Opening the Source Document of a Web Page on 
page 6-148).

! Print—Lets the user print all or select portions of your Web publication, when using 
the Internet Explorer browser (see Adding a Print Button to Your Web Publication on 
page 6-138).

Each of these special-purpose links can be added to the navigation button bars you create.

After you select a template for editing, you can open Navigation and the other property 
sheets from the Template toolbar. Or you can open the Edit Template dialog box and 
move between the four property sheets from there. You can use the property sheets in any 
order.
Content Publisher User Guide 6-135



Templates
If you plan to use a default graphics set, you should pick one before you enter the 
Navigation property sheet. See Selecting a Graphics Set for a Web Page (page 6-198).

Printing From the Web
This section covers the following topics:

! About the Print Button (page 6-136)

! Adding a Print Button to Web Pages (page 6-137)

! Adding a Print Button to Your Web Publication (page 6-138)

! Associating a Print Button With an Element (page 6-138)

! Enabling the Print Functionality (page 6-139)

! Printing a Web Publication (page 6-140)

! PrintPublication.htm (page 6-141)

! Printing the Publication (page 6-141)

! Map File (page 6-142)

About the Print Button
You can add a Print button to your Web publication to print all or selected portions of the 
publication if you are using Internet Explorer. The button is not strictly a navigation 
button, but you use settings in Navigation to place it in your Web publication.

Keep these points in mind when working with Print buttons:

! To place a Print button in your Web publication, use options in the Page Button Bar 
and Element Button Bar of Navigation. See Adding a Print Button to Your Web 
Publication (page 6-138).

! Since Navigation is template-based, you will need to edit each template in your 
project if you plan to place the Print button on every Web page.

! You may need to place the Print button only in the most obvious places of your Web 
publication – say, at the top of each TOC. The important thing is that it is accessible to 
your users at all times. The button functions the same way no matter where it is 
placed.

! The Print functionality is different for Internet Explorer than Netscape Navigator. In 
Internet Explorer, the button allows you to print all or select portions of your Web 
publication. In Netscape Navigator, you can print only the Web page on which the 
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button resides. (Thus, the button functions similar to the Print button on the browser 
toolbar.)

To enable the print functionality, you need to (a) add a Print button to the publication, (b) 
generate an XML Map file, and (c) include a script that will download a print control. 
Since Site Builder does the last two by default, all you need to do is add a Print button to 
your publication.

! See Adding a Print Button to Your Web Publication (page 6-138) for more on how to 
add the button to a page or element button bar.

! Site Builder automatically generates an XML Map file for each project. This file lists 
the hierarchy and output pages of your publication. The print control (which the Print 
button activates) uses this file to identify the output files available for printing. See 
Map File (page 6-142) for more information.

! Site Builder automatically references a file that contains a script that is run the first 
time the user clicks any Print button in a Web publication. See PrintPublication.htm 
(page 6-141).

If the print functionality is not enabled for a particular project, a warning message will 
appear as soon as you try to add a Print button to a project. This could happen, for 
example, if you import a version 3.x project or publication file. See Enabling the Print 
Functionality (page 6-139).

Adding a Print Button to Web Pages
The Print button is one of several navigation buttons available for Web pages. Like the 
other navigation buttons, it can be added to a button bar at the top or bottom of a Web page 
as part of a Page Button Bar.

The Print button functions differently from the other navigation buttons. Moreover, it 
functions differently for Internet Explorer than Netscape Navigator. See About the Print 
Button (page 6-136) and Enabling the Print Functionality (page 6-139).

1. In the Contents pane, select the template you want to edit and click Navigation ( ).

2. Click Page Button Bar to open that tab dialog.

3. Double-click in the Before and/or After column opposite Print in the Link Type list 
(you may have to scroll down to see Print).

4. If you already have a graphics set associated with the template, the Print button from 
that Set will appear in the Preview boxes at the bottom, and the path and file name will 
appear opposite Print in the Link Icon column. If you don't, click the Gallery button 
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and choose a Print button from one of the graphics sets. You can click Groups under 
Mode and then select Print to review all the Print buttons available.

You can also click Browse to locate the file. This may be appropriate if you are 
substituting one of your own graphics for the buttons in the Gallery.

5. Select an alignment option for the button. You can use drag-and-drop to move the 
button in relation to any other buttons on the page button bar.

6. Click OK.

By default, Site Builder uses “Print” as the alternative text for the Print button. You can 
change this in Link Properties (page 6-143).

If you want the Print button to be accessible to your users at all times, you may want to 
place it on every TOC in your Web publication.

Adding a Print Button to Your Web Publication
The Print button is one of several navigation buttons available for Web pages. Like the 
other navigation buttons, you have the option of:

! Adding a Print button to Web pages as part of a page button bar (see Adding a Print 
Button to Web Pages on page 6-137), or

! Associating a Print button with an element as part of an element button bar (see 
Associating a Print Button With an Element on page 6-138)

The Print button functions differently from the other navigation buttons. Moreover, it 
functions differently for Internet Explorer than Netscape Navigator. See About the Print 
Button (page 6-136) and Enabling the Print Functionality (page 6-139).

Associating a Print Button With an Element
The Print button is one of several navigation buttons available for Web pages. Like the 
other navigation buttons, it can be associated with a specific element on the Web page as 
part of an Element Button Bar.

The Print button functions differently from the other navigation buttons, Moreover, it 
functions differently for Internet Explorer than Netscape Navigator. See About the Print 
Button (page 6-136) and Enabling the Print Functionality (page 6-139).

1. In the Contents pane, select the template you want to edit and click Navigation ( ).

2. Click Element Button Bar to open that tab dialog.
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3. Select the element you want to associate the button with, and then double-click in the 
Before and/or After column opposite Print in the Link Type list (you may have to 
scroll down to see Print).

4. If you already have a graphics set associated with the template, the Print button from 
that Set will appear in the Preview box at the bottom, and the path and file name will 
appear opposite Print in the Link Icon column. If you don't, click the Gallery button 
and choose a Print button from one of the graphics sets. You can click Groups under 
Mode and then select Print to review all the Print buttons available.

You can also click Browse to locate the file. This may be appropriate if you are 
substituting one of your own graphics for the buttons in the Gallery.

5. Select an alignment option for the button. You can use drag-and-drop to move the 
button in relation to any other buttons on the page button bar.

6. Click OK.

By default, Site Builder uses “Print” as the alternative text for the Print button. You can 
change this in Link Properties (page 6-143).

If you want the Print button to be accessible to your users at all times, you may want to 
place it on every TOC in your Web publication.

Enabling the Print Functionality
The Print button is one of several navigation buttons available for creating Web pages. 
To use the button, you must enable the print functionality, which entails:

! Adding a Print Button to Your Web Publication (page 6-138)

! Generating a Map File (page 6-142).

! Running a script to download a print control from the Web site (see About the Print 
Button on page 6-136 and PrintPublication.htm on page 6-141)

Generally, adding the Print button is the only formal step you need to take. Generating a 
Map file and including the script are handled by default. You should find the following 
options set in the Map File/Print Publication tab dialog of the Project Options dialog box:

! Under Map file, the Create XML Map file check box is selected. (For the purposes of 
enabling the print functionality, it doesn’t matter whether the Map file contains source 
file details or not.)

! The File Name text box should display the path for the script file required to enable 
the print functionality. If you accepted the default installation, it should read:
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C:\Program Files\Stellent Content Publisher\gallery\en\HTMLCode\ 
PrintPublication.htm

If necessary, click Gallery to open the HTML Code subdirectory, and select the file.

It you are using the Internet Explorer browser, you can select which portions of your Web 
publication you want to print. In Netscape Navigator, the Print button prints only the Web 
page on which it resides (and therefore works like the Print button on the browser toolbar).

If for any reason the print functionality is not enabled, a warning will appear as soon as 
you try to add a Print button to the project. You can then set the above options in the 
Project Options dialog box.

Printing a Web Publication
One of the navigation options is to add a Print button to your Web publication. The Print 
button works the same way, no matter where it is placed in your Web publication. See 
Adding a Print Button to Your Web Publication (page 6-138).

If you are using the Internet Explorer browser, you can select which portions of your Web 
publication you want to print. With Netscape Navigator, the Print button prints only the 
Web page on which it resides (and therefore works like the Print button on the browser 
toolbar).

1. Click the Print button in your Web publication. The Select Files to Print dialog box 
opens.

2. Select the appropriate boxes to specify what you want to print.

You can print any combination of pages you want. By default, whatever box you 
select, all pages below that level will be printed, too. But you can then clear any boxes 
below that level for those documents you don’t want to print. You can thus print any 
combination of Web pages you want.

3. Click OK. The Windows Print dialog box opens.

4. Click OK again.

The first time a user clicks the Print button, there will be a short delay until the print 
functionality is enabled. Thereafter, the user will be able to select and print Web pages 
immediately. See Enabling the Print Functionality (page 6-139).
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PrintPublication.htm
PrintPublication.htm plays an important role in enabling the print functionality when you 
add a Print button to your Web publication.

! The file is shipped with Site Builder and installed in the \\Gallery\en\HTMLCode 
directory.

! It contains JavaScript that is placed in the head of every Web page on which you 
choose to place a Print button. Since the file is referenced by default in the Project 
Options dialog box, Site Builder does this automatically when it translates a project.

! The first time a user clicks a Print button anywhere in a Web publication, Site Builder 
runs a script that causes the user’s browser to download the file PrintCtl.cab from the 
Web site. (In the process, the browser displays a message asking the user to confirm 
the download). The browser then examines this file and extracts, and registers, the file 
PrintCtl.ocx. It is this file that enables the print functionality.

! In creating a Web publication that contains the Print button, you may want to alert 
users that the first time they click the Print button there will be a short delay before the 
PrintCtl.cab file is downloaded and the PrintCtl.ocx file is extracted and registered - 
that is, before the Select Files to Print dialog box actually opens (see Printing a Web 
Publication on page 6-140).

! This delay will only occur the first time the Print button is used on the first Content 
Publisher publication run on a user’s machine. Once PrintCtl.ocx is downloaded and 
registered, the Select Files to Print dialog box will open immediately each time the 
Print button is clicked.

! You can view the contents of this file by opening it in any text editor.

To enable print functionality, you also need a Map File (page 6-142), which Site Builder 
generates automatically each time you translate.

Printing the Publication
You can add a Print Publication button to your publication, just as you do navigation 
buttons in Navigation. Unlike navigation buttons, however, the print button won’t 
function unless you also identify a script to be used with the button.

1. Click Project Options on the View menu to open that dialog box.

2. Click Map File / Print Publication to open that tab dialog.
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3. Under Print Publication, in the File Name text box, enter the path and name of the 
script you want to use to enable the print publication functionality. Alternatively, click 
Browse or Gallery to locate the script file.

If you installed Site Builder to the default directory, the default setting is:

C:\Program Files\Stellent Content Publisher\Gallery\en\HTMLCode\ 
PrintPublication.htm

4. Click OK.

These settings are project-specific and are therefore saved to the project file. The settings 
will apply whether you run the project locally, move it to a network location, or schedule it 
for translation by Site Server.

If in step 3 you select a file from Content Server, you will activate the Info ( ) button 
and thereafter will be able to open the Content Information page for that file.

Map File
A Map file is an XML file that Site Builder generates to describe the output of your project 
on your Web site. The file plays a key role in enabling the print functionality.

1. Choose Project Options from the View menu to open that dialog box.

2. Click Map File / Print Publication to open that tab dialog.

3. Under Map File, select the Create XML map file check box.

4. In the File Name text box, enter the name you want to use for the map file (the default 
is MapFile). Site Builder will apply the .xml extension to the file name when it 
translates your project and creates the file.

5. Select Map file contains source file details only if you want the file to reveal the 
input document names corresponding to your source documents.

6. Click OK.

Site Builder places the Map file in the root output directory. If you are moving your output 
files, you must be sure to move the Map file, too.

When a user clicks a Print button on a Web page, the print control (PrintCtl.ocx) examines 
the Map file to identify all the output pages that are available for printing. See Printing a 
Web Publication (page 6-140).

The Map file contains information on output files only for the project it was created for. 
So the Print functionality created for a publication won’t apply to content you may import 
from another publication (for example, if you placed a non-Content Publisher publication 
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in the frame of a Content Publisher publication). Likewise, if a Content Publisher 
publication were to become part of a non-Content Publisher publication, the Map file 
would have to reside at the root level of the Content Publisher output files and could be 
used to enable print functionality only for those files.

The Map file settings are project-specific and are therefore saved to the project file. They 
will apply whether you run the project locally, move it to a network location, or schedule it 
for translation by Site Server.

Hyperlinks
This section covers the following topics:

! Link Properties (page 6-143)

! Navigating to Another Web Site (page 6-144)

! Navigating to the Top Page of a Web Publication (page 6-145)

Link Properties
Link properties are the properties of a navigation link you select when creating a page or 
element button bar. They comprise:

! Link Type—The type of link you are adding to the page or element button bar. In 
addition to the usual links for Previous Page, Next Page, etc., Site Builder offers 
special links for Top of Project, Link to Source, Print, and Specific Page. You must 
choose a Link Type before entering the Link Properties dialog box.

! Link icon—The button, representing the link, that will display on your Web page. 
If you have already selected a button for a particular link, it will display in the Link 
Properties dialog box.

! Include a link of this type—Places the link in your Web publication. The Before 
content option places the link at the top of the Web page for a page button bar and 
before the selected element for an element button bar. The After content option 
places it at the bottom of the Web page or after the element.

! File name—The path and file name for the graphic representing the link. If you have 
associated a graphics set with your template, the appropriate button will be selected 
automatically. If a button isn’t automatically selected, click the Gallery button to open 
the Gallery and choose a button. To use one of your own graphics, click the Browse 
button and locate the graphic in a repository.
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If you select a graphic from Content Server, you can open the Content Information page 
for that graphic at any time by clicking the Info button ( ).

! Alternative text—The text that displays as a screen tip when you pass your cursor 
over the navigation button on a Web page. Also the text that displays instead of the 
graphic if the user chooses to view only text in the browser.

! Source page URL—Applicable only when creating a Link to Source navigation 
button. You can use different URLs (the default is %%TRANSIT-
INPUTPATH%%), depending on the location of the source document you are 
linking to. See Opening the Source Document of a Web Page (page 6-148) for more 
information.

! Specific page URL—Applicable only when creating a link to a specific page on 
another Web site. The complete URL for the page you are targeting is entered here. 
Site Builder provides three links for this purpose. See Navigating to Another Web Site 
(page 6-144) for more information.

There are 28 graphics sets available from the Gallery in Site Builder. Each one includes a 
unique set of buttons for creating navigation links.

The button used for a Specific Page link varies from graphics set to graphics set. In some 
instances the Home button is used. Since this button is also used for a Link to Source link, 
you may want to consider the best selection of buttons if you happen to be using both 
types of links in the same navigation bar.

Navigating to Another Web Site
Among the navigation options in Site Builder are several special-purpose links that can be 
added to a page or element button bar. Included is the Specific Page link, which lets you 
link to any URL anywhere.

See the following for more information:

! Adding a Specific Page Link to a Page Button Bar (page 6-151)

! Adding a Specific Page Link to an Element Button Bar (page 6-152)

! Hyperlinks (page 6-143)
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Navigating to the Top Page of a Web Publication
Among the navigation options in Site Builder are several special-purpose links that can be 
added to a page or element button bar. Included is the Top of Project link, which lets the 
user return to the top page of the highest-level publication in your project from anywhere 
in the project.

! Adding a Top of Project Link to a Page Button Bar (page 6-153)

! Adding a Top of Project Link to an Element Button Bar (page 6-154)

! Hyperlinks (page 6-143)

Link to Source Button
This section covers the following topics:

! Adding a Link to Source Link to a Page Button Bar (page 6-145)

! Adding a Link to Source Link to an Element Button Bar (page 6-147)

! Opening the Source Document of a Web Page (page 6-148)

! Optional URLs for Linking to a Source Document (page 6-148)

Adding a Link to Source Link to a Page Button Bar
Among the navigation options in Site Builder are several special-purpose links that can be 
added to a page or element button bar. Included is the Link to Source link, which lets users 
open the source document used to create the Web page on which the link resides.

For a user to be able to open a source document in its native format from a Web page, the 
application used to create the source document must be available on the user’s machine.

To add a Link to Source link to a page button bar

1. In the Contents pane, select the template you want to edit and click Navigation ( ) 
on the toolbar.

2. Click Page Button Bar to open that tab dialog.

3. Under Link Type, select Link to Source, and then click Properties to open the Link 
Properties dialog box.

4. Select the Include a link of this type check box, and then select the Before and/or 
After check box.
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5. In File Name text box, enter the path and name of the graphic to be used for the 
button. Or click Browse or Gallery to locate the graphic, if necessary. If you have 
picked a default graphics set for the template, a button from that Set appears in the 
appropriate Preview window as soon as you specify a link and leave the Link 
Properties dialog box. Otherwise, open the Gallery in the groups mode and select a 
button from the Link to Source group of graphics available. Or click Browse to locate 
the file you want to use.

6. In the Alternative Text text box, type the alternative text you want to appear in your 
Web page (the default text is “Source Document”).

7. Under Source page URL enter the required URL to identify the location of your 
source document. The default is:

%%TRANSIT-INPUTPATH%%

This “token” will work for all intranet environments where the source file is in a 
shared location. See Optional URLs for Linking to a Source Document (page 6-148) 
for more information on alternative URLs.

8. Click OK to return to the Page Button Bar tab dialog. The path and file name for the 
navigation button now displays in the Link Icon column.

9. Under Align top and/or Align bottom, select Left, Center, or Right to position the 
graphic on the page. If several graphics are displayed in the preview boxes, you can 
use drag and drop to change their order. Then click OK to return to the main window.

Note: 

To select or clear a button, you can also double-click in the Before or After column (in the 
Page Button Bar tab dialog) to change the red cross to a green check mark. Alternatively, 
you can right-click and choose the green check mark from the popup menu, or press 
Ctrl+B (Before column) or Ctrl+A (After column).

If you select a file from Content Server, the Info button ( ) becomes active, and you 
can check the Content Information page for that file at any time.

The button used for a Specific Page link varies from graphics set to graphics set. In some 
instances the Home button is used. Since this button is also used for a Link to Source link, 
you may want to consider the best selection of buttons if you happen to be using both 
types of links in the same navigation bar.
6-146 Content Publisher User Guide



Templates
Adding a Link to Source Link to an Element Button Bar
Among the navigation options in Site Builder are several special-purpose links that can be 
added to a page or element button bar. Included is the Link to Source link, which lets users 
open the source document used to create the Web page on which the link resides.

For a user to be able to open a source document in its native format from a Web page, the 
application used to create the source document must be available on the user’s machine.

1. In the Contents pane, select the template you want to edit and click Navigation ( ) 
on the toolbar.

2. Click Element Button Bar to open that tab dialog.

3. From the Elements list, select the element you want to associate the button bar with. 
Under Link Type, select Link to Source, and then click Properties to open the Link 
Properties dialog box.

4. Select the Include a link of this type check box, and then select the Before and/or 
After check box.

5. In File Name text box, enter the path and name of the graphic to be used for the 
button. Or click Browse or Gallery to locate the graphic, if necessary. If you have 
picked a default graphics set for the template, a button from that Set appears in the 
appropriate Preview window as soon as you specify a link and leave the Link 
Properties dialog box. Otherwise, open the Gallery in the groups mode and select a 
button from the Specific Page group of graphics available. Or click Browse to locate 
the file you want to use.

6. In the Alternative Text text box, type the alternative text you want to appear in your 
Web page (the default text is “Source Document”).

7. Under Source page URL enter the required URL to identify the location of your 
source document. The default is:

%%TRANSIT-INPUTPATH%%

This URL will work for all intranet environments where the source file is in a shared 
location. See Optional URLs for Linking to a Source Document (page 6-148) for more 
information on alternative URLs.

8. Click OK to return to the Element Button Bar tab dialog. The path and file name for 
the navigation button now displays in the Link Icon column.

9. Under Alignment, select the appropriate radio button, depending on how you want 
the new link to be positioned on the page. Then click OK to return to the main 
window. 
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The button used for a Specific Page link varies from graphics set to graphics set. In 
some instances the Home button is used. Since this button is also used for a Link to 
Source link, you may want to consider the best selection of buttons if you happen to be 
using both types of links in the same navigation bar.

To select or clear a button, you can also double-click in the Before or After column (in the 
Element Button Bar tab dialog) to change the red cross to a green check mark. 
Alternatively, you can right-click and choose the green check mark from the popup menu, 
or press Ctrl+B (Before column) or Ctrl+A (After column).

If you select a file from Content Server, the Info button ( ) becomes active, and you 
can check the Content Information page for that file at any time.

When a button is associated with an element and set to align away from content, Site 
Builder uses an HTML table to achieve this effect. If your audience uses browsers that do 
not support tables, you should avoid using icons, bullets, or navigation buttons that are 
formatted to appear away from content.

Opening the Source Document of a Web Page
Among the navigation options in Site Builder are several special-purpose links that can be 
added to a page or element button bar. Included is the Link to Source link, which lets the 
user open the source document used to create the Web page on which the link resides.

See:

! Adding a Link to Source Link to a Page Button Bar (page 6-145)

! Adding a Link to Source Link to an Element Button Bar (page 6-147)

! Link to Source Button (page 6-145)

Optional URLs for Linking to a Source Document
Among the navigation options in Site Builder are several special-purpose links that can be 
added to a page or element button bar. Included is the Link to Source link, which lets users 
open the source document used to create the Web page on which the link resides.

This link is set in the Link Properties dialog box in Navigation. (In the Page Button Bar or 
Element Button Bar tab dialog, select Link to Source under Link Type and click Properties 
to open the dialog box.) You can use different URLs for this link. Each URL uses one of 
two tokens to help identify the location of the source document.

! %%TRANSIT-INPUTPATH%% — Token is replaced by the path and file name 
of the source document.
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! %%TRANSIT-INPUTFILENAME%% — Token is replaced by the file name of 
the source document.

Sample URLs
! %%TRANSIT-INPUTFILENAME%% — Suitable for an Internet environment 

where the source document has been associated with a publication in the project and 
placed in the output Pages directory.

! file://\%%TRANSIT-INPUTPATH%% — The default setting. Suitable for an 
intranet environment where the source document is in a shared location that all 
browsers can see.

! file://\\\NORTHEND\source%%TRANSIT-INPUTFILENAME%% — Suitable 
for an intranet environment where it is desirable to convert the path to a UNC.

! http://www.yourname.com\source\%%TRANSIT-INPUTFILENAME%% — 
Suitable for an Internet environment where the source directory has been mapped to 
the Web server.

Repository-Based Tokens
Where the source document is in the repository of Content Server, three additional tokens 
are available:

! %%TRANSIT-INPUTDOCID%% — Token is replaced by the Content ID of the 
source document (internally known as dDocName)

! %%TRANSIT-INPUTLIBID%% — Token is replaced by the database name (the 
full CGI URL of the content server).

! %%TRANSIT-INPUTVERSION%% — Token is replaced by the unique version 
number of the source document (internally known as dID).

Example
If you are using Microsoft Internet Information Server (IIS) to host Content Server, the 
required string will be

http://<webserver>/intradoc-
cgi/idc_cgi_isapi.dll?IdcService=GET_FILE&dID=%%TRANSIT-
INPUTVERSION%%

If you are using Netscape Enterprise Server to host Content Server, the required string will 
be
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http://<webserver>/intradoc-cgi/nph-
idc_cgi.exe?IdcService=GET_FILE&dID=%%TRANSIT-INPUTVERSION%%

In each case, replace <webserver> with the name of the Web server hosting your content 
server.

If you plan to use the same template for two source documents drawn from two different 
content servers, a better alternative to the above would be:

%%TRANSIT-INPUTLIBID%%?IdcService=GET_FILE&dID=%%TRANSIT-
INPUTVERSION%%

For a user to be able to open a source document in its native format from a Web page, the 
application used to create the source document must be available on the user’s machine.

A Link to Source can only be added to a body template. It cannot be placed on a reference 
page.

Navigation Bars
This section covers the following topics:

! Adding a Specific Page Link to a Page Button Bar (page 6-151)

! Adding a Specific Page Link to an Element Button Bar (page 6-152)

! Adding a Top of Project Link to a Page Button Bar (page 6-153)

! Adding a Top of Project Link to an Element Button Bar (page 6-154)

! Formatting a Text Bar with CSS (page 6-155)

! Navigating With a Page Button Bar (page 6-156)

! Navigating With a Page Text Bar (page 6-157)

! Navigating With an Element Button Bar (page 6-158)

! Navigating With an Element Text Bar (page 6-159)

! Using a Content Server URL to Create a Hyperlink (page 6-160)

! Using a Document Title to Create a Hyperlink (page 6-161)

! Using a Content ID to Create a Hyperlink (page 6-162)

! Retaining Original Bookmark Names (page 6-163)
6-150 Content Publisher User Guide



Templates
Adding a Specific Page Link to a Page Button Bar
When you create a page button bar to help users navigate your Web publication, you can 
include a special link to any URL anywhere. Site Builder lets you create three such links.

1. In the Contents pane, select the template you want to edit and click Navigation ( ) 
on the toolbar. Then click Page Button Bar to open that tab dialog.

2. Under Link Type, select one of the Specific Page entries, and then click Properties 
to open the Link Properties dialog box.

3. Select the Include a link of this type check box, and then select the Before and/or 
After check box. To select or clear a link, you can also double-click in the Before or 
After column (in the Page Button Bar tab dialog) to change the red cross to a green 
check mark. Alternatively, you can right-click and choose the green check mark from 
the popup menu, or press Ctrl+B (Before column) or Ctrl+A (After column).

4. In File Name text box, enter the path and name of the graphic to be used for the 
button. Or click Browse or Gallery to locate the graphic, if necessary. If you have 
picked a default graphics set for the template, a button from that Set appears in the 
appropriate Preview window as soon as you specify a link and leave the Link 
Properties dialog box. Otherwise, open the Gallery (in the Groups mode) and select a 
button from the Specific Page group. Or click Browse to locate the file you want to 
use.

5. In the Alternative Text text box, type the alternative text you want to appear in your 
Web page.

This text will display as a screentip when you pass your cursor over the navigation 
button on a Web page. It will also display instead of the graphic if the user chooses to 
view only text in the browser

6. In the Specific Page URL text box, enter the full URL for the specific page on the 
Web site you want to link to.

7. Click OK to return to the Page Button Bar tab dialog. The path and file name for the 
navigation button now display in the Link Icon column.

8. Under Align top and/or Align bottom, select Left, Center, or Right to position the 
graphic on the page. If several graphics are displayed in the preview boxes, you can 
use drag and drop to change their order.

9. Click OK to return to the main window.

The button used for a Specific Page link varies from graphics set to graphics set. In some 
instances the Home button is used. Since this button is also used for a Link to Source link, 
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you may want to consider the best selection of buttons if you happen to be using both 
types of links in the same navigation bar.

Adding a Specific Page Link to an Element Button Bar
When you create an element button bar to help users navigate your Web publication, you 
can include a special link to any URL anywhere. Site Builder lets you create three such 
links.

1. In the Contents pane, select the template you want to edit and click Navigation ( ) 
on the toolbar. Then click Element Button Bar to open that tab dialog.

2. From the Elements list, select the element you want to associate the button bar with. 
Under Link Type, select one of the Specific Page entries, and click Properties to 
open the Link Properties dialog box.

3. Select the Include a link of this type check box, and then select the Before and/or 
After check box. To select or clear a button, you can also double-click in the Before 
or After column (in the Element Button Bar tab dialog) to change the red cross to a 
green check mark. Alternatively, you can right-click and choose the green check mark 
from the popup menu, or press Ctrl+B (Before column) or Ctrl+A (After column).

4. In File Name text box, enter the path and name of the graphic to be used for the 
button. Or click Browse or Gallery to locate the graphic, if necessary. If you have 
picked a default graphics set for the template, a button from that Set appears in the 
appropriate Preview window as soon as you specify a link and leave the Link 
Properties dialog box. Otherwise, open the Gallery (in the groups mode) and select a 
button from the Specific Page group. Or click Browse to locate the file you want to 
use.

5. In the Alternative Text text box, type the alternative text you want to appear in your 
Web page.

This text will display as a screentip when you pass your cursor over the navigation 
button on a Web page. It will also display instead of the graphic if the user chooses to 
view only text in the browser

6. In the Specific Page URL text box, enter the full URL for the specific page on the 
Web site you want to link to.

7. Click OK to return to the Element Button Bar tab dialog. The path and file name for 
the navigation button now display in the Link Icon column.

8. Under Alignment, select the appropriate radio button, depending on how you want 
the new link to be positioned on the page. When a button is associated with an element 
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and set to align away from content, Site Builder uses an HTML table to achieve this 
effect. If your audience uses browsers that do not support tables, you should avoid 
using icons, bullets, or navigation buttons that are formatted to appear away from 
content.

9. Click OK to return to the main window.

The button used for a Specific Page link varies from graphics set to graphics set. In some 
instances the Home button is used. Since this button is also used for a Link to Source link, 
you may want to consider the best selection of buttons if you happen to be using both 
types of links in the same navigation bar.

Adding a Top of Project Link to a Page Button Bar
Among the navigation options in Site Builder are several special-purpose links that can be 
added to a page or element button bar. Included is the Top of Project link, which lets the 
user return to the top page of your Web publication from anywhere in the publication.

1. In the Contents pane, select the template you want to edit and click Navigation ( ) 
on the toolbar.

2. Click Page Button Bar to open that tab dialog.

3. Under Link Type, select Top of Project, and then click Properties to open the Link 
Properties dialog box.

4. Select the Include a link of this type check box, and then select the Before and/or 
After check box.

5. In File Name text box, enter the path and name of the graphic to be used for the 
button. Or click Browse or Gallery to locate the graphic, if necessary. If you have 
picked a default graphics set for the template, a button from that Set appears in the 
appropriate Preview window as soon as you specify a link and leave the Link 
Properties dialog box. Otherwise, open the Gallery (in the groups mode) and select a 
button from the Top of Project group. Or click Browse to locate the file you want to 
use.

6. In the Alternative Text text box, type the alternative text you want to appear in your 
Web page (the default text is “Home Page”).

7. Click OK to return to the Page Button Bar tab dialog. The path and file name for the 
navigation button now display in the Link Icon column.

8. Under Align top and/or Align bottom, select Left, Center, or Right to position the 
graphic on the page. If several graphics are displayed in the preview boxes, you can 
use drag and drop to change their order.
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9. Click OK to return to the main window.

To select or clear a button, rather than open Link Properties, you can double-click in the 
Before or After column to change the red cross to a green check mark. Alternatively, you 
can right-click and choose the green check mark from the popup menu, or press Ctrl+B 
(Before column) or Ctrl+A (After column).

The button used for a Specific Page link varies from graphics set to graphics set. In some 
instances the Home button is used. Since this button is also used for a Link to Source link, 
you may want to consider the best selection of buttons if you happen to be using both 
types of links in the same navigation bar.

Adding a Top of Project Link to an Element Button Bar
Among the navigation options in Site Builder are several special-purpose links that can be 
added to a page or element button bar. Included is the Top of Project link, which lets a user 
return to the top page of your Web publication from anywhere in the publication.

1. In the Contents pane, select the template you want to edit and click Navigation ( ) 
on the toolbar.

2. Click Element Button Bar to open that tab dialog.

3. From the Elements list, select the element you want to associate the button bar with. 
Under Link Type, select Top of Project, and then click Properties to open the Link 
Properties dialog box.

4. Select the Include a link of this type check box, and then select the Before and/or 
After check box. To select or clear a button, you can also double-click in the Before 
or After column to change the red cross to a green check mark. Alternatively, you can 
right-click and choose the green check mark from the popup menu, or press Ctrl+B 
(Before column) or Ctrl+A (After column).

5. In File Name text box, enter the path and name of the graphic to be used for the 
button. Or click Browse or Gallery to locate the graphic, if necessary. If you have 
picked a default graphics set for the template, a button from that Set appears in the 
appropriate Preview window as soon as you specify a link and leave the Link 
Properties dialog box. Otherwise, open the Gallery in the groups mode and select a 
button from the Top of Project group of graphics available. Or click Browse to locate 
the file you want to use.

6. In the Alternative Text text box, type the alternative text you want to appear in your 
Web page (the default text is “Home Page”).
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7. Click OK to return to the Element Button Bar tab dialog. The path and file name for 
the navigation button now display in the Link Icon column.

8. Under Alignment, select the appropriate radio button, depending on how you want 
the new link to be positioned on the page. When a button is associated with an element 
and set to align away from content, Site Builder uses an HTML table to achieve this 
effect. If your audience uses browsers that do not support tables, you should avoid 
using icons, bullets, or navigation buttons that are formatted to appear away from 
content.

9. Click OK to return to the main window.

The button used for a Specific Page link varies from graphics set to graphics set. In some 
instances the Home button is used. Since this button is also used for a Link to Source link, 
you may want to consider the best selection of buttons if you happen to be using both 
types of links in the same navigation bar.

If the root publication is framed, clicking the Top of Project button will open the frameset. 
If it is unframed and has a TOC, the link will be to the TOC. If it is unframed without a 
TOC, the first page in the publication will open.

Formatting a Text Bar with CSS
The formatting options for creating text bars differ, depending on whether Cascading 
Style Sheets (CSS) is turned on or off.

With CSS turned off, the Font panel in the Page Text Bar and Element Text Bar tab 
dialogs of Navigation displays as follows:

Figure 6-6 CSS turned off

With CSS turned on, it displays as follows:
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Figure 6-7 CSS turned on

Thus, with CSS, you have additional options from the drop-down list for Use this size. In 
particular, by selecting Custom, you can choose both the unit of measure (points, inches, 
centimeters, or percentage) and a precise font size.

Navigating With a Page Button Bar
Among your navigation options is the ability to create a button bar to be placed on each 
page of your Web publication. The button bar can contain links to other parts of your 
publication. It can also contain special links such as those that allow the user to print the 
publication and to open the source documents used to create it.

You can also create an element button bar that is associated with a specific element in your 
publication (see Navigating With an Element Button Bar on page 6-158).

1. In the Contents pane, select the template you want to edit and click Navigation ( ) 
on the toolbar.

2. Click Page Button Bar to open that tab dialog.

3. Under Link Type, select the link you want to create.

4. For each type of link you want, double-click the red cross in the Before and/or After 
column, depending on where you want to place the specific link (top or bottom of the 
page). The red cross turns into a green check mark.

If you have picked a default graphics set for the template, a button from that Set 
appears immediately in the appropriate Preview window below and the path and file 
name for the graphic appears in the Link Icon column. Otherwise, click Gallery and 
select a button from the appropriate group.

5. To change the order of the buttons on the bar, select the button you want to move and 
use the Reorder arrows above the Top of Page Preview window, or simply drag and 
drop the graphics image.
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6. Under Align top, select Left, Center, or Right, depending on where you want the 
button bar positioned. Under Align bottom, do the same.

7. Click OK.

In step 4, you could also right-click and choose the green check mark from the popup 
menu, or press Ctrl+B (Before column) or Ctrl+A (After column). Alternatively, once you 
select a Link Type (step 3), you can click Properties to open the Link Properties dialog 
box and make your selection there (see Link Properties (page 6-143)).

The Continue links between documents check box is selected by default. As a result, 
users can scroll through the Web pages created from all of the source documents in a given 
publication. To create a formal break after the last Web page of each document, clear this 
check box.

Navigating With a Page Text Bar
Among your navigation options is the ability to create a page text bar to link the pages of 
your Web publication. The text is drawn from headings (or other content) of all the Web 
pages for a given publication.

You can also create an element text bar that draws its content from headings on the Web 
page on which the text bar resides (see Navigating With an Element Text Bar 
(page 6-159)).

1. In the Contents pane, select the template you want to edit and click Navigation ( ) 
on the toolbar.

2. Click Page Text Bar to open that tab dialog.

3. Click Build a text bar from all, and from the first drop-down list, select the element 
to be used for building the text bar. From the second drop-down list, select the number 
of words to be used for each entry.

Example If you select Heading 1 and accept the default of 2 words, Site Builder 
creates a text bar comprising an entry for each heading at that level, using the first two 
words of each heading.

4. Click Strip input to first blank space or tab, if necessary (recommended if the 
element is numbered, so that only the text of the element will appear in the text bar).

5. Under Placement, select Top of Page or Bottom of Page.

6. Under Alignment, select Left, Center, or Right.
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7. Under Font, click Use this font and select the font you want to use from the drop-
down list. Then click Use this size and select Absolute, Larger or Smaller. If you 
choose Absolute, select a relative size from the second drop-down list.

8. Select Bold, Italic, and/or All Caps to complete the formatting of your text bar.

9. Click OK.

If you turn on Cascading Style Sheets for the template, the drop-down list for font size 
(step 7) provides more options. In particular, you can select Custom and then choose both 
a unit of measure (the default is points) and a precise font size. See Formatting a Text Bar 
with CSS (page 6-155).

The font you select for the text bar must be available on the user’s machine. Otherwise, the 
browser will substitute a font.

Navigating With an Element Button Bar
Among your navigation options is the ability to associate a button bar with a specific 
element on your Web pages. The button bar can contain links to other parts of your 
publication. It can also contain special links such as those that allow the user to print the 
publication and to open the source documents used to create it.

You can also create a page button bar to appear at the top and/or bottom of your Web 
pages (see Navigating With a Page Button Bar on page 6-156).

1. In the Contents pane, select the template you want to format and click Navigation 
( ) on the toolbar.

2. Click Element Button Bar to open that tab dialog.

3. From the Elements list, select the element you want to associate the button bar with. 
Under Link Type, select the link you want to create.

4. For each type of link you want, double-click the red cross in the Before and/or After 
column, depending on where you want to place the specific link (before and/or after 
the element). The red cross turns into a green check mark.

If you have picked a default graphics set for the template, a button from that Set 
appears immediately in the appropriate Preview window below and the path and file 
name for the graphic appears in the Link Icon column. Otherwise, click Gallery and 
select a button from the appropriate group.

5. To change the order of the buttons on the bar, select the button you want to move and 
use the Reorder arrows above the Preview window, or simply drag and drop the 
graphics image.
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6. Under Alignment, select the appropriate radio button, depending on how you want 
the new link to be positioned in this page. 

When a button is associated with an element and set to align away from content, Site 
Builder uses an HTML table to achieve this effect. If your audience uses browsers that 
do not support tables, you should avoid using icons, bullets, or navigation buttons that 
are formatted to appear away from content.

7. Click OK.

In step 4, you could also right-click and choose the green check mark from the popup 
menu, or press Ctrl+B (Before column) or Ctrl+A (After column). Alternatively, once you 
select a Link Type (step 3), you can click Properties to open the Link Properties dialog 
box and make your selection there (see Link Properties on page 6-143).

The Continue links between documents check box is selected by default. As a result, 
users can scroll through the Web pages created from all of the source documents in a given 
publication. To create a formal break after the last Web page of each document, clear this 
check box.

Navigating With an Element Text Bar
Among your navigation options is the ability to create an element text bar to link the 
elements of a Web page. The text is drawn from headings (or other content) on the Web 
page on which the text bar resides.

You can also create a page text bar that draws its content from all the Web pages for a 
given publication (see Navigating With a Page Text Bar on page 6-157).

1. In the Contents pane, select the template you want to format and click Navigation 
( ) to open that property sheet.

2. Click Element Text Bar to open that tab dialog.

3. Click Build a text bar from all, and from the first drop-down list, select the element 
to be used for building the text bar. From the second drop-down list, select the number 
of words to be used for each entry.

Example If you select Heading 1 and accept the default of 2 words, Site Builder 
creates a text bar comprising an entry for each heading at that level, using the first two 
words of each heading.

4. Click Strip input to first blank space or tab, if necessary (recommended if the 
element selected is numbered, so that only the text of the element will appear in the 
text bar).
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5. Under Placement, click Top of page or Bottom of page to place the text bar at the 
top or bottom of Web pages. To place the text bar before or after a specific element, 
click Before every or After every and choose that element from the appropriate drop-
down list.

6. Under Alignment, select Left, Center, or Right.

7. Under Font, click Use this font and select the font you want to use from the drop-
down list. Then click Use this size and select Absolute, Larger or Smaller. If you 
choose Absolute, select a relative size from the second drop-down list.

8. Select Bold, Italic, and/or All Caps to complete the formatting of your text bar.

9. Click OK.

If you turn on Cascading Style Sheets for the template, the drop-down list for font size 
(step 7) provides more options. In particular, you can select Custom and then choose both 
a unit of measure (the default is points) and a precise font size. See Formatting a Text Bar 
with CSS (page 6-155).

The font you select for the text bar must be available on the user’s machine. Otherwise, the 
browser will substitute a font.

Using a Content Server URL to Create a Hyperlink
When creating a hyperlink to a document stored in Content Server, one option is to use the 
content server URL. 

This type of link will be preserved (fixed up, if necessary) when the document containing 
the link or both documents (the document that contains the link and the document that is a 
target of the link) are included in a Content Publisher project.

Say only the document containing the link is included in your project. In that event, by 
clicking the link in the output Web page created from that document, you will log into 
Content Server and be able to view the target document from within the content server.

Say both documents are included in your project. Again, the link will be preserved (fixed 
up, if necessary) during translation, but this time you will be able to view both documents 
as part of your Web publication. By clicking the link in the output Web page created from 
the first document, you will open the output Web page created from the target document.

Follow these steps to create a hyperlink in Word:

Say you want to place a hyperlink in Document A (your source Word document) that 
targets Document B, which has been checked into Content Server.

1. In Word, open Document A.
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2. In Content Server, open the Content Information page for Document B.

3. Right-click the Web Location URL for Document B, and choose Copy Shortcut 
from the popup menu.

4. Switch to Word, where Document A is open. Select the text that will contain the 
hyperlink, and click Hyperlink on the Insert menu.

5. In the Insert Hyperlink dialog box, place the cursor in the Link to File or URL text 
box and press Ctrl-V to copy the shortcut containing the URL for Document B into 
the text box.

6. Click OK, and then Save.

Content Publisher fixes up these links, as necessary, in order to preserve them in the 
output pages. See Retaining Links to Documents Stored in Content Server (page 6-197) 
for alternative methods to creating hyperlinks.

The links between documents must function correctly in Content Server in order for them 
to work correctly in Content Publisher.

The Globals option for “relinking hyperlinks in output pages” must be selected to retain 
links to documents stored in the content server. The option is selected by default. (See 
Retaining Links to Documents Stored in Content Server on page 6-197.)

Using a Document Title to Create a Hyperlink
When creating a hyperlink to a document stored in Content Server, one option is to use the 
document title. 

This type of link will be preserved (fixed up, if necessary) when both the document that 
contains the link and the document that is a target of the link are included in a Content 
Publisher project.

Say you want to place a hyperlink in Document A (your source Word document) that 
targets Document B, which has been checked into Content Server.

1. In Word, open Document A.

2. Select the text that will contain the hyperlink, and click Hyperlink on the Insert 
menu.

3. In the Insert Hyperlink dialog box, place the cursor in the Link to File or URL text 
box and type the document title for Document B into the text box. You must include 
the extension.

4. Click OK, and then Save.
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During fixup, Content Publisher could mistake a Content ID for a document title and 
attempt a link to that, instead. This could happen if, say, the document title is in the form 
of a number. For example, in searching for the document 000116.pdf, Content Publisher 
could find a document with the Content ID 000116 -- and link to that by mistake. 

To avoid this, turn off the Globals option for preserving hyperlinks in output pages. (This 
option is turned on by default. See Relinking Hyperlinks in Output Pages (page 6-196).)

See Retaining Links to Documents Stored in Content Server (page 6-197) for alternative 
methods to creating hyperlinks.

This type of link will not work in Content Server. But Content Publisher will perform the 
necessary fixup during staging and publishing to ensure that they work in the output 
pages.

The source and target documents must be in the same project and in the same content 
server. Also, the output files must be emitted to the same folder of the translation area.

The standard naming option must be selected. (“Use standard naming” is turned on by 
default. See the Repositories tab of the Project Options dialog box, from the View menu.)

Using a Content ID to Create a Hyperlink
When creating a hyperlink to a document stored in Content Server, one option is to use the 
Content ID. 

Say you want to place a hyperlink in Document A (your source Word document) that 
targets Document B, which has been checked into Content Server.

1. In Word, open Document A.

2. In Content Server, open the Content Information page for Document B.

3. Select the Content ID and press Ctrl-C. 

4. Switch to Word, where Document A is open. Select the text that will contain the 
hyperlink, and click Hyperlink on the Insert menu.

5. In the Insert Hyperlink dialog box, place the cursor in the Link to File or URL text 
box and press Ctrl+V to copy the Content ID for Document B into the text box.

6. Click OK, and then Save.

This type of link will work if both the source and target documents are included in your 
project and are stored in the same content server. Content Publisher fixes up these links, as 
necessary, in order to preserve them in the output pages. 
6-162 Content Publisher User Guide



Templates
See Retaining Links to Documents Stored in Content Server (page 6-197) for alternative 
methods to creating hyperlinks.

The Globals option for “relinking hyperlinks in output pages” must be selected to retain 
links to documents stored in the content server. The option is selected by default. (See 
Relinking Hyperlinks in Output Pages on page 6-196.)

Retaining Original Bookmark Names
The global settings available to enhance the look of Web pages include the option to retain 
bookmark names that are in the source document and place those names in the appropriate 
location in the output web pages.

To preserve bookmark names

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Select the Retain original bookmark name check box.

4. Click OK.

Graphics
This section covers the following topics:

! Changing the Properties of Graphics Sets (page 6-164)

! Changing the Properties of Groups of Graphics (page 6-164)

! Creating a New Graphics Set (page 6-164)

! Creating a New Group of Graphics (page 6-165)

! Deleting a Graphics Set (page 6-165)

! Editing a Graphics Set (page 6-166)

! Templates and Associated Graphics Sets (page 6-166)

! Editing a Group of Graphics (page 6-167)

! Formatting a Rule for a Graphics Set (page 6-168)

! Gallery Sets (page 6-168)

! Renaming a Graphics Set (page 6-169)
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! The Gallery (page 6-169)

! Graphics Formats Supported (page 6-170)

Changing the Properties of Graphics Sets
You can create a new graphics set for the Gallery and edit existing Sets. You do this in Set 
Properties dialog box, which is available from the Gallery dialog box when it is in the Sets 
mode. (Click Properties to open the dialog box.)

See:

! Creating a New Graphics Set (page 6-164)

! Editing a Graphics Set (page 6-166)

! Graphics (page 6-163)

Changing the Properties of Groups of Graphics
You can create a new group of graphics for the Gallery, and edit new or existing groups. 
You do this in Set Properties in the Groups mode.

See:

! Creating a New Group of Graphics (page 6-165)

! Editing a Group of Graphics (page 6-167)

! Graphics (page 6-163)

Creating a New Graphics Set
You can create a new graphics set in the Gallery if you don’t want to use any of the Sets 
provided. You can open the Gallery in different ways. If you select a template and open 
Globals, click the Set tab, and then click Gallery, the Gallery is already in the Sets mode.

1. Click New to open the Set Properties dialog box.

2. In the Name text box, enter the name you want to use for the new Set.

3. Double-click any of the buttons you want to use, for example, Previous Page (top left). 
This will return you to the Gallery, which is now in the Groups mode.

4. From the Groups box, click the plus box opposite Preview Page to list all the graphics 
available in that category.
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5. Click several, in turn, to see which one you want to use. Select one and click OK. 
You’ll return to Set Properties, with the graphic you just selected in the Previous Page 
box.

6. In the Set Properties dialog box, double-click the second button you want to use, and 
repeat steps 4 and 5.

7. Repeat this procedure until you have created a graphics set that includes all the 
navigation and visual aids you’ll need for your Web pages.

8. When you’re done, click OK. When you return to the Gallery this time, you will be in 
the Sets mode and the name of the new Set will display under Sets, to the left.

If you select a rule as part of your graphics set, see Formatting a Rule for a Graphics Set 
(page 6-168) for how to edit its size and color.

Creating a New Group of Graphics
Site Builder ships with over 900 GIFs in groups or categories, such as separators and 
bullets. You can create a new group, if you want. You can use some of the graphics 
already in the Gallery or your own graphics.

1. In the Gallery dialog box, select Groups under Mode.

2. Click New.

3. In the Name text box enter the name of the group you want to create.

4. In the File Name specification text box, enter a specification for the type of graphics 
you’ll place in the group (say, *.gif). You can enter multiple specifications by 
separating them with a comma.

5. In the Directory, enter a path for the directory that contains the graphics you want to 
place in the new group (use the Browse button to locate the directory, if necessary).

6. Under Group Type, select the type of group you want to create.

7. Click OK.

Deleting a Graphics Set
You can delete a graphics set in the Gallery at any time.

1. Under Mode, select Sets.

2. From the list of Sets, select the Set you want to delete.

3. Click Delete.
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Editing a Graphics Set
You can edit a graphics set in the Gallery at any time, whether it’s a Set provided by Site 
Builder or one you created yourself. You can open the Gallery in different ways. If you 
select a template and open Globals, click the Set tab, and then click Gallery, the Gallery is 
already in the Sets mode.

1. Under Sets, select the graphics set you want to edit.

2. Click Properties to open the Set Properties dialog box.

3. Double-click the graphic you want to change, for example, Index. You’ll return to the 
Gallery, which is now in the Groups mode.

4. Under Groups, locate the Index group and click the plus box to display all the graphics 
available in that group.

5. Select another graphic and click OK. You’ll return to the Set Properties dialog box, 
with the new graphic you selected now in the Index box.

6. Repeat these steps to edit any additional buttons you want to change.

7. Click OK.

Templates and Associated Graphics Sets
The table below lists all 19 body templates in the default project file. The graphics set 
listed for each body template is also associated with the TOC, Query, and Index templates, 
where available. (There are 28 graphics sets in Site Builder, so not all are used.)

Template Graphics Set

Academy Aqua Weave

Acclaim CSS Investment

Account Clearing House

Adagio CSS Gray Tab

Administration Planner

Analysis Grouted Tiles

Archive CSS Scalloped
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Editing a Group of Graphics
You can edit a group of graphics in the Gallery at any time, whether an existing group or 
one you created yourself.

1. Under Mode, select Groups.

2. Under Groups, select the group you want to edit.

3. Click Properties to open the Set Properties dialog box.

4. Edit the Name, File Name Specification, Directory, and Group Type information, 
as appropriate.

5. Click OK.

Blank None

Business Blue Bevel

Ceremonial Blue Mexico

Courtesy CSS Cranberry Script

Executive Gray Tab

Introduction CSS Blue Peach

Lotus 1-2-3 Royal Cloth

Lotus Freelance Olive

MS Excel Skill Set

MS PowerPoint Maroon Sand

Purple Frost Lilac Spiral

Retrofied! CSS Salmon Retro

Template Graphics Set
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Formatting a Rule for a Graphics Set
Each graphics set in the Gallery has a rule as part of the Set. And when you create a new 
graphics set (see Creating a New Graphics Set on page 6-164), you have the option of 
including a rule in the Set.

In the Set Properties dialog box, you select the bar containing the rule, which activates the 
Properties button in the Horizontal Rule panel. You can then click Properties to open the 
Rule Properties dialog box.

1. Opposite the Set width box, accept the default 80% or use the Up/Down control to 
adjust the value. If you prefer to set the value in pixels, click Pixels in the Width is 
panel, and then adjust the value in the Set width box.

2. Opposite Set height (pixels), set a value for the height of the rule in pixels. Use the 
Up/Down control to adjust the value, if necessary.

3. Click 3D Shading if you want a 3D effect for the rule. Alternatively, click Set Color 
in the Color panel and click the Color button to open the Color dialog box. Select a 
color and click OK to return to the Rule Properties dialog box.

You can check your formatting in the Sample box as you make changes.

4. Under Alignment, check Left, Center, or Right for the horizontal placement of the 
rule.

5. Click OK to return to the Set Properties dialog box.

If you make the graphics set your default for a template, this rule will be available 
throughout Site Builder for the template. That is, wherever you select a rule, the settings 
will be automatically used. However, you can always format the rule differently for a 
specific use, if you want.

Gallery Sets
Site Builder ships with over 900 GIFs for use as navigation and visual aids. Many of them 
are available as part of the 28 graphics sets you can choose from to ensure a consistent 
look to your Web pages.

Each Set consists of all the navigation buttons you’ll need to create the necessary jumps 
between the pages of your Web publication, plus a separator, a horizontal rule, a bullet, 
and a background. And each Set has its own distinctive design.

You can make any of the Sets your default Set for a particular template. Once you do that, 
graphics from that Set are immediately available from the Set at appropriate points in the 
program.
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For example, if in Formatting you want to place a separator before the element selected, 
simply click the Insert Separator Before Content check box in the Separators tab dialog. 
The separator from the default graphics set will display immediately in the Preview 
window and the path and file name for the graphic will display in the File Name text box.

When you associate a graphics set with a template, the background graphic is 
automatically applied to all Web pages controlled by that template. You can change this, if 
you want, in the Colors tab dialog of Globals.

See:

! Selecting a Graphics Set for a Web Page (page 6-198)

! Graphics (page 6-163)

Renaming a Graphics Set
1. Open the Globals property sheet.

2. Click Set to open that tab dialog, and then click Gallery to open the Gallery.

3. Select the Set you want to rename, and click Properties to open the Set Properties 
dialog box.

4. In the Name text box, enter the name you want to use for the Set, and click OK.

5. Click OK to return to the Set tab dialog, and OK again to return to the main window.

The Gallery
Graphics can enhance your Web pages in many ways. Site Builder ships with over 900 
GIFs that can be selected from 28 pre-arranged Sets that contain navigation and visual aids 
in the same graphics style. You can also select graphics grouped in categories such as 
backgrounds and separators (the same categories are reflected in the folders found in the 
Gallery directory). You can even create your own Sets.

The Gallery has two modes: Sets and Groups. In the Sets mode (the default), you can click 
the options in the Sets window (Apple Butter, etc.) to view the various navigation buttons 
and other visual aids available in a particular style. (To view the graphic individually, 
click the plus box next to the Set name to open a folder and then click the graphics you 
want to view.)

In the Groups mode, click any plus box in the Groups window to open the folder to reveal 
all the graphics of a particular type available. You can select the first graphic in the group 
and press the down arrow repeatedly to scroll through all the options available.
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Graphics Formats Supported
Site Builder supports the graphics formats listed below.

All embedded graphics in source documents are converted according to the default setting 
in the Graphics tab dialog of Formatting. The options are GIF, JPEG, PNG, WBMP, and 
BMP. Any linked graphic in the source documents will be “passed through” by Site 
Builder during translation. All other linked graphics will be governed by the settings in 
Formatting.

Format Version

Adobe Photoshop* (PSD) 4.0

Adobe Illustrator* (AI) through 7.0, 9.0

Adobe FrameMaker Graphics (FMV) vector/raster through 5.0

Adobe Acrobat* (PDF) 2.1, 3.0 – 7.0 

Ami Draw (SDW) Ami Draw

AutoCAD* Interchange and Native Drawing 
Formats

DXF and DWG

AutoCAD Drawing 2.5, 2.6, 9.0 through 14.0, 2000i and 
2002

AutoShade Rendering (RND) 2.0

Binary Group 3 Fax all versions

Bitmap (BMP, RLE, ICO, CUR, OS2 DIB, and 
WARP)

all versions

CALS Raster (GP4) Type I and Type II

Corel Clipart format (CMX) 5 through 6

Corel Draw (CDR) 3.x – 8.x 

Corel Draw* (CDR with TIFF header) 2.x – 9.x

Computer Graphics Metafile (CGM) ANSI, CALS, NIST 3.0
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Encapsulated PostScript (EPS) TIFF header only

GEM Paint (IMG) no specific version

Graphics Environment Manager (GEM) bitmap and vector

Graphics Interchange Format (GIF) all versions 

Hewlett Packard Graphics Language (HPGL) 2.0

IBM Graphics Data Format (GDF) 1.0

IBM Picture Interchange Format (PIF) 1.0

Initial Graphics Exchange Specification* 
(IGES)

5.1

JFIF (JPEG not in TIFF format) all versions

JPEG (including EXIF) all versions

Kodak Flash Pix (FPX) all versions

Kodak Photo CD (PCD) 1.0

Lotus PIC all versions

Lotus Snapshot all versions

Macintosh PICT1 & PICT2 bitmap only

MacPaint (PNTG) no specific version

Micrografx Draw (DRW) through 4.0

Micrografx Designer (DRW) through 3.1

Micrografx Designer* (DSF) Windows 95, 6.0

Novell PerfectWorks (Draw) 2.0

OS/2 PM Metafile (MET) 3.0

Paint Shop Pro 6 (PSP) Windows only, 5.0 - 6.0

Format Version
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PC Paintbrush (PCX and DCX) all versions

Portable Bitmap (PBM) all versions

Portable Graymap (PGM) no specific version

Portable Network Graphics (PNG) 1.0

Portable Pixmap (PPM) no specific version

Postscript* (PS) Level II

Progressive JPEG no specific version

Sun Raster (SRS) no specific version

StarOffice /
Open Office Draw

5.2, 6.x, 7.x /
1.1 (text only)

TIFF through 6

TIFF CCITT Group 3 & 4 through 6

Truevision TGA (TARGA) 2

Visio (preview) 4

Visio 5, 2000 and 2002

WBMP no specific version

Windows Enhanced Metafile (EMF) no specific version

Windows Metafile (WMF) no specific version

WordPerfect Graphics (WPG and WPG2) through 2.0, 7 and 10

X-Windows Bitmap (XBM) x10 compatible

X-Windows Dump (XWD) x10 compatible

X-Windows Pixmap (XPM) x10 compatible

Format Version
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The asterisk (*) denotes a high-end graphics formats. All high-end graphics formats are 
provided “as is,” without representations or warranties.

In addition to graphics formats, Site Builder supports many text formats. (See Text 
Formats Supported on page 5-45.)

You can also pass through source documents to preserve the original file type or file 
extension, such as HTML, XML, PDF, and so on. (See About Pass-Through Conversion 
on page 5-37.)

You can also treat graphics as input files in Site Builder (see Graphics as Input Files on 
page 6-124).

GLOBAL SETTINGS
This section covers the following topics:

! Globals (page 6-173)

! Horizontal Rules (page 6-174)

! Table of Contents (page 6-176)

! HTML and Scripting (page 6-177)

! Tokens (page 6-186)

! Query Pages (page 6-189)

! Hyperlink Behavior (page 6-195)

! Text and Background Color (page 6-198)

! Other Web Page Settings (page 6-200)

Globals
Globals is one of four property sheets used to edit templates. Once you set up a project, 
you use the property sheets to complete the settings for each template. The settings 
determine the look and behavior of a Web page created from any source document 
associated with the template.

In Globals, your settings apply to a Web page as a whole. The settings are still saved as 
part of the template but are not associated with specific elements.

Globals’ options include:
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! Set colors for the whole Web page, including colors for links, depending on their 
status

! Add titles to the Web publication and individual Web pages

! Insert separators and rules to be placed at the beginning and end of a Web page

! Insert an address, copyright line, and email address in your Web page

! Add separators, rules, and HTML code to the page TOC

To open Globals, select a template for editing and

! Click Globals ( ) on the Template toolbar, or

! Open the Edit Template dialog box and click the Globals button.

In the Edit Template dialog box, you can move between the four property sheets and use 
them in any order. You can also preview your changes as you make them.

Horizontal Rules
This section covers the following topics:

! Adding Rules to a Web Page (page 6-174)

! Adding Separators to a Web Page (page 6-175)

Adding Rules to a Web Page
The global settings available to enhance the look of Web pages include the option to add 
rules to a Web page.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Rules to open that tab dialog.

3. Click Insert rule before content. If you want to accept the defaults, go to step 7.

4. In the Width Is panel, select % or Pixels. In the Set Width edit box, enter a value for 
the percentage or number of pixels you want to use, or use the Up/Down control to 
select the value.

5. In the Set Height edit box, enter a value for the number of pixels you want to use, or 
use the Up/Down control to select a value.
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6. Under Color, click Set Color and then click the Color button to open the Color 
dialog box. Select the color you want to use for the rule and click OK.

7. Under Alignment, click Left, Center, or Right, depending on how you want the rule 
to align on the page.

8. Check the Samples box to view the changes you make.

9. To add a rule after the content, click Insert rule after content and repeat steps 4 to 7. 
Then click OK.

Adding Separators to a Web Page
The global settings available to enhance the look of Web pages include the option to add 
separators to a Web page.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Separators to open that tab dialog.

3. Click Insert separator before content.

4. Enter the path and file name of the graphic you want to use in the text box, or click 
Browse or Gallery to locate the graphic. If you already have a default graphics set, 
the separator from that Set will appear when you click the check box.

5. Under Alignment, click Left, Center, or Right, depending on how you want the 
separator to align on the page.

6. To add a separator after the content, click Insert separator after content and repeat 
steps 4 and 5.

7. In the Alternative Text box, enter information that you would like to display onscreen 
in the event that the separator doesn’t display. 

8. Click OK.

If you select a file from Content Server (by clicking Browse in step 4), you can click the 
Info button ( ) at any time to view the Content Information page for that file (if, say, 
you want to select another version of the file).

The alternative text (Step 7) will display when (a) a user's browser is text only, (b) a user 
chooses to disable the browser's graphics functionality, or (c) a visually impaired user is 
viewing Web pages with an HTML screen reader. 

If you do not add alternative text, no default text will be used.
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Table of Contents
This section covers the following topics:

! Adding Global Settings to a Page TOC (page 6-176)

! Adding Rules to a Page TOC (page 6-176)

! Adding Separators to a Page TOC (page 6-177)

Adding Global Settings to a Page TOC
In Globals you can add three settings that affect the page TOC as a whole: rules, 
separators, and HTML or scripting code. These are all done from the Page TOC tab. See 
Related Topics for specific topics that address these options.

You can also edit the page TOC in Formatting. There, you format the individual elements 
of a page TOC. See Formatting the Page TOC (page 6-134).

Adding Rules to a Page TOC
The global settings available to enhance the look of your Web page include the option to 
add rules to the page TOC of the page.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Rules to open that tab dialog, and then click Page TOC.

3. In the Page TOC tab dialog, click Insert rule before content.

If you want to accept the defaults, go to step 7.

4. In the Width Is panel, select % or Pixels. In the Set Width edit box, enter a value for 
the percentage or number of pixels you want to use, or use the Up/Down control to 
select the value.

5. In the Set Height edit box, enter a value for the number of pixels you want to use, or 
use the Up/Down control to select a value.

6. Under Color, click Set Color and then click the Color button to open the Color 
dialog box. Select the color you want to use for the rule and click OK.

7. Under Alignment, click Left, Center, or Right, depending on how you want the rule 
to align on the page.

The Samples box will show the changes made.
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8. To add a rule after the content, click Insert rule after content and repeat steps 4 
through 7.

9. Click OK.

Adding Separators to a Page TOC
The global settings available to enhance the look of Web pages include the option to add 
separators to the page TOC of the page.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Page TOC to open that tab dialog, and then click the Separators button.

3. In the Separators tab dialog, click Insert separator before content.

4. Enter the path and file name of the graphic you want to use in the text box, or click 
Browse or Gallery to locate the graphic. If you already have a default Set, the 
separator from that Set will appear when you click the check box.

5. Under Alignment, click Left, Center, or Right, depending on how you want the 
separator to align on the page.

6. To add a separator after the content, click Insert separator after content and repeat 
steps 4 and 5.

7. In the Alternative Text box, enter information that you would like to display onscreen 
in the event that the separator doesn’t display. 

8. Click OK.

If you select a file from Content Server (by clicking Browse in step 4), you can click the 
Info button ( ) at any time to view the Content Information page for that file (if, say, 
you want to select another version of the file).

The alternative text will display when (a) a user's browser is text only, (b) a user chooses 
to disable the browser's graphics functionality, or (c) a visually impaired user is viewing 
Web pages with an HTML screen reader.

HTML and Scripting
This section covers the following topics:

! Including HTML or Scripting Code at the Top of an HTML File (page 6-178)

! Handling an Event Within a Body Page (page 6-179)
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! Including HTML or Scripting Code in a Page TOC (page 6-179)

! Including HTML or Scripting Code in a Web Page (page 6-180)

! Including HTML or Scripting Code in the Head of a Web Page (page 6-181)

! Including HTML or Scripting Code Inside the HTML Tag (page 6-182)

! Including Scripting Variables in Output (page 6-183)

! Scripting Variables in Site Builder (page 6-183)

! Compliance With HTML 4.0 (page 6-184)

! Generating XML-Compliant Output (page 6-185)

Including HTML or Scripting Code at the Top of an HTML 
File
The global settings available to enhance the look of Web pages include an option to place 
HTML or scripting code at the top of an HTML file, before the <HTML> tag. (See 
Including HTML or Scripting Code in the Head of a Web Page on page 6-181 and Tokens 
for Adding HTML Code on page 6-186.)

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Head to open that tab dialog.

3. Click Include HTML or scripting code at the top of file, and do one of the 
following:

! Click Use the following, and enter the code in the box, or

! Click Use the contents of this file and enter the path and file name in the text box 
or click the Browse or Gallery button to locate the file.

4. Click OK.

It is up to the author to supply and verify any linked file in HTML or scripting code that is 
inserted. If the HTML or scripting code calls another file, that file should be placed in the 
proper output directory (see Associating a File With a Publication on page 5-99).

To state that your Web pages comply with HTML version 4.0, use the <!DOCTYPE> 
declaration at the top of your HTML file. That is, check the appropriate boxes and place 
the following in the first text box:

<!DOCTYPE HTML PUBLIC “-//W3C/DTD HTML 4.0 Final//EN”>
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If you select a file from Content Server (step 3), you can click the Info button ( ) at 
any time to view the Content Information page for that file (if, say, you want to select 
another version of the file).

Handling an Event Within a Body Page
You can assign an event handler to a Web page that is triggered each time an event occurs 
in your browser. Such an event handler might be onLoad or onUnload. You could also 
include HTML code or JavaScript within the page.

1. Click Globals ( ) on the toolbar to open that property sheet.

2. Click Tags to open that tab dialog.

3. Click Include HTML or scripting code in the Body tag, and then click either Use 
the following or Use the contents of this file.

4. If you click Use the following, enter the code you want to use in the box provided.

5. If you click Use the contents of this file, enter the path and file name in the text box, 
or click Browse to locate the file, or click Gallery to pick a file from the HTML Code 
folder in the Gallery.

6. Click OK.

If you select Use the contents of this file and the referenced file references another file, 
such as a graphic, this file should be listed in the Associated Files dialog box so that Site 
Builder will copy this file to the output directory when you translate the publication. See 
Associating a File With a Publication (page 5-99).

To temporarily remove an event handler from a body page but keep it available for future 
use, clear the Include HTML or scripting code in the Body tag check box. When you’re 
ready to assign the event handler once more within the body page, select the check box.

See Handling an Event Within a Frameset (page 5-64), Handling an Event for an Element 
(page 6-23), Tokens for Adding HTML Code (page 6-186), and Including HTML or 
Scripting Code Inside the HTML Tag (page 6-182).

If you select a file from Content Server (step 5), you can click the Info button ( ) at 
any time to view the Content Information page for that file (if, say, you want to select 
another version of the file).

Including HTML or Scripting Code in a Page TOC
The global settings available to enhance the look or functionality of Web pages include the 
option to place HTML or scripting code in the page TOC of the page.
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1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Page TOC to open that tab dialog, and then click the HTML button.

3. In the HTML tab dialog, click Include HTML or scripting code before the content.

4. Do one of the following:

! Click Use the following and enter the code you want to use in the box.

! Click Use the contents of this file and enter the path and file name in the text box 
or click the Browse or Gallery button to locate the file.

5. If necessary, click Include HTML or scripting code after the content and repeat 
step 4.

6. Click OK.

It is up to the author to supply and verify any linked file in HTML or scripting code that is 
inserted. If the HTML or scripting code calls another file, that file should be placed in the 
output directory (see Associating a File With a Publication on page 5-99).

See Tokens for Adding HTML Code (page 6-186).

If you select a file from Content Server (step 4), you can click the Info button ( ) at 
any time to view the Content Information page for that file (if, say, you want to select 
another version of the file).

Including HTML or Scripting Code in a Web Page
The global settings available to enhance the look or functionality of Web pages include the 
option to place HTML or scripting code in a Web page.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click HTML to open that tab dialog.

3. Click Include HTML or scripting code before the content.

4. Do one of the following:

! Click Use the following and enter the code you want to use in the box.

! Click Use the contents of this file and enter the path and file name in the text box 
or click the Browse or Gallery button to locate the file.

5. If necessary, click Include HTML or scripting code after the content and repeat 
step 4.
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6. Click OK.

It is up to the author to supply and verify any linked file in HTML or scripting code that is 
inserted. If the HTML or scripting code calls another file, that file should be placed in the 
output directory (see Associating a File With a Publication on page 5-99).

See Tokens for Adding HTML Code (page 6-186).

If you select a file from Content Server (step 4), you can click the Info button ( ) at 
any time to view the Content Information page for that file (if, say, you want to select 
another version of the file).

Including HTML or Scripting Code in the Head of a Web 
Page
The global settings available to enhance the look of your Web page include an option to 
place HTML code in the head of a Web page. (See Including HTML or Scripting Code at 
the Top of an HTML File on page 6-178.)

1. In the Contents pane, select the template you want to edit and click Globals ( ) on 
the toolbar.

2. Click Head to open that tab dialog.

3. Click Include HTML or scripting code in the Head, and do one of the following:

! Click Use the following, and enter the code in the box, or

! Click Use the contents of this file and enter the path and file name in the text box 
or click the Browse or Gallery button to locate the file.

4. Click OK.

It is up to the author to supply and verify any linked file in HTML or scripting code that is 
inserted. If the HTML code calls another file, that file should be placed in the proper 
output directory.

See Tokens for Adding HTML Code (page 6-186).

If you select a file from Content Server (step 3), you can click the Info button ( ) at 
any time to view the Content Information page for that file (if, say, you want to select 
another version of the file).

You can convert HTML source files (for example, ASP files) by adding the appropriate 
header information to the output files. In addition to following the above steps to add the 
code containing the header information, you should select the Include for HTML 
documents check box. The specified code will be added to the top of all HTML source 
files associated with the selected template.
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Including HTML or Scripting Code Inside the HTML Tag
You can include HTML or scripting code inside the HTML tag, which will be applied 
globally to your Web output pages. Typically, the most likely use of this would be to drop 
in the LANG or Version attributes.

The LANG attribute allows you to identify the language being used for the Web pages 
associated with the template, while the Version attribute allows you to include a version 
number in the output. The LANG attribute can be used by a user agent in different ways, 
including assisting search engines and speech synthesizers.

1. On the main window, select the template you want to edit and click Globals ( ) on 
the standard toolbar.

2. Click Tags to open that tab dialog.

3. Select Include HTML or scripting code inside the HTML tag, and then click either 
Use the following or Use the Contents of this file.

4. If you click Use the following, enter the code you want to use. For example, to denote 
Web pages in Italian, you would enter LANG=“it” (note the quotations marks around 
the language abbreviation). 

5. If you click Use the contents of this file, enter the path and file name in the text box, 
or click Browse to locate the file.

6. Click OK.

If you select Use the contents of this file and the referenced file references another file, 
this file should be listed in the Associated Files dialog box so that Site Builder will copy 
this file to the output directory when you translate the publication. See Associating a File 
With a Publication (page 5-99).

To temporarily remove HTML or scripting code from a body page but keep it available for 
future use, clear the Include HTML or scripting code in the HTML tag check box. 
When you’re ready to assign the code once more within the HTML tag, select the check 
box.

See Handling an Event Within a Body Page (page 6-179) (which you would also set up on 
the Tags tab dialog).

If you select a file from Content Server (step 5), you can click the Info button ( ) at 
any time to view the Content Information page for that file (if, say, you want to select 
another version of the file).
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Including Scripting Variables in Output
The global settings available to enhance the look or functionality of Web pages include the 
option to include scripting variables in output pages. With JavaScript, these variables can 
be used to access different information stored in the output HTML files.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Click Include scripting variables in output.

4. Click Variables contain source file details if you want the TRANSIT_SOURCE 
variable to include the path of source documents.

5. Click OK.

See Scripting Variables in Site Builder (page 6-183) for a complete list of variables in Site 
Builder.

Scripting Variables in Site Builder
The global settings available to enhance the look or functionality of your Web pages 
include the option to include scripting variables in output pages. With Javascript, these 
variables can be used to access different information stored in the output HTML files.

Site Builder does not automatically include scripting variables in your output HTML files. 
See Including Scripting Variables in Output (page 6-183).

Following is a list of all the Site Builder variables. Except for TRANSIT_SOURCE, all 
links will be relative paths so that they work equally well in the staging and published 
areas.

TRANSIT_XMLFILE a relative link from this document to the XML Map 
file

TRANSIT_DOCID the ID (as stored in the XML Map file) of this 
document

TRANSIT_PREVPAGE a relative link from this document to the previous page

TRANSIT_NEXTPAGE a relative link from this document to the next page

TRANSIT_FIRSTPAGE a relative link from this document to the first page of 
the current publication
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Compliance With HTML 4.0
If you are using a CSS-enabled template, Site Builder is fully compliant with the HTML 
4.0 standard. If you are using a non–CSS-enabled template, Site Builder does not comply 
with HTML 4.0 in one respect.

Site Builder seeks to duplicate the look of source documents in the Web pages you create. 
As a result, in order to duplicate indentation in the source documents, Site Builder uses the 
<BLOCKQUOTE> and <UL> tags. You can remove these if you want to create a Web 
publication that is fully compliant with HTML 4.0.

To create a Web publication compliant with HTML 4.0

TRANSIT_TOC a relative link from this document to the table of 
contents

TRANSIT_LOF a relative link from this document to the list of figures

TRANSIT_LOT a relative link from this document to the list of tables

TRANSIT_INDEX a relative link from this document to the index

TRANSIT_QUERY a relative link from this document to the query page

TRANSIT_HOME a relative link from this document to the project's 
home page

TRANSIT_SOURCE an absolute path to the source file for this document 
(empty for reference documents)

TRANSIT_FRAMESET the relative path to the publication frameset file

TRANSIT_BODYFRAME the frame name for body documents

TRANSIT_TOCFRAME the frame name for the TOC

TRANSIT_LOFFRAME the frame name for the LOF

TRANSIT_LOTFRAME the frame name for the LOT

TRANSIT_INDEXFRAME the frame name for the INDEX

TRANSIT_CONTAINFRAM
E

the name of the frame, if any, that contains the Content 
Publisher publication (e.g. `_top')
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1. In the Contents pane, select one of the templates you want to edit, and click 
Formatting ( ) on the toolbar.

2. Select all the elements in the Elements list.

3. Click the Paragraph tab to open that tab dialog.

4. Under Alignment, click Don’t Specify.

5. Click OK to return to the Contents pane.

6. Repeat steps 1 to 5 for any additional templates in your publication.

7. Click Save to save your template changes to the project file.

Generating XML-Compliant Output
The global settings available in Site Builder include the option to generate XML output.

Any source documents that Site Builder can turn into HTML output, it can just as easily 
turn into XML output. As a result, information is no longer trapped in Web pages, but can 
be made accessible to other applications.

Site Builder generates XML output by removing telltale HTML elements such as the 
HTML, Head, and Body tags. It also balances tags, where necessary. Thus, instead of 
generating <IMG SRC=“filename.gif”> for HTML output, Site Builder will generate 
<IMG SRC=“filename.gif”/> (the forward slash at the end of the element content is used 
to denote the closing tag).

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Click Generate XML-compliant output.

4. Click the XML Options button to open that dialog box. In the XML Options dialog 
box you might specify an XML declaration such as <?xml version=“1.0”?> .

5. Enter XML code, as appropriate, at the top of all output HTML files and also at the 
end by selecting the appropriate check boxes, clicking Use this (specify the code) or 
Use the contents of this file (specify the file that contains the code).

6. Click OK to return to the Options tab dialog, and OK, again, to return to the main 
window.

Site Builder does not automatically apply the .xml extension to XML output. You may 
want to use the .xml extension, since some viewers will not recognize XML files without 
it. See Specifying the Extension for Output Files (page 5-106).
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If you select a file from Content Server (step 5), you can click the Info button ( ) at 
any time to view the Content Information page for that file (if, say, you want to select 
another version of the file).

Tokens
This section covers the following topics:

! Tokens for Adding HTML Code (page 6-186)

! Template Token Example (page 6-189)

Tokens for Adding HTML Code
Several tokens are available when adding HTML code to a Web publication. The tokens 
can be used when inserting HTML code before or after an element, at the top of a file or in 
the head of a file, or before or after any content.

%%TRANSIT-CONTENT%%

Site Builder replaces this token in the output HTML with the specified content. For 
example, Weblink, one of three character elements in the templates that ship with Site 
Builder, includes the following HTML code before the element:

<A HREF=“http://%%TRANSIT-CONTENT%%”>

This is an example of pattern matching. During translation, Site Builder replaces 
%%TRANSIT-CONTENT%% with the appropriate content each time it finds a string 
beginning with www, and adds http:// to the string. As a result, all such links to Web sites 
are automatically activated in the output pages.

%%TRANSIT-GALLERY_GRAPHIC_DIR%%

This token can be used when referring to an object in the Gallery Graphics directory.

%%TRANSIT-PATH(TOC)%%
%%TRANSIT-PATH(LOF)%%
%%TRANSIT-PATH(LOT)%%
%%TRANSIT-PATH(INDEX)%%
%%TRANSIT-PATH(FILENAME)%%

These tokens are used to dynamically include a reference page in a separate Web page, 
usually the cell of an HTML table. (See Populating the Cells of an HTML Table on 
page 5-80.) When the project is translated, staged, and published, the token is replaced 
with the path to the reference page file. The %%TRANSIT-PATH(FILENAME) token 
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displays the file name and extension of the current output file. The Transit-Path token 
must be used with a scripting language (Idoc, ASP, SSI, or JSP). For scripting syntax, see 
HTML Table Cells and Dynamic Includes (page 5-77).

<!-- TRANSIT - LAYOUT(TOC) -->
<!-- TRANSIT - LAYOUT(LOF) -->
<!-- TRANSIT - LAYOUT(LOT) -->
<!-- TRANSIT - LAYOUT(INDEX) -->
<!-- TRANSIT - CUSTOMLAYOUT(BODY) -->

These tokens are used to statically include a reference page or body page in a separate 
Web page, usually the cell of an HTML table. (See Populating the Cells of an HTML 
Table on page 5-80.) When the project is translated, staged, and published, the token is 
replaced with the contents of the source reference page or body page. Content Publisher 
body pages can be included as a static page only. As such, the ' TRANSIT - 
CUSTOMLAYOUT(BODY)' tag is used, regardless of the static or dynamic nature of 
your Web page.

<!-- TRANSIT - CUSTOMLAYOUT(TOP) -->
<!-- TRANSIT - CUSTOMLAYOUT(HEAD) -->
%%TRANSIT-BODYATTRIBUTES%%

These tokens are used to insert template settings into the custom table layout that you 
likely created in a third-party HTML editor. The 'TOP' token should be placed at the top of 
the Web page before the <HTML> tag. The 'HEAD' token should be placed between the 
<HEAD> tags. The 'Body Attributes' token should be placed in the <BODY> tag. Lastly, 
the necessary tokens from above (reference and body pages) need to be placed in the Web 
page, where you want the reference or body page content to appear.

See an example of all three tokens in the Web page (possibly created in a third party 
HTML editor) that will serve as a custom table layout for your publication (see Template 
Token Example on page 6-189).

%%TRANSIT-RELATIVEPATH(path statement)%%

The above token is used to insert a relative path rather than a full path to a Web page on 
your site. (Replace 'path statement' with the path to the file.) When the project is 
translated, staged, and published, the token is replaced with the relative path to the source 
document. For example, you may want to use this token when you link from one source 
document to another in the same publication or different publications.

Example: If you have a page located in c:\output\sub1\sub2\, and you want to link from 
that page to another page located in c:\output\filename.htm, you could use this token 
instead of manually determining the relative path (such as “..\..\”) in the directory 
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structure. By inserting this token with the path to the file -- for example: %%TRANSIT-
RELATIVEPATH(C:\output\filename.htm)%% -- you would successfully link to the 
other Web page when you translate, stage, and publish your project.

%%TRANSIT-DM_UIPROPERTY(Field Caption)%%
%%TRANSIT-DM_PROPERTY(Field Name)%%

With either of these two tokens you can retrieve the same property value. Depending on 
which one you use, the token is replaced in the output HTML by the corresponding Field 
Caption value or Field Name value. Field Caption refers to the label used in the interface 
to identify a document property; Field Name refers to the string in Content Server that 
uniquely identifies the same property.

You can retrieve the same property value by using either method. For example, you might 
add one of the following as HTML code in the Head tab dialog of Globals, to be inserted 
before content in your output pages:

<META NAME=“Author” CONTENT=“%%TRANSIT-
DM_UIPROPERTY(Author)%%”>

<META NAME=“Author” CONTENT=“%%TRANSIT-
DM_PROPERTY(dDocAuthor)%%”>, or

Either would produce the same result:

<META NAME=“Author” CONTENT=“Jane Doe”>

All tokens and their parameters are case sensitive.

Field Caption Field Name

Account dDocAccount

Author dDocAuthor

Title dDocTitle

Type dDocType

Security Group dSecurityGroup

Release Date dInDate

Expiration Date dOutDate

Comments xComments
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The reference page token (%%TRANSIT-PATH()%%) is used when you dynamically 
include content in the cell of an HTML table, using Idoc, ASP, or JSP scripting languages. 
See Creating an HTML table layout for details.

The field caption “Account” was previously called “Document Account.” You can still 
use “Document Account” (any projects that already use this field caption will still run 
fine). Likewise, you can still use “Document Author,” “Document Title,” and “Document 
Type.”

Although you can publish output containing content server metadata by using the “Field 
Caption” and “Field Name” tokens, there is an alternative that gives you more control over 
the look and feel of the publication, including the promotion of content server metadata to 
the TOC. See Making a Metadata Element-Based (page 6-78) and Publishing Metadata to 
a Content Server (page 6-79) for more information.

Template Token Example
Tokens are in bold for illustration:

<!-- TRANSIT - CUSTOMLAYOUT(TOP) -->
<html>
<head>
<!-- TRANSIT - CUSTOMLAYOUT(HEAD) -->
</head>
<body %%TRANSIT-BODYATTRIBUTES%%>
<p>
[Insert reference page and body page tokens here.]
</p>
</body>
</html>

Query Pages
This section covers the following topics:

! Choosing Fields and Buttons for a Query Page (page 6-190)

! Query Reference Page (page 6-191)

! Selecting a Query Form (page 6-192)

! Setting Options for a Query Results Page (page 6-193)
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Choosing Fields and Buttons for a Query Page
A Query reference page (see Query Reference Page (page 6-191)) can add a powerful 
dimension to your Web publication by creating a search feature that can be used to locate 
information not only in your Web publication but also anywhere in the content server in 
which your Web publication resides.

Once you add a Query page to your publication, you then set parameters for searches on 
the page. This three-part task consists of:

! Selecting a Query form

! Choosing fields and buttons for the Query page

! Setting options for the Query results page

You set the parameters in the Query tab dialog in Globals. Most of the options are not 
enabled until you have set staging and/or publishing options, and thus identified a content 
server for the Web publication.

1. In the Contents pane, select the Query page and click Globals ( ) on the standard 
toolbar.

2. Click Query to open that tab dialog (which is available only when you select a Query 
page in the Contents pane).

3. On the Fields and Buttons tab dialog, first select the search fields you want to be 
available for searches.

The default is for all the fields listed in the Query Field column to display on your 
Query page. You can double-click any entry in the Show/Hide column to toggle 
between showing and hiding a field on the Query page. Alternatively, you can select 
the entry and click the Show or Hide button at the side. Whatever Query fields you 
select, they will only show in the Query page if the script allows it.

4. Select a style for the buttons that will display on the Query page. The default style is 
displayed in the preview box. To select an alternative button style, click Browse to 
locate a graphic in a repository that you want to use, or click Gallery to select a 
graphic from the Gallery in Site Builder.

You must use either the default buttons or alternative buttons. Once you select an 
alternative, you can toggle between that button and the default button by double-
clicking the green check mark or red cross in the Use Graphic column. (If you never 
select an alternative, it doesn’t matter whether the Use Graphic column displays a 
green check mark or a red cross – the default button will still appear in the Query 
page.)
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5. If you haven’t yet done so, click Query Form to open that tab dialog to select a Query 
form (see Selecting a Query Form on page 6-192).

6. Click Results Options to open that tab dialog to set options for the Query results page 
(see Selecting a Presentation Option for a Query Results Page on page 8-71).

7. When you have set the necessary options on all three tab dialogs, click OK to return to 
the main window.

Because a Query page relies on a content server to function, you cannot test the Query 
page until you stage or publish your publication (and place all your translated output in a 
content server).

Query Reference Page
A Query reference page can add a powerful dimension to your Web publication by 
creating a search feature that can be used to locate information not only in your Web 
publication but also anywhere in the content server in which your Web publication 
resides.

You add the Query page to a publication just as you would any other reference page. You 
can place it in any frame of a frameset, if you want to, and associate it with any Query 
template (special Query templates are available if you want to use the same graphics set 
for a Query page as other body and reference pages in your publication).

You then set parameters for the searches that can be made from the Query page and also 
options for the results page you want to display.

Thus, creating a Query reference page is a two-part task, consisting of:

! Adding the reference page to a Web publication (see Adding a Reference Page on 
page 5-53).

! Setting parameters and options for the Query page and the results page (for the 
search).

The second task takes place on the Query tab dialog of Globals, which is available only 
after you have added a Query page to your publication. (It replaces the Page TOC tab 
dialog, which is available when you select any other reference page or source document in 
the Contents pane before opening Globals.)

After you create a Query reference page, you can add navigation buttons to it just as you 
would with any other reference page. For example, these could help you toggle between 
different reference pages in your Web publication.
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If you are creating a Table layout, the Query icon is not available in the Components box 
of the Layout dialog box. With this type of layout, the Query reference page is 
automatically placed in the table cell reserved for body pages. You still add the reference 
page to the project in the Contents pane in the usual way.

Selecting a Query Form
A Query reference page (see Query Reference Page on page 6-191) can add a powerful 
dimension to your Web publication by creating a search feature that can be used to locate 
information not only in your Web publication but also anywhere in the content server in 
which your Web publication resides.

After you add a Query page to your publication, you then set parameters for searches on 
the page. This three-part task consists of:

! Selecting a Query form

! Choosing fields and buttons for the Query page

! Setting options for the Query results page

You set the parameters in the Query tab dialog in Globals. Most of the options are not 
enabled until you have set staging and/or publishing options, and thus identified a content 
server for the Web publication.

Use this process to select a Query form:

1. In the Contents pane, select the Query page and click Globals ( ) on the standard 
toolbar .

2. Click Query to open that tab dialog (which is only available when you select a Query 
page in the Contents pane).

3. On the Query Form tab dialog, click Use the following to use the default script 
listed. (This script is available for any Content Server you are staging or publishing 
to.)

Alternatively, type in a script you want to use or click Use the contents of this file 
and provide the path and name of the file containing the script. (Clicking Browse 
provides access to the content server while clicking Gallery opens the Gallery as 
installed on your local drive with Content Publisher.).

4. Click Fields and Buttons to open that tab dialog to choose fields and buttons for the 
Query page (see Choosing Fields and Buttons for a Query Page on page 6-190).

5. Click Results Options to open that tab dialog to set options for the Query results page 
(see Selecting a Presentation Option for a Query Results Page on page 8-71).
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6. When you have set the necessary options on all three tab dialogs, click OK to return to 
the main window.

Because a Query page relies on a content server to function, you cannot test the Query 
page until you stage or publish your publication (and place all your translated output in a 
content server).

Setting Options for a Query Results Page
A Query reference page (see Query Reference Page on page 6-191) can add a powerful 
dimension to your Web publication by creating a search feature that can be used to locate 
information not only in your Web publication but also anywhere in the content server in 
which your Web publication resides.

Once you add a Query page to your publication, you then set parameters for searches on 
the page. This three-part task consists of:

! Selecting a Query form

! Choosing fields and buttons for the Query page

! Setting options for the Query results page

You set the parameters in the Query tab dialog in Globals. Most of the options are not 
enabled until you have set staging and/or publishing options, and thus identified a content 
server for the Web publication.

Use this process to set options for a Query results page:

1. In the Contents pane, select the Query page and click Globals ( ) on the standard 
toolbar.

2. Click Query to open that tab dialog (which is available only when you select a Query 
page in the Contents pane).

3. On the Results Options tab dialog, set the parameters for your Query by clicking the 
Select button in the Query Scope panel to open the Content Query Capture page.

4. Refine the fields to define the information that a user may search for in your Web 
publication and content server. You can refine the scope of only those fields you select 
in the Fields and Buttons dialog box.

Example If, on the Fields and Buttons tab dialog, you choose to show the Document 
Author field in your Query page, you can refine the scope of that field by selecting a 
specific author on the Content Query Capture page.
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For the user to successfully conduct a search on the Query page, the Document Author 
field should either be left empty or the specific author name entered here should be 
used. Otherwise, the search will return no documents. A Webmaster might want to 
hide the field on the Query page. In that event, the restrictions set here will still apply. 
That is, any searches the user makes using other parameters will find only those Web 
pages that both satisfy those parameters and the restriction on Author set here.

5. Once you have refined the necessary fields, click Search (to display the current list of 
documents that would be available from your Query page). Then click Add Query to 
Project to confirm the scope of your Query page and return to the Results Options tab 
dialog.

The Query Scope panel will now display a summary of the scope you have set. If in 
the Content Query Capture page you do not refine any field in any way, you will see 
<Unrestricted Query> in this box. Click the Clear button to clear this box at any time 
and set a new scope for your Query page.

6. Under Query Results Presentations Options, click the Select button to open the 
Results Presentation Option dialog box. From the Name drop-down list, select the 
presentation format you want to use for the Query results page. (Your Content Server 
administrator creates these options.) A description of the presentation format and the 
text that will display in the results page appears below.

Text 1 and Text 2 typically include the Content ID and Title (the administrator can 
define the fields in different ways), and will appear in the Description column of the 
Query results page. This is the minimum amount of information (along with an icon 
that lets you jump to the Web page) that will appear.

7. Click OK to return to the Results Options tab dialog. Select the appropriate check 
boxes to determine what additional columns will appear in the Query results page.

8. If you haven’t yet done so, click Query Form to open that tab dialog to select a Query 
form (see Selecting a Query Form on page 6-192), and click Fields and Buttons to 
open that tab dialog to choose fields and buttons for the Query page (see Choosing 
Fields and Buttons for a Query Page on page 6-190).

9. When you have set the necessary options on all three tab dialogs, click OK to return to 
the main window.

Because a Query page relies on a content server to function, you cannot test the Query 
page until you stage or publish your publication (and place all your translated output in a 
content server).
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Hyperlink Behavior
This section covers the following topics:

! Suppressing Cross-References in a Web Page (page 6-195)

! Specifying a Target for External Hyperlinks (page 6-195)

! Relinking Hyperlinks in Output Pages (page 6-196)

! Omitting Hyperlink Targets for Promoted Elements (page 6-197)

! Retaining Links to Documents Stored in Content Server (page 6-197)

Suppressing Cross-References in a Web Page
The global settings available to enhance the look of Web pages include the option to 
include or suppress cross-references.

Site Builder automatically includes cross-references in Web pages and retains the links 
inserted in the source document. But you can suppress the cross-references, if you want.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Clear the Include cross references in output check box.

4. Click OK.

The cross-references are no longer linked to the target text in the Web page (but they 
remain linked in the source document).

Specifying a Target for External Hyperlinks
You may want to include a link from your Web site to an external location, such as an 
altogether different Web site. When you include this type of external hyperlink, you may 
want the site that is referenced in the link to open in a separate browser window. When 
this occurs, those viewing your Web site retain their place on your site and can simply 
close the window of the external site without losing their connection to your site.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.
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3. Under Include cross-references in output, select Use this target for external 
hyperlinks, and enter _blank in the text box.

4. Click OK.

You can enter any standard HTML target into the text box depending on what you want to 
do:

! _blank opens a new browser window that is separate from your Web site

! _parent opens the document in the frameset parent of the current document

! _self opens the document in the same window that contained the page with the link, so 
the current page is “overwritten”

! _top opens the document in the full browser window, replacing any frameset your 
Web site may have

Relinking Hyperlinks in Output Pages
The global settings available to enhance the look or functionality of Web pages include the 
option to relink hyperlinks.

Site Builder preserves hyperlinks in source documents where the document containing the 
hyperlink and the target document are both part of the same project. This is done 
automatically thanks to a default setting in Globals. In the event that you have to reset this 
option, do the following.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Click Include cross-references in output and also Hyperlinks within project 
relinked in output pages.

4. Click OK.

If different templates are used for the source and target documents, the above steps must 
be completed for both templates.

If you would like to retain hyperlinks between documents that are stored in Content 
Server, see Retaining Links to Documents Stored in Content Server (page 6-197).

With the hyperlink option set in Globals, Site Builder will preserve other types of links, 
too. For example, any hyperlink that targets a URL or uses the Mailto: function will be 
recognized by Site Builder in the output pages (the Mailto: link can only be activated if 
your browser includes a mail option). However, to create a hyperlink to a document in its 
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native format, you must copy this document to the appropriate output directory for the 
hyperlink to succeed. The best way to do this is to treat the target document as an 
associated file. See Associating a File With a Publication (page 5-99).

Different applications have different settings. You may need to experiment with 
hyperlinks in your source documents to see what works.

The Options tab dialog in Globals also contains the option Strip path from external 
hyperlinks. This check box is cleared by default. It is potentially useful if you choose to 
move your target document to a relative or absolute network path on your intranet.

Omitting Hyperlink Targets for Promoted Elements
Elements that are promoted to a reference page (TOC, Index, etc.) will include an anchor 
tag so that a user can easily navigate back to the original document or, more importantly, a 
section of that document.

You can remove this hyperlink target if you do not want it to interfere with your Web page 
layout, such as an HTML table, or a scripting interpretation of your Web page, such as 
XML.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Select the Omit hyperlink targets for promoted elements check box.

4. Click OK.

Retaining Links to Documents Stored in Content Server
Retaining links between documents on the file system is handled automatically by Site 
Builder, thanks to a default setting in Globals (see Relinking Hyperlinks in Output Pages 
on page 6-196).

When creating a hyperlink to a document stored in Content Server, you have several 
options:

! Using a Content Server URL to Create a Hyperlink (page 6-160)

! Using a Content ID to Create a Hyperlink (page 6-162)

! Using a Document Title to Create a Hyperlink (page 6-161)
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Text and Background Color
This section covers the following topics:

! Setting Colors for a Web Page (page 6-198)

! Selecting a Graphics Set for a Web Page (page 6-198)

! Selecting a Background Graphic for a Web Page (page 6-199)

Setting Colors for a Web Page
The global settings available to enhance the look of your Web publication include the 
option to set colors for the text, links, and background of Web pages.

1. In the Contents pane, select the template you want to edit and click Globals ( ) on 
the toolbar.

2. Click Colors to open that tab dialog.

There are four color options plus a fifth choice that enables you to use a graphic 
instead of a color as the background for the Web page.

3. To select a background color, click the Background check box and the click the Color 
button to open the Color dialog box. Select any color, and then click OK to return to 
the Color tab dialog.

The color you selected appears in the color bar and can also be viewed in the Sample 
box.

4. Choose additional colors for other components of the Web page, if you want. The 
Sample box will show the result of each color choice.

You can also select a background graphic, instead (see Selecting a Background Graphic 
for a Web Page on page 6-199). Or you can use a background color with a background 
graphic, if the graphic is transparent.

Selecting a Graphics Set for a Web Page
The global settings available to enhance the look of Web pages include the option to select 
one of the 28 graphics sets supplied with Site Builder.

Making one of the graphics sets the default Set for a particular template ensures the 
consistent use of navigation buttons and visual aids for all the Web pages created with that 
template. You can switch between Sets at any time to dramatically alter the look and feel 
of your Web pages.
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1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Set to open that tab dialog.

3. The Set text box displays the name of any Set currently selected for the template. 
Click Gallery to open the Gallery dialog box.

4. Select the Set you want to use. The graphics from the Set will appear in the Preview 
window.

5. Click Make Default. The name of the selected Set is now in bold.

6. Click OK to return to the Set tab dialog.

7. Click Apply Set Selection. This will change all graphics currently specified in the 
template.

A dialog box appears and asks you to confirm your selection of the Set. Click Yes.

8. Click OK to return to Globals.

If you make a graphics set the default for a particular template, the background graphic 
from that Set will automatically be applied by Site Builder to all Web pages created with 
that template. You can change or turn off the background graphic in the Colors tab dialog 
of Globals.

Selecting a Background Graphic for a Web Page
The global settings available to enhance the look of your Web pages include the option to 
add a background graphic. You can choose a graphic from the selection of GIFs shipped 
with Site Builder.

1. In the Contents pane, select the template you want to edit and click Globals ( ) on 
the toolbar.

2. Click Colors to open that tab dialog.

3. Click Use a background graphic.

If you have picked a graphics set from the Gallery and made it the default, the 
background graphic from this Set will automatically display in the Sample box and the 
path to the GIF will display in the File Name text box.

4. If you have not picked a graphics set, or want to select another graphic, do one of the 
following:

! Enter the path and file name of the graphic you want to use, or

! Click Browse to choose a repository and locate the file you want to use, or
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! Click Gallery and choose a graphic from the Backgrounds group of graphics.

5. Click OK.

You can use a background color instead of a graphic, if you want. See Setting Colors for a 
Web Page (page 6-198). You can also use a background color with a background graphic, 
if the graphic is transparent.

If you select a file from Content Server (step 4), you can click the Info button ( ) at 
any time to view the Content Information page for that file (if, say, you want to select 
another version of the file).

Other Web Page Settings
This section covers the following topics:

! Adding an Address to Your Web Page (page 6-200)

! Adding an E-Mail Address to Your Web Page (page 6-201)

! Adding Titles to a Web Page (page 6-201)

! Displaying Headers and Footers in a Web Page (page 6-202)

! Including Revision Information From Source Documents (page 6-203)

! Preserving Links to Embedded OLE Objects (page 6-203)

! Setting the Order of Navigation and Visual Aids in a Web Page (page 6-204)

! Skipping Single Hard Carriage Returns (page 6-205)

! Suppressing Footnotes and Endnotes in a Web Page (page 6-205)

! Adding Options to a Web Page (page 6-206)

! Suppressing Tables in a Web Page (page 6-206)

Adding an Address to Your Web Page
The global settings available to enhance the look of your Web page include the option to 
add an address to Web pages.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Address to open that tab dialog.

3. Under Address Lines, click Include Address. In the four text boxes, enter the 
information you want to display in your Web page. It will appear at the end of the 
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page. The address can contain any kind of information. For example, you might enter 
a copyright line here.

4. Click OK.

You can format the address by using Address (System), the special element that is 
automatically a part of every template in Site Builder. However, the address will always 
appear in italic because that is how browsers interpret the <ADDRESS> tag that Site 
Builder applies to this information. If you don’t want the address to appear in italic, you 
can apply the <P> tag, instead, to this content.

Adding an E-Mail Address to Your Web Page
The global settings available to enhance the look of Web pages include the option to add 
an email address.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Address to open that tab dialog.

3. Under Email Lines, click Include Email Address.

4. In the Email Prompt text box, enter the text you want to appear on the Web page to 
signify an email link.

5. In the Email Address text box, enter the complete email address you want to use.

6. Click OK.

You can format this email address by using Email (System), the special element that is 
automatically a part of every template in Site Builder.

Adding Titles to a Web Page
The global settings available to enhance the look of Web pages include the option to add 
titles. Site Builder lets you place the titles in both the title bar of the Web browser and the 
body of the Web page.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Titles to open that tab dialog.

3. Under Title Placement, click Place a title in the body of the Web pages.

If you also want to the title to appear in the title bar of your Web browser, click Place 
a Title in the title bar of the Web browser. When you create a frameset for a 
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publication, the frameset title, as set in the Frameset Properties dialog box, appears in 
the browser title bar.

4. Under Title Contents, click the appropriate check boxes to decide which components 
you want to use to create the title. Select any number of check boxes.

5. Site Builder combines the components you select into one title.

6. Under Document Component of Title (if you checked the appropriate box in step 4), 
decide whether you want the title to come from an element (click the appropriate radio 
buttons for the Title element or select an alternative element from the drop-down list) 
or from the Title entry in the Document Properties dialog box (click the last radio 
button).

7. Under Page Component of Title (if you checked the appropriate box in step 4), decide 
whether you want to use content derived from an element (select from the drop-down 
list) or type a title in the text box.

8. Under Page Numbering, select None or one of the numbering options available if you 
want to add this component to the title.

9. Click OK.

By default, the Title (System) element for a body page template consists of the document 
title. For a reference page template, it consists of the publication title plus the document 
title.

You can format the title by using Title (System), the special element that is automatically 
a part of every template you create in Site Builder.

Displaying Headers and Footers in a Web Page
The global settings available to enhance the look of your Web page include the option to 
place headers and footers in output pages. Site Builder does not automatically include 
headers and footers in Web pages, but you can display them, if you want.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Click Include headers in output if you want to include headers in the output pages.

4. Select Place on all pages or Place on first page only. You may want to choose the 
second option if you’re splitting a source document into several Web pages.
6-202 Content Publisher User Guide



Templates
5. Click Include footers in output if you want to include footers in output pages. Again, 
select Place on all pages or Place on first page only.

6. Click OK.

Including Revision Information From Source Documents
The global settings available to enhance the look of Web pages include the option to 
include revision information in output pages.

By default, if a source document contains text that has been inserted or deleted with 
revisions turned on, Site Builder will implement the revisions in the output Web page. 
That is, the Web page will look the same as if the revisions had been accepted in the 
source document before translation. You can, instead, display the revisions just as they are 
in the source document.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Click Include revision information from source documents.

4. Click OK.

Site Builder maps inserted text to underscore and deleted text to strike through. You can 
change this mapping, if you want. (See Changing Text Effects on page 6-129.)

Site Builder does not retain any colors associated with inserted or deleted text in the 
source documents.

Preserving Links to Embedded OLE Objects
The global settings available to enhance the look of Web pages include the option to 
preserve links to embedded OLE objects. This option is available only for OLE objects 
embedded in a Word or Excel source document.

If such a document contains an OLE object, Site Builder will create not only an output 
graphics file as a graphical representation of the object, but also a file for the linked object 
itself. It will then attempt to link the graphical representation of the object in the output 
Web page to that file. If that object-type is supported by the browser, clicking the graphic 
will display the object in its native format (assuming the appropriate application is 
installed on the user’s machine).

Example If you embed a portion of an Excel spreadsheet in a Word 97 document, Site 
Builder will turn the embedded object into a graphic in the Web page you create and also 
Content Publisher User Guide 6-203



Templates
create a .xls file for the linked object itself. Clicking the graphic will open the spreadsheet 
(.xls file) in its native format.

To preserve links to embedded OLE objects:

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Click the Preserve links to embedded OLE objects where possible.

4. Click OK.

The link will only be preserved if the program used to create the object supports OLE. The 
link will not work if your browser doesn’t support such links.

Setting the Order of Navigation and Visual Aids in a Web 
Page
The global settings available to enhance the look of Web pages include the option to set 
the order of navigation and visual aids in Web pages.

When you create a Web page, you may add navigation buttons bars or text bars, separators 
or rules, HTML or scripting code, and a regular or email address. Your source document 
will probably have a title and may also have headers and footers.

You can set the order of all of these for your Web page.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Layout to open that tab dialog.

All possible navigation and visual aids appear in the two Preview windows, including 
ones you may not be using. You can use a different order for the same aids at the top 
versus the bottom of the page. You can also change the alignment of the items.

3. In the Preview pane for Top of Page, select the navigation aid, separator, or rule that 
you want to move, and use the Reorder arrows to change its order in the sequence. Or 
select the navigation aid, separator, or rule, and with the mouse button held down, 
drag and drop the item to reposition it.

Note: You must be sure to embed the object in the source document, and not link it to its 
source. That is, in the source document itself, you must turn off the options “Float Over 
Text” and “Link to File” for the object. Also, in Site Builder, you must preserve links to 
embedded OLE objects.
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4. To change the alignment of the navigation or visual aid, select the item and with the 
mouse button held down, drag and drop the item so that it is flush left, centered, or 
flush right in the pane. The cursor changes as you drag the image, indicating the Left, 
Center, or Right alignment.

5. Do likewise in the Preview window for Bottom of Page, if you want to reorder items 
there, too.

6. Click OK.

Skipping Single Hard Carriage Returns
The global settings available to enhance the look of Web pages include the option to skip 
single hard carriage returns. This may be useful if your source document is in ASCII 
format.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Click the Skip single hard carriage returns check box.

4. Click OK.

Suppressing Footnotes and Endnotes in a Web Page
The global settings available to enhance the look of your Web page include your ability to 
control the display of footnotes and endnotes.

Site Builder automatically includes footnotes and endnotes in your Web pages. But you 
can suppress them, if you want. Site Builder also automatically places endnotes in their 
own page. You can change that, too.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Clear the Include footnotes and endnotes in output check box.

4. Click OK.

You should also ensure that any elements associated with footnotes and endnotes are not 
included in the body of your Web pages. Open Element Setup and check the status of any 
such elements in the Elements tab dialog.
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Adding Options to a Web Page
The global settings available to enhance the look of Web pages include the option to place 
headers and footers in output pages. You can also suppress footnotes and endnotes, if you 
want, as well as cross-references and tables.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar.

2. Click Options to open that tab dialog.

3. Click or clear each check box that applies.

4. Click OK.

Suppressing Tables in a Web Page
The global settings available to enhance the look of Web pages include the option to 
include or suppress tables. Site Builder automatically includes tables in Web pages. But 
you can suppress them, if you want.

1. In the Contents pane, select the template that you want to edit and click Globals ( ) 
on the toolbar to open that property sheet.

2. Click Options to open that tab dialog.

3. Clear the Include tables check box.

4. Click OK.

Tables in the source document will no longer appear in the Web page.

If the intent is to provide files that will display properly in those browsers that do not 
support tables, you will also need to turn off certain formatting options. That's because 
Site Builder uses tables to position certain graphical elements on a Web page. 
For example, the following will be affected if you suppress tables and are using such a 
browser:

! Any bulleted lists with graphical bullets

! Element button bars where the buttons are placed on the same line as the element.

! Icons that are set “away from content.”
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7.PREVIEWING WEB PAGES
This section covers the following topics:

! Viewing Web Pages (page 7-1)

! Setting Up a Viewer (page 7-2)

! Previewing Web pages (page 7-3)

! Installing Internet Explorer (page 7-3)

! Changing the Preview Document (page 7-4)

! Previewing a Source Document (page 7-4)

! Previewing in Netscape Navigator (page 7-5)

! Preview Fail (page 7-5)

VIEWING WEB PAGES
When you install Site Builder, the Installer searches for Microsoft Internet Explorer and 
Netscape Navigator on your machine and associates both browsers with the program. You 
can associate additional browsers with Site Builder and also utilities such as Notepad.

All viewers associated with Site Builder are available from the Viewers menu. You can 
also click the down arrow to the right of the default viewer name on the large toolbar to 
display a popup menu from which you can choose the viewer you want to use.

To view Web pages click Launch Viewer on the Viewers menu or click Viewer on the 
standard toolbar or large toolbar.
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To switch viewers, right-click the Viewer icon on the large toolbar and choose the viewer 
you want to use from the popup menu. (You can also choose Setup from the Viewers 
menu.)

If the viewer you want to use isn’t currently associated with Site Builder, choose Setup 
from the Viewers menu and add the viewer in the Viewers Setup dialog box.

If multiple output files are selected in the Contents pane, the default browser will display 
the first file selected. If no files are selected, the browser will display the first file listed. 
(To clear your selection of one or more pages, click the Contents pane below the list of 
files.)

If your Web publication has a frameset, it won’t matter what you select – the default 
browser will open all frames, with the main frame displaying the opening body page of 
your publication.

If your frameset specifies frames for a TOC or an index, and you haven’t added a TOC or 
index to your publication, the frameset will include an empty frame.

The Viewer button is based on the default viewer. The icon will change when you change 
the viewer.

SETTING UP A VIEWER
You can associate a new Web browser or other viewer with Site Builder at any time.

1. From the Viewers menu, choose Setup.

2. In the Viewers Setup dialog box, click Add to open the Viewer Properties dialog box.

3. In the File Name text box, enter the path and name of the executable of the Web 
browser or editor you want to associate with Site Builder, or click Browse to locate 
and select the executable file.

4. In the Description text box, enter the name or phrase you want to use as a label for the 
viewer. This will display on the Viewers menu, the large toolbar opposite the View 
button, and the popup menu that appears when you click the down arrow to the right 
of the default viewer name on the large toolbar.

5. Click OK to return to the Viewers Setup dialog box, and OK again to return to the 
main window.
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PREVIEWING WEB PAGES
You can preview the Web pages you create in the Choose Template, Edit Template, and 
Layout dialog box. The translations you see in the Preview windows are temporary. You 
must still return to the main window to translate a publication once you finish editing the 
templates in the publication.

To preview your Web pages, you must have Microsoft Internet Explorer version 4.0 or 
higher or Netscape Navigator version 6.01 or higher installed on your machine. If you 
have both browsers installed, you can toggle between them by using the IE and Netscape 
radio buttons at the top of each dialog box. (In the case of the Layout dialog box, the 
options are only available when you are in the Preview Mode.)

When you first add a document to a publication and choose a template in the Choose 
Template dialog box, the document has not yet been imported. As a result, the preview 
may not show the full effect of the selected template. This is especially so for styles such 
as Title, Heading 1, and Heading 2 (assuming you’re importing styles). When you click 
OK, styles (or patterns) will be imported from the document and you’ll return to the main 
window. If you then select the document and open the Edit Template dialog box, the 
preview you see now will give you a better idea of how your Web page will look once you 
translate the document.

INSTALLING INTERNET EXPLORER
For Content Publisher to talk to Content Server, Internet Explorer version 4.0 or higher 
must be installed on each machine on which either Site Builder or Site Server is installed. 
Internet Explorer is also required in order to display previews of your Web pages in Site 
Builder.

Note: If you install Netscape Navigator after you install Content Publisher, you will need 
to run the mini-installer RegisterNetscapeControl.exe to register a Netscape control. The 
mini-installer can be found in the Support folder of your Content Publisher product disc. 
(See Previewing in Netscape Navigator on page 7-5.)
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CHANGING THE PREVIEW DOCUMENT
The Change Preview dialog box lets you preview the effects of changes to a template for 
any source document the template is associated with. You can enter this dialog box from 
either the Edit Template dialog box or the Preview tab dialog on the Pattern Properties tab 
dialog.

1. From the list of source documents, select the document you want to preview instead.

2. Click OK.

If you are returning to the Edit Template dialog box, the document selected will appear in 
the Preview window. If you are returning to the Preview tab dialog in Pattern Properties in 
Element Setup, you will see the first instance of the pattern selected. The Preview 
window will be empty if the selected document contains no instances of the selected 
pattern.

PREVIEWING A SOURCE DOCUMENT
You can preview a document as it is being checked into Content Server to see how the 
document will look when converted into HTML format. You can do this for an individual 
document in your project or for a document that is part of a Directory Item.

For previews to be possible:

! At check-in, a source document that is to be part of a Directory Item must be assigned 
document information that will make the document part of the query used to create 
Directory Item

! The Directory Item must be “restricted” (see Creating a Restricted Directory Item in 
Content Server on page 5-29).

! The project must be registered on the content server that the document is being 
checked into (see Registering a Project to Preview a Source Document on page 8-76).

! Content Server must be configured for HTML previews and you must install 
DtmServer on any machine on which Site Server is installed. To learn more about 
configuring Content Server and installing DtmServer, see the DTM Server and HTML 
Preview Administration Guide.

In the case of an individual source document, previews at check-in will only be possible 
once the document has been added to the project and therefore been associated with a 
project template.
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PREVIEWING IN NETSCAPE NAVIGATOR
You can preview your Web pages in Netscape Navigator as well as Internet Explorer. 

The preview option is available in the Choose Template, Edit Template, and Layout dialog 
boxes. Two radio buttons – IE and Netscape -- let you toggle between the two browsers, 
assuming you have both browsers installed. The radio buttons are at the top of each dialog 
box. (In the case of the Layout tab dialog, they are visible only when you click the Preview 
Mode button.)

This preview capability is available only if you are running Netscape Navigator version 
6.01 or higher on your machine.

If you are running version 6.01, the Installer will recognize this version when you install 
Content Publisher and will automatically activate the Netscape radio button on these 
dialog boxes. 

If you install version 6.01 or higher after you install Content Publisher, you need to run a 
mini-Installer program to register a Netscape control that will activate the radio button to 
permit previewing in this browser. The mini-Installer, RegisterNetscapeControl.exe, is 
available in the Support folder on your Content Publisher product disc.

PREVIEW FAIL
Sometimes an error message displays when you try to preview a source document in the 
Preview window in the Edit Template dialog box or Choose Template dialog box.

Several reasons may explain why Site Builder is unable to complete a temporary 
translation of the source document in order to provide a preview. The source document 
may have been moved, its name may have been changed, the file may be corrupted, or the 
file may be in an unsupported format. A full translation of the file may help you identify 
the problem.

Do the following to determine why a preview has failed:

1. Click OK to return to the main window.

2. Choose Application Options from the View menu to open that dialog box.

3. Under Logging, be sure that logging is set to 5, the highest level.

4. Check the text box for the path and name of the log file you want to generate.
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5. Click OK.

6. In the main window, click Translate All on the toolbar.

Open the log file for information on why a specific file failed to translate.
7-6 Content Publisher User Guide



C h a p t e r

8.PUBLISHING THE SITE
This section covers the following topics:

! The Publishing Process (page 8-1)

! The Dual Publishing Model (page 8-2)

! Staging a Project (page 8-3)

! Workflow (page 8-12)

! Publishing a Project (page 8-14)

! Scheduling a Project for Publishing (page 8-22)

! Document Information (page 8-49)

! Publishing to a File System (page 8-54)

! Publishing to an FTP Server (page 8-60)

! Publishing to an HTTP Server (page 8-64)

! Publishing to Content Server (page 8-68)

THE PUBLISHING PROCESS
The publishing process involves translating source documents in a project and then 
copying those translated documents to a Web server (file system, FTP, HTTP, or Content 
Server).
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The publishing process consists of two distinct activities:

! Translating (see Translating Source Documents on page 5-41), which includes 
updating the Web publication (see Updating Source Documents in Content Server on 
page 8-70)

! Staging (copying the translated output to the staging server, see Stage Command on 
page 8-6) and publishing (copying the translated output to the publishing server, see 
Publish Command on page 8-15) the Web publication

For more information on staging and publishing in Content Publisher, visit The Dual 
Publishing Model on page 8-2.

Translating, staging, and publishing can all be automated using Site Scheduler and Site 
Server (see Automated Publishing in Site Server on page 8-25).

THE DUAL PUBLISHING MODEL
Content Publisher includes a two-part publishing system—staging and publishing. By 
staging your Web publication, you (or a content reviewer) can first preview the Web site 
before going “live” with it.

This dual publishing capability can be setup in the Staging/Publishing Options dialog box 
of Site Builder. Using this dialog box, you can designate a staging and publishing server. 
The staging and publishing server can be a file system, FTP, HTTP, or Content Server (but 
you must use the same type of destination for both staging and publishing).

Dual publishing facilitates a formal review process for your Web site. Typically, this can 
be done in the following steps:

! Designate a staging server (the preview location) and a publishing server (the final 
Web site) in the Site Builder Staging/Publishing Options dialog box (see Staging and 
Publishing Options on page 8-10).

! Specify the metadata that you would like associated with your Web pages, both on the 
staging server and the publishing server (see Specifying Document Information on 
page 8-49). You may also choose to inherit metadata from your source documents.

! Register your project on the staging server (see Registering a Project on a Staging 
Server on page 8-77) and create a staging criteria workflow for your content authors 
and content reviewers (see Workflow and Registration on page 8-12).

! Stage and publish the Web publication (see Stage Command on page 8-6 and Publish 
Command on page 8-15).
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STAGING A PROJECT
This section covers the following topics:

! Confirming Staging Options (page 8-3)

! Setting Staging Options (page 8-4)

! Staging a Project (page 8-5)

! Stage Command (page 8-6)

! Staging Options (page 8-6)

! Reviewing Outstanding Problem Reports (page 8-8)

! Unregistering a Project on a Staging Server (page 8-8)

! Update Versions Command (page 8-9)

! Updating a Linked Publication (page 8-10)

! Staging and Publishing Options (page 8-10)

! Setting Staging and Publishing Options for Graphics and Gallery Graphics 
(page 8-11)

! Incremental Publishing (page 8-11)

! Publishing With Errors (page 8-11)

! The Incremental Database (page 8-12)

Confirming Staging Options
Each time you Stage a project, the Confirm Staging Options dialog box will open, 
assuming you have set staging options:

! To accept the information, click OK and Site Builder publishes to the staging server. 
That is, it copies the translated output from the file system to Content Server, as 
specified in Staging Options.

! To change the information, click Cancel, and then return to the Staging Options 
dialog box to specify different options.

If you click Stage before specifying the locations, the Staging/Publishing Options dialog 
box will open so you can provide the required information.
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Each time you use the Stage command, Site Builder performs an incremental staging. It 
first creates new output files for any new source documents added to the project since the 
last time you staged. It then replaces, as necessary, previously staged files that have been 
updated since the last time you published. Finally, it deletes previously staged files for 
those source documents that are no longer part of the project.

Setting Staging Options
Staging is the process whereby Site Builder copies translated output from the file system 
to a staging location for review before the finally approved content is published to the 
publishing server (Web site).

You must set staging options in order to stage your project. If you are staging to Content 
Server, you must at least designate a staging server and specify document information.

Follow these steps to designate the staging server:

1. With your translated project open in Site Builder, click Staging Options on the Run 
menu to open the Staging/Publishing Options dialog box.

2. From the Repository drop-down list, select the type of location you want to stage to: 
Content Server, file system, FTP site, or HTTP site. 

3. Click the Browse button opposite Pages.

4. If you are staging to Content Server, the Staging Options dialog box will open. If you 
have configured more than one content server, click the Content Server button to 
open the Choose a Content Server dialog box, and select the content server you want 
to stage to. (If you have only one content server configured, it will already be 
selected.) Then see below for specifying document information.

5. If you are staging to the file system, the Select Publish Directory dialog box will open. 
Locate the directory you want to stage to, click Open, and then click OK.

6. If you are staging to an FTP or HTTP site, the Publish Destination dialog box will 
open. Complete the required information in the dialog box and click OK. (See 
Specifying Staging and Publishing Options for an FTP Site on page 8-61 and 
Specifying Staging and Publishing Options for an HTTP Site on page 8-65.)

If you are staging to Content Server, the same content server is now designated for all 
three types of output: pages, graphics, and Gallery graphics. You can use different content 
servers for the other two, if you want, though this is unlikely to be useful.

Part of your publication will consist of files for frames, reference pages, etc., that are 
generated by Site Builder during translation. Since these output pages can't inherit from 
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source documents, you must specify document information so that these files can be 
checked into the content server that is used for staging.

This document information will be used, by default, for body pages, too—unless you 
designate property values and security settings to be inherited from the source documents.

1. Once you have designated a content server, click the Document Information button 
to open that dialog box.

2. Change or complete the other fields to set the document information you want to 
associate with the staged output. This can include custom document information 
specific to an organization.

3. Click the Assign Info button to return to the Staging Options dialog box.

4. Click OK to return to the Staging/Publishing Options dialog box.

See Staging Options (page 8-6) for additional tasks you might want to perform in the 
Staging Options dialog box, such as registering the project to facilitate workflow.

Staging a Project
Staging is the process whereby Site Builder copies translated output from the file system 
to a staging server for review before the finally approved content is published to the 
publishing server (Web site).

You can, in fact, by-pass staging and go straight to publishing. But a review is advisable if 
only because there likely will be some features of your Web site that can be checked only 
once you have staged (or published) your project.

For example, staging offers you the first chance to check any Query reference pages or 
dynamic content in your project. It also provides an opportunity to inherit document 
information from source documents and place it in output Web pages and to check 
conditional disclosure for the first time.

Generally, it is wise to stage your project. If you choose to stage, you can do three things 
independently:

! Create staging criteria workflow

! Register the project and create “problem reports”

! Add a special icon to each Web page to provide direct access to the Content 
Information page.
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You can thus create problem reports without creating staging workflow—and workflow 
without problem reports. You can also stage without using either workflow or problem 
reports (or placing the special icon on output pages).

You will require sub admin rights to stage a project (use the Stage command).

Stage Command
Staging is the process whereby Site Builder copies translated output from the file system 
to a staging server for review before the finally approved content is published to the 
publishing server (Web site).

You must set staging options in order to stage your project. At a minimum, you must 
designate a staging server and specify document information.

Follow these steps to stage a project:

1. Click Stage on the Run menu or Stage on the standard or large toolbar.

2. The Confirm Staging Options dialog box opens, to ask you to confirm your options. 
To accept the information, click OK. Site Builder stages the project. To change any 
information, click Cancel and return to the Staging/Publishing Options dialog box.

If, when you click Stage, you haven't already specified the required information, the 
Staging/Publishing Options dialog box will open instead.

When you click OK, Site Builder copies all translated output from your file system to the 
staging server. If your Web publication includes Query reference pages, these will be 
active for the first time on the staging server. And if you have decided to create staging 
workflow (and have registered the project), workflow will begin as soon as the project is 
staged.

You will require sub admin rights to stage a project (use the Stage command).

It's always wise to update (and re-translate) your project before you stage. See Updating 
Source Documents in Content Server (page 8-70).

Staging Options
You must set staging options in order to stage your project. The staging options you set 
apply only to staged output. Once you have reviewed your staged Web publication and are 
ready to publish, you must set publishing options. (Although you set the options 
separately, you should generally set them the same way.)
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You set staging options by completing the following tasks. The first two are required:

! Identify the staging server, that is, the content server you want to use to stage your 
translated output

! Specify document information to be used, by default, for all output Web pages so that 
your output can be checked into the staging server (required, even if you choose to 
inherit properties from source documents, to ensure that those pages that do not 
originate in the source server are assigned document information)

! Specify properties you want your body pages to inherit from their source documents 
instead of using the default document information (see Inheriting Document 
Information From Source on page 8-50). (This is optional.)

The document information you specify is default information that will be used for all 
output pages, in particular, files for frames, TOCs, etc., that are built by Site Builder and 
do not have their origin in Content Server. If you specify property values and security 
settings that you want your body pages to inherit from their source documents, the 
inherited values will prevail for all body pages.

Example: If the name of Author A is inherited from a source document and the name of 
Author B is specified for the output pages generated from that source document, only the 
name of Author A will be retained by Content Server.

! Register the project on the staging server to facilitate workflow (see Registering a 
Project on a Staging Server on page 8-77). (This is optional.)

! Suppress placement of the special Info icon on output Web pages (see Suppressing the 
Info Icon on Web Pages on page 8-72). (This is optional.)

! Generate document names from file names (optional) if you would like to publish to 
the content server without a unique suffix (see Publishing to the Content Server 
Without a Unique Suffix on page 8-81). When this option is selected, only the file 
name, with its prefixes (if added), is published to the staging server. This is used most 
often when adding a prefix to output file names to help generate predictable file names 
(see Adding a Prefix to Output File Names on page 8-79).

! Set check-in file extensions if you would like to check in files with an extension other 
than the default hcsp extension when you publish to the staging server (see Setting 
Check-In File Extensions on page 8-82). (This is optional.)
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Reviewing Outstanding Problem Reports
When you try to publish a project in Site Builder when there are still some open staging 
workflow (some documents in staging workflow have not been approved) and/or 
outstanding problem reports, the Publish Warnings dialog box opens to alert you. You can 
click Yes to publish anyway, and might want to do so if you know that the workflow and 
problem reports are insignificant.

In most instances, you will want to review the workflow and problem reports.

Follow these steps to review open problem reports:

1. Click the appropriate More Info button in the Publish Warnings dialog box to open the 
Open Problem Reports dialog box. This dialog box lists all the problem reports 
outstanding for the project you want to publish.

2. Double-click any problem report to open the Problem Report Information dialog box 
for that problem report.

The Problem Report Information dialog box provides a complete summary of the 
problem report, including the original message compiled by a reviewer to summarize 
the problem.

3. Click OK when you have reviewed the information.

Unregistering a Project on a Staging Server
Once you register a project, you have to be careful about unregistering it. If you decide to 
unregister a project -- that is, clear the Register the Project check box in Staging options -- 
the following warning will appear:

Figure 8-1 Registration warning

There may be an advantage to unregistering a project if you simply want to start again 
from scratch. However, if your goal is the temporary one of staging your project without 
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triggering workflow, the better solution would be to disable all criteria workflow 
associated with the project. (The special Content Information page will still be created, but 
you can simply ignore the problem report section if you don't want to use it.)

Update Versions Command
The Update Versions command is used to update source documents before translation. 
You don't need to use it each time you translate, but you will want to be sure to update 
your project at critical times, especially before staging and publishing.

Except for single source documents on the file system, the command is required to update 
Directory Items (including dynamic Directory Items), and source documents from Content 
Server, or from an FTP or HTTP site. If your project contains single source files on the file 
system (those not part of a Directory Item), Site Builder recognizes when any of these 
have changed and automatically includes the revised files in the next incremental 
translation.

Site Builder doesn’t check documents out of Content Server. Rather, it identifies the 
version current during project setup and obtains a copy of that version for all translations. 
Update Versions identifies the latest version of a document available so that Site Builder 
can use that for your final translation before publishing to a content server. (See Updating 
Source Documents in Content Server on page 8-70.)

By default, the Update Versions dialog box displays when you first click Update 
Versions on the standard toolbar ( ) or on the Run menu.

Figure 8-2 Update Versions dialog box

Click Yes, always update before translating and Don't show this dialog box again to 
automate the command in Site Builder. In that event, Site Builder will automatically run 
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the Update Versions command each time you translate. If you prefer, you can choose to 
update manually each time by clicking No, I will manually update when required.

The Update Versions command also applies to linked templates (after the template has 
been brought into a project and edited) In the Manage Templates dialog box, you can 
select the linked template and click the Update Versions button. Alternatively, in the 
Content pane, you can right-click a document associated with the linked template and 
select Update Versions and then Templates (or Document and Templates) from the 
popup menu. 

You can update source documents selectively in Site Builder by right-clicking a 
publication in the Publication Hierarchy pane and choosing Update Versions from the 
popup menu, or right-clicking a Directory Item or document in the Contents pane and 
choosing Update Versions and then Documents from the popup menu.

Site Server automatically updates all source documents for projects that have been 
scheduled for translation on the server. 

If you have selected Don't show this dialog again, you can always display dialog box 
again by opening the Applications dialog box (from the View menu) and selecting the 

Show the Update Versions dialog box before translating on the Dialogs tab dialog.

Updating a Linked Publication
A linked publication cannot be changed from within a master project. It must be opened 
separately, by itself, in Site Builder, and the Update Versions command used to update the 
contents of the project.

Once the linked publication is updated, you must then use the Update Versions Command 
(page 8-9) the next time you open the master project for changes in the linked publication 
to be reflected in the master project.

Staging and Publishing Options
In the Staging/Publishing Options dialog box you can set both staging and publishing 
options for your project.

You can use staging options without publishing options, and publishing options without 
staging options. Typically, however, you will first want to stage your project so that you 
can review your Web publication before publishing it—that is, going live to your Web 
site.
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Setting Staging and Publishing Options for 
Graphics and Gallery Graphics
When you set staging or publishing options for a project, you can assign unique locations 
and document information for your pages, graphics, and Gallery graphics. Generally, you 
will choose the same location and document information for all three types of Web output.

See Setting Staging Options (page 8-4) and Setting Publishing Options (page 8-19) for 
more information

Incremental Publishing
Content Publisher publishes incrementally. Say you have already published and decide to 
update source documents and therefore the translated output in the staging area. When you 
retranslate and click Publish, Site Builder will copy only the revised output files from the 
staging area to the location designated for published output. It will preserve the original 
document IDs in the process.

If you publish to another instance of Content Server, your output will be totally 
republished and new document IDs will be created.

The Update Versions, Translate, and Publish commands work differently when you 
schedule a publication for translation by Site Server.

Publishing With Errors
The Publish with Errors setting in the Project Options dialog box allows you to publish 
with errors even when Site Builder encounters problems during translation. The option is 
turned off by default.

The option is designed especially for situations where a file in an unsupported format 
inadvertently has been added to a Directory Item. With this check box selected, Site 
Builder will simply skip this file and complete the translation and publishing process as if 
the file wasn’t in the Directory Item at all. (Its failure to translate the file will be noted in 
the Log file.)

To publish with errors:

1. Click Project Options on the View menu to open that dialog box.

2. In the General tab dialog, under Publish with Errors, select the Allow publishing even 
if errors occurred during translation check box.
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3. Click OK.

The option is particularly useful with Site Server, where the Update Versions, Translate, 
and Publish commands are handled automatically.

The Incremental Database
The incremental database is a series of temporary files created by Site Builder that are 
used to track promotion data, file dates, etc., so as to allow incremental translations to take 
place.

When you create a project and initially translate it, Site Builder creates a subdirectory and 
places temporary files in the subdirectory that summarize information about the 
timestamps in the project.

Site Builder updates the database each time you change the promotion data by creating 
new temporary files. Should you delete these temporary files, Site Builder will simply run 
a full translation (even if you choose an incremental one) and create new temporary files.

When you close your project, Site Builder incorporates the incremental database 
information into the history file. Thus, if you move the project file and history file to 
another machine, Site Builder does not have to (and does not) run a full translation the 
next time you translate.

WORKFLOW
This section covers the following topics:

! Workflow and Registration (page 8-12)

! Reviewing Open Staging Workflow (page 8-14)

Workflow and Registration
“Workflow” is the process whereby content is created and reviewed before the approved 
version is released to a specified audience. “Registration” is the process of registering a 
project with a content server to facilitate certain tasks.
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Workflow
You can set up workflow on two different content servers, for two different purposes:

! On the source server, workflow known as “contributor criteria workflow” is set up to 
facilitate the review and approval of source documents for publication. This workflow 
focuses on content.

! On the staging server, workflow known as “staging criteria workflow” is set up to 
facilitate the review and approval of the output Web pages created from these source 
documents. This workflow focuses on the look and feel of the Web pages (content 
also may be addressed).

Registration
You register a project with a content server to facilitate certain tasks.

! You register a project on a source server in order to facilitate a “preview” of how a 
source document will look once translated and turned into a Web page (see 
Registering a Project to Preview a Source Document on page 8-76).

! You register a project on a staging server to enable staging workflow and to facilitate 
the creation of “problem reports” for the entire Web output created when your project 
is staged (see Registering a Project on a Staging Server on page 8-77).

Workflow and registration can be used in the publishing process as follows (the shaded 
areas represent tasks you perform in Site Builder).

On the source server On the staging server

Workflow Use contributor criteria 
workflow for the review and 
approval of source documents

Use staging criteria workflow 
for the review and approval of 
output Web pages

Registration Register a project to enable 
“previews” of source 
documents in HTML format

Register a project to enable 
staging workflow and to create 
a special version of the Content 
Information page that includes 
a “problem report”
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Reviewing Open Staging Workflow
When you try to publish a project in Site Builder when there are still some open staging 
workflow (some documents in staging workflow have not been approved) and/or 
outstanding problem reports, the Publish Warning dialog box opens to alert you. You can 
click Yes to publish anyway, and might want to do so if you know that the workflow and 
problem reports are insignificant.

In most instances, you will want to review the workflow and problem reports.

To review the status of a open staging workflow

1. Click the appropriate More Info button in the Publish Warnings dialog box to open 
the Documents in Workflow dialog box.

2. This dialog box provides a complete summary of all Web pages in all open staging 
workflows for the project.

3. Right-click any entry to jump to the Workflow Step Information page, where you can 
view a complete status of the Web page in question, including its current step in the 
workflow process.

PUBLISHING A PROJECT
This section covers the following topics:

! Overriding Publish Warnings for Site Server (page 8-15)

! Publish Command (page 8-15)

! Publishing Notes (page 8-16)

! Publish Warnings (page 8-16)

! Publishing a Project (page 8-17)

! Publishing Options (page 8-18)

! Setting Publishing Options (page 8-19)

! Confirming Publishing Options (page 8-21)

! Overriding Staging and Publishing Options (page 8-21)
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Overriding Publish Warnings for Site Server
When you create a project in Site Builder, the Publish Warnings dialog will open when 
you try to publish if there are staging criteria workflow open and/or problem reports 
outstanding. You can click Yes to publish anyway, and may want to do so because the 
workflow and problem reports are insignificant.

If you plan to schedule the project for publishing on Site Server and also want to ignore 
open workflow and outstanding problem reports, you must formally choose to do so 
before the scheduled project runs.

To override publish warnings in Site Server:

1. On the Publishing Options tab dialog of the Staging/Publishing Options dialog box, 
click the Details button to open that dialog box.

2. Select the Ignore problem reports on staging documents and Ignore staging 
documents still in workflow check boxes, as appropriate.

3. Click OK to return to the Staging/Publishing Options tab dialog.

You may also choose to publish with errors (see Publishing With Errors on page 8-11). 
This would allow you to complete the translation of a project on Site Server where, for 
example, a file in an unsupported format has inadvertently been added to a Directory Item 
in the project.

Publish Command
Publishing is the process whereby Site Builder copies translated output from the file 
system to a publishing server (the Web site).

You must set publishing options in order to publish your project. At a minimum, you must 
designate a publishing server and specify document information.

To publish a project, click Publish on the Run menu or Publish ( ) on the standard 
toolbar.

The Confirm Publishing Options dialog box opens, to ask you to confirm your options. 
To accept the information, click OK. Site Builder publishes the project. To change any 
information, click Cancel and return to the Staging/Publishing Options dialog box.

When you click OK, Site Builder copies all translated output from your file system to the 
publishing server.

If, when you click Publish, you haven't already specified the required information, the 
Staging/Publishing Options dialog box will open instead.
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It's always wise to update (and re-translate) your project before you stage and publish it 
for the last time. See Updating source documents.

You shouldn't be updating between staging and publishing, because if something has 
changed, you probably want to translate your Web publication one more time and also 
stage it again before finally publishing.

Publishing Notes
Publishing is the process whereby Site Builder copies translated output from the file 
system to a publishing server. See Publishing a Project (page 8-17) for more information. 
Here are some notes to consider when publishing.

! The expiration date on a staged or published file governs the expiration date of a Web 
page. That date is either the date inherited from the source document used to create the 
Web page (see Inheriting Document Information From Source on page 8-50) or the 
date used when you specified document information (see Setting Staging Options on 
page 8-4 and Setting Publishing Options on page 8-19).

! Check-in of a Web page on the staging or publishing server will fail if the expiration 
date is earlier than the release date. The release date is either the date inherited from 
the source document or the one applied when you specified document information.

! Site Builder stages and publishes incrementally. Say you have already staged or 
published and decide to update source documents and therefore the translated output. 
When you re-translate your project and then stage or publish again, Site Builder will 
copy only the revised output files to the location designated for staged or published 
output. It will preserve the original Content IDs in the process.

! The Update Versions, Translate, Stage, and Publish commands work differently when 
you schedule a publication for translation by Site Server. See Site Scheduler 
(page 8-38).

Publish Warnings
If when you finally try to publish a staged project and either staging workflow is not 
complete or at least one problem report is outstanding, the Publish Warnings dialog box 
will open.
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Figure 8-3 Publish warnings dialog box

Both bulleted items display if a staging criteria workflow is incomplete (one or more Web 
pages in a workflow has not been approved) and there is at least one outstanding problem 
report (one with a State other than Closed). If only one applies, only the appropriate 
bulleted item will appear in the dialog box.

You can click Yes to publish if you already know that the open workflow or outstanding 
problem reports are not significant.

Instead, you may want to Reviewing Open Staging Workflow (page 8-14) or Reviewing 
Outstanding Problem Reports (page 8-8).

Publishing a Project
Publishing is the process whereby Site Builder copies translated output from the file 
system to a publishing server (your Web site).

Typically, you will have staged before you publish, in order to review your Web 
publication before going “live” to your Web site. Publishing isn't very different from 
staging. In fact, you could, if you like, “stage” directly to your Web site. As long as you 
suppress the Information icon on the output Web pages, you will end up with the same 
results as you would if you had published directly to your publishing server. However, you 
shouldn't “stage” to a publishing server if you have already staged to a staging server.

So setting publishing options is very similar to setting staging options. But remember: If 
you set both staging and publishing options, but only publish—don't first stage—your 

Note: Because staging workflow and problem reports are independent of each other, there 
is not necessarily a relationship between open staging workflow and outstanding problem 
reports.
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project, then you may receive a warning in the log file: “The publish operation cannot 
obtain inherited values.” This signifies that the most current metadata will not be inherited 
from the source and published to your site. Instead, Site Builder will inherit the metadata 
from your latest staged output, if available. (This applies only to users who have chosen to 
inherit property values and security settings from source documents.)

Publishing Options
You must set publishing options in order to publish your project. If you have already set 
staging options, these apply only to staged output. Once you have reviewed your staged 
Web publication and are ready to publish, you must set publishing options for your Web 
output.

Tasks in Setting Publishing Options
You set publishing options by completing the following tasks. The first two, identifying 
the publishing server and specifying document information, are required:

! Identify the publishing server, that is, the content server you want to use to publish 
your translated output (required)

! Specify document information to be used, by default, for all output Web pages so that 
your output can be checked into the publishing server (required, even if you choose to 
inherit properties from source documents, to ensure that those pages that do not 
originate in the source server are assigned document information)

! Specify properties you want your body pages to inherit from their source documents 
instead of using the default document information (see Inheriting Document 
Information From Source on page 8-50). (This is optional.)

Note: Although you set staging and publishing options separately, you should generally 
set them the same way. The essential difference is that you cannot register the project on 
the publishing server or place the Information icon on output pages.

Note: Although you set the options separately, you should generally set them the same 
way. 

Note: The document information you specify is default information that will be used for 
all output pages, in particular, files for frames, TOCs, etc., that are built by Site Builder 
and do not have their origin in the source server. If you specify property values and 
security settings that you want your body pages to inherit from their source documents, the 
inherited values will prevail for all body pages. 
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Example
If the name of Author A is inherited from a source document and the name of Author B is 
specified for the output pages generated from that source document, only the name of 
Author A will be retained by Content Server.

! Generate document names from file names (optional) if you would like to publish to 
the content server without a unique suffix (see Publishing to the Content Server 
Without a Unique Suffix on page 8-81). When this option is selected, only the file 
name, with its prefixes (if added), is published to the content server. This is used most 
often when adding a prefix to output file names to help generate predictable file names 
(see Adding a Prefix to Output File Names on page 8-79).

! Set check-in file extensions if you would like to check in files with an extension other 
than the default hcsp extension when you publish to the content server (see Setting 
Check-In File Extensions on page 8-82). (This is optional.)

Setting Publishing Options
Publishing is the process whereby Site Builder copies translated output from the file 
system to a publishing server (the Web site).

You must set publishing options in order to publish your project. If you are publishing to 
Content Server, you must at least designate a publishing server and specify document 
information.

1. With your translated project open in Site Builder, click Publishing Options on the 
Run menu to open the Staging/Publishing Options dialog box.

2. From the Repository drop-down list, select the type of location you want to stage to: 
Content Server, file system, FTP site, or HTTP site. 

3. Click the Browse button opposite Pages.

4. If you are publishing to Content Server, the Publishing Options dialog box will open. 
If you have configured more than one content server, click the Content Server button 
to open the Choose a Content Server dialog box, and select the content server you 
want to publish to. (If you have only one content server configured, it will already be 
selected.) Then see below for specifying document information.

Note: Although you set staging and publishing options separately, you should generally 
set them the same way. The essential difference is that you cannot register the project on 
the publishing server or place the Information icon on output pages. If you are going to 
stage your project, see Setting Staging Options on page 8-4.
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5. If you are publishing to the file system, the Select Publish Directory dialog box will 
open. Locate the directory you want to publish to, click Open, and then click OK.

6. If you are publishing to an FTP or HTTP site, the Publish Destination dialog box will 
open. Complete the required information in the dialog box and click OK. (See 
Specifying Staging and Publishing Options for an FTP Site on page 8-61 and 
Specifying Staging and Publishing Options for an HTTP Site on page 8-65.) With 
your translated project open in Site Builder, click Publishing Options on the Run 
menu to open the Staging/Publishing Options dialog box.

If you are publishing to Content Server, the same content server is now designated for all 
three types of output: pages, graphics, and Gallery graphics. You can use different content 
servers for the other two, if you want, though this is unlikely to be useful.

Follow these steps to specify document information:

Part of your publication will consist of files for frames, reference pages, etc., that are 
generated by Site Builder during translation. Since these output pages can't inherit from 
source documents, you must specify document information so that these files can be 
checked into the content server that is used for publishing.

This document information will be used, by default, for body pages, too, unless you 
designate property values and security settings to be inherited from the source documents.

1. Click the Document Information button to open that dialog box.

2. Change or complete the other fields to set the document information you want to 
associate with the published output. This can include custom document information 
specific to an organization.

3. Click the Assign Info button to return to the Publishing Options dialog box.

4. Click OK to return to the Staging/Publishing Options dialog box.

5. Click Details to open that dialog box. If you are planning to schedule the project on 
Site Server and want the server to ignore outstanding problem reports and staging 
documents still in workflow, select both check boxes.

6. Click OK to return to the Staging/Publishing Options dialog box.

You should not update between staging and publishing, because if something has changed, 
you probably want to translate your Web publication one more time and also stage it again 
before finally publishing.

See Publishing Options (page 8-18) for additional tasks you might want to perform in the 
Publishing Options dialog box, such as registering the project to facilitate workflow.
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Confirming Publishing Options
Each time you Publish a project, the Confirm Publishing Options dialog box opens, 
assuming you have set staging or publishing options:

! To accept the information, click OK and Site Builder publishes to the repository. That 
is, it copies the translated output from the file system to Content Server, as specified in 
Publishing Options.

! To change the information, click Cancel, and then return to the Publishing Options 
dialog box to specify different options.

If you click Publish before specifying the locations, the Staging/Publishing Options dialog 
box opens so you can provide the required information.

Each time you use the Publish command, Site Builder performs an incremental publish. It 
first creates new output files for any new source documents added to the project since the 
last time you published. It then replaces, as necessary, previously published files that have 
been updated since the last time you published. Finally, it deletes previously published 
files for those source documents that are no longer part of the project.

Overriding Staging and Publishing Options
When you complete staging or publishing options for a project, you are treating all of your 
publication the same way for the output location selected. That is, the same property 
values and security settings (whether specified or inherited) will be applied to all output 
pages and graphics for a given output location.

If you prefer, you can fine-tune your Web publication by specifying different property 
values and security settings for individual subpublications or documents in your project. 
This is only possible after you have completed staging or publishing options.

1. Right-click a subpublication in the Publication Hierarchy pane or a source document 
in the Contents pane and choose Properties from the popup menu. The Publication or 
Document Properties dialog box opens.

The dialog box now has a Publish Options tab, which displays only if you have 
already specified output locations (in the Staging Options or Publishing Options 
dialog box).

2. Click Publishing Options to open that tab dialog.

You have two sets of options: pages and graphics. Within each, you have the 
opportunity to edit property values and security settings that will override those set for 
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the publication as a whole in Staging or Publishing Options. (In each case, the Clear 
button will simply clear whatever property values or security settings have been 
entered. In that event, the values and settings will revert to whatever is set at the next 
highest level in the hierarchy.)

The <No Overrides> entries signify that no property values or security settings have 
been specified for this subpublication or source document (those set in Staging or 
Publishing Options for the Web publication are to be used).

3. Under Pages, click the Edit button opposite Properties to open the Publishing Options 
dialog box.

This is the same dialog box you saw when you first set staging options (except that you 
cannot change the content server and the option to register the project is not available).

Now you can set property values and security settings for the selected subpublication or 
document that will override those values set for publication as a whole.

Publish options set for a subpublication or source document override options set at a 
higher level in the hierarchy. Typically, this means they override options set in the Staging 
or Publishing Options dialog box for the publication as a whole. You could set options for 
a subpublication that are different from the project options, and then set options differently 
for a source document within that subpublication.

Although the Publish Options tab is available for the root publication (as well as all 
subpublications and source documents), you should ignore it (except for linked 
publications). You must always use the Publish Options dialog box to set publish options 
for the publication as a whole.

Gallery graphics are dealt with only at the project level.

SCHEDULING A PROJECT FOR PUBLISHING
This section covers the following topics:

! Enabling DCOM (page 8-23)

! Site Server Topics (page 8-24)

! Scheduling a Task (page 8-37)
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Enabling DCOM
When connecting Site Scheduler to Site Server, you may need to run DCOM 
Configuration in order to enable DCOM, and also to set access and launch permissions for 
each user so that you can control the list of users who will be allowed to launch the server.

To ensure that remote DCOM is installed and enabled on both the Site Scheduler and Site 
Server machines, you need to run DCOM Configuration on each machine to check the 
settings.

On Windows XP

1. From the Start menu, click Settings, and then Control Panel.

2. Switch to the Classic View, if necessary. Double-click Administrative Tools, and 
then double-click Component Services.

3. In the Computers folder of the console tree of the Component Services 
administrative tool, right-click the computer for which you want to disable or enable 
DCOM, and then click Properties.

4. Click the Default Properties tab. Select the Enable Distributed COM on this 
Computer check box.

5. Click OK to close the dialog box.

On Windows 2000

1. From the Start menu, click Run. In the Open text box type dcomcnfg, and click Yes 
to open the Distributed COM Configuration Properties dialog box.

If you previously installed Site Builder on the machine, a DCOM Configuration 
Warning dialog box may appear. Click Yes to record the Registry entries mentioned in 
the Warning.

2. In the Distributed COM Configuration Properties dialog box, click Default 
Properties to open that tab dialog. Select the Enable Distributed COM on this 
computer check box.

3. Click OK to close the dialog box.
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Site Server Topics
This section covers the following topics:

! Site Server (page 8-24)

! Automated Publishing in Site Server (page 8-25)

! Changing the Server Setup (page 8-26)

! Automatically Running Pre-7.2 Projects in Site Server (page 8-26)

! Registering a Username and Password for Site Server (page 8-27)

! Running Site Server (page 8-28)

! Scheduling Projects From Previous Versions on Site Server (page 8-29)

! Setting Up Site Server as a Service (page 8-29)

! Starting and Stopping Site Server (page 8-31)

! Connecting to Site Server (page 8-32)

! Disconnecting from Site Server (page 8-33)

! Pause Publishing in Site Server (page 8-33)

! Running Multiple Projects in Site Server (page 8-34)

! Sending an E-Mail Notification for a Task (page 8-35)

Site Server
The installation and setup of Site Server is discussed in the Installation & Configuration 
Guide (see Installation & Configuration Guide.pdf in the Documentation folder of your 
installed directory and also the Content Publisher product disc).

Here are some important points to note:

! Once you connect to Site Server, Site Server continues to run in the background, even 
if you exit Site Scheduler, as long as the Site Server host computer is still running.

! When running Site Server on Windows 2000 as an OLE Automation server, the Site 
Server icon ( ) displays at the bottom right of your screen, on the Windows taskbar. 
You can exit Site Server at any time by right-clicking this icon and choosing Stop Site 
Server from the popup menu.

! If you right-click the logo and choose Properties, you will open the Site Server 
Properties dialog box. On the Options tab dialog you can set logging information for 
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the Site Server log file. This log file is different from the ones you create in Site 
Scheduler. (See Setting Up the Server Log File on Site Server (page A-8) for more 
information.)

! When running Site Server as a Service, you start and stop Site Server from the Control 
Panel (the Services window in Windows 2000). Double-click the Site Server icon in 
the Control Panel to open the Site Server Properties dialog box. Then click the Start or 
Stop button on the Control tab.

! To set logging information for Site Server as a Service, open the Windows Control 
Panel and double-click the Site Server icon to open the Site Server Properties dialog 
box, and then open the Options tab dialog.

Automated Publishing in Site Server
Site Builder can be used to create projects and publications, add source documents, 
manage templates, and ultimately publish the Web publication to a repository.

Site Server extends the power of Site Builder by automating the publishing process below:

! update source documents at run-time
(Update Versions command), 

! translate source documents
(Translate command)

! copy the translated output to the staging server
(Stage command)

! copy the translated output to the publishing server
(Publish command)

You don't, in fact, select Update Versions in Site Scheduler, because the project is 
automatically updated when it runs in Site Server. Typically, you will schedule a project to 
Translate or to Translate and Stage.

You would schedule a separate task to Publish the project. If you have full confidence in 
your Web output, you may choose to bypass staging altogether, in which case you would 
use the Translate–Publish sequence. (Of course, staging and publishing options must be 
set before you can stage or publish a project.)

If you’re still in the process of creating a project, and it isn't ready to be staged or 
published yet, you may prefer to simply update and translate.
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Changing the Server Setup
When you install Site Server, you are given the option to run the server as an OLE 
Automation server or as a Service. You can change the server setup after installation, if 
you want. You do this by typing the appropriate command line on the path (otherwise, the 
full path is required).

To register Site Server as a Service:
TCServer -Service

To register Site Server as an OLE Automation server set up to run as a remote server:
TCServer -Automation

To unregister Site Server at any time:
TCServer -Unregister

If you decide to register Site Server as a Service, you must then set up the user account. 
See Setting Up Site Server as a Service (page 8-29).

Automatically Running Pre-7.2 Projects in Site Server
Like Site Builder, Site Server will automatically translate 7.2, 7.5, and 7.6 projects; 
however, it will not automatically translate pre-7.2 projects. If you plan to schedule pre-
7.2 projects for translation on Site Server, you have two options:

! Open the pre-7.2 project files in Site Builder and save them to the 10gR3 format and 
then schedule them for translation by Site Server.

! Change a setting in the Site Server Properties dialog box so that the server will 
automatically convert all scheduled pre-7.2 projects to the 10gR3 format before 
translating them. Since Site Server simply converts an existing file to the 10gR3 
format (and does not preserve a copy of the pre-7.2 version), this switch is off by 
default.

Follow these steps to automatically schedule pre-7.2 projects in Site Server:

1. Open the Properties dialog box for Site Server.

Depending on your setup, you can open the dialog box either from the Control Panel 
or by right-clicking the Site Server icon on the taskbar (with Site Server running) and 
choosing Properties.

2. On the Options tab dialog, select the Update old project files to the current format 
check box.
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Project files in the pre-7.2 format will be automatically updated by Site Server to the 
10gR3 format and will be translated at the scheduled time. A copy of the old pre-7.2 
project file will not be retained.

Registering a Username and Password for Site Server
Each machine on which Site Server is installed requires a username and password in order 
for Site Server to access Content Server. System administrators can use password 
encryption to configure the machines on which Site Server is installed, using the utility 
PswdCfg.exe, which is available in the Support folder of the Content Publisher product 
disc.

Typically, the system administrator will want to encrypt passwords during the setup of 
Site Server. In that event, before running the utility the system administrator should first 
register the names of all content servers that Site Server will require access to. You can 
register only one content server during installation. However, you can register additional 
content servers after installation. (See Registering a Content Server by Running the 
Mini-Installer on page 8-74.)

Follow these steps to encrypt a password:

1. Double-click PswdCfg.exe in the \Resources\en folder of your Content Publisher 
installation directory to run the encryption utility. The Access Configuration dialog 
box opens.

Figure 8-4 Access configuration dialog
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2. Select the name of the first content server you want to configure.

3. Under Authentication Credentials, provide the user name and password (twice), as 
required. 

4. Click Update. The following dialog box will appear, to confirm that the username and 
encrypted password have been successfully registered.

Figure 8-5 Access dialog box

5. Select each additional content server, in turn, that you want to configure, and repeat 
steps 3 and 4.

6. When you have configured all the content servers necessary for the machine on which 
Site Builder is installed, click the Close button to the right of the title bar.

7. Follow the above steps to configure additional machines on which Site Server is 
installed.

You can run PswdCfg.exe at any time to configure additional content servers you may 
register later.

You can run PswdCfg.exe at any time to change an encrypted password. If for some 
reason you no longer want a password to be encrypted, you will have to remove the 
registry entry manually from the Registry and create a new entry.

Running Site Server
You can install Site Server on a Windows 2000 or XP machine, either as 

! an OLE Automation server, or

! a Service

No additional configuration is necessary with the OLE Automation option. The Service 
option, which affords the most flexible setup, requires additional configuration after 
installation. See Setting Up Site Server as a Service (page 8-29).

Whichever option you choose during installation, you can easily switch later to the other 
option by using a command line in DOS. See Changing the Server Setup (page 8-26).
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Whichever option you choose, you still need to register the username and password of 
someone who has access to Content Server. See Registering a Username and Password for 
Site Server (page 8-27).

If you choose Service, you still have to ensure that Site Builder can connect to Site Server. 
You use Site Scheduler, a utility installed with Site Builder, to do this. Connecting to Site 
Server isn’t a problem if you install Site Builder and Site Server on the same machine. But 
you are most likely to install Site Server on a dedicated server. See Connecting to Site 
Server (page 8-32).

Scheduling Projects From Previous Versions on Site 
Server
Site Server 10gR3 will automatically translate 7.2, 7.5, and 7.6 project files.

However, Site Server will not translate pre-7.2 projects. If you plan to schedule pre-7.2 
projects for translation on Site Server, you can

! Open the pre-7.2 project files in Site Builder and save them in the 10gR3 format, and 
then schedule them for translation by Site Server, or

! Change a setting in the Site Server Properties dialog box so that the server will 
automatically convert all scheduled pre-7.2 projects to the 10gR3 format before 
translating them. Since Site Server simply converts the existing file to the 10gR3 
format (and does not preserve a copy of the pre-7.2 version), this switch is off by 
default. See Automatically Running Pre-7.2 Projects in Site Server (page 8-26).

Setting Up Site Server as a Service
To run Site Server as a Service, you must create a user account for a user with full network 
access, such as the network domain administrator. Once the user account is set up, Site 
Server will be able to handle the translation of any project scheduled for translation from 
any workstation in the network.

When you set up a user account, you can accept the default system account or specify your 
own account and password. The preferred option is to specify your own user account and 
password so that you can specify the account’s network access privileges and rights. You 
can thus ensure that Site Scheduler and Site Server work together successfully and that 
Site Server can access all the files it needs to at any time in order to process the tasks 
scheduled.
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Follow these steps to specify a user account and password in Windows 2000:

1. On the Start menu, click Settings, Control Panel, Administrative Tools, and then 
Services.

2. In the Services dialog box, right-click Site Server, and then click Properties on the 
popup menu to open the Site Server Properties dialog box. 

3. On the General tab dialog, select Automatic from the Startup Type drop-down list. 

4. Click Log On to switch to that tab dialog. 

5. Under Log On As, select This Account, and then specify the account that you want to 
use.

6. Enter a password, and then confirm it.

7. Click OK to return to the Services dialog box. The Startup Type column opposite 
Transit Central Server now reads Automatic. 

8. Right-click the Site Server entry and click Start on the popup menu.

To specify a user account and password in Windows XP:

1. On the Windows Start menu, click Settings and then Control Panel. 

2. Click Switch to Category View.

3. Click Performance and Maintenance, and then double-click Administrative Tools, 
and double-click the Services icon.

4. In the Services dialog box, right-click Site Server, and then click Properties on the 
popup menu to open the Site Server Properties dialog box.

5. On the General tab dialog, from the Startup Type drop-down list, select Automatic.

6. Click Log On to open that tab dialog.

7. Under Log On As, select This Account and specify the account you want to use. The 
account must be set up for a user who has complete access to the network. Only in this 
way will Transit Central Server have complete access to all files specified by any task 
you run. (The default option, System Account, will not provide complete network 
access.) If necessary, click the button to the right of the text box to open the Add User 
dialog box and select the user that way. 

8. Enter a password, and then confirm it.

9. Click OK to return to the Services dialog box. The Startup column opposite Server 
now reads Automatic.

10. Click Start the service at the top left of the screen.
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11. Right-click the Transit Central Server entry and click Start on the popup menu.

Site Server is now set up as a Service and is running on the server machine. Once users are 
successfully connected to Site Server via Site Scheduler (see Connecting to Site Server on 
page 8-32), they can access Site Server at any time by running Site Scheduler from their 
workstations. Site Server, in turn, will automatically check every five seconds for jobs 
scheduled by Site Scheduler.

Because Site Server can check the task list only when it is running, it is important that, if 
your users are scheduling overnight translations, the machine on which Site Server is 
installed should be left running. That’s why it’s important to set Site Server to an 
automatic startup when you configure it in the Services applet of the Control Panel.

User accounts should not be confused with user logins. Services on Windows 2000 and 
Windows XP can run without any user logged into the machine.

Starting and Stopping Site Server
You can start and stop Site Server at any time.

Follow these steps to start and stop Site Server on Windows 2000:

1. Double-click Site Server in the Services window to open the Site Server dialog box.

2. On the General tab dialog, click the Start or Stop button, as appropriate.

To start and stop Site Server on Windows XP:

1. In the Control Panel, click Switch to Classic View.

2. Double-click the Site Server icon to open the Site Server dialog box.

3. On the Control tab dialog, click the Start or Stop button, as appropriate.

If you are running the Server remotely, you must close it on the machine on which it is 
running.

Follow these steps to start Site Server from a workstation:

If Site Server is installed locally, you can start it in different ways:

! From the Start menu, click Programs, click Content Publisher (or the name of the 
program group you chose during installation), and then click Site Server, or

! In the Content Publisher directory in Windows Explorer, double-click TCServer.exe, 
or
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! From the Start menu, choose Run, and in the Open text box type the path file name 
for TCServer.exe (for example, “C:\Program Files\Stellent Content Publisher\ 
TCServer.exe,”), or

Follow these steps to connect to Site Server:

Site Server can be running without Site Builder being connected to it. Once you connect 
Site Builder to the server locally, the server automatically starts. However, if Site Server is 
installed to run remotely, it must already be running for a remote client to successfully 
connect to it.

You will need to know the name of the server machine to make this connection. See the 
instructions above for starting the server from the server machine.

1. To connect Site Builder to Site Server, start Site Scheduler in Site Builder by clicking 
Site Scheduler ( ) on the standard toolbar or choosing Site Scheduler from the 
Server menu.

If during a previous session you successfully connected to Site Server from Site 
Scheduler, Site Server will start automatically.

2. If you need to establish a connection, open the Connect to Server dialog box from the 
Server menu. See Connecting to Site Server (page 8-32) for more information.

If you try to stop Site Server when it is running a task, it won’t stop until it has completed 
that task.

You can also use the Pause Publishing command to temporarily halt translations by Site 
Server. Site Server continues to run and accept projects for translation, but it won’t 
translate these projects until you “continue publishing.” See Pause Publishing in Site 
Server (page 8-33).

Connecting to Site Server
Before you can use Site Scheduler to schedule the translation of projects created in Site 
Builder, you must connect your workstation to Site Server -- that is, to the machine on 
which Site Server is running. You do this from Site Scheduler. (See Starting Site 
Scheduler on page 8-39.)

1. In the Site Scheduler window, click Connect ( ) on the toolbar or choose Connect 
from the Server menu to open the Connect to Server dialog box.

2. In the Server text box, enter the name of the machine you want to connect to, that is, 
the name of the machine on which Site Server runs.
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If you are running Site Server on your local machine and are not sure of its name, 
right-click Network Neighborhood in Windows Explorer, and choose Properties 
from the popup menu. In the Network dialog box, click Identification to open that tab 
dialog. The name of your machine is displayed in the Computer Name text box.

If you are running Site Server on a remote machine, click Browse in the Connect to 
Server dialog box to open the Browse for Computer dialog box, which displays the 
Network Neighborhood. You should see the name of the machine there. Select the 
machine from the list, or contact your network administrator to find out which 
machine on the network is running Site Scheduler.

3. Click OK. The title bar of Site Scheduler displays the name of the machine you are 
now connected to.

Once you have established a connection to a particular server, Site Scheduler will 
reconnect to that server each time you open Site Scheduler in the future. If you close Site 
Scheduler, Site Server will continue to run as long as the computer it is installed on is still 
running.

You may need to run DCOM Configuration in order to enable DCOM (see Enabling 
DCOM on page 8-23), and also to set access and launch permissions for each user, so that 
you can control the list of users who will be allowed to launch the server.

Disconnecting from Site Server
You can disconnect from Site Server at any time, by doing one of the following, in Site 
Scheduler:

! Click Disconnect ( ) on the toolbar, or

! Choose Disconnect from the Server menu.

If you close Site Scheduler, Site Server will continue to run as long as the computer it is 
installed on is still running.

Pause Publishing in Site Server
You can use the Pause Publishing command to temporarily halt all translations scheduled 
for Site Server. Site Server will continue to accept the scheduling of projects from 
workstations, but it won’t translate those tasks until you choose the Continue command.

Follow these steps to pause publishing on Site Server:

1. Right-click the Site Server icon ( ) on the Windows taskbar to display the Site 
Server popup menu.
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2. Click Pause Publishing.

The popup menu closes. You have now instructed Site Server to “pause” all scheduled 
tasks. To continue publishing again, repeat the above steps, this time clicking Continue 
on the popup menu.

Follow these steps to pause publishing when running the server as a service:

1. Click Settings on the Start menu, and then choose Control Panel from the submenu.

2. In the Explorer window that opens, double-click the Site Server icon to open the 
Content Publisher Properties dialog box.

3. Click Control to open that tab dialog.

4. Click Pause Publishing, and then click OK.

When you are ready to continue publishing again, repeat these steps, this time clicking 
Continue in the Control tab dialog.

Running Multiple Projects in Site Server
You can run multiple tasks at the same time in Site Server to increase the amount of work 
(throughput) that your system completes.

Although you benefit most from running tasks simultaneously if you use a multiprocessor 
machine, you can still use this option to increase your efficiency if you use a uniprocessor 
machine.

Many different factors affect the throughput of Site Server, including memory availability, 
machine CPU loads, disk speeds, and network bandwidth. As such, the “server threads” 
setting recommendations in step 2 should be taken as general guidelines that may vary 
depending upon your setup and current situation.

1. To open the Site Server Options dialog, do one of the following, depending on your 
setup:

! From the Start menu in Windows, choose Settings, and then Control Panel. In 
the Control Panel window, double-click the Site Server icon, or

! Right-click the Site Server icon on the Windows taskbar, and choose Properties 
from the popup menu.

2. Under Server threads, enter one of the following:

! If you are using a multiprocessor machine, enter the number of server threads that 
you want Site Server to use. For most configurations, this value should not exceed 
the number of available processors. View the number you enter as a starting 
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number. Given variations in CPU loads, disk speeds, etc., you may find that 
greater throughput is achieved with another number.

! If you are using a uniprocessor machine, enter 2. Entering a number greater than 2 
will not improve throughout noticeably (and may even degrade performance). 
Enter 1 if simultaneous translations are not required and also if you want 
backward compatibility with prior versions of Content Publisher. 

3. Click OK.

If you attempt to run two tasks that specify the same project at the same time, the tasks run 
one at a time regardless of the Server thread setting. This occurs because the project can 
only be opened by one process at a time.

Sending an E-Mail Notification for a Task
Each time a scheduled task runs on Site Server, an email can be automatically generated to 
confirm how successfully the task has been translated, staged, or published. You can also 
attach the translation log file to provide information on how the task ran.

E-mail can be sent to anyone within the organization, but you will likely want the 
Webmaster to be alerted on the outcome of translation, staging, and publishing.

Configure Site Server to Send E-Mail Notification
1. From the Windows Control Panel, double-click the Site Server icon to open the Site 

Server dialog box.

2. Click Notifications to open that tab dialog. The information that displays may have 
been set during installation, but you can change it at any time.

3. Under Mail Server Configuration, enter the address of your mail server in the Mail 
Server text box, such as mail.company.com.

4. Under SMPT Port, accept the default of 25, or, if necessary, enter a different port 
number.

5. In the Notification sender email address text box, enter the email address that 
represents the message sender. This may be a general mailbox, such as 
info@company.com. The email address entered here will be listed as the sender each 
time Site Server generates a notification email message.

6. In the System administrator email address text box, enter the email address of the 
system administrator if you want to send an email to this address every time certain 
server errors occur. This may be a general mailbox, such as 
sysadmin@company.com, or any valid email address in the organization. This 
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information is optional. If you leave this text box blank, no server-error related email 
is generated.

7. Click OK.

An email notification on server errors contains information similar to that found in the 
server log.

Even if you don't want Site Server to generate email notification on server errors, you 
must enter information in the Mail Server Configuration and Notification Sender 
Email Address text boxes, since this information determines the mail server and sender 
address that Site Server uses when sending all email notifications.

To send an email notification for a particular task, you must set options for that task in the 
New Task or Edit Task dialog box of Site Server.

Set Up an E-Mail Notification for a Task
1. In the Site Scheduler main window, click New on the Task menu to open the New 

Task dialog box, or select an existing task and click Edit on the Task menu to open the 
task dialog box.

2. Under Notification, in the Email address text box, enter the email address of the 
person who will be notified of the publication status, such as 
webmaster@company.com. You can enter only one address in this field.

3. Under Notification, from the Notification level drop-down list, select the level of 
notification you want to use for the task being scheduled.

Level Description

0 - No notification No email is generated.

1 - Notify on errors Notification of errors that occur during translation, 
staging and publishing.
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The information contained in the email is a summary of the translation log file.

4. If you want to attach a log file, select Attach Log File to Notification. To attach a log 
file to an email, you must also specify a log file and set the logging level under 
Logging.

5. Click OK.

To send an email notification for a task, you must also configure Site Server to include 
mail server, port, and sender information (see Configure Site Server to Send E-Mail 
Notification on page 8-35).

You can include the same project in more than one task (but only one project in each task.) 
For example, you may want to set up email notification for a task that directs Site Server 
to translate and stage a project when it is run, and set notification for a different task that is 
set to publish the project at a later date.

Scheduling a Task
This section covers the following topics:

! Site Scheduler (page 8-38)

! Starting Site Scheduler (page 8-39)

! Adding or Editing a Project (page 8-39)

! Adding a Project to the Task List (page 8-39)

! Editing a Project on the Task List (page 8-40)

2 - Success with output Notification of errors that occur when output is 
generated during translation, staging and publishing, 
and
Notification when output is generated and translation, 
staging and publishing succeed.
When you select this level you will receive an email 
only when output is generated as a result of a task 
being run.

3 - Always Notification of all errors and successes that occur 
during translation, staging and publishing.

Level Description
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! Exiting Site Scheduler (page 8-40)

! Managing the Task List (page 8-40)

! Reconnecting to a Server (page 8-41)

! Removing a Project From the Task List (page 8-41)

! Reviewing Task Information (page 8-41)

! Scheduling a Task (page 8-42)

! Sending an e-Mail Notification for a Task (page 8-42)

! Suspending an Individual Task (page 8-44)

! Specifying a Task (page 8-45)

! Site Scheduler Help (page 8-46)

! Testing a Scheduled Project (page 8-47)

! Translation Status (page 8-48)

! UNC Paths (page 8-48)

Site Scheduler
Site Scheduler is the scheduling component for Site Server. Once you complete projects in 
Site Builder, you can use Site Scheduler to schedule those projects for translation on your 
server at any time.

Site Scheduler is installed with both Site Builder and Site Server (where the latter is 
installed on a dedicated server machine). So you can start Site Scheduler from within Site 
Builder or separately, by itself (see Starting Site Scheduler on page 8-39).

To use Site Scheduler, you must:

! Connect your workstation to Site Server (see Connecting to Site Server on page 8-32)

! Add your projects to the task list for the Server you are connected to (see Adding a 
Project to the Task List on page 8-39)

! Specify and schedule each task when you add the project to the task list (see 
Specifying a Task on page 8-45 and Scheduling a Task on page 8-42)
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Starting Site Scheduler
You can start Site Scheduler from within Site Builder at any time. You can also start Site 
Scheduler separately, by itself, without Site Builder running.

! In the Site Builder window, click Scheduler ( ) on the standard toolbar or Site 
Scheduler on the Server menu.

To start Site Scheduler by itself

! From the Start menu in Windows, choose Programs, and from the Content Publisher 
program group, choose Site Scheduler, or

! Double-click TCScheduler.exe in the installed directory for Site Builder or Site 
Server

Adding or Editing a Project
To add a new project to the task list, you use the New Task dialog box. To edit an existing 
project on the task list, you use the Edit Task dialog box. (The two dialog boxes are the 
same; only the title bar changes, depending on which one you open.)

! To add a project to the task list, click New Task ( ) on the toolbar or choose New 
from the Task menu.

! To edit an existing project, select the project in the task list and click Edit Task ( ) 
on the toolbar or choose Edit from the Task menu.

The New Task or Edit Task dialog box will open accordingly. Click Related topics for 
topics that provide more information on projects and the task list.

Adding a Project to the Task List
Once you complete projects in Site Builder, you can translate them right away. 
Alternatively, you can use Site Scheduler to schedule their translation on Site Server.

You do this by adding a project to the task list for a specific server and then specifying and 
scheduling the task to run.

Follow these steps to add a project to the task list:

1. In Site Scheduler, click New Task ( ) on the toolbar or choose New from the Task 
menu to open the New Task dialog box.

Note: You must be connected to the machine running Site Server in order to schedule 
projects for translation.
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2. To select the project file and specify the task, see Specifying a Task (page 8-45).

3. To schedule the task, see Scheduling a Task (page 8-42).

4. Click OK.

Editing a Project on the Task List
Once you schedule a project in Site Scheduler, you may want to change the original 
specifications and schedule. You can edit any task you added to the task list at any time.

Follow these steps to edit a project to the task list:

1. In the Site Scheduler window, select the project you want to edit from the task list.

2. Click Edit Task ( ) on the toolbar or choose Edit from the Task menu to open the 
Edit Task dialog box.

3. On the Specifications and Schedule tab dialogs, edit the information for the selected 
project.

4. Click OK to return to the Site Scheduler window.

A Webmaster will need superuser privileges in order to edit the tasks of others. 
See Managing the Task List (page 8-40).

Exiting Site Scheduler
You can exit Site Scheduler at any time. Do one of the following:

! From the Server menu, choose Exit.

! Use the keyboard shortcut Alt, S, X.

! Use the keyboard shortcut Alt+F4.

! Click the Close button on the title bar.

! Click the Site Scheduler logo on the title bar and choose Close from the System menu.

After you exit Site Scheduler, Site Server will continue to run on the machine it is installed 
on.

Managing the Task List
Individual users at workstations throughout the organization can add projects to the task 
list, but they can only edit their own tasks. A Webmaster who wants to be able to edit all 
the tasks on the list must be set up as a superuser.
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To accomplish this, the Webmaster must create a new DWORD value for the following 
Key in the Registry on the server machine:

HKEY_CURRENT_USER\Software\Stellent\Content Publisher\Scheduler\6.0\Settings

The Value Name of the DWORD is “superuser” and its Value Data is 1.

As a superuser, the Webmaster can edit all tasks on the task list for a given server, but not 
change their ownership.

Reconnecting to a Server
From the Server menu in Site Scheduler, choose the name of the server you want to 
reconnect to. The File menu lists the servers (up to six) that you used most recently. 
Or click Connect ( ) on the toolbar or choose Connect from the Server menu.

Removing a Project From the Task List
Once you schedule a project in Site Scheduler, you may want to remove that project later.

1. With Site Builder running, click Scheduler ( ) on the toolbar.

2. In the Site Scheduler window, select the project in the task list that you want to 
remove.

3. Click Delete Task ( ) on the toolbar or choose Delete from the Task menu, or 
select the task and press the Delete key.

Reviewing Task Information
You can obtain preliminary information on how any task has run by opening the Task Info 
dialog box in Site Scheduler.

You can also send an email notification for a task to direct Site Server to automatically 
generate email that confirms how successfully a task has been translated, staged, or 
published (see Sending an E-Mail Notification for a Task on page 8-35). The email can 
include the translation log file, if you wish.

To review task information, right-click the task on the task list and choose Info from the 
popup menu. The Task Info dialog box opens, to provide a preliminary account of how the 
task last run.

You should always check the log file in the event that a task fails to run successfully or has 
run successfully, but with warnings or errors.
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Scheduling a Task
Adding a project to the task list in Site Scheduler requires that you first select the project 
and specify the task (see Specifying a Task on page 8-45) and also set the actual schedule 
for when the task is to run (see below).

1. In the New Task dialog box, click the Schedule tab to open that tab dialog.

2. Schedule a time for your project to run.

Note that the times for scheduling are set up in increments of a minute. If you select 
Every, the default setting of 1:00 represents one hour. With this option you should 
also specify the time period during which the task should be run.

3. If you want to translate the project over only a limited period of time, click Expires on 
under Keep Running Until and use the Up/Down control to select a date from the box.

4. Click OK to return to Site Scheduler main window, where the new task is now listed 
in the task list.

5. To schedule other projects for translation, repeat the above steps and also the required 
specification steps. When your task list is complete, click the Close box on the title 
bar or choose Exit from the File menu.

If you prefer, you can quickly test a scheduled project to see that it will run smoothly 
without warnings and errors at the scheduled time. (See Testing a Scheduled Project on 
page 8-47.)

Sending an e-Mail Notification for a Task
Each time a scheduled task runs on Site Server, an email can be automatically generated to 
confirm how successfully the task has been translated, staged, or published. You can also 
attach the translation log file to provide information on how the task ran.

Email can be sent to anyone within the organization, but you will likely want the 
Webmaster to be alerted on the outcome of translation, staging, and publishing.

Configure Site Server to Send E-Mail Notification
1. From the Windows Control Panel, double-click the Site Server icon to open the Site 

Server dialog box.

2. Click Notifications to open that tab dialog. The information that displays may have 
been set during installation, but you can change it at any time.
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3. Under Mail Server Configuration, enter the address of your mail server in the Mail 
Server text box, such as mail.company.com.

4. Under SMPT Port, accept the default of 25, or, if necessary, enter a different port 
number.

5. In the Notification sender email address text box, enter the email address that 
represents the message sender. This may be a general mailbox, such as 
info@company.com. The email address entered here will be listed as the sender each 
time Site Server generates a notification email message.

6. In the System administrator email address text box, enter the email address of the 
system administrator if you want to send an email to this address every time certain 
server errors occur. This may be a general mailbox, such as 
sysadmin@company.com, or any valid email address in the organization. This 
information is optional. If you leave this text box blank, no server-error related email 
is generated.

7. Click OK.

An email notification on server errors contains information similar to that found in the 
server log.

Even if you don't want Site Server to generate email notification on server errors, you 
must enter information in the Mail Server Configuration and Notification Sender 
Email Address text boxes, since this information determines the mail server and sender 
address that Site Server uses when sending all email notifications.

To send an email notification for a particular task, you must set options for that task in the 
New Task or Edit Task dialog box of Site Server (see below).

Set up an E-Mail Notification for a Task
1. In the Site Scheduler main window, click New on the Task menu to open the New 

Task dialog box, or select an existing task and click Edit on the Task menu to open the 
task dialog box.

2. Under Notification, in the Email address text box, enter the email address of the 
person who will be notified of the publication status, such as 
webmaster@company.com. You can enter only one address in this field.

3. Under Notification, from the Notification level drop-down list, select the level of 
notification you want to use for the task being scheduled.
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The information contained in the email is a summary of the translation log file.

4. If you want to attach a log file, select Attach Log File to Notification. To attach a log 
file to an email, you must also specify a log file and set the logging level under 
Logging.

5. Click OK.

To send an email notification for a task, you must also configure Site Server to include 
mail server, port, and sender information (see Configure Site Server to Send E-Mail 
Notification on page 8-42).

You can include the same project in more than one task (but only one project in each task.) 
For example, you may want to set up email notification for a task that directs Site Server 
to translate and stage a project when it is run, and set notification for a different task that is 
set to publish the project at a later date.

Suspending an Individual Task
On occasion, you may decide to temporarily suspend the translation of a particular project, 
one that is scheduled for translation at a regular time each day. Without affecting any of 
the schedule settings, you can temporarily stop the project from being translated.

Level Description

0 - No notification No email is generated.

1 - Notify on errors Notification of errors that occur during translation, 
staging and publishing.

2 - Success with output Notification of errors that occur when output is 
generated during translation, staging and publishing, 
and
Notification when output is generated and translation, 
staging and publishing succeed.
When you select this level you will receive an email 
only when output is generated as a result of a task 
being run.

3 - Always Notification of all errors and successes that occur 
during translation, staging and publishing.
8-44 Content Publisher User Guide



Publishing the Site
Follow these steps to suspend an individual task:

1. Select the project in Site Scheduler, and choose Edit from the Task menu to open the 
Edit Task dialog box.

2. Click Schedule to open that tab dialog, and under Keep Running Until, click the 
Down control for the list box in order to change the Expires On date to yesterday's 
date.

3. Click OK to return to the Site Scheduler main window. The Status column opposite 
the project will shortly read Expired.

You can reschedule the task at any time by re-entering the Edit Task dialog box and 
changing the Expires On date to an appropriate time in the future.

Specifying a Task
Adding a project to the task list in Site Scheduler requires that you first select the project 
and specify the task (see below) and also set the actual schedule for when the task is to run 
(see Scheduling a Task on page 8-42).

1. In Site Scheduler, click New Task ( ) on the toolbar or choose New from the Task 
menu to open the New Task dialog box.

2. In the Specification tab dialog, select Content Server from the Repository drop-down 
list, and click Browse opposite the Project field to open the Select a Project dialog 
box. Conduct a search of project files and then click the appropriate Select button for 
the one you want to schedule. The Select a Project dialog box closes and the Content 
Publisher dialog box opens.

3. You are prompted on whether you want Site Server to overwrite the existing version 
of the project file when Site Server runs the project, or whether you want to create a 
new version of the project file in Content Server. Click Yes to create a new revision of 
the project file in Content Server or No to overwrite the current version in the content 
server. (See Versioning the Project File (page 4-9).) The Content Server dialog box 
closes, and you are returned to the New Task dialog box.

4. In the Log File text box, enter a directory and file name for the log file you want to 
create to produce a report of the translation.

This information is from the perspective of the machine running Site Server. So if you 
enter C:\MyDocuments\Logfile.txt, the log file will be written to the server’s local 
drive in the directory MyDocuments. Choose a drive and directory that is accessible 
by both the server and your login. (See UNC Paths on page 8-48.)
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5. In Logging Level, select a logging level from the drop-down list. The highest level is 
5. Click Clear log file if you want Site Server to create a new log file just for the 
scheduled translation. To create a continuous record of all logging, clear this check 
box. Site Server will then append new logging information to the log file as each 
scheduled translation takes place. (See Logging Options on page A-2 for more 
information.)

6. Under Steps, select the appropriate check boxes for the steps you want Site Server to 
complete when the project is run.

When you select Translate, the project is automatically updated. You can select all 
three check boxes, but you will lose the advantage of staging if you do so. To both 
stage and publish your project, you will want to schedule two tasks. In the first task, 
you would schedule the project for the sequence Translate-Stage (and thus select the 
Translate and Stage check boxes). For the second task, you would want to select only 
the Publish check box.

If you haven’t staged your project and want to publish only, you would select the 
Translate and Publish check boxes. Conceivably, you might want to check only 
Translate.

7. In the Post-processing field, enter the name of the executable file that will trigger any 
post-processing activity, immediately the project has run. (You can enter only the file 
name if the executable resides in the root of the installed directory for Site Server; 
otherwise, enter a full path.)

8. Under Notification, enter email address and notification level information to 
automatically send an email notification for the task when it runs. See Sending an E-
Mail Notification for a Task (page 8-35) for information.

9. Click the Schedule tab to open that tab dialog, and complete the scheduling 
information, as explained in Scheduling a Task (page 8-42).

Site Scheduler Help
The following commands are available from the Help menu:

! Help Topics— Opens the Content Publisher Help system.

! About Site Scheduler— Opens the About Box for Site Scheduler, displaying 
copyright and version number information.

In addition, two toolbars offer assistance. The Toolbar provides quick access to main 
commands in Site Scheduler.
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Figure 8-6 Site Scheduler Toolbar

This displays the commands Connect, Disconnect, New Task, Edit Task, Delete Task, and 
Run. You can hide the toolbar by choosing Toolbar from the View menu. (Repeat this 
action to display the toolbar again.)

The Status Bar is found along the bottom of the Site Scheduler window.

Figure 8-7 Status bar:

As you pass your cursor over menu commands and buttons on the toolbar, a brief 
description of each appears on the status bar. You can hide the status bar by choosing 
Status Bar from the View menu. (Repeat this action to display the status bar again.)

Testing a Scheduled Project
You may want to test a project before its scheduled time to run to be sure that there will be 
no problems when the project runs later at the scheduled time. You can do this at any time, 
including when you first add the project to the task list (but not after the task has expired).

1. In the Site Scheduler window, select the task you want to test.

2. Click Run ( ) on the toolbar or choose Run from the Task menu (or right-click the 
task and choose Run Task from the popup menu).

The Last Run column indicates progress as the task runs. It displays a green check mark to 
denote that the task has run successfully or a red cross to denote the task has not run 
successfully. In either case, the time of the test also appears in the column.

A task might fail to run for different reasons. For example, the project file may no longer 
exist, or the machine on which Site Server is running does not have access to the content 
server in which the project file resides. Once a task has been tested in this way, you can 
easily obtain preliminary information on how the task has run. See Reviewing Task 
Information (page 8-41).
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Translation Status
The Status column of the task list in the Site Scheduler window displays the status of each 
project scheduled for translation. A project can be in one of five states:

! Waiting—The project is awaiting its appointed time to run.

! Pending—The project is ready to run, once other projects are completed.

! Running—The project is currently running.

! Expired—The project has run the required number of times and is not scheduled to 
run again.

! Locked—The project schedule is currently being edited by someone else.

You may want to retain an expired project on the task list if you anticipate running it at 
some future time. That way, you won’t have to enter most of the required information in 
the Edit Task dialog box again.

A task can only be edited if it is in the Waiting or Expired state.

UNC Paths
When you add a project to the task list, you will typically want to identify a log file to 
capture important information about the translation. This is done on the Specification tab 
dialog in the New Task dialog box.

When you choose a drive and directory for the log file, you should be sure to use UNC 
paths rather than DOS paths, as these are more universal, and users won’t have to worry 
about whether or not they are using the same drive mappings as the server.

Example: \\News\Share might be the UNC equivalent of drive S:\.

To ensure that you use an UNC path, always use the Browse button opposite the Project 
text box to select the project file, and always start your search from Network 
Neighborhood in the Open dialog box (you can use the Look In drop-down box to locate 
Network Neighborhood). Starting your search from Network Neighborhood will ensure 
that a UNC path is returned in the Project text box in the New Task dialog box.
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DOCUMENT INFORMATION
This section covers the following topics:

! Specifying Document Information (page 8-49)

! Inheriting Document Information From Source (page 8-50)

! Inheritance Settings (page 8-51)

! Conditional Disclosure (page 8-53)

Specifying Document Information
A required task in setting staging and publishing options is to decide what metadata you 
want to associate with the Web output you check into the content server. That metadata 
can be used to facilitate searches for information later.

At a minimum, you must specify Type, Author, and Security Groups (and any customized 
metadata that are also required) for your Web output to be successfully checked into the 
content server. This document information is always used for those output pages (frames, 
reference pages, etc.) that do not originate in a content server or the file system. For body 
pages, you have the option of inheriting document information (see Inheriting Document 
Information From Source on page 8-50).

1. In the Staging or Publishing Options dialog box, select a location (content server) for 
your staged or published output. 

2. Click the Document Information button to open the Document Information dialog 
box.

3. From the Type, Author and Security Group drop-down lists, select the metadata you 
want to associate with your Web output.

4. Click the Assign Info button to associate the selected metadata and return to the 
Staging or Publishing Options dialog box.

5. Click the Inheritance Settings button if you want to inherit metadata from source for 
output body pages (and see Inheriting Document Information From Source on 
page 8-50). Otherwise, click OK, and OK again, to return to the main window.

You can promote element-based metadata to a TOC, and that metadata can be published to 
a content server, too, just like the metadata associated with body pages.
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Inheriting Document Information From Source
One optional task in setting staging or publishing options is to decide what metadata you 
want your output body pages to inherit from source. Whatever metadata is associated with 
those Web pages checked into the content server can be used to facilitate searches for 
information later.

At a minimum, you must specify document information (Type, Author, and Security 
Group) for your Web output to be successfully checked into the content server (see 
Specifying Document Information on page 8-49). This document information is always 
used for those output pages (frames, reference pages, etc.) that do not originate in a 
content server or the file system. It will be used for body pages, too, unless you choose to 
inherit document information from source. You can promote element-based metadata to a 
TOC, and that metadata can be published to a content server, too, just like the metadata 
associated with body pages.

1. In the Staging or Publishing Options dialog box, select a location (content server) for 
your staged or published output. If you haven’t already done so, click Document 
Information to specify document information for frames, reference pages, etc. (see 
Specifying Document Information on page 8-49).

2. Click Inherited Settings to open the Inherited Document Information dialog box.

3. Select the appropriate check boxes to identify those metadata that should be inherited 
and associated with the output body pages to be checked into the content server.

4. Click OK to return to the Staging or Publishing Options dialog box.

5. Click OK to return to the main window.

When Site Builder stages or publishes the project, it will examine all metadata that is 
available in the source documents of the project. That is, it will recognize all content 
server metadata specified in step 3 as well as any element-based standard and custom 
metadata that you have published to the content server. Where any metadata clash, Site 
Builder will use a hierarchy of metadata (see The Hierarchy of Metadata on page 6-81) to 
determine which metadata are associated with the staged or published output.

If you do not select (in step 3) one of the metadata that has already been specified for 
document information (Type, Author, and Security Group), the one specified will be used, 
instead (see Specifying Document Information on page 8-49).

For source documents that are on the file system, only standard and custom metadata can 
be inherited.
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When Site Builder inherits from source, it applies the hierarchy to all non-empty metadata 
fields in the source documents. Say you publish the standard metadata Author to override 
the content server metadata Author. If a particular source document has no standard 
metadata for Author, Site Builder will inherit the content server metadata for that 
document, instead. 

Staging options apply only to staged output, and publishing options apply only to 
published output. You need to set both options separately, and likely will want to set them 
the same way.

If, for a particular project, you set only staging options or only publishing options, any 
metadata you inherit will be inherited direct from the source. If you set both staging and 
publishing options, the metadata will come from your staged output (which will have 
obtained them from the source).

If, however, you set both staging and publishing options but only publish—and don’t first 
stage—your project, then your output pages will not be able to inherit metadata. Site 
Builder (or Site Server) will try to inherit them from the staged output. It will fail to do so 
and will generate a publishing error.

Inheritance Settings
One of the keys to publishing metadata to a content server is the document information 
you choose to inherit when you set staging options or publishing options. 

In setting these options, you begin by identifying a location (content server) for your 
staged or published output and specifying document information (see Specifying 
Document Information on page 8-49). This document information is used for those output 
pages (frames, reference pages, etc.) that do not originate in a content server or the file 
system. It will also be used for output body pages if you choose not to inherit from source.

When you inherit from source, you can place metadata in all of the metadata fields in the 
Inherited Document Information dialog box. 
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Figure 8-8 Inherited Document Information dialog

You must select the appropriate metadata field in order to inherit from source; otherwise, 
the only metadata that will be applied to your staged or published output will be the 
document information you have specified (see Specifying Document Information on 
page 8-49).

The fields shown are the default ones for Content Server. You may add custom fields to 
your instance of Content Server. (For Document Information, you must retain the three 
required fields of Type, Author, and Security Group, but you can create additional 
required fields, if you want.) 

Once you select any given field, Site Builder will try to pull metadata from the source and 
place that metadata in the content server. In doing so, Site Builder will recognize all 
metadata available for a given field. Where there are multiple metadata available, it will 
apply a hierarchy of metadata (see The Hierarchy of Metadata on page 6-81) to decide 
which metadata is to be associated with the staged or published output. How you order 
metadata in Element Setup may determine which metadata are published (see Ordering 
Metadata on page 6-86).

When Site Builder inherits from source, it applies the hierarchy to all non-empty metadata 
fields in the source documents. Say you publish the standard metadata Author to override 
the content server metadata Author. If a particular source document has no standard 
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metadata for Author, Site Builder will inherit the content server metadata for that 
document, instead. 

Content server metadata is automatically available for inheritance. Standard and custom 
metadata is available only if (a) you have made the metadata element-based, and (b) you 
have published the element to the content server, using one of the fields shown above (or 
one you have customized).

Conditional Disclosure
You can use “conditional disclosure” to limit the content that a user can view on your Web 
site.

As a result, if a user is denied access to a particular source document in Content Server, 
the user won’t be able to:

! view any Web page created from that source document

! see any links in reference pages to a Web page created from that source document 
(assuming elements have been promoted from the document to the reference page)

Any links to that Web page may still exit elsewhere in the Web site. This could include 
Next Page and Previous Page buttons that reference the missing Web page. Trying to use 
any of these links will result in an Access Denied message.

Access is controlled by the security level assigned to each Web page. You apply security 
to Web pages by

! Inheriting security from the security level that was applied to the source document 
when it was checked into Content Server (see Inheriting Document Information From 
Source on page 8-50 for how to do this when setting staging or publishing options at 
the project level).

! Explicitly setting security at the project level by specifying document information in 
staging or publishing options for all output pages.

! Explicitly overriding inherited or specified security settings at the project level by 
setting security for a specific subpublication or document (see Overriding Staging and 
Publishing Options on page 8-21).

Finally, you must enable conditional disclosure in Content Publisher for it to take effect on 
the Web site.
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Follow these steps to enable conditional disclosure:

1. Click Project Options on the View menu to open that dialog box.

2. Click Repositories to switch to that tab dialog.

3. Under Conditional Disclosure, select the Enable conditional disclosure check box.

4. Click OK.

This setting is project-specific and is therefore saved to the project file. The setting 
selected will apply whether you run the project locally, move it to a network location, or 
schedule it for translation by Content Server.

You should enable conditional disclosure only with projects that use Content Server for 
the source documents and for storing the Web output created for staging and publishing 
(not with the file system).

PUBLISHING TO A FILE SYSTEM
This section covers the following topics:

! Specifying Staging or Publishing Options for a File System (page 8-54)

! Specifying Linking When Publishing to a File System (page 8-55)

! About URL Templates (page 8-56)

Specifying Staging or Publishing Options for 
a File System
Staging is the process whereby Site Builder copies translated output to a staging server for 
review before the finally approved content is published to the publishing server (Web 
site).

The Publish command is the final command you use when you create a Web publication. 
When you publish, Site Builder copies your translated output to a publishing server. 
Among your options is the ability to stage or publish to a file system.

1. From the Run menu, select Staging Options or Publishing Options to open the 
Staging/Publishing Options dialog box.

2. On the Staging Options or Publishing Options tab dialog, select File System from the 
Repository drop-down list.

3. Click Browse opposite Pages to open the Select Publish Directory dialog box.
8-54 Content Publisher User Guide



Publishing the Site
4. Locate and select the directory you want to use for output body pages.

5. Click OK to leave the Select Publish Directory dialog box and return to Staging 
Options or Publishing Options.

The directory you choose for Pages will automatically be used for Graphics and 
Gallery Graphics. You can use different directories, if you want.

6. Click Details to open the Publish Details dialog box. (To set options in this dialogue 
box, see Specifying Linking When Publishing to a File System on page 8-55.)

7. Click OK to return to the main window.

When you publish to a file system, you publish incrementally.

Specifying Linking When Publishing to 
a File System
When you publish to a file system, you must specify publish options. In addition to setting 
output locations, you can also specify URL template information that determines how a 
link will reference its target.

Links between documents and images are automatically fixed up when you publish to a 
Web site. Changing the target link information is optional. You may want to do this, for 
example, if your site and your images are on separate servers. By changing the URL 
template, you can set the target path for graphics to the graphics server, so the links to 
those images reference the correct server.

1. From the Run menu, select Publish Options.

2. In the Publish Options dialog box, complete the required information necessary to 
identify the file system and directory you are publishing to. See Specifying Staging or 
Publishing Options for a File System (page 8-54).

3. Click Details to open the Publish Details dialog box.

4. Enter one or more replacement parameters for a URL Template. (See About URL 
Templates on page 8-56 for a description of the defaults and each option you can set.)

5. Click OK to return to the Publish Options dialog box.
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About URL Templates
Links between documents and images are automatically fixed up when you publish to a 
Web site. You can also specify URL template information that determines how a link will 
reference its target for pages, graphics, and gallery graphics by changing the default 
replacement parameters in a URL template. This option is available when you select File 
System, FTP, or HTTP as your repository.

You change URL templates in the Staging / Publishing Options dialog box (see Specifying 
Staging or Publishing Options for a File System on page 8-54). First select one of the 
repositories from the Repository drop-down list, and then click Details to open the Details 
dialog box.

You may want to change the parameters of a URL template if, for example, your site and 
your images are on separate servers. By changing the URL template, you can set the target 
path for graphics to the graphics server, so the links to those images will reference the 
correct server (see Example 2, below).

Example 1: Results Using Various Parameters
The table below shows how the URL to your targets would be set if you select the 
available replacement parameters and start from an output directory such as the following:

Figure 8-9 Replacement parameters

In this example, the Images folder contains “mygraphic.gif,” and x2.htm contains a 
hyperlink to another file that also contains an anchor tag, such as <a name=“mark”>. The 
server URL is http://myserver.com/.

The results in the table apply to the file system, FTP, and HTTP repositories unless 
otherwise noted.
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Replacement 
Parameter

Description Target URL Result

%%RELURL%% Replaces the parameter with 
the relative URL from the 
source document to the 
target.

Images/mygraphic.gif

%%PATH%% Replaces the parameter with 
the entire path of the target 
in the output area.

C:/Output/Images/mygraphic.gif

%%SERVER%% When using an FTP or 
HTTP repository, replaces 
the parameter with the 
Server Name entered in the 
Destination dialog box.
Access the dialog box by 
clicking Browse for an 
output location from the 
Staging / Publishing Options 
dialog box.

The server name entered in the 
Destination dialog box, such as 
“myserver.com.”

%%DIR%% Replaces the parameter with 
a path that is relative to the 
location specified under 
“output locations” in the 
Staging / Publishing Options 
dialog box.

Images

%%FILE%% Replaces the parameter with 
the file name. This is 
typically used for graphics.

mygraphic.gif

%%PT%% Replaces the parameter with 
an anchor.

mark
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If you are using ASP or CGI files, you may want to use %%PT%% rather than 
%%#PT%%. This may save you steps in a programming environment, because you will 
not need to remove the initial number sign (#).

The following table lists the default URL templates, which use the replacement 
parameters shown above. The Target URL Result (last column) follows the same example 
above.

%%#PT%% Replaces the parameter with 
an anchor. This form 
includes the initial number 
sign (#).

#mark

Default URL 
Templates

Description Target URL Result

%%RELURL%%
%%#PT%%

Replaces the parameter with 
a relative path and also an 
anchor (if one exists).
This is the default setting for 
File System options, and for 
FTP and HTTP Relative 
URL Template options.

x2.htm#mark

<protocol>: 
//%%SERVER%%
%%DIR%%/ 
%%FILE%%%%#
PT%%
[Note the forward 
slash between the 
“DIR” and “FILE” 
entries.]

Replaces the parameter with 
a full URL.
This is the default setting for 
FTP and HTTP Absolute 
URL Template options, 
where <protocol> is FTP or 
HTTP.

http://myserver.com/Output/ 
images/ mygraphic.gif

Replacement 
Parameter

Description Target URL Result
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Example 2: Linking Graphics to a Specific Server
In this example, you are publishing to the file system. The site content and images are on 
separate servers, as follows:

You want to set up your Web site so that when you publish, the target URLs, which are the 
links to the graphics, point to the images server listed above. To do this, enter the 
following under Graphics, where <image server URL> represents the domain name of the 
server that contains the images:

http://<image server URL>/%%DIR%%/%%FILE%%

The following graphic shows how you could set options in the Details dialog box where 
the image server is www.stellentimages.com.

Figure 8-10 Details dialog

Site content: http://www.companysite.com/

Images: http://www.companyimages.com
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PUBLISHING TO AN FTP SERVER
This section covers the following topics:

! Publishing to an FTP Site (page 8-60)

! Proxy Settings for an FTP Site (page 8-61)

! Specifying Staging and Publishing Options for an FTP Site (page 8-61)

! Updating Source Documents From an FTP or HTTP Site (page 8-62)

! Specifying a Link When Publishing to an FTP Site (page 8-63)

Publishing to an FTP Site
The Publish command is the final command you use when you create a Web publication. 
When you publish Site Builder copies your translated output from the file system to 
another repository. Among your options is the ability to publish to an FTP site.

1. From the Run menu, select Publishing Options.

2. On the Publishing Options tab dialog of the Staging/Publishing Options dialog box, 
select FTP from the Repository drop-down list.

3. Click Browse opposite Pages to open the Publish Destination dialog box. To complete 
the required information in that dialog box, see Specifying Staging and Publishing 
Options for an FTP Site (page 8-61).

The FTP directory you choose for Pages will automatically be used for Graphics and 
Gallery Graphics. You can use different directories, if you want. All directories must 
already exist.

4. Click Details to open the Publish Details dialog box (see Specifying a Link When 
Publishing to an FTP Site on page 8-63).

5. Click OK to return to the main window.

You can also stage to an FTP site. See Specifying Staging and Publishing Options for an 
FTP Site (page 8-61) for more information.

When you publish to an FTP site, you publish incrementally.

Caution: Content Publisher cannot be used to move files without a file extension.
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Proxy Settings for an FTP Site
You can select source documents from different repositories, including an FTP site. You 
can also stage and publish to those repositories. If you are connecting to the FTP site 
through a proxy server, you need to provide the address and port number for the server.

1. In the Proxy Settings dialog box, click Access the World Wide Web using a proxy 
server.

2. In the Address box, enter the server name (example: ftp.stellent.com). In the Port 
box, enter the port of the server being used for the FTP address.

3. If there are any addresses for which the proxy server should be bypassed, enter them 
in the box below. You can separate multiple entries with semicolons.

Example ftp.stellent.com;ftp.infoaccess.com

4. Click OK to return to the FTP Source Document dialog box.

For more information, see Adding a Document (page 5-31) and Adding a Directory Item 
(page 5-89).

You can also create a Dynamic Directory Item from an FTP site. See Adding a Dynamic 
Directory Item From the File System or an FTP Site (page 5-93) for more information.

Specifying Staging and Publishing Options for 
an FTP Site
Staging is the process whereby Site Builder copies translated output from the file system 
to a staging server for review before the finally approved content is published to the 
publishing server (Web site).

The Publish command is the final command you use when you create a Web publication. 
When you publish Site Builder copies your translated output from the file system to 
another repository. Among your options is the ability to stage or publish to an FTP site.

1. From the Run menu, select Staging Options or Publishing Options.

2. On the Staging Options or Publishing Options tab dialog of the Staging/Publishing 
Options dialog box, select FTP from the Repository drop-down list.

3. Click Browse opposite Pages to open the Publish Destination dialog box.

4. Under Destination, enter the FTP server name. Neither the protocol (ftp://) nor a 
closing forward slash is required.

Example ftp.company.com.
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5. Under Directory to contain your Web pages, click Browse and locate the directory 
you want to use for output body pages. The directory you choose will automatically be 
used for Graphics and Gallery Graphics. You can use different directories, if you 
want. All directories must already exist.

6. Under Login Credentials, click Use Anonymous FTP if you are staging or publishing 
to an FTP site that permits an anonymous user. If you require an FTP user account to 
stage or publish to the site, click Use specific credentials and enter both your user 
account and password.

7. Click Use specific server TCP/IP port if the server at the FTP site you are 
connecting to does not use the standard FTP port. Then enter the port number in the 
box.

8. Click OK.

9. Click OK to leave the Publish Destination dialog box and return to Staging Options or 
Publishing Options.

If you are connecting to the FTP site through a proxy server, click Proxy to open the 
Proxy Settings dialog box (see Proxy Settings for an FTP Site (page 8-61)).

Updating Source Documents From an FTP or 
HTTP Site
When you start a new project and add source documents from an FTP or HTTP site, Site 
Builder makes copies of those documents, places them in a temporary directory on the file 
system, and translates the copies. Site Builder will continue to use those copies for 
translation during your current session in Site Builder unless you formally update the 
source documents. 

So if there is a delay between the first time you translate and the last time you translate 
before publishing, you should update the copies of the source documents in the temporary 
directory. To update source documents, click Update Versions ( ) on the toolbar.

Copies of the latest versions of the source documents on the FTP or HTTP site have been 
placed in a temporary directory on your file system. You can now translate one last time 
and then publish. (See Update Versions Command on page 8-9.)

Note: You can stage or publish to any FTP site that you can connect to. But when using 
“Anonymous.” you may find that you are restricted to certain levels of files (which may 
also be the case with an FTP user account).
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Site Builder copies a source document the first time it is “requested.” This could be when 
you associate a template with the source document in the Choose Template dialog box 
(with the preview functionality turned on), when you preview the document in the Edit 
Template dialog box, or when you first translate the document. Also, Site Builder will 
delete the temporary file each time you close the project and create a new one the next 
time you start the project and the document is first requested.

Because Site Builder copies source documents only when they are “requested,” the Status 
column in the main window may be misleading. You may see a green check mark even 
though a more recent version of a document is available from an FTP or HTTP site. So 
always click Update Versions (see Update Versions Command on page 8-9) before your 
final translation. If a green check mark opposite a document turns to a red cross, you’ll 
know that Site Builder has just copied an updated version of that document into the 
temporary directory, ready for translation.

Specifying a Link When Publishing to an FTP 
Site
When you publish to an FTP site, you must specify publish options. This includes 
providing the necessary link to ensure that your published output can be identified on your 
FTP site by your Web server.

1. From the Run menu, select Publish Options.

2. In the Publish Options dialog box, complete the required information necessary to 
identifying the FTP site and directory you are publishing to. See Publishing to an FTP 
Site (page 8-60) for more information.

3. Click Details to open the Publish Details dialog box.

4. Select the appropriate link from the Absolute URL template drop-down list. 
The default is:

ftp://%%SERVER%%%%DIR%%/%%FILE%%%%#PT%%
(note the forward slash between the “DIR” and “FILE” entries)

For ASP files, you should use %%PT%% (the target fragment identifier), rather 
than %%#PT%% (the target fragment identifier with initial delimiter). 

5. Click OK to return to the Publish Options dialog box.

You can change this link. For example, some URLs specify both the user and password. 
Any link you enter will be preserved for future use.
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PUBLISHING TO AN HTTP SERVER
This section covers the following topics:

! Publishing to an HTTP Site (page 8-64)

! Proxy Settings for an HTTP Site (page 8-65)

! Specifying Staging and Publishing Options for an HTTP Site (page 8-65)

! Updating Source Documents From an FTP or HTTP Site (page 8-66)

! Specifying a Link When Publishing to an HTTP Site (page 8-67)

Publishing to an HTTP Site
The Publish command is the final command you use when you create a Web publication. 
When you publish Site Builder copies your translated output from the file system to 
another repository. Among your options is the ability to publish to an HTTP site.

You can only publish to an HTTP site that allows files to be written there. Also, the 
published output will not recreate the hierarchy of publications in your project. However, 
your Web publication should still display properly on your Web site.

1. From the Run menu, select Publishing Options.

2. On the Publishing Options tab dialog of the Staging/Publishing Options dialog box, 
select HTTP from the Repository drop-down list.

3. Click Browse opposite Pages to open the Publish Destination dialog box. To complete 
the required information in that dialog box, see Specifying Staging and Publishing 
Options for an HTTP Site (page 8-65).

The HTTP directory you choose for Pages will automatically be used for Graphics and 
Gallery Graphics. You can use different directories, if you want. All directories must 
already exist.

4. Click Details to open the Publish Details dialog box (see Specifying a Link When 
Publishing to an HTTP Site on page 8-67).

5. Click OK to return to the main window.

You can also stage to an HTTP site. See Specifying Staging and Publishing Options for an 
HTTP Site (page 8-65).

When you publish to an HTTP site, you publish incrementally.
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Proxy Settings for an HTTP Site
You can select source documents from different repositories, including an HTTP site. You 
can also stage and publish to those repositories. If you are connecting to the HTTP site 
through a proxy server, you need to provide the address and port number for the server.

1. In the Proxy Settings dialog box, click Access the World Wide Web using a proxy 
server.

2. In the Address box, enter the server name (example: www.stellent.com). In the Port 
box, enter port of the server being used for the HTTP address.

3. If there are any addresses for which the proxy server should be bypassed, enter them 
in the box below. You can separate multiple entries with semicolons.

Example www.stellent.com;www.infoaccess.com

4. Click OK to return to the HTTP Source Document dialog box.

See also:

! Adding a Document (page 5-31)

! Adding a Directory Item (page 5-89)

! Publishing to an HTTP Server (page 8-64)

Specifying Staging and Publishing Options for 
an HTTP Site
Staging is the process whereby Site Builder copies translated output from the file system 
to a staging server for review before the finally approved content is published to the 
publishing server (Web site).

The Publish command is the final command you use when you create a Web publication. 
When you publish Site Builder copies your translated output from the file system to 
another repository. Among your options is the ability to stage or publish to an HTTP site.

1. From the Run menu, select Staging Options or Publishing Options.

2. On the Staging Options or Publishing Options tab dialog of the Staging/Publishing 
Options dialog box, select HTTP from the Repository drop-down list.

3. Click Browse opposite Pages to open the Publish Destination dialog box.

4. Under Destination, enter the HTTP server name. Neither the protocol (http://) nor a 
closing forward slash is required.
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Example: www.stellent.com.

5. In the Subfolder Containing Your Web Pages text box, enter the path and name of the 
directory you want to publish to.To specify the directory you want to stage or publish 
to, you can open the HTTP site in your browser and select the directory from the 
directory listing. Then copy the URL from the Address or Location bar and paste it 
into the Subfolder Containing Your Web Pages text box.

The HTTP directory you choose for Pages will automatically be used for Graphics and 
Gallery Graphics. You can use different directories, if you want. All directories must 
already exist.

6. Under Login Credentials, click Use anonymous connection if you are publishing to 
an HTTP site that permits an anonymous user. If you require an HTTP user account to 
stage or publish to the site, click Use specific credentials and enter both your user 
account and password.

7. Click Use specific server TCP/IP port if the server at the HTTP site you are 
connecting to does not use the standard HTTP port. Then enter the port number in the 
box.

8. Click OK.

9. Click OK to leave the Publish Destination dialog box and return to Staging Options or 
Publishing Options.

You can stage or publish to any HTTP site that you can connect to. But when using 
“Anonymous” you may find that you are restricted to certain levels of files (which may 
also be the case with an HTTP user account).

If you are connecting to the HTTP site through a proxy server, click Proxy to open the 
Proxy Settings dialog box (see Proxy Settings for an HTTP Site on page 8-65).

Updating Source Documents From an FTP or 
HTTP Site
When you start a new project and add source documents from an FTP or HTTP site, Site 
Builder makes copies of those documents, places them in a temporary directory on the file 
system, and translates the copies. Site Builder will continue to use those copies for 
translation during your current session in Site Builder unless you formally update the 
source documents.

Site Builder copies a source document the first time it is “requested.” This could be when 
you associate a template with the source document in the Choose Template dialog box 
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(with the preview functionality turned on), when you preview the document in the Edit 
Template dialog box, or when you first translate the document. Also, Site Builder will 
delete the temporary file each time you close the project and create a new one the next 
time you start the project and the document is first requested.

So if there is a delay between the first time you translate and the last time you translate 
before publishing, you should update the copies of the source documents in the temporary 
directory. To do so, click Update Versions ( ) on the toolbar.

Copies of the latest versions of the source documents on the FTP or HTTP site have been 
placed in a temporary directory on your file system. You can now translate one last time 
and then publish. (See Update Versions Command on page 8-9.)

Because Site Builder copies source documents only when they are “requested,” the Status 
column in the main window may be misleading. You may see a green check mark even 
though a more recent version of a document is available from an FTP or HTTP site. So 
always click Update Versions (see Update Versions Command on page 8-9) before your 
final translation. If a green check mark opposite a document turns to a red cross, you’ll 
know that Site Builder has just copied an updated version of that document into the 
temporary directory, ready for translation.

Specifying a Link When Publishing to an HTTP 
Site
When you publish to an HTTP site, you must specify publish options. This includes 
providing the necessary link to ensure that your published output can be identified on your 
HTTP site by your Web server.

1. From the Run menu, select Publish Options.

2. In the Publish Options dialog box, complete the required information necessary to 
identifying the HTTP site and directory you are publishing to. See Publishing to an 
HTTP Site (page 8-64) for more information.

3. Click Details to open the Publish Details dialog box.

4. Select the appropriate link from the Absolute URL template drop-down list. The 
default is:

http://%%SERVER%%%%DIR%%/%%FILE%%%%#PT%%
(note the forward slash between the “DIR” and “FILE” entries)

For ASP files, you should use %%PT%% (the target fragment identifier), rather 
than %%#PT%% (the target fragment identifier with initial delimiter). 
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5. Click OK to return to the Publish Options dialog box.

You can change this link, if you want. For example, some URLs specify both the user and 
password. Any link you enter will be preserved for future use.

PUBLISHING TO CONTENT SERVER
This section covers the following topics:

! Content Servers (page 8-68)

! Connecting to Content Server (page 8-69)

! Choosing a Content Server (page 8-69)

! Updating Source Documents in Content Server (page 8-70)

! Updating to the Latest Released Version of a Source Document (page 8-71)

! Selecting a Presentation Option for a Query Results Page (page 8-71)

! Suppressing the Info Icon on Web Pages (page 8-72)

! Finding the Home Page (page 8-72)

! Registration (page 8-73)

! File Naming Conventions (page 8-79)

Content Servers
The ideal setup in publishing is three content servers:

! source server for source documents (including graphics, associated files, and the 
project file itself)

! staging server for staged output

! publishing server for published output

Conceivably, staging and publishing could be done on the same content server. You might 
even use a single content server for all three purposes. Your project could also draw files 
from more than one source server.

The number of content servers in use does not affect workflow or registration. In other 
words, the procedures you follow to register a project on a source server and a staging 
server are unchanged even though a single server is used for both source documents and 
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staging. Also, staging criteria workflow is still possible where the source server and the 
staging server are the same content server.

Connecting to Content Server
For Content Publisher to run successfully with Content Server, you need to complete the 
following:

On each machine on which either Site Builder or Site Server is installed

! Register the name of each content server and also the name of the HTTP server that is 
hosting each content server. See Registering a Content Server (page 8-74).

On each machine on which Site Server is running

! Register a username and password in order to access each content server. See 
Registering a Username and Password for Site Server (page 8-27).

Choosing a Content Server
When you use Content Publisher with Content Server, you use the Select a Repository 
dialog box to first select Content Server as your repository of choice for adding source 
documents, saving project files, and so on (see Selecting a Repository on page 5-8).

Figure 8-11 Select a Repository dialog

If Site Builder is configured to work with more than one content server, once you select 
Content Server in the Select a repository dialog box, the Choose a Content Server dialog 
box will open for you to select the particular content server you want to work with.

Choose your content server of choice from the drop-down list.

If you will be working only with the Content Server, you can click the Don’t show this 
dialog box again check box in the Select a Repository dialog box. If you have multiple 
content servers configured on your machine, the Choose a Content Server dialog box will 
still open each time.
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Updating Source Documents in Content Server
You will want to use the Update Versions Command (page 8-9) as you create your project. 
You won't necessarily want to use the command before each translation, but you will 
certainly want to use it at critical times during project creation to be sure that what you are 
reviewing contains the latest content. This obviously becomes more important during 
staging, and more important still before you finally publish.

The Update Versions command is important because when you add documents that reside 
in Content Server, you do not check out those documents as you do in your normal use of 
Content Server. Rather, Site Builder identifies the current version of each document at the 
time it is added to the publication and obtains a working copy of that version for 
translation.

As a result, someone else may check out one or more of those documents during your 
session in Site Builder, between the time you start your project and are ready to publish. 
That’s why you may want to use the Update Versions command before your final 
translation.

! Click Update Versions ( ) on the toolbar.

Site Builder checks the repository and identifies the latest released version of each 
document in your publication. Any updated document will have an 8after it in the Status 
column. You should translate and view your publication one more time before you click 
Stage to check all output files into the staging server (or click Publish to place them in a 
publishing server, assuming you haven’t staged your project).

You can specify a particular version of a source document. In that event, Site Builder 
always translates the specified version and simply ignores any other versions of the 
document when you click Update Versions. See Version Options When Translating a 
Source Document (page 5-28).

Clicking Update Versions on the Run menu or toolbar updates all source documents in 
your publication (unless you have specified that a particular version be used). To update 
selectively, select only the appropriate subpublication in the Publication pane, or 
Directory Item or document in the Contents pane, right-click, and then choose Update 
Versions from the popup menu. Site Builder will check for new versions of only those 
source documents included in your selection.

You can select multiple documents with the Ctrl key and the mouse.
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Updating to the Latest Released Version of a 
Source Document
The default behavior in Content Server is for the latest released version of a source 
document to be used each time you translate. Thus, each time you enter the Document 
Details dialog box, the Allow refresh to latest released version check box is selected at 
the top of the dialog box.

You may have previously specified that a particular version be used and now want the 
latest released version to be used, instead.

1. In Site Builder, right-click the appropriate source document in the Contents pane and 
choose Properties from the popup menu.

2. In the Document Properties dialog box, click the Info button ( ) to open the 
Document Details dialog box.

3. At the top of the dialog box, select the Allow refresh to latest released version check 
box.

4. Click the Select button to close the Document Details dialog box.

Each time you use the Update Versions Command (page 8-9), Site Builder will now use 
the latest released version of this source document when you translate or publish in future.

Selecting a Presentation Option for a Query 
Results Page
When you create a Query page for a Web publication, you set options for the Query results 
page. Among them are the presentation format for the information that will be returned 
from a search on the Query page.

In the Results Presentation Option dialog box, select from the Name drop-down list the 
presentation format you want to use. (Your administrator creates these options.) A 
description of the presentation format and the text that will display in the results page 
appear below.

Text 1 and Text 2 typically include the Content ID and Title (the administrator can define 
the fields in different ways), and will appear in the Description column of the Query 
results page. You can select additional columns to appear on the results options page. See 
Setting Options for a Query Results Page (page 6-193) for more information.
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Suppressing the Info Icon on Web Pages
One optional task in setting staging options is to decide whether you want to use the 
special Info icon on every Web page of your staged output. This icon provides access to 
the Content Information page for a Web page, including the special problem report section 
(if you have registered the project). It is added by default to every Web page of your 
staged output.

You don't have to use the Info icon ( ) when you stage. For example, you may decide to 
use it initially when you first stage your project, and then decide later to leave it off when 
you feel that your staged version is almost ready to be published. At that time you will be 
able to view your Web pages exactly as they should appear on your Web site.

To suppress the Info icon on output pages, on the Staging Options dialog box, select the 
Suppress placement of Info buttons on staged output check box.

The Info icon will be removed from your Web pages the next time you stage the project.

Each time you change this option, Site Builder will automatically rebuild your entire 
staged output, even if you have only changed one or two source documents since the last 
time you translated the project.

Finding the Home Page
Once you have staged a Web publication and want to view it, you can open the publication 
from Content Server by using the home page of the publication as an entry point.

1. In Content Server, open the Search page.

2. Create a full-text query by typing dPublishType=H in the full text search box, and 
then click Search.

The Query results page displays the top page of each publication. This could be a 
frame (Frame.htm is the default in Content Publisher), a TOC (if the publication is 
unframed), or the first page of your publication (if the publication is unframed and 
doesn't contain any reference pages)

3. Click the appropriate top page to open the complete publication in your browser.
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Registration
This section covers the following topics:

! Registration in Content Publisher (page 8-73)

! Registering a Content Server (page 8-74)

! Registering a Content Server by Running the Mini-Installer (page 8-74)

! Registering a Content Server by Manually Creating a Registry Entry (page 8-75)

! Registering a Project to Preview a Source Document (page 8-76)

! Registering a Project on a Staging Server (page 8-77)

! Registering a Username and Password for Site Server (page 8-77)

Registration in Content Publisher
Registration in Content Publisher takes many forms, all of which help Content Publisher 
connect and share files with Content Server.

! You register a content server if you plan to share documents between Content 
Publisher and Content Server (includes source documents, staged, and published 
output). See Registering a Content Server (page 8-74).

! You register a project on a source server in order to preview the translated version (the 
Web page) of a source document. See Registering a Project to Preview a Source 
Document (page 8-76).

! You register a project on a staging server to enable staging workflow and the use of 
'problem reports' for your staged Web pages. See Registering a Project on a Staging 
Server (page 8-77).

! When running Site Server on a separate machine (from Content Publisher), you 
register a username and password in order to access Content Server. See Registering a 
Username and Password for Site Server (page 8-27).

There is another form of registration that Content Publisher performs automatically when 
you publish a project to Content Server. As a result, files on the content server can be 
easily monitored, and your projects run much faster.
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Registering a Content Server
For Content Publisher to work successfully with Content Server, both Site Builder and 
Site Server must have access to each content server in use. This is true whether the content 
server is a source of documents for your projects or serves as a location for the staged and 
published output that your projects generate.

During installation you can register a single content server by providing the name of the 
content server and also the name of the HTTP server that is hosting the content server. 
You may need to register additional content servers (say, for the staged and published 
output your projects generate). You can do this either by

! Running the mini-installer provided on your Content Publisher product disc (see 
Registering a Content Server by Running the Mini-Installer on page 8-74), or

! Manually creating a Registry entry (see Registering a Content Server by Manually 
Creating a Registry Entry on page 8-75).

Running the mini-Installer simply automates the process of creating the required Registry 
entry.

Registering a Content Server by Running the 
Mini-Installer
During the installation of Site Builder or Site Server, you can register a single content 
server by providing the name of the content server and also the name of the HTTP server 
that is hosting the content server. This is essential if the client or server is to have access to 
Content Server.

You may need to register additional content servers (say, for the staged and published 
output your projects generate). You can do so at any time by running the mini-Installer 
that is available on your Content Publisher product disc.

To run the mini-Installer:

1. Insert your Content Publisher product disc in the disc drive of the machine on which 
either Site Builder or Site Server is installed.

2. Open the Support folder and double-click CSSetup.exe.

3. Complete the information requested on each of the installer screens that appear, in 
turn.

4. Click Finish to complete the running of the mini-Installer.

You have created the necessary Registry entry. You can begin using the client or server 
immediately to access the content server you have just registered.
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Follow the above steps to register the same content server on any additional machines, as 
necessary, and also to register additional content servers on the same machine.

The mini-Installer simply automates the process of creating the required Registry entry. 
To manually create the entry or to edit an existing entry, see Registering a Content Server 
by Manually Creating a Registry Entry (page 8-75).

Registering a Content Server by Manually Creating a 
Registry Entry
During the installation of Site Builder or Site Server, you can register a single content 
server by providing the name of the content server and also the name of the HTTP server 
that is hosting the content server. This is essential if the client or server is to have access to 
Content Server.

You may need to register additional content servers (say, for the staged and published 
output your projects generate). You can do so at any time by manually creating the 
required Registry entry.

1. From the Start menu, click Run.

2. In the Open text box, type regedit and click OK.

3. Locate the following Registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Stellent\Content Publisher\Repository\ 
6.0\Stellent\CS List

4. Right-click CS List, and choose New and then Key from the popup menu.

5. In the edit box that appears, replace New Key #1 with the name of the content server, 
say, Dev. Press Enter.

6. Right-click the new Key (say, Dev) and select New and then String Value from the 
popup menu.

7. Enter the String Name CgiURL and press Enter.

8. Right-click CgiURL and choose Modify from the popup menu. In the Value Data text 
box, enter the following if you are using Microsoft Explorer Information Server to 
host Content Server:

http://<HTTP server name>/intradoc-cgi/idc_cgi_isapi.dll

For example, if your HTTP server is named ContentServer, you would enter:

http://contentserver/intradoc-cgi/idc_cgi_isapi.dll
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If, instead, you are using Netscape Enterprise Server to host Content Server, enter the 
following in the Value Data box:

http://<HTTP server name>/intradoc-cgi/nph-idc_cgi.exe

Example:

http://contentserver/intradoc-cgi/nph-idc_cgi.exe

9. Press Enter.

You have created the necessary Registry entry. You can begin using the client or server 
immediately to access the content server you have just registered.

You can edit this entry at any time, should you later change the name of your content 
server or HTTP server.

Follow the above steps to register the same content server on additional machines, as 
necessary, and also to register additional content servers on the same machine.

You can automate the process of registering a content server by using the mini-Installer 
available on the Content Server product disc. See Registering a Content Server by 
Running the Mini-Installer (page 8-74).

Registering a Project to Preview a Source Document
Registering a project on a source server allows a content author to preview a source 
document as it is checked into that source server. (Previews are possible any time the 
document is checked in.)

1. With a project open in Site Builder, click Project Registration on the View menu to 
open the Project Registrations dialog box.

2. In the Registrations window, select the name of the content server in which your 
source documents reside and double-click the red cross opposite, in the Preview 
column, to turn it into a green check mark.

3. Click OK.

4. Click Save ( ) on the standard toolbar.

You have registered the project on the specified source server.

Previews work only with documents in Content Server. If the source document is part of a 
Directory Item, the Directory Item must be “Restricted” (see Specifying a Directory Item 
to Facilitate Previews on page 5-28). In the case of a source document that is not part of a 
Directory Item, the preview won’t be possible until the document has been added to your 
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project and associated with a template. So it won’t be possible the first time you check the 
document into the content server.

Registering a Project on a Staging Server
One optional task in setting staging options is to register the project on the staging server 
in order to facilitate “staging criteria workflow.” Doing so will also result in the creation 
of the special Content Information page containing a problem report section that can be 
used by the reviewer to send a report to the content author and project author highlighting 
a problem with a particular Web page.

You can only register a project that has been saved to Content Server. (The option is 
grayed out otherwise.)

1. On the Staging Options dialog box, select the Register the project with the Content 
Server for staging workflow check box.

2. Click OK to close the Staging Options dialog box and return to the Staging/Publishing 
Options dialog box.

The project will remain registered as long as you continue to stage to the designated 
content server or clear this check box (see Unregistering a Project on a Staging Server on 
page 8-8).

Registering a Username and Password for Site Server
Each machine on which Site Server is installed requires a username and password in order 
for Site Server to access Content Server. System administrators can use password 
encryption to configure the machines on which Site Server is installed, using the utility 
PswdCfg.exe, which is available in the Support folder of the Content Publisher product 
disc.

Typically, the system administrator will want to encrypt passwords during the setup of 
Site Server. In that event, before running the utility the system administrator should first 
register the names of all content servers that Site Server will require access to.

1. Double-click PswdCfg.exe in the \Resources\en folder of your Content Publisher 
installation directory to run the encryption utility. The Access Configuration dialog 
box opens.
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Figure 8-12 Access configuration dialog

2. Select the name of the first content server you want to configure.

3. Under Authentication Credentials, provide the user name and password (twice), as 
required. 

4. Click Update. A dialog box will appear, to confirm that the username and encrypted 
password have been successfully registered.

Figure 8-13 Access dialog

5. Select each additional content server, in turn, that you want to configure, and repeat 
steps 3 and 4.

6. When you have configured all the content servers necessary for the machine on which 
Site Builder is installed, click the Close button to the right of the title bar.

7. Follow the above steps to configure additional machines on which Site Server is 
installed.
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You can register only one content server during installation. However, you can register 
additional content servers after installation. (See Registering a Content Server by Running 
the Mini-Installer on page 8-74.) You can run PswdCfg.exe at any time to configure 
additional content servers you may register later. 

You can run PswdCfg.exe at any time to change an encrypted password. If for some 
reason you no longer want a password to be encrypted, you will have to remove the 
registry entry manually from the Registry and create a new entry.

File Naming Conventions
This section covers the following topics:

! Adding a Prefix to Output File Names (page 8-79)

! Publishing to the Content Server Without a Unique Suffix (page 8-81)

! Setting Check-In File Extensions (page 8-82)

! Illegal Characters in a Title (page 8-83)

Adding a Prefix to Output File Names
You can add a prefix to your staged or published output to help create predictable file 
names when publishing to Content Server. Using this option, you can more easily 
distinguish between published files in different projects.

Prefixes can be added at the project, publication, and Directory Item levels. Site Builder 
adds the prefixes to the output files during translation. With this feature, you can use the 
same source document in multiple publications of the same project.

Example: You could add document.doc to both PublicationA and PublicationB of a 
project if you apply a prefix to the output file in one of the publications. If you add a “test” 
prefix to PublicationA, during translation that file becomes testdocument.htm, while the 
output file name for PublicationB remains document.htm.

You can add multiple prefixes in a project. Prefixes are appended to each other, and the 
prefix assigned to the closest publication always takes priority over other publications.

Example: Your publication hierarchy and prefix settings are as follows:

Level Prefix

Project P
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Using the above example:

! If you set prefixes for the Project, Publication 3, and Directory Item 4, the prefix 
appended to output files for the documents contained in the Directory Item would be 
P34.

! If you set a prefix for the Project, Publication 2, Publication 3, and Directory Item 4, 
the prefix for the documents contained in the Directory Item would also be P34, since 
Publication 2 is not directly related to Directory Item 4.

! If you set a prefix for Publication 3 and Directory Item 4, without setting any other 
prefixes, the prefix for the documents contained in Publication 3, except Directory 
Item 4, would be 3. The prefix for items contained in Directory Item 4 would be 34. 
There would be no prefix associated with items contained in the Project through 
Publication 2 levels.

Specifying a Prefix at the Project Level
Follow these steps to specify a prefix at the project level:

1. Click Project Options on the View menu.

2. On the File Naming tab dialog, under Output Name Prefix, enter the prefix to apply to 
each output file in the project.

3. Click OK.

To specify a prefix at the publication level

1. Right-click the publication in the Publication Hierarchy pane.

2. Select Properties from the popup menu.

3. In the Prefix to be added to all output file names text box, enter the prefix to apply 
to each output file in this publication.

4. Click OK.

Publication 1 1

Publication 2 2

Publication 3 3

Directory Item 4 4

Level Prefix
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Specifying a Prefix at the Directory Item Level
Follow these steps to specify a prefix at the Directory Item level:

1. In the Contents pane, right-click the Directory Item and choose Properties from the 
popup menu to open the Properties dialog box.

2. In the General tab dialog, in the Prefix to be added to all output file names text box, 
enter the prefix to apply to each output file in this Directory Item.

3. Click OK.

When publishing to the content server, ensure that the file name, including all prefixes, is 
no more than 30 characters.

You may also want to generate document names from file names only, instead of 
appending a unique suffix, when adding prefixes to output file names (see Publishing to 
the Content Server Without a Unique Suffix on page 8-81).

Publishing to the Content Server Without a Unique Suffix
When files are staged or published to Content Server, by default Content Publisher 
appends a unique suffix to each file name when the file is checked in. This ensures file 
name uniqueness within the content server. If you prefer, you can publish to the content 
server without the unique suffix. You may want to use this in conjunction with the prefix 
option so that you can more easily recognize and predict the file name.

1. With your translated project open in Site Builder, click Staging Options or 
Publishing Options on the Run menu to open the Staging/Publishing Options dialog 
box.

2. Under Repository, select Content Server from the drop-down list.

3. On the Staging Options or Publishing Options tab dialog, click the Browse button 
opposite Pages to open the Staging or Publishing Options dialog box.

4. Under Document Names, select Generate document names from file names. When 
this option is selected, only the file name, with its prefix (if added), is published to the 
content server, such as P34document.hcsp. When this option is not selected, the 
unique suffix is appended to the end of the file, such as P34document_ia937498-
2.hcsp.

This option is also available at the publication, Directory Item, and document levels.
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Setting Check-In File Extensions
You can specify the file extensions that Site Builder assigns to files when checking 
documents into the content server during staging or publishing. This allows flexibility in 
determining the final URLs of published documents.

You can specify that either the extension created during translation or a file extension you 
specify is used during check-in. If using a specific extension, most often you will want to 
accept the default, which is hcsp.

When publishing Query Pages, you should ensure that an hcsp extension is used, as those 
pages must contain the hcsp extension when checked into the content server.

You can specify file extensions for check-in to the content server at the project, 
publication, Directory Item, and document levels.

See Overriding Staging and Publishing Options (page 8-21) for hierarchy information and 
which setting takes precedence over another.

Follow these instructions to set a file extension at the project level:

1. Click Staging Options or Publishing Options from the Run menu depending on 
which option you are setting to open the Staging/Publishing Options dialog box.

2. When setting output locations for pages, click Browse to open the corresponding 
staging options or publishing options dialog box.

3. Under File Extensions, do one of the following:

! if you want to check in files using the extension generated during translation, click 
Check in documents using original file extensions.

! if you want to specify the file extension, click Check in documents using this 
file extension, and enter a file extension of up to 8 characters in the text box.

! if you want to check in files using the default hcsp extension, ensure that Check 
in documents using this file extension is selected and the hcsp extension 
displays in the text box. This is the default file extension used when you check 
files into the content server.

4. Click OK.

Use these instructions to set a file extension at the publication level:

1. After you set staging and publishing options at the project level, right-click the 
publication in the Publication Hierarchy pane and select Properties from the popup 
window to open the Publication Properties dialog box.
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2. Select the Publishing Options tab dialog, which only displays if you have set 
publishing options and/or staging options at the project level.

3. Under Pages, click Edit to open the Publishing Options dialog.

4. Under File Extensions, do one of the following:

! if you want to check in files using the extension generated during translation, click 
Check in documents using original file extensions.

! if you want to specify the file extension, click Check in documents using this 
file extension, and enter a file extension of up to 8 characters in the text box.

! if you want to check in files using the default hcsp extension, ensure that Check 
in documents using this file extension is selected and the hcsp extension 
displays in the text box. This is the default file extension used when you check 
files into the content server.

5. Click OK.

The file extensions set in staging options should be the same as the extensions set in 
publishing options.

This option is also available for Directory Items and documents. To set file extensions for 
either a Directory Item or document, open the appropriate Publishing Options dialog box, 
which appears after you set project options. Set the extensions following the information 
described in step 4, above.

Illegal Characters in a Title
When you add a document to a publication, Site Builder uses the document title of the 
source document in Content Server as the file name in Site Builder. When you translate 
the publication, Site Builder creates an output file using the same name (adding the 
extension .htm). The name of the output file that is created during translation is used as the 
title when you publish and place the output files in the repository.

In Content Server you can create a document title that includes characters that are illegal 
on the file system. (For example, you can use commas and quotation marks.) Content 
Publisher handles illegal characters in the document title by replacing them with an 
underscore ( _ ) when it creates a file name. The file system therefore accepts the output 
file name that is created during translation and Content Publisher successfully translates 
the file. As a result, when the output file is published back to the repository, its title is now 
slightly different to the source document title.

This modification of the source document title to create an output file name occurs only 
when the title contains illegal characters. The source document title itself is not modified.
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A p p e n d i x

A.TROUBLESHOOTING
This section covers the following topics:

! Log File (page A-1)

! Errors and Warning Messages (page A-8)

! Project Recovery When the Content Server is Unavailable (page A-16)

LOG FILE
This section covers the following topics:

! Logging Options (page A-2)

! Logging Levels (page A-2)

! Logging Errors (page A-3)

! Viewing the Translation Log File (page A-4)

! Setting Up the Translation Log on Site Builder (page A-5)

! Setting Up the Translation Log File on Site Server (page A-7)

! Setting Up the Server Log File on Site Server (page A-8)
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Logging Options
Content Publisher allows you to create two log files to track the translation of a project: 
the “translation log” and the “server log.”

! The translation log is used to identify specific problems (such as missing graphics) 
that arise during translation. See Setting Up the Translation Log on Site Builder 
(page A-5).

! The server log is used to monitor server activity and track the translation of multiple 
tasks. See Setting Up the Server Log File on Site Server (page A-8).

When you use Site Builder as a standalone workstation, you use only the translation log 
and set the logging level in the Application Options dialog box, from the View menu. You 
will probably want to save this log file to a local drive.

When Site Builder is used in tandem with Site Server, you set the translation log file in the 
New Task dialog box in Site Scheduler. You do this for each task (project file), as you 
schedule it, and will probably want to save this log file to a network drive.

The server log file is set in the Site Server dialog box. Like the translation log, the logging 
options include logging level as well as the path and file name for the file.

Logging Levels
When you create a translation log file or a server log file in Content Publisher, you can 
choose from the following logging levels:

! 0 - No Logging — Site Server won’t create a log file.

! 1 - Start/Stop and fatal errors — The log file will include the start and stop times of 
the translation and provide a summary of fatal errors, if any, indicating which input 
files caused the errors.

! 2 - Warning errors — The log file will list all warnings in addition to start and stop 
times and fatal errors (each logging level includes the levels below it). It will identify 
which input files caused the warnings.

Note: Because logging information set in Site Builder is user-specific for a given machine, 
and is not saved to the project file, any information set in the Application Options dialog 
box is irrelevant when a project is passed to Site Server for translation. So whatever is 
specified in the New Task dialog box will prevail. (If no log file is specified, none will be 
created.)
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! 3 - Input files processed — The log file will also include a complete list of all input 
files processed.

! 4 - Output files generated — The log file will also include a complete list of all 
output files generated by Site Server, including frames, reference pages, and graphics 
files. This is the default logging level.

! 5 - Diagnostic/Verbose — The log file provides diagnostic reporting.

Logging Errors
If Site Builder generates any fatal errors or warnings during translation, the Translation 
Warnings/Errors dialog box will appear. You can click the Log File button to open the log 
file immediately. You should consult Logfile.txt (the default name of the log file), to 
determine the cause of the error. Unless you have changed the name or the output 
directory, you should find Logfile.txt in the Content Publisher directory.

A fatal error means Site Builder was unable to translate the source document that caused 
the error. This could happen, for example, if the source document is corrupted. In that 
event, Site Builder will move to the next source document to continue the translation. But 
it won’t create an output page for the document that caused the fatal error.

Site Builder may also generate warnings during translation (these are simply logged in the 
log file). Warnings are less critical. Site Builder will still create an output page for the 
document, but the translation may not be completely successful. For example, if Site 
Builder cannot find a graphic during translation, it will produce an output file without the 
graphic -- and flag the omission with a warning. 

Generally, a warning means the translation is not completely successful and that you have 
to correct the problem that has been flagged. In two instances, however, Site Builder will 
correct the problem. First, if “promotion” information is missing from the temporary 
database file, Site Builder will do a full translation to regenerate this information. Second, 
if links between documents have been broken, Site Builder will fix them (broken links 
should occur only if the HTML code has been manually edited.)

Whether a fatal error or a warning has occurred, the log file will tell you which input files 
have caused the problem. For more information on logging levels, see Setting Up the 
Translation Log on Site Builder (page A-5).

You can also check the Status column in the Contents pane for fatal errors after each 
translation. A blue exclamation mark (!) will appear opposite any source document that 
Site Builder could not translate. (Blue exclamation marks that appear temporarily 
onscreen during translation can be ignored.)
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Viewing the Translation Log File
Site Builder generates a log file each time you translate a publication. This translation log 
summarizes translation details, including errors or warnings that may have occurred 
during the translation process.

A translation log file is set up by default for each new project in Site Builder. You can, of 
course, modify your log file settings at any time, such as the logging level, log file 
location, and log file format (text or HTML).

Log file settings can be found in the Application Options (available from the View menu) 
or the New Task dialog (when you are using Site Scheduler to schedule projects in Site 
Server).

HTML Log File
Site Builder includes a friendly alternative to conventional log file formats. With HTML 
formatting enabled, you can quickly find what you are looking for by using the color-
coded system available for this format.

Figure A-1 Sample log file

At the top of the log file, you will find additional links to customize the log file layout.

! Go To Bottom/Go To Top — Provides a quick jump to the top or bottom of the log 
file.
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! Enable Word Wrap — Provides word wrapping so that you can view your log file in 
a smaller area.

! Preferences — Opens a set of controls that allow you to change the log text attributes 
for each logging level. This can be especially useful when you are working on a 
particular task or troubleshooting a specific error message.

! Search/Reset — Provides a back/next style of navigation and a global query of the 
entire log file, regardless of the number of HTML pages. (Site Builder will break up 
HTML log files at every 1000 lines to reduce the amount of time it takes to open the 
log file in a browser.)

For more information on the contents of a log file, see Logging Errors (page A-3).

Choose Log File from the View menu in Site Builder to view your existing log file. 
Alternatively, you can view the log file from certain error messages, such as the 
Translation Warnings/Errors dialog box.

The Preferences in the HTML log file rely on the Internet Explorer browser. You can view 
the log file in Netscape Navigator, but the log file may load slowly.

If you have another browser session open in a second window, the HTML log file will 
display in that window, regardless of its size. To view the translation log file in its entirety, 
close all other browser windows before viewing the log file.

Setting Up the Translation Log on Site Builder
The translation log file is a text or HTML file that Site Builder creates by default each time 
you translate a publication. It summarizes translation details, including any fatal errors or 
warnings that may have occurred during translation. (See Setting Up the Translation Log 
File on Site Server on page A-7.)

1. From the View menu, choose Application Options to open that dialog box.

2. Under Logging, select the level of logging you want from the drop-down list of 
options. The default is Level 4.

0 - No Logging means that Site Builder won’t create a log file. With one of the other 
five options, Site Builder will create a log file with the degree of detail based on the 
logging level.

1 - Start/Stop and fatal errors — The log file will include the start and stop times of 
the translation and provide a summary of fatal errors, if any, indicating which input 
files caused the errors.
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2 - Warning errors — The log file will list all warnings in addition to start and stop 
times and fatal errors (each logging level includes the levels below it). It will identify 
which input files caused the warnings.

3 - Input files processed — The log file will also include a complete list of all input 
files processed.

4 - Output files generated — The log file will also include a complete list of all 
output files generated by Site Builder, including frames, reference pages, split HTML 
files, and graphics files.

5 - Diagnostic/Verbose — Provides the maximum amount of logging information.

3. Choose HTML or Text from the Format field. With HTML formatting enabled, you 
can quickly find what you are looking for using a color-coded logging system. The log 
file includes a set of preferences for customizing the layout of the log details.

4. Click Reset log file for each translation if you want Site Builder to create a log file 
just for the current translation. Clear this check box if you want to create a continuous 
record of all logging. Site Builder will then add new logging information to the log file 
each time you translate a publication.

5. In the Log File text box, type the path and file name for the log file. (You can change 
the name of the log file as well as the path.) Alternatively, use the Browse button to 
search for the directory you want to use.

This setting is user-specific on a given machine. It applies to all projects run on the 
machine by the user logged in at the time of the change.

If Site Builder generates any fatal errors or warnings during translation, the Translation 
Warnings/Errors dialog box will appear. You can click the Log File button to open the log 
file immediately. A fatal error (for example, because of a corrupt source document) will 
result in a source document not being translated. A warning (which could result from a 
missing graphic) means that the translation has not been completely successful.

You can view the log file at any time by clicking Log File on the View menu. Site Builder 
will open the log file created during your last translation.
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Setting Up the Translation Log File on Site 
Server
The translation log is a text or HTML file that Site Server creates each time you translate a 
project. It summarizes translation details, including any errors or warnings that may have 
occurred during translation. (See Setting Up the Translation Log File on Site Server on 
page A-7.)

Any logging options you may have set in the Application Options dialog box in Site 
Builder are application-specific and won’t be saved to the project file. When scheduling a 
project for translation by Site Server, you must set logging information in the New Task 
(or Edit Task) dialog box.

Follow these instructions to set up a translation log file:

1. With a project selected in the Site Scheduler window, click Edit Task ( ) on the 
toolbar or choose Edit from the Task menu to open the Edit Task dialog box.

2. In the Log File text box, type the path and file name for the log file for this project. 
Alternatively, use the Browse button to locate the directory you want to use.

3. Select the level of logging from the drop-down list of options. The default level is 4. 
(See Logging Levels on page A-2 for more information.)

4. Click Clear log file if you want Site Server to create a log file just for the current 
translation. Clear this check box if you want Site Server to create a continuous record 
of all logging. Site Server will then append new logging information to the log file 
each time it translates a project.

5. Choose HTML or Text from the Format field. With HTML formatting enabled, you 
can quickly find what you are looking for using a color-coded logging system. The log 
file includes a set of preferences for customizing the layout of the log details.

The default translation log file name is Logfile.txt, and the default directory is:
C:\Documents and Settings\<username>\My Documents\Stellent

If you decide to capture information for successive translations in the same file, you will 
probably want to periodically “reset” the log file, because otherwise you will end up with 
a very large file.

You can attach the log file to an email notification for a task. The email is automatically 
generated to confirm how successfully the task has been translated, staged, or published. 
See Sending an E-Mail Notification for a Task (page 8-35) for more information.
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Setting Up the Server Log File on Site Server
The server log is a text file that Site Server creates each time you translate a project. It is 
used to monitor server activity and track the translation of multiple tasks.

You specify a server log file in the Site Server dialog box.

1. To open the Site Server Options dialog, do one of the following, depending on your 
setup:

! From the Start menu in Windows, choose Settings, and then Control Panel. In 
the Control Panel window, double-click the Site Server icon, or

! Right-click the Site Server icon on the Windows taskbar, and choose Properties 
from the popup menu.

2. In the Site Server dialog box, under Logging, enter the path and name of the log file 
you want to use in the Server Log File text box.

3. Under Logging Level, select a logging level from the drop-down list of options. (See 
Logging Levels on page A-2 for more information.)

4. Click OK.

The default server log file name is Serverlog.txt, and the default directory is:
C:\Documents and Settings\<username>\My Documents\Stellent

ERRORS AND WARNING MESSAGES
Content Publisher requires that certain tasks be completed in a particular order for 
successful translation, staging, and publishing to occur; otherwise, you may encounter a 
number of error messages or warnings.

This section summarizes the most common messages generated by Content Publisher and 
Content Server along with the appropriate steps to resolve and prevent the error from 
happening in the future.

! Error: The Stellent Gateway Local Server could not be instantiated (page A-9)

! Error: The following conflicts were noted prior to translation (page A-10)

! Error: The following document could not be prepared for previewing (page A-10)

! Error: The following document is in an unsupported format (page A-11)

! Error: The project cannot be read (page A-11)

! Error: This project cannot be opened (page A-11)
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! Error: This template cannot be imported (page A-12)

! Error: Warnings and/or Errors occurred (page A-12)

! Warning: Content Server is currently unavailable (page A-12)

! Warning: A valid file specification has not been entered (page A-13)

! Warning: The path specified is invalid or does not exist (page A-13)

! Warning: The project file was not properly saved during a prior session (page A-13)

! Warning: You have imported a manually formatted document into a template 
(page A-14)

! Warning: You have imported a styled document into a template (page A-14)

! Warning: You must translate the publication at least once prior to preview 
(page A-15)

! Warning: Confirm your current staging options (page A-15)

! Warning: Confirm your current publishing options (page A-16)

Error: The Stellent Gateway Local Server could 
not be instantiated
Serverlog.txt: <IAStellent> Attempting to connect to Content Server 'intradocdev’ at CGI 
URL 'http://address here/'. The Stellent Gateway Local Server could not be instantiated. 
Ensure that IAStellentCommLink.exe is available and properly registered. Unable to 
connect to library 'intradocdev'

! Details: Site Server cannot connect to Content Server because the 
IAStellentCommLink component has not been instantiated, or accessed. This issue 
was resolved in Stellent Content Publisher 5.1.

! Resolution: You can correct this by setting the application access permissions for the 
IAStellentCommLink component (using the DCOM Configuration).
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Error: The following conflicts were noted prior 
to translation
File Conflicts Notice: The following conflicts were noted prior to translation. Press OK to 
continue with the translation or Cancel to stop the translation.

! Details: One or more output files will overwrite existing files in the output 
directory—each file originating from a different source. This is especially common 
when working with Content Server. This message should not be taken lightly; one of 
the alike file names will be overwritten!

! Resolution: If you don't mind overwriting the files specified, click OK; otherwise, 
click Cancel and perform one of the following tasks:

! Rename the specified file or files in your publication to prevent overwriting.

! Move the specified output files to another, distinct directory.

! Change your output directory for the current publication.

! More information: File Conflicts Notice (page 5-103).

Error: The following document could not be 
prepared for previewing
Preview Fail: The following document could not be prepared for previewing. Please refer 
to the log file for further information.

! Details: Preview failure often results from a much larger issue, such as a missing or 
damaged source document. (The source document may have changed, could be 
corrupt, or possibly unsupported by Content Publisher.)

! Resolution: To resolve a preview failure, set your logging to 5, perform a full 
translation, and check your log file for translation problems.

! More information: Preview Fail (page 7-5).
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Error: The following document is in an 
unsupported format
Import Failure: The following document is in an unsupported format: Any styles and/or 
patterns in this document will not be added to the template. Would you like to continue?

! Details: The document you are importing falls outside of the supported Site Builder 
formats (word processing, spreadsheet, presentation files, etc.).

! Resolution: Verify the document you are importing is listed as a compatible format in 
the below topic.

! More information: File Formats and Translation (page 5-44).

Error: The project cannot be read
Site Builder: The Project cannot be read. Please check that you selected a Content 
Publisher project.

! Details: Content Publisher must recognize a project file (version 3.0 or later) in order 
to open, manage, and publish with it.

! Resolution: Verify that the file you are opening is a supported version and that other 
projects can be opened with your copy of Site Builder.

! More information: About Projects (page 4-2).

Error: This project cannot be opened
Site Builder: This project cannot be opened because it contains items from a repository 
that is not currently available.

! Details: Your workstation does not have access to the repository containing source 
documents, graphics, or associated files for this project.

! Resolution: Verify that your Site Builder has access to the necessary repositories—
FTP, HTTP, or Content Server. It may be necessary to reinstall Content Publisher to 
restore the repository components (DLLs).

! More information: Selecting a Repository (page 5-8).
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Error: This template cannot be imported
Site Builder: This template cannot be imported. Please ensure that you select a valid 
template file.

! Details: Templates with the .ttp extension are recognized by Site Builder as valid 
template files.

! Resolution: Verify that you are importing a template and not a source document, 
graphic, or other unsupported format.

! More information: Importing a Template (page 6-13).

Error: Warnings and/or Errors occurred
Warnings/Errors: Warnings and/or Errors occurred. Please refer to the log file for 
further information.

! Details: Problems occurred during translation. An output page is created, but the 
translation may not have been successful. 

! Resolution: Click the Log File button to open the log file and determine which input 
file may have caused the problem. You may need to set your logging level to 5.

! More information: Logging Errors (page A-3).

Warning: Content Server is currently 
unavailable
Content Publisher: The project file could not be saved to Content Server. Content 
Publisher has saved a backup copy of the project. You will be able to recover the project 
once communication with the Content Server has been re-established.

! Description: Your workstation cannot communicate with Content Server for some 
reason. Your project file and history file have been saved to your hard drive, where 
you will be able to recover them later.

! Resolution: Do not try to open the recoverable version on your hard drive. Wait until 
Content Server is available once again, and then open your project in the usual way 
from the content server. Content Publisher will retrieve the recoverable project file 
from your hard drive. 

! More information: Project Recovery When the Content Server is Unavailable 
(page A-16).
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Warning: A valid file specification has not been 
entered
Hierarchy Import: The pass through option has been enabled, but a valid file 
specification has not been entered. Do you want to continue?

! Details: When pass-through conversion is selected, source documents are passed 
through to the output folder in their original format. This assumes the file format is 
web viewable or can be viewed on your visitors' machines.

! Resolution: When using this option, it is highly recommended that you specify which 
file formats, in the form of a wildcard (*.doc;*.txt), to pass-through; otherwise, you 
run the risk of converting file formats that cannot be viewed in your web publication.

! More information: Passing Through Source Documents Without Conversion 
(page 5-38).

Warning: The path specified is invalid or does 
not exist
Path Fixup: The path specified is invalid or does not exist. Do you want to use this path 
anyway?

! Details: Site Builder cannot find a file or directory while opening a project and in 
turn, creates an artificial location.

! Resolution: Choose Yes to accept the new directory and repair the missing files or 
directories at a later time, or choose No to resolve this problem now.

! More information: Replacing a File or Directory (page 4-20).

Warning: The project file was not properly 
saved during a prior session
Content Publisher: The project file titled <title> was not properly saved to Content 
Server during a prior session. Content Publisher automatically created a backup copy of 
the project file dated <date>. Do you want to recover this project? If you want to recover 
the project, click Yes. If you want to open the version from the content server, click No.

If you want to open the recoverable version from your hard drive, click OK. If you want to 
open the selected version from the content server, click No.
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! Description: Since communication with Content Server has been re-established, you 
can now open the recoverable version of the project file from your hard drive.

! Resolution: Click OK and Content Publisher will retrieve the recoverable version 
from your hard drive. Then click Save to save the recoverable version to your content 
server.

! More information: Project Recovery When the Content Server is Unavailable 
(page A-16).

Warning: You have imported a manually 
formatted document into a template
Import Conflict: You have imported a manually formatted document into a template 
which formerly contained style-based elements. You can choose OK to continue, Cancel 
to stop this process, or Help for more information.

! Details: Patterns take precedence over styles. When the two are combined, a conflict 
arises and the formatting associated with a particular style may be overridden by a 
pattern.

! Resolution: Click OK to continue importing the document and then resolve the 
conflict at a later time or click Cancel to stop the process and resolve the conflict 
using one of the following methods:

! Remap a pattern or a style to another element (if you know where the potential 
conflict will occur).

! Create two identical templates and use one only for styled documents and the 
other for manually formatted documents.

! More information: Resolving Import Conflicts Between Styles and Patterns 
(page 6-92).

Warning: You have imported a styled document 
into a template
Import Conflict: You have imported a styled document into a template which formerly 
contained pattern-based elements. You can choose OK to continue, Cancel to stop this 
process, or Help for more information.
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! Details: Patterns take precedence over styles. When the two are combined, a conflict 
arises and the formatting associated with a particular style may be overridden by a 
pattern.

! Resolution: Click OK to continue importing the document and then resolve the 
conflict at a later time or click Cancel to stop the process and resolve the conflict 
using one of the following methods:

! Remap a pattern or a style to another element (if you know where the potential 
conflict will occur).

! Create two identical templates and use one only for styled documents and the 
other for manually formatted documents.

! More information: Resolving Import Conflicts Between Styles and Patterns 
(page 6-92).

Warning: You must translate the publication at 
least once prior to preview
Site Builder: You must translate the publication at least once before you can preview a 
reference document.

! Details: A reference document must be populated with linked documents before it can 
exist as a reference page or be previewed as a reference page. This is one of the many 
roles of a publication translation.

! Resolution: To preview a reference document, first translate your publication, thus 
populating the document with content.

! More information: Using the Edit Template Dialog Box (page 6-7).

Warning: Confirm your current staging options
Confirm Staging Options: Your current staging settings are: Repository: Output 
locations for: Pages: Graphics: Gallery graphics: Please note that this will be an 
incremental staging operation. If these settings are not correct then select Cancel and 
change the settings in the ‘Staging Options’ dialog box (available from the Run menu).

! Details: This confirmation dialog box opens each time you Stage a project (assuming 
you have set staging options) and gives you a chance to change your staging settings.
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! Resolution: Click OK to accept the staging options and continue publishing to the 
staging server or Cancel to return to the Staging Options dialog box, where you can 
specify different options.

! More information: Confirming Staging Options (page 8-3).

Warning: Confirm your current publishing 
options
Confirm Publish Options: Your current publishing settings are: Repository[name of 
repository]; Output locations for [paths and directories for Pages, Graphics, Gallery 
graphics]; Please note that this will be an incremental publish operation. If these settings 
are not correct, then select Cancel and change the settings in the ‘Publish Options’ dialog 
box (available from the Run menu).

! Details: This confirmation dialog box opens each time you Publish a project 
(assuming you have set publishing options) and gives you a chance to change your 
publishing settings.

! Resolution: Click OK to accept the publishing options and continue publishing to the 
repository or Cancel to return to the Publishing Options dialog box, where you can 
specify different options.

! More information: Confirming Publishing Options (page 8-21).

PROJECT RECOVERY WHEN THE CONTENT SERVER 
IS UNAVAILABLE

If Content Server is unavailable when you try to save a project, Content Publisher will 
automatically save the project to a special folder on your hard drive. You will be able to 
recover the project file once communication with the content server has been re-
established.

When you open a project from Content Server, Content Publisher tracks the project by 
means of Project Recovery Manifest.hda, which resides in the Project Recovery folder in 
your Content Publisher directory. (Both the file and folder are created the first time you 
communicate with Content Server to save a new project or to check out an existing one.)

When you are running a project in Content Publisher, you may find that you cannot save 
the project to Content Publisher. For example, the content server may have been turned 
off, there may be a connection problem, or you may have run out of disk space. 
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In that event, Content Publisher will automatically save the project file (and the history 
file) to the Project Recovery folder. It will confirm this with an onscreen message. 

Once Content Server is available again, you should open your project from Content Server 
in the usual way.

1. In Content Server, click the appropriate Select button on the Select a Project page to 
open the latest version of the project.

2. A message appears, to alert you that a recoverable version of the project is available 
on your hard drive. Click OK. 

3. A second message may ask whether you want to undo the checkout of the project from 
the content server. Click OK. 

This message will appear only if the project is still checked out. (Conceivably, you or 
someone else may have undone the checkout in the content server after the project 
was saved to your hard drive.) 

4. When the recovered project opens in Content Publisher, click Save on the File menu 
to save the recoverable version to the content server immediately.

Follow these instructions to use a version other than the recoverable project file:

If you don’t want to use the recoverable version of a project, you can use the latest version 
in the content server (or an earlier one), instead. 

1. In Content Server, select the appropriate Select button on the Select a Project page to 
open the particular version of the project you prefer to use. 

2. If you select the latest version, the message alerting you that a recoverable version is 
available will appear. Click No. A second message may ask you whether you want to 
undo the checkout of the project from the content server. Click OK. 

3. If you have selected an earlier version of the project file, it will open immediately in 
Site Builder.

In either case, the recoverable version on your hard drive will be automatically deleted.

If you are scheduling projects on Site Server, a default setting ensures that the project is 
automatically saved to the Project Recovery folder on the Server machine (the log file will 
flag this event). The next time you run the task, Site Server will automatically retrieve the 
recoverable version of the project file from your hard drive and run that version. It will 
also save that recovered version back to the content server. 

If you don’t want Site Server to save project files in this way, you should clear the Allow 
recovery of project files where possible check box on the Options tab dialog of the Site 
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Server Properties dialog box. (Depending on your setup, you can open this dialog box 
either from the Control Panel or by right-clicking the Site Server icon on the taskbar.)

You shouldn’t try to open the project directly from the Project Recovery folder, unless 
your content server is permanently unavailable. In that event, however, you will have to 
recreate your project, because your source documents will no longer be available 
(assuming these were in the same content server as your project file).
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B.OFFICE 2007 LIMITATIONS
This section provides a number of limitations related to conversion of Office 2007 files:

! All Office Applications (page B-1)

! Word 2007 (page B-2)

! Excel 2007 (page B-3)

! PowerPoint 2007 (page B-3)

! Examples of Unsupported Objects (page B-4)

ALL OFFICE APPLICATIONS
Please note the following conversion limitations that currently apply for all Office 2007 
applications:

! Smart art (see Examples of Unsupported Objects on page B-4 for an example)

! VB controls and macros (see Examples of Unsupported Objects on page B-4 for an 
example)

! Table cell formatting

! Word art (see Examples of Unsupported Objects on page B-4 for an example)

! Vector graphics (Office art & VML) transparency, picture styles, effects, etc. 
(see Examples of Unsupported Objects on page B-4 for an example)

! Password-protected documents
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WORD 2007
Please note the following conversion limitations that currently apply for Word 2007 
documents:

! Picture bullets

! Tint support

! Table styles (see Examples of Unsupported Objects on page B-4 for an example)

• Different column and row definitions (even/odd, etc.)

• Different header row and column definitions

! List level overrides

! Alternate text

! OLE objects

! Equations (see Examples of Unsupported Objects on page B-4 for an example)

! Theme effects (in Office art)

! Line numbers

! Watermarks

! Page color (not supported in the viewer)

! Footnote and end note reference numbers

! Revision delete attributes (text is supported)

! Controls (only last edited text is output for legacy controls)

! Custom XML (structure, schemas, expansion packs), cfChunk/altChunks are not 
supported
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EXCEL 2007
Please note the following conversion limitations that currently apply for Excel 2007 
spreadsheets:

! Conditional formatting (highlight cells with rules, top bottom rules, data bars, color 
scale icon sets, and custom rules; see Examples of Unsupported Objects on page B-4 
for an example).

! Formatting as tables (the data in the cell is output, but the formatting is not retained)

! Headers and footers (different even/odd page headers are not supported)

! Protected workbooks

POWERPOINT 2007
Please note the following conversion limitations that currently apply for PowerPoint 2007 
presentations:

! Table formatting (similar to Excel)

! Actions are currently not supported

! “Objects” (this is represented as VML; currently not supported)

! Movies/sounds are not supported

! Complex gradients are not supported (see Examples of Unsupported Objects on 
page B-4 for an example)

! Animation is currently not supported

! Only solid fills are supported for text

! Only left-to-right text direction is supported (not related to bidi)

! Shading and fills of certain shapes are not supported (see Examples of Unsupported 
Objects on page B-4 for an example)

! Transparency of lines/vector objects is not supported
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EXAMPLES OF UNSUPPORTED OBJECTS
This section provides some examples of Office 2007 objects that cannot be converted at 
this point.

Figure B-1 Smart art

Figure B-2 Table styles
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Figure B-3 Picture styles/effects

Figure B-4 Word art

Figure B-5 Equations

Figure B-6 Controls
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Figure B-7 Data bars with conditional formatting, color scales, and icon sets

Figure B-8 3D effects in PowerPoint

Figure B-9 Complex gradients
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Figure B-10 Complex shapes with varying fills (1)

Figure B-11 Complex shapes with varying fills (2)
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C.THIRD PARTY LICENSES

OVERVIEW
This appendix includes a description of the Third Party Licenses for all the third party 
products included with this product.

! Apache Software License (page C-1)

! W3C® Software Notice and License (page C-2)

! Zlib License (page C-4)

! General BSD License (page C-5)

! General MIT License (page C-5)

! Unicode License (page C-6)

! Miscellaneous Attributions (page C-7)

APACHE SOFTWARE LICENSE
* Copyright 1999-2004 The Apache Software Foundation.

* Licensed under the Apache License, Version 2.0 (the "License");

* you may not use this file except in compliance with the License.

* You may obtain a copy of the License at

*      http://www.apache.org/licenses/LICENSE-2.0

* 
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* Unless required by applicable law or agreed to in writing, software

* distributed under the License is distributed on an "AS IS" BASIS,

 * WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

 * See the License for the specific language governing permissions and

 * limitations under the License.

W3C® SOFTWARE NOTICE AND LICENSE
* Copyright © 1994-2000 World Wide Web Consortium, 

* (Massachusetts Institute of Technology, Institut National de 

* Recherche en Informatique et en Automatique, Keio University). 

* All Rights Reserved.  http://www.w3.org/Consortium/Legal/

* 

* This W3C work (including software, documents, or other related items) is

* being provided by the copyright holders under the following license. By

* obtaining, using and/or copying this work, you (the licensee) agree that

* you have read, understood, and will comply with the following terms and

* conditions:

* 

* Permission to use, copy, modify, and distribute this software and its

* documentation, with or without modification, for any purpose and without

* fee or royalty is hereby granted, provided that you include the following

* on ALL copies of the software and documentation or portions thereof,

* including modifications, that you make:

* 

*   1. The full text of this NOTICE in a location viewable to users of the

*      redistributed or derivative work.

* 

*   2. Any pre-existing intellectual property disclaimers, notices, or terms
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*      and conditions. If none exist, a short notice of the following form

*      (hypertext is preferred, text is permitted) should be used within the

*      body of any redistributed or derivative code: "Copyright ©

*      [$date-of-software] World Wide Web Consortium, (Massachusetts

*      Institute of Technology, Institut National de Recherche en

*      Informatique et en Automatique, Keio University). All Rights

*      Reserved. http://www.w3.org/Consortium/Legal/"

* 

*   3. Notice of any changes or modifications to the W3C files, including the

*      date changes were made. (We recommend you provide URIs to the location

*      from which the code is derived.)

* 

* THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS," AND COPYRIGHT HOLDERS

* MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT

* NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR

* PURPOSE OR THAT THE USE OF THE SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE

* ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.

* 

* COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL OR

* CONSEQUENTIAL DAMAGES ARISING OUT OF ANY USE OF THE SOFTWARE OR

* DOCUMENTATION.

* 

* The name and trademarks of copyright holders may NOT be used in advertising

* or publicity pertaining to the software without specific, written prior

* permission. Title to copyright in this software and any associated

* documentation will at all times remain with copyright holders.

*
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ZLIB LICENSE
* zlib.h -- interface of the 'zlib' general purpose compression library

  version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied

  warranty.  In no event will the authors be held liable for any damages

  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,

  including commercial applications, and to alter it and redistribute it

  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not

     claim that you wrote the original software. If you use this software

     in a product, an acknowledgment in the product documentation would be

     appreciated but is not required.

  2. Altered source versions must be plainly marked as such, and must not be

     misrepresented as being the original software.

  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly jloup@gzip.org

  Mark Adler madler@alumni.caltech.edu
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GENERAL BSD LICENSE
Copyright (c) 1998, Regents of the University of California

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, 

are permitted provided that the following conditions are met:

"Redistributions of source code must retain the above copyright notice, this 

list of conditions and the following disclaimer. 

"Redistributions in binary form must reproduce the above copyright notice, this 

list of conditions and the following disclaimer in the documentation and/or other 

materials provided with the distribution. 

"Neither the name of the <ORGANIZATION> nor the names of its contributors may be 

used to endorse or promote products derived from this software without specific 

prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. 

IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 

PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE.

GENERAL MIT LICENSE
Copyright (c) 1998, Regents of the Massachusetts Institute of Technology

Permission is hereby granted, free of charge, to any person obtaining a copy of this 

software and associated documentation files (the "Software"), to deal in the 

Software without restriction, including without limitation the rights to use, copy, 

modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 

and to permit persons to whom the Software is furnished to do so, subject to the 

following conditions:
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The above copyright notice and this permission notice shall be included in all 

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 

PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 

HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 

CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 

OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

UNICODE LICENSE
UNICODE, INC. LICENSE AGREEMENT - DATA FILES AND SOFTWARE

Unicode Data Files include all data files under the directories 

http://www.unicode.org/Public/, http://www.unicode.org/reports/, and 

http://www.unicode.org/cldr/data/ . Unicode Software includes any source code 

published in the Unicode Standard or under the directories 

http://www.unicode.org/Public/, http://www.unicode.org/reports/, and 

http://www.unicode.org/cldr/data/.

NOTICE TO USER: Carefully read the following legal agreement. BY DOWNLOADING, 

INSTALLING, COPYING OR OTHERWISE USING UNICODE INC.'S DATA FILES ("DATA FILES"), 

AND/OR SOFTWARE ("SOFTWARE"), YOU UNEQUIVOCALLY ACCEPT, AND AGREE TO BE BOUND BY, 

ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT 

DOWNLOAD, INSTALL, COPY, DISTRIBUTE OR USE THE DATA FILES OR SOFTWARE.

COPYRIGHT AND PERMISSION NOTICE

Copyright © 1991-2006 Unicode, Inc. All rights reserved. Distributed under the 

Terms of Use in http://www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining a copy of the 

Unicode data files and any associated documentation (the "Data Files") or Unicode 

software and any associated documentation (the "Software") to deal in the Data 

Files or Software without restriction, including without limitation the rights to 

use, copy, modify, merge, publish, distribute, and/or sell copies of the Data Files 

or Software, and to permit persons to whom the Data Files or Software are furnished 

to do so, provided that (a) the above copyright notice(s) and this permission notice 

appear with all copies of the Data Files or Software, (b) both the above copyright 

notice(s) and this permission notice appear in associated documentation, and (c) 

there is clear notice in each modified Data File or in the Software as well as in 
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the documentation associated with the Data File(s) or Software that the data or 

software has been modified.

THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO 

EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR 

ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES 

WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF 

CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH 

THE USE OR PERFORMANCE OF THE DATA FILES OR SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used 

in advertising or otherwise to promote the sale, use or other dealings in these Data 

Files or Software without prior written authorization of the copyright holder.

________________________________________Unicode and the Unicode logo are trademarks 

of Unicode, Inc., and may be registered in some jurisdictions. All other trademarks 

and registered trademarks mentioned herein are the property of their respective 

owners

MISCELLANEOUS ATTRIBUTIONS
Adobe, Acrobat, and the Acrobat Logo are registered trademarks of Adobe Systems 
Incorporated.

FAST Instream is a trademark of Fast Search and Transfer ASA.

HP-UX is a registered trademark of Hewlett-Packard Company.

IBM, Informix, and DB2 are registered trademarks of IBM Corporation.

Jaws PDF Library is a registered trademark of Global Graphics Software Ltd.

Kofax is a registered trademark, and Ascent and Ascent Capture are trademarks of 
Kofax Image Products.

Linux is a registered trademark of Linus Torvalds.

Mac is a registered trademark, and Safari is a trademark of Apple Computer, Inc.

Microsoft, Windows, and Internet Explorer are registered trademarks of Microsoft 
Corporation.

MrSID is property of LizardTech, Inc. It is protected by U.S. Patent No. 5,710,835. 
Foreign Patents Pending.

Oracle is a registered trademark of Oracle Corporation.

Portions Copyright © 1994-1997 LEAD Technologies, Inc. All rights reserved.
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Portions Copyright © 1990-1998 Handmade Software, Inc. All rights reserved.

Portions Copyright © 1988, 1997 Aladdin Enterprises. All rights reserved.

Portions Copyright © 1997 Soft Horizons. All rights reserved.

Portions Copyright © 1995-1999 LizardTech, Inc. All rights reserved.

Red Hat is a registered trademark of Red Hat, Inc.

Sun is a registered trademark, and Sun ONE, Solaris, iPlanet and Java are trademarks 
of Sun Microsystems, Inc.

Sybase is a registered trademark of Sybase, Inc.

UNIX is a registered trademark of The Open Group.

Verity is a registered trademark of Autonomy Corporation plc
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GLOSSARY
absolute URL
The full Internet address of a Web page. It consists of the transfer protocol, network 
location, and optional path and file name. For example: 
http://www.stellent.com/news/update.htm, where ‘http’ defines the transfer protocol, 
‘www.stellent.com’ identifies the server where the document resides, ‘news’ is a 
subdirectory, and ‘update.htm’ is the file name.

active link
The currently selected link on a Web page. Web browsers often display links in a different 
color when clicked—and change the color again, once the reader has visited the site or 
page the link points to.

Active Server Pages
A Microsoft scripting language capable of performing server side functions with 
Microsoft Internet Information Server (IIS). ASP (and more recently ASP+) can be used 
to build dynamically assembled Web pages that draw information (using queries) from a 
relational database. ASP pages contain the .asp file extension.

ActiveX control
A component that can be embedded in a Web page to provide functionality not directly 
available in HTML, such as animation sequences and spreadsheet calculations. ActiveX 
controls can be activated in a number of programming languages.
Content Publisher User Guide G-1



Glossary
Address (System)
A special element that is part of every template in Site Builder. Used to format an address 
in a Web page, that is, the information entered under Address Lines in the Address tab 
dialog of the Globals property sheet.

administrator
A person or computer login that has maximum privileges over the computer or network. 
Administrative access includes the ability to use every feature of the system and assign 
unique privileges to other users.

anchor
A named location on a Web page that serves as the target of another hyperlink. Anchor 
tags allow you to link to a specific section of a Web page. In a URL, an anchor is preceded 
by the pound (#) sign. Anchors are also called bookmarks.

applet
Short for Java applet, a short program written in Java that is embedded in a Web page and 
executed by a Web browser. Java applets are frequently used to add interactivity or 
application functions to a Web page. Java applets can be read by Microsoft Internet 
Explorer, Netscape Navigator, or any Web browser capable of interpreting Java.

ASCII 
American Standard Code for Information Interchange. A universally recognized text-only 
format that contains characters, spaces, punctuation, etc., but no formatting information. 
You can transfer ASCII files between programs that could not otherwise understand each 
other’s documents. HTML files can be encoded in ASCII format.

background color
The color setting of a Web page or table cell.

background graphic
The graphic used instead of a color for the background of a Web page. Each graphics set 
in Site Builder includes a background graphic that is automatically applied to all Web 
pages created from the template the graphics set has been applied to.

base URL
An optional URL that you can assign to a Web page to convert relative URLs on the page 
to absolute URLs. A base URL should end with a document name, such as 
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http://www.stellent.com/news.htm, or a trailing slash, such as 
http://www.stellent.com/news/. A base URL is also called a base location.

bitmap (.bmp)
A Windows-compatible graphics file format in which the image is represented by a series 
of bits. Site Builder converts numerous image types, including bitmaps, in source 
documents into the GIF, JPEG, PNG, WBMP, or BMP format.

body page
What a source document becomes when translated by Site Builder. Translated output 
consists mostly of body pages, but Site Builder can also create reference pages to navigate 
the body pages.

bookmark
1) A means to store a Web site or other Internet URL for future use. Instead of entering the 
URL each time a user wants to visit a site, the user can open the URL once, 'bookmark' the 
URL, then use the bookmark to make subsequent visits. Bookmarks are also called 
'Favorites.'
2) A named location on a Web page that serves as the target of another hyperlink. 
Bookmarks allow you to link to a specific section of a Web page. In a URL, a bookmark is 
preceded by the pound (#) sign. Bookmarks are also called anchors.

broken hyperlink
A hyperlink that points to a URL or file that does not exist (or one that cannot be found by 
the computer).

bulleted list
A series of related items in paragraphs set off by bullets. Also known as an unordered list.

cell
The smallest component of a table.

cell padding
The amount of space between the content and border of a table cell.

cell spacing
The amount of space between cells in a table.
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character
A single alphabetic letter, numeric digit, or special symbol such as a decimal point or 
comma.

character element
An element used to format only characters, that is, a portion of text in a paragraph.

client
On a network or the Internet, a program that requests files or services from another 
computer with shared resources (usually a server).

content server
Any Content Server. In the context of the publishing process within Content Publisher, a 
content server may be a source server (where source documents reside), a staging server 
(where a project is staged for review purposes), or a publishing server (the final Web site).

Contents pane
One of two panes in the main window of Site Builder where project setup takes place. 
Displays output pages, the paths and names of source documents, and the template 
associated with each document. The Publication Hierarchy pane displays the publication 
hierarchy.

core HTML tags
The most commonly used HTML tags: six heading tags, the paragraph tag for all text, and 
two tags for handling lists.

Cascading Style Sheets (CSS)
A means of separating structure from presentation so as to introduce layout control over 
Web pages. Style sheets can be included in an HTML document by (a) linking to an 
outside style sheet, (b) embedding a document-wide style in the <HEAD> tag of the 
document, or (c) embedding inline styles where needed. Site Builder implements CSS 
both the second and third way. (Outside style sheets can be added by using the 'Include 
HTML or scripting code before content' option.)

Custom Table Layout
An option in the Layout dialog box of Site Builder. Users can create a custom HTML table 
layout using a third party editor (Microsoft FrontPage, Macromedia Dreamweaver, Adobe 
GoLive, etc.) and then apply that layout to a publication using this feature. Tokens are 
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used to statically or dynamically include reference pages, body pages, or template 
components in a custom table layout.

default
A choice made by an application unless the user specifies otherwise. Applications have 
default settings built into them for certain values or options that are required for the 
program to function. For example, in Site Builder the default extension for output body 
pages is .htm.

Default Character
A special element that can be associated with any character in a source document that is 
not associated with a specific style.

Default Paragraph
A special element that Site Builder assigns to content in a source document that is not 
associated with any other element.

Default.tcp
One of two default project files in Site Builder. A copy of the project file opens 
automatically when you start a new HTML project. The project file is installed in the 
Content Publisher directory (a copy is also available in the Support folder of the Content 
Publisher product disc). A second default project file, DefaultWML.tcp, is used to create 
WML projects.

DefaultWML.tcp
One of two default project files that is installed in the Content Publisher directory (and is 
also available on the Content Publisher product disc). Site Builder opens a copy of 
DefaultWML.tcp each time you start a new WML project. DefaultWML.tcp is used to 
create WML projects. You use Default.tcp to create HTML projects.

dialog box
A window containing command buttons and options that allow you to carry out a 
particular task. In Site Builder, reserved for secondary windows that are accessible 
directly from commands in menus, tab dialogs, and other dialog boxes.

directory
The name of a storage area on a computer's disk drive that contains a collection of files, 
other directories, or both. The directory name should identify its contents. In the Windows 
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operating system, a directory is represented by a yellow icon that resembles a manila 
folder. Directories are also called folders.

Directory Item
A directory or folder that you have added to a project in Site Builder so that source 
documents placed in the directory at any time become part of the project. (The Update 
Versions command must be run in order to recognize new documents added to the 
directory.)

document
A computer file that contains information, usually text. In Site Builder, documents are 
added to a publication for translation. Each document translated in Site Builder becomes a 
Web page for viewing in a Web browser (or multiple Web pages if the document is split). 
Also known as source document.

document management system
A system of electronic files grouped by libraries and folders in a repository. The document 
management system controls access to the files and tracks the history of each file.

domain name
A name that resolves or points to an IP address. Domain names give a 'friendly name' to a 
Web site, making it easy for users to find the Web site on the World Wide Web.

download
To transfer a file from a remote computer to a local machine.

dual publishing
A feature in Content Publisher that allows you to preview a Web site before going “live” 
with the Web site. The dual publishing feature can be found in the Staging/Publishing 
Options of Site Builder, where you can designate a staging server (a preview Web site) 
and a publishing server (the final Web site). Typically, you will first stage your project for 
others to review and then publish your project to the final Web site.

dynamic Directory Item
An extension of a Directory Item, whereby Site Builder incorporates not only the 
identified folder (directory) but all of the folders below that folder in the system hierarchy. 
When the directory is in Content Server, the contents of the directory are defined by 
search criteria.
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effect
A characteristic of a portion of text in a document, such as bold, italic, or subscript. Site 
Builder lets you retain or change such effects when you translate source documents.

element
Similar to a style name used in a word-processing template. When Site Builder imports 
styles or patterns in a source document, it automatically associates an element with each 
style or pattern to facilitate the translation of the source document. An HTML tag is 
assigned to each element, and the elements are saved in the template. Also known as an 
element.

element button bar
A navigation aid consisting of buttons with labels such as “Previous” and “Next” to denote 
their purpose. Used to move between elements within Web pages.

element link
A link at the element level that allows readers to jump between content associated with a 
specific element in a Web publication.

Element Setup
A property sheet in Site Builder in which you manage the elements generated when you 
import styles or patterns from a source document or use the ranks that Content Publisher 
assigns by default.

element text bar
A navigation aid consisting of text drawn from elements. Used to move between elements 
within Web pages.

email
Electronic mail. The transmission of messages electronically over a network.

Email (System)
A special element that is part of every template in Site Builder. Used to format an email 
address in a Web page, that is, the information entered in the Email Prompt text box in the 
Address tab dialog of the Globals property sheet.
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embedded files
A graphic, sound, or object included in a document (such as a Microsoft Word document). 
Site Builder converts embedded objects into graphics and also creates a link to the object 
in its native format (such as .xls for Microsoft Excel documents).

Favorites
To store a Web site or other Internet URL for future use. Instead of entering the URL each 
time a user wants to visit a site, the user can open the URL once, save the URL as a 
'Favorite,' then use the Favorite to make subsequent visits. Favorites are also called 
'Bookmarks.'

file
A named collection of information that is stored in a file system or repository.

file extension
The part of a file name that identifies the purpose or use of the file. File extensions 
determine file type. As a result, software applications are able to read the file as necessary. 
For example, files with the .txt extension can be opened with a text editor; files with the 
.bmp extension can be opened with a graphics editor; and files with the .exe extension can 
be run by the operating system.

file server
A computer running on a network that stores files and provides local and remote access to 
them. File servers are also called Web servers.

file type
The format of a file, usually indicated by its file name extension. Most software 
applications work with a specific set of file types.

folder
The name of a storage area on a computer's disk drive that contains a collection of files, 
other folders, or both. The folder name should identify its contents. In the Windows 
operating system, a folder is represented by a yellow icon that resembles a manila folder. 
Folders are also called directories.

font
Set of characters of a particular design and size. A typeface is composed of fonts. Arial is 
a typeface; Arial 12 point roman bold is a font.
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form
A set of fields used for data input and placed on a Web page. The submitted data is 
processed on a Web server, and the results are posted to a file, email address, or database. 
In Content Server, forms are created with HTML and Idoc Script and given the .hcsf file 
extension (the results are posted to a template file with the .hcsp file extension).

Formatting
A property sheet in Site Builder in which you format the content of your Web pages.

frame
A partition within the Web browser window that allows readers to view content. When 
used with other frames as part of a frameset, other Web pages can be viewed 
simultaneously. In Site Builder you set frames in the Layout dialog box.

frameset
A set of named scrollable windows that can be dedicated to separate Web pages. In Site 
Builder you can create a frameset for each publication in your project. You can save 
framesets in the Framesets Gallery for use on other projects.

Frameset Layout
An option in the Layout dialog box of Site Builder (the other option is HTML table 
layout). With Frameset Layout, you create a set of frames that help you organize content 
for viewing in a Web browser. Each frame may contain a reference page, a body page, or 
another component.

FTP
File Transfer Protocol. An Internet protocol used to transfer files between servers on a 
network or the Internet. Most Web sites are created and maintained by using an FTP 
client.

Gallery
1) A dialog box in Site Builder that offers over 900 graphics that serve as navigation and 
visual aids to fine-tune the appearance of Web pages. Many of the graphics are organized 
in 28 Sets, which ensure that the buttons, bullets, separators, and background in your Web 
publication are all of a consistent design.
2) The folder in the Content Publisher directory that contains these graphics in GIF 
format.
3) A dialog box in Site Builder used to access different framesets or HTML tables created 
in the Layout dialog box.
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GIF (.gif)
Graphics Interchange Format, a compressed graphics file that handles eight-bit color (256 
colors) and achieves a compression ratio of roughly 2:1. GIF images are a popular graphic 
file format on the Internet because of the reduced download time. GIFs are one of the 
default formats that Site Builder uses to convert graphics imported in source documents. 
Any GIFs linked to source documents are “passed through” by Site Builder during 
conversion.

global setting
Any option in Site Builder set in the Globals property sheet. Associated with a specific 
template rather than an individual element within the template.

Globals
A property sheet in Site Builder where you format the template as a whole, as opposed to 
its individual elements. For example, you can create a background color for all documents 
associated with that template, and this color will be used for all Web pages created when 
those documents are translated.

graphic
A particular type of file that typically displays an image rather than text. Site Builder 
accepts graphics in a variety of formats when it translates source documents into Web 
pages. It converts them into the GIF, JPEG, PNG, BMP, or WBMP format. Site Builder 
also includes a Gallery of graphics for use as navigation and visual aids in Web 
publications.

GUI
Graphical user interface, a graphics-based user interface that incorporates icons and pull-
down menus and allows users to use a mouse to execute commands. GUIs create visually 
oriented interfaces that make it easy for users to interact with computerized information of 
all kinds.

HCSP
Hyper Content Server Page. An HCSP page is a dynamic Web page containing HTML 
and Idoc Script and is stored in Content Server. The Idoc Script syntax is comprised of the 
following tags: <!--$code--> (where code represents an Idoc Script command). HCSP 
pages are indexed by the Verity search engine to provide users with efficient search 
results. HCSP pages contain the .hcsp file extension.
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HCST
Hyper Content Server Template. An HCST page is a dynamic Web page containing 
HTML and Idoc Script and is stored in Content Server. The Idoc Script syntax comprises 
the following tags: <$code$> (where code represents an Idoc Script command). HCST 
pages are template files and as such, are not indexed by the Verity search engine. HCST 
pages contain the .hcst file extension.

header
The initial portion of an HTML file between the <HEAD> and </HEAD> tags where titles 
are commonly supplied.

heading
A text style that displays in a larger typeface than the default or normal text. Headings 
denote hierarchy in a document. A Heading 1 is generally the largest, a Heading 2 the next 
largest, and so forth. A Heading tag in HTML denotes the same hierarchy.

heading level
A level in the hierarchy of a document. Heading levels help structure content. Documents 
often contain several heading levels with style names such as Heading 1 and Heading 2. 
Each heading would be set in a different font size or weight to denote its level of 
importance.

helper
A program launched or used by a Web browser to process files that the browser itself 
cannot handle. For example, a helper application may be needed to view JPEG images or 
play sound files.

hierarchical structure
The manner in which a Web publication or page is created. In Site Builder you use a 
publication hierarchy consisting of a root publication and any subpublications to denote 
the top-level hierarchical structure of the Web publication (the complete publication 
hierarchy contains the source documents and reference pages added to each publication in 
the hierarchy). The hierarchical structure of a Web page is determined by the heading 
levels used.

home page
The opening, introductory page of a Web site, whether on an intranet or the Internet, 
which is retrieved and displayed by default when a user visits that site. A home page 
usually provides an introduction to the Web site along with hypertext links to local 
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resources. The home page is often named index.htm, default.htm, or home.htm. Since Site 
Builder uses Index.htm as the default for any Index you create for a publication, you might 
want to rename this file to match the configuration of your Web server.

hotspot
A portion of text or an image that contains a hyperlink. Clicking the hotspot takes the user 
to related information. In Web browsers, hotspots are invisible. Users can tell that a 
hotspot is present by the changing appearance of the pointer.

HTM
The default extension for output HTML files created in Site Builder. 

HTML
HyperText Markup Language. The markup language used to turn a document into a Web 
page that can be viewed in a Web browser. HTML tags are used to format the text and the 
background of the document. HTML pages contain the .html or .htm file extension.

HTML 4.0
The current standard administered by the W3C (more specifically, version 4.01). Most 
Web browsers will support version 4.0 and 4.01.

HTML file
What Site Builder produces when it translates a source document or reference page. Each 
HTML file displays as a Web page in a Web browser. (If a source document is split into 
several HTML files, each file displays as a single Web page.)

HTML format
The format used to view documents in a Web browser. Files in HTML format are text files 
with HTML tags assigned to blocks of text. Site Builder turns source documents into body 
and reference pages that are in HTML format.

HTML tags
A collection of symbols that specify the appearance and properties of a document. Web 
browsers interpret HTML tags and display the contents in the browser window.

HTTP
The protocol used by Web browsers and Web servers to communicate over the Internet. 
More specifically, a Web browser requests a document from a Web server and displays its 
contents using HTTP. The HTTP protocol appears at the beginning of a URL (for 
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example, http://). The HTTP specification is maintained by the World Wide Web 
Consortium.

HTTPS
HTTPS is standard HTTP exchanged over an SSL-encrypted session.

hyperlink
A jump from a piece of text or image in one document to another document located within 
the Web publication, the file system, a network, or the Internet. Site Builder creates 
hyperlinks automatically for navigation purposes. Site Builder also preserves hyperlinks 
in source documents that can take the user, for example, to another Web site. Hyperlinks 
are the primary means of navigating on the World Wide Web. Hyperlinks are also called 
links.

hypertext
A nonlinear way to organize information, especially text. Hypertext provides a way to 
adapt text, graphics, and other kinds of data for computer use so that individual data 
elements point to one another. Any document that contains hypertext links to other 
documents is a hypertext document. Most Web pages are hypertext documents.

hypertext link
A hotspot overlaid on a graphic or piece of text. Facilitates navigation within and between 
Web publications according to users’ interests. When readers click the hypertext link, 
they’re taken to another part of the Web page or Web publication.

Idoc Script
A scripting language used to create dynamic Web pages in Content Server. Idoc Script 
provides the ability to reference variables, conditionally include content in HTML pages, 
loop over results returned from queries, and more. Idoc Script is primarily used to present 
HTML templates. Idoc Script pages may contain a number of different file extensions 
(usually .idoc, .hcsp, or .hcst) depending on its use.

image
A graphic in GIF, JPEG, PNG, BMP, or WBMP format that can be inserted into a Web 
page. Site Builder lets you import graphics in a variety of formats and convert them into 
one of these five formats.
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Image tag
The HTML image tag <IMG> for placing graphics in-line in Web pages. Used with Web 
browsers that support HTML 2.0 and later versions.

imported style
A style name imported from a source document and associated with a element.

incremental translation
An option whereby Site Builder translates only those source documents in a publication 
that have changed since the last translation. Particularly useful when you’re revising only 
one or two source documents in a large publication. The incremental translation command 
is available from the Run menu, Run toolbar, and large toolbar.

Index 
An optional reference page you can build in Site Builder when you convert source 
documents into Web pages. This alphabetical list is based on index entries embedded in 
the source documents. Site Builder creates a separate Web page for the Index and 
automatically links each entry in the Index to the appropriate Web page for the source 
document containing that entry. Also known as key word index.

Index Entry
A special element that Site Builder automatically associates with text tagged with an index 
marker in a source document. Site Builder compiles all the content associated with this 
special element to generate a key word index. You can format the Index Entry as you 
would any other element. Site Builder also uses the Index SubEntry element where you 
have created an index with second-level entries.

Index Heading
A special element. Site Builder automatically associates index entries embedded in the 
source documents with another special element named Index Entry to generate a key word 
index. At the same time, it creates alphabetical headings (A, B, C, etc.) for the index and 
associates these headings with Index Heading. You can format the Index Heading as you 
would any other element.

inline image
An image embedded in a line of text rather than its own window. Can appear by itself or 
merged with displayed text.
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inline style
A method of applying cascading style sheet settings to items in a document. Inline styles 
can be used in substitution of standalone cascading style sheets. Site Builder implements 
cascading style sheets using embedded inline styles and document-wide styles.

Internet
A global computer network composed of thousands of Wide Area Networks (WANs) and 
Local Area Networks (LANs) that use TCP\IP to provide worldwide communication to 
governments, universities, businesses, organizations, and individuals. The Internet hosts 
the World Wide Web.

Internet address
A unique identifier for a Web site on the Internet. Users can access a Web site by entering 
its Internet address in a Web browser address bar or clicking a link that contains the 
Internet address. For example, http://www.stellent.com. Also known as host name or 
network location.

Internet Explorer
Microsoft's Web browser used to interpret HTML markup and Internet protocols (HTTP 
and FTP), thus allowing users to browse the World Wide Web. Site Builder provides 
previewing capabilities of both templates and Web pages using Internet Explorer or 
Netscape Navigator.

Internet Information Services
Microsoft's Web server software used to deliver Web pages on the World Wide Web. IIS 
incorporates numerous server-side functions for its native ASP (Active Server Page) 
scripting language. IIS can also be used as an FTP server to transfer documents over the 
Internet.

intranet
One or more Web servers located inside an organization’s internal network that are used to 
store internal company information. Intranets generally exist as a separate Web site from 
an external or customer Web site. Anyone connected directly to the network, such as an 
employee, can access the intranet site.

IP address
A numerical address that identifies a computer on the Internet. An IP address comprises 
four sets of numbers (up to three digits each) separated by periods. An IP address can be 
used as an alternative to a domain name when the domain name is assigned a dedicated IP.
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Java
A general-purpose programming language created by Sun Microsystems. Java can be used 
to create Java applets. A Java program is downloaded from the Web server and interpreted 
by a program running on the machine containing the Web browser.

Java Server Page
A technology for serving Web pages through the use of servlets, or small programs that 
run on the Web server. JSP is similar to Microsoft's Active Server Pages (ASP)—they 
both request programs from the Web server before displaying the results in a Web 
browser. JSP pages contain the .jsp file extension.

JavaScript
A cross-platform, Web scripting language developed by Netscape Communications and 
Sun Microsystems, Inc. Compared to Java, JavaScript is limited in performance because it 
is not compiled before execution. Basic online applications and functions can be added to 
Web pages with JavaScript, but the number and complexity of available application 
programming interface functions are fewer than those available with Java. JavaScript code 
can be added to existing HTML code in a Web page.

JPEG (.jpg)
Joint Photographics Experts Group. A compressed graphics file format used to display 
high-resolution color graphics. JPEG is a popular format for photographs and images rich 
in color and detail. Site Builder can convert graphics in source documents into the JPEG 
format.

key word index
An optional reference page you can build for your Web publication when you translate 
source documents. This alphabetical list is based on index entries embedded in the source 
documents. Site Builder automatically links each entry in the index to the appropriate Web 
page. Also known as index.

Layout options
A feature in Site Builder that can be used to create a frameset or HTML table layout for a 
Web publication. With Layout options, you can design where items should appear on the 
Web page. You can do this by using the settings in the Layout dialog box or by attaching 
your own custom layout created in a third party editor (Microsoft FrontPage, Macromedia 
Dreamweaver, Adobe GoLive, etc.).
G-16 Content Publisher User Guide



Glossary
library
A collection of folders in a repository containing documents that can be checked into and 
out of the repository. A library typically would be identified with a specific location or 
function in an organization.

link
A pointer in one part of a Web publication that a reader can click to navigate to related 
information in another part of the same publication or in another publication entirely. 
Links permit rapid, easy movement between related information and are often coded to 
change color once they have been selected or used on the Internet.

linked publication
A publication with its own project file that is linked to an existing project, which becomes 
the master project, as a result. You must open the linked publication by itself in Site 
Builder in order to edit it. Once the linked publication is edited, you can update it within 
the master project by using the Update Versions command.

list
A series of related items in paragraphs, usually set off by numbers (a numbered or ordered 
list) or bullets (a bulleted or unordered list).

list element
An item in a list tagged with the HTML List Item tag <LI>.

List of Figures
A reference page you can build in Site Builder to summarize all the figures of a 
publication. Since you can promote any kind of content to a List of Figures, it can be used 
in the same way as two other reference pages: List of Tables and Table of Contents.

List of Tables
A reference page you can build in Site Builder to summarize all the tables of a publication. 
Since you can promote any kind of content to a List of Tables, it can be used in the same 
way as two other reference pages: List of Figures and Table of Contents.

local link
A link that connects two pieces of related information in the same Web page.

logging in
The process of identifying oneself to an account through a username and password.
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main window
What you see when you run Site Builder (with the Startup Screen closed). Contains the 
title, menu, and status bars, the main toolbar, the large toolbar, the Publication Hierarchy 
pane and the Contents pane (which summarizes key information about the source 
documents you select for translation). After you work in the four property sheets to edit a 
template, you always return to the main window to save the project file, translate the 
publication, and view the Web publication you create.

manually formatted document
A source document that contains only one named style or no styles at all. Also known as 
an unstyled document. Site Builder translates such documents by identifying patterns in 
the use of font type and size, bold and italic, and so on. It names and imports the patterns 
just as it does styles for a styled document.

markup
The process of embedding special characters in a text file that tells a computer program 
how to handle the contents of the file itself. HTML tags are a form of markup.

markup language
A defined set of markup tags.

master project
The same as a regular project except that it contains one or more linked publications; that 
is, one or more subpublications in the project’s publication hierarchy contain a link to 
another project file.

menu bar
The horizontal bar at the top of the main window that lists the names of the menus 
available. Each menu contains a drop-down list of commands.

Meta tag
The HTML tag that must appear in the <HEAD> portion of an HTML file. A Meta tag 
supplies information about a Web page but does not affect its appearance.

metadata
“Data about data.” In addition to content, the typical source document has a title, author, 
and other properties associated with it that can be used in different ways. Content 
Publisher recognizes three types of metadata: standard, custom, and repository.
G-18 Content Publisher User Guide



Glossary
Standard metadata are automatically generated by the application that was used to create 
the source document. Custom metadata are properties that you create in the application for 
the source document. (Not every document has standard or custom metadata.) And 
repository metadata are special properties (security group, document ID, version number, 
etc.) that you assign to content stored in a content management system, an FTP, or HTTP 
site.

named style
A set of formatting characteristics that have been saved and assigned a name, and which 
can be applied to any paragraph in a source document. For example, Heading 1, which 
may be Arial 18-point bold.

navigation
The process of using links and other devices to move within and between Web pages.

Navigation
A property sheet in Site Builder in which you add navigation aids to your Web 
publication.

navigation aid
A pointer in one part of a Web publication that guides readers to related information in 
another part of the same publication or another publication entirely. Links permit rapid, 
easy movement between related information. Navigation aids often come in the form of 
buttons with labels such as “Previous” and “Next” to denote their purpose.

navigation bar
A series of hypertext links arranged on a single line of a Web page to provide a set of 
navigation controls for a Web publication. Site Builder lets you create both button and text 
bars, for a Web page as a whole and for specific elements.

Netscape Navigator
Netscape's Web browser used to interpret HTML markup and Internet protocols (HTTP 
and FTP), thus allowing users to browse the World Wide Web. Site Builder provides 
previewing capabilities of both templates and Web pages using Netscape Navigator or 
Internet Explorer.

numbered list
A series of related items in paragraphs, numbered sequentially. Also known as an ordered 
list.
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OLE
Object Linking and Embedding. A technology or method for sharing information between 
applications. If a Word or Excel document in Site Builder contains an embedded object, 
that object can be converted to a linked graphic file that targets the object in its native 
application.

online
Information, activity, or communications located on or taking place in an electronic, 
networked computing environment like the Internet. The opposite of off-line, which is 
how you work when your computer is not connected to the Internet or any network.

output directory
The directory in which you store files once source documents have been translated into 
HTML format or passed through in their original format. Also used to store the HTML 
files for reference pages and the graphics in source documents once they are converted 
into the GIF, JPEG, PNG, WBMP, or BMP format. The output directory can be changed 
in the Publication and Document Properties dialog boxes.

output HTML file
The file that Site Builder creates when it converts a source document into a body page or 
builds a reference page during translation.

output page
What you generate when you translate a publication. There are two kinds. You create a 
body page for each source document you translate. You can also build optional reference 
pages during translation.

page
A Web page, that is, a single file that users view in a Web browser. Web publications 
typically consist of many Web pages, the one that opens by default being the home page. 
Pages must be linked to enable users to navigate through a Web publication.

page button bar
A navigation aid for moving between Web pages, consisting of buttons with labels such as 
“Previous” and “Next” to denote their purpose.

page Table of Contents
The table of contents (TOC) for a single Web page that appears at the beginning of the 
page in a Web browser and is part of the same HTML file. Different from the publication 
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TOC, which is an optional reference page that summarizes the content of all the pages of a 
Web publication and exists as a separate HTML file.

page text bar
A navigation aid for moving between Web pages consisting of text drawn from specific 
elements.

paragraph
The fundamental unit of a text or word processing file that defines content. A paragraph 
can be associated with only one style. In an HTML file, it is defined by the markup tag 
<P>.

parent directory
A directory that contains other directories. Directories are also called 'folders.'

password
A string of letters and numbers associated with a username that together make up a login. 
The password adds security to the login, preventing others from using it to gain access to 
the computer or network. A password character usually display as an asterisk (*) to 
prevent others from seeing or using the password.

path
The sequence of drive, directory, and subdirectory names that defines a file’s location, 
such as C:\Program Files\Stellent Content Publisher\. Also refers to the portion of a URL 
that identifies the folder containing a file. In 
http://www.stellent.com/techsup/more/techsup.htm, the path would be /techsup/more/.

pattern
A set of text attributes in a source document that Site Builder can identify and associate 
with an element. If a manually formatted source document has headings in Arial, 18-point, 
bold, you can base a pattern on these attributes and associate this pattern with an element. 
You can then use this element to format the content associated with the pattern. There are 
two kinds of patterns in Content Publisher: paragraph and character.

pattern attribute 
An individual character or text attribute such as Bold used to create a pattern.
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pattern string
The string of characters used by Site Builder to identify a pattern in a source document. 
For example, the pattern string [Bullet][A-Z][A-Za-z]+ tells Site Builder to search for a 
pattern of text in the source document that begins with a bullet, followed by an upper-case 
letter, followed by one or more upper-case or lower-case letters.

pixel
Short for picture element. A pixel is the smallest ‘dot’ your computer screen is capable of 
rendering at the resolution determined by your hardware and software. The size of a pixel 
may vary from system to system, depending on your graphics adapter, the screen 
resolution specified in the operating system setup, etc. Common screen resolutions are 640 
by 480 pixels, 800 by 600, and 1024 by 768.

plug-in
One of a set of software modules that can be integrated into a Web browser to offer a 
range of interactive and multimedia capabilities.

PNG (.png)
Portable Network Graphics. New graphics format designed to replace the older and 
simpler GIF format. Offers superior compression and display capabilities. One of five 
formats available in Site Builder when converting graphics in source documents.

Preview window
A window inside a dialog box that shows you what your source document will look like in 
a Web browser, once translated. Site Builder lets you preview Web pages in the Choose 
Template and Edit Template dialog boxes.

problem report
A report written to highlight a problem with the content or some other aspect of a Web 
page that is part of your staged output. The report is written in the problem report section 
of a special version of the Content Information page, which is created when you register a 
project on the staging server. Problem reports can be used in conjunction with staging 
workflow to review your staged output.

project
The overall term for the Web publication you create that encompasses the project file, its 
templates, and all source documents, related graphics, and associated files.
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project file
What you need to begin a new project. Site Builder starts with a copy of the default project 
file already open (“Unsaved” appears in the title bar). You use a project file to save 
important details about a project, including the publication hierarchy, the location of 
source documents, the template associated with each document, and the location of output 
directories for the HTML files produced during translation. Two default project files are 
available: Default.tcp is used to create HTML projects, and DefaultWML.tcp is used to 
create WML projects.

promotion
The process of making the specified content of a source document available for inclusion 
in one or more reference pages. Once you promote an element in the template of the 
source document, you must then edit the template of the reference page to ensure that the 
element is included in the reference page.

properties
The characteristics of a publication, source document, reference page, element, rank, style, 
or pattern. For example, the name of a publication is one of its properties. Properties can 
be viewed and edited in the various Properties dialog boxes.

property sheet
An interface in Site Builder with a series of tabs that provide access to commands and 
options for carrying out specific tasks. Element Setup, Formatting, Navigation, and 
Globals are all property sheets.

protocol
A method for two devices to communicate over the Internet. A protocol is an algorithm, or 
step-by-step procedure, carried out by such devices. File Transfer Protocol (FTP) and 
HyperText Transfer Protocol (HTTP) are protocols used to transfer files over the Internet.

publication
A container for the source documents that you want to translate and any reference pages 
you want Site Builder to build. Each new project has a root publication. (Its default name, 
“Unnamed,” appears at the top of the Publication Hierarchy pane.) You can create a 
publication hierarchy by adding publications to the root publication, publications to those 
publications, and so on. (Each publication, when added to another, becomes a 
subpublication.)
Content Publisher User Guide G-23



Glossary
publication hierarchy
The structure of a project in Site Builder in terms of its publications and documents. In 
addition to helping a Webmaster organize a publication, the hierarchy determines the 
order in which documents are translated, the order of items in a TOC, and so on.

Publication Hierarchy pane
One of two panes in the main window of Site Builder where project setup takes place. The 
Publication Hierarchy pane displays the root publication and all subpublications. The 
Contents pane summarizes key information about the source documents for the 
publication selected in the Publication Hierarchy pane.

publication Table of Contents (TOC)
An optional reference page in Site Builder that can be used to summarize information in a 
Web publication. You can promote any kind of information to the publication TOC, not 
just headings. When you promote elements, Site Builder builds the publication TOC by 
deriving content associated with those elements from the body pages. It also automatically 
links the entries in the publication TOC to content in the body pages. Two other reference 
pages—List of Tables, List of Figures—can be used in the same way.

publishing
Part of the dual-publishing feature in Content Publisher. When you publish a project, Site 
Builder (or Site Server) copies translated documents from the output directory of your file 
system to a publishing server—in effect, your Web site. As part of the dual-publishing 
feature, you can first “stage” your project to a staging server (a preview area) before you 
publish to the “live” Web site.

publishing server
The final or publicly available Web site that usually follows a staging phase. Publishing 
server details can be set up in the Publishing Options dialog box (a part of the dual-
publishing feature in Content Publisher).

Query reference page
A special kind of reference page that can be used to search for information throughout a 
Web site, that is, the content server in which the Web publication resides.

rank
Used by Site Builder to identify the structure of a source document based on the hierarchy 
of content in that document. As a result, the top-level hierarchy of each source document 
is treated the same. This is especially useful when translating legacy documents or 
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documents from a Directory Item. In the Choose Template dialog box, the default setting 
under Import Styles or Patterns is None, which means that a default set of ranks is applied 
to the document rather than importing styles or patterns.

raster image
An image formed by light and dark pixels in a rectangular array, rather than by a 
collection of lines, as in a vector graphic.

reference page
An optional page built during translation. Reference pages (except for Query pages) 
derive their content from body pages and are automatically linked to them. There are five 
types: publication Table of Contents (TOC), List of Tables (LOT), List of Figures (LOF), 
Index, and Query. Each one is an HTML file. The TOC you place at the beginning of a 
body page is a “page TOC” and is a part of the same HTML file as the body page. Its 
contents typically differ from the contents of the publication TOC.

registration
The process of establishing a connection between Content Publisher (and its projects) and 
Content Server. There are many forms of registration: (1) registering a content server with 
Content Publisher, (2) registering a project on a source server in order to preview source 
documents, (3) registering a project on a staging server to enable staging workflow, and 
(4) registering a username and password in Site Server to automate publishing with 
Content Server. There is another form of registration performed automatically by Content 
Publisher that improves project performance in Content Server.

relative URL
The Internet address of a Web page with respect to the Internet address of the current 
page. A relative URL gives the path from the current location of the page to the location of 
the destination page. For example, the relative path from fileA.htm to fileB.htm, where 
fileB.htm is stored in a subfolder called 'news,' would be 'news/fileB.htm.'

repository 
A place where electronic files are stored (and often managed). In Site Builder, the file 
system, an FTP site, an HTTP site, and Content Server are all repositories.

root publication
The top-level publication in a project in Site Builder. All publications directly below the 
root publication are subpublications. You can add publications to subpublications to create 
additional subpublications at different levels in the Publication Hierarchy.
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root web
The default or top-level of a Web site. The root web can be accessed by entering the Web 
site URL without specifying a subfolder or Web page. In Site Builder, the root web 
location is specified in the Output directories of the root publication properties.

RTF (.rtf)
Rich Text Format. A method of encoding text formatting and document structure using the 
ASCII character set. Site Builder can translate source documents in RTF format.

screentip
A popup that appears when you pass your cursor over an element of the interface. For 
example, if you place your cursor over a button on the toolbar, the name of the button will 
display in a popup. Screentips are also used in the Preview window of the Edit Template 
dialog box in Site Builder. As you pass your cursor over content, a popup displays the 
name of the element associated with that particular piece of content.

script
A type of computer code that can be executed by a program that understands the scripting 
language. Unlike most computer code, a script does not need to be compiled to run. Many 
scripts are placed on Web servers where they are read and executed by Web browsers.

separator
A graphical aid similar to a rule that Site Builder can place in a document to set off 
different portions of the content.

server
A computer that offers services on a network. On the Web, servers run the Web server 
software that responds to HTTP protocol requests and delivers Web pages.

server-side include
A process whereby a script and a Web server function together to automatically include 
the text from one Web page in another Web page. This process takes place when a Web 
browser requests a Web page from a Web server. Site Builder uses server-side includes to 
dynamically include reference pages in an HTML table.

graphics set
A collection of graphics provided in Site Builder, available from the Gallery. Each 
graphics set is uniquely designed and consists of a series of navigation buttons, a bullet, a 
separator, and a background. There are 28 Sets in Site Builder.
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SGML
Standard Generalized Markup Language. An ISO (International Standards Organization) 
markup language for defining and using a set of tags to denote the nature of document 
content. HTML is based on SGML.

signature
An identifier you can add to a Web publication to specify such things as the Webmaster or 
copyright information. You do this in the Address tab dialog of the Globals property sheet.

source document
The content you want to translate into HTML as part of your overall Web site. Site Builder 
converts source documents from many formats into Web viewable formats. Once you 
translate a source document, it becomes a Web page for viewing in a Web browser.

split
The process of taking a source document and turning it into multiple Web pages to 
facilitate browsing and downloading. A default option in Site Builder allows you to use 
Heading 1 to split a document into a series of Web pages, each beginning with Heading 1 
content.(You can use another element if you prefer, or even multiple elements.) Another 
option allows you to create multiple Web pages by splitting on each hard return in the 
source document.

staging
Part of the dual-publishing feature in Content Publisher. When you stage a project, Site 
Builder (or Site Server) copies the translated output from the file system to a content 
server known as the staging server so that the contents of your Web publication can be 
formally reviewed and approved before being published. If you set up workflow on the 
staging server (and register the project on that server), you can use workflow to facilitate 
the review process.

staging server
A Web site that is intended for internal review, proofing, and workflow before the site is 
published to a publishing server (your final Web site). Staging server details can be set up 
in the Staging Options dialog box (a part of the dual-publishing feature in Content 
Publisher).

staging workflow
The process that facilitates the formal review of Web pages on a staging server before a 
project is finally approved and published. If workflow has been set up on the staging 
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server and the project has been registered on that server, workflow begins automatically as 
soon as the project is staged.

Startup Screen
The opening screen on top of the main window that displays when you first start Site 
Builder. It contains alternative ways to start a new publication or open an existing one. It 
also offers access to the “Seven Easy Lessons” and the Tutorial.

status bar
The area at the bottom of the Site Builder main window that displays information about 
the currently selected command. Also, the area at the bottom of a Web browser that 
displays information about a Web page, connection status, etc.

style
A set of formatting characteristics with an assigned name that defines how text appears in 
a document. In Content Publisher, there are two kinds of styles: paragraph and character. 
Styles can be assembled together to make up a style sheet or Cascading Style Sheet.

style sheet
A set of formatting instructions that control how a Web page will display in a Web 
browser. See also Cascading Style Sheets.

subdirectory
A directory within or below another directory. Directories and subdirectories are also 
called folders and subfolders.

subpublication
Any publication added to the root publication or another subpublication. A subpublication 
can be exported from one project to become a publication in a new project or a 
subpublication in another project.

tab dialog
A particular type of dialog box in Site Builder that you open by clicking a tab on one of 
the property sheets, for example, the Character tab on the Formatting property sheet.

table
A series of cells organized in rows and columns used to arrange data systematically. In 
HTML, a table can be used to organize the layout of items (text, graphics, etc.) on a Web 
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page. The Layout dialog box in Site Builder can be used to create framesets or HTML 
tables for your Web publication.

Table Layout
One of the options in the Layout dialog box of Site Builder (the other option is Frameset 
Layout). Users can design a layout for a publication using HTML tables and HTML table 
cells. Each table cell serves as a placeholder for a reference page, a body page, or another 
component.

tag
The formal name for an HTML markup element. HTML tags are enclosed in angle 
brackets (< >). Site Builder automatically generates an element for each imported style or 
pattern, and then assigns an HTML tag to each element.

target frame
The frame that all hyperlink targets should display in. It is most common to place 
hyperlinks in one frame and assign a separate frame as the target frame. This way, your 
reference pages (containing the hyperlinks) display in one frame, and the body pages 
display in another frame.

TCP (.tcp)
The extension for a project file created in Site Builder.

TCP/IP
Transport Control Protocol/Internet Protocol, a standard format for transferring data in 
packets from one computer to another. This protocol is used on the Internet and other 
networks. The first part of this standard, TCP, constructs the data packets; the second part 
of this standard, IP, routes the packets from computer to computer.

template
A set of formatting and other instructions for text and images that determines how a source 
document will display in a Web browser once it is translated. Most of the instructions are 
associated with the individual elements that reside in the template, though some are 
associated with the template itself. Only one template can be associated with a given 
document, but the same template can be associated with many documents. A template is 
typically saved with the project file. You can export and import templates by creating 
standalone template files. You can also link source documents to external, standalone 
template files.
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text mode
A mode of operation in which a computer or Web browser displays letters, numbers, and 
other characters but no graphical images. A text mode Web browser cannot display 
graphics without the assistance of a helper application.

thumbnail
A miniature rendering of an image used as a placeholder and linked to the full-sized 
image.

TIFF (.tif)
Tagged Image File Format. A tag-based image format used for the universal interchange 
of digital graphics. Site Builder can convert TIFF images into the GIF, JPEG, PNG, 
WBMP, or BMP format.

title
1) Text supplied between the <TITLE> and </TITLE> tags in an HTML file to define the 
caption that displays in the title bar of the Web page when it’s viewed in a Web browser.
2) The text that can be added at the beginning of a Web page in Site Builder. (You set 
titles in the Titles tab dialog of the Globals property sheet.)

title bar
1) The horizontal bar at the top of the main window in Site Builder that displays the name 
of the project file currently open as well as the application name.
2) The bar at the top of the Web browser that displays the title of a Web page or the path 
and name of the HTML file being shown.

Title (System)
A special element that is part of every template in Site Builder. Used to format titles in a 
Web page, that is, the information set in the Titles tab dialog of the Globals property sheet.

token
A snippet of code that can be placed in a publication in place of a file name or path 
statement. The token acts as a variable (or placeholder) for other content in a publication. 
This content could be a graphic file, a reference page, template settings, and more. When a 
publication is translated, staged, and published, the token is replaced with the correct path 
and file name for the content it represents. As a result, you never have to worry about 
updating path statements when you move or expand a publication.
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toolbar
A series of icons that allow you to execute commands quickly by clicking a button rather 
than choosing a command from a pull-down menu. In Site Builder there is a main toolbar, 
which is located at the top of the main window, beneath the menu bar. There is also a large 
toolbar, which displays down the right side of the main window.

translation
The process of creating Web pages from source documents in Site Builder. The formatting 
and other instructions contained in a template control the translation details. The source 
documents remain unchanged.

transparent GIF
A specially rendered GIF image in which one ‘color’ is transparent, allowing the 
background to show through. This type of graphic blends with the document’s existing 
color scheme and provides a more professional-looking Web page. Not all Web browsers 
are capable of handling transparent GIFs.

TTP (.ttp)
The extension for a template file in Site Builder. Generally, a template exists as part of the 
project file. But you can create a standalone template file that can be linked to that or 
another project file or imported into another project. In which case, Site Builder assigns 
the .ttp extension.

UNIX
A multi-user and multitasking operating system that exists in various forms and 
implementations. Unix is typically used with proprietary computer and software systems 
and unlike Microsoft Windows, it is primarily a command line environment.

Update Versions
The command used to update source documents. Except for single source documents on 
the file system, the command is required to update all source documents before an 
important translation, including those in Directory Items and from Content Server or an 
FTP or HTTP site. In the case of Content Server, Site Builder doesn’t check documents 
out of the content server. Rather, it identifies the version current during project setup and 
obtains a copy of that version for all translations. Update Versions identifies the latest 
version of a document available so that Site Builder can use that for your final translation 
before publishing to a content server. You can automate the command in Site Builder. Site 
Server automatically updates all source documents when it runs a project.
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upload
To transfer a file from a local computer to a remote computer on a network or the Internet.

URL
Uniform Resource Locator. A unique address that specifies where a document can be 
found on the Internet along with the protocol needed to locate the document (such as 
HTTP or FTP). URLs tend to be quite long, and you must enter the exact address in order 
to view the Web site associated with the URL.

username
A string of letters (and possibly numbers) that together with a password make up a login. 
Your username uniquely identifies you to the computer or network you are logging on to.

VBScript
A subset of the Microsoft Visual Basic programming system. Major Web browsers can 
read VBScript that is embedded in a Web page. VBScript can be executed on the Web 
server and the Web browser machine. Microsoft ASP (Active Server Pages) supports 
VBScript functions.

vector graphics
An image created by a collection of lines rather than a pattern of dots (pixels), as in a 
raster image.

visited link
A hyperlink on a Web page that has been activated. Visited hyperlinks are usually 
displayed in a unique color by the Web browser.

watermark
An image that appears on the background of a Web page that is used to decorate and 
identify the page or Web site but does not scroll as the page scrolls.

Web
An abbreviation for World Wide Web. A subset of Internet servers that support HTTP 
protocol and can host hypertext documents.

Web browser 
Software that is used to request information from the Internet, interpret HTML markup, 
and display Web pages to the user. Microsoft Internet Explorer and Netscape Navigator 
are among the most common Web browsers.
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Web page
A file containing HTML intended for display in a Web browser. Web sites are comprised 
of individual Web pages that contain hyperlinks to one another. Site Builder creates Web 
pages and ultimately Web sites from your source documents when you translate your 
publication.

Web publication
What you create in Site Builder to display in a Web browser. Consists of one or more Web 
pages that contain the content of the source documents you translated plus optional 
reference pages, such as an Index, you built during translation.

Web server
A computer connected to the Internet that stores files and makes them available to the 
public. Web server software runs on top of an operating system.

Web site
A collection of HTML or scripting-based Web pages that are linked together and stored on 
a Web server. Every Web site has a unique URL so that it can be accessed publicly on the 
World Wide Web. In Content Publisher, this is where you stage or publish a publication. 
The staging server is essentially a preview Web site, and the publishing server is the final 
Web site.

Webmaster
A person who creates and maintains the content and organization of a Web site. In the 
Content Management system, this individual is responsible for reviewing a project on the 
staging server and for authorizing its final approval and release to the Web site (publishing 
server).

World Wide Web
A subset of Internet servers that support HTTP protocol and can host hypertext 
documents. Hypertext documents may contain text, pictures, sounds, and other media. 
Users view such documents using a Web browser. The World Wide Web is also called the 
'Web.’

World Wide Web Consortium (W3C)
A consortium of institutions that performs research and promotes standards in areas 
related to the World Wide Web.
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#
%%#PT%%, 8-56
%%DIR%%, 8-56
%%FILE%%, 8-56
%%PATH%%, 8-56
%%PT%%, 8-56
%%RELURL%%, 8-56
%%SERVER%%, 8-56
%%TRANSIT-BODYATTRIBUTES%%, 6-186
%%TRANSIT-CONTENT%%, 6-186
%%TRANSIT-DM_PROPERTY(Field Name), 6-186
%%TRANSIT-DM_UIPROPERTY(Field 

Caption)%%, 6-186
%%TRANSIT-GALLERY_GRAPHIC_DIR%%, 6-186
%%TRANSIT-INPUTDOCID%%, 6-148
%%TRANSIT-INPUTFILENAME%%, 6-148
%%TRANSIT-INPUTLIBID%%, 6-148
%%TRANSIT-INPUTPATH%%, 6-148
%%TRANSIT-INPUTVERSION%%, 6-148
%%TRANSIT-PATH(FILENAME)%%, 6-186
%%TRANSIT-PATH(INDEX)%%, 6-186
%%TRANSIT-PATH(LOF)%%, 6-186
%%TRANSIT-PATH(LOT)%%, 6-186
%%TRANSIT-PATH(TOC)%%, 6-186
%%TRANSIT-RELATIVEPATH(path 

statement)%%, 6-186
<!-- TRANSIT - CUSTOMLAYOUT(BODY) -->, 6-186
<!-- TRANSIT - CUSTOMLAYOUT(HEAD) -->, 6-186
<!-- TRANSIT - CUSTOMLAYOUT(TOP) -->, 6-186
<!-- TRANSIT - LAYOUT(INDEX) -->, 6-186
<!-- TRANSIT - LAYOUT(LOF) -->, 6-186
<!-- TRANSIT - LAYOUT(LOT) -->, 6-186
<!-- TRANSIT - LAYOUT(TOC) -->, 6-186
<!DOCTYPE> declaration, 6-178
<HTML> tag

including HTML or scripting in top of file, 6-178
<LI> tag as a custom tag, 6-119

A
About Box, 1-5
Add Document command, 3-6
Add Publication command, 3-6
Add Reference Page command, 3-6
Add toolbar commands, 3-6
Address (System) element

explained, 6-30
using to format address information, 6-200

advanced CSS options, 6-101
alignment of tables, 6-60
alignment property of a rank, 6-37
alternative text

adding for bullets, 6-120
adding for separators on a page TOC, 6-177
adding for separators on a Web page, 6-175
adding to an icon, 6-131
as a link property, 6-143
associating with a graphic, 5-34
creating from a caption, 5-35
obtaining from a source document, 5-34

anti-virus software, 2-5
appearance of tables, 6-114, 6-116
application options

described, 3-14
international versions of Word, 6-50
setting, 3-16
showing CSS caution, 3-20
showing print warning, 6-139
showing Select a Repository dialog box, 3-21
showing the Startup Screen, 3-19
specifying output file extension, 5-106
warning for Print button, 3-21

applying the <LI> tag as a custom tag, 6-119
ASCII source documents, 6-205
ASP script syntax, 5-112
associated file, 5-99
Associated Files command, 3-13
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associating a file with a publication, 5-38
automated publishing

scheduling a task, 8-42
specifying a task, 8-45
with Stellent Site Server, 8-25

B
background color

for paragraphs, 6-126
setting, 6-198

background graphic from a graphics Set, 6-198
background image, 6-126
binary template, 6-5
BMP graphics format supported, 6-170
body page

deleting, 5-102
elements assigned to, 6-18
handling an event within, 6-179
linking a reference page to, 6-24
placing metadata in, 6-26

bookmark names, retaining in output, 6-163
borders for paragraphs, 6-102
borders of tables, 6-117
borders, adding, 6-103
browser, default, 3-17
bulleted list

bullets for, 6-120
creating a paragraph pattern for, 6-59
formatting, 6-120

button bar for navigating page elements, 6-158
button bar for navigating pages, 6-156

C
captions

creating alternative text from, 5-35
promoting, 6-98
promoting from tables, 6-99
promoting to a reference page, 6-98

cascading style sheets, explained, 6-107
case sensitivity of output file names, 5-101
case, complying with ISO 9660, 5-107
causes of path conflicts, 4-18
caution for using CSS, 3-20
CDR graphics format supported, 6-170
cell, in HTML tables, 5-69
Central European (ISO-8859-2) character set, 5-108
Central European (Windows-1250) character set, 5-108
CGM graphics format supported, 6-170
Change Pattern Associations dialog box, 6-53
Change Preview dialog box, 7-4

Change Style Associations dialog box, 6-29
Change Text Effects dialog box, 6-129
character pattern, 6-55
character set

Latin 1, 5-109
output, 5-108

Character tab dialog, 6-108, 6-110
characters

formatting in tables, 6-113
formatting with CSS, 6-108
formatting without CSS, 6-110

check-in file extension, setting, 8-82
Choose Template command, 3-11
Choose Template dialog box, 6-3
choosing a template, 6-3
closing Stellent Site Builder, 2-4
closing Stellent Site Scheduler, 8-40
Color dialog box, 6-129
color property of a rank, 6-39
colors for a Web page, 6-198
colors in tables, 6-115
commands

Add Document, 3-6
Add Publication, 3-6
Add Reference Page, 3-6
Associated Files, 3-13
Choose Template, 3-11
Copy, 3-8, 5-40
Cut, 3-8, 5-40
Delete, 3-8, 5-40
Edit Template, 3-11
Element Setup, 3-11
Exit, 2-4
Formatting, 3-11
Framesets, 3-13
Globals, 3-11
Incremental Translation, 3-12
Manage Templates, 3-11
Navigation, 3-11
New, 3-9
Open, 3-9
Paste, 3-8, 5-40
Project Export Wizard, 3-13
Publication Properties, 3-13
Publish, 3-12, 8-15
Save, 3-9, 4-12
Save As, 4-12
Stage, 8-6
Stellent Site Scheduler, 3-13
Translate, 5-41
Translate All, 3-12, 5-41
Update Versions, 3-12
Viewer, 3-17

compact XML template, 6-5
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compliance with HTML 4.0, 6-178, 6-184
complying with ISO 9660, 5-107
Computer Graphics Metafile graphics format 

supported, 6-170
conditional disclosure

enabling, 8-53
configuring Stellent Content Publisher, 2-5
confirming publish options, 8-21
confirming staging options, 8-3
conflict in template names, 6-8
conflicting paths, resolving, 4-18
conflicts between styles and patterns, 6-92
conflicts during translation, 5-103
conflicts in paths

causes of, 4-18
connecting to Stellent Content Server, 5-21
connecting to Stellent Site Server, 8-32
Content ID as a hyperlink, 6-162
content server

adding a Directory Item from, 5-18
choosing, 8-69
creating a Registry entry to register, 5-24
creating a restricted Directory Item in, 5-29
document name when checking in, 8-81
importance of ordering published metadata, 6-86
link to documents stored in, 6-197
opening your Web publication from, 8-72
publishing metadata to, 6-79
registering, 5-24
registering a username and password for Stellent 

Site Server, 8-27
registering with the mini-Installer, 5-25
setting the check-in file extension, 8-82
type of metadata, 6-73

content server URL as a hyperlink, 6-160
content servers in publishing, 8-68
Contents pane, changing order of source 

documents, 5-34
Continue command, 8-33
contributor criteria workflow, 8-12
contributor preview, 7-4
controlling the content a user can view, 8-53
converting

graphics in source documents, 6-124
HTML source files, 6-181
setting options for a Directory Item, 5-95
using the pass-through conversion option, 5-37, 

5-38
Copy command, 3-8, 5-40
copying a frameset, 5-59
copying a project file, 4-10
copying a template, 6-4
copyright line for a Web page, 6-200
Corel Draw graphics format supported, 6-170

creating alternative text from a caption, 5-35
Creating multiple web pages from a single 

document, 6-95
criteria of a Directory Item in Stellent Content 

Server, 5-30
cross-references in a Web page, 6-195
CSS

advanced options, 6-101
caution for, 3-20
explained, 6-107
formatting a text bar, 6-155
formatting characters with, 6-108
formatting characters without, 6-110

custom metadata, 6-69, 6-83, 6-83
custom table layout

creating, 5-84
using with third-party applications, 5-110

custom tag
adding before or after an element, 6-88
applying <LI>, 6-119
for new metadata, 6-82
including JavaScript, 6-88

customizing the default project file, 4-6
customizing the standard toolbar, 3-7
Cut command, 3-8, 5-40

D
DCOM, enabling, 8-23
default browser, 3-17
Default Character element, explained, 6-30
Default Paragraph element

explained, 6-30
default project file

customizing, 4-6
editing, 4-5
explained, 4-6

default project file. See Default.tcp
Default.tcp

customizing, 4-6
editing, 4-5
explained, 4-6
importing an older version, 1-6

DefaultWML.tcp, 4-6
Delete command, 3-8, 5-40
designating output directories, 5-101
dialog boxes

Change Preview, 7-4
Change Style Associations, 6-29
Change Text Effects, 6-129
Choose Template, 6-3
Color, 6-129
Details, 8-55, 8-56
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Document Properties, 5-32
Edit Template, 6-7
Effects, 6-128
File Conflicts Notice, 5-103
Gallery, 6-169
Link Properties, 6-143
Manage Templates, 6-12
Project Path Conflict, 4-18, 4-19
Project Path Replacement, 4-19, 4-20
Project Paths Verification, 4-19, 4-20, 4-20
Publication Properties, 5-6
Publish Warnings, 8-16
Selective Incremental Translation, 3-20

Digital Research graphics format supported, 6-170
directory for temporary files, 5-26
Directory Item

adding, 5-89
adding from an FTP site, 5-10
adding from an HTTP site, 5-13
adding from file system, 5-89, 5-93
adding from Stellent Content Server, 5-18
checking the criteria for, 5-30
compared to the Folder Import Wizard, 5-98
conversion options, 5-95
creating, 5-95
making dynamic, 5-10, 5-95
metadata-generated folders, 5-96
options, 5-95
pass-through conversion option, 5-37, 5-38, 5-95
query results hierarchy, 5-96
restricted, 5-28, 5-29
setting the extension for output pages, 5-95
sorting, 5-94
standard, 5-29
updating, 5-94

disclosure, conditional, 8-53
disconnecting from Stellent Site Server, 8-33
disk space for translation, 2-6
displaying

headers and footers in a Web page, 6-202
large toolbar, 3-18
standard toolbar, 3-18
status bar, 3-19

docking a toolbar, 3-9
document

adding, 5-31
adding from an FTP site, 5-11
adding from an HTTP site, 5-14
adding from Stellent Content Server, 5-17
adding from the file system, 5-31
alternative text from, 5-34
changing order in the Contents pane, 5-34
converting graphics in, 6-124

HTML file as, 5-43
illegal characters in a title, 5-22
importing styles, 6-47
in workflow, 8-14
including revision information from, 6-203
non-English, 6-50
obtaining from Stellent Content Server, 5-22
opening from a Web page, 6-145, 6-147, 6-148
opening in its native format, 5-38
optional URLs for linking to, 6-148
overriding staging and publishing options, 8-21
passing through without conversion, 5-37, 5-38
PDF file as, 5-36
previewing, 7-4
properties, 5-32
registering a project to preview, 8-76
removing from a publication, 5-40
selecting an output character set for, 5-108
sharing styles, 6-91
skipping carriage returns in ASCII, 6-205
specifying a particular version of, 5-27
splitting into web pages, 6-95
splitting on hard page breaks, 6-96
translation status of, 5-42
updating from FTP site, 5-12
updating from HTTP site, 5-12
updating in a repository, 8-70
updating to the latest released version, 5-27
updating with Update Versions command, 8-9
version options when translating, 5-28
XML file as, 5-36

document information
inheriting from source, 8-50
specifying, 8-49

document name when checking into the content 
server, 8-81

document title as a hyperlink, 6-161
documentation for Stellent Content Publisher, 1-3
DRW graphics format supported, 6-170
dual publishing process, 8-2
DXF graphics format supported, 6-170
dynamic include token syntax, 5-112
dynamic includes, 5-110
dynamically included reference pages, 5-111

E
Edit Template command, 3-11
Edit Template dialog box, 6-7
Edit toolbar commands, 3-8
editing options for templates, 6-9
Effects dialog box, 6-128
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element
adding custom tags before or after, 6-88
assigning an HTML tag to, 6-89
associating a metadata with, 6-78
associating a Print button with, 6-138
associating HTML or scripting code with, 6-127
changing assignments, 6-18
changing association with a rank, 6-38
changing its association with a pattern, 6-53
changing its association with a style, 6-46
changing its association with metadata, 6-82
changing properties, 6-19
changing the name of, 6-21
character, 6-19
creating, 6-21
deleting, 6-27
explained, 6-16
handling an event for, 6-23
Index Entry, 6-19
Index Heading, 6-19
Index SubEntry, 6-19
linking with a button bar, 6-158
linking with a text bar, 6-159
paragraph, 6-19
placing in a Meta tag, 6-25
placing in the Head, 6-25
placing in Web pages, 6-26
promoting, 6-27
properties, 6-22
renaming in a new publication, 6-93
special, 6-30
Stellent element, 6-16
system character, 6-19
system paragraph, 6-19

element button bar
adding a Specific Page link, 6-152
adding a Top of Project link, 6-154
creating, 6-158

Element Setup command, 3-11
Element Setup property sheet, explained, 6-17
element text bar

creating, 6-159
element-based metadata

creating, 6-78
ordering, 6-86

Elements list, 6-19
Elements tab dialog, 6-22
Email (System) element

explained, 6-30
using to format address information, 6-201

Email element, 6-30
email, sending notification for a scheduled task, 8-35
embedded OLE object, 6-203
enabling DCOM, 8-23

enabling the print functionality, 6-139, 6-141
Encapsulated PostScript graphics format 

supported, 6-170
encrypting a password for Stellent Site Server, 8-27
endnotes in a Web page, 6-205
EPS graphics format supported, 6-170
errors

during translation, 8-35, A-3, A-4, A-5
email notification of for scheduled tasks, 8-35
logging, A-3
publishing with, 8-11
troubleshooting, A-8

event, 5-64, 6-23, 6-179
event handler, 5-64, 6-23, 6-179
examples of pattern matching, 6-60
Excel

creating a new style in, 6-48
embedding OLE objects in, 6-203
standard and custom metadata, 6-83
styles in, 6-48

Exit command, 2-4
exiting Stellent Site Builder, 2-4
exiting Stellent Site Scheduler, 8-40
Expired (Status column), 8-48
exporting a publication, 5-4
exporting a template, 6-5
extension

setting for check-in to content server, 8-82
specifying for output files, 5-106

external template, 6-14

F
fatal errors during translation, A-3, A-4, A-5
figure numbers

creating a paragraph pattern for, 6-57
file

log, A-5
Map, 6-142
project, 4-3

File Conflicts Notice dialog box, 5-103
file extension

modifying, 5-116
setting for check-in to content server, 8-82
specifying for output files, 5-106

file formats, 5-44
file name

adding a prefix to, 8-79
enforcing upper case, 5-107
using a maximum of 8 characters, 5-107
when checking into the content server, 8-81

file system
adding a Directory Item from, 5-89
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adding a document from, 5-31
importing folders from, 5-97
specifying linking for, 8-55
specifying staging or publishing options for, 8-54

File toolbar commands, 3-9
files in a specified directory, translating, 5-89
finding the home page, 8-72
Folder Import wizard, 5-97, 5-98
font properties of a pattern, 6-61
font property of a rank, 6-38
footer in a Web page, 6-202
footnotes in a Web page, 6-205
formats, file, 5-44
formatting

bulleted lists, 6-120, 6-120
characters in tables, 6-113
characters with CSS, 6-108
characters without CSS, 6-110
colors in tables, 6-115
explained, 6-97
headings in tables, 6-118
inserting icons, 6-131
inserting rules, 6-132
inserting separators, 6-133
lists, 6-121
numbered lists, 6-122
page TOC, 6-134
paragraphs in tables, 6-115
paragraphs with CSS, 6-111
paragraphs without CSS, 6-112
rule for a graphics Set, 6-168
table alignment, 6-60
table borders and size, 6-117
tables, 6-114
text effects, 6-128

Formatting command, 3-11
Formatting property sheet, explained, 6-97
frame

adding a link to, 5-65
populating, 5-65
properties, 5-61, 5-62
setting options, 5-61

frameset
adding from the Gallery, 5-67
adding to a project, 5-59
adding to the Gallery, 5-66
applying from the Gallery, 5-67
associating with a publication, 5-58
copying, 5-59
creating for a project, 5-59
editing, 5-61
explained, 5-58
Gallery, 5-67
handling an event within, 5-64

properties, 5-62, 5-63
targeting, 5-65

frameset Gallery
adding a frameset to, 5-66
applying a frameset from, 5-67
associating with a publication, 5-58
selecting a frameset from, 5-67

Framesets command, 3-13
frequency of ranks, 6-43
FTP

adding a Directory Item from site, 5-10
adding a source document from, 5-11
publish options for, 8-61
publishing to a site, 8-60
specifying a link when publishing to site, 8-63
updating source documents from site, 5-12

full XML template, 6-5

G
Gallery

creating a new group of graphics, 6-165
creating new graphics Set, 6-164
deleting a graphics Set, 6-165
dialog box, 6-169
editing a graphics Set, 6-166
editing a group of graphics, 6-167
Group mode, 6-169
HTML table, 5-83
selecting a graphics Set from, 6-198
Sets, 6-168
Sets mode, 6-169
using your own graphics, 6-165

Gallery Graphics output directory, 5-102
GEM graphics format supported, 6-170
generating document names from file names, 8-81
generating XML-compliant output, 6-185
global setting for page TOC, 6-176
Globals

explained, 6-173
Query results page, 6-193
selecting a Query form, 6-192

Globals command, 3-11
Globals property sheet, explained, 6-173
Glossary, 1-5
graphics

as input files, 6-124
associating alternative text with, 5-34
background, 6-199
changing to properties of a group, 6-164
converting in source documents, 6-124
creating a paragraph pattern for, 6-57
editing a group of, 6-167
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formats supported, 6-170
output directory, 5-102
promoting captions of, 6-98
using your own in the Gallery, 6-165

graphics formats, 6-170
graphics Set

changing properties, 6-164
creating, 6-164
deleting, 6-165
editing, 6-166
formatting a rule for, 6-168
renaming, 6-169
selecting, 6-198
the Gallery, 6-169

grayed out elements in Elements list, 6-19
Greek (ISO-8859-7) character set, 5-108
Group mode in the Gallery, 6-169
group of graphics

changing the properties of, 6-164
creating new, 6-165
editing, 6-167

H
handling an event for an element, 6-23
handling an event within a body page, 6-179
handling an event within a frameset, 5-64
hard page returns for splitting a source document, 6-96
Head

including HTML or scripting code in, 6-181
placing elements in, 6-25

header, in a Web page, 6-202
headings in tables, formatting, 6-118
height of lines in paragraphs, 6-106
Help

opening from the Menu bar, 1-5
using, 1-4

Hewlett Packard Graphics Language graphics format 
supported, 6-170

hiding the large toolbar, 3-18
hiding the standard toolbar, 3-18
hiding the status bar, 3-19
hierarchy of metadata

applying, 6-70
explained, 6-81

hierarchy of ranks, 6-43
hierarchy, publication, 5-8
history file, 4-3, 8-12
home page, finding in Stellent Content Server, 8-72
HTML

as input file, 5-43
tables, 5-69

HTML 4.0, compliance with, 6-184

HTML code
associating with an element, 6-127
at top of HTML file, 6-178
in the head of a Web page, 6-181
including in a page TOC, 6-179
including in a Web page, 6-180
passing through, 5-39
tokens for adding, 6-186

HTML file, importing, 5-45
HTML generation, 5-109
HTML links, case sensitivity of, 5-101
HTML output

placing elements in body pages, 6-26
placing metadata in Meta tags, 6-25

HTML pages, 5-102
HTML source files, 6-181
HTML tables

adding to the Table Gallery, 5-84
applying from the Gallery, 5-83
associating with a publication, 5-69
cell properties, 5-70
copying, 5-72
creating, 5-73
defined, 5-69
editing, 5-74
editing cells, 5-75
gallery, 5-83
populating the cells in, 5-80
properties, 5-81
using dynamic includes, 5-77

HTML tag
assigning to an element, 6-89
explained, 6-89
including a version number in, 6-182
including HTML or scripting code in, 6-182
including the LANG attribute in, 6-182

HTML version 4.0, 6-178
HTTP

adding a Directory Item from site, 5-13
adding a source document from, 5-14
element, 6-30
publish options for a site, 8-65
publishing to a site, 8-64
specifying link when publishing to site, 8-67
updating source documents from site, 5-12

hyperlink
creating with a Content ID, 6-162
creating with a content server URL, 6-160
creating with a document title, 6-161
omitting targets for promoted elements, 6-197
relinking in output page, 6-196
targets for external links, 6-195
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I
Icons tab dialog, 6-131
icons, inserting, 6-131
Idoc Script syntax, 5-112
illegal characters in a title, 5-22
import conflicts, 6-91
import conflicts between styles and patterns, 6-92
importing a publication, 5-5

folders from the file system hierarchy, 5-97
new styles from a source document, 6-47
older Default.tcp, 1-6
older templates, 1-9
source documents that share styles, 6-91
templates, 6-13

Importing old project files, 1-7
includes

dynamic, 5-110
dynamic include token syntax, 5-112
reference pages, 5-111
static, 5-110

including scripting variables in output, 6-183
incremental database, 8-12
incremental publishing, 8-11
incremental translation, 3-20
Incremental Translation command, 3-12, 5-41
indents

adding, 6-103
in bulleted lists, 6-119

Index
adding, 5-53
explained, 5-52

Index Entry element, 6-30
Index Heading element, 6-30
Index SubEntry element, 6-30
Info icon

suppressing on Web pages, 8-72
information

inheriting from source, 8-50
on a task that has run, 8-41

inheritance settings, 8-51
inheriting document information from source, 8-50
inheriting metadata

a strategy, 6-67
examples of, 6-70

input effects, 6-129
input files, 6-124
inserting icons, 6-131
inserting rules, 6-132
inserting separators, 6-133
installing Internet Explorer, 7-3
interface

Add toolbar, 3-6
Contents pane, 3-3

displaying and hiding toolbars, 3-18
Edit toolbar, 3-8
File toolbar, 3-9
large toolbar, 3-9
main window, 3-2
menu bar, 3-5
Publication Hierarchy pane, 3-3
Publication toolbar, 3-13
Run toolbar, 3-12
Server toolbar, 3-13
standard toolbar, 3-11
Startup Screen, 2-1
status bar, 3-4
Template toolbar, 3-11
title bar, 3-4
toolbars, 3-6
Viewer toolbar, 3-17

international versions of Word, 6-50
Internet Explorer, requirement for, 7-3
ISO 9660 compliance, 5-107
ISO Latin 1 character set, 5-109

J
JavaScipt in custom tags, 6-88
JavaScript in custom tags, 6-88
JavaScript variables, 6-183
JSP script syntax, 5-112

K
Keywords element, 6-30

L
LANG attribute, 6-182
large toolbar, 3-9, 3-18
latest released version, updating a source document 

to, 5-27
launching a source document, 5-38
layout

custom table, 5-68, 5-84
dialog box, 5-56
framesets, 5-58
HTML table, 5-69, 5-73

line height for paragraphs, 6-106
line indentation, 6-104
link

adding to a frame, 5-65
Link to Source button, 6-145, 6-147
retaining to docs stored in content server, 6-197
Specific Page, 6-151, 6-152
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Top of Project, 6-153, 6-154
Top of Project button, 6-145
when publishing to a file system, 8-55
when publishing to FTP site, 8-63
when publishing to HTTP site, 8-67

Link Properties dialog box, 6-143
Link to Source button, 6-145, 6-147, 6-148
linked publication

adding to a project, 5-2
updating, 8-10

linking
a Web page to a specific page, 6-151
a Web page to the top page of a project, 6-153
an element to a specific page, 6-152
an element to the top of a Web publication, 6-154
page elements with a button bar, 6-158
page elements with a text bar, 6-159
reference pages, 6-24
targets, 8-56
to a specific page, 6-144
to an external template, 6-14
Web pages with a button bar, 6-156
Web pages with a text bar, 6-157

links
setting colors for, 6-198
targets for, 6-195
to embedded OLE objects, 6-203

list
bulleted, 6-120
formatting, 6-121
numbered, 6-122
selecting bullets for, 6-120

list of elements, 6-19
List of Figures

adding, 5-53
explained, 5-52

List of Tables
adding, 5-53
explained, 5-52

Locked (Status column), 8-48
LOF (List of Figures), 5-52
log file

attaching to email notification, 8-35
Server, A-8
setting up, A-5
translation, 8-35, A-7
using a UNC path to identify the drive and 

directory, 8-48
viewing, A-4

logging errors, A-3
logging levels, A-2, A-5
logging options, A-2
LOT (List of Tables), 5-52

M
main window, explained, 3-2
Manage Templates command, 3-11
Manage Templates dialog box, 6-12
managing templates, 6-12
managing the task list, 8-40
manually formatted document, setting up, 6-93
Map file, 6-142
mapping input and text output effects, 6-129
mapping text effects, 6-128
margins

adding, 6-103
margins of paragraphs, 6-105
matching patterns, 6-62
matching patterns by using text expressions, 6-65
menu bar

explained, 3-5
Help, 1-5

Meta tag, placing an element in, 6-25
metadata

applying the hierarchy of, 6-70
changing the association with an element, 6-82
changing the properties of, 6-84
content server, 6-73
creating, 6-74
custom tags for, 6-82
examples of inheritance, 6-70
explained, 6-69
hierarchy of, 6-81
including in HTML output, 6-25, 6-26
inheriting, 6-67
list of standard, 6-76
making element-based, 6-78
options, 6-77
ordering, 6-86
placing in body pages, 6-26
placing in Meta tags, 6-25
placing in Web pages, 6-26
publishing to a content server, 6-79
removing from a template, 6-87
uses of, 6-69

Metadata tab dialog, 6-85
Micrografx Designer graphics format supported, 6-170
Microsoft Excel

creating a new style in, 6-48
styles in, 6-48

Microsoft Internet Explorer, 7-3
Microsoft Paint graphics format supported, 6-170
Microsoft PowerPoint styles, 6-49
Microsoft Word, international versions of, 6-50
migrating from a previous version, 1-6
mini-Installer, using to register a content server, 5-25
moving a toolbar, 3-9
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moving project files, 4-13
MS Excel

creating a new style in, 6-48
styles in, 6-48

MSP graphics format supported, 6-170

N
naming output pages, 5-105
naming templates, 6-7
navigating to another Web site, 6-144
navigation

creating a page button bar, 6-156
creating a page text bar, 6-157
creating an element button bar, 6-158
creating an element text bar, 6-159
JavaScript file, 5-6

navigation aids
in a Web page, 6-204
setting order of, 6-130

Navigation command, 3-11
Netscape Navigator, previewing in, 7-5
network directory, 4-13
New command, 3-9
new rank, creating, 6-41
new template, creating, 6-4
non-English source documents, 6-50
numbered list

creating a paragraph pattern for, 6-58
formatting, 6-122

O
obtaining source documents from Stellent Content 

Server, 5-22
OLE object support, 5-51
OLE object, preserving links to, 6-203
omitting, hyperlink targets for promoted elements, 6-197
Open command, 3-9
opening your Web publication from Stellent Content 

Server, 8-72
optional URLs for linking to a source document, 6-148
options

application, 3-14
for a Directory Item, 5-95
for setting frames, 5-61
in Stellent Site Builder, 3-16
logging, A-2
project, 4-7
publishing, 8-18, 8-19
setting project, 4-9
staging, 8-4, 8-6

template, 6-9
order of documents in the Contents pane, 5-34
order of navigation and visual aids, 6-204
order of patterns, 6-54
order of ranks, 6-35
ordered lists, 6-122
ordering metadata, 6-86
output character set, 5-108
output character sets, 5-108
output directory

designating, 5-101
Gallery Graphics, 5-102
metadata folder hierarchy, 5-96

output effects, 6-129
output file name

adding a prefix to, 8-79
case sensitivity of, 5-101
output page names, 5-105

output files, specifying extension for, 5-106
output HTML pages, 5-102
output page names, 5-105
output page, extension for a Directory Item, 5-95
outstanding problem reports, 8-8
overriding publish warnings for Stellent Site Server, 8-15
overriding staging and publishing options, 8-21
overwriting output pages, 5-103

P
padding, 6-103
padding for paragraphs, 6-100
page button bar

adding a Specific Page link, 6-151
adding a Top of Project link to, 6-153
navigating with, 6-156

page names, output, 5-105
page text bar, navigating with, 6-157
page TOC

adding global settings to, 6-176
adding rules to, 6-176
adding separators to, 6-177
elements assigned to, 6-18
explained, 5-52
formatting, 6-134
including HTML or scripting code in, 6-179
linking a reference page to, 6-24

page, reference, 5-52
Paint graphics format supported, 6-170
paragraph, 1-21
paragraph margins, 6-105
paragraph pattern

for a bulleted list, 6-59
for a numbered list, 6-58
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for figure numbers, 6-57
for graphics in a source document, 6-57
for tables, 6-60

paragraph properties of a pattern, 6-62
Paragraph tab dialog

formatting with CSS, 6-111
formatting without CSS, 6-112

paragraph width, 6-106
paragraphs

adding padding to, 6-100
advanced CSS options, 6-101
background color, 6-126
background image, 6-126
borders, 6-102
defined, 1-21
formatting in tables, 6-115
formatting with CSS, 6-111
formatting without CSS, 6-112
line height, 6-106
setting line indentation, 6-104
width, 6-106

pass-through conversion option, 5-37, 5-38
passing through HTML and scripting code, 5-39
password

password encryption, 8-27
registering for Stellent Site Server, 8-27

Paste command, 3-8, 5-40
path conflicts, causes of, 4-18
path verification, 4-19
path verification complete, 4-20
path, UNC, 8-48
pattern

changing its association with an element, 6-53
changing order of, 6-54
changing properties, 6-53
changing the name of, 6-54
changing the preview document, 7-4
character, 6-55
compared with rank and style, 6-28
conflict with styles, 6-92
creating, 6-56
explained, 6-52
font properties, 6-61
matching, 6-60
previewing, 6-63
properties, 6-63
removing from a template, 6-64
renaming in a new publication, 6-93
text expression properties, 6-65

Patterns tab dialog, 6-63
Pause Publishing command, 8-33
PCC graphics format supported, 6-170
PCX graphics format supported, 6-170
PDF as input file, 5-36

Pending (Status column), 8-48
PLT graphics format supported, 6-170
PNG graphics format, supported, 6-170
Portable Network Graphics format supported, 6-170
post-processing in Stellent Site Server, 8-45
PowerPoint

standard and custom metadata, 6-83
styles in, 6-49

pre-7.2 projects, scheduling on Stellent Site Server, 8-26
predictable file names, publishing with, 8-79
prefix, adding to output file names, 8-79
presentation option for Query results page, 8-71
preserving links to embedded OLE objects, 6-203
Preview Fail, 7-5
preview of source document, registering a project 

for, 8-12
previewing

a document, 6-7
a pattern in a document, 7-4
a source document, 7-4, 8-76
in Netscape Navigator, 7-5
patterns, 6-63
Web pages, 7-3

previews of source documents, Directory Item for, 5-28
previous version

scheduling projects from, 8-29
scheduling projects on Stellent Site Server, 8-26
upgrading from, 1-6

previous versions, migrating from, 1-6
Print button

adding to Web pages, 6-137
adding to your Web publication, 6-138
associating with an element, 6-138
explained, 6-136

print functionality, 6-139
printing a Web publication, 6-138, 6-140
printing the publication, 6-141
PrintPublication.htm, 6-141
problem report

registering a project to create, 8-12
registering a project to enable, 8-77

problem reports, outstanding, 8-8
problems during translation, A-3, A-4, A-5
project

adding a frameset to, 5-59
adding a publication to, 5-3
adding a reference page to, 5-53
adding to the task list, 8-39
associating a file with, 5-99
default HTML file, 4-6
default WML file, 4-6
editing on the task list, 8-40
explained, 4-2
linking to another project, 5-2
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publishing, 8-17
registering on a source server, 8-12
registering on a staging server, 8-12
registering to preview a source document, 8-76
removing from the task list, 8-41
saving, 4-12
scheduling for the task list in Stellent Site 

Server, 8-42
setting up, 4-4
staging, 8-5
starting, 4-11
unregistering on a staging server, 8-8

Project Export wizard, 3-13, 4-13
project file

converting old versions in Stellent Site Builder, 1-7, 
1-8

copying, 4-10
creating in Stellent Content Server, 5-20
customizing the default, 4-6
default HTML, 4-6
default WML, 4-6
explained, 4-3
in Stellent Content Server, 4-3
moving to a network directory, 4-13
opening from Stellent Content Server, 5-23
overwriting in Stellent Site Server, 8-45
saving, 4-12
versioning, 4-9
versioning in Stellent Site Server, 8-45

project options
case sensitivity of output file names, 5-101
complying with ISO 9660, 5-107
described, 4-7
HTML generation, 5-109
Map file, 6-142
output character sets, 5-108
output page names, 5-105
printing, 6-141
setting, 4-9

Project Path Conflict dialog box, 4-18, 4-19
Project Path Replacement dialog box, 4-19, 4-20
Project Paths Verification dialog box, 4-19, 4-20, 4-20
project recovery, A-16
promoting an element, 6-27
promoting captions, 6-98
properties

changing a pattern name, 6-54
changing for patterns, 6-53
changing for styles, 6-47
document, 5-32
element, 6-19, 6-22
element name, 6-21
frame, 5-62
frameset, 5-63

graphics Sets, 6-164
of a frameset, 5-62
of a pattern, 6-62
of a style, 6-44
of metadata, 6-84
pattern, 6-63
promotion, 6-27
publication, 5-6
rank, 6-34, 6-40

property sheets
Element Setup, 6-17
Formatting, 6-97
Globals, 6-173
Navigation, 6-134

proxy settings
Proxy settings for an FTP site, 8-61
Proxy settings for an HTTP site, 8-65

publication
adding to a project, 5-3
associating a file with, 5-99
associating a frameset with, 5-58
creating a JavaScript file for, 5-6
explained, 5-2
exporting, 5-4
importing, 5-5
linked, 5-2
printing, 6-141
properties, 5-6
updating when linked, 8-10

Publication Hierarchy pane
explained, 3-3

publication hierarchy, explained, 5-8
Publication Properties command, 3-13
publication TOC

adding, 5-53
explained, 5-52

Publication toolbar commands, 3-13
Publish command, 3-12, 8-15
publish options

confirming, 8-21
explained, 8-18
specifying for a file system, 8-54
specifying for an FTP site, 8-61
specifying for an HTTP site, 8-65

Publish Warnings dialog box, 8-8, 8-14, 8-16
publish warnings for Stellent Site Server, 8-15
publishing

a project, 8-17
in Stellent Site Server, 8-25
setting options, 8-19
use of content servers in, 8-68
using tasks in Stellent Site Scheduler, 8-45
version options of source documents, 5-28
with errors, 8-11
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with file name only, 8-81
with predictable file names, 8-79
without unique suffix, 8-81

publishing metadata to a content server, 6-79
publishing notes, 8-16
publishing options

explained, 8-18
inheritance settings, 8-51
inheriting document information from source, 8-50
metadata strategy for, 6-67
overriding, 8-21
setting, 8-19
setting at the subpublication or document level, 8-21
specifying document information, 8-49

publishing process, 8-1
publishing server

content servers, 8-68
designating, 8-19

publishing to an FTP site, 8-60
publishing to an HTTP site, 8-64
publishing with errors, 8-11

Q
query

checking details of, 5-30
creating and using a Directory Item, 5-18
reference page, 6-191

Query form, selecting, 6-192
Query reference page

explained, 5-52
fields and buttons for, 6-190

query results hierarchy, 5-96
Query results page

presentation option, 8-71
setting options for, 6-193

quitting Stellent Site Builder, 2-4

R
rank

changing alignment property, 6-37
changing association with an element, 6-38
changing color property, 6-39
changing effects, 6-40
changing font property, 6-38
compared with style and pattern, 6-28
creating, 6-41
explained, 6-36
frequency, 6-43
hierarchy, 6-43
order, 6-35

properties, 6-34, 6-40
removing from a template, 6-32
rules, 6-33

rank rules, changing, 6-40
Ranks tab dialog, 6-33
RAS graphics format supported, 6-170
Raster Image Format gra, 6-170
recent server connections, 8-41
reconnecting to a server, 8-41
reference page

adding to a project, 5-53
creating, 5-53
explained, 5-52
linking, 6-24
promoting captions to, 6-98
removing from a publication, 5-40

reference pages
dynamically included, 5-111
Query, 6-191
statically included, 5-111

registering a content server
by manually creating a Registry entry, 5-24
by running the mini-Installer, 5-25
explained, 5-24
in Stellent Content Publisher, 8-73
in Stellent Site Server, 8-27

registering a project
for the creation of problem reports, 8-12
in Stellent Content Publisher, 8-73
on a staging server, 8-77
to enable staging criteria workflow, 8-12
to preview a source document, 8-76

Registry entry, creating to register a content server, 5-24
released version

updating a document to the latest, 5-27
relinking hyperlinks in output pages, 6-196
renaming a graphics Set, 6-169
renaming patterns and elements, 6-93
replacement parameter, 8-56
repositioning a toolbar, 3-9
repository

obtaining source documents from, 5-22
Select a Repository dialog box, 3-21
selecting, 5-8
updating source documents in, 8-70
updating to latest version of source document, 5-27

resetting the log file, A-5
resolving conflicting paths, 4-18
resolving import conflicts between styles and 

patterns, 6-92
restricted Directory Item, 5-29
reviewing task information, 8-41
revision information from source documents, 6-203
RTF, standard metadata, 6-83
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rules
adding to a page TOC, 6-176
adding to a Web page, 6-174
for ranks, 6-33
inserting, 6-132

Rules tab dialog, 6-132
Run menu, 5-41
Run toolbar commands, 3-12
Running (Status column), 8-48
running Stellent Site Server, 8-28

S
Save As command, 4-12
Save command, 3-9, 4-12
saving a project file, 4-12
saving a template, 6-9
scheduled project, testing, 8-47
scheduled task, testing, 8-47
Scheduler command, 3-13
scheduling a project, 8-39
scheduling a task, 8-42
scheduling projects

automatically running pre-7.2 projects on Stellent 
Site Server, 8-26

from previous versions, 8-29
script for obtaining printer control, 6-141
scripting code

associating with an element, 6-127
at top of HTML file, 6-178
in head of Web page, 6-181
including in a page TOC, 6-179
including in a Web page, 6-180
passing through, 5-39

scripting syntax
tokens available, 5-111
using with Stellent tokens, 5-112

scripting variables
in Stellent Site Builder, 6-183
including in output, 6-183

scripting, including in top of file, 6-178
security, 8-53
Select a Repository dialog box

showing, 3-21
selecting

a background graphic, 6-199
a graphics Set for a Web page, 6-198
a repository, 5-8
an output character set for a document, 5-108

Selective Incremental Translation, 3-20
separators

adding to a page TOC, 6-177
adding to a Web page, 6-175

inserting, 6-133
server

changing the setup, 8-26
moving a publication to, 3-13

Server log file, 8-35, A-8
server reconnection, 8-41
server threads, 8-34
Server toolbar commands, 3-13
Service

running Stellent Site Server, 8-28
setting up Stellent Site Server as, 8-29
setting up Stellent Site Server as a Service, 8-29

Sets mode in the Gallery, 6-169
Sets of graphics, 6-168
setting publishing options, 8-19
shared network directory, 4-13
showing

the large toolbar, 3-18
the Print button warning, 3-21
the Select a Repository dialog box, 3-21
the Startup Screen, 3-19

size of tables, 6-117
skipping single hard carriage returns in ASCII 

documents, 6-205
sorting Directory Items, 5-94
source file URL, 6-143
source files supported, 5-45, 6-170
source ID, output page names, 5-105
source server

explained, 8-68
previewing a document in, 7-4
registering a project on, 8-12

special Stellent elements, 6-30
Specific Page link, 6-144, 6-151, 6-152
specific page URL, 6-143
splitting a source document into several web pages, 6-95
splitting a source document on hard page breaks, 6-96
SSI script syntax, 5-112
Stage command, 8-6
staged output, suppressing the Info icon, 8-72
staging

a project, 8-5
in a file system, 8-54
in Stellent Site Server, 8-45
setting options, 8-4
with file name only, 8-81
without unique suffix, 8-81

staging and publishing options, 8-10
staging criteria workflow

workflow and registration, 8-12
staging options

confirming, 8-3
explained, 8-6
inheritance settings, 8-51
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inheriting document information from source, 8-50
metadata strategy for, 6-67
overriding, 8-21
setting at the subpublication or document level, 8-21
specifying document information, 8-49
specifying for a file system, 8-54
specifying for FTP, 8-61
specifying for HTTP, 8-65
suppressing the Info icon, 8-72

staging server
content servers, 8-68
registering a project on, 8-12, 8-77
unregistering, 8-8

staging workflow
documents in, 8-14
registering a project to enable, 8-12, 8-77
reviewing open, 8-14

standard Directory Item, 5-29
standard HTML tags, 6-89
standard metadata, 6-83

explained, 6-69, 6-83
list of, 6-76

standard naming of output pages, 5-105
standard toolbar, 3-7, 3-11, 3-18
starting a project, 4-11
starting Stellent Site Scheduler, 8-39
starting Stellent Site Server, 8-31
Startup Screen

opening, 1-5
showing on startup, 3-19

static includes, 5-110
statically included body pages, 5-111
statically included reference pages, 5-111
status bar

displaying and hiding, 3-19
explained, 3-4

status bar, displaying and hiding, 3-19
status, translation, 5-42, 8-48
Stellent Content Publisher

configuring, 2-5
integrating third-party applications, 5-110
new features, 1-2
requirement for Internet Explorer, 7-3
user documentation, 1-3

Stellent Content Server
adding a Directory Item from, 5-18
adding a source document from, 5-17
connecting to, 5-21
creating a project file in, 5-20
criteria of a Directory Item, 5-30
document name when checking in, 8-81
importance of ordering published metadata, 6-86
obtaining source documents from, 5-22
opening a project file from, 5-23

opening your Web publication from, 8-72
previewing a source document, 8-76
project files in, 4-3
registering, 5-24
setting check-in file extensions, 8-82
updating source documents in, 8-70
versioning the project file, 4-9

Stellent Site Builder
exiting, 2-4
exporting a publication, 5-4
exporting templates, 6-5
Help system, 1-4
main window, 3-2
options available, 3-16
registering a content server, 5-24
versioning the project file, 4-9

Stellent Site Builder Help, using, 1-4
Stellent Site Scheduler

exiting, 8-40
starting, 8-39

Stellent Site Scheduler command, 3-13
Stellent Site Server

changing the setup, 8-26
connecting to, 8-32
converting old project files in, 1-8, 8-26
disconnecting from, 8-33
overriding publish warnings, 8-15
overwriting or versioning the project file, 8-45
pause publishing in, 8-33
reconnecting to, 8-41
registering a content server, 5-24
registering a username and password, 8-27
running, 8-28
scheduling a pre-7.2 project on, 8-26
scheduling a task, 8-42
setting logging, 8-45
setting up as a Service, 8-29
specifying a task, 8-45
staging and publishing in, 8-45
starting and stopping, 8-31
versioning the project file, 4-9

stopping Stellent Site Scheduler, 8-40
stopping Stellent Site Server, 8-31
strategy for inheriting metadata, 6-67
stripping non-list items, 6-123
style

changing its association with an element, 6-46
changing the properties of, 6-47
compared with rank and pattern, 6-28
conflict with patterns, 6-92
creating, 6-45
creating in Microsoft Excel, 6-48
deleting, 6-44
explained, 6-46
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importing, 6-47
in Microsoft Excel, 6-48
in Microsoft PowerPoint, 6-49
properties of, 6-44
removing from a template, 6-44
to format the appearance of tables, 6-116

Styles tab dialog, 6-44
subpublication, setting staging or publishing 

options, 8-21
suffix, 8-81
summary of templates, 6-3
superuser privileges for managing the task list, 8-40
supported graphics formats, 6-170
suppressing

cross-references in a Web page, 6-195
footnotes and endnotes in a Web page, 6-205
tables in a Web page, 6-206

suppressing the Info icon on Web pages, 8-72

T
table layout

custom, 5-68, 5-84
HTML, 5-73

tables
creating a paragraph pattern for, 6-60
formatting, 6-114
formatting characters, 6-113
formatting headings, 6-118
formatting paragraphs, 6-115
promoting captions from, 6-99
setting alignment, 6-60
setting borders and size, 6-117
setting colors, 6-115
setting up styles to format, 6-116
suppressing in a Web page, 6-206

tags before or after an element, 6-88
targeting a frameset, 5-65
targets for external hyperlinks, 6-195
targets for hyperlinks, 8-56
targets for promoted elements, 6-197
task

running multiple, 8-34
scheduling, 8-42
sending an email notification for, 8-35
specifying, 8-45
testing before it runs, 8-47

task information, reviewing, 8-41
task list

adding projects to, 8-39
editing a project on, 8-40
removing a project from, 8-41
superuser privileges for managing, 8-40

testing tasks on, 8-47
template

adding a new element to, 6-21
and associated graphics Sets, 6-11
changing the preview document, 6-7
choosing, 6-3
copying, 6-4
creating, 6-4
default settings, 6-10
deleting, 6-5
editing options, 6-9
explained, 6-2
exporting, 6-5
guidelines, 6-15
importing, 6-13
importing from a previous version, 1-9
linking to, 6-14
managing, 6-12
name conflict, 6-8
names, 6-7
removing a pattern from, 6-64
removing a rank from, 6-32
removing a style from, 6-44
removing an element from, 6-27
saving, 6-9
summary, 6-3

template tokens, 5-111, 5-114
Template toolbar commands, 3-11
temporary files, specifying a directory for, 5-26
testing a scheduled project, 8-47
text bar

formatting with CSS, 6-155
navigating page elements, 6-159
navigating pages, 6-157

text effects, 6-128
text expression properties of a pattern, 6-65
text formats supported, 5-45
third-party applications

applying web pages to a Stellent publication, 5-86
including content from in Stellent projects, 5-115
integrating with Stellent Content Publisher, 5-110
using tokens with, 5-110

TIFF graphics format supported, 6-170
title

creating for a Web publication, 6-201
illegal characters in, 5-22

Title (System) element, explained, 6-30
title bar, explained, 3-4
TOC.js, 5-6
tokens

dynamic include syntax, 5-112
for adding HTML code, 6-186
scripting syntax, 5-112
syntax, 5-111
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template, 5-111, 5-114
using with third-party applications, 5-110, 5-110, 

5-110
tokens for creating links to source documents, 6-148
toolbars

Add, 3-6
customizing, 3-7
displaying and hiding, 3-18
Edit, 3-8
explained, 3-6
File, 3-9
large, 3-9, 3-18
moving, 3-9
Publication, 3-13
Run, 3-12
Server, 3-13
standard, 3-11
Template, 3-11
Viewer, 3-17

Top of Project button, 6-145
Top of Project link

adding to a page button bar, 6-153
adding to an element button bar, 6-154

Translate All command, 3-12, 5-41
Translate command, 5-41
translating

documents in a specified directory, 5-89
in Stellent Site Server, 8-45
Microsoft Excel spreadsheets, 6-48
source documents, 5-41
version options of source documents, 5-28

translation
conflicts, 5-103
disk space required, 2-6
errors, A-3
errors and warnings, A-4
issues, 5-44
log file, A-7
one or more items, 3-20
options, 5-41
process, 5-44
status, 8-48
status of source documents, 5-42
using selective incremental option, 3-20
with anti-virus software running, 2-5

troubleshooting errors and warnings, A-8
types of source files supported, 6-170

U
UNC path, 8-48

Unicode (UTF-8) character set, 5-108
unique suffix when staging and publishing, 8-81
Unix-based server and case sensitivity, 5-101
unordered list

formatting, 6-120
removing indent from, 6-119

unregistering a project on a staging server, 8-8
Update Versions command

explained, 8-9
updating

a dynamic Directory Item, 5-94
a linked publication, 8-10
a Web publication, 5-6
source documents, 5-36
source documents from an FTP or HTTP site, 5-12
source documents in a repository, 8-70
to the latest released version of a source 

document, 5-27
Update Versions command, 8-9

upgrading from a previous version, 1-6
upper case, enforcing, 5-107
URL template, 8-56

specifying, 8-55
URL, optional for linking to source document, 6-148
user documentation for Stellent Content Publisher, 1-3
username and password, registering for Stellent Site 

Server, 8-27
using Stellent Site Builder Help, 1-4

V
variables for JavaScript, 6-183
variables, scripting, 6-183
verification of paths, 4-19
version attribute, 6-182
version of a source document

specifying, 5-27
version options when translating a source 

document, 5-28
versioning the project file, 4-9
viewer

default, 3-17
setting up, 7-2

Viewer command, 3-17
viewing

a source document, 5-38
Web pages, 7-1

viewing the log file, A-4
visual aids

in a Web page, 6-204
setting order of, 6-130
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W
Waiting (Status column), 8-48
warning for Print button, 3-21
warnings during translation, A-3, A-4, A-5
web page

adding a copyright line, 6-201
adding a Print button to, 6-137, 6-138
adding a Specific Page link to, 6-151
adding a Top of Project link to, 6-153
adding an address, 6-200
adding an email address, 6-201
adding options to, 6-206
adding rules to, 6-174
adding separators to, 6-175
adding titles to, 6-201
basing disclosure on security, 8-53
converting graphics for, 6-124
displaying headers and footers in, 6-202
formatting, 6-97
formatting bulleted list, 6-120
formatting characters in tables, 6-113
formatting characters with CSS, 6-108
formatting characters without CSS, 6-110
formatting colors in tables, 6-115
formatting lists, 6-121
formatting numbered lists, 6-122
formatting page TOC, 6-134
formatting paragraphs in tables, 6-115
formatting paragraphs with CSS, 6-111
formatting paragraphs without CSS, 6-112
formatting table alignment, 6-60
formatting tables, 6-117
formatting text effects, 6-128, 6-129
including HTML or scripting code at the top, 6-178
including HTML or scripting code in, 6-180
including HTML or scripting code in the head, 6-181
inserting icons, 6-131
inserting rules, 6-132
inserting separators, 6-133
linking to, 6-144
linking with a button bar, 6-156
linking with a text bar, 6-157
making compliant with HTML 4.0, 6-184
opening a source document from, 6-145, 6-147
placing an element in, 6-26
previewing, 7-3
printing, 6-140
printing out, 6-137
selecting a background color for, 6-199

setting colors for, 6-198
setting order of navigation and visual aids, 6-130, 

6-204
suppressing cross-references, 6-195
suppressing footnotes and endnotes, 6-205
suppressing Info icon on, 8-72
suppressing tables in, 6-206
third party, 5-86
viewing, 7-1

Web publication
adding a Print button to, 6-138
explained, 5-2
printing, 6-140
updating, 5-6

Web site, navigating to, 6-144
Weblink element, 6-30
Western (ISO-8859-1) character set, 5-108
Western (Windows-1252) character set, 5-108
width of paragraphs, 6-106
Windows

running Stellent Site Server on, 8-28
starting and stopping Stellent Site Server, 8-31

Windows-specific characters, 5-109
wizards

Add a Document, 2-1
Folder Import, 5-97
Project Export, 3-13

WMF graphics format supported, 6-170
WML project, creating, 4-10
Word

embedding OLE objects in, 6-203
preserving links to bookmarks, 5-39
standard and custom metadata, 6-83

Word Pro, standard metadata, 6-83
Word versions 2 and 6

standard metadata, 6-83
WordPerfect

standard metadata, 6-83
workflow

reviewing open, 8-14
types of, 8-12

WPG graphics format supported, 6-170

X
XML as input file, 5-36
XML Map file, 6-142
XML template, 6-5
XML-compliant output, 6-185
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